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Getting Started with VERICUT 
 

Introduction 
 

Introduction to VERICUT 
VERICUT simulates or replaces costly steps of the NC data verification process, plus 
optimizes the efficiency of material removal. By simulating NC programs, VERICUT 
can reduce or eliminate the time-consuming and expensive steps of the traditional data 
prove-outs. The program also optimizes program feed and speeds to increase the 
efficiency of the machining process. This all adds up to lower costs and higher profits for 
your business. 

Need training? Visit the CGTech web site at www.cgtech.com and click Training, in 
the Services pull-down menu, for training course descriptions, schedules, and online 
registration. 

 

NC program verification process with VERICUT: 

 
 

http://www.cgtech.com/
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VERICUT interactively simulates the material removal process of NC program data. 
Instead of messy wax or foam models, or costly prove-outs that waste valuable 
production time, a simulated VERICUT part is graphically produced on your computer 
screen. VERICUT then verifies the accuracy of the NC program and makes certain the 
finished part matches the design model. Before any machine time is spent, VERICUT 
catches discrepancies that could corrupt the cutting process and identifies the responsible 
NC program records for fast and easy adjustment. 

The input into VERICUT is NC program data from almost any source. G and M code 
data as well as APT type CL-files are directly processed by VERICUT. Similar to the 
requirements of machining a real part, VERICUT needs the NC program data, a 
description of the raw stock material to be machined, and descriptions of the cutting tools 
used to machine the part. The result of the verification process is a solid model of the 
machined part and an error Log file reporting any machining errors detected during the 
simulation. The VERICUT model can be inspected, saved, or used as the stock material 
for another NC program. 

In addition to streamlining the verification process, VERICUT dramatically boosts 
productivity on the shop floor. Automated and user-selectable optimization settings in 
VERICUT let you maximize the material removal process. The feed rate and cutting 
speed of each NC program automatically adjust based on the depth, width, and angle of 
each cut. In fact, you can even set VERICUT to compensate for dull or custom cutters or 
other elements unique to your operation. 

VERICUT simulates up to 5-axis milling, drilling and wire EDM operations, as well as 
turning and combination mill/turn machining. With a complete line of specialization 
modules for added features and functionality, VERICUT is truly the total simulation, 
verification, and optimization solution for unleashing NC productivity. 

Also see "Overview of Using VERICUT", in the Using VERICUT section, in the 
CGTech Help Library. 

 

Installing VERICUT 
In most cases installing VERICUT is a straight-forward and easy task, requiring only a 
few minutes of time. Prior to installing any software, review the system requirements and 
the installation procedure for the computer type on which you intend to operate 
VERICUT. 

Detailed step-by-step instructions are provided in the installing_cgtech_products.pdf 
included on the VERICUT software CD, and online in the Installing CGTech Products 
section of the CGTech Help Library. Follow all applicable steps to ensure smooth 
VERICUT installation and successful operation.  
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Accessing VERICUT 
The method of accessing VERICUT is different, depending on the environment in which 
it is operated. All methods described below are for accessing VERICUT as installed 
using instructions provided by CGTech. Your VERICUT installation may be different. 

 

Access VERICUT on a Windows computer: 
From the Taskbar, click Start > All Programs > CGTech VERICUT 6.x > VERICUT 
6.x where "6.x" is the desired VERICUT version number. 

For example, to run VERICUT 6.2 you would click: Start > All Programs > CGTech 
VERICUT 6.2 > VERICUT 6.2 

 

Access VERICUT on a UNIX computer: 
Type "vericut". If the command is not found, include the full path, e.g. 
"/<cgtech6x>/<computertype>/commands/vericut" where <cgtech6x> represents the 
directory path to where CGTech products were installed, and <computertype> is the type 
of computer on which VERICUT is being operated, for example: hp, rs, or solaris. 

For example, to run VERICUT installed in "/server/apps/cgtech62" on an HP700 
computer, you would type: /server/apps/cgtech60/hp/commands/vericut 

Hint: Copy the "vericut" command file to the /usr/bin directory and the next time you log 
in, you should be able to just type "vericut". 

 

Access VERICUT from CATIA: 
Assuming you have CGTech's CATIA-to-VERICUT Interface installed, choose the 
"CATV" function. Use CATV functions to select the CATIA data to use in the 
verification session (geometry models, NC programs, etc.) and transfer the data to 
VERICUT. Then access VERICUT via choosing PROCESS menu > VERICUT. 

 

Access VERICUT from NX: 
Assuming you have CGTech's NX-to-VERICUT Interface installed, access VERICUT 
from NX as follows: 

Click on the Verification icon in the NX CAM icon bar. 
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Access VERICUT from Pro/Engineer: 
Access VERICUT from ProE as follows: 

Click NC Sequence Play Path menu > NC Check => simulates the current selected NC 
sequence. 

Click CL Data menu > NC Verification => enables users to select a single NC 
sequence, multiple sequences, or an entire NC operation for simulation.  

NOTE:  The NC data must be selected prior to selecting starting the verification 
process. 

 

Access VERICUT from Mastercam-to-VERICUT Interface: 
Access VERICUT from Mastercam as follows: 

Hold down the Alt key and click the C key (referred to as Alt-C). You will see a file 
selection dialog offering all the installed C-Hooks. Pick "VERICUT.dll" and click on the 
Open button. 
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VERICUT Licenses and Options 
 

 
 

VERICUT licenses and capabilities differ, depending on the environment in which 
VERICUT is being operated. A modular approach provides the flexibility to purchase 
only the capabilities you need. As your needs change, you can add the appropriate 
licenses to increase VERICUT's functionality. The terms "licenses" and "options" are 
synonymous, since each option for VERICUT is licensed by CGTech. It is not necessary 
to install any additional software to add an option. CGTech provides a license that allows 
immediate access. See Product Line, on the CGTech website, for complete details on 
available options. 

CGTech software licenses allow you to share VERICUT over a network. Only one user 
may access a given license at a time. CGTech's license system supports Windows 2000, 
XP, XP64, HP, RS and Solaris. See VERICUT System Requirements, on the CGTech 
website, for more detailed information. The server and networked workstations can be 
different computer types. 

 
Licensing for VERICUT 
VERICUT 6.2 licensing is required. Pre-6.2 licensing is incompatible with the 6.2 
CGTech Network License Server. If you do not have a 6.2 license, obtain licensing from 
CGTech as described below. 

6.2 licenses are issued via email only. Your 6.2 license will be emailed to the primary 
VERICUT user at your company. If you do not have licensing, submit an application via 
CGTech website. 

 

NOTE TO NEW CUSTOMERS — You will need to know the machine ID 
(ethernet address) of the machine on which the CGTech Network License Server is to 
operate. To determine the machine ID, see the steps described in the Installing CGTech 

http://cgtech.com/usa/products/
http://cgtech.com/usa/support/systemrequirements/
http://cgtech.com/usa/support/license/
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Products section of the CGTech Help Library. (ref. Determine Your Host ID and 
Request a License). 



VERICUT HELP - Getting Started with VERICUT 
 

 

VERICUT with SpaceBall/SpaceMouse 
 

VERICUT now supports 3Dconnexion 6 axis input devices (SpaceBall and SpaceMouse) 
on Windows. Use of these devices requires a driver known as 3DxWare. 

 
These devices have at least 8 buttons, some of which we have designated as follows: 

1. Toggles translations on and off.  
2. Toggles rotations on and off (you can't have both of these off together, so turning 

one off will turn the other on if necessary).  
3. Toggles the dominant axis filter on and off (when on, only one axis moves at 

once).  
4. Fit. 
5. Decreases sensitivity.  
6. Increase sensitivity.  
7. Reverse 
8. Refine 

With the exception of buttons 4, 7 and 8, these functions are a de-facto standard for 
software that supports the devices. PTC uses button 4 as "Fit" in Pro/E. A configuration 
file (VERICUT.scg) is required and is accessed by the 3DxWare driver on startup. This 
file is distributed by 3Dconnexion with the most recent version of their driver. 

While beta testing has shown that VERICUT generally works correctly with various 
older models and older versions of the device drivers, CGTech recommends using the 
latest driver version. It can be downloaded from www.3dconnexion.com. The VERICUT 
configuration file was added to 3DxWare version 2.3 build 5, September 4, 2002. 

  

NOTE: 3Dconnexion motion control devices currently work with VERICUT on 
Windows platforms only. 

 

http://3dconnexion.com/
http://www.3dconnexion.com/
http://www.3dconnexion.com/
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Performance Considerations 
 

This section describes ways to help increase VERICUT productivity. 

 

System considerations 
Computer speed — VERICUT runs faster on faster computers. When comparing 
computers made by different manufacturers, you can get a general idea how VERICUT 
will perform by comparing the processor speed for floating point computations. 

Multiple processors — VERICUT runs 10-20% faster on computers with dual 
processors over a comparable computer with a single processor. 

Memory — The amount of memory available to VERICUT can make a difference. See 
"VERICUT System Requirements" for memory recommendations. If you intend to 
process large tool paths, complex cutting operations, or use AUTO-DIFF, you may need 
more memory. VERICUT uses virtual memory (hard disk) when physical memory 
(RAM) is exhausted. Best performance is obtained when sufficient physical memory is 
available to VERICUT. Excessive memory does not make VERICUT run faster, 
however, insufficient memory will slow it down. 

Running concurrently with other applications — Even though your system may run 
VERICUT or other large applications (e.g. CAD/CAM packages) comfortably, running 
them concurrently may cause competition for resources: memory, disk space, etc. Under 
these conditions the computer begins "paging" or "swapping" memory (a.k.a. "disk 
thrashing"), which adversely affects performance. Symptoms of disk thrashing are: 
constant hard drive activity or noise, active applications are slow, "Out of memory" error 
messages or warnings appear. In the worst case you can run out of all available memory 
which can cause your computer to crash or hang. When determining the amount of 
memory the system needs to run your applications, be sure to consider the memory 
requirements of ALL applications that will be run concurrently. 

Graphics cards — VERICUT uses 2-D raster (pixmap) graphics. It does not use triangle 
shading (such as with a 3-D API like OpenGL or Direct3D), texture mapping, or much (if 
any) vector drawing. All graphics cards (even the cheapest) do pixmap graphics. The card 
needs enough display or video memory to drive the display resolution at the desired 
number of colors. For example, 8 mb of display memory may be enough to do a 1024 x 
768 display at True Color, but may only be able to do 64k colors at 1600 x 1024 
resolution. VERICUT 5.0 or higher performs best in a True Color display environment. 
More expensive does not necessarily mean "better for VERICUT". Lower cost cards 
frequently outperform expensive cards when running VERICUT. 
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Tolerances  
Cutting Tolerance — The "Cutting Tolerance" value (ref. File menu > Properties, 
Tolerance tab) controls the accuracy of cuts applied to the workpiece. This value 
directly affects the speed and quality of the results from comparing or exporting models, 
optimizing tool paths, checking for holder collisions, "Fast Feed" errors, dynamic rotation 
speed, and zoom speed. A larger cutting tolerance value makes VERICUT go faster, but 
the resulting cut model and collision checking will be less accurate. A smaller cutting 
tolerance value may slow the simulation, but provides the high level of accuracy needed 
to perform detailed model analysis or export, optimization, etc. 

• A larger cutting tolerance value is probably okay for quick visual checks, or when 
only X-Caliper will be used to analyze the model (no AUTO-DIFF). 

• Use a smaller cutting tolerance value if you expect to use AUTO-DIFF, Model 
Export, OptiPath, or examine very small model details. 

 
How VERICUT uses Cutting Tolerance to determine model accuracy — The "Base 
Cut Tolerance on" option on the File menu > Properties: Tolerance tab controls how 
VERICUT applies the Cutting Tolerance value to set cut model accuracy. 

• Choose "Stock Size" to achieve consistent performance on similar sized parts, 
regardless of the variety of cutting tools used. However, cuts made by very small 
cutters or cutters with complicated shapes should be evaluated closely to determine if 
sufficient accuracy has been maintained. 

• Choose "Tool Size" to consider sizes of cutting tools in addition to the stock model 
size, or when optimal results must be achieved for all cutting tools. Be aware that 
with this option, very small cutters such as tiny drills, scribe end mills, etc. can 
severely impact overall performance. 

 
Model file tolerances — Model files, such as Stereo lithography (STL) or VERICUT 
model files, exported from CAD systems should be created using tolerances appropriate 
for how they will be used in VERICUT. For example, models that will be used as stock 
workpieces, holding fixtures, or NC machine components probably do not need to be as 
accurate as models that will be used by AUTO-DIFF to check for gouges or excess 
material. Outputting CAD models with excessively small tolerance values can result in 
very large model file sizes that cause VERICUT to use large amounts of memory. Similar 
considerations apply to tolerances for converting IGES model files that will be used in 
VERICUT. Assuming you have enough memory, model file size/complexity does not 
affect cutting speed in VERICUT. 

 

Other tips and tricks 
Axes display — Axes displayed in the graphics area (e.g. via View menu > View Axes 
or right-click shortcut menu) slow cutting speed. For best performance clear all axes 
before cutting. 
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Fixture display — Fixtures displayed in the "Workpiece" view slow cutting speed. For 
best performance, set Visibility to Machine View on the Component Attributes tab of the 
Modeling window. (e.g. via Project menu > Setup Models > Define: Component 
Attributes tab or double-click on the fixture component in the Component Tree) 

Skip Cut and Animation Speed control — These features on the Project menu > 
Processing Options > Motion window directly affect cutting speed. Skipping cuts can 
make VERICUT run faster by updating the display less frequently, especially when 
multi-axis cuts, large cutters, or tools with holders are involved. Also, for best 
performance ensure the Animation Speed slider, located at the bottom of the VERICUT 
main window, is positioned as far right as it will go ("Fast"). 

No Animation — This feature on the Project menu > Processing Options  > Motion 
window enables you to reduce processing time. When No Animation is toggled "on", the 
graphics display is not updated until either processing is complete or you Stop the 
processing. At that time the cut model is displayed in it "final" state or the state that it 
was in when processing was stopped. You can also toggle No Animation On/Off using 

the No Animation icon, , in the VERICUT toolbar. 

Tool holders — Using tool holders enables VERICUT to detect when non-cutting 
portions of the tool assembly remove material or crash into clamps/fixtures holding the 
workpiece. You can minimize this effect by modeling only portions of the tool assembly 
that can be involved in a collision. For example, don't bother modeling the taper of a 
milling tool holder (portion that seats inside the spindle). If you don't have concerns 
about tool holder collisions, VERICUT will run faster if tool holders are not displayed, 
e.g.: Project menu > Processing Options > Motion: clear the "Display Holders in 
Workpiece View" checkbox. 

Status and NC Program windows — Opening these windows via the Info menu 
provides valuable information about the machining process. However, since VERICUT 
updates them with each tool path record processed, having them open while cutting slows 
performance. For best performance, close them before cutting. You can reopen them 
later, as needed for reference. 

Address unsupported codes in G-Code tool paths — When processing G-Code tool 
paths, "unsupported" codes cause messages to be written to the VERICUT Log file and 
the VERICUT main window message area. Reporting numerous unsupported codes can 
slow performance dramatically. Avoid writing "false" errors and the corresponding time 
loss by addressing unsupported codes via the NC control configuration. To ignore codes 
that are unimportant to the simulation, use Configuration menu > Word/Address to add 
groups that will have unsupported codes call the macro, IgnoreMacro. 

Faster zooming — Following is a technique to improve the zoom and display speed, and 
eliminate the post zoom delay between pressing Play and resuming cutting. Create a 
second, smaller view window (View menu > Layout > Add View) and position it to the 
side. Cut the part. When you want to see an area in more detail, use the smaller window 
for zooming. This protects the refined display in the larger window. Because VERICUT 
needs only to update the smaller image, you get zoom images much faster than 
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performing the operation in the larger window. Also, when you restart the simulation 
there is virtually no delay before VERICUT starts cutting again. 

 

 

 
 

Disable Report — This feature on the Analysis menu > AUTO-DIFF window: 
Settings tab enables you to turn off the AUTO-DIFF Report feature to reduce AUTO-
DIFF processing time. For large NC program files, generating the report can take a 
significant amount of time. When toggled "off", you will still see the AUTO-DIFF results 
in the graphics area. 

 

Want more VERICUT tips and tricks from the experts? Visit the CGTech web site at 
www.cgtech.com and click "SUPPORT PAGE", then look for "Tips and Tricks".   

 

http://www.cgtech.com/
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VERICUT Files 
 

Summary of VERICUT File Types 
The sections that follow provide information about the files VERICUT uses and typical 
file extensions. 

 

Types of VERICUT files 
Files provided by CGTech to assist with simulating NC program and machine tool 
motions can be divided into two categories: 

Library files — General purpose files for configuring VERICUT to simulate NC 
program and machine motions. Library files are included in every installation, and 
include: 

VERICUT default files — Default files opened by VERICUT. The files are configured 
to perform a short simulation when Play is pressed. Two sets of files provide 
demonstrations for inch (vericut.VCProject) and metric (vericutm.VCProject) 
environments. 

VERICUT initialization files — Initialization files opened by VERICUT via File menu 
> New Project. Two sets of files provide initialization for inch (init.VCProject) and 
metric (initm.VCProject) environments. 

Machine and Control files — NC machines and controls intended to help you configure 
VERICUT for simulating G-Code NC programs that run on popular NC machining 
centers. See "Library Machine files" and "Library Control files" for details. 

For information about these files, see "Library Files". 

Sample files — Files used to demonstrate VERICUT capabilities and options. Sample 
files are included with CGTech software on the CD, and are available to all users who 
choose to load them. For information about these files, see Sample-Demo Files in the 
CGTECH Help Library. 

 

VERICUT File Descriptions 
The types of files used by VERICUT to load and save various types of data are listed 
below in alphabetical order. See the appropriate section for a description of file contents 
and formats, and how to open and save them.
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APT Output File 
 

Typical file extension: .apt 

 

 An ASCII text file containing APT NC program records resulting from reverse post-
processing by VERICUT. By default when sequenced G-Code data is converted, columns 
73-80 in the output file indicate the block numbers of the G-Code data block where the 
converted records came from. Sequence number output is controlled via the Output Block 
Sequence Numbers feature on the Project menu > Processing Options > G-Code > 
Process Options: Messages tab. 

An APT Output file is created when a G-Code NC program is processed with Create 
APT Output File feature on the Project menu > Processing Options > G-Code > 
Process Options: G-Code Output Files tab is active. You can view this file using the 
View APT Output File feature on the Project menu > Processing Options > G-Code > 
Process Options: G-Code Output Files tab or the View feature, under APT Output 
File, on the Project menu > Output: G-Code Files tab. 

  

Sample G-Code NC Program file: 
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Sample of resulting APT Output file: 
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APT Table File 
 

Typical file extension: .tbl 

 

 An ASCII text file used by the Binary CL Converter that contains information necessary 
to convert binary APT data into ASCII APT NC program records. Such information 
includes: blocking factor, major and minor word classes, sub-classes, etc. 

APT Table files are loaded into VERICUT via the File menu > Convert > Binary CL 
function. APT Table files can also be specified on the command line when the Binary CL 
Converter is executed, such as during batch processing to simulate NC programs without 
user interaction. 

Sample APT Table file "aptwords.tbl" (located in the \vericut\ directory of your 
VERICUT installation):  
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Tips: 
1. The default blocking factor for interpreting binary CL data is 3228. If this does 

not produce favorable results, use any text editor to change the blocking factor. 
Other typical blocking factors you can try are: 512, 4628, 15476. 

2. If the ASCII NC program file output by the converter has major or minor words 
other than what you expected, try editing the APT Table file to change the 
"Word" output for a specific APT class/subclass. 
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AUTO-DIFF Report File 
 

Typical file extension: .rpt 

 

 An ASCII text file that contains information about an AUTO-DIFF model comparison 
operation, such as identification of all detected errors, and the NC program history related 
to each error. This information is valuable when determining the correctness of the 
VERICUT simulated cut model, and NC program records responsible for discrepancies 
detected by AUTO-DIFF. 

An AUTO-DIFF Report file is created when an AUTO-DIFF comparison is performed, 
and can be viewed via the "Report" feature. (Ref. Analysis menu > AUTO-DIFF) 

The exact format of the report varies, but generally includes a summary of the results, 
information about tolerances and models used in the comparison, error types 
(gouge/excess) and amounts, NC program history associated with errors, etc. 

Sample AUTO-DIFF Report file: 
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AVI File 
 

Typical file extension: .avi 

  

Also known as an Audio-Video Interleaved file, this file contains recorded images of 
VERICUT. AVI files are saved (recorded) via the File menu > Images > Record Movie 
function, and replayed via File menu > Images > Playback AVI Movie. 
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Batch Script Files 
Multiple VERICUT batch sessions can be run via a single executable command by 
including VERICUT batch commands in an executable script file. The script file is then 
submitted to the operating system for processing. After each batch execution terminates, 
the operating system then executes the next command in the script file. 

Batch files for different operating systems differ slightly in format. Details will follow 
later in this document. In general, each batch command in the script file appears as it 
would when entered by itself on the command line. Other operating system commands, 
such as those that delete or rename files can also be included in the script file. 

Tip: VERICUT batch files can be easily created using VERICUT's Batch Wizard. 

Windows batch script files 
A batch file to be run on Windows is named with a ".bat" extension, for example 
"batchfile.bat". Windows NT batch execution lines in the script file are "called" via the 
"call" command to return control to the script file after each VERICUT execution. The 
examples that follow show two sample script files. 
 
Windows XP batch script file examples: 

 
Example 1 executes two batch sessions, each processing a part unrelated to the other. 
 

call vericut batch "vcp=part1.VcProject" 
call vericut batch "vcp=part2.VcProject" 

 
Example 2 represents a part machined in two setups: the first is configured to 
automatically save an In-process file named "setup1.ai" via the AutoSave function. 
The second uses the ip=<ipfile> option to load the "setup1.ai" In-process file so 
cutting can be continued with the session configuration saved in the 
"setup2.VcProject" project file. 
 

call vericut batch "vcp=setup1.VcProject" 
call vericut batch "vcp=setup2.VcProject" "ip=setup1.ai" 

 
 
UNIX batch script files 
A batch script file to be executed in UNIX must have "executable" permissions. Use the 
"chmod" command to give the file executable permissions, for example the following 
command makes a file named "batchfile" executable by all users: chmod 777 batchfile 
The "batchfile" file is executed via typing the file name on the command line, for 
example type: batchfile. The examples that follow show two sample script files.  
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UNIX batch script file examples: 
 
Example 1 executes two batch sessions, each processing a part unrelated to the other. 
 

vericut batch vcp=part1.VcProject 
vericut batch vcp=part2.VcProject 

 
Example 2 represents a part machined in two setups: the first is configured to 
automatically save an In-process file named "setup1.ai" via the AutoSave function. 
The second uses the ip=<ipfile> option to load the "setup1.ai" In-process file so 
cutting can be continued with the session configuration saved in the 
"setup2VcProject" project file. 
 

vericut batch vcp=setup1.VcProject 
vericut batch vcp=setup2.VcProject ip=setup1.ai 
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CGTECH Macro Executable File 
 

Typical file extension: .cme 

  

A platform-independent binary file also known as a "CME file", that is created using the 
C Macro Extension – Application Programming Interface, or CME–API (ref. CME-
API in the VERICUT Development Tools section, in the CGTech Help Library) and 
contains custom macros that control processing G-Code data. In addition to macros, this 
file can also establish modals which allow users to further customize how machine code 
data is interpreted, and provide access to custom tables containing job and machine 
related data. The CME file used to perform these tasks is specified via the Advanced 
Control Option window: Dev Kit CME tab (ref. Advanced Control Option window: 
Dev Kit CME tab, in the Configuration Menu section of VERICUT Help). 
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Control File 
 

Typical file extension: .ctl 

 

An ASCII text file that contains data describing how the NC control processes G-Codes. 
Data in this file includes: a list of interpretable machine codes, machine code format 
information, rules for grouping machine codes, and rules for calling macros. This file is 
required to interpret G-Code data via the G-Code Data NC program type. When the C 
Macro Extension – Application Programming Interface, or CME–API (ref. CME-
API in the VERICUT Development Tools section, in the CGTech Help Library) is used 
to create a custom CME file, the Control file can also specify a custom CME file to assist 
with the simulation. 

By default, VERICUT is configured with a "Fanuc" control. Many control configurations 
are available in the library that is installed with VERICUT software- see "Library 
Control Files" for more information. 

A different Control file can be loaded into VERICUT via the Configuration  menu > 
Control > Open function. NC control configurations are changed via other "Control" 
functions in the Configuration menu. Save the new file via Configuration menu > 
Control > Save As. 

 

Encrypted Control Files 
A "standard" encrypted (X-File) control file: 

• has a .xctl extension 

• works with a standard VERICUT license. 

• is a compressed binary file. 

• contains all files referenced by the Control file (no external subroutines). 

• simulates exactly the same as a standard control file (.ctl) 

• disables the Configuration menu features when used in a setup. 

• can be created by any user. 

• can not be decrypted/expanded except by CGTech so retain your original control 
(.ctl) file  
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A "limited" encrypted (X-File) control file: 

• has a .xctl extension 

• works only for a specific customer with a VERICUT Limited license. 

• is a compressed binary file. 

• contains all files referenced by the Control file (no external subroutines). 

• disables the Configuration menu features when used in a setup. 

• can only be created by CGTech. 

• can not be decrypted/expanded except by CGTech. 
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Control Report File 
 

Typical file extension: .rpt 

  

An ASCII text file that contains information about how the current NC control 
configuration will interpret various codes. Reported information includes: 

G-Codes present in the NC program and macros (actions) the control will perform, 
variables used (if any), cutting tools used, subroutines defined and referenced, and more. 
Control Report files are created via the Info menu > Control Report function. 

  

Sample Control Report file: 
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CSYS File 
   
An ASCII text file containing information necessary to create a VERICUT Coordinate 
System using the CSYS from File feature in the Coordinate System window. The file 
contains a collection of APT CL matrices, possibly with different syntaxes in a single 
file. The CSYS File is also used by the csys_file command line argument. 
 
  
The CSYS file may contain one or all combinations of: 
  
CATIA syntax: 
   

$$*CATIA0 
$$*AXS1 
$$     1.00000 ... 
 
Use "$$*AXS xx" to name the coordinate system, for example "AXS1" in the above 
snippet. 

  
 
NX syntax: 
  

TOOL PATH/P1 
. 
. 
MSYS/ ... 
 
Use "TOOL PATH/ xx" to name the coordinate system, for example "P1" in the 
above snippet. 

  
PTC syntax: 
  

$$-> FEATNO / 102 
. 
. 
TRANS / ... 
$$-> CSYS / ... 
 
Use "FEATNO / xxx" to name the coordinate system, for example "102" in the above 
snippet. 
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VERICUT-MATRIX syntax: 
 
Modify the syntax to allow an optional name. The code needs to support both with a 
quoted name string and without. 
 

PPRINT/VERICUT-MATRIX "name" 1,0,0 ... 
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Design Points File 
 

Typical file extension: .pts 

  

An ASCII text file, also known as an "inspection point file", that contains point locations 
used to inspect the VERICUT model when performing an AUTO-DIFF Point comparison 
operation. 

Design Point files are loaded into VERICUT via the Project menu > Setup Models > 
Define function. Point record formats support specifying surface normals, tolerances, and 
check distances with any or all inspection points. Example point record formats follow. 

 

Design Points file record formats: 

GOTO/X,Y,Z — where "X,Y,Z" represents the design point location, for example: 
"GOTO/1,2,3". 

 

GOTO/X,Y,Z,I,J,K — as above plus "I,J,K" represents the surface normal vector, for 
example: "GOTO/1,2,3,1,0,0". 

 

GOTO/X,Y,Z,I,J,K,intol,outtol — as above plus "intol" and "outtol" override the 
Gouge Tolerance and Excess Tolerance values, for example: 
"GOTO/1,2,3,1,0,0,.0005,.015". The overrides are only applied to the point where they 
are listed. 

 

GOTO/X,Y,Z,I,J,K,intol,outtol,incheck,outcheck — as above plus "incheck" and 
"outcheck" override the Gouge Check Distance and Excess Check Distance values, for 
example: "GOTO/1,2,3,.1,0,0,.015,.015,.300,.300". The overrides are only applied to the 
point where they are listed. 

 

Any combination of the above formats can be included in the Design Points file. There is 
no limit to number of records that the file can contain. "$$" comment records and spaces 
are permitted. 



VERICUT HELP - Getting Started with VERICUT 
 

Sample Design Points file: 
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Die Sinking Simulation Report File 
 

Typical file extension: .htm 

  

An HTML file that contains data describing a particular die sinking process. 
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G-Code Log File 
 

Typical file extension: .log 

  

An ASCII text file that contains error, warning and informational messages about G-
Code processing. One of the most valuable pieces of information this file provides is a 
copy of each input G-Code data block followed by the converted ASCII APT NC 
program record indented by 4 spaces. This allows you to see a direct translation of G-
Code versus equivalent ASCII APT output for all NC program records processed. 

G-Code Log files are created when a name is entered in the Project menu > Processing 
Options > G-Code > Process Options: G-Code Output File tab, Log File field, and 
are viewed via Project menu > Processing Options > G-Code > Process Options: G-
Code Output Files tab, View G-Code Log File.  

For help with interpreting error and warning messages in this file, visit the VERICUT 
Users' Forum or contact CGTech technical support via our website, just click on the 
support link. 

  

Sample G-Code Log file: 

 
 

http://cgtech.com/forum/
http://cgtech.com/forum/
http://cgtech.com/
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G-Code Report File 
 

Typical file extension: .rpt 

  

An ASCII text file that contains information about how the current NC control 
configuration will interpret a G-Code NC program file. Reported information includes: 
G-Codes present in the NC program and macros (actions) the control will perform, 
variables used (if any), cutting tools used, subroutines defined and referenced, and more. 
G-Code Report files are created via the Info menu > G-Code Report function. 

  

Sample G-Code Report file: 
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IGES Model File 
 

Typical file extension: .igs 

  

An IGES (Initial Graphics Exchange Specification) model file, also known as an "IGES 
file", is an ASCII text file which describes virtually anything that can be modeled in a 
CAD system. IGES data is widely accepted as an industry standard for transferring model 
data. While IGES model files containing only 2-D data (lines and arcs) are not useful in 
VERICUT, files containing 3-D surfaces and solids can be used to describe stock, fixture, 
or design models, as well as machine component shapes. 

IGES model files are imported into VERICUT via the Project menu > Setup Models > 
Define function, or can be converted into STL or VERICUT Polygon model files using 
the IGES converter. 
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Image File 
 

Typical file extension: .img 

  

A platform-independent binary file that contains recorded images of a NC program 
simulation. Image files can contain any combination of snapshot (single still image) and 
animation images (similar to a movie). These files can be recorded and replayed on any 
supported computer platform. 

Two types of VERICUT images can be recorded. Both types can be recorded into the 
same file. Machining status is automatically recorded with either image type. 

Snapshot — single-frame image. These images are also used to mark stop points in an 
animation. 

Animation — multiple images that when replayed, appear like a simulation (like a 
movie). 

Image files are saved (recorded) via the File menu > Images > Record Movie function, 
and replayed via File menu > Images > Playback VERICUT Movie. 

  

NOTE:  Image files are not intended for printing. Use File menu > Print View or File 
menu > Images > View Capture to print VERICUT images. 

 



VERICUT HELP - Getting Started with VERICUT 
 

 

In-Process File 
 

Typical file extension: .ip 

  

A part ASCII text-part binary file also known as an "IP file" that contains the data 
necessary to re-establish a VERICUT session, including the current VERICUT model 
(with cuts), user interface settings, and a copy of the Log file. IP files are also used to 
"backup" the verification session, safeguarding against lost work if the session is 
interrupted by computer or power failure. 

Save an In-process file interactively via File menu > In Process > Save As, or 
automatically via the File menu > AutoSave function. You can also save an IP file using 
the SAVE_IP, VERICUT-COMMAND record (ref. to VERICUT-COMMAND Record 
in Automating VERICUT, in the CGTech Help Library). Due to differences in math 
processing on various computer types, IP files are usable on computers of the same type 
on which they were saved. 

In-Process (IP) files are by default compressed when they are saved. VERICUT can read 
these compressed files directly. 

To disable writing compressed IP files, set the environment variable 
CGTECH_COMPRESS=IP (ref. Environment Variables in the VERICUT Help section, 
in the CGTech Help Library for additional information). 

Load IP files via File menu > In Process > Open to re-establish a VERICUT session or 
provide a VERICUT model for additional machining and analysis. IP files can also be 
specified on the command line when VERICUT is executed, such as during batch 
processing to simulate NC programs without user interaction. 

  

NOTE:  Environment variables can be used to affect VERICUT's use of IP files. For 
more information, see Environment Variables in the VERICUT Help section, in the 
CGTech Help Library for additional information. 
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Inspection Sequence Custom Tolerance File 
 

Typical file extension: .txt 

  

A custom inspection tolerance file is an ASCII text file that contains default tolerances 
that are automatically used when creating inspection record in an Inspection Sequence 
data table. 
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Inspection Sequence File 
 

Typical file extension: .VcInspect 

  

An inspection sequence file is an XML (Extensible Markup Language) text file used to 
retain all the information needed to reproduce the Inspection Sequence data table and the 
corresponding inspection markers on the workpiece for a single inspection report. 
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Log File 
 

Typical file extension: .log 

  

An ASCII text file that contains information about a VERICUT session, such as: names 
of NC programs processed, errors, warnings, simulated machining times, and other 
informational messages. 

When VERICUT is run, it must always be able to open a Log file. When an existing Log 
file of the same name is found VERICUT responds differently, depending on the run 
mode: 

VERICUT run in interactive mode — Log file is automatically reset, unless the 
"append log" command line option is used. 

VERICUT run in batch mode — Log file is automatically reset, unless the "reset log" 
command line option is used. 

For more information on command line options used with VERICUT, see "Command 
line options for VERICUT". 

Using the Info menu > VERICUT Log function, Log file contents can be viewed, 
edited, or the file name changed. For help with interpreting error and warning messages 
in this file, visit the VERICUT Users’ Forum or contact CGTech technical support via 
our website, just click on the support link.  

http://cgtech.com/forum/
http://cgtech.com/
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Sample VERICUT Log file: 
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Machine File 
 

Typical file extension: .mch 

  

An ASCII text file that contains data describing the construction, kinematics, and other 
properties of an NC machine tool. By default, VERICUT is configured with a 3-axis 
vertical mill machine. Many machine configurations are available in the library that is 
installed with VERICUT software- see Library Machine Files in the VERICUT Files 
section for more information. 

A different Machine file can be loaded into VERICUT via the Configuration menu > 
Machine > Open function. NC machine configurations are changed via other "Machine" 
functions in the Configuration menu. Save the new file via Configuration menu > 
Machine > Save As. 

 

Encrypted Machine Files 
A "standard" encrypted (X-File) machine file: 

• has a .xmch extension 
• works with a standard VERICUT license. 
• is a compressed binary file. 
• contains all files referenced by the Machine file (no external models). 
• simulates exactly the same as a standard machine file (.mch) 
• disables the Configuration menu features when used in a setup. 
• can be created by any user. 
• can not be decrypted/expanded except by CGTech so retain your original 

machine (.mch) file  

 
A "limited" encrypted (X-File) machine file: 

• has a .xmch extension 
• works only for a specific customer with a VERICUT Limited license. 
• is a compressed binary file. 
• contains all files referenced by the Machine file (no external models). 
• disables the Configuration menu features when used in a setup. 
• can only be created by CGTech. 
• can not be decrypted/expanded except by CGTech. 
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NC Program File 
 

Typical file extension: .mcd (G-Code), .tp (APT), many other extensions depending on 
CAM system 

  

NC program, or "NC program" files are ASCII text files that contain data describing 
cutting tool positions, machine information, and other information required to operate NC 
machine tools. 

NC program files to be simulated or optimized are referenced in VERICUT via the 
Project menu > NC Programs function. VERICUT does not actually keep a copy of the 
NC program files, but instead stores NC program file names and keep tracks of which 
record in the file is being processed. 

NC programs files can be divided into two general types: APT-CLS NC and G-Code. A 
general discussion of each type follows. 

 



VERICUT HELP - Getting Started with VERICUT 
 

 

APT-CLS NC program files 
 

APT and CLS NC program files are generic file formats output by CAM systems that are 
intended to be easily read by the NC programmer. They are intermediate file formats that 
typically are not used directly by the NC machine. Before the data can be used by an NC 
machine these files must be post-processed to a G-Code NC program file format 
containing codes specific to that machine tool (see "G-Code NC program files" below). 

VERICUT processes "Simple ASCII APT" NC programs-meaning all macros, motion 
commands, and motion copy routines are pre-processed into an ASCII centerline file 
containing GOTO, CIRCLE, CYCLE, and miscellaneous machine commands. No 
geometry definitions, symbolic substitutions, macros, or complex motions (such as 
GORGT, GOLFT, etc.) are present. 

Common APT-CLS NC program variations that VERICUT can process are listed below. 

ACL 
CADRA CL data 
CATIA workstation APT 
CV APT 
ProManufacturing APT 
UG CLS 

To process one of the APT-CLS NC program variations listed above, be sure to specify 
the appropriate NC Program Type under Project menu > NC programs. 
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G-Code NC program files 
 

G-Code NC program files are formatted for use directly by the NC machine. These files 
typically originated as APT-CLS NC program files (see "APT-CLS NC program files" 
above), and have been post-processed to contain specific codes for a given machine tool. 

To process G-Code NC program file, be sure to specify NC program Type=G-Code Data 
under Project menu > NC programs. While VERICUT easily processes G-Code data 
that conforms to the EIA Standard RS-274 format, other variations can also be simulated 
with a little configuration effort. Configuration menu functions provide most of the 
configurability needed to support various NC machine and control combinations. 
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Operations File 
 

Typical file extension: .VcTmp 

  

Introduction 
An Operations File, or Ops File, can be used to assemble a project with multiple setups 
from several VERICUT project files, which typically have the extension ".VcProject". 
This assembly process can only be triggered from the command line that invokes 
VERICUT. The necessary command line syntax is;  

  

For Windows ... "ops=D:\My\Path\MyOperationsFile.VcTmp"   ... 

For UNIX ... "ops=/My/Path/MyOperationsFile.VcTmp"   ...   

  

Any extension can be used in the file name, but by convention ".VcTmp" denotes a 
temporary file.  

 An Operations File is a man-readable text file. Each line of the file is independent and 
references a VERICUT project file. A line requests that information from its project file 
should be transferred to the project being assembled. A line can request that the entire 
project and all its setups be transferred, or that information from one setup be transferred, 
or that all the setup-independent information, which we will refer to as project 
information, be transferred. It is suggested that the first line of the file should always 
request at least the project information from a ".VcProject" file that was saved by 
VERICUT, so that the new project will have a good foundation.  

  

Syntax 
In the following explanation the Windows path delimiter, "\", is used. For a UNIX 
platform you should substitute the "/" character. Names should be enclosed in double 
quotation characters ("). Fields are separated by one or more spaces.  

 To request that the entire project, with all its setups, be transferred to the new project 
being assembled, the syntax of the required line is;  

 
ALL   FILE="My\Path\MyProjectTemplate.VcProject" 
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To request that the project information from a file be transferred to the new project being 
assembled, the syntax of the required line is;  

  
PROJECT   FILE="My\Path\MyProjectTemplate.VcProject"  
  

Setup independent information in a project file pertains to the following VERICUT menu 
items;  

Model Export  
Colors  
Image Recording and Playback  
View Capture  
AutoSave  
View Select/Store  
Status  
Graphs  
Cycle Definitions  
AUTO-DIFF  

  

To request that setup information from a file be transferred to the new project, the syntax 
of the required line is;  

  
SETUP  NAME="Setup A"  INDEX=1 SETUP=1  MERGE_TOOLS FILE="\Path\Tmp.VcProject"  

 

The NAME field specifies the name that the setup will have in the new project. The 
INDEX field selects which of the setups in the referenced file will be transferred. An 
index value of "1" selects the first setup in the file, "2" would use the second setup, 
etcetera. The INDEX field is optional and defaults to 1 if not present. The SETUP=n field 
specifies the index of the setup in the merged file that this line refers to. It is optional and 
is only required if the MERGE_TOOLS field is present.  The MERGE_TOOLS field 
specifies that the tool library associated with the setup being imported should be merged 
with the current tool library rather than overwriting it. This field is optional. The FILE 
field references the VERICUT project file that contains the required setup.  

Note that more than one SETUP line in the Operations File can have the same NAME 
field. The first such line would cause a new setup to be appended to the project being 
assembled, and subsequent lines could adjust the parameters of that same setup. Setup 
specific information in a project file pertains to the following VERICUT menu items;  

Properties  
Views  
Sections  
Components and Models  
NC Programs and Filters  
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Tools and Tool Changes  
APT and G-Code Settings  
Coordinate Systems  
Control  
Machine  
Inspection  
Die Sinking  
OptiPath  

  

Project Naming 
The name and location of the assembled project file will be derived from the name and 
location of the Operations File. The extension ".VcProject" will replace any extension 
that the Operations File's name has, and the assembled project will be placed in the same 
folder. This assumes that the user saves the project before explicitly renaming it and 
before exiting VERICUT. To remind the user that he needs to save the project before 
exiting, you can include another keyword on the command line. Thus you may have;  

  

...   "ops=D:\My\Path\MyOperationsFile.VcTmp"   usr_changed   ...  
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Optimized File 
 

Typical file extension: .opti, .mco (G-Code NC program file) or .tpo (APT NC program 
file) 

  

The Optimized NC program file is created from optimizing NC program feed rates via 
OptiPath. 

For details about using OptiPath and sample optimized NC program files, see the 
OptiPath menu functions. 
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OptiPath Library File 
 
Typical file extension: .olb 

  

An ASCII text file that contains optimization data for use by VERICUT's OptiPath feed 
rate optimization module. Specific optimization data values are defined per tool intended 
to be used in specific machining conditions, e.g. workpiece material, NC machine, etc. 

  

NC program optimization can performed in a variety of ways, including: configuring 
cutting tools-to-optimization library records, storing optimization information with tools 
in a VERICUT Tool Library, or interactive prompting. 
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Post-Processor File 
 

Typical file extension: .VcPost 

  

A Post-Processor file is an ASCII text file, created using the CGTech Post Processor, 
containing all the information required to read machine independent NC Program data 
and convert it to G-Code files for a specific machine/control combination. 
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Preferences File 
 

Typical file extension: .prefs 

  

Also known as a "Prefs file", this ASCII text file is automatically saved when you exit 
VERICUT and stores such user preferences as: 

 

• VERICUT user interface Look & Feel 
• size and locations of VERICUT windows 
• state of menu toggles in any window that has them, for example: View menu > 

Toolbar, View Axes, etc. 
• filters for VERICUT file selection windows 
• recent User/Project files opened in VERICUT 

 

The Preferences file is unique for each VERICUT version and each user, based on your 
login. The file is named "cgtech_user.prefs" for VERICUT 5.0, and follows the naming 
convention "cgtech_<ver#>_user.prefs" for subsequent versions. For example, a Prefs file 
for VERICUT 5.1 has the name "cgtech_51_user.prefs". The Prefs file is automatically 
stored in your home directory and are updated each time you exit VERICUT. When you 
run a new VERICUT version for the first time (no Prefs file exists for that version), it 
will attempt to use the Prefs file from the previous version. 

When users share a machine (or an account), CGTech recommends that each user set a 
unique CGTECH_USERNAME environment variable to prevent overwriting the 
Preferences file. See "Environment Variables" for more information. 

 

To reset Preferences file settings: 
Windows — Choose Reset VERICUT Preferences file from the CGTech programs 
group. 

UNIX — Delete the "cgtech_user.prefs" from your home directory, or run the 
"delprefs" command file located in the ...<computertype>/commands directory of 
your VERICUT installation. 
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Sample Preferences file "cgtech_user.prefs": 
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Project File 
 

Typical file extension: .VcProject 

  

A VERICUT Project file is an XML (Extensible Markup Language) text file containing 
VERICUT session settings, also known as "user configuration values" or "user values", 
including: measurement units, colors, choices, data field values, directory paths and file 
names, etc. These files are relatively small in size, yet can control the entire cutting 
process and minimize the effort required to configure the system for processing NC 
program files. 

 Project files are saved via the File menu > Save Project function, and loaded via File 
menu > Open. User files can also be specified on the command line when VERICUT is 
executed, such as during batch processing to simulate NC programs without user 
interaction. 
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Report Template File 
 

Typical file extension: .VcTemplate 

  

A Report Template file is an XML (Extensible Markup Language) text file containing all 
of the formatting information required to generate VERICUT reports. 
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Status File 
 

Typical file extension: .txt 

  

An ASCII text file that contains whatever data is sent to the Status window during the 
simulation (ref. Info menu > Status). A Status file is created when the 
CGTECH_STATUS environment variable is set to a file name before VERICUT is 
executed. The file is overwritten when the VERICUT model is reset. 

For each NC program record processed, the following status data is written: 

REC — Indicates a NC program record processed. 

REC fields — NC program Record Line Number, NC program Record 

DATA — Specifies most of the status values separated by commas. Fields not 
displayed in the Status window are represented by commas. 

DATA fields — Mch Axis Loc- X, Y, Z, A, B, C, U, V, W, Tool Tip Loc- X, Y, Z, I, 
J, K, Errors, Warnings, Time, Time%, Dist, - Dist%, Coolant, Feedrate, OP Feedrate, 
Spindle, OP Spindle 

TOOLCHANGEREC — The record which caused the last tool change (present only 
if the Status window is configured to show this field). 

TOOLDESC — The current tool description (present only if the Status window is 
configured to show this field). 

TOOLGEOMETRY — The current tool geometry (present only if the Status 
window is configured to show this field). 

  

APT example: 

REC,12,GOTO/3,2,1 
DATA,,,,,,,,,,,,,,,,3,,,,0,0,0.5355,,,,ON ,10 IPM,,500,CLW , 
TOOLCHANGEREC,CUTTER/1.125,.25,0,0,0,0,2.1 

  

G-Code example: 
REC,20,N0130G0X-.2Y-.3Z2.S1200M3 
DATA,,,,,,,,,,,,,,,,19,,,4,0,0,1.6979,,,,OFF,2 IPM,,1200, 
TOOLCHANGEREC,N0120T4M6 

 



VERICUT HELP - Getting Started with VERICUT 
 

 

Stereolithography (STL) Model File 
 

Typical file extension: .stl 

  

A Stereolithography model file, also known as an "STL" or "SLA" file, is an ASCII text 
or binary file which describes virtually any surfaced or solid model shape. The STL data 
representing the model shape is composed of three-sided facets with associated surface 
normals. STL files typically originate from a CAD system and represent an enclosed 
model used by an SLA machine, such as developed by 3D Systems. 

Load Stereolithography model files into VERICUT via the Project menu > Setup 
Models > Define function. For an STL file to be used in VERICUT as a solid model, the 
STL data must represent a fully enclosed (watertight) model and have normals that point 
consistently outward. (STL files used as surface models do not have to be watertight.) If 
normals are inconsistent, gaps exist between facets, or facets overlap, solid model display 
results are unpredictable. When cutting is started or the model is analyzed, these 
symptoms indicate problems exist in the model file data: 

• model is not displayed at all 

• model is displayed with holes, gaps, or seams 

• portions of the model are missing 

  

Tip:  If any of the above symptoms are experienced, use the PolyFix Converter and/or 
the Stock Consistency Check feature (ref. File menu > Properties: General tab) to 
repair the model before cutting. Similar advice applies for models added to Design 
components for use with AUTO-DIFF, except the Design Consistency Check feature is 
used (ref. Analysis menu > AUTO-DIFF: Options tab). 
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Sample STL file: 
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Tool Library File 
Typical file extension: .tls 

  

An ASCII text file that contains descriptions of cutting tools, shanks and holders, as well 
as other tool data used by VERICUT. Specific tool data is stored and retrieved via a tool 
"ID". 

This file is created and maintained via the Project menu > Tools function. The Tool 
Library file used by VERICUT when the Project menu > NC programs function is 
configured to do so. 

NOTE:  If errors occur when attempting to load the file, visit the VERICUT Users’ 
Forum or contact CGTech technical support via our website, just click on the support link 
for assistance. 

  

Sample VERICUT Tool Library file: 

 
 

http://cgtech.com/forum/
http://cgtech.com/forum/
http://cgtech.com/
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Tool Manager Report File 
 

Typical file extensions: .htm (HTML version), .txt (test version) 

  

An HTML or text file that contains information about tools in a VERICUT Tool Library 
file, such as: the Tool Library name, listing of tools, tool images (HTML version only), 
and optimization properties, if defined. Tool Manager Report files are created and viewed 
from the Tool Manager window via clicking File menu > Create Report features. 

  

Sample HTML version Tool Manager Report file: 
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Sample text version Tool Manager Report file: 
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User File 
 

Typical file extension: .usr 

  

An ASCII text file that contains VERICUT session settings, also known as "user 
configuration values" or "user values", including: measurement units, colors, choices, 
data field values, directory paths and file names, etc. These files are relatively small in 
size, yet can control the entire cutting process and minimize the effort required to 
configure the system for processing a NC program file. 

User files are loaded via File menu > Open. User files can also be specified on the 
command line when VERICUT is executed, such as during batch processing to simulate 
NC programs without user interaction. 

  

Sample User file: 
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Within the User file, the left column contains descriptive information about user 
variables, the center column lists the user variable names, and the right column lists saved 
values for corresponding user variables. 

Use the user variable names listed in the center column when referencing via command 
line options. For more information, see "Command Line Options". 

 

NOTE:  Environment variables can be used to affect VERICUT's use of User files. For 
more information, see "Environment Variables". 
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VERICUT Linear Sweep File 
 

Typical file extension: .swp 

  

A VERICUT Linear-sweep file, or "Linear-sweep file" for short, is an ASCII text file that 
describes an extruded shape. A 2-D profile is defined in the XY plane, then swept 
(extruded) along the model's Z axis. 

Linear-sweep files are loaded into VERICUT via the Project menu > Setup Models > 
Define function, and contain the following data: 

File type record — Specifies the type of VERICUT file, for example "VERICUT-
model". 

Version number record — Software version in which the file is to be used, for 
example "version-3.0". 

Model file identifier record — Model file type: "2" identifies a Linear-sweep file. 

Sweep start value — Z value of the linear sweep start. 

Sweep end value — Z value of the linear sweep end. 

Polyline data — The remaining records in the file are the XY point pairs which 
define the polyline to extrude. Each X and Y value must be on a separate line with a 
space between values. There is no limit on the number of point pairs allowed, but 
there must be at least 3 pairs. The polyline can be completely enclosed or open ended, 
but can not cross over itself. Open ended polylines are automatically closed to the 
start point. 
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Sample Linear-sweep files: 
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VERICUT Polygon File 
 

Typical file extensions: design- .dsn, fixture- .fix, stock- .stk, any- .ply 

  

A VERICUT Polygon file, or "Polygon file" for short, is an ASCII text file that describes 
virtually any shape open surface or enclosed shape. The polygon (faceted) data is 
composed of three or four sided polygons with associated surface normals that represent 
the true geometric model shape. 

Load Polygon model files into VERICUT via the Project menu > Setup Models > 
Define function. For a Polygon file to be used in VERICUT as a solid model, the polygon 
data must represent a fully enclosed (watertight) model and have normals that point 
consistently outward. (Polygon model files used as surface models do not have to be 
watertight.) If normals are inconsistent, gaps exist between facets, or facets overlap, solid 
model display results are unpredictable. When cutting is started or the model is analyzed, 
these symptoms indicate problems exist in the model file data: 

 
• model is not displayed at all 
• model is displayed with holes, gaps, or seams 
• portions of the model are missing 

 

 Tip:  If any of the above symptoms are experienced, use the PolyFix Converter and/or 
the Stock Consistency Check feature (ref. File menu > Properties, General tab) to 
repair the model before cutting. Similar advice applies for models added to Design 
components for use with AUTO-DIFF, except the Design Consistency Check feature is 
used (ref. Analysis menu > AUTO-DIFF, Options tab). 

  

Polygon file format: 
File type record — Specifies the type of VERICUT file, for example "VERICUT-
model". 

Version number record — Software version in which the file is to be used, for example 
"version-3.0". 

Model file identifier record — Model file type: "1" specifies a Polygon file. 

Sweep start value — Z value of the linear sweep start. 

Sweep end value — Z value of the linear sweep end. 
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Polygon format record — Describes the surface normal data and vertex data formats. 
This record contains three integer numbers separated by blanks: n1 n2 n3 (e.g. "0 0 1") 
where: 

n1 (normal vector type) — Specifies the type of surface normal vector information 
present in the polygon file. 

 
0 - each polygon has one normal vector 
1 - each vertex has a normal vector 
 

n2 (normal vector direction) — Specifies the surface normal vector direction 
relative to the model surface. 
 

0 - normal vectors point inward 
1 - normal vectors point outward 
2 - normal vector directions are inconsistent (should ONLY be used after both the 

"0" and "1" values have been attempted with unfavorable results; requires 
significantly more processing time and computer resources) 

 
n3 (Polygon format type) — Specifies the polygon data format. 
 

0 - binary data format (recommended- requires less storage space and is processed 
faster, however, binary formatted files are computer-specific) 

1 - ASCII data format 
 

Polygon data — The remaining records in the file are the polygon data records which 
define the model shape. Each model facet (or polygon) is represented by a series of 
records describing its number and location of vertices, as well as surface normal vector 
direction(s). There is no limit on the amount of data allowed. 

Two polygon data formats are supported. The polygon data type must be consistent for 
the entire file. 

Format 1 - 1 normal per polygon: 

vertex count (3 or 4) 
X Y Z (vertex 1) 
X Y Z (vertex 2) 
X Y Z (vertex 3) 
I J K (normal) 
 

Format 2 - 1 normal per vertex: 

vertex count (3 or 4) 
X Y Z (vertex 1) 
X Y Z (vertex 2) 
X Y Z (vertex 3) 
I J K (normal 1) 
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I J K (normal 2) 
I J K (normal 3) 

  

Sample Polygon file: 
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VERICUT Solid File 
 

Typical file extension: .vct 

  

A VERICUT Solid file is a binary file containing data representing a cut stock model. 
The VERICUT Solid enables you to use a previously created cut stock model in a new 
VERICUT session as a stock, fixture or design model. You can also use a VERICUT 
Solid as a design model for Constant Gouge Check. 

A cut stock model can be saved as a VERICUT Solid using either File menu > Save Cut 
Stock > VERICUT Solid in the VERICUT Menu Bar, or using the File > Save Cut 
Stock option in the Configuration menu  > Component Tree window, or automatically 
via the File menu > AutoSave function. You can also save a VERICUT Solid file using 
the SAVE_VCT, VERICUT-COMMAND record (ref. to VERICUT-COMMAND 
Record in Automating VERICUT, in the CGTech Help Library). 

VERICUT Solid (.vct) files are by default compressed when they are saved. VERICUT 
can read these compressed files directly. 

To disable writing compressed VERICUT Solid files, set the environment variable 
CGTECH_COMPRESS=NO (or IP). (ref. Environment Variables in the VERICUT 
Help section, in the CGTech Help Library for additional information). 

A cut stock model can be saved as a VERICUT Solid file "with features" or "without 
features". When the cut stock model is saved "with features", the cut database and the full 
history database are stored in the VERICUT Solid file in addition to the geometry data. 

Original cut and stock colors are also preserved if the "Save With Features" option is 
used. When the file is loaded into VERICUT, the color options in the Model Definition 
window are ignored and the colors specified in the Shade Color list (ref. Color window: 
Define tab, also in the VERICUT Help section) are used. Only indices into the Shade 
Color list are stored. The actual colors displayed after loading the VERICUT Solid file 
into a new VERICUT session will only be the same if the Shade Color list is the same. 
Otherwise, the colors will be re-assigned according to the colors in the new Shade Color 
list. Pre-6.0 VERICUT Solid files are compatible and should correctly reproduce cut 
colors when the file is loaded into a V6.0, or later, VERICUT session. The original stock 
colors were not saved in the pre-6.0 VERICUT Solid files. When such a file is loaded 
into V6.0, its uncut stock colors will be assigned according to the Model Definition color 
setting for the model. 

When the cut stock model is saved "without features", only the geometry data is saved in 
the VERICUT Solid file.  

Toggle the Save with Features option, on the Save Cut Stock window, On (the default) 
or Off. 
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VERICUT Solid files are loaded into VERICUT using the Project menu > Setup 
Models > Define function.  
When a VERICUT Solid file, saved with features, is loaded into a new VERICUT 
session: 

Before cutting: 
Modeling window > Position tab >Assemble tab features, Mate and Align, 
recognize the original features saved in the VERICUT Solid. 

X-Caliper treats the VERICUT Solid in an approximated (triangulated) way, the same 
as any other primitive (Swept Solid, Solid of Revolution (SOR), etc.). 

 

When cutting begins: 
If the VERICUT Solid model was saved "with features", then the history database is 
used to create the new cut stock from VERICUT Solid model with the new settings. 
This is usually is much faster and more accurate than using a VERICUT Solid saved 
"without features", and restores all features of the original cut stock saved into the 
VERICUT Solid file. 

 

X-Caliper: 
Once the new cut stock is created, all X-Caliper measurements on a VERICUT Solid 
model, saved "with features", are exact. 

NOTES: 
1. VERICUT Solid models are not recognized in FastMill Cut Mode or when using 

AUTO-DIFF Surface. 

2. AUTO-DIFF and Die Sinking models are always saved without features (features 
are destroyed by the tolerance offsets). 
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VERICUT Solid-of-Revolution File 
 

Typical file extension: .sor 

  

A VERICUT Solid-of-revolution file, or "Solid-of-revolution file" for short, is an ASCII 
text file that describes a revolved shape. A 2-D profile is defined in the ZX plane, then 
revolved around the model's Z axis. 

Solid-of-revolution files are loaded into VERICUT via the Project menu > Setup 
Models > Define function, and contain the following data: 

File type record — Specifies the type of VERICUT file, for example "VERICUT-
model". 

Version number record — Software version in which the file is to be used, for 
example "version-5.0". 

Model file identifier record — Model file type: "0" identifies a Solid-of-revolution 
file. 

Tolerance of revolution — Chordal tolerance (intol) of the revolved surface, 
controls the S.O.R.'s degree of roundness for the model database. 

Polyline data — The remaining records in the file are the XZ point pairs which 
define the polyline to revolve. Each X and Z value must be on a separate line with a 
space between values. There is no limit on the number of point pairs allowed, but 
there must be at least 3 pairs. X values must be greater than or equal to zero. The 
polyline can be completely enclosed or open ended, but can not cross over itself. 
Open ended polylines are automatically closed to the start point. 
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Sample Solid-of-revolution files:  
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Library Files 
 

Library File Overview 
This section provides information about the library files installed with VERICUT 
("library" directory in your VERICUT installation). Library files are included in every 
installation, and include: 
 
General Purpose Library Files 
The following types of General Purpose Library Files are included: 

VERICUT default files — Default files opened by VERICUT. The files are 
configured to perform a short simulation when Play is pressed. Two sets of files 
provide demonstrations for inch (vericut.*) and metric (vericutm.*) environments. 

VERICUT initialization files — Initialization files opened by VERICUT via File 
menu > New Project. Two sets of files provide initialization for inch (init.*) and 
metric (initm.*) environments. 

 

Library Control Files 
Library Control Files are example NC machine controls intended to help you configure 
VERICUT for simulating G-Code NC Programs that run on popular NC machining 
centers.  

 

Library Machine Files 
Library Machine Files are example NC machines intended to help you configure 
VERICUT for simulating G-Code NC Programs that run on popular NC machining 
centers. 
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General Purpose Library Files  
 
The general purpose library files are listed below in alphabetical order. 
 
Library file name: Usage: Notes: 

2_axis_lathe_template_inch.vcproject 
2_axis_lathe_template_metric.vcproject
  
3_axis_mill_template_inch.vcproject 
3_axis_mill_template_metric.vcproject 
 
4_axis_mill_template_inch.vcproject 
4_axis_mill_template_metric.vcproject 

These files are 
sample template files 
to be used with the 
CAM Interfaces (ref. 
to the Converters 
and CAD/CAM 
Interfaces section, 
in the CGTech Help 
Library) 

These files are 
intended to be used as 
a starting point for 
creating your own 
template files. Change 
the machine and 
control files, and any 
settings as appropriate 
for your environment. 

init.VcProject (in), 
initm.VcProject (mm) 

Initialization files for 
VERICUT- clears 
settings from the 
prior simulation, 
then configures 
VERICUT with 
default settings for 
inch (init.*) or 
metric (initm.*) 
environments. 

Automatically loaded 
by VERICUT via 
selecting File menu > 
New Project > Inch 
(Millimeter ). 

vericut.VcProject (in), 
vericutm.VcProject (mm) 

Default files- files 
configured to 
perform a short 
simulation of a three 
setup project, using 
three different 
machines, when Play 
is pressed. 

Demonstrates how 
VERICUT identifies 
many common NC tool 
path problems. 
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Library Control Files 
 

This section describes Control files available in the CGTech library ("library" directory in 
your VERICUT installation). These files enable you to quickly configure VERICUT to 
simulate how features of various NC controls affect the machining process. A Control file 
is loaded into VERICUT via the Configuration menu > Control > Open function, or by 
opening a Project file configured to use the control. 

Available NC controls are listed below in alphabetical order, by control manufacturer and 
model. See also the accompanying notes file for details (same base file name with .txt 
extension-located in the "library" directory).  

NOTE:   Customized machines and controls can be found in the "samples" directory in 
your VERICUT installation. See "Sample-Demo Files" in the CGTech Help Library for 
more information. 

 

Control Manufacturer Control Model Control File Name 

Acramatic (by Cincinnati) 
    

  850MC acr850mc.ctl 

  950MC acr950mc.ctl 

  2100 acr2100.ctl 

  CNC PC acrcncpc.ctl 

 

Allen-Bradley     

  7320 ab_7320.ctl 

  8200 ab_8200.ctl 

  8600 ab_8600.ctl 

  9260 ab_9260m.ctl 

 

Bosch     

  CC300 bshcc300.ctl 



VERICUT HELP - Getting Started with VERICUT 
 

 

Boston Digital     

  BDC 3200 (inch) bdc3200_in.ctl 

  BDC 3200 (mm) bdc3200_mm.ctl 

 

Charmilles     

  200 Wire EDM chr200.ctl 

 

Cincinnati - see "Acramatic" 
 

    

 

Fadal     

  
CNC 88, Format 1 
("Fadal" mode) 

fad88a.ctl 

  
CNC 88, Format 2 
("Fanuc" mode) 

fad88.ctl 

 

Fanuc     

  
Series 0 fan0m.ctl (mill) 

fan0t.ctl (turn) 

  
Series 3 fan3t.ctl (turn) 

fan3tt.ctl 

  Series 5 fan5m.ctl (mill) 

  
Series 6 fan6m.ctl (mill) 

fan6t.ctl (turn) 

  Series 9 fan9t.ctl (turn) 

  
Series 10 fan10m.ctl (mill) 

fan10t.ctl (turn) 
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Series 11 fan11m.ctl (mill) 

fan11t.ctl (turn) 

  
Series 12 fan12m.ctl (mill) 

fan12t.ctl (turn) 

  

Series 15 
fan15im.ctl (model "I" mill) 
fan15it.ctl (model "I" turn) 
fan15m.ctl (mill) 
fan_15m_custom_optimizable.ctl
fan15t.ctl, (turn) 
fan15t_t.ctl (turn-turret) 
fan15t_t_ws.ctl 

  

Series 16 fan16im.ctl (model "I" mill) 
fan16it.ctl (model "I" turn) 
fan16m.ctl (mill) 
fan16t.ctl, (turn) 
fan16w.ctl (wireEDM) 
mori_seiki_mt2000sz_fan16it.ctl

  

Series 18 
fan18im.ctl (model "I" mill) 
fan18it.ctl (model "I" turn) 
fan18m.ctl (mill) 
fan18t.ctl (turn) 

  

Series 21 
fan21im.ctl (model "I" mill) 
fan21it.ctl (model "I" turn) 
fan21m.ctl (mill) 
fan21t.ctl (turn) 

  Series 30 fan30im.ctl (model "I" mill) 

  Series 31 fan31im.ctl (model "I" mill) 

  Series 32 fan32im.ctl (model "I" mill) 
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Series 150 
fan150im.ctl (model "I" mill) 
fan150it.ctl (model "I" turn) 
fan150m.ctl (mill) 
fan150t.ctl (turn) 

  

Series 160 
fan160im.ctl (model "I" mill) 
fan160it.ctl (model "I" turn) 
fan160m.ctl (mill) 
fan160t.ctl (turn) 

  

Series 180 
fan180im.ctl (model "I" mill) 
fan180it.ctl (model "I" turn) 
fan180m.ctl (mill) 
fan180t.ctl (turn) 

  

Series 210 
fan210im.ctl (model "I" mill) 
fan210it.ctl (model "I" turn) 
fan210m.ctl (mill) 
fan210t.ctl (turn) 

  Series 300 fan300im.ctl (model "I" mill) 

  Series 310 fan310im.ctl (model "I" mill) 

  Series 320 fan320im.ctl (model "I" mill) 

  Series 3000 fan3000c.ctl 

 

Fidia     

  M30 fidia_m30.ctl 

 

GEMINI 
(by Kearney & Trecker) 

    

  GEMINI-C kt_c.ctl 

  GEMINI-D gemini_d.ctl 

  GEMINI-E gemini_e.ctl 
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General Electric (GE)     

  1050MC CNC ge_1050mc.ctl 

  2000MC CNC ge_2000mc.ctl 

 

Generic (Fanuc-like) controls 
   

  
decimal generic.ctl (in) 

genericm.ctl (mm) 

  
leading zeros genlead.ctl (in) 

genleadm.ctl (mm) 

  
trailing zeros gentrail.ctl (in) 

gentrailm.ctl (mm) 

 

Giddings & Lewis (G&L) 
      see "NumeriPath" 

    

 

HAAS     

  CNC hascnc.ctl 

  MiniMill haas_minimill.ctl 

 

Heidenhain     

  Mill Plus heimplus.ctl 

  
TNC 407 hei407.ctl 

(conversational) 
hei407g.ctl (ISO) 

  
TNC 415b hei415b.ctl 

(conversational) 
hei415bg.ctl (ISO) 

  
TNC 415c hei415c.ctl 

(conversational) 
hei415cg.ctl (ISO) 
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TNC 425 hei425.ctl 

(conversational) 
hei425g.ctl (ISO) 

  
TNC 426 hei426.ctl 

(conversational) 
hei426g.ctl (ISO) 

  
TNC 430 hei430.ctl 

(conversational) 
hei430g.ctl (ISO) 

  TNC530 hei530.ctl 

 

Kearney & Trecker - see 
"GEMINI" 

    

 

Lumonics     

  Laserdyne System 94 laserdyne_94.ctl 

 

Maho - see "Phillips"     

 

Makino     

  Professional Series 3 makpro3.ctl 

  Professional Series 5 makpro5.ctl 
makpro5_mag3.ctl 

 

Mazak     

 Matrix mazak_matrix_nexus510c.ctl 

  

Mazatrol 
Fusion 
640 

maz640m.ctl (mill) 
maz640mpro.ctl (mill) 
maz640t.ctl (turn) 
maz640t_t.ctl 
maz640mpro_mazak_e650h_2000u.ctl
maz640m_mazak_nexus410a.ctl 
maz640m_variaxis.ctl 
mazak_e650h_2000u_640mpro.ctl 
mazak_nexus410a_maz640m.ctl 
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  Mazatrol 
M-2 

mazm2.ctl 

  Mazatrol 
M-3 

mazm3.ctl 

  Mazatrol 
M-32 

mazm32.ctl 

  Mazatrol 
T-2 

mazt2.ctl 

  Mazatrol 
T-3 

mazt3.ctl 

  Mazatrol 
T-32 

mazt32.ctl 

 

NUM     

  1020T num1020t.ctl 

  1040T num1040t.ctl 

  1060M num1060m.ctl 

  1060T num1060t.ctl 

 

NumeriPath (by G&L)     

  800M nph800m.ctl 

  8000L nph8000l.ctl 

  8000M nph8000m.ctl 

 

Okuma - see "OSP"     

 

Olivetti     

  MC8600 oli8600.ctl 

 

OSAI     

    osai_10.ctl 
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OSP (by Okuma)     

  OSP700L osp700l.ctl 

  OSP5000L osp5000l.ctl 

  OSP5000M osp5000m.ctl 

  
OSP7000L osp7000l.ctl 

osp7000l_t.ctl (turret) 

  OSP7000M osp7000m.ctl 

 

PaR Systems     

  Cimroc 
5000 

cimroc_5000.ctl 

 

Phillips     

  CNC 432 phi432.ctl 

  CNC 532 phi532.ctl 

 

Sinumerik (by Siemens) 
    

  3T, 3TT sin3t.ctl,   sin3tt.ctl 

  810 sin810d.ctl (810D) 

  

840 sin840c.ctl (840C) 
sin840d.ctl (840D) 
index_sin840c.ctl (840C) 
sin840d_frames.ctl 

  880M sin880m.ctl (880M) 

  FM-NC sinfmnc.ctl 
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Sundstrand     

  
Micro 
SWINC 
LM 

swilm.ctl 

  
Micro 
SWINC 
M200 

swim200.ctl 

 

Thermwood     

  
91000 
Super 
Control 

thermwood_91000.ctl 

 

Tosnuc (by Toshiba)     

  888 tos888.ctl 

 

Yasnac     

  i80m yasi80m.ctl 

  MX-3 yasmx3.ctl 
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Library Machine Files 
 

This section describes Machine files available in the CGTech library ("library" directory 
in your VERICUT installation) and CGTech sample files ("samples" directory). These 
files enable you to quickly configure VERICUT to simulate motions on various NC 
machines. Note that while library machines are generally considered ready to use, many 
of the sample machines have job-related data that may interfere when configuring for use 
with new NC tool paths. A Machine file is loaded into VERICUT via the Configuration 
menu > Machine > Open function, or by opening a Project/User file configured to use 
the machine. 

Available NC machines are listed below in alphabetical order, by manufacturer and 
model. All machines reside in the "library" directory of your VERICUT installation 
unless otherwise noted to be in "samples" or "showroom". See also the accompanying 
notes file for details (same base file name with .txt extension-located in the "library" 
directory). See "Sample-Demo Files" in the CGTech Help Library for more information. 

 

Machine 
Manufacturer 

Machine 
Model 

Thumbnail 
 

Machine File Name 

Aerostar      

  

H2200  
5ax 
horiz. 
mill 

aerh2200.mch 

 

Bohle      

  

BW120S  
5ax horiz. 
mill 

bohbw120.mch 
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Bostomatic      

  

405  
5ax vert. 
mill 

bos405.mch 

  

5ax vert. 
mill 

samples - bos5vm01.mch 

 

Charmilles      

  

Robofil 
200 4ax 
wire 
EDM 

chr200.mch 

 

Cincinnati      

  

3-spindle 
5ax 
gantry 
mill 

samples - cinci_3spindle_5ax.mch 

  

5ax dual-
tilting 
head vert. 
mill 

samples- cin5vm01.mch 

  

T30  
5ax 
horiz. 
mill 

cint30.mch (inch) 
cint30m.mch (mm), 
cint30_2.mch, 
 

 
Deckel Maho - 
see "Maho" 
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Dixi      

  

100  
4ax 
horiz. 
mill 

dix100m4.mch 

  

100  
5ax 
horiz. 
mill 

dix100m5.mch 

  

150  
4ax 
horiz. 
mill 

dix150m4.mch 

  

150  
5ax 
horiz. 
mill 

dix150m5.mch 

  

350 
TCA50S 
5ax 
horiz. 
mill 

dix350m.mch 

  

DPH-80 
4ax 
horiz. 
mill 

dixi_dph80.mch 

 

Droop and 
Rein 

  
 

  

  

DR969 
vert. 3 
spindle 
mill 

dr_dr969.mch 
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Fadal      

  

VMC 15 
3ax vert. 
mill 

fadvmc15.mch 

  

VMC 
4020 4ax 
vert. mill 

fadal_vmc4020.mch 

  

VMC 
6030 3ax 
vert. mill 

fadal_vmc6030.mch 

 

Fidia      

  

218  
5ax vert. 
mill 

fidia_218.mch 

 

Forest      

  

Flexiax 
510 5ax 
horiz. 
mill 

forfx510.mch 

 

Generic 
machines 

  
 

  

  

2ax 
horiz. 
lathe 

generic_2ax_turn.mch 

  

2ax 
horiz. 
turret 
lathe 

samples-  
2hl02.mch (shown), 
2hl03.mch 
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3ax vert. 
mill 

g3vm.mch 
generic_vmill_3ax.mch 
generic_vmill_3ax_3d.mch 

  
4ax vert. 
mill-table 
A 

Not 3-D 
g4vmta.mch 

  

3ax vert. 
mill with 
robot 
gripper 
arm 

samples -  
bars_robot.mch 

  

3ax 
horiz. 
mill/turn-
table C 

samples - 
3ht.mch 

  

4ax 
horiz. 
dual 
turret 
lathe 

samples - 
4hl02.mch (steadyrest), 
4hl03.mch (no steadyrest), 
4hl04.mch (steadyrest) 

  

4ax 
horiz. 
dual 
turret 
lathe 
with 
pick-off 
spindle 

 samples - mcdturn6.mch (robot arm 
part-grabber) 

  

4ax 
horiz. 
mill-table 
B 

library - 
generic_vmill_4ax_table_b.mch 
samples -  
4hmtb.mch (shown) 

  

4ax 
horiz. 
mill/turn-
table C 

samples -  
4ht.mch (in), 
4htm.mch (mm) 

  
4ax vert. 
mill-table 
A 

Not 3-D 
generic_vmill_4ax_table_a.mch 
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5ax 
horiz. 
mill-head 
A, table 
B 

Not 3-D 

generic_5ax_hmill_heada_tableb.mch

  

5ax 
horiz. 
mill-table 
A on 
table B 

Not 3-D 

generic_5ax_hmill_tablea_tableb.mch

  

5ax 
horiz. 
mill-table 
B on 
table A 

Not 3-D 

generic_5ax_hmill_tableb_tablea.mch

  

5ax vert. 
mill-head 
A on 
head B 

Not 3-D 

generic_5ax_vmill_heada_headb.mch

  

5ax vert. 
mill-table 
A, head 
B 

Not 3-D 

generic_5ax_vmill_tablea_headb.mch

  

9ax 
cutter 
grinder 

samples - 
9v_grind.mch 

 
 
Giddings & 
Lewis 
(G&L) 

  
 

  

    Not 3-D gl_2ax_turn.mch 

  

5ax vert. 
mill/turn-
table C 

samples- gl_5vt01.mch 

  

G60 4ax 
horiz. 
boring mill 

gl_g60.mch 
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HAAS      

  

MiniMill  
3ax vert. 
mill 

haas_minimill.mch 

  

VB-1  
5ax vert. 
mill 

hasvb1.mch 

 

Hermle      

  

C30 
5ax mill 

hermle_c30.mch 

  

C800U 
5ax mill 

hermle_c800u.mch 

 

Huron      

 KX 100 
5ax mill 

huron_kx100.mch 

 

Index    

 

G200 
4ax 
mill/turn 

index_g200.mch 
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Ingersoll      

  

Masterce
nter 4ax 
Multi-
head 
gantry 
mill-
detailed 

ingmast1.mch 

 

Kearney & 
Trecker 
(K&T) 

  
 

  

  

HB4  
4ax horiz. 
mill 

kt_hb4.mch 

  

Model 
180 4ax 
horiz. 
mill 

kt_180.mch 

 

Kuraki      

  

KBM11  
5ax horiz. 
boring 
mill 

kurkbm11.mch 

 

Maho      

  

DMU 80 
P 5ax 
horiz. 
mill 

mahdmu80.mch 

  

MH700  
3ax vert. 
mill 

mah700m.mch (mm), 
mahmh700.mch (in) 

    Not 3-D mahvrt.mch 
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DMU 
50V 5ax 
vert. mill 

dmg_dmu50v.mch 

  

DMU 60 
t 5ax vert. 
mill 

dmg_dmu60t.mch 

  

DMU 
125 P 5ax 
vert. mill 

dmg_dmu125p.mch 

  

DMU 
200 P 5ax 
vert. mill 

dmg_dmu200p.mch 

 

Makino      

  

MC1010 
5ax horiz. 
mill 

 

mak1010.mch 

 

A51 
4ax horiz. 
mill 

 

makino_a51.mch 

  

A55  
4ax horiz. 
mill 
   

makino_a55.mch 

  

A66  
5ax horiz. 
mill 

 

makino_a66.mch 

  

A77  
4ax horiz. 
mill 

 

makino_a77.mch 
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A71 
3ax horiz. 
mill 

 

makino_a71.mch 

 

Marwin      

  

Advanced 
Manufactu
ring Cell  
5ax horiz. 
mill 

 

mrwamc.mch 

 

Matsuura      

  
FX-5  
4ax vert. 
mill 

Not 3-D 
matfx5.mch 

  
MAM 
600HF 
vert. mill 

Not 3-D 
mat600hf.mch 

 

Mazak      

  

H500  
4ax horiz. mill 

mazh500.mch 

  

Super 400H 
4ax horiz. mill 

maz400h.mch 

  

E650H  
horiz. 
mill/turn 

mazak_e650h_2000u_3_jaw.mch

  

HTC 4000 
5ax horiz. mill 

mazak_htc_4000.mch 
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Nexus 410A 
vert. mill 

mazak_nexus410a.mch 

 

Nexus 510C 
3ax vert. mill 

mazak_nexus_510c.mch 

  

QTN250MY mazak_qtn250my.mch 

  

Variaxis 500 
5ax vert. mill 

mazak_variaxis500.mch 

  

  mazak_variaxis730.mch 

 

Mori Seiki      

  

Partner M-
400C1  
5ax vert. mill 

ms_m400.mch 

  

MT 2000 SZ 
multi-axis 
turning center 

mori_seiki_mt2000sz_alpha1.mch

 

Mori Seiki 
SV500 
3ax vert. 
machining 
center (with 
Tsukakoma 
TRNCB 201 
double rotary 
table) 

mori_seiki_sv500.mch 
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Motch      

  

135 VNC 
vert. turning 
center 

motch_135vnc.mch 

 

Okuma      

  

LB400 
2ax horiz. 
lathe 

Okuma_LB400.mch 

  

LB25 
2ax horiz. 
lathe 

samples - 
okulb25.mch 

 

MB-46V 
3ax vert. mill 

okuma_mb46v_osp7000m.mch 

 

SNK      

  

FSP-100V 
5ax horiz. 
mill 

snkfsp01.mch 

  

SH-200  
5ax gantry 
mill 

snksh200.mch 
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Sundstrand      

  

Omnimil OM3 
5ax vert. mill 

sunom3.mch 

  

Omnimil 
OM80  
5ax horiz. mill 

sunom80.mch 

 

Toyoda      

  

FH80  
5ax horiz. mill 

tydfh80.mch 

 

Tsugami      

  
MA3  
4ax horiz. mill Not full 3-D 

tsuma3.mch 

 

Warner & 
Swasey 

  
 

  

  

Titan  
4ax horiz. dual 
turret lathe 

ws_titan.mch 
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Sample–Demo Files 
 
See the Sample-Demo Files section in the CGTech Help Library. 
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Environment Variables  

 

You can set environment variables to help customize the VERICUT user interface, alter 
VERICUT performance, and perform other various actions. This section describes 
environment variable formats and the available environment variables that can affect the 
VERICUT simulation. 

Environment variables are typically set via CGTech command files located in the 
CGTech "commands" directory, under the directory representing your computer type. For 
example, the command files or VERICUT 6.1 installed on the "C:" drive of a Windows 
NT computer are located in the C:\CGTech61\winnt\commands directory. Environment 
variables can also be set in any other system file used to execute VERICUT. 

 
Formats 
Formats used to set environment variables differ, based on the computer's operating 
system. Consult the operating system documentation, or refer to the CGTech-installed 
command files on your computer for specific examples. 

 

Operating 
System 

Environment Variable  
Format 

Examples of Use 

Windows set 
ENV_VAR_NAME=value

set CGTECH_DEFAULT_UNITS=inch 

set 
CGTECH_LIBRARY=C:\CGTech50\library

UNIX ENV_VAR_NAME=value

export 
ENV_VAR_NAME 

(2 records required to set 
each variable) 

CGTECH_DEFAULT_UNITS=inch 

export CGTECH_DEFAULT_UNITS 

CGTECH_LIBRARY=C:\CGTech50\library

export CGTECH_LIBRARY 
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"CGTECH" Environment Variables 
Available environment variables that can affect the VERICUT simulation are listed 
below in alphabetical order. For simplicity, all examples of use below are in Windows 
format. See above for UNIX format examples. 

 

 
CGTECH_CEILING_IMAGE — Specifies the JPEG file to use as texture for the 
ceiling in OpenGL machine views. 

Example of use:  
set CGTECH_CEILING_IMAGE=C:\path\ceiling.jpg 
 

 
CGTECH_CODEC_FILTER — Enables you to remove invalid codecs from the Select 
a CODEC pull-down list in the Image Record window (File > Images > Record Movie, 
Output Format set to AVI)   
 
Example of use: 
 

set CGTECH_CODEC_FILTER=CVID Y411 
 
The above removes the CVID and Y411 options from the list. Use a blank space to 
separate options. 
 
 

CGTECH_COMPRESS — By default, In Process (IP) files and VERICUT Solid (.vct) 
files are compressed when they are saved. VERICUT can read these compressed files 
directly. CGTECH_COMPRESS enables you to disable writing compressed In Process 
files and/or VERICUT Solid files. 

Valid settings are: 

NO = no compression 

IP = compress IP files only 

VCT = compress VCT files only 

ALL = compress both IP and VCT files (Default) 

Example of use:  
set CGTECH_COMPRESS=ALL  
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CGTECH_DEFAULT_UNITS — Sets the default units for VERICUT. Specify either 
INCH or MILLIMETER 

Example of use:  
set CGTECH_DEFAULT_UNITS =MILLIMETER 

 
  

CGTECH_DISPLAY — Sets the animation display method for tool motion in the 
Workpiece view. The display is updated for animation when you start cutting or the 

refine the display ( e.g. press Refine Display  ). Changing the animation display 
method can affect simulation speed and display quality, but does not affect model 
accuracy. Results are different, based on the types of parts you cut and specified Cutting 
Tolerance.  

Options: 
 

REFINE1 — This display method creates the best quality animation image for all-
around use, but may take slightly longer to simulate with than REFINE2 (see below). 
REFINE2 — Alternate display method-fastest when a large amount of model detail 
is visible. This method is more sensitive to Cutting Tolerance than REFINE1, and is 
typically very good when the cut tolerance is small enough. 
ULTRA — Another alternate display method-this method can be faster than the 
others, but has lower display quality when compared to the default method. 
 

Example of use:  
set CGTECH_DISPLAY=REFINE2 

 
 
CGTECH_FLOOR_IMAGE — Specifies the JPEG file to use as texture for the floor in 
OpenGL machine views. 

Example of use:  
set CGTECH_FLOOR_IMAGE=C:\path\floor.jpg 

  

 

CGTECH_FONT_SIZE — Sets the font size for text appearing in the VERICUT user 
interface. Size can be given an absolute point size, or incremental value from the default 
value of "12". 

Examples of use: 
set CGTECH_FONT_SIZE=14 (sets 14 pt. font) 
set CGTECH_FONT_SIZE=+2 (also sets 14 pt. font: default 12 +2= 14) 
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CGTECH_FSB_ICONS — Environment variable CGTECH_FSB_ICONS is used to 
permit suppression of attempts to get individual icons for each branch of the file system 
tree. With "set CGTECH_FSB_ICONS=No" (or Non, Nein, Nyet or anything that starts 
with an "N") each branch will use a simple folder icon. 

Examples of use: 

set CGTECH_FSB_ICONS=No 
 

This environment variable was added to resolve a situation where VERICUT hangs when 
opening a File Selection Box  (FSB) when a Samba drive is mounted on a network. 

• If the Samba drive is mounted in Windows via a UNC path, then VERICUT's 
FSB will always hang while opening. The hang occurs the second time a 
VERICUT FSB is opened. Thus you can successfully browse to set your working 
dir, but then hang when opening the FSB to get the next file (IP, project, etc).  

• If the Samba drive is mounted in Windows via a drive letter, then the hang is 
more sporadic. But it still hangs while the FSB is opening.  

It is VERY IMPORTANT to realize that the user does not need to access the Samba drive 
for the problem to happen. It simply needs to be mounted on his computer. 

Use of this environment variable eliminates going thru Samba to get each folder's 
"desktop.ini" file. 

 
 

CGTECH_INSPECTION_TOLERANCES — Specify a fully qualified /path/filename 
of a "custom" inspection tolerance file" containing default tolerances to be used for 
Inspection Sequence. 

Example of use:  
set CGTECH_INSPECTION_TOLERANCES=C:\mydir\inspect_tolfile.txt 

  

 
CGTECH_LIBRARY — Specifies the directory location of the CGTech Library of 
machines and controls accessed via choosing the "CGTECH_LIBRARY" shortcut option 
on file selection windows. Setting this environment variable can be useful for sites that 
use their own library VERICUT machines and controls instead of that supplied on CD 
with VERICUT. The full directory path can be included.  

Example of use:  

set CGTECH_LIBRARY=C:\mylibrarydir 

 

See also:  "Where VERICUT looks for files" in the Introduction section 
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CGTECH_MACHINE_CONFIG — Enables you to turn off the display of  the 
Configuration menu, in the VERICUT menu bar. Set to FALSE to remove the display. 

Example of use:  
set CGTECH_MACHINE_CONFIG=FALSE  

 

CGTECH_MATRIX_FORMAT — Enables you to view the Matrix Tables in the 
Coordinate System window: Matrix tab, the Machine Offsets window, and the 
Modeling Window: Position tab: Matrix tab with the I, J, K values along the vertical 
axis and the X, Y, Z along the horizontal axis rather than the "default" horizontal 
orientation. 

 

Horizontal Orientation (default): 

 
  

Example of use:  
set CGTECH_MATRIX_FORMAT=VERTICAL 

  

Vertical Orientation: 

 
 

 
CGTECH_OLD_FSB — Enables you to use the more common Windows File Selection 
Box (FSB) rather than the "standard" VERICUT FSB. 

Example of use:  

set CGTECH_OLD_FSB=YES 
 

CGTECH_REF_CUTTER_LIB — Enables you to specify an external Tool Library file 
to be used as a reference library for the Milling Tool Wizard. All cutters in the specified 
tool library will be listed, by Tool ID, in the  Milling Tool Wizard's Cutter pull-down list. 

Example of use:  
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set CGTECH_REF_CUTTER_LIB=C:\path\filename.tls 
 

CGTECH_REF_EXTENSION_LIB — Enables you to specify an external Tool 
Library file to be used as a reference library for the Milling Tool Wizard. All extensions 
in the specified tool library will be listed, by Tool ID, in the  Milling Tool Wizard's 
Extension pull-down list. 

Example of use:  
set CGTECH_REF_EXTENSION_LIB=C:\path\filename.tls 

 
CGTECH_REF_HOLDER_LIB — Enables you to specify an external Tool Library 
file to be used as a reference library for the Milling Tool Wizard. All holders in the 
specified tool library will be listed, by Tool ID, in the  Milling Tool Wizard's Holder 
pull-down list. 

Example of use:  
set CGTECH_REF_HOLDER_LIB=C:\path\filename.tls 

 
CGTECH_SLM_DEBUG — Enables you to write out "client side" license problem 
debug information to a file. This must be defined before VERICUT is run. 

Example of use:  
set CGTECH_SLM_DEBUG=FILE:\path\filename 

 
CGTECH_STATUS — Creates a Status file, an ASCII text file that contains whatever 
data is sent to the Status window  during the simulation. The full directory path can be 
included with the file name. 

Example of use:  
set CGTECH_STATUS=C:\mydir\statusfile.txt 
 

CGTECH_TPEDITOR — Causes Edit Toolpath to issue a system command using the 
string content of the variable, with the current tool path file as an argument. Thus you can 
choose to run an alternate tool path editor, such as any one of the clever NC code editors 
available today. 

When you press Edit > NC Program > 'c:\path\filename.mcd', or  Project menu > NC 

Program >(list item) > right mouse click > Edit, or the Edit NC Program icon   , 
then VERICUT issues the system command: 

 

c:\program files\cooltoolpatheditor\editor.exe c:\path\filename.mcd 
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This will only work with tool path editors that can take the tool path file name as an 
argument on the command line that runs the editor. Depending on the editor's command 
syntax, it may be necessary to point CGTECH_TPEDITOR at a batch or script file that 
intercepts the tool path file name and re-formats the command as necessary. 

Example of use:  
set CGTECH_TPEDITOR=c:\program files\cooltoolpatheditor\editor.exe 

  
 

CGTECH_USERNAME — Specifies the user name to include in the name of the 
Preferences file that is automatically saved when you exit VERICUT. This environment 
variable is recommended to prevent users that share a machine (or an account) from 
overwriting the Preferences file. 

Example of use:  
set CGTECH_USERNAME=bob (Preferences file saved => "cgtech_bob.prefs") 

 
  

CGTECH_VCPROJECT — Specifies the default Project file for VERICUT. The full 
directory path can be included. 

Example of use:  
set CGTECH_VCPROJECT=C:\mydir\myprojectfile.VcProject 

  

 
CGTECH_VCUSR — Specifies the default User file for VERICUT. The full directory 
path can be included. 

Example of use:  
set CGTECH_VCUSR=C:\mydir\myuserfile.usr 

  

 
CGTECH_VIEWER — Enables you to select an external editor/viewer. 

Example of use:  
set CGTECH_VIEWER=C:\path\editor.exe 

 

CGTECH_X_WALL_IMAGE — Specifies the JPEG file to use as texture for the two 
walls having normals along plus or minus X in OpenGL machine views. 

Example of use:  
set CGTECH_X_WALL_IMAGE=C:\path\x_wall.jpg 
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CGTECH_Y_WALL_IMAGE — Specifies the JPEG file to use as texture for the two 
walls having normals along plus or minus Y in OpenGL machine views. 

Example of use:  
set CGTECH_Y_WALL_IMAGE=C:\path\y_wall.jpg 

  
 
 
Adding custom environment variables for shortcuts 
You can add your own environment variables to the beginning section of the VERICUT 
command file and have them appear in the shortcut list of file selection windows. 
VERICUT lists all custom environment variables that begin with "CGTECH_" in the 
shortcut list, and have at least one file in the directory that is recognized as a CGTech file 
type, for example a file with any of the following extensions: *.ctl, *.ip, *.job, *.mcd, 
*.mch, *.olb, *.stl, *.tls, *.tp, *.usr, or  *.VcProject 

Note that the contents of the file are not verified unless loaded by VERICUT. Just the 
existence of a file with an extension that qualifies as one of the valid CGTech file types 
(see above) is enough to make the shortcut appear in the list. 

Example 1 — The following environment variable creates a shortcut to a directory 
containing VERICUT 6.1 sample files. 

set CGTECH_61SAMPLES=C:\CGTech61\samples\vericut 
 

Example 2 — The following environment variable creates a shortcut to a directory 
containing a user's custom VERICUT files. The directory contains a file named 
"dummy.usr". 

set CGTECH_MYVERICUTFILES=E:\myvericutfiles 
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Interacting with VERICUT 
 

VERICUT main window 
The VERICUT main window is composed of distinct areas, each with different user 
interaction. The window header displays the last Project file loaded and the current 
session units (inch or millimeter). This window can be resized like most other window, 
via dragging the window header, sides or corners. 

 
Hint: Press "F1" in any VERICUT window to receive help on that window. 
 

 Menu Bar 

Graphics Area 

Message Logger 
(Dockable) 

Simulation (VCR)
Controls  Animation 

Slider 

 Status Lights Progress Bar 

Animation Controls
(Dockable) 

Toolbar  
(Dockable) 
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Also see "Overview of Using VERICUT", in the Using VERICUT section, in the 
CGTech Help Library. 
 
 

Menu Bar 
 

The menu bar, located across the top of the VERICUT window, provides easy access to 
VERICUT functions. Each menu in the menu bar contains groups of related functions. 
Left-click on any menu name to expose the list of functions available in that menu. If an 
arrow appears to the right of a function in a menu, move the mouse over the arrow to 
expose a sub-menu of additional functions. Click on the function in the menu you want to 
use. 
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VERICUT menu descriptions 
 

The menus which provide access to all VERICUT functions are listed below, followed by 
a brief description of what the menu functions do. In VERICUT Help, click VERICUT 
Menus & Functions, then open the desired menu and select the function for more 
information about each function. 

File menu — Functions in this menu open and save the most common files used in 
VERICUT, access converter products, control properties, export cut model data, and 
generate VERICUT reports. 

Edit menu — Functions in this menu enable you to edit text files, NC programs and 
control display colors. 

View menu — Functions in this menu set up the number of views, orientation (angle 
and distance) for each view, and store or select commonly used views, and set up 
other VERICUT display characteristics. 

Info menu — Functions in this menu access session information, such as the files 
currently being used, machining status, machine offsets, and log files. 

Project menu — Functions in this menu provide the functions required for "job" 
setup including the display of the Project Tree. Functions include selection of 
machines, controls, NC programs, tools, and processing options. Its features also 
enable the selection and setup of output files created by VERICUT during processing 
and customized reports. 

Configuration menu — Functions in this menu are used to build or configure NC 
machines and controls. 

Analysis menu — Functions in this menu are used to analyze and inspect the 
VERICUT model. It provides access to the following features: X-Caliper, AUTO-
DIFF, Comparator, NC Program Review, Inspection and Die Sinking Simulation. 

OptiPath menu — Functions in this menu access OptiPath-the feed rate and spindle 
speed optimization software that creates "optimized" tool paths that cut parts in the 
least amount of time. 

 
Also see  the "Using VERICUT" section, in the CGTech Help Library. 
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Tool Bar 
 

VERICUT's Toolbar provides quick and easy access to the most commonly-used 
functions/features. 

 
 

To see what is associated with a Toolbar icon, simply position the cursor over the icon 
and a tip appears, as shown with the Close Toolbar icon in the illustration above. You can 
close/open the Toolbar at any time. Using View menu > Toolbar you can also customize 
the Toolbar to suit your needs. The Toolbar is also one of the dockable features enabling 
you to be able to re-position it if you choose. See "Dockable Windows" for more 
information. 

 

To close the Toolbar: 

From the Toolbar select  (Close Toolbar). 

 

To open the Toolbar: 
Select View menu > Toolbar. 

Select Display Toolbar. 

 

To add/remove groups in the Toolbar: 
Select View menu > Toolbar. 

Clear the check, by clicking on it, to remove groups you do not want displayed. Add a 
check, by clicking in the box, for groups that you want to display. 

 

Tip: You can affect all Toolbar groups at once using the Set All / Clear All buttons. 
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Graphics area 
 

The graphics area is where solid models of the workpiece, fixtures, etc. are displayed, and 
where the simulation takes place. By default, two views are seen: a Workpiece view and 
a Machine Cut/Stock view. Using View menu > Layout you can add more views 
displaying the workpiece or NC machine (if a machine is defined). All views are 
contained within the VERICUT main window. 

 

 
 

Right-click in a view to display Shortcuts menu, as shown in the illustration below, 
enabling you to modify its attributes, such as: view type, standard modeling views, 
background, etc. Use dynamic and static view options on the Tool Bar to rotate, zoom, or 
fit the model.  
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Many other VERICUT functions enable user interactions in this area, including: picking 
models or surfaces to be measured, determining tool path records responsible for specific 
cuts, and more. 
 
See the Right Mouse Button Shortcut Menus section, also in VERICUT Help for a 
complete list of  windows where Shortcut menus are available. 
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Graphics Area Right Mouse Button Shortcut Menus 
 
Workpiece View 
Right-click in a Workpiece View to display a menu with the following features: 

 

 
 

View Type — Use to change the view type. (ref. View Attributes window, General 
tab, in the View Menu section of VERICUT Help) 

View to Back — Moves the view to the back. (ref. Layout (view), in the View Menu 
section of VERICUT Help) 
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View Always in Front — Makes the view remain "always in front". (ref. Layout (view), 
in the View Menu section of VERICUT Help) 

Reverse —  Reverses viewing direction. (ref. View Orient window, in the View Menu 
section of VERICUT Help) 

Fit — "Fits" the objects in the view. (ref. View Orient window, in the View Menu 
section of VERICUT Help) 

Set Spin Center — Use to specify a point to be used as the center of rotation during 
dynamic rotations. (ref. View Orient window, in the View Menu section of VERICUT 
Help) 
Select View — Orients the objects in the view to the selected view. The Select View 
feature list will contain all available standard and custom views. 

Background Style — Use to specify the background style for the view. (ref. View 
Attributes window, General tab, in the View Menu section of VERICUT Help) 
Attach Component — Attaches the view point and line of sight for a view to the 
selected component. (ref. View Attributes window, General tab, in the View Menu 
section of VERICUT Help) 
Color — Use to change the color of the selected component or model. This feature is 
only available when the Project Tree, Component Tree, or the Modeling window is 
displayed. With the Project Tree or the Modeling window open, only the color of 
components and models in the Attach Component branch can be changed. When the 
Component Tree is opens all component and model colors can be changed. 

Accelerated (Open GL) — Toggles Hardware Graphics Acceleration (OpenGL) "On" 
and "Off". A check indicates that OpenGL is toggled "On". (ref. View Attributes 
window, in the View Menu section of VERICUT Help) 

Set Active Coord. Sys. — Use to designate the "active"coordinate system. (ref. Set 
Active Coordinate System, in the Project Menu section of VERICUT Help. 

Display Axes — Use to control when various axes and coordinate systems are displayed. 
A check next to any of the Display Axes features, indicates that the feature is toggled 
"On". (ref. View Axes window, in the View Menu section of VERICUT Help) 

Model Definition — Opens the Modeling window. (ref. Modeling window, in the 
Project Menu section of VERICUT Help) 

Project Tree — Opens the Project Tree. (ref. Project Tree, in the Project Menu section 
of VERICUT Help) 

 



VERICUT HELP - Getting Started with VERICUT 
 

 
Machine View 
Right-click in a Machine View to display a menu with the following features: 

 

 
 

View Type — Use to change the view type. (ref. View Attributes window, General 
tab, in the View Menu section of VERICUT Help) 

View to Back — Moves the view to the back. (ref. Layout (view), in the View Menu 
section of VERICUT Help) 
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View Always in Front — Makes the view remain "always in front". (ref. Layout (view), 
in the View Menu section of VERICUT Help) 

Reverse —  Reverses viewing direction. (ref. View Orient window, in the View Menu 
section of VERICUT Help) 

Fit — "Fits" the objects in the view. (ref. View Orient window, in the View Menu 
section of VERICUT Help) 

Set Spin Center — Provides the same functionality as the Set Spin Center feature in the 
View Orient window. (ref. View Orient window, in the View Menu section of VERICUT 
Help) 

Select View — Orients the objects in the view to the selected view. The Select View 
feature list will contain all available standard and custom views. 

Draw Mode — Use to specify how machine components are displayed. (ref. View 
Attributes window, General tab, in the View Menu section of VERICUT Help) 

Background Style — Use to specify the background style for the view. (ref. View 
Attributes window, General tab, in the View Menu section of VERICUT Help) 

Component Visibility — Use to make the selected component visible, or not visible, in  
machine views (Machine or Machine/Cut Stock) in the VERICUT graphics area. A check 
indicates that the component is visible. 

This feature is especially useful when using "encrypted" machine files and you do not 
have access to the Component Tree. 

If the component list contains more than 32 items, VERICUT will automatically break up 
the list into sub-lists. Each sub-list will be identified by the first, and last, component in 
the list. 

Attach Component — Attaches the view point and line of sight for a view to the 
selected component. (ref. View Attributes window, General tab, in the View Menu 
section of VERICUT Help) 

Color — Use to change the color of the selected component or model. This feature is 
only available when the Project Tree, Component Tree, or the Modeling window is 
displayed. With the Project Tree or the Modeling window open, only the color of 
components and models in the Attach Component branch can be changed. When the 
Component Tree is opens all component and model colors can be changed. 

Accelerated (Open GL) — Toggles Hardware Graphics Acceleration (OpenGL) "On" 
and "Off". A check indicates that OpenGL is toggled "On". (ref. View Attributes 
window, in the View Menu section of VERICUT Help) 

Set Active Coord. Sys. — Use to designate the "active"coordinate system. (ref. Set 
Active Coordinate System, in the Project Menu section of VERICUT Help. 

Display Axes — Use to control when various axes and coordinate systems are displayed. 
A check next to any of the Display Axes features, indicates that the feature is toggled 
"On". (ref. View Axes window, in the View Menu section of VERICUT Help) 
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Model Definition — Opens the Modeling window. (ref. Modeling window, in the 
Project Menu section of VERICUT Help) 

Project Tree — Opens the Project Tree. (ref. Project Tree, in the Project Menu section 
of VERICUT Help) 

 
 
Profile View 
Right-click in a Profile View to display a menu with the following features: 

 

 
 

View Type — Use to change the view type. (ref. View Attributes window, General 
tab, in the View Menu section of VERICUT Help) 

View to Back — Moves the view to the back. (ref. Layout (view), in the View Menu 
section of VERICUT Help) 
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View Always in Front — Makes the view remain "always in front". (ref. Layout (view), 
in the View Menu section of VERICUT Help) 

Reverse —  Reverses viewing direction. (ref. View Orient window, in the View Menu 
section of VERICUT Help) 

Fit — "Fits" the objects in the view. (ref. View Orient window, in the View Menu 
section of VERICUT Help)Set Spin Center — Provides the same functionality as the Set 
Spin Center feature in the View Orient window. (ref. View Orient window, in the View 
Menu section of VERICUT Help) 

Select View — Orients the objects in the view to the selected view. The Select View 
feature list will contain all available standard and custom views. 

Draw Mode — Use to specify how machine components are displayed. (ref. View 
Attributes window, General tab, in the View Menu section of VERICUT Help) 

Attach Component — Attaches the view point and line of sight for a view to the 
selected component. (ref. View Attributes window, General tab, in the View Menu 
section of VERICUT Help) 

Display Axes — Use to control when various axes and coordinate systems are displayed. 
A check next to any of the Display Axes features, indicates that the feature is toggled 
"On". (ref. View Axes window, in the View Menu section of VERICUT Help) 

Model Definition — Opens the Modeling window. (ref. Modeling window, in the 
Project Menu section of VERICUT Help) 

Project Tree — Opens the Project Tree. (ref. Project Tree, in the Project Menu section 
of VERICUT Help) 
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Message Area (Logger) 
The message area, also known as the "message logger" or "Logger", is located below the 
graphics area, and by default displays the most recent message VERICUT has provided. 
VERICUT provides error, warning, and informational messages to assist you during a 
simulation session. You can easily determine the type of message by the following: 

Information messages have no preceding label. 
Warning messages are preceded by "Warning:". 
Error messages are preceded by "Error:". 

You can control the number of messages displayed in the Logger at any one time by 
clicking on the divider between the Logger and the Graphics Area and either dragging up 
to increase the number message lines displayed , or down to reduce the number message 
lines displayed.  

You can always use the scroll bar to view messages that are not currently visible in the 
Logger window. 

 

 
 

The Message Area/Logger is also one of the "dockable" features enabling you to be able 
to re-position it if you choose. See "Dockable Windows" for more information. 
 

Shortcut:  Right-click in the Message Area (Logger) to display a menu with the 
following features: 
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NOTES:    
1. These features provide the same functionality described under Logger View 

Options for controlling what is displayed in the Logger. (ref. Logger View 
Options, in the View Menu section of VERICUT Help) 

2. A check next to any of the features indicates that the feature is toggled "On". 
 
Tip:  Clicking on an error in the Logger will highlight the NC program record in the NC 
Program window (Info menu > NC Program) that caused the error. 

 

NOTES:   
1. All messages can be seen along with other valuable information in the Log file. 

2. For information and tips about using VERICUT and troubleshooting problems, 
visit the VERICUT Users’ Forum or contact CGTech technical support via our 
website, just click on the support link. 

http://cgtech.com/forum/
http://cgtech.com/
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Animation Controls 
 
The Animation Controls features, located in the VERICUT main window, enable you to 
control and visually monitor certain events related to the simulation. The Animation 
Controls consist of the following four features.  
 

 
 

Animation Speed Slider — Enables you to control the speed of the simulation. 

Status Lights — Enables you to visually monitor certain events associated with the 
simulation (status of travel limit checking, collisions, probing, subroutines, cutter 
compensation, cycles, motion, OptiPath, and when VERICUT is processing). 

Progress Bar — Enables you to monitor the progress of the current task. 

Simulation (VCR) Controls — Enables you to start, single step, stop, rewind, and 
reset the VERICUT simulation. 

 

Each of these Animation Controls features is described in detail in the following 
sections.  
 
Animation Controls is also one of the "dockable" features enabling you to be able to re-
position it if you choose. See "Dockable Windows" for more information. 
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Animation Speed Slider 
 

The Animation Speed Slider, located on the left end of the Animation Controls 
features, controls the speed at which VERICUT animates material removal in workpiece 
views. Moving the slide bar left slows animation by adding intermediate tool display 
positions between motion start and end points. Moving the slide bar right reduces the 
number of intermediate tool display positions to speed animation display. 

 

 The Animation Speed Slider will be displayed in one of two ways: 

 Animation Speed Slider in full right 
position 

 Animation Speed Slider moved off of full 
right position 

     

 

 

 
  

  

Use Min. Motion Dist. and Max. Motion Dist., in the Project > Processing Options > 
Motion window, to define the range for the Animation Speed Slider. 

   

Tip:  To group cuts together for even faster animation display, use the Skip Cut feature 
located on the Motion window.  
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Status Lights 
 

 
 

The "Status Lights", located between the Animation Speed Slider and the Progress 
Bar in the Animation Controls features, provide constant visible feedback over when 
VERICUT is processing certain events, busy performing a task, or optimizing an NC 
program file. The function and conditions represented by the color of each status light is 
described below. 

 

LIMIT — Indicates the status of travel limit checking. 

Red –  indicates that a travel limit has been exceeded on the current block. 

Yellow - indicates that a travel limit has been exceeded during the current session. 

Green – indicates when Overtravel Detection On is toggled "On". 

Dark Green – indicates that Overtravel Detection On is toggled "Off". 

 

COLL — Indicates the status of collision checking. 

Red –  indicates that a collision occurred on the current block. 

Yellow - indicates that a collision has occurred during the current session. 

Green – indicates that Collision Detection is toggled "On". 

Dark Green – indicates that Collision Detection is toggled "Off". 

 

PROBE — Indicates Probe status. 

 Green — indicates when Probe is "Armed". 

 Dark Green — indicates when Probe is "Not Armed". 

 
SUB — Indicates the status of Subroutine processing. 

 Green — indicates when VERICUT is processing a project subroutine. 

Dark Green — indicates that no project subroutine is being processed. 
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COMP — Indicates the status of Cutter Compensation. 

Green — indicates that Cutter Compensation is "Active". 

Dark Green — indicates that Cutter Compensation is "Not Active". 

 

CYCLE — Indicates CYCLE status. 

 Green — indicates when CYCLE is "Active". 

 Dark Green — indicates when CYCLE is "Not Active". 

FEED / RAPID — Indicates the current Motion status. 

Red — indicates a "Rapid" motion. 

Green — indicates a "Linear" motion. 

Dark Green — indicates some "Other" type of motion. 

 

OPTI — Indicates OptiPath status. 

Green — indicates OptiPath is "On". 

Yellow — indicates OptiPath is in "Learn Mode". 

Dark Green — indicates that OptiPath is "Off". 

 

READY — Indicates VERICUT Status. 

Red — indicates that VERICUT is "Busy" processing. 

Green — indicates that VERICUT is "Ready" for user commands. 

 

TIP:   Place the cursor over any of the Status Lights to see a summary of its function 
and conditions.  
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Progress Bar 
The Progress bar, located between the Status Lights and the Simulation (VCR) 
Controls in Animation Controls features, provide constant visible feedback over the 
progress of a CPU-intensive tasks, such as: comparing models using AUTO-DIFF, 
exporting model data, and checking the consistency of the stock model(s). The progress 
bar moves towards the right as the task nears completion. To interrupt the task, press 

 (Stop). 

 

Sample progress bar part way through a task: 
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Simulation (VCR) controls 
 

 
The simulation controls, also known as VCR buttons, located on the right end of the 
Animation Controls features, control interactive tool path simulation. Once VERICUT 
is configured, you will use these controls to start and stop the simulation, as well as begin 
with a new, uncut workpiece. To see what is associated with a Simulation control icon, 
simply position the cursor over the icon and a tip appears.  

 

Simulation controls: 

Icon Name Function 

 
Play to End Start or re-start tool path processing 

 
Single Step Process one tool path record ("single 

block") 

  
(or press Escape key 

<Esc>) 

Stop Stop processing (after the current record 
is processed) 

 Rewind NC Program Rewind the NC program file to the 
beginning (leave the model as is) 

 
Reset Model Display a new VERICUT model and 

rewind the tool path file 
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Dynamic Zoom, Pan, and Rotate  
 
The Dynamic Zoom, Pan and Rotate features enable you to manipulate the displayed 
image of a view using a single mouse button. 
 
 

Rotate 

 

Click with the left mouse button in a view and drag the 
mouse to rotate the display. 

Pan 

 

Click with the right mouse button in a view and drag the 
mouse to rotate the display. 

Zoom 

 
 

 

Rotate the thumb wheel while the cursor is in a view to 
zoom in or out on the display. 
 
Move the wheel toward you to make the displayed 
image larger. 
 
Move the wheel away from you to make the displayed 
image smaller. 

Zoom to Box 

 
 

 

Press the thumb wheel down in a view and drag the 
mouse to define the box to zoom to. Release the thumb 
wheel to start the zoom.  
 
You can also click the thumbwheel to define the first 
corner of the box, and then move the mouse to the 
position defining the other corner of the box and click 
again.  

 
 

NOTES:   
1. Dynamic Controls (View menu > Dynamic Controls) must be set to VERICUT. 
2. The Shift key, Ctrl key, and mouse button combinations used in pre-V6.1 for view 

manipulation is still available. 
3. The Shift key, Ctrl key, and Arrow key combinations are no longer available. 
4. In NC Program Review, the dynamic rotate with the left button is briefly 

suspended when picking a rectangle for Settings > Display to Box. 
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5. In AUTO-DIFF, when using Compare By Region, the dynamic rotate with the 
left button is suspended as long as the Drag Region button is active. 
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Look & Feel 
Location: View menu > Look & Feel 

 

The Look & Feel features change the appearance of VERICUT's user interface. All 
windows are affected. The look and feel of VERICUT can be changed at any time. 

 

To change the user interface look and feel: 
1. In the View menu, select Look and Feel. 
2. Choose the option that provides the desired appearance. 

 

NOTE:  Not all options are available on all systems. 

Options: 
 

Metal —  
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Motif — 

 
 

 



VERICUT HELP - Getting Started with VERICUT 
 

 

Windows — 
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Windows Classic — 
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Text Larger — Use to make the text in VERICUT menus, message logger, windows, 
etc. larger. Each time you click on "Text Larger", the text gets incrementally larger to 
a maximum font size of "14 point". 
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Text Smaller — Use to make the text in VERICUT menus, message logger, 
windows, etc. smaller. Each time you click on "Text Smaller", the text gets 

incrementally smaller to a minimum font size of "6 point ". 
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Introduction to VERICUT File Selection Windows 
 
File selection windows are used throughout VERICUT to open and save various 
VERICUT file types. They are also accessed by using the Browse buttons found on many 
VERICUT windows to assist you in specifying required /path/filenames. Most features 
on this window are standard file selection window features that enable you to navigate 
through directories, filter files, and type, or select, /path/filenames. Each window may 
vary slightly depending on its intended purpose. This section describes the features 
common to all VERICUT file selection windows. Features specific to a particular 
window are described in the documentation for the window. 
 

 
 
 

Directory Tree — Displays your computer's directories (folders) in a tree type structure.  

File List — Displays the files contained in the directory highlighted in the Directory 
Tree, filtered according to the setting of the Filter feature described below. 

File — Use this text field to manually enter /path/filename information. VERICUT will 
fill in this field as you use the Directory Tree and File List to specify the /path/filename. 
You can also edit the /path/filename entered by VERICUT.   

Filter — Use this feature to specify the types of files to be displayed in the File List. 

Shortcut — The Shortcut option list on file selection windows provides quick access to 
files in your Working Directory, or CGTech Library, CGTech Sample, Showroom, and 
Training files. Choosing a shortcut automatically filters for files in that directory. You 
can also type new shortcuts into the list, but they are only remembered during the current 
VERICUT session. See Adding Custom Environment Variables for Shortcuts in the 
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Environment Variables topic, in VERICUT Help for information on adding additional 
permanent shortcuts. 

 (Up One Level) — Enables you to quickly move up one level in the directory 
structure. 

  (New Folder) — Displays the New folder window enabling you to create a new 
directory/folder. 

 
Enter the name for the new folder in the New sub-folder name text field, and then 
select OK to create the new folder inside the folder highlighted in the Directory Tree. 

Use Cancel to close the New folder window without creating the folder. 

 

Open / Save — Use to open/save the specified file in the specified directory. 

Cancel — Use Cancel to close the file selection window without opening/saving a file.
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Right Mouse Button Shortcut Menus 
 
Many of the VERICUT windows have shortcut menus available, by clicking with the 
right mouse button, that contain features specific to that window. The following provides 
a summary of the VERICUT windows that have right mouse button shortcut menus. 
Refer to the VERICUT Help section for each window for specific information about the 
features contained in these shortcut menus. 
 
VERICUT Main Window 

Workpiece View 
Machine View 
Profile View 
Message Area (Logger) 
 

Text File (edit) window 
 
NC Program (edit) window 
 
View Section window 
 
Select/Store View window 
 
NC Program (Info) window 
 
G-Code Report window 
 
Control Report window 
 
Profile Sketcher window 

Revolve Profile 
Sweep Profile 

 
NC Program window 
 
Tool Manager Window 

Tool Table  
Tool Display Area  

 
G-Code Settings Window 

Subroutines tab 
Collision Detect tab 

 
Variables window 
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Cycles window 
 
Report Template window 

Page Layout tab 
Styles tab 
User Defined Tags tab 

 
Setup Plan window 
 
MDI window 
 
Project Tree Window 

Project Branch 
Setup Branch 
CNC Machine Branch 
Control Branch 
Machine Branch 
Attach Component 
Component Branch 
Model 
Coordinate Systems Branch 
Coordinate System 
Tooling 
NC Programs 
NC Program file 
NC Subroutines 
NC Subroutine file 
Saved IP Files 
IP file 

 
Machine Settings window 

Collision Detect tab 
 
Component Tree Window 

component 
model 

 
Word Format window 

Word Format tab 
 
Word/Address window 
 
Control Settings window 

Sync tab 
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Advanced Control Options window 
Subroutines tab 
Substitute tab 
OptiPath Substitute tab 

 
NC Program Review window 

Main Window 
Workpiece View 
Machine View 
Profile View 

NC Program Listing Area 
NC Program Preview window 

Main Window 
Workpiece View 
Machine View 
Profile View 

NC Program Listing Area 
 
Inspection Window 
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Personalizing the VERICUT Main Window 
 

VERICUT enables you to personalize your workspace to match the process by which you 
use VERICUT's many features, as well as incorporating your own personal preferences. 
Through the use of "dockable" dialog windows, you can set up your VERICUT 
workspace as simply or as complex as you choose. Each of these windows can be docked 
inside the VERICUT main window, or un-docked to be displayed as a stand alone 
window like previous versions of VERICUT. By docking or undocking windows, you 
can tailor the VERICUT workspace to meet your specific needs. The "Simple VERICUT 
Workspace" illustrates the most basic workspace.  

  

Simple VERICUT Workspace: 

 
  
 The "Complex VERICUT Workspace" is shown with nearly all of the available 
"dockable" windows docked to the VERICUT main window. While it appears cluttered, 
and is not likely an efficient workspace, the intent is to show the flexibility that you have 
for setting up your workspace. Your optimum workspace layout will likely fall 
somewhere between these two extremes. The main point is that you decide the most 
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effective workspace layout based on how you use VERICUT and how you prefer to 
interact with its many features. 

  

Complex VERICUT Workspace: 
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Dockable Windows 
 

The following summarizes the dialogue windows that can be docked inside VERICUT's 
main desktop: 

  

Dockable Window Location Docking Positions 
      

Toolbar VERICUT main window Left, Right , Top, Bottom, 
Standalone 

Progress bar VERICUT main window Top, Bottom, Standalone 

NC Program window Info menu > NC Program Left, Right , Top, Bottom, 
Standalone 

NC Program Review 
window 

Analysis menu > NC Program 
Review 

Left, Right , Top, Bottom, 
Standalone 

Status window Info menu > Status Left, Right, Standalone 
Project Tree window Project menu > Project Tree Left, Right, Standalone 
X-Caliper window Analysis menu > X-Caliper Left, Right, Standalone 
 
NOTE:  When any of the above "windows" is docked, make sure that you click in the 
window so that it becomes the "active" window before using F1 to get help specific to the 
window. Otherwise F1 will go to the CGTech Help Library. 
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Docking and Un-docking windows 
 

The procedure for docking/undocking any of the dockable windows is the same. All 
dockable windows have a dotted line on the left side of the window as indicated by the 
arrow in the Toolbar in the picture below. This dotted line is used for both docking and 
undocking these windows. To undock a currently docked window, left click on the dotted 
line on the left side of the window, then while keeping the button depressed, drag the 
rectangle representing the window (see Figure 1) to the desired location outside the 
VERICUT main window. When you release the mouse button, the window moves and is 
displayed as a stand alone window.  

  

Figure 1 
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Figure 2 shows the result of dragging the Toolbar window to a position below the 
VERICUT main window. 

  

Figure 2 

 
  

 The procedure for docking a stand alone window or moving a currently docked window 
to a different docking location is the same. Starting with the stand alone Toolbar window 
shown in Figure 2, left click on the dotted line in the Toolbar window, then drag the 
rectangle representing the window to one of the docking positions available for the 
particular window. 
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In this case we are docking the Toolbar window on the right side of the VERICUT main 
window. When the rectangle representing the window is dragged to a dockable position, 
the shape of the rectangle will change and the border will be displayed red as shown in 
Figure 3.  

 

Figure 3 
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Releasing the left mouse button moves the window to the docked position as shown in 
Figure 4. 

 

Figure 4 
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Introduction to VERICUT Reports 
 

VERICUT Report provides the tools needed modify/create report templates enabling you 
to generate "custom" reports.  

 Generate reports that only include information important to your particular work 
environment, in a format that is most meaningful to the users of the report. Eliminate the 
need to search through the wide range of information that is included in a more generic 
"standard" report. 

  

VERICUT Reports:  
• Enables you to generate reports using one of the "standard" report templates 

supplied. The following "standard" report templates are included and can be 
found in the "library" directory of your VERICUT installation: 

inspection.VcTemplate - Use this template to create a basic inspection report that 
includes the inspection sequence table and graphic showing the location of the 
inspection points on the part. This is the default report template that Inspection 
Sequence will use if no other template has been specified. 

NOTE:  Report template inspection.VcTemplate should only be used for 
creating reports from the Inspection Sequence window. Using it to create reports 
from other VERICUT applications will result in incorrect data being displayed in 
the report. 

  

vericut.VcTemplate - This is the default report template that VERICUT will use 
if no other template has been specified. 

vericut_basic.VcTemplate - Use this report template to create a report 
containing overview information about the VERICUT session. Includes a file 
summary, and a Tool Summary table and Tool Use graph for each NC program 
file. 

vericut_optipath.VcTemplate - Use this report template to create a report 
similar to the "basic" report but also includes OptiPath information. 

vericut_shadecopy.VcTemplate - Use this report template to create a report 
similar to the "basic" report but also includes View Capture images specified with 
File > AutoSave: View Capture tab. 

vericut_full.VcTemplate - Use this report template to create a report similar to 
the "View Capture" report but also includes OptiPath information. 

NOTE:  The above five report templates should only be used for creating reports 
using File menu > Create Report > ... in the main VERICUT window. Using 
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them to create reports from other VERICUT applications will result in incorrect 
data being displayed in the report. 

  

vericut_tools.VcTemplate - Use this template to create a tool library report. This 
is the default report template that Tool Manager will use if no other template has 
been specified. 

NOTE:  Report template vericut_tools.VcTemplate should only be used for 
creating reports from the Tool Manager window. Using it to create reports from 
other VERICUT applications will result in incorrect data being displayed in the 
report. 

• Enables you to modify a "standard" report template by changing the content, layout 
and/or format of the included information and save it as a "custom" report template. 

• Enables you to produce "custom" report templates from "scratch". You decide the 
format, layout and content that best meet your needs. 

• Provides the tools to include a wide variety of information from different sources. 
Include text, tables or pictures. Extract information from the VERICUT user file; 
include information from external files, or "generic tags" that will be updated with 
information specific to a particular user file at the time that the report is created. 

  

What is involved with creating a custom VERICUT report? 
Creating and deploying a custom report for use by VERICUT users involves the 
following steps.  

1. Set up "styles" to be used for the report template 

2. Define "user defined tags" that will be included in the template 

3. Create the page layout for the report template 

4. Using the report template 

 

For more information on creating and using custom report templates, see the following: 

1. See the Report Template topics in the Project menu section of VERICUT Help. 

2. See the Working with VERICUT Reports, in the Using VERICUT section, in 
the CGTech Help Library for additional information. 
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VERICUT Menus and Features 
 

File Menu 
 

New Project 
Location: File menu > New Project > Inch / Millimeter 

Toolbar short cut for creating a New Project file:  (Inch), or  (Millimeter). 
Right-click on the icon to switch between the two modes. 

Sets VERICUT to a "new" condition, as if no files have been loaded. Afterwards, 
configure VERICUT by adding models, tool paths, descriptions of cutting tools, etc. 

To establish the new condition, VERICUT purges all data from memory, and then opens 
the init.VcProject (inch project) or initm.VcProject (millimeter project) Project file from 
the CGTech library. The Project Tree and Component Tree shown below are 
automatically defined, ready for you to configure VERICUT by adding models, tool 
paths, descriptions of cutting tools, etc. 

 

  

Project Tree after a new condition: Component Tree after a new condition: 
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Tips: 
 
1. You can customize how VERICUT establishes the new condition by making changes 

to the init.VcProject or initm.VcProject files. Store the changed files in your working 
directory, or the CGTech library directory. 

2. If needed, change the units for the new session as follows: 
A. Right-click in the graphics area and select Project Tree in the menu that 

displays. 
B. In the project tree, right click on the "project" branch, and select Unit > Inch 

or Millimeter in the menu that displays. 
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Open (Project) 
Location: File menu > Open 

  

Toolbar short cut for opening Project files:  
  
Use to open an existing Project file with the current VERICUT session settings. Use the 
Open Project file selection window that displays to select the desired project file. Most 
features on this window are standard file selection window features that enable you to 
navigate through directories, filter files, and type, or select, /path/filenames. A description 
of features specific to VERICUT can be found in the Introduction to VERICUT File 
Selection Windows in the Getting Started section of VERICUT Help. 
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Save Project  
Location: File menu > Save Project 

Toolbar short cut for saving Project files:   

Tip:  Right-click on the icon to toggle between  (Save Project) and   (Save 
Project As) modes. 

 

Saves (updates) an existing Project file with the current VERICUT session settings. 
VERICUT will save the project file if you have sufficient permissions to save the file in 
its present directory. Otherwise, the Save Project File As window will display enabling 
you to specify a location to save where you have write permissions. 
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Save As 
VERICUT Users: 
VERICUT Location: File menu > Save As 

Toolbar short cut for saving Project files as:  

Tip:  Right-click on the icon to toggle between  (Save Project) and   (Save 
Project As) modes. 

 

Mold and Die Users: 
Mold and Die Location:   Setup page > Save the Setup or Preview and Optimize page 
> Save the Setup 

Notebook Feature:        

  

Cutter Grinder Users: 
Cutter Grinder Location:   Setup page > Save the Setup or View Simulation page > 
Save the Setup 

Notebook Feature:       

 

 
 

Opens the Save Project As window enabling you to save Project files (ref. Project Files 
in the Getting Started section of VERICUT Help). Most features on this window are 
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standard file selection window features that enable you to navigate through directories, 
filter files, and type, or select, /path/filenames. A description of features specific to 
VERICUT can be found in the Introduction to VERICUT File Selection Windows in 
the Getting Started section of VERICUT Help. 
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Save All 
Location: File menu > Save All 

  
Saves (updates) the Project file, Machine Files and Control Files associated with the 
current setup. It provides the combined functionality of File menu > Save Project, 
Configuration menu > Control > Save and Configuration menu > Machine > Save. 
In the event that a file cannot be saved (for example not having write permissions in the 
specified directory), a window will open enabling you to Save As. 
 
Single Setup Project File: 
When you select Save All for a single setup project file, the following will happen: 

1. VERICUT will save the project file if you have sufficient permissions to save the 
file in its present directory. Otherwise, the Save Project As window will display 
enabling you to specify a location to save where you have write permissions. 

2. VERICUT will save the machine file if you have sufficient permissions to save 
the file in its present directory. Otherwise, the Save Machine File window (ref. 
Save As (Machine File) in the Configuration menu section of VERICUT Help) 
will display enabling you to specify a location to save where you have write 
permissions. 

3. VERICUT will save the control file if you have sufficient permissions to save the 
file in its present directory. Otherwise, the Save Control File window (ref. Save 
As (Control File) in the Configuration menu section of VERICUT Help) will 
display enabling you to specify a location to save where you have write 
permissions. 

 
 
Multiple Setup Project File: 

When you select Save All for a multiple setup project file, the following will happen: 

1. VERICUT will save the project file if you have sufficient permissions to save the 
file in its present directory. Otherwise, the Save Project As window will display 
enabling you to specify a location to save where you have write permissions. 

2. VERICUT will save the machine file associated with the "current" setup (ref. 
Current Setup, in the Project menu section of VERICUT Help) if you have 
sufficient permissions to save the file in its present directory. Otherwise, the Save 
Machine File window (ref. Save As (Machine File) in the Configuration menu 
section of VERICUT Help) will display enabling you to specify a location to save 
where you have write permissions. 

3. VERICUT will save the control file associated with the "current" setup if you 
have sufficient permissions to save the file in its present directory. Otherwise, the 
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Save Control File window (ref. Save As (Control File) in the Configuration 
menu section of VERICUT Help) will display enabling you to specify a location 
to save where you have write permissions. 
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In Process 

Open (In Process file) 
  
VERICUT Users: 
VERICUT Location: File menu > In Process > Open 

Toolbar short cut for opening IP files:  
  
Mold and Die Users: 
Mold and Die Location:   Setup page > Open In-Process Session 

Notebook Feature:       

  
Cutter Grinder Users: 
Cutter Grinder Location:   Setup page > Open In-Process Session 

Notebook Feature:       

  
Opens the Open In-Process window enabling you to open (load) an In Process file, or 
"IP file" (ref. In-Process File in the Getting Started section of VERICUT Help). IP files 
contain all the data necessary to re-establish a VERICUT session, including the current 
VERICUT model (with cuts), user interface settings, and a copy of the Log file.  
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Most features on this window are standard file selection window features that enable you 
to navigate through directories, filter files, and type, or select, /path/filenames. A 
description of features specific to VERICUT can be found in the Introduction to 
VERICUT File Selection Windows in the Getting Started section of VERICUT Help. 
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Merge (In Process file) 
 

VERICUT Location: File menu > In Process > Merge 

 

Displays the MergeIPro window enabling you to select the In-Process (IP) file (ref. In-
Process File in the Getting Started section of VERICUT Help) to be merged. 

 

 
 
Most features on this window are standard file selection window features that enable you 
to navigate through directories, filter files, and type, or select, /path/filenames. A 
description of features specific to VERICUT can be found in the Introduction to 
VERICUT File Selection Windows in the Getting Started section of VERICUT Help. 

Use the Merge feature to load an In-Process (IP) file without removing the current project 
from VERICUT session. This feature enables you to create multi-setup project files, one 
setup at a time without the need to reprocess previous setups. This is especially useful for 
setups that take a long time to process. 

IP files can be successfully "merged" as long as they contain fewer processed setups than 
the number of setups in the project file that they are being merged into. If the IP file has 
an equal number, or greater number of setups than the number of setups in the project file 
that they are being merged into, then the Merge operation is equivalent to File menu > In 
Process > Open. 

When a "merge" operation is successful, the current VERICUT project data remains 
unchanged, but the setups in the IP file, replace an equal number of setups in the project 
file. Any setups in the project file, as shown in the Project Tree, below the setups merged 
from the IP file remain unchanged. 
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NOTE:  There are no checks, or validation, to determine whether or not the IP file is 
related to current project. 

 

Simple Merge IP file example: 
1. Create the project file containing the first setup. 

2. Process the first setup. If the results are OK, save an IP file (File menu > In Process> 
Save). Save the project file (File menu > Save Project). The Project Tree should 
now look something like the picture below. 

 

 
 

3. Add the next setup to the project file. The Project Tree should now look something 
like the picture on the next page. 
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4. Before processing the second setup, merge the IP file you saved in step 2. (You can 
either use File menu > In Process > Merge  in the VERICUT main menu, or in the 
Project Tree, right click on the IP file shown in Setup 1 and select Merge IP File 
from the pull-down menu.) 

5. Once the "merge" is complete, you are ready to process Setup 2 without re-processing 
Setup1. Setup 1 is restored to the state it was in when you saved the IP file, Setup 2 is 
unchanged. 

 



VERICUT HELP – File menu 
 

 

Save (In Process file) 
Location: File menu > In Process > Save 

Toolbar short cut for saving IP files:  

TIP:  Right-click on the icon to toggle between  (Save In-Process) and  (Save 
In-Process As) modes. 

 
Saves (or updates an existing) In-Process file, or "IP file" (ref. In-Process File in the 
Getting Started section of VERICUT Help), with the current VERICUT model, including 
all machine cuts. VERICUT will save the In-Process file if you have sufficient 
permissions to save the file in its present directory. Otherwise, the Save In-Process As 
window will display enabling you to specify a location to save where you have write 
permissions. 

In Process (IP) files are by default compressed when they are saved. VERICUT can read 
these compressed files directly. 

To disable writing compressed IP files, set the environment variable 
CGTECH_COMPRESS=IP (ref. Environment Variables in the VERICUT Help section, 
in the CGTech Help Library for additional information).
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Save As (In Process file) 
  
VERICUT Users: 
VERICUT Location: File menu > In Process > Save As 

Toolbar short cut for saving IP files:  

TIP:  Right-click on the icon to toggle between  (Save In-Process) and  (Save 
In-Process As) modes. 

 

Mold and Die Users: 
Mold and Die Location:   Preview and Optimize page > Save In-Process Session 

Notebook Feature:       

  
Cutter Grinder Users: 
Cutter Grinder Location:   View Simulation page > Save the In-Process Session 

Notebook Feature:       

  

Opens the Save In-Process As window enabling you to save (or update an existing) In-
Process file, or "IP file" (ref. In-Process File in the Getting Started section of VERICUT 
Help), with the current VERICUT model, including all machine cuts. IP files contain all 
the data necessary to re-establish a VERICUT session, including the current VERICUT 
model (with cuts), user interface settings, and a copy of the Log file (ref. Log File in the 
Getting Started section of VERICUT Help).  
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Most features on this window are standard file selection window features that enable you 
to navigate through directories, filter files, and type, or select, /path/filenames. A 
description of features specific to VERICUT can be found in the Introduction to 
VERICUT File Selection Windows in the Getting Started section of VERICUT Help. 

In Process (IP) files are by default compressed when they are saved. VERICUT can read 
these compressed files directly. 

To disable writing compressed IP files, set the environment variable 
CGTECH_COMPRESS=IP (ref. Environment Variables in the VERICUT Help section, 
in the CGTech Help Library for additional information). 

 



VERICUT HELP – File menu 
 

 

Save Cut Stock 

VERICUT Solid 
VERICUT Location: File menu > Save Cut Stock > stock name 

  

Save Cut Stock opens the Save Cut Stock window enabling you to save the selected Cut 
Stock model as a VERICUT Solid file (.vct). This option is only active after a Cut Stock 
model has been created by VERICUT. The default file extension is .vct. 

 

 
 
Most features on this window are standard file selection window features that enable you 
to navigate through directories, filter files, and type, or select, /path/filenames. A 
description of features specific to VERICUT can be found in the Introduction to 
VERICUT File Selection Windows in the Getting Started section of VERICUT Help. 

A cut stock model can be saved as a VERICUT Solid file "with features" or "without 
features". Toggle the Save with Features option, in the Save Cut Stock window, On (the 
default) or Off. 

When the cut stock model is saved "with features", the cut database, the full feature 
(cylinder, plane, torus, etc.) database, cut and stock colors are stored in the VERICUT 
Solid file in addition to the geometry data. When the cut stock model is saved "without 
features", only the geometry data is saved in the VERICUT Solid file. 

VERICUT Solid (.vct) files are by default compressed when they are saved. VERICUT 
can read these compressed files directly. 
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To disable writing compressed VERICUT Solid files, set the environment variable 
CGTECH_COMPRESS=VCT (ref. Environment Variables in the VERICUT Help 
section, in the CGTech Help Library for additional information). 
  
This feature provides access to the same functionality as File > Save Cut Stock in the in 
the Component Tree window. 
 
See VERICUT Solid File, in the Getting Started with VERICUT section, of VERICUT 
Help for more information. 
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STL 
VERICUT Location: File menu > Save Cut Stock > STL 

 

 
 

Output File — Enter the \path\file name in the text field of the file to receive exported 
model data or click on Browse and use the Export Model File selection window to 
specify the file. 

File Type — Type of file to export. 

Options are: VERICUT and STL 

File Format — Format in which STL or VERICUT model data is exported. 

Options are: ASCII or Binary. 

Reduce Triangles — When unchecked (the default), the STL file is created using the 
original STL output (as found under Model Export), with no triangle reduction. A Model 
Export license is not required. When checked, the STL file is created using the triangle 
reduction method as in V6.1. The state is saved in the project file as a global project 
setting (not a setup setting). 

Stock — When multiple Stock components are defined, this option enables you to select 
which one to export. 

Coordinates — Coordinate system in which model data is exported. 

Options are: Stock (stock component origin) or Active System (See Project menu > 
Coord. System). 

Units — Unit measurement system in which model data is exported. 

Options are: Inch or Millimeter. 
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Apply — Saves the STL Output window settings. 

Output — Processes and exports the VERICUT model according to the STL Output 
window settings. 

Close — Closes the STL Output window. 
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CAD Model 

Export Cut Stock window 
Location: File menu > Save Cut Stock > CAD Model  

 

Opens a window enabling you to export the VERICUT model. Export formats include: 
Stereo lithography (STL) or VERICUT Polygon model files, or IGES data. A cut 
VERICUT model is exported with machine cuts intact. During the export operation a 
Model Export Boundaries window may open enabling you to manually close ambiguous 
open boundaries that VERICUT was unable to resolve, prior to completing the export. 
When the model has been exported, a message informs you how many IGES surfaces (or 
model file triangles) were created. 

 

 
 

Tips on exporting models: 
1. Make sure that Model Export Cut Mode in the File menu > Properties > 

General tab is toggled "On". 

2. Make sure that Display Holders in Workpiece View in the Project menu > 
Processing Options > Motion window is toggled "Off". 
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3. Make sure that Visibility is set such that models of fixture components are not 
visible in the Workpiece View. See Model menu > Model Definition > 
Component Attributes tab for more information. 

4. When you cut the model a message similar to "For best AUTO-DIFF, OptiPath 
and Model Results, set Cut Tolerance to 0.XXXX, due to small tool features" will 
appear in the logger. Use this information as a starting point for setting Cutting 
Tolerance and  Base Cut Tolerance on values on the File menu > Properties > 
Tolerance tab. 

5. To export a higher quality model, reduce the Cutting Tolerance. 

6. You can section cut models, then export what remains in the sectioned view. This 
can be helpful to export portions of complex models on computers with limited 
resources. 

7. Also see Notes about Using Model Export, in the Notes about Special Topics 
section, in the CGTech Help Library. 

 

Settings tab — Features on this tab establish general properties for the model export. 

Options tab — Features on this tab are used specify properties related to specific methods 
of processing VERICUT model geometry. 

 

Apply — Saves the Export Model window settings. 

Output — Processes and exports the VERICUT model according to the Export Model 
window settings. During the export operation a Model Export Boundaries window 
opens providing control over small surfaces that may cause problems in your CAD 
system. When the model has been exported, a message informs you how many IGES 
surfaces (or model file triangles) were created. 

Close — Closes the Export Model window. 
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Export Cut Stock window, Settings tab 
Location: File menu > Export Cut Stock 

  

Features on this tab establish general properties for the model export. 

  

 
  

Output File — Enter the \path\file name in the text field of the file to receive exported 
model data or click on Browse and use the Export Model File selection window to 
specify the file. 

File Type — Type of file to export. Options are: VERICUT, STL, IGES, CATIA V5, 
ACIS, CATIA V4 and STEP. 

File Format — Format in which STL or VERICUT model data is exported. Options are: 
ASCII or Binary. 

Output Color — Use to specify the color that is stored in the IGES file for the exported 
model. (Only active when File Type = IGES) 

Output Solid — Use to export a solid model. (Only active when File Type = CATIA V5, 
ACIS, CATIA V4, or STEP) 

Stock — When multiple Stock components are defined, this option enables you to select 
which one to export. 

Coordinates — Coordinate system in which model data is exported. Options are: Stock 
(stock component origin) or Active System (See Project menu > Coord. System). 
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Units — Unit measurement system in which model data is exported. Options are: Inch or 
Millimeter. 

Method — Controls the method of processing VERICUT model geometry into the 
specified data format. Features and Patches, Features Only and Turned Features Only are 
only active when File Type = IGES, CATIA V5, ACIS, CATIA V4, or STEP.  Slices is 
only active when File Type = IGES 

Options: 
Features and Patches — Builds synthetic features from several small adjacent 
features that are difficult to resolve in 'Features Only' mode. Analyzes the cut model 
using UV grid logic and group machined features by grid region. Grid Count specifies 
the number of grid squares in U and V space, spread over the cut model surface. 
VERICUT attempts to create one surface within in each grid, or as few surfaces as 
possible.  This option is recommended for cut models with smooth or transitioning 
surfaces, for example: mold and die cavities and patterns, blended or sculptured 
surfaces, etc.  

Features Only — Groups similar machined features into like IGES data entities. This 
option is recommended for cut models with distinct differences between machined 
features, for example: aerospace structural components, pocketed parts, parts with 
strengthening ribs/walls and stepped floors, etc. 

Turned Features Only — Exports the turned, or "revolved", representation of the 
cut model. Turned models are exported as an IGES file and contain the 2-D turned 
profile and surface of revolution. 

Slices — Exports the cut model such that resulting IGES output is a set of composite 
curves representing slice profiles of the cut stock. 

 
 
To Export Cut Stock window
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Export Model window, Options tab 
Location: File menu > Export Cut Stock 

  

Features on this tab are used specify properties related to specific methods of processing 
VERICUT model geometry. The options displayed will vary depending on the method of 
processing (either Features and Patches or Slices) selected on the Settings tab.  

 

 
 

Process = Features and Patches 
Global Angle — Angle which, if exceeded, divides the machined surface into multiple 
IGES surfaces. Enter the angle in degrees. Increasing the angle decreases output file size 
and decreases IGES data accuracy.  On "Grid" processed models Global Angle affects the 
output of all machined surfaces. 

NOTE:  When you increase the Grid Count (more grid sections), the Global angle can 
also typically be increased since fewer features are considered for each grid. 

 

Tolerance — Use to specify the amount that the exported model surface can deviate 
from the cut model surface. The smaller the value, the closer the output model will 
approximate the cut stock. 

 NOTE:  This tolerance value should be equal to, or greater than, the cut tolerance. 
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Group by Color — When toggled "On" (checkmark visible), patches will be created to 
only contain data related to a single color. 

Detect Scallop Planes — Toggle "On" to activate "scallop plane logic" to process. 
Processing is faster when toggled "Off". 

Feature Collection — Use to specify the size of the area to be taken into account when 
differentiating between a "feature" and a "surface". Select the appropriate "feature" tab, 
(Plane, Cone, Cylinder, Sphere, Torus, Torus Sweep, or Ellipse Sweep) then use the 
slider to specify the size of the area. The percent value, shown above the slider, 
represents the percentage of the total slider distance of the current setting, where the 
More end of the slider is 0% and the None end of the slider is 100%. The number in 
parenthesis, shown above the slider, represents the actual size of the area (specified in 
inches2, or millimeters2) to be taken into account for the feature. This value is comparable 
to those shown in the Size column in the Preview and Combine window. The slider 
displays yellow as soon as it is moved off the None position. 

The More end if the scale is approximately equal to .0001 of the part size. None end of 
the scale is approximately equal to .1 of the part size. 

  

Process = Slices 
Slice Direction — Use to specify the direction of the slices. Select X, Y, or Z based on 
the axes of the cut stock model. 

Number of Slices — Use to specify the total number of slices to create. 

NOTE:   If the specified number is greater than the number of grid planes internally 
stored in the cut stock database, the number of slices output will automatically be reduced 
to this smaller value. 

 Local Angle — determines the max angle between 2 adjacent pieces of one slice when 
they still can be combined in one segment. 

Tolerance — Use to specify the amount that the exported curves can deviate from the cut 
model surface. The smaller the value, the closer the output curves will approximate the 
cut stock surface. 

NOTE:  This tolerance value should be equal to, or greater than, the cut tolerance. 

 
 
To Export Cut Stock window
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Export Cut Stock, Preview and Combine window 
 

After VERICUT completes a preliminary analysis of the model, the model display 
changes to show multi-colored patches (see below), and the Preview and Combine 
window displays enabling you to: 

 

• Preview the model before going through the entire model export process. This 
enables you to cancel the current export and update settings before proceeding. 

• Merge adjacent patches for smoother output, faster model export, and smaller 
model sizes. 

• Split patches for more efficient merges. 

   

VERICUT display for Preview and Combine Patches 
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Most of the features available, and how to use them, are described right in the window. 
The others are described below. 

 

 
 

 (Pick mode) — Use to toggle "pick mode" on and off.  

Opened/Closed — Use to specify whether the points selected while in pick mode create 
an open or closed boundary. Pick mode must be toggled "off" in order to select Opened 
or Closed. 

Reverse — Use to reverse the order of the points that are picked in pick mode. The 
direction of in which the points are picked will affect which part of a patch is retained 
and which part will be removed. It also has an affect on the direction of the resulting 
surface normal. 
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Split — Use this feature split a patch. Use either an Opened or Closed pick mode 
boundary to specify the location of the split. 

Collect — Use this feature to enable the collection of patches based on Opened/Closed 
boundary construction.  

Feature to Patch — Use to convert the selected feature to a patch. 

Fit Patch — Use to resize and center the graphics window display around the selected 
feature/patch. Select the feature/patch in the table or by clicking on the feature/patch in 
the graphics area. 

 

Tip:  Click on the column headings in the Feature Table to sort the table by that 
characteristic. For example, sorting by Size enables small features to be quickly 
identified. 
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Export Cut Stock, "Combine" Example 
The following example shows the process of combining a number of smaller patches into 
a single patch. 

When Preview and Combine Patches is toggled "On", VERICUT completes a 
preliminary analysis of the model, then displays the model as multi-colored patches as 
shown below. 

 
To combine patches, start by selecting the "initial" patch (in this case patch # 1) using the 
left mouse button. The initial patch will display as shown below. 

NOTE:  Patch boundaries and numbers have been added for illustration purposes and 
will not be seen in the VERICUT display. 
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Select the first patch to be merged (in this case patch #2) with the middle mouse button. 
Any patch adjacent to the "initial" patch could have been selected for merging. The 
display updates as shown. 

 

 
 

Continue selecting adjacent patches to merge using the middle mouse button. The picture 
below shows the display after all 12 of the numbered patches have been selected for 
merging. 
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When finished selecting patches to be merged, click on the part with the left mouse 
button to combine the selected patches into a single patch as shown in the picture below. 
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Export Cut Stock, Preview and Combine Techniques 
The following techniques are provided to assist you in maximizing the quality of the 
models you create using the Export Cut Stock features. 
 
  
1. Avoid long narrow strips. 
  

The first image shows original patches. 

 

The second image shows a resultant long 
narrow patch which should be avoided. 

 

The third image shows an ideal resultant 
patch. 
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2. Consider neighboring node propagation. 
  

The first image shows original patches.  

 

The second image shows a resultant 
patch which will be split do to 
neighboring nodes. 

 

The third image shows what should be 
done to minimize unnecessary splits. 
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3. Merge small patches.  
  

Use the table to identify small patches by 
sorting by the Size column. Once small 
patches have been identified combine 
small patch with larger patch or combine 
a group of small patches to create one 
large patch. The image at the right shows 
a small patch (in red) that should be 
merged with one of the two larger 
patches.  

 
  
 
 
4. Merge all small plane anomalies. 
 

All small anomalies within a plane 
should be combined with the plane. The 
first image shows a plane (in red) with 
several small anomalies within the plane.  

 

The second image shows the plane with 
the small anomalies combined with the 
plane. 
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5. Consider initial design intent. 

When combining patches take into 
consideration intended design feature. 
The initial design intent of the images 
below is a cylinder. 
The first image shows the original 
patches. 

 

The second image shows the combined 
patches considering the initial design 
intent. 

 
 
  
6. Tabulated cylinder representation. 
  

Patches should be combined to represent 
a tabulated cylinder. The first image 
shows the original patches. 
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The second image shows what should not 
be done. 

 

The third image shows the ideal patch 
combination abiding by the tabulated 
cylinder rule. 

 
  
  
7. Use Split and Merge to improve fillets. 
  

The first image shows the patches from 
the original collection. 
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The second image shows the patches 
after using split and merge to improve 
fillet areas. 

 
  
  
8. Use Split and Merge to improve jagged boundaries. 
  

The first image shows the original patch 
boundary. 

 

The second image shows the patch, after 
using split and merge to improve 
boundary. 
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Model Export Boundaries window 
The features in the Model Export Boundaries window enable you to close difficult or 
poorly defined feature trimming edges before exporting the model. 

  

 
  

Feature/Boundary Table — Contains a list of features. Each "feature" contains one or 
more open edges that VERICUT was not able to close automatically. Click on the "+" 
sign to the left of the feature to display a list of edges associated with it.  

Construct Mode — These options enable you to manually close open feature edges prior 
to exporting the model. To activate Construct Mode, select any option in the list other 
than "Off". A red and white "cross-hairs" cursor indicates when Construct Mode is active. 

Options: 
Off — Turns off Construct Mode. (You can also use the "escape" key on the 
keyboard) 

Project Edge — Use to extend an edge along a feature/feature intersection, one 
point at a time by projecting  the "Begin / End" point of the highlighted edge to 
the selected point on the intersection.  

Trim Edge — Use to eliminate overlapping boundary curves by trimming the 
"Begin / End" point of the highlighted boundary to the selected location.  

NOTE:  It is better to trim the boundary short, leaving a small gap that can then 
be closed than to have an "overlap" condition in the boundary. 
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Add Edge — Use to connect two edges within the same feature. The "begin/end" 
point of the highlighted edge is connected to the "end" or "begin" point on the 
selected edge.  

NOTE:  Highlight the edge by selecting it in the Feature/Edge table or by 
clicking on the edge in the graphics area with the center mouse button. 

Construct Patch — Use to construct a patch to fill an open area between 
features. 

Delete Edge — Use to delete the highlighted edge. 

 

Reverse Edge — Use to reverse the direction of the highlighted edge. 

Fit Edge — Use to resize and center the graphics window display around the highlighted 
edge. Select the edge in the Feature/Edge table or by clicking on the edge with the center 
mouse button in the graphics area. 

Fit Feature — Use to resize and center the graphics window display around the selected 
feature. Select the feature in the Feature/Edge table or by clicking on the feature in the 
graphics area. 

Clear — Use to clear the graphics display of "persistent boundaries". 

Do Not Output Open Boundaries — Toggle "on" to prevent the export of open 
boundaries. 

Persistent Boundaries — When toggled "on", enables you to display multiple feature 
boundaries. Use to display the feature boundaries adjacent to the edge that you are trying 
to close. Use Clear, described above, to remove "persistent boundaries" from the graphics 
display.  

Color Pallet — Select an object from the list then click on the color pallet icon to display 
the color pallet. Select the color for the selected object. You can specify colors for the 
following objects: 

Begin Point Color — Use to specify the color to display the "begin" point of an open 
feature boundary. 

End Point Color — Use to specify the color to display the "end" point of an open feature 
boundary. 

Boundary Color — Use to specify the color to display "open" feature boundaries. 

Projection Color — Use to specify the color to display the projected feature curve that 
displays when using Construct Mode options Project, Trim or Extend are used. 

Selected Color — Use to specify the color to display "selected" open boundary color (the 
highlight color of the active boundary).  

Closed Color — Use to specify the color to display "closed" feature boundaries. 

Node Color — Use to specify the color to display "node" points (the point where two 
adjacent edge segments connect on a feature boundary). 
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OK — Creates the export file and closes the Model Export Boundaries window. 

Output — Creates the export file and leaves the Model Export Boundaries window open. 

Cancel — Cancels the export of the model. 
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Working Directory 
  
VERICUT Users: 
VERICUT Location: File menu > Working Directory 

Toolbar short cut for setting a working directory:    
  
Mold and Die Users: 
Mold and Die Location:   Setup page > Work Directory 

Notebook Feature:       

  
Cutter Grinder Users: 
Cutter Grinder Location:   Setup page > Work Directory 

Notebook Feature:       

  

Opens a window enabling you to set the working directory where you can open and save 
VERICUT files. After setting the working directory, VERICUT will look here by default 
whenever files are saved or opened. You can also quickly access files in this directory via 
the Working Directory entry in the file selection window Shortcut list.  

Most features on this window are standard file selection window features that enable you 
to navigate through directories, filter files, and type or select file names. In this case, all 
that is required is to select a directory. 
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Properties window 
  
VERICUT Users: 
VERICUT Location: File menu > Properties 

  

Mold and Die Users: 
Mold and Die Location:   Other Settings page > Session Properties 

Notebook Feature:        

  

Cutter Grinder Users: 
Cutter Grinder Location:   Other Settings page > Session Properties 

Notebook Feature:       

  

Opens a window to set properties for the verification session, such as: cut mode, 
resolution and tolerance values that affect cut model display, accuracy, and motion 
simulation. 

 

 
 

General tab — Features on this tab establish general properties for the VERICUT 
simulation session. 

Tolerance tab — Features on this tab set tolerances for the overall simulation session. 
These values are used by VERICUT to construct the solid database for machining, 
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simulate circle motions, identify errors related to material removal, and work with conic 
solid models. 

OK — Saves the window settings and closes the Properties window. 

Apply — Saves the current window settings and leaves the Properties window open. 

Cancel — Closes the Properties window without saving changes. 
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Properties window, General tab 
Location: File menu > Properties 

 

Features on this tab establish general properties for the VERICUT simulation session. 

 

 
 

Default Machining Type — Sets the machining mode for VERICUT.  

Options: 

Mill — A spinning tool removes material when in contact with Stock/Fixture. 

Turn — A Spindle spins the Stock/Fixture assembly and a stationary tool (not 
spinning) removes material when in contact with Stock/Fixture. 

Wire EDM — An electrically charged wire removes material when in contact with 
Stock/Fixture. 

The machining type can be changed during the simulation using a VERICUT-
MODAL record (APT or G-Code tool paths) or via the 
VC_ModeMilling/VC_ModeTurning NC control macros (G-Code tool paths only). 

 

Stock Consistency Check — When selected, VERICUT checks the consistency of stock 
models, including: check for "watertight" solid- repair improperly trimmed surfaces 
(overlaps and gaps), and reconstruct insignificant missing surfaces. This option is highly 
recommended for stock models creating from importing IGES data, and other model files 
where portions of the stock model disappear, or gaps/seams appear in the model when 
cutting is started. 

Model Export Cut Mode — When toggled "On", causes VERICUT to cut with a more 
accurate internal cutter representation for better results when using modules like Model 
Export or OptiPath. Only toggle "On" when the additional accuracy is required as it can 
have an impact on processing speed. 
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NC Program Review Options 
The following options only apply to NC Program review and what is displayed as you 
step back through a toolpath. 
 
Replace Material When Stepping Back — When toggled "On", removed material will 
be replaced as you step back through the toolpath. 

NOTE:   Replace Material When Stepping Back and FastMill mode (ref, FastMill, 
on the Motion window, in the Project menu section, also in the VERICUT Help section) 
are mutually exclusive. 

When Replace Material When Stepping Back is toggled "On", VERICUT will turn 
FastMill "Off" Conversely, if FastMill is toggled "On", VERICUT will turn Replace 
Material When Stepping Back "Off. VERICUT will display a pop-up notification when 
these situations occur. 

 
Animate Machine When Stepping Back — When toggled "On", the machine will 
animate as you step back through the toolpath. 
 
NOTE:  These two options must be set before simulating the toolpath in VERICUT to 
have the feature available in NC Program Review. 
 
 
To Properties window
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Properties window, Tolerance tab 
Location: File menu > Properties 

 

Features on this tab set tolerances for the simulation. The tolerance values control the 
accuracy of the cut stock model, simulated circular motion and other interpolated 
motions, whether or not certain errors get written to the error log, and the accuracy of 
cylinders, cones and other revolved models and tool assemblies for collision checking. 

 

 
 

Interpolation Tolerance — This value is used to interpolate intermediate positions 
during NURBS, circular, and helical motions. This tolerance is also used by the Detect 4-
Axis Rotary Motion APT setting to determine if sequential GOTO locations can be 
performed as a single 4-axis motion- ref. Project menu > Processing Options > APT 
Settings: Rotary tab. 

Minimum Error Volume — This value sets a threshold for the minimum volume of 
material that must be removed by a fast feed motion or holder collision in order for an 
error to be reported. If the volume removed by an error motion is less than this value then 
no error is reported in the log file or logger for the motion and the error count is not 
incremented.  

However, any volume of material removed by a fast feed motion or holder is always 
shaded in the error color (typically red), regardless of the volume. Thus small volume 
errors may be shaded red but will not be reported in the log file or logger if the volume is 
less than Minimum Error Volume.  

The Minimum Error Volume value is in cubic units (inch or millimeter). Use this setting 
to filter very small fast feed and holder collisions from VERICUT's error reports. The 
default value "0" causes VERICUT to report all fast feed and holder/stock collision 
errors. 

Model Tolerance — This value is used when displaying revolved models such as 
cylinders, cones, and revolved profiles. It is also used when displaying the revolved 
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image of a turning stock model created from an IGES profile. Accuracy of cylindrical 
tool assemblies displayed in a machine view are also affected by this value. 

This value has a small effect on collision checking accuracy for revolved models used to 
represent machine components or fixtures. 

Cutting Tolerance — This value sets the accuracy of VERICUT's cut stock model. The 
Base Cut Tolerance on choices below determine how the value is used to establish the cut 
stock accuracy. Increasing the Cutting Tolerance value increases the speed of the 
simulation and various other operations, and uses less memory, but reduces the accuracy 
of the cut stock model. Decreasing the value improves accuracy of the cut stock model, 
but reduces speed and increases the memory required by the cut stock model. 

The cutting tolerance affects the accuracy and speed of AUTO-DIFF, Model Export, and 
OptiPath. A smaller Cutting Tolerance produces more accurate results but takes longer to 
process. VERICUT's ability to detect small holder collisions and fast feed errors are also 
affected. The speed of dynamic rotate/pan/zoom operations and the time required to 
create the refined image in the workpiece view are also affected. 

NOTE:  This feature is only available when the first setup in a project is active. For 
subsequent setups, this feature is grayed out. 

Base Cut Tolerance on — Controls how VERICUT applies the Cutting Tolerance to set 
the accuracy of the cut stock model. 

Tool Size — When selected, VERICUT scans the current tool path files and analyzes the 
geometry of all cutters used by the NC programs. The Cutting Tolerance value is applied 
as a chordal deviation on curved tool shapes (diameter, corner radius, etc). The smallest 
calculated chord length or cutter profile segment is then used to set the accuracy of 
VERICUT's cut stock model in order to reliably create cut features with the tools used by 
the current NC programs. This option is recommended when faster simulation speed is 
important. This is the default setting. 

Stock Size — When selected, VERICUT applies the Cutting Tolerance value directly, 
creating the cut stock model at the specified accuracy. The tool path files are not scanned 
to detect the cutters used. The value represents the size of the smallest cut feature 
VERICUT can detect.  

NOTE:  It is very important to understand that the value represents the size of a cut's 
volume measured in any direction. Thus, cuts that are larger than the Cutting Tolerance in 
at least one direction will be detected by VERICUT.   

For example, a .001" axial depth cut by a .25" ball end mill produces a volume with the 
following shape: 



VERICUT HELP – File menu 
 

 
 
As a general practice, setting Cut Tolerance Based on Stock Size to one-fourth (1/4) the 
size of a cut volume's span will detect the cut. Thus in this case, to detect a .001" deep cut 
by a .25" ball end-mill, set Cut Tolerance to .007" or smaller. However, results can vary 
depending on the shape of the cut volume. 
The Stock Size option is recommended when an exact value is desired for VERICUT's 
cut stock model accuracy, independent of the tools used. 
NOTE:  This feature is only available when the first setup in a project is active. For 
subsequent setups, this feature is grayed out. 
 
 
To Properties window
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Preferences window 
Location: File menu > Preferences 

  

Opens a window enabling you to specify the VERICUT project file (.VcProject) that you 
want displayed when you start the next VERICUT session, the number of "recent files" 
that you want VERICUT to remember, and the PDF reader/web browser that you want 
VERICUT to use for online Help. 

  

  

  

Start-up tab — Use the features on this tab to specify the VERICUT project file 
(.VcProject) that you want displayed when you start the next VERICUT session, the 
number of "recent files" that you want VERICUT to remember. 

PDF/HTML tab — Use the features in this tab to specify the Adobe Reader and/or 
Internet Browser that you want VERICUT to use to display online Help. 

 

OK — Saves the window settings and closes the Preferences window. 

Cancel — Closes the Preferences window without saving the window settings. 
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Preferences window, Start-up tab 
 
Use the features on this tab to specify the VERICUT project file (.VcProject) that you 
want displayed when you start the next VERICUT session, the number of "recent files" 
that you want VERICUT to remember. 
 
 

 
 

Open standard VERICUT project — When toggled "On", the standard VERICUT 
project is displayed upon startup. The standard VERICUT project is either 
vericut.VcProject, or vericutm.VcProject, in the "library'" directory of your VERICUT 
installation depending on the way environment variable, CGTECH_DEFAULT_UNITS, 
is set.  

Start a new project — When toggled "On", the VERICUT session opens ready to start a 
new project. 

Open last project — When toggled "On", the new VERICUT session opens with the 
same project file that was open when you closed the previous VERICUT session. 

Choose project file on startup — When Toggled "On", VERICUT displays the Open 
Project window at startup enabling you to select a project file. 

# of recent files remembered — Use this feature to specify the number of "Recent Files" 
that you want VERICUT to remember and display. 

Clear all lists of recent files — Use this feature to clear all "Recent Files" lists. This 
includes the "Recent Files" lists in the File menu in the main VERICUT window, Report 
Template window, and in the Inspection Sequence window. 

 
 
To Preferences window
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Preferences window, PDF/HTML tab 
 
Use the features in this tab to specify the Adobe Reader and/or Internet Browser that you 
want VERICUT to use to display online Help. 
 
 

 
 
 

Adobe Reader — Enter the path/file name in the Adobe Reader text field, or use the 
Browse button and use the file selection window that displays, to specify the Adobe 
Reader that VERICUT is to use to display online Help. 

NOTE:  This feature is only available on Windows machines. On UNIX machines, the 
Adobe Reader will be accessed through the internet browser. 

 
Internet Browser — Enter the path/file name in the Internet Browser text field, or use 
the Browse button and use the file selection window that displays, to specify the internet 
browser that VERICUT is to use to display online Help. 

Both of the above settings are stored in the Preferences File. For more information on the 
Preferences File, see Summary of VERICUT File Types, in the Getting Started with 
VERICUT section. 
 
 
To Preferences window
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Convert 
 
See Converters and CAD/Cam Interfaces in the CGTech Help Library. 
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Custom Interface 
Location: File menu > Custom Interface 

Toolbar short cut for accessing Custom Interface:   

 

Opens a file selection window that enables you to select an existing custom VERICUT 
User Interface for use; or for editing an existing, or creating a new custom interface with 
VERICUT Customizer. 

  

 
  

Folder "tree"— Enables you to specify the location for new custom interface folder or 
select an existing custom interface folder. All files related to the notebook and custom 
interface are stored in this folder. 

Shortcut — Displays the Shortcut option list providing quick access to files in your 
Working Directory, or CGTech library and sample files. Use the "Folder Up" icon to 
move to the next higher level in the Folder "tree". 

Folder — Use this text field to enter a /path/folder name to open an existing custom 
interface notebook, or to create a new custom interface folder and open a new "empty" 
custom interface notebook. You can also  use the Folder "tree" to specify the path then 
append the name for the new custom interface folder in the text field,. 

OK — Opens an existing custom interface notebook or creates the new custom interface 
folder and displays new "empty" custom interface notebook. 

Cancel — Ends book selection and returns to VERICUT. 
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Introduction to VERICUT Customizer 
The VERICUT Customizer, or "Customizer", is a standard VERICUT feature that 
provides the tools to create a custom simplified VERICUT User Interface. VERICUT 
Customizer is designed to simplify VERICUT usage for specific jobs or classes of jobs. 

Include only the VERICUT functionality that you need in a custom interface and 
eliminate the need to search through the wide range of features that are presented in 
VERICUT's "full function" standard user interface to find the ones they need to use.  

VERICUT Customizer:  

• Enables you to graphically arrange and label buttons, choice lists, check boxes, 
etc. in a way that is most meaningful in your particular work environment. 

• Enables you to include instructions and pictures within the interface to prompt or 
explain to the user how to use VERICUT to accomplish their job. 

• Enables you to produce a simplified user interface that will make "new" or 
"occasional" VERICUT users productive with minimal training. 

  

What does a custom VERICUT interface look like? 

 
 

A custom VERICUT interface consists of two main parts, the "notebook" and the 
VERICUT main window. 

 



VERICUT HELP – File menu 
 

 
Notebook 
This is a simplified VERICUT user interface. It has been designed for a particular type or 
class jobs. It contains only the functionality essential to the particular job type without the 
complexity of the standard "full functionality" VERICUT user interface. A notebook can 
be created with both "feature" and "help" pages.  

Feature Pages -  
Contain features (buttons, text fields, choice lists, etc.) that enable you to pass 
necessary information to VERICUT for processing. Each of the features selected 
for use on the feature pages can be labeled in the language and/or terminology 
that is most appropriate for the intended end user. Feature pages use XML files to 
store feature information. 

Help Pages -  
Used to include instructions, explanations and pictures within the custom 
interface to assist the user in providing the necessary information to VERICUT. 
Help pages are HTML files and GIF or JPEG images to illustrate the instructions. 

 

VERICUT Main Window 
The VERICUT main window in a custom user interface is similar to the standard 
VERICUT main window without the main menu bar and a lot less icons. This makes 
using VERICUT much easier to use for those who do not need the full range of 
functionality provided by the standard VERICUT user interface.  

  

What is involved with creating a custom VERICUT interface? 
Creating and deploying a custom interface for use by VERICUT users involves the 
following seven steps. Each of the steps listed below is described in the following 
section. 

1. Set up a default user file. 

2. Creating the notebook. 

3. Determining the size of the notebook. 

4. Adding custom interface features. 

5. Adding custom interface help. 

6. Test the custom interface. 

7. Make the custom interface available for use. 
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Setting up the Custom Interface Default Project File 
  

Each customized interface notepad references a default project file. This project file is 
retrieved by VERICUT each time the notebook is opened. It is advisable to preset as 
many parameters as possible in the default project file. Doing this will minimize the 
number of features that will be required in the customized interface notebook and make it 
much simpler to use. 

It cannot be stressed too much that the key to creating a concise, easy to use custom 
interface is attention to detail in the design of the default project file. While there are 
seven steps involved in creating a custom interface, it is estimated that as much time will 
be spent on this first step as the other six put together. If you get the default user file 
right, the remaining steps to create the custom interface will be much easier and the 
resulting notebook will be much simpler to use. 

The following topics should be considered when setting up a default user file for use with 
a specific notebook: 

• Use of colors  

• Cut mode (Standard or FastMill)  

• Units  

• Tolerances  

• Conditions for AutoSave  

• Layout, orientation and attributes of Views  

• Configuration of status window  

• Report, log and result file names  

• Machine and fixture models  

• Toolpath type  

• Tool change technique  

• Motion, G-Code and APT settings  

• Location of stock model within stock component  

• Tool and OptiPath library  

• Control parameters  

• Machine parameters  

Many of the parameters associated with the above topics can be set using features 
displayed on the feature pages of the notebook, but if they are not going to change, there 
is no reason to include them in the notebook. Just set them in the default project file. 
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After all, the purpose of the custom interface is to simplify the use of VERICUT.  
   
In many instances, creating multiple notebooks that reference different default user files 
can simplify the use of a custom interface. For example, if you are creating a notebook to 
lead a machine operator through processing a toolpath in VERICUT before running it on 
the machine, it could be beneficial to create a notebook and corresponding default user 
file for each machine/controller combination on the shop floor. That way the operator 
does not have to enter machine/controller information every time. Just call up the 
appropriate notebook enter the toolpath information, then process.  
   
Notebooks should be created in such a way that the user is can only save the user file 
with their input under a different name. Default project files should also have permissions 
set as "read only" and stored in "write protected" directories and folders so they do not 
accidentally get modified.  
   
   
Now that you have tailored a project file for the notebook you intend to create, it's time to 
create the notebook. 
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Creating the Custom Interface Notebook 
  
Creating a custom interface notebook: 
Select File > Custom Interface in the VERICUT main menu to display the Select book's 
folder window shown below. 
  

 
 

 Folder "tree"— Enables you to specify the location for the custom interface folder. All 
files related to the notebook and custom interface are stored in this folder. 

Shortcut — Displays the Shortcut option list providing quick access to files in your 
Working Directory, or CGTech library and sample files. Use the "Folder Up" icon to 
move to the next higher level in the Folder "tree". 

Folder — Use this text field to enter a /path/folder name, or use the Folder "tree" to 
specify the path and append the name in the text field, for the new custom interface 
folder. 

OK — Creates the folder and displays the new custom interface notebook. 

Cancel — Ends book selection and returns to VERICUT. 
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The notebook: 
  

 
  

Notice that when the notebook is created it contains no pages. Adding pages will be 
discussed later. The custom interface notebook header shows the folder that the notebook 
is associated with. The main menu bar contains the following options: 

  

File: 
Open — Displays the Select book's folder window allowing you to open another custom 
interface notebook for editing or create a new notebook. 

Recent — Displays a list of recently opened files. To open a file in the list, select the 
desired file. 
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Close Book — Closes the VERICUT custom interface and displays the standard 
VERICUT interface. 

Exit VERICUT — Ends the VERICUT session. 

  

Layout: 

 — Positions the notebook on the left side of the VERICUT main window. 

 — Positions the notebook on the right side of the VERICUT main window. 

 — Overlays the notebook on top of the VERICUT main window. Left click on 
the notebook's header and drag to any position.  

Minimize — Reduces the notebook size to only display the custom Interface header 
and main menu bar. 

One Page — Use to display the custom interface notebook as a single page. 

Two Pages — Use to display the custom interface notebook as two pages. 

  

Help: 
On VERICUT — Starts VERICUT Help. 

About VERICUT — Opens a window that displays information about the current 
VERICUT session. 

  

Notebook modes: 
User mode:  
When a notebook is in "user" mode it can only be used to interact with VERICUT. It 
cannot be modified or edited in any way. When a notebook is opened, it is always in 
"user" mode, even when it is new and empty. If password protection for "author" mode is 
in effect, the following window will be displayed when the F7 key is used to enter 
"author" mode: 

 

Password — Enter the correct password in the text 
field and select Unlock to allow entry to "author" 
mode. 

Unlock — Use with password above, to allow 
entry to "author" mode. 

Cancel — Use to dismiss the access window. 
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Author mode: 
When a custom interface notebook is in "author" mode, pages and features can be added 
or removed, text and labels can be edited and the size of the notebook can be changed. 
Use the F7 key on the keyboard to switch between "user" and "author" modes. When you 
are in "author" mode, the notebook changes as seen in the illustration below. 

 
Notice that "(284x554)" has been added to the end of the menu bar. This number 
represents the current size of the notebook in pixels. While you are in "author" mode you 
can change the size of the notebook. Click on one of the corners or edges and drag to 
change the notebook size like any other window. The size of the notebook that is set in 
"author" mode is what the user will have to work with. The size of the notebook is fixed 
for the user. The position of the notebook can be changed by the user but not the size. See 
Sizing the Custom Interface Notebook below, for more information on determining the 
appropriate size for the notebook. 
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Notice also that a row of icons has been added to the sides of the notebook. The icons on 
the right are used to add or remove pages and save the notebook. The icons on the left are 
used to edit the text on notebook help pages. They remain grayed out and inactive until 
help pages are added to the notebook. 

Finally, the following options have been added to the File menu: 

User File — Enables you to specify the default .usr file that is associated with the 
custom interface notebook. 

Protect — This item enables the author to prevent the user from entering "author" 
mode without entering a password. Selecting Protect displays the Protection window 
which enables you to specify whether or not to use password protection for the 
notebook while in "user" mode and to specify a password. 

 

 
 

 

Password — Enter a password in the 
text field that will allow entry to 
"author" mode. 

Lock — Use to turn on password 
protection for "author" mode. 

Unlock — Use to turn off password 
protection for "author" mode. 

Cancel — Use to exit the Protection 
window without making changes. 

 

To add password protection for entering "author" mode: 

1. Type a password in the text field 

2. Select the Lock button. 

3. Save the notebook using the Save all changes icon. 

The next time that the notebook is opened, if the user uses the F7 key to enter "author" 
mode, they will be prompted to enter the password before being allowed into "author" 
mode. 

Use the Unlock button while in "author" mode to remove an existing password 
protection. 

  

Allow Close — This item enables the author to prevent the user from exiting the custom 
VERICUT interface and returning to the standard VERICUT interface. This item toggles 
"on" and "off". 

If Allow Close is toggled "on" (indicated by a checkmark), the Close Book option will 
appear in the File menu when in "user" mode allowing the user to exit the custom 
VERICUT user interface and return to the standard VERICUT user interface. 
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 If Allow Close is toggled "off" (indicated by no checkmark), the Close Book option will 
not appear in the File menu when in "user" mode preventing the user from exiting the 
custom VERICUT user interface and returning to the standard VERICUT user interface. 

  

Adding pages to the notebook: 
Before you can add features or help text to the notebook you need to add pages. Add any 
combination of feature pages and help pages. Keep in mind that two pages are displayed 
at once. It makes a lot of sense to have alternate feature pages and help pages. One 
advantage of this user interface style is that it can lead the user through a specific 
sequence of steps. 

Use the icons illustrated below to add pages to or remove pages from the notebook. 

NOTE:  If you do not see the icons below on the right side of the notepad, you are not in 
"author" mode. Use the F7 key on the keyboard to switch to "author" mode. 

  

  

  

 

  

Help Page   

Feature Page 

  

 

  

Remove Upper Page 

 Insert Upper Page 

 Insert Lower Page 

 Append Page 

 Remove Lower Page 

 Save all changes 
  

  

Remove upper page — Use to remove the displayed upper page from the notebook. 

Insert upper page — Use to insert a page into the displayed upper position of the 
notebook. Select HTML or Form from the pop-up menu to specify the type of page to 
create. 

HTML — Use to create a help page.  

Hint: You can tell a help page by its white background. 

Form — Use to create a feature page. 

Hint: You can tell a feature page by its gray background. 

Insert lower page — Use to insert a page into the displayed lower position of the 
notebook. Select HTML or Form (described above) from the pop-up menu to specify the 
type of page to create. 
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Append page — Use to add a page to the end of the notebook. Select HTML or Form 
(described above) from the pop-up menu to specify the type of page to create. 

Remove lower page — Use to remove the displayed lower page from the notebook. 

Save all changes — Use to save all changes made to the notebook. This includes 
notebook size changes, pages added or removed, and page content added or edited.  

NOTE:  There is no "undo" capability in "author" mode so saving often is highly 
recommended. 

  

Once you have added some pages, use the following to move around in the notebook. 

Click on one of the "dog-eared" corners in the upper page (or use the Page Up key on 
the keyboard) to turn back one page in the notebook. 

Click on the one of the "dog-eared" corners in the lower page (or use the Page Down 
key on the keyboard) to turn forward one page in the notebook. 

Use the Ctrl and Home keys on the keyboard at the same time to move directly to the 
first page of the book.  

Use the Ctrl and End keys on the keyboard at the same time to move directly to the 
last page of the book. 

  

Now that you have created the notebook, it's time to decide on the size of the notebook. 
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Sizing the Custom Interface Notebook 
A customized interface notebook retains the size set while in "author" mode and cannot 
be changed by user. This is because information on one page does not reposition to the 
next page if the size of the notebook is reduced, nor are scroll bars used if a page contains 
more information than will fit. To do so would be contrary to the idea of a simplified user 
interface.  

You need to decide on the size of the notebook, which in turn determines the size of its 
pages, before you start adding content. The size of the notebook can be changed later, but 
if you make it smaller you may be spending a lot of time cutting and pasting between 
pages.  

To help determine the appropriate size for the notebook, try to answer the following 
questions: 

1. What is the resolution of my target user's screen?  

2. How large does the VERICUT main window need to be?  

3. How much space to the left or right of the VERICUT main window remains for 
the notebook? Positioning the notebook on either of the main window is clearly 
preferable. 

If the answer to this last one is "Not enough!", is it reasonable to overlay the 
notebook on top of the VERICUT main window?  

As a starting point, you might try allocating 3/8ths of the screen's width for the notebook. 
You can adjust the notebook size by dragging its edges or corners as you would any other 
window. The numbers on the right side of the notebook's menu bar will continuously 
update as you re-size the notebook. If your target screen resolution is 1280 x 1024, and 
you have decided to allocate 3/8ths of the width to the notepad, you could manipulate the 
window until you see (480 x 990), leaving some space for the Windows taskbar.  If your 
target user has a Windows based platform, you do not want to use screen's full height or 
the notebook will be partially hidden behind the Windows taskbar.  
   
Use the Save all changes icon ( ) located on the right side of the notebook to save the 
notebook with its size and position.  
   

Now that you have established the size of the notebook, and thus the size of its pages, 
you can add features to the pages. 
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Creating Custom Interface Feature Pages 
  

Now that you have created and sized the notebook, it is time to add features to the feature 
pages. The user interacts with features in the notebook to enter numbers, select files, 
make choices from a limited set of options and see results. As the author of a custom user 
interface notebook it is your task to arrange a collection of features so the user can 
specify all the parameters needed to get his or her job done. The way that you lay out the 
features within the notebook, and use help pages, enables you to lead the user through a 
logical sequence of actions to accomplish the required task. 

If your notebook does not yet contain feature pages, or you need additional ones, use the 
procedure described in Adding Pages to the Notebook to add them. 

  

Feature Page Layout: 

 
  

A "feature" page is easily distinguished from a "help" page by its gray background. 
Features can only be added to "feature" pages. They cannot be added to "help" pages. In 
order to add features to the page you must be in "author" mode. 

Within a page, features are laid out in two columns. The left column will only be as wide 
as the widest feature that it contains. All features placed in the right column will expand 
to fill the remaining width. Use blank spaces within features in the left column to control 
sizing of the two columns. Adding blank spaces to the longest feature in the left column 
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will increase the width of the left column, thereby decreasing the width of the right 
column. Add or remove blank spaces to the longest feature in the left column until the 
desired column balance is achieved.  

Typically the left column will contain labels explaining the purpose of the corresponding 
feature in the right column, although you are not restricted to this convention. The first 
feature that you place in a form will always go to the left column. 

  

What Features Are Available? 
The following feature types are available for use in any combination on the feature pages 
of your notebook. 

FEATURE DESCRIPTION 

 
Labels the purpose of adjacent features. 

 

Text Fields are used to enable the user to input 
character information to, or receive results 
from VERICUT. 

 

Numeric Fields are used to input one or more 
numeric values. Can also be used to input 
numeric data requiring calculations like 
"3+31/64". 

 
File Selection Boxes are used to input file 
names or browse for the file using the icon. 

 

Choice Lists are used to present a limited set 
of options in a drop-down list 

 
Check Boxes are used for options requiring 
only a simple on/off condition. 

 

Radio Buttons are used as an alternate method 
of presenting a limited set of options. There 
can only be one set of radio buttons used on 
each feature page. Only one of the radio 
buttons will be active at a time. When one is 
selected, all others in the set become 
deactivated. 

 
Buttons are used to trigger actions like file 
conversion or display a secondary window. 

 
MDI Buttons are used to input machine 
control functions. 
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MDI Numeric Fields are used to input numeric 
data to machine control functions. 

  
 
Adding Features: 

 

While in "author" mode (use F7 key on your keyboard if necessary 
if necessary), move the cursor to an unoccupied area of the page 
and click the right mouse button. You will see a pop-up menu like 
the one shown on the left, enabling you to select one of the various 
feature types described above. As each feature is added to the page 
you will notice that initially they contain question marks "???" for 
text. Type over the "???" with the desired text. You can edit the 
text of an existing feature by clicking in it and making the changes. 
Remember that features on the page are positioned in just two 
columns. The first feature is added in the left column. Initially it 
appears in the center of the page. As soon as you add another 
feature to the right of it, it repositions the first one from the center 
to the left edge of the page. 
Continue adding the desired features to the page, or until the page 
is full. At that point, add another feature page and continue. Note 
that you can insert a feature between two existing rows by 
carefully positioning the cursor between them. 

  

 

You may have noticed that the pop-up menu of feature types has another 
choice, Paste, that we have not discussed yet. If you right-click on one of 
the features that you have already put on the page, you will see the pop-up 
menu shown on the left. Select either the Cut or Copy options, then right-
click on an empty area of the page. The feature type pop-up menu discussed 
above will display. Selecting the Paste enables you to move or copy the 
feature. This is also the way that you can move or copy features to another 
page if necessary. Delete enables you to remove an existing feature from 
the page. 

  
 
Connecting the Features to VERICUT: 
To this point the features that you have added to your notebook may look great but they 
are not yet functional. They need to be connected to the parameters and functions of 
VERICUT so that they produce the desired result when put to use by the user. These 
connections to VERICUT are accomplished by using the Details option that appears 
when you right-click on a feature. This is the same pop-up menu that contained the Cut 
and Copy options discussed above. 

 The interaction that follows is dependent on the feature type, although some feature 
types require similar interaction. Each of the topics listed below is described in detail on 
the following sections. 
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Labels and Text Fields  

Numeric Fields  

File Selection  

Choice Lists and Radio Buttons  

Check Boxes  

Buttons  

MDI Buttons and Numeric Fields  

   
Once you have finished adding functional feature pages to the notebook, it's time to add 
some help pages. 
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Custom Interface - Labels and Text Fields 
While in "author" mode, right-clicking on either a label or a text field on a feature page 
and selecting Details, displays essentially the same window. The only difference is that 
the one for label features has a set of radio buttons that enable you to adjust its alignment. 
The tree that dominates these windows is identical. It is organized to reflect VERICUT's 
menu structure. Each "leaf" in the tree represents a text parameter. When selecting 
between using a label or a text field, keep in mind that a user can only read a label, but 
can edit the content of a text field. Most label features in a notebook will not need to be 
associated with a VERICUT parameter. They will simply be used to describe other 
features on the feature page. 
To connect a feature to a parameter, simply expand the tree till you find the parameter 
you are looking for, select it and click OK. You can also use these windows to check on 
an existing association, in which case you would use the Cancel button afterwards.  
  
Label Feature Window   

  
  
  
Label features can be used to display the text 
output of certain VERICUT parameters. The label 
feature window to  the left illustrates how a label 
can be used for this purpose. The label is associated 
with the second line on X-Caliper's Feature/History 
tab, which presents the coordinates of a selected 
geometry feature's datum (such as a sphere's 
center). When the user selects a geometry feature in 
the VERICUT graphics area, the text of the label 
will change to display the resulting text, just as it 
would be displayed in the X-Caliper window. 
 It is also possible to associate a text field feature 
with such a parameter, but it is probably not a good 
idea to do so unless the user will need to copy and 
paste the text to another application.  
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Text Feature Window   

  
  
  
The text feature window to the left illustrates how a 
text field feature can be associated with the 
operating system's print command for use by 
VERICUT's ShadeCopy function.  
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Custom Interface - Label/Text Field Parameter List 
  
  

File Shade Copy Print Command   
    Annotation   
        
        
Setup Motion Start At   
    Stop At   
        
  G-Code Block Skip Character   
        
  APT Settings Rotation Center   
    Goto Format   
        
        
Analysis X-Caliper  Feature/History Feature 1 
      Feature 2 
      Feature 3 
      Feature 4 
      Feature 5 
      Feature 6 
      History 1 
      History 2 
      History 3 
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Custom Interface - Numeric Fields 
  

While in "author" mode, right-clicking on a numeric field on a feature page and selecting 
Details, displays the window illustrated below. The title of the window is the current text 
from the numeric field. Note that you can also specify the maximum number of decimal 
places used to display the parameter. For an integer, such as the number of cuts between 
automatically saved ShadeCopy images, use zero decimal places.  

The tree that dominates the window is organized to reflect VERICUT's menu structure. 
Each leaf in the tree corresponds to a numeric parameter that appears in one or more of 
VERICUTS's standard user interface windows. Each of them can be placed on a feature 
page independently, though some will almost always appear in sets.  A good example is 
the direction of the light that illuminates each view, represented by an (I, J, K) vector. 
The three parameters that control the location of a stock model relative to the stock 
component's datum are another, but they can be combined with three choice lists to 
provide some extra functionality that is not currently available in the standard VERICUT 
user interface. 

To connect a feature to a parameter, simply expand the tree until you find the parameter 
you are looking for, select it and click OK. You can also use these windows to check 
existing associations, in which case you would use the Cancel button afterwards.
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Numeric Field Feature Window   

  
  
  
Defining the three dimensions of a stock block is 
another good example. 
 In the numeric field feature window displayed on 
the left, a numeric field feature is associated with 
the Length (X) dimension of a stock model block. 
When combined on the feature page with numeric 
fields associated with the Width (Y) and Height (Z) 
values, the user can quickly and easily define a 
stock block 
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Custom Interface - Numeric Field Parameter List 
  
  
File Convert IGES   Tolerance 
          
    Surface   Tolerance 
        Offset 
        Base Location 
          
    VDAFS   Tolerance 
          
    Binary CL   Minimum 

Cutter Height 
          
  Model Export Grid Count     
    Global Angle     
    Tolerance (Grid)     
    Plane Size     
    Number of Slices     
    Local Angle     
    Tolerance (Slice)     
          
  Properties Circle Radial 

Tolerance 
    

    Interpolation 
Tolerance 

    

    Minimum Error 
Volume 

    

    Model Tolerance     
    Cutting 

Tolerance 
    

          
  AutoSave In Process # of Cuts   
          
    Shade Copy # of Cuts   
          
      Margins Left 
        Right 
        Top 
        Bottom 
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      Render   
        Width 
        Height 
          
      View Angle   
          
    VERICUT Solid # of Cuts   
          
          
          
View Attributes Light (IJK)     
          
  Section Cuts     
    Delay     
          
          
Model Block Length (X)     
    Width (Y)     
    Height (Z)     
          
  Auto Block Offset     
          
  Cone Height (Z)     
    Base Radius     
    Top Radius     
          
  Cylinder Height (Z)     
    Radius     
          
  IGES File Tolerance     
    Offset Amount     
    Base Location     
          
  Location 

Relative tp 
Parent 

X     

    Y     
    Z     
          
          
Setup Motion Start At Line Number   
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    Stop At Num of Cuts   
      Line Number   
          
    Stop At Max 

Errors 
    

    Stop At Max 
Warnings 

    

    Fast Feed     
    Skip Cut     
    Min. Cutter 

Height 
    

    Holder 
Clearance 

    

          
  G-Code Settings   Ignore Data 

after Column 
        Rotary Feed 

Motion Tol 
        Rotary Rapid 

Motion Tol 
          
    Turning   CSS Maximum 

RPM 
          
    WireEDM   Wire Diameter 
        Work Table XY 

Plane 
        XY Plane to UV 

Plane 
          
  APT Settings Max Tool Axis 

Angle 
    

    Tool Axis Reset 
Angle 

    

    Default 
CLEARP 

    

    GOHOME R 
Dist 

    

          
  Machine Default Near 

Miss 
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Analysis AUTO-DIFF Solid Gouge 

Tolerance 
  

      Excess 
Tolerance 

  

          
    Point Gouge 

Tolerance 
  

      Excess 
Tolerance 

  

      Gouge Check 
Distance 

  

      Excess Check 
Distance 

  

      Default 
Normal (IJK) 

  

          
    Profile Gouge 

Tolerance 
  

      Excess 
Tolerance 

  

          
    Constant Gouge 

Check 
Tolerance   

          
    Compare by 

Region 
Minimum 
XYZ 

  

      Maximum 
XYZ 

  

          
          
OptiPath Override All 

Feedrates % 
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Custom Interface - File Selection 
  

While in "author" mode, right-clicking on a file selection feature on a feature page and 
selecting Details, displays the window illustrated below. The title of the window is the 
current text from the feature, in this case the file's path and name.  

The tree that dominates the window is organized to reflect VERICUT's menu structure. 
Each "leaf" in the tree represents an input or output file.  

To connect a file selection feature to a file type, simply expand the tree till you find the 
file type you are looking for and select it.  To connect a widget to a file type, simply 
expand the tree till you find the one you are looking for and select it. 

You can also supply a prompt which will be used in the file selection window when the 
user clicks on the browse icon ( ) to the right of the feature. If the file type has one or 
more commonly used extensions, you can specify them as a filter for this window also. In 
this case we have just used "*.olb" to narrow the choices to OptiPath libraries, but for 
toolpaths you could use a compound filter, such as "*.tp;*.apt;*.cls". The user can always 
override the filter.  

When you are satisfied with the properties of the file selection feature, click on the "OK" 
button. You can also use these windows to check existing associations, in which case you 
would use the Cancel button afterwards. 
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File Selection Feature Window  

  
  
  
  
  
In the example window on the left, a file 
selection feature is being associated with the 
OptiPath library. 
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Custom Interface - File Selection Parameter List 
  
  
File User File     
  Working Directory     
        
  Convert IGES Input File 

      Output File 
        
    PolyFix Input File 
      Output File 
        
    Surface Input File 
      Output File 
        

    VDAFS Input File 
      Output File 
        
    Binary CL Input File 
      Output File 
      APT Table File 
        
    Export Model File   
    Edit   
        
  ShadeCopy Output File   
        
  AutoSave In Process Auto Save 
      Auto Error 
        
    Shade Copy Auto Save 
      Auto Error 
        
    VERICUT Solid Auto Save 
      Auto Error 
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Info G-Code Report     
  Control Report     
        
        
Model Stock Model File   
    IGES File   
        
  Design Model File   
    IGES File   
        
  Cut Stock     
        
        
Setup Toolpath     
  G-Code APT Output File   
    G-Code Log File   
  Tool Library     
  Control     
  Machine     
        
        
OptiPath OptiPath Library     
  Optimized File     
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Custom Interface - Choice Lists and Radio Buttons 
  

While in "author" mode, right-clicking on either a choice list or radio button on a feature 
page and selecting Details, displays essentially the same window. The only difference is 
that the one for choice list features has a table of choices at the bottom of the window and 
the one for  a radio button feature has a single drop-down list. The title of  the window is 
either the text of the current choice in the choice list or the caption of the radio button.  

The tree that dominates these windows is identical. It is organized to reflect VERICUT's 
menu structure.  Each "leaf" in the tree represents a set of choices for a single parameter.  

To connect a feature to a parameter, simply expand the tree till you find the parameter 
you are looking for and select it. Select an option from those available in the Choice pull-
down for each Item, and then click OK. The interaction is slightly different for choice 
lists and radio buttons and described in more detail below. You can also use these 
windows to check on an existing association, in which case you would use the Cancel 
button afterwards. 
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Choice List Feature Window For a choice list feature, 

selecting a parameter in the tree, 
causes the Choice column of the 
table at the bottom of the window 
to be filled with the set of options 
that are appropriate for the 
selected parameter. Each cell of 
the Choice column is itself a 
choice list containing the set of 
options that are appropriate for the 
selected parameter.   
The text that will appear to the 
user in the choice list appears in 
the Item column of the table. 
Double-click on the item to edit 
the text. You can also edit the text 
for each item in the choice list 
from the feature page while in 
"author" mode. 
To associate each item with a 
particular option: 

1. Click on an item in the 
Item column so that it 
becomes highlighted. 

2. Click on the corresponding 
row in the Choice column 
to expand the pull-down of 
available options. 

3. Click on the option in the 
pull-down to associate it 
with the item. 

4. When you have finished 
associating the items with 
options, click on the OK 
button. 

You can provide the user with a 
more limited set of options than is 
available in the standard 
VERICUT user interface by 
simply including fewer items in 
the Item column.  
The items that you include can be 
in any order. To change the order 
of items, use the small blank 
buttons on the left edge of the 
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table to drag rows to different 
positions. 

  
  
Radio Button Feature Window   

For radio buttons, selecting a parameter in the tree, 
causes the Choice pull-down at the bottom of the 
window to be filled with the set of options that are 
appropriate for the selected parameter. Keep in 
mind that there can only be one set of radio buttons 
on each feature page so when picking a parameter 
for one radio button, you are actually picking it for 
all the others on the page. The same is true if you 
change the parameter associated with a radio 
button. It will change for all the other radio buttons 
on the page also.  
In either case you will need to associate a particular 
option for each individual radio button. 
To associate an option with a radio button, simply 
click on the Choice pull-down to expand it and 
click on the desired option. Click OK. 
The text for radio buttons can only be edited on the 
feature page while in "author" mode. 
As with choice lists, you do not need to include a 
radio button for all of the available options. Include 
fewer radio buttons on the feature page to simplify 
the interaction for the user. 

  

Most of the parameters in the tree correspond to functionality that is available in 
VERICUT's standard user interface. The exceptions are the three parameters located 
under Model > Relative Location. These parameters control the location of a stock 
block model relative to the stock component's datum and when combined on a feature 
page with certain other features provide some extra functionality for automating the 
placement of a stock block that is not currently available in the standard VERICUT user 
interface. 
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Example - Automatic Stock Block Placement 
  

The following example shows how you can use a custom user interface to automate the 
placement of a stock block at the machine origin. This cannot be accomplished using the 
standard VERICUT user interface. 

The upper three numeric field features are 
connected to the X, Y and Z parameters 
respectively, located under Model > Block in 
the numeric field "Details" tree representing 
the length, width and height of a stock block. 
When the user changes one of the values, all 
models in the stock component are replaced by 
a single block with the specified dimensions.  
The lower three numeric field features are 
connected to the X, Y, and Z parameters 
respectively, located under Model > Relative 
Location in the same tree. When the user 
changes one of these values, the origin of the 
block (the X min, Y min, Z min corner)  is 
positioned at the specified offsets. 
The three choice lists in the lower left corner 
are connected to the parameters located under 
Model > Relative Location in the choice list 
"Details" tree. These features are unique to a 
custom interface and do not correspond to any 
of the features in the standard VERICUT user 
interface. They can be used to locate any of the 
block's corners, mid-edges or mid-faces to the 
specified location. As shown in the sample at 
the left, the center of the bottom face of the 
block is designated as the block's origin.  
If a dimension of the block is changed, the 
position of the block remains unchanged. For 
example if block width is increased to 3, it 
would grow by 1/2 a unit in the +Y and -Y 
directions, thereby keeping the center of the 
bottom face position unchanged. 

  

  

 If you decide to use one or more of these choice lists, it is possible to limit the options 
available to the user. Each list can contain up to four choices but not all choices need to 
be included in the list. For example, the list for the Z axis has options for "Z", "Z Low", 
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"Z Mean" and "Z High". You may decide that "Z Mean" makes no sense in your 
application and could omit that choice from appearing the list.  

However, you should never omit the "X", "Y" or "Z" choices from the choice lists. These 
are needed to position the block by specifying values directly in one of the numeric entry 
fields because none of the predetermined positions is appropriate. For example, if the 
block is 1.5 units high and the user enters a Z location of -0.5, the choice list should not 
display "Z Low", "Z Mean" or "Z High". Instead it should be able to display just "Z".  

You can of course alter the text of the choices, so instead of using "Z Low" and "Z High", 
you could display "Z Minimum" and "Z Maximum", or "Bottom Face" and "Top Face" or 
any other suitable text. 

NOTE: The three parameters for automating the location of a stock block are not 
applicable to other types of primitives, such as cylinders, cones, polygon files or IGES 
files. 
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Custom Interface - Choice List/Radio Button Parameter 
List 
  
  
File Convert IGES Output File Type 
      Output File 

Format 
      Normal Direction 
      Surface Input 

Mode 
        
    PolyFix Input File Type 
      Output File Type 
      Output File 

Format 
        
    Surface Input File Type 
      Output File Type 
      Output File 

Format 
        
    VDAFS Output File Type 
      Output File 

Format 
      Normal Direction 
        
    Binary CL Input File Type 
        
  Export Model File Type   
    File Format   
    Output Color   
    Coordinates   
    Units   
    Process   
    Slice Direction   
        
  Colors Brightness   
        
  Properties Default Units   
    Display Resolution   
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    Default Machining Type   
    Base Cut Tolerance On   
        
  Shade Copy Type   
    Method   
    Shading By   
    Orientation   
    Paper Size   
    Light Location   
        
        
View Attributes View Type   
    Draw Mode   
    Background   
        
        
Model Location Relative 

to Parent 
X   

    Y   
    Z   
  Normals     
  Units     
  Visibility     
  Mixed Mode     
        
        
Setup Toolpath Toolpath Type   
    Tool Change By   
        
  Motion Start At   
    Stop At   
    Drill Cycle   
    Tool Display   
    Cut Color Method   
    Control Point   
        
  G-Code Settings Programming 

Method 
        
    Block Skip Apply Switch 

Value 
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    4-Axis Sync Method   
        
  Apt Settings Default Toolpath Units   
    RAPID Motion   
    GOHOME Motion   
    ROTATE   
    ROTABL   
    ROTHED   
    Philosophy   
    Angle Value   
    Direction   
        
  Machine Floor/Wall Orient   
    Ignore Collision between 

Cutter and Stock 
  

        
        
Analysis AUTO-DIFF Stock Display   
    Design Display   
    Comparison Method   
    Comparison Type   
    Normal Direction   
        
        
OptiPath OptiPath Control     
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Custom Interface - Check Boxes 
  

While in "author" mode, right-clicking on a checkbox feature on a feature page and 
selecting Details, displays the window illustrated below. The title of the window is the 
current text associated with the check box. 

The tree that dominates the window is organized to reflect VERICUT's menu structure. 
Each "leaf" in the tree represents an on/off parameter available in the standard VERICUT 
user interface.  

To connect a feature to a parameter, simply expand the tree till you find the on/off 
parameter you are looking for, select it and click OK. You can also use these windows to 
check existing associations, in which case you would use the Cancel button afterwards.  

  

Check Box Feature Window  

  
In the example window on the left a check box 
feature is being associated with the on/off flag that 
determines whether an APT output file is 
generated corresponding to the processed G-Code 
toolpath. 
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Custom Interface - Check Box Parameter List 
  
  
File Convert Surface Project Rectangle 
        
    Binary CL Output Circles 
        
  Export Model Binary   
    Millimeter   
    Group By Color   
    Detect Scallop Planes   
        
  Colors Recycle Cut Color   
        
  Properties Millimeter   
    Stock Consistency Check   
    Model Export Cut Mode   
        
  AutoSave In Process Cutter Change 
      # of Cuts 
      File End 
      Auto Error 
        
    Shade Copy Print Command 
      Annotation 
      Cutter Change 
      # of Cuts 
      File End 
      Auto Error 
      Color 
      Portrait 
      Add output file to 

Report 
      Render 
      Specify image size 
      Shadows 
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    VERICUT Solid Cutter Change 
      # of Cuts 
      File End 
      Auto Error 
        
View Orient Zoom creates new View   
    Standard Rotation Image   
        
  Section Section on mouse pick   
        
  Axes Component   
    Model   
    Machine Origin   
    Workpiece Origin   
    Coordinate System   
    Tool Tip Zero   
    Driven Point Zero   
    Active Coordinate System   
        
        
Info Status SubSystem   
        
    Position Record Number 
      Toolpath Record 
      Machine Axes 
      Tool Tip 
        
    Tool Record Number 
      Change Record 
      Sequence 
      Geometry 
      Description 
      Number 
      ID 
        
    Status Errors 
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      Warnings 
      Time 
      Time % 
      OP Time 
      Distance 
      Distance % 
      Coolant 
        
    Feed Feedrate 
      OP Feedrate 
        
    Speed Spindle 
      OP Spindle 
        
    OP Info Volume Removal Rate 
      Chip Thickness 
        
    Graph Tool Use 
      Cutting Conditions 
        
        
Model Model File Outward   
    Millimeter   
        
  Component 

Attributes 
Disable Auto Direction   

    Reverse Direction   
        
  Import Offset Surface   
    Extend to Rectangle   
        
  Delete Material Update While Simulating   
        
  Save Cut Stock Save With Features   
        
        
Setup Motion Stop At Max Errors   
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    Stop At Max Warnings   
    No Animation   
    Check for Spindle Off   
    FastMill   
    Ignore Undercuts   
    Display Holder in 

Workpiece View 
  

    Tool/Fixture Collision 
Only (no cutting) 

  

    Calculate Min. Cutter 
Extension 

  

        
  G-Code Settings Process Cutter Comp. 
      Scan Toolpath Files 
      Ignore Data After 

Column 
      Apply Acceleration to 

Cycle Time 
        
    Block Skip Immediate 
      Switch 1  
      Switch 2 
      Switch 3 
      Switch 4 
      Switch 5 
      Switch 6 
      Switch 7 
      Switch 8 
      Switch 9 
        
    Turning RPM changes with 

RAPID and CSS 
        
    Process Options Create Apt Output File 
        
  Apt Settings Millimeter   
    MULTAX   
    Process Circles   
    Reverse Circles   
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    Detect Chordal GOTO's   
    Reset Tool Change   
    Process NX or CATIA 

Matrix 
  

    Ignore unrecognized 
Major words 

  

        
    Rapid Motion Square 
        
    GOHOME Motion Retract 
        
    Angle Value Absolute 
        
    Detect 4-Axis Rotary 

Motion 
  

        
  Machine Machine Simulation On   
    Transparent Stock   
    Collision Detect   
    Overtravel Detection On   
        
    Axis Priority Pos/Neg 
      Negative 
        
        
Analysis AUTO-DIFF Settings Stock Display 
      Design Display 
        
    Options Design Consistency 

Check 
      Keep Design Solid 
      Disable Report 
      Report Uncut 

Differences 
      Show Point Vectors 
      Constant Gouge Check 
        
    Compare by Region On 
      Apply Regions Over 
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Entire Stock 
      Improve Cut Stock 

Tolerance 
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Custom Interface - Buttons 
  

While in "author" mode, right-clicking on a button feature on a feature page and selecting 
Details, displays the window illustrated below. The title of the window is the current text 
from the button. 

The tree that dominates the window is organized to reflect VERICUT's menu structure. 
Each "leaf" in the tree represents an action available in the standard VERICUT user 
interface.  

To connect a feature to a parameter, expand the tree until you find the parameter you are 
looking for, select it and click OK. You can also use these windows to check existing 
associations, in which case you would use the Cancel button afterwards.  

A button can contain an icon in addition to, or instead of, the caption. An icon is derived 
from a GIF or JPEG file which you select while in this dialog. An icon's height is limited 
to 16 pixels. If you select a larger icon, it will be shrunk to fit within the button's height, 
but its aspect ratio is maintained. The GIF or JPEG file will be copied to the book's folder 
if necessary, so that the entire book can be handled as a unit. Use the Icon field, at the 
bottom of the Button Feature window, to enter or select the image file to use. 

  

Button Feature Window  
  
  
  
  
  
In the example window on the left a button feature 
is being associated with a request to browse 
VERICUT's help files. When the user presses the 
button, VERICUT Help will display. 
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Custom Interface - Button Parameter List 
  
  

File User File New 
    Open 
    Save 
    Save As 
      
  In Process Open 
    Save 
    Save As 
      
  Working Directory   
      
  Convert IGES 
    PolyFix 
    Surface 
    VDAFS 
    Binary CL 
      
  Export Model   
      
  Edit Toolpath 
    File 
      
  Colors   
  Properties   
      
  Report Create Text Report 
    Create HTML Report 
    Create PDF Report 
    Report Template 
    User-Defined Tags 
      
  Print   
  Shadecopy   
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  Close Book   
  Exit VERICUT   
      
      
View Layout One View 
    Left and Right 
    Top and Bottom 
    1 Left, 2 Right 
    1 Top, 2 Bottom 
    Four Views 
    Add View 
    Delete View 
    Cascade 
    Tile Horizontally 
    Tile Vertically 
    View to Back 
    Always in Front 
      
  Orient Dialog 
    XY 
    YZ 
    ZX 
    YX 
    ZY 
    XZ 
    H-ISO 
    V-ISO 
    Zoom In 
    Zoom Out 
    Fit 
    Fit All 
    Refine 
    Last Refine Display 
    Reverse 
    Reset 
      
  Attributes   
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  Section   
  Select/Store View   
  Axes   
      
      
Info Toolpath   
  Status   
  Machine Offsets   
  File Summary   
  VERICUT Log   
  Clear Logger   
      
      
Model Model Definition   
  Auto Block   
  Component Tree   
  Load Stocks   
  Delete Material   
  Revolve Profile   
  Sweep Profile   
      
Setup Toolpath   
  Motion   
  G-Code Settings 
    Variables 
  Apt Settings   
  Cycle Definitions   
  Coordinate Systems   
  Tool Manager   
      
  Control Open 
    Save 
    Save As 
    Words 
    Word/Address 
    Mdi 
    Settings 
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    Advanced Control Options 
      
  Machine Open 
    Save 
    Save As 
    Settings 
      
      
Analysis X-Caliper   
  AUTO-DIFF Dialog 
    Apply 
      
  Comparator   
  Toolpath Review   
  Inspection Sequence   
  Die Sinking Simulation   
      
      
OptiPath OptiPath Control   
  OptiPath Manager   
  Compare Toolpath Files   
      
      
Help Browse   
  About   
      
      
Simulation Reset Model   
  Rewind Toolpath   
  Single Step   
  Play to End   
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Custom Interface - MDI Buttons and Numeric Fields 
  

While in "author" mode, right-clicking on an MDI button feature on a feature page and 
selecting Details, displays the window illustrated below. The title of the window is the 
current text from the MDI button. 

 

MDI Button Feature Window In the "SubSystem" field, enter the index 
number of the subsystem (not the 
subsystem name) that the MDI Action 
command is to be applied to.  
In the "MDI Action" field, enter the 
command(s) to be executed when the MDI 
button is pressed by the user, then click 
OK. 
You can also use the window to check 
what command(s) are currently associated 
with the MDI button, in which case you 
would use Cancel afterwards.  
A default MDI button will contain the icon 
( ), in addition to the caption. But you 
can provide another icon from a GIF or 
JPEG file which you select while in this 
dialog. An icon's height is limited to 16 
pixels. If you select a larger icon, it will be 
shrunk to fit within the button's height, but 
its aspect ratio is maintained. The GIF or 
JPEG file will be copied to the book's 
folder if necessary, so that the entire book 
can be handled as a unit.  

  

While in "author" mode, right-clicking on an MDI numeric feature on a feature page and 
selecting Details, displays the window illustrated below. The title of the window is the 
current MDI command combined with the value from the MDI numeric field.
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MDI Numeric Feature Window  

 

In the "SubSystem" field, enter the 
index number of the subsystem (not 
the subsystem name) that the MDI 
Action command is to be applied to.  
In the "MDI Action" field, enter the 
command to be executed when the 
value in the MDI numeric feature 
field is changed or when the MDI 
icon ( ) is pressed, then click OK. 
Use the Decimal Places field to 
specify the maximum number of 
decimal places to display. For an 
integer, use zero decimal places.  
Once you have entered the desired 
MDI Action command and specified 
decimal places, click OK.  
You can also use the window to 
check what command and decimal 
place value is currently associated 
with the MDI numeric feature, in 
which case you would use Cancel 
afterwards.  

As with an MDI button, you can 
change the icon used with an MDI 
numeric field by specifying an 
appropriate GIF or JPEG file. 
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Creating Custom Interface Help Pages 
 

Now that you have created and sized the notebook and added some features to the feature 
pages, it is time to add some help pages to assist the user in using the custom user 
interface to accomplish their job. Use help pages in the notebook to instruct the user on 
how to use the features or guide then through a sequence of actions to accomplish the 
required task. 

A "help" page is easily distinguished from a "feature" page by the white background. 
Only text and illustrations can be added to "help" pages. In order to add, remove or 
modify text or add, remove or replace illustrations to a help page you must be in "author" 
mode (F7 key). 

If your notebook does not yet contain any help pages, or you need additional ones, use 
the procedure described in Adding Pages to the Notebook to add them. 

Help Page Layout: 
 Each help page is created blank. Click on the help page and begin to type your 
instructions. Use the column of icons located on the right side of the notebook (when in 
"author" mode) to position, place emphasis on portions of text or add "style" to your help 
page. Use the bottom icon in the column to add illustrations to your help page. Each of 
the icons is described in more detail below. 

The first four icons are used to control the appearance of the text. They can be used in 
two ways. As you type you can change the current "mode" by clicking on one of the 
icons. Subsequent text will exhibit the change until you click the same icon again to 
revert to regular characters. Or you can highlight an existing portion of the text and 
update its appearance by clicking on one or more of the icons. A double click will 
highlight a word. A triple click will highlight a line. You can also apply multiple style 
types to your text as illustrated here using bold, italics and underline on the same text. 

 

 

Bold 
Italics 
Underline 
Text Color 
Align Left 
Center 
Align Right 
Add image 
Insert Hyperlink 
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Bold — Use to make selected text bold. 

Italics — Use to make the selected text in italics. 

Underline — Use to underline the selected text. 

Text Color — Displays a color pallet enabling you specify a color for text. Pick one of 
the colored squares to proceed. The darker colors show up best on the white background 
of a help page.  

The next three icons are used to control the position of the text displayed on the page. 

Align Left — Use to align the selected text to the left side of the page. This is the default. 

Center — Use to center the selected text on the page. 

Align Right — Use to align the selected text to the right side of the page. 

Add Image — Use to add illustrations to your help page. The images used for 
illustrations can be in GIF or JPEG format. When you select an image file it is copied to 
the notebook folder so that all elements of the notebook are kept together. Each image 
will be centered in the page and will be at its stored size. If you need to adjust the size of 
an illustration, do so with an image editing software before using on your help page.  

Insert Hyperlink — Use create a hyperlink between the highlighted text and an HTML 
file. Highlight the desired text, select the Insert Hyperlink icon, then use the file selection 
box that displays to specify the file to create the hyperlink to. 
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Sample Help Page: 

 
 
The figure above illustrates a simple example of how you can use a help page to instruct 
the user on how to use the features contained on the feature page below. 
  

Now that you have a complete custom VERICUT interface notebook, it's time to do some 
testing. 
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Testing the Custom Interface 
  

While a notebook is in "author" mode, (size displayed adjacent to the menu items and 
columns of icons displayed on both sides) any changes to the content of features are not 
communicated to VERICUT. To test that all features are connected to the correct 
parameters and function as intended, the notebook needs to be in "user" mode. Toggle 
between these modes with the F7 key on the keyboard 

Unlike many of VERICUT's windows, the notebook window does not use the concept of 
an Apply or OK button to invoke sets of changes. When the user changes the content of a 
feature on a notebook's feature page, that change is sent to VERICUT immediately. For 
many parameters, a change in value does not cause any immediate response. For 
example, changing the number of cuts to be processed when the "Play" button is hit has 
no effect until the toolpath is processed. 

On the other hand, some feature changes will cause an immediate response from 
VERICUT. For example, using a file selection feature associated with the user file will 
cause VERICUT to retrieve the selected file immediately. Similarly, if you have numeric 
fields associated with the dimensions of a block, changing one of the values will cause 
VERICUT to immediately apply the change. With experience you will learn which 
parameters will prepare for a future response and which ones will result in an immediate 
response from VERICUT. 

As you test the notebook try to view it as the targeted user will. Is the purpose of each 
feature clear? Would some different wording in the labels make more sense, or perhaps 
some extra labels? Could an illustration on a help page replace a bunch of words? Do the 
views presented by the notebook's default user file display the process effectively or 
could they be improved? Above all, is it simpler to use and save time for the user? 

If you decide that refinements are needed in the default user file, closing the notebook 
while in "author" mode causes VERICUT's standard user interface to be displayed so that 
you can make those changes.  

  

When you are satisfied with the notebook's behavior, it is time to make your custom 
VERICUT user interface available for use. 
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Making the Custom Interface Available for Use 
  
Notebook folder and file descriptions: 
All of the files that define a notebook are stored in a single folder, the name of the folder 
being the name of the notebook. Some or all of the following file types may be present: 

• HTML files for the help pages. 
Their names will be of the form "Pagexxx.html", where "xxx" is the page number. 

• GIF and JPEG files referenced by the HTML pages. 

• XML files for the notebook and it's feature pages. 
Their names will be of the form "Pagexxx.xml", where "xxx" is the page number. 

• "Page000.xml" which contains information pertinent to the whole notepad. 

Notably absent from the above list is the default user file for the notebook and any files 
referenced by it. It may be beneficial to store the default user file and any associated files 
in the notebook folder to simplify data management. That way, if a notebook's folder 
location is changed, all of the files associated with it move with it.  
   

Making the notebook available: 
Deploying a customized notebook to a target user involves making the folder available. 
This can be done by establishing a network mapping to the folder, or by copying the 
folder to the user's machine. If the default user file and the files which it needs are not in 
the same folder, you may find that the relocated notebook is unable to access the default 
user file. If this is the case, on the target machine use the F7 key to briefly get into 
"author" mode again, switch to the required user file and re-save  the notepad. The user 
file that is displayed at the time you save becomes the notebook's default.  

You can also launch VERICUT each time with a custom user interface instead the 
standard user interface by using the file customizer. bat to start the VERICUT session. 
This file can be found in the \cgtech6x\windows\commands\  folder. The customizer 
.bat file needs to be edited as follows to specify which custom interface notebook to use 
at startup. 

In the customizer.bat file locate the "start" command, shown below, at the end of the file. 

%start_cmd% "%CGTECH_JRE%\bin\javaw" -Xms16m -Xmx64m -Xss4m -
classpath"%CGTECH_CLASSES%;%CGTECH_CLASSES%\CGTech.jar" VeriBook 
%argstr% 
                                                                                                                                                
                                                                

Make sure that the next to the last parameters is VeriBook (not Vericut) indicating that 
VERICUT should be started with a custom user interface instead of the standard user 
interface. 
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Replace the last parameter "argstr" with the path to the desired custom interface 
notebook folder. 

Now simply use customizer.bat to start the VERICUT session with the specified 
notebook instead of with the standard VERICUT user interface. 
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Using a VERICUT Custom User Interface 
 

The following user interface is applicable to the VERICUT Mold & Die and VERICUT 
Grinder products, as well as to any "custom" interface created with VERICUT 
Customizer. 

 

 
 

The user interface consists of two main parts, the "notebook" and the VERICUT main 
window. 

  

Notebook VERICUT Main Window 

Help Page 

Feature Page 



VERICUT HELP – File menu 
 

The Notebook 
The notebook consists of a menu bar and two different types of pages. Click on the upper 
page corners to page back in the notebook. Click on the lower page corners to page 
forward in the notebook. 

Menu Bar 
File: 

Open — Displays the Select book's folder window allowing you to open another 
custom interface notebook for editing or create a new notebook. 

Recent — Displays a list of recently opened files. To open a file in the list, select the 
desired file. 

Exit VERICUT — Ends the VERICUT session. 

  

Layout: 

 — Positions the notebook on the left side of the VERICUT main window. 

 — Positions the notebook on the right side of the VERICUT main window. 

 — Overlays the notebook on top of the VERICUT main window. Left click on 
the notebook's header and drag to any position.  

  

Help: 
On VERICUT — Starts VERICUT Help. 

About VERICUT — Opens a window that displays information about the current 
VERICUT session. 

  

Help Pages 
Help pages contain instructions, explanations and pictures to assist you in providing the 
necessary information to VERICUT. Help pages are easily recognized by the white 
background. 

Feature Pages 
Feature pages contain features (buttons, text fields, choice lists, etc.) that enable you to 
pass necessary information to VERICUT for processing. Each of the features on a 
"feature" page is described on the previous "help" page. Feature pages are easily 
recognized by the gray background. 

Some features display another window enabling you to provide additional information to 
VERICUT. Use the F1 key to display more information about the displayed window. 
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VERICUT Main Window 
 

The VERICUT main window is composed of six distinct areas, each with different user 
interaction. The window header displays the VERICUT version and the current session 
units (inch or millimeter). This window can be resized and/or moved like most other 
windows, via dragging the window header, sides or corners. 

 

 
 

Tool Bar 

Graphics Area 

Animation  
Slider 

Status Lights 
Progress 

Bar 
Simulation (VCR) 

Controls 

Message 
Logger 
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Toolbar 
 

VERICUT's Toolbar provides quick and easy access to the view manipulation 
functions/features. 

 
To see what is associated with a Toolbar icon, simply position the cursor over the icon 
and a tip appears.  

  

Dynamic viewing options 
These options use mouse actions to dynamically orient the object in view. Mouse actions 
are different, depending on the active option-see the table below for details. Dynamic 
viewing options: 

Icon: Name: Action: 

 
Dynamic X Rotation Horizontal rotation- drag 

mouse up/down in direction 
to rotate 

 
Dynamic Y Rotation Vertical rotation- drag 

mouse left/right in direction 
to rotate 

 
Dynamic Z Rotation Screen plane rotation- drag 

mouse left to rotate CCLW, 
right for to rotate CLW 

 
Dynamic XY Rotation Horizontal/vertical 

combined rotation- drag 
mouse up/down/left/right in 
direction to rotate 

 
Dynamic Pan Pan/translate- drag mouse in 

the direction pan 

 
Dynamic Zoom Zoom/magnify- drag mouse 

up to zoom in, down to 
zoom out 
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Shortcut: The following keys provide instant access from the keyboard to dynamic 
viewing options (press and hold keys while dragging): Dynamic Zoom — <Ctrl>, 
Dynamic Pan — <Shift>, Dynamic XY — <Ctrl> + <Shift>. Mouse actions are the same 
as above. 

  

Static viewing buttons 
These buttons use various mouse actions to zoom, fit, and reverse the object in view. See 
the table below for details. 

 

 Icon: Name: Action: 

 
Zoom to Box (standard 
mode) 

Left-click and move mouse 
to trap area to zoom (press 
<Esc> to interrupt 
rubberbanding) 

 
Zoom In / Zoom Out Zooms in/out approx. 20% 

each time clicked 

 
Fit Fits object in active view 

 
Refine Display Refines the display to 

improve image quality 

 
Last Refine Display Restores the last refined 

display 

 
Reverse Reverses viewing direction, 

as if you stood behind the 
object 

 
To learn more about interacting with VERICUT through the main window components, 
review the following topics under Interacting with VERICUT, in the Getting Started 
section of VERICUT Help. 
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Create Report 
Location: 

File menu > Create Report, in the main VERICUT window. 

File > Create Report, in the Inspection Sequence window. 

File > Create Report, in the Tool Manager window. 

  

Opens the Save VERICUT Report window enabling you to specify the /path/filename for 
the report file to be created. If "User-Defined" information has not been previously 
defined, (either using the User-Defined Tag Values window or during a previous use of 
Create Report) VERICUT will then prompt you for any unspecified User-Defined Tag 
values, then generate the report using the "current" report template. Choose one of the 
following report formats: 

Text — Use this option to create a report in text format. 

HTML — Use this option to create a report in HTML format. 

PDF — Use this option to create a report in PDF format. (PDF report generation 
based in part on iText (www.lowagie.com/iText). 

 

See Introduction to VERICUT Reports , in the Getting Started section of VERICUT 
Help for information on report template files supplied with VERICUT. 

See Create a Report Using a Template, in the Using VERICUT section, in the CGTech 
Help Library for additional information.  

http://www.lowagie.com/iText
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Print View 
Location: File menu > Print View 

Toolbar shortcut:  

Opens a window enabling you to print images of VERICUT view ports. Each view port is 
automatically fit to the printable area and printed on a separate page. All view ports are 
printed. Features on this window are standard print window features that enable you to 
access printer settings, specify number of copies, etc. Consult your printer documentation 
for more information. 
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Record Movie 
Location: File menu > Images > Record Movie 

Toolbar short cut for recording images:   

Opens a window enabling you to record images as a VERICUT Image file, or an AVI 
file. Images in all view ports are recorded. Images can be recorded interactively in 
VERICUT, or via batch processing. After recording is stopped, you can view the file via 
the File menu > Images > VERICUT Playback or File menu > Images > AVI 
Playback function, depending on the file type. 

This window appears differently, depending on the Output Format choice. See the 
VERICUT Image Record window and AVI Image Record window topics below for 
additional information. 

 

NOTES:  
1. The size of the graphics area directly affects the display size of the recorded 

Image file. Make the VERICUT window larger to record larger images. 

2. Recording animations captures all changes in the graphics area. Recorded tool 
paths with lots of small motions can generate large Image files sizes. Consider 
using the Animation Slider, located at the bottom of the VERICUT main window 
to reduce Image file size. 

3. AVI record is not intended for use with cascaded views. 

4. AVI record does not support capture of the Profile view. 

5. The AVI record feature is not available on UNIX platforms. 
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VERICUT Image Record window 
Location: File menu > Images > Record Movie 

 

These features are available when recording images in a VERICUT Image file. 

 

 

 
  
 
 

Output Format group: 

These options determine the output format and the /path/filename of the recording file. 

Output Format = VERICUT — Format of the output image file is VERICUT 
Image file. 

Filename — Name of the file to receive recorded images. 
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Snapshot Events group: 
These options control when a snapshot image is recorded. Each selected event causes a 
snapshot to be recorded when that event occurs.  

Error — Record a snapshot when VERICUT detects an error. 

Cutter Change — Record a snapshot when the cutter has been changed. 

N Records — Record a snapshot after a specified number of tool path records have 
been processed. 

Processing Complete — Record a snapshot when tool path processing has been 
completed. 

  

Animation Control group: 
These options determine when animation images are recorded, and how they will be 
replayed.  

Disabled — Do not record animation images. 

Forward — Record animation images to play in the forward direction only. 

Forward & Backward — Record animation images to play in forward or backward 
direction. 

  

Append Options group: 
These options control appending images to an existing Image file. 

Append — When active, appends recorded images to the end of an existing Image 
file. 

Append Delay — When appending images, inserts the specified number of seconds 
of delay prior to appending new images. 

  

Pauses group: 
These features control the recording process, and insert delays into the VERICUT Image 
file. 

Insert Stop — Inserts a stop point into the Image file. The stop point is used by the 
Stop at Inserted Stop play back feature. 

Insert Delay — Inserts the specified seconds of delay. 

 
Record — Starts recording images based on current window settings, VERICUT window 
size, shape, and layout. Recording must be stopped before the Image file can be viewed. 
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Stop — Stops recording. The Image file can be viewed via File menu > Images > 
VERICUT Playback. 

Snapshot — Records a single snapshot image. 

Close — Closes the Image Record window. 
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AVI Image Record window 
Location: File menu > Images > Record Movie 

 

NOTE:  This feature is not available on UNIX platforms. 

 

These features are available when recording images in an AVI file.  

 

 
 
 

Output Format group: 
These features define the format and /path/filename for the recorded file. 

Output Format = AVI — Format of the output image file is an AVI file. 

Filename — Name of the file to receive recorded images. 
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Recording Screen Area group: 
These features control the screen area to record. 

Start Left / Start Top — Identifies the start point (top-left location) of the screen 
area to record. 

Width / Height — Width and height (in pixels) of the screen area to record, as 
measured from the top-left start point. 

Select Region — Uses a rubber-banding box to indicate region to record. Left-click 
to define the start point of the region, then move the mouse to trap the area to record. 
Press <Esc> to interrupt rubber-banding. 

Select All — Records all views. 

  

AVI Frame Rates group: 
These features set the rate at which to record image frames. Frame rate controls the speed 
at which the AVI file plays back. 

Playback Rate — Number of frames to record per second. Increasing the recording 
frame rate causes the AVI file to play back faster. 

  

Pauses group: 
These features control the AVI recording process, and insert delay into the AVI file. 

Pause / Continue — Pauses (or continues) AVI file recording. VERICUT motions 
simulated after pausing are not recorded. 

Insert Delay — Inserts the specified seconds of delay. 

 

Select a CODEC — Select the desired CODEC from the pull-down list. Use the CGTech 
environment variable, CGTECH_CODEC_FILTER, to remove invalid CODECs from 
the list. 

See Environment Variables, in the Getting Started section for additional information. 

 

Record — Starts recording animation images based on current window settings, 
VERICUT window size, shape, and layout. Recording must be stopped before the Image 
file can be viewed. 

Stop — Stops recording. The AVI file can be viewed via File menu > Images > AVI 
Playback. 

Snapshot — Records a single frame image. 

Close — Closes the Image Record window. 
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Playback VERICUT Movie 
Location: File menu > Images > Playback VERICUT Movie  

Toolbar short cut for playing back VERICUT images:    

 

Opens a "VERICUT Player" window to load and play back an Image file recorded by the 
File menu > Images > Record Movie function. Images are played in a separate "image 
player" window enabling simultaneous access to the VERICUT main window and its 
functions. The size and view layout of the image player window is as recorded. However, 
this window can be moved, or minimized using standard window controls. Recorded 
machining status is also seen when the Status window is open while playing. 

 

 
 

File menu 
Functions in this open new Image files, compare existing Image files, and provide control 
over playing back recorded images. 

Open — Open an existing Image file. 

Compare Files — Opens a window to configure the player to compare two Image 
files. Features enable you to play both Image files simultaneously, and identify 
differences between them. 
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Playback Options — Opens the Image Playback Options window for controlling 
playing back recorded images. See the Playback Options window topic below for 
additional information. 

Close — Closes the VERICUT Player window. 

 
Playback (VCR) icons  
These icons control playing and rewinding recorded images. To see what is associated 
with an icon, position the mouse cursor over the icon and a tip appears. Playback VCR 
icons: 

Icon: Name: Function: 

  Play Play images in the forward 
direction 

  Next Snapshot Advance to the next snapshot

  Skip to End Advance to file end 

  (or press Escape key <Esc>) Stop Stop playing back images 

  Play Backwards Play images in the backward 
direction 

  Previous Snapshot Rewind to the previous 
snapshot 

  Skip to Start Rewind to the Image file 
beginning 
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Image Playback Options window 
 

 
 

Configure group: 
Speed — Controls how fast images are played back. Actual speed varies, depending 
on computer hardware. Stop the play back to access this feature. 

Snapshot Delay — Number of seconds to pause after displaying a snapshot. 

  

Control group: 
These options provide additional stop control by event, or the ability to play in a 
continuous loop (without stopping). Options: 

Stop at Error — Stop replay at an error detected by VERICUT. 

Stop at File End — Stop replay when the end of a toolpath file end has been reached. 

Stop at Cutter Change — Stop replay when the cutter has been changed. 

Stop at Every N Events — Stop replay after a specified number of events (frames) 
have been recorded. 

Stop at Inserted Stop — Stop replay on a stop inserted by pressing "Insert Stop" on 
the File menu > Images > Record Movie window. 

Loop — Play in a continuous loop until interactively stopped via pressing   
(Stop), or pressing the Escape key <Esc>. 

   

OK — Applies the settings and closes the Image Playback Options window. 
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Apply — Applies the settings and leaves the Image Playback Options window open. 

Cancel — Cancels the current setting changes and closes the Image Playback Options 
window. 
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Playback AVI Movie 
Location: File menu > Images > Playback AVI Movie 

Toolbar short cut for playing back VERICUT images:   

 

NOTE:  This feature is not available on UNIX platforms. 

 

Opens an "AVI Player" window to play back an AVI files recorded by the File menu > 
Images > Record Movie function. Assuming your system has an AVI player installed, 
the AVI images are played in a separate "image player" window enabling simultaneous 
access to the VERICUT main window and its functions. The size and view layout of the 
image player window is as recorded. 
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View Capture window 
Location: File menu > Images > View Capture 

                File menu > AutoSave > View Capture tab: Properties 

Toolbar short cut for accessing View Capture:   

 

Opens a window to capture VERICUT images and format them for printing or importing 
into desktop publishing applications. View Capture can also output printer-formatted files 
that you can move to other computers or printing devices. Images can be captured and 
output interactively or automatically (via AutoSave), or via batch processing. When 
configuring this window for future use or batch processing, press OK (instead of Output) 
to save the window configuration without outputting a View Capture image file. Hint: 
Avoid having to re-configure this window by creating a master Project file containing the 
modified View Capture values. 

 

 
 

Attributes tab — Features on this tab are used to configure the attributes for formatting 
captured VERICUT images. 

Postscript Settings tab — Features on this tab provide information about centering and 
annotating PostScript format images on the printed page. 

Render tab — Features on this tab enable you to specify the output size of "rendered" 
images. 
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OK — Saves the View Capture window settings and closes it without outputting an 
image file. 

Output — Outputs the current VERICUT image to the specified file. File format is 
determined by the View Capture window configuration. 

NOTE:  Output is not applicable when setting up File menu > AutoSave > View 
Capture tab: Properties. 

Cancel — Closes the View Capture window without saving setting changes or outputting 
an image file. 
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View Capture window, Attributes tab 
Location: File menu > Images > View Capture 

Toolbar short cut for accessing View Capture:   

 

Features on this tab are used to configure the attributes for formatting captured 
VERICUT images. 

 

 
 

Type — Type of format in which to capture VERICUT images. Printer-ready and 
electronic formats are available. Options: 

• PostScript — Postscript format. 

• EPSF — Encapsulated PostScript File. 

• TIFF — Tag Image Format File. 

• JPEG — JPEG compressed format. (JPEG image support based in part on the 
work of the Independent JPEG Group.) 

 

Method — Method of coloring the captured image. Options: 

• Standard — black and white only 

• Grayscale — black and white with shading 

• RGB Color — Red-Green-Blue values for each pixel 

• Palette Color — Red-Green-Blue color tables 

• CMYK Color — Cyan-Magenta-Yellow-Black color tables 
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Shading By — Method of shading black and white images. Options: 

• Intensity — Shade by light intensity only, for example: the brightest yellow color 
is the same shade of gray as the brightest blue color. 

• Color — Shade by color differences and light intensity. 

 
Orientation — Controls image orientation on the printed page: Landscape or Portrait. 

 
Output File — Use to specify the name of the file to receive image data when the Output 
button is pressed. Enter the \path\file name in the text field or click on Browse and use 
the Save File selection window to specify the file. 

NOTE:  When images are output via File menu > AutoSave, the file names specified 
on the AutoSave, View Capture tab are used instead. 

 
Add output file to report — When toggled "On", and Output is pressed, the output 
JPEG images are available for use in "standard" VERICUT reports.  

NOTE:  Add output file to report is not available when setting up File menu > 
AutoSave > View Capture tab: Properties. 

 
Render — Use to toggle the Render feature on and off. When Render is toggled "on" 
and the Output button is pressed, the active view will be rendered and a JPEG file will 
be output with the name specified in the Output File field. Pressing the "Stop" button 
during rendering will stop the process. 

 By default, the width and height of the active view is used for the size of the rendered 
image. Use Specify image size on the Render tab to specify a different width and/or 
height for the rendered image. 

• Currently, JPEG is the only supported output. 

• Method, Shading By and Orientation are not applicable to Render. 

• AUTO-DIFF models, Travel Axis, design components/models and Temp Stock 
components are not supported by the Render feature. 

NOTE:  Generating a "rendered" image can take considerably longer than generating a 
standard View Capture image. 
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Standard View Capture image Rendered image 
 
 
 
To View Capture window
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View Capture window, Postscript Settings tab 
Location: File menu > Images > View Capture 

Toolbar short cut for accessing View Capture:   

 

Features on this tab provide information about centering and annotating PostScript format 
images on the printed page. 

 

 
 

Center / Margins options — Controls image placement on the printed page. Options: 

• Center — Center image in the middle of the page. 

• Margins — Place image according to specified margin dimensions (see below). 

Left / Right / Top / Bottom — Margin dimensions, as measured from the corresponding 
edges of the paper. 

Paper Size — Size of paper to print. 

Annotation — When active, includes annotated text with the image. Annotation includes 
the current date, tool path file name, tool path record number being processed, and user 
specified text. 

 

Tip: If you want to add a note that uses special characters add an "escape" backslash 
character ("\") before each special character.  
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Example: 

To enter this annotated text => Part Number (1234) ((due date 12/01/00)) 
Type this in the Annotation field => Part Number \(1234\) \(\(due date 12\/01\/00\)\) 
 
To View Capture window 
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View Capture window, Render tab 
Location: File menu > Images > View Capture 

Toolbar short cut for accessing View Capture:   

  

Features on this tab enable you to specify the output size, whether or not to use shadows, 
and light source location for "rendered" images. 

 

 
 

Specify image size — Toggle "On" to use the Width and Height values specified below 
for creating an image using Render. By default, the width and height of the active view is 
used for the size of the rendered image. 

Width — Use to specify the width for a rendered image. 

Height — Use to specify a height for a rendered image. 

Shadows — Toggles Shadows On/Off. 

Light Location — Use to specify one nine fixed light locations. Choose from: Top Left, 
Top, Top Right, Left, Center, Right, Bottom Left, Bottom, and Bottom Right. 

View Angle — This field enables you too define the view angle. Valid range is from 1 to 
80 degrees. 

 
 
To View Capture window
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AutoSave window 
Location: File menu > AutoSave 

Toolbar short cut for accessing AutoSave:   

 

Opens a window to configure VERICUT to automatically save In Process files, View 
Capture image files, (such as JPEG, PS, EPSF, or TIFF files) or VERICUT Solid (.vct) 
files. Saving is based on user specified events or when VERICUT detects errors during 
tool path processing. Auto-saving is especially useful to save data during batch 
processing. 

 

 
 

 

In Process tab — Features on this tab control automatic saving of In Process files. 

View Capture tab — Features on this tab control automatic saving of ShadeCopy image 
files. 
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VERICUT Solid tab — Features on this tab control automatic saving of VERICUT Solid 
files. 

 

OK — Saves all tab settings and closes the AutoSave window. 

Cancel — Closes the AutoSave window without saving settings. 
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AutoSave window, In Process tab 
Location: File menu > AutoSave window 

                Project menu > Output window 

VERICUT toolbar short cut:   

  

Features on this tab control automatic saving of In Process files, or "IP files". 

 

 
  

Auto Save options — These options control when VERICUT automatically saves IP 
files. Click on the box to the left of the event to toggle On/Off. Each selected event 
causes a file to be saved when that event occurs. Options: 

• Cutter Change — Save an IP file when the cutter has been changed. 

• # of Cuts — Save an IP file after a specified number of cuts. Enter the number of 
cuts in the # of Cuts text field. 

• File End — Save file at the end of  tool path processing. Choose either End of 
each File (end of each NC program file), or End of each Setup, or End (end of 
the program) from the pull-down list. 
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In Process File — Use to specify the base name for IP files saved. Enter the 
\path\filename in the text field or click on Browse and use the selection window to 
specify the file. 

Unique file names are maintained by appending the tool path number and line number of 
the record causing the event to the end of the base file name. Naming convention for 
auto-saving files is: <IPfilename>n1_n2.ip where "<IPfilename>" is the name 
specified in the In Process File field, "n1"=sequential tool path number, and 
"n2"=number of the record causing the auto-save event. 

The following examples assume the AutoSave (or Output) window configuration shown 
below. 

 

 
 

Example 1:  One tool path processed, tool change on record #10 => test1_10.ip 

Example 2:  Two tool paths processed, tool change on record #10 in both tool paths 
=> test1_10.ip (from tool change in tool path #1), test2_10.ip (from tool change in 
tool path #2) 

Example 3: Two tool paths processed, tool path one tool change on record #10, tool 
path two tool change on record #5 => test1_10.ip (from tool change in tool path #1), 
test2_5.ip (from tool change in tool path #2) 

 



VERICUT HELP – File menu 
 

Auto Error On — When active, VERICUT automatically saves an IP file when an error 
is detected. 

In Process File — Specifies the base name for IP files saved due to errors. Similar to In 
Process File for the Auto Save options (see above), unique file names are maintained by 
appending the line number of the record causing the error to the end of the specified IP 
file name. 

 
 
To AutoSave window
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AutoSave window, View Capture tab 
Location: File menu > AutoSave 

                Project menu > Output 

VERICUT toolbar short cut:   

  

Features on this tab control automatic saving of View Capture image files (JPEG, PS, 
EPSF, or TIFF). 

 

 
 

Print Command — When toggled "Off", sends graphical data to the specified View 
Capture image file. When toggled "On", executes the print command that sends raw 
graphical image data to the printer. 

By default, the "prshade" command executes the "prshade" command file containing 
operating system commands typically used to print images on your computer. If printing 
fails, correct the entry in the Print Command field, or use an ASCII text editor (NOT a 
word processor) to edit the "prshade" command file to have the proper print command for 
your computer/printer. 

Properties — Opens the View Capture window to access settings for file formatting 
and printing. 
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Auto Save options 
These options control when VERICUT automatically saves View Capture image files. 
Click on the box to the left of the event to toggle On/Off. Each selected event causes a 
file to be saved when that event occurs. Options: 

• Cutter Change — Save a View Capture image file when the cutter has been 
changed. This feature can also be used to capture images of electrodes used for 
Die Sinking Simulation when they are changed during the burn process.  

• # of Cuts — Save a View Capture Image file after a specified number of cuts. 
Enter the number of cuts in the # of Cuts text field. 

• File End — Save a View Capture image file at the end of tool path processing. 
Choose either End of each File (end of each NC program file), or End of each 
Setup, or End (end of the program) from the pull-down list. 

• View Capture File — Use to specify the base name for View Capture image files 
saved as a result of Auto Save options described above, when the Print 
Command checkbox is toggled "Off". Enter the \path\file name in the text field 
or click on Browse and use the selection window to specify the file. The naming 
convention used for saved files is as described for IP files-see In Process tab for 
details. 

  

Auto Error options 
These options control when VERICUT automatically saves Vie Capture image files due 
to errors. 

• Auto Error On — When toggled "On", VERICUT automatically saves a View 
Capture image file when an error is detected. 

• View Capture File — Use to specify the base name for View Capture image files 
automatically saved as a result of errors detected when AutoError On is toggled 
"On", and the Print Command checkbox is toggled "Off". Enter the \path\file 
name in the text field or click on Browse and use the Save File selection window 
to specify the file. The naming convention used for saved files is as described for 
IP files-see In Process tab for details. 

 
 
To AutoSave window
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AutoSave window, VERICUT Solid tab 
Location: File menu > AutoSave 

                Project menu > Output 

VERICUT toolbar short cut:   

  

Features on this tab control automatic saving of VERICUT Solid (vct.) files. 

  

 
  

Auto Save options 

Use these options to specify the events when VERICUT should automatically save 
VERICUT Solid files. Click on the box to the left of the event to toggle On/Off. Each 
selected event causes a file to be saved when that event occurs. Options: 

Cutter Change — Save a VERICUT Solid file when the cutter has been changed. 

# of Cuts — Save a VERICUT Solid file after a specified number of cuts. Enter the 
number of cuts in the # of Cuts text field. 

File End — Save a VERICUT Solid file at the end of tool path processing. Choose either 
End of each File (end of each NC program file), or End of each Setup, or End (end of 
the program) from the pull-down list. 
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VERICUT Solid File — Use to specify the base name for VERICUT Solid files saved 
due to Auto Save options. Enter the \path\file name in the text field or click on Browse 
and use the selection window to specify the file. 

  

Auto Error options 
Use these options to specify whether or not VERICUT automatically saves VERICUT 
Solid files when an error is detected. 

On — Click on the box to the left to toggle On/Off. When active, VERICUT 
automatically saves a VERICUT Solid file when an error is detected.  

VERICUT Solid File — Use to specify the base name for VERICUT Solid files saved 
when AutoError is active. Enter the \path\file name in the text field or click on Browse 
and use the selection window to specify the file. 

 NOTE: The naming convention used for saved VERICUT Solid files is the same as 
described for IP files-see In Process tab for details. 

 
 
To AutoSave window
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Recent Files 
Location: File menu > Exit 

 

Provides a list of recently opened Project files or User files. Select the desired file from 
the pull-down list. 

List contents are stored in the VERICUT Preferences file. 

 



VERICUT HELP – File menu 
 

 

Exit  
Location: File menu > Exit 

 

Exits (quits) the VERICUT program. Any files that were opened during the VERICUT 
session, such as the Log file, Image file, etc. are automatically closed. You can also exit 
VERICUT by clicking "X" at the top right corner of the VERICUT main window. 

NOTE:  Session information is not automatically saved by VERICUT upon exiting. It is 
the responsibility of the user to decide if session information should be saved before 
exiting. 
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Edit menu 
 

Text File (edit) 
Location: Edit menu > Text File 

 

Opens a text editor window - just load any ASCII text file and start editing. The 
following is a general description of the features available for searching and editing text 
and tool path files throughout VERICUT. The features available in a particular window 
may vary depending on the purpose of the window that they appear in. 
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Menu Bar: 
The menu bar located at the top of the window provides easy access to major functions. 
Each menu contains groups of related functions. Left-click on any menu name to display 
the list of functions available in that menu. Click on the function in the menu you want to 
use. The name of the current file is also displayed in this area. 

 

File:  
Open — Open a file. 

Save — Save the current file. 

Save As — Save the current file under a different name. 

Print — Print the file. 

Exit — Close the window. 

Edit: 
Cut — Cuts the highlighted text in the file listing and puts it in the paste buffer.  

Copy — Copies the highlighted text in the file listing to the paste buffer. 

Paste — Puts the contents of the paste buffer at the location of the cursor in the file 
listing. 

 

Icon Bar: 
 

 
 

The items in the Icon Bar enable you to search for, and/or replace, specific items in the 
file listing, print the file, or exit the window. Moving the cursor over the icon will display 
name of the option. Each feature (from left to right) is described below. 

 

 Open File — Opens a file selection window enabling you to select another file. 

 Save File — Save the current file. 

Line Number or Search Text — Use this text field to enter a line number, or a string of 
text, to search for. 

 Goto Line Number — Moves the cursor in the file listing to the line number 
specified in the Line Number or Search Text field. 
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 Search Forward — Searches forward in the file listing for the text string specified 
in the Line Number or Search Text field. 

 Search Backward — Searches backward in the file listing for the text string 
specified in the Line Number or Search Text field. 

Replacement Text — Use this text field to enter a "replacement text" string. 

 Replace One — Replace one occurrence of text string in the Line Number or Search 
Text field (or the highlighted text in the file listing) with the text string in the 
Replacement Text field. 

 Replace All — Replace all occurrences of the text string in the Line Number or 
Search Text field with the text string in the Replacement Text field. 

 Print — Print the file. 

 Close Window — Closes the window. 

 
 
Shortcut:  Right-click in the Text File Edit window to display the following menu: 
 

 
 
These features provide the same functionality as those available under Edit in the menu 
bar.
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NC Program (edit) 
  

VERICUT Users: 
VERICUT Location: Edit menu > NC Program 

Toolbar short cut for accessing the NC program editor:   

 

Selecting Edit menu > NC Program displays a list of all NC programs and subroutines 
in the project file. Choosing one of the NC program files/subroutines opens a text editor 
window with the selected NC program file/subroutine file loaded and ready for editing. 
Standard text editing features are provided, such as: copy/cut, paste, search, etc. 

  

Mold and Die Users: 
Mold and Die Location:   Analyze, View Files, Print page > Edit the Tool Path File 

Notebook Feature:       

 

Edit the Tool Path File opens a text editor window with the "current" tool path file 
loaded and ready for editing. 

  

Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print page > Edit Grinding Program 

Notebook Feature:      

 

Edit Grinding Program opens a text editor window with the "current" grinder program 
file loaded and ready for editing.  
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WARNING:  Editing the NC program file can cause undesirable results, especially 
when edits are made to portions of the tool path which have already been processed by 
VERICUT. These edits can cause the tool path record number pointer to be out of sync 
with the edited tool path file. In these cases it is recommended to rewind the tool path file 
after editing, and restart the simulation with the last unedited record prior to the first 
addition/deletion. 

 
Menu Bar: 
The menu bar located at the top of the window provides easy access to major functions. 
Each menu contains groups of related functions. Left-click on any menu name to display 
the list of functions that are available in that menu. Click on the function in the menu you 
want to use. The name of the current file is also displayed in this area. 
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File:  
Open — Open a file. 

Save — Save the current file. 

Save As — Save the current file under a different name. 

Print — Print the file. 

Exit — Close the window. 

Edit: 
Cut — Cuts the highlighted text in the file listing and puts it in the paste buffer.  

Copy — Copies the highlighted text in the file listing to the paste buffer. 

Paste — Puts the contents of the paste buffer at the location of the cursor in the file 
listing. 

Restore — Restores the NC program to its un-edited state. 

 

Icon Bar: 
 

 
 

The items in the Icon Bar enable you to search for, and/or replace, specific items in the 
file listing, print the file, or exit the window. Moving the cursor over the icon will display 
name of the option. Each feature (from left to right) is described below. 

 Open File — Opens a file selection window enabling you to select another file. 

 Save File — Save the current file. 

Line Number or Search Text — Use this text field to enter a line number, or a string of 
text, to search for. 

 Goto Line Number — Moves the cursor in the file listing to the line number 
specified in the Line Number or Search Text field. 

 Search Forward — Searches forward in the file listing for the text string specified 
in the Line Number or Search Text field. 

 Search Backward — Searches backward in the file listing for the text string 
specified in the Line Number or Search Text field. 

Replacement Text — Use this text field to enter a "replacement text" string. 
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 Replace One — Replace one occurrence of text string in the Line Number or Search 
Text field (or the highlighted text in the file listing) with the text string in the 
Replacement Text field. 

 Replace All — Replace all occurrences of the text string in the Line Number or 
Search Text field with the text string in the Replacement Text field. 

 Undo Highlighted Changes — Restores the highlighted changes to the original 
state. 

 Print — Print the file. 

 Close Window — Closes the window. 

 
Shortcut:  Right-click in the NC Program Edit window to display the following menu: 
 

 
 
These features provide the same functionality as those available under Edit in the menu 
bar.
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Color window 
 
VERICUT Users: 
VERICUT Location: Edit menu > Colors 

Toolbar short cut for accessing the Color window:   

  

Mold and Die Users: 
 Mold and Die Location:   Other Settings page > Colors 

Notebook Feature:       

  

Cutter Grinder Users: 
Cutter Grinder Location:   Other Settings page > Colors 

Notebook Feature:      

  

Colors opens a window to define the colors seen in VERICUT. Colors are changeable at 
any time. The affect of changing colors is immediate. 
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Assign tab — Features on this tab are used to assign Error, Reset Cut and Background 
colors. 

Cut Colors tab — Features on this tab assign colors to machine cuts made in the 
workpiece. 

Define tab — Features on this tab define colors seen in VERICUT, and control light 
brightness. 

  

OK — Saves tab settings and closes the VERICUT Color window. 

Apply — Saves tab settings and leaves the VERICUT Color window open. 

Cancel — Closes the VERICUT Color window without saving tab settings. 

 
 
Also see "Using Colors in VERICUT", in the Using VERICUT section, in the CGTech 
Help Library.
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Color window, Assign tab 
 

Features on this tab are used to assign Error, Reset Cut and Background colors. 

 

 
 

Error — Color for highlighting unsafe machining conditions (default: "Red"). The "error 
color" will help you identify the following potentially dangerous situations: 

Material removed while cutting too fast (known as a "fast feed" error) 

Cuts in clamps, fixtures, bolts, and other hardware holding the workpiece 

Material removed by non-cutting portions of the tool, such as: tool holders, 
extensions, etc. 

Gouges in a design model (via AUTO-DIFF) 

 

Floor, Ceiling, Wall — Colors of the floor, ceiling and walls displayed in a machine 
view when Background is set to Walls in the View menu > Attributes window. A 
sample machine is shown below with the floor, ceiling and walls in the background. The 
tile affect on the floor is created by alternating the Floor and Ceiling colors. 



VERICUT HELP – Edit menu 
 
 

 
 

Shaded Background — Use to specify the color that will be displayed when the view 
Background attribute is set to Shaded. 

Reset Cut — Color applied to all cuts in the workpiece when a Reset Cut Color 
operation is performed (see below). By default this color is set the same color as the stock 
model to give the appearance of uncut stock, however, any defined color can be selected. 

Reset Cut Color — When selected, the colors of all cuts in the workpiece are changed to 
the single color specified by Reset Cut (see above). 

 
 
To Color window
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Color window, Cut Colors tab 
  

Features on this tab assign colors to the machine cuts made in the workpiece. The items 
displayed on this tab will vary depending on the Color Method selected. 

  

Color Method 
Method of determining colors used to shade machined cuts. Options are:  

Cut Color Table — Cut color is determined by the Cut Sequence/Color list defined in 
the Cut Color Table.  

  

 
  

Cut Seq. / Color list — List of colors used for material cut with a safe cutting 
feed rate (less than the Fast Feed threshold). The cut color list associates colors 
with cut sequences in the NC program file. A new cut sequence is assumed when 
a tool with a different shape is loaded for cutting. All portions of the cutting tool 
shape are considered for differences. When the number of cut sequences exceeds 
the number of cut colors defined in the table, Recycle Cut Color determines the 
cut color for the remaining tools (see below). 
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Double-click on the cut sequence number in the table to edit it. Double-click on a 
color in the table and select from the pull-down color list to change a color. Add 
or remove colors from the pull-down list using the Shade Colors list feature on the 
Color window, Define tab.  

Add — Use to add Cut Sequences/Colors to the list. 

Delete — Use to delete Cut Sequences/Colors from the list. 

Recycle Cut Color — When selected, recycles colors in the cut color list when 
the tool path contains more tools than cut colors defined. For example, assume 
that 4 cut colors are defined. When tool 5 is encountered VERICUT recycles cut 
color 1, tool 6 uses cut color 2, and so on. When this option cleared, the last 
defined cut color is used for cut sequences that follow the last defined cut 
sequence color. Using the example above, tool 4, 5 and 6 would receive the cut 
color defined for cut sequence 4. 

  

Tool Color — Cut color is determined by the tool color property stored in a VERICUT 
Tool Library. 
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Feed Range Color — Cut color is determined by the feed rate programmed in the NC 
program file. 

  

 
  

Feed Range / Color list — List of colors used for material cut within a specified 
feed rate range. The cut color list associates colors with feed rates in the NC 
program file. Using the sample table shown above, cuts using a feed rate between 
0 and 25 will be displayed Aquamarine. Cuts using a feed rate between 25 and 49 
will be displayed Light Steel, and so on. 

Double-click on the Feed Range number in the table to edit it. Double-click on a 
color in the table and select from the pull-down color list to change a color. Add 
or remove colors from the pull-down list using the Shade Colors list feature on 
the Color window, Define tab. 

 

Add — Use to add Feed Ranges/Colors to the list. 

Delete — Use to delete Feed Ranges/Colors from the list. 
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NC Program File Color — Cut color is determined by the Cut Sequence/Color list 
defined in the Cut Color Table method described above except that the Cut Sequence 
changes as the NC program file changes instead of when the tool changes. If a Project file 
only uses one NC program file, then all cuts will be the same color. 

 

 
 
 
 
 
To Color window
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Color window, Define tab 
 

Features on this tab define colors seen in VERICUT, and control light brightness. 

 

 
 

Shade Color list — List of colors that can be used to shade solid objects seen in 
VERICUT, such as: models, cutting tools, and machined cuts (maximum 128 colors). 
The number of shade colors also affects shade quality. The color band at the bottom of 
the window displays the shade variations of the selected color in the list, as impacted by 
the total number of defined colors. Once defined, assign the colors to solid objects using 
the features on the Assign tab and the Cut Colors tab. 

Add — Use to add colors to the Shade Color list. 

Delete — Use to delete colors from the Shade Color list. 

Red-Green-Blue slidebars — Control the amount of red, green, and blue color 
components mixed to define a color. The exact value is shown in the field to the right of 
each slidebar (0=none to 255=maximum). 
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Color List — Opens a window of pre-mixed colors selectable for background, 
foreground, and shade colors. Click on the desired color. 

 

RGB Pick List window 

 
 
Brightness — Controls the amount of light for shading solid objects. Options are: 

High  
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Normal 

 
 
 

 Low 

 
 
 
Flat Colors group: 

Background — Select this option to change the color of the graphics area background 
when View menu > Attributes: Background is set to "Flat". You can also change the 
background to display a shaded color, or machine views can display ceiling, floor, and 
walls. 
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Foreground — Select this option to change the color of items drawn on top of the 
VERICUT display, for example: coordinate system axes, lines indicating the bounding 
region of selected models/components, etc. 

The Background and Foreground colors should be different, or foreground-colored items 
may "blend in" with the background. 

 

To Color window 
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View Menu 
 
Also see "Working with VERICUT Views", in the Using VERICUT section, in the 
CGTech Help Library. 
 
 

Layout (view) 
Location: View menu > Layout  

 

The options in the Layout menu control how many views of the VERICUT model are 
seen, and how they are arranged. All views are contained within the VERICUT main 
window. The size and orientation of the model in each view is individually controlled. 
View port size and layout are saved in the user file.  

One view is considered by VERICUT to be the "active view". A view is made active by 
clicking in it, and is designated by a colored window header. Many VERICUT functions 
are effective only in the active view, including most viewing functions. 

Standard — Sets views of the VERICUT model to one of the standard view layout 
choices. By default standard view layouts are tiled, but you can change this using other 
functions in the Layout menu, or via standard window management features, such as 
dragging, resizing, etc. 

 
Tip:  You can also use the corresponding view layout icons in the Toolbar. 

 
Add View — Adds a view. You can add as many views as desired. What is seen in a 
view (workpiece, machine, etc.) is determined by the view attributes (ref. View Attributes 
window, also in the VERICUT Help section. 
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Shortcut: You can quickly change the attributes or orientation of a view by right-
clicking in the view, and selecting from the displayed menu. See the Graphics Area 
Right Mouse Button Shortcut Menus, in the Getting Started with VERICUT section of 
VERICUT Help for more information. 

 

Delete View — Deletes a view. You can also delete a view via clicking "X" at the top 
right corner of the view window. 

Cascade — Cascades views in an overlapping arrangement. Note that cascaded view 
layouts are not saved by VERICUT. 

Tile Horizontally — Tiles views in a horizontal arrangement. 

Tile Vertically — Tiles views in a vertical arrangement. Examples follow. 

 

Cascaded Tiled horizontally Tiled vertically 

 

 

View to Back — Moves the "active" view to the back. This function can also be accessed 
using the right mouse button in the active view. 

View to Front — Moves the selected view to the front. Selecting "View to Front" 
displays a list of all available views allowing you to select the desired view to be moved 
to the front even if it is obscured by other views in the graphics area.  

Always in Front — Makes the active view remain "always in front" until it is 
specifically moved to the back or until another view is specified as "always in front". 
This function can also be accessed using the right mouse button in the active view. 
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View Orient window 
Location: View menu > Orient 

 

Opens a window to orient the view, including: rotate, zoom, pan, reverse, etc. You can 
view machining from any angle or distance, and change the view at any time during the 
simulation. Views of the workpiece, NC machine, or cutting tools seen in the Tool 
Manager are oriented in the same manner, as described by the sections that follow. In 
general, click in a view to make it active, then change view orientation as required. View 
rotations are described with respect to the "view coordinate system". 

 

 
 

Dynamic Viewing Options: 
These options use mouse actions to dynamically orient the object in view. Mouse actions 
are different, depending on the active option-see the table below for details. Dynamic 
viewing options are also available on the VERICUT Toolbar.  
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Toolbar Icon: Name: Action: 

 
Dynamic X Rotation Horizontal rotation- drag mouse up/down in 

direction to rotate 

 
Dynamic Y Rotation Vertical rotation- drag mouse left/right in 

direction to rotate 

 
Dynamic Z Rotation Screen plane rotation- drag mouse left to rotate 

CCLW, right for to rotate CLW 

 
Dynamic XY 
Rotation 

Horizontal/vertical combined rotation- drag 
mouse up/down/left/right in direction to rotate 

 
Dynamic Pan Pan/translate- drag mouse in the direction pan 

 
Dynamic Zoom Zoom/magnify- drag mouse up to zoom in, down 

to zoom out 

 

Shortcuts:    
1. Use the following mouse features to manipulate the view with a single mouse 

button. 

Dynamic Rotate — Left mouse button, drag. 

Dynamic Pan — Right mouse button, drag. 

Dynamic Rotation — Rotate the thumbwheel toward you to make the displayed 
image larger, away from you to make the displayed image smaller. 

See Dynamic Zoom, Pan and Rotate in the Getting Started with VERICUT 
section for additional information. 

NOTE:  Dynamic Controls (View menu > Dynamic Controls) must be set to 
VERICUT. 
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2. The following keys provide instant access from the keyboard to dynamic viewing 
options (press and hold keys while dragging):  

Dynamic Zoom — <Ctrl>, drag 

Dynamic Pan — <Shift>, drag 

Dynamic XY — <Ctrl> + <Shift>, drag  

Mouse actions are the same as described above. 

 

Standard drawing view buttons- XY, YX, YZ, ZY, ZX, XZ, V-ISO, H-ISO — 
Orients the object in the selected standard drawing view and automatically fits the object 
in the view. 

 
Rotation Options: 
Angles — Absolute rotation about the view coordinate system X Y Z axes, respectively. 
The three values are separated by spaces. 

 

Increment — Degrees of incremental rotation to apply when a rotation button is pressed 
(see below). 

 

Rotation buttons (X+/X-, Y+/Y-, Z+/Z-) — axis and direction in which to apply 
incremental rotation specified by the Increment value. 

 

Spin Center — Specify a point to be used as the center of rotation during dynamic 
rotations. Click in the Spin Center field so that it becomes active, then either enter XYZ 
values (separated by spaces) in the field and click on the Apply button or click on a 
position in the view to specify the Spin Center point. The values are applied to the 
"active" view. If a workpiece view is the active view, the coordinates are relative to the 
origin of the workpiece coordinate system. If the "active" view is a machine view, the 
coordinates are relative to the origin of the machine coordinate system.  

Press  to display the Spin Center marker and activate the point for the active view. 
To de-activate Spin Center point, press the button again. You can specify a different 
rotation point for each view. When you close the View Orient window, the Spin Center 
markers will no longer be displayed but the activated Spin Centers will remain active. 
When you use one of the dynamic rotation features described above in a view with an 
active Spin Center, the Spin Center point will be used as the center of rotation instead of 
the view coordinate system origin. 

Shortcut:  You can quickly change the spin center location by right-clicking in the view, 
select Spin Center from the displayed menu, and then select the desired position in the 
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graphics area. See the Graphics Area Right Mouse Button Shortcut Menus, in the 
Getting Started with VERICUT section of VERICUT Help for more information. 

 

Orient on Feature — Resets the view, normal to the feature selected in the graphics 
area. The modified view is centered on the position of the selection vector. 

 

Zoom creates new View — When toggled on, creates a new view for the zoomed area 
instead of modifying the current view. Also changes the icon in the toolbar to the Zoom 
(create new view mode) icon. 

Shortcut:  You can quickly toggle between the two Zoom modes (standard or create 

new view) by right-clicking on the Zoom to Box icon  , or ,  in the toolbar. 

 

Static Viewing Options: 
These buttons use various mouse actions to zoom, fit, and reverse the object in view. See 
the table below for details. Static viewing options are also available on the VERICUT 
Toolbar.  

 

Button name: Toolbar Icon: Action: 

Zoom (standard mode) 

 

  (Zoom to Box) 

Left-click and move mouse 
to trap area to zoom (press 
<Esc> to interrupt rubber-
banding) 

Zoom ( with Zoom creates 
new View toggled On) 

  (right click on Zoom to 
Box) 

Similar to Zoom (standard 
mode) described above 
except a new view is created 
to display the zoomed area. 

Zoom In / Zoom Out 
    

Zooms in/out approx. 20% 
each time clicked 

Fit 
  (left click) 

Fits object in active view 

Fit All 
  (right click) 

Fits objects in all views 
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Refine 
  (Refine Display) 

Refines the display to 
improve image quality 

Reverse 

  

  

  

Reverses viewing direction, 
as if you stood behind the 
object (see also: "reverse" 
VERICUT command record)

none 
  (Last Refine Display) 

Restores the last refined 
display 

 

Shortcuts:   
1. You can quickly reverse or orient the model in one of the defined views by right-

clicking in the view and selecting from the displayed menu. See the Graphics 
Area Right Mouse Button Shortcut Menus, in the Getting Started with 
VERICUT section of VERICUT Help for more information. 

2. Use the thumb wheel on the mouse to Zoom to Box. Click on the thumb wheel 
and drag the mouse to define the box to zoom to. The zoom takes place when you 
release the thumb wheel. 

See Dynamic Zoom, Pan and Rotate in the Getting Started with VERICUT 
section for additional information. 

NOTE:  Dynamic Controls (View menu > Dynamic Controls) must be set to 
VERICUT. 

 

Reset — Resets the view to the last orientation accepted by pressing Apply, or as it was 
when the Orient window was opened. 
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View Attributes window 
Location: View menu > Attributes 

 

Opens a window to control the attributes of a view, such as: what is seen in a view, light 
source, shading, etc. In general, click in a view to make it active, then change attributes 
as required. Each view has its own view attributes. 

 
 

General tab — The features on this tab enable you to control the display characteristics of 
a view. 

OpenGL Settings tab — The features on this tab enable you to control the display 
characteristics of an Accelerated (OpenGL) view. This tab is only available when 
Accelerated (OpenGL) is toggled "On". 

 

OK — Applies the changes and closes the View Attributes window. 

Apply — Applies the changes and leaves the View Attributes window open. 

Cancel — Closes the View Attributes window without applying changes. 
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View Attributes Window, General tab 
Location: View menu > Attributes 

 
The features on this tab enable you to control the display characteristics of a view. 
 
 

 
 

View Type — Controls what is seen in a view.  

Options are: 
Workpiece — Displays the stock workpiece and machining that occurs on it. This 
view supports full inspection capabilities on the machined part, including X-Caliper 
measurements and AUTO-DIFF model comparisons. 

Machine — Displays a 3-D NC machine, when defined. The uncut stock can be seen, 
however, material removal does not occur in this view type. 

Machine/Cut Stock — Same as above, except material removal does occur. (Does 
not support machined part inspection-use a Workpiece view type for this activity.) 

Profile — Displays a 2-D profile view of a turned workpiece in a G-Code tool path 
simulation, as if it were spinning and sectioned along the turning axis. The profile is 
created when cutting begins.  

NOTE:  Ensure a Spindle component is defined in the machine and turned on by 
codes in the G-Code tool path file. 



VERICUT HELP – View menu 
 
 

 

Shortcut:  You can quickly change the View Type by right-clicking in the view, and 
selecting from the displayed menu. See the Graphics Area Right Mouse Button 
Shortcut Menus, in the Getting Started with VERICUT section of VERICUT Help for 
more information. 

 

Draw Mode — Controls how machine components are displayed.  

Toolbar short cuts for Draw Shaded , Draw Lines , and Draw Mixed  draw 
modes.  

Options: 

Shade — Shaded solids 

Lines — Wireframe 

Hidden — Wireframe with back-facing lines hidden 

Mixed — shade, lines or hidden, as defined by the component's Mixed Mode 
attribute (Ref. Project menu > Model Setup > Define: Component Attributes tab) 

 

Shortcut:  You can quickly change the Draw Mode by right-clicking in the view, and 
selecting from the displayed menu. See the Graphics Area Right Mouse Button 
Shortcut Menus, in the Getting Started with VERICUT section of VERICUT Help for 
more information. 

 

Light — I J K vector direction in which the light source points. The three values are 
separated by spaces, as described in the view coordinate system. A second light source 
shines on the opposite side of the model. 

 

Background Style — Controls the background seen in a view. Colors for backgrounds 
are defined via the Edit menu > Colors function.  

Options: 

Flat — Monochromatic. 

Shaded — Light-to-dark shading. 

Walls — Walls, floor, and ceiling-machine views only. 

 

 



VERICUT HELP – View menu 
 
 

Sample backgrounds:  

Shaded 

 

Walls Flat 

 

Shortcut:  You can quickly change the Background Style by right-clicking in the view, 
and selecting from the displayed menu. See the Graphics Area Right Mouse Button 
Shortcut Menus, in the Getting Started with VERICUT section of VERICUT Help for 
more information. 

 

Attach Comp. — Attaches the view point and line of sight for a view to the selected 
component. By default, a Workpiece view is attached to a Stock component, thus the 
workpiece remains stationary while the tool moves about it. Similarly, by default in a 
Machine view the view is attached to the machine's Base component, thus the machine 
base appears stationary while its axes move. Whatever component is selected as the 
attach component becomes stationary in the simulation, while all other objects are 
simulated as moving relative to that component. 

Shortcut: You can quickly change the component the view is attached to by right-
clicking in the view, and selecting Attach Component in the menu that displays. See the 
Graphics Area Right Mouse Button Shortcut Menus, in the Getting Started with 
VERICUT section of VERICUT Help for more information. 

 

Translucent — Controls when the stock model is displayed as translucent (can be seen 
through).  
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Translucent can only be applied to an active workpiece view. Once the attribute is set, 
more than one workpiece view can be displayed "translucent".  It is only valid with a 
"refined display". 

All VERICUT functions can be used with a translucent view. However, when the model 
is rotated, sectioned, or zoomed, the resulting view is a solid. Use Refine Display to re-
display the translucent view. Almost any model feature can be seen using combinations 
of Translucency, Reverse, Section, and Zoom. 

NOTE:  Translucent cutters may intermittently disappear while cutting a translucent 
model. Display the tool as a solid to eliminate this "flashing" affect. 

Toolbar short cut:   

Options are: 
Off — Translucency is off and the workpiece is displayed as a solid (can not be seen 
through). 

Normal — Causes material in front of a machined surface to become translucent. 
When a machined surface is not present behind material, the material is displayed in 
solid. 

Extended — Similar to Normal, except when a machined surface is not present 
behind material, the material is still displayed with translucency. 

  

Translucent "Off" Translucent "Normal" Translucent "Extended" 

   

  

Shortcut:  You can quickly change the Translucent setting by using the toolbar short 

cut:   Use the left mouse button on the icon to toggle Translucent "On" or "Off". 
When the Translucent icon is toggled "On", use the right mouse button on the icon to 
quickly toggle between Translucent "Normal" and Translucent "Extended" modes. 
The change is immediately applied to the "active" workpiece view. 

 

Accelerated (OpenGL) — Toggles Hardware Graphics Acceleration "On" and "Off".  
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Shortcut:  You can also right-click in the graphics area and use Accelerated (OpenGL) 
in the displayed menu to toggle Hardware Graphics Acceleration "On" and "Off". See 
the Graphics Area Right Mouse Button Shortcut Menus, in the Getting Started with 
VERICUT section of VERICUT Help for more information. 
 
 
 
To View Attributes window



VERICUT HELP – View menu 
 
 

 

View Attributes window, OpenGL Settings tab 
Location: View menu > Attributes 

 
The features on this tab enable you to control the display characteristics of an Accelerated 
(OpenGL) view. This tab is only available when Accelerated (OpenGL) is toggled 
"On". 
 

 
 

 
Display Options tab — The features on this tab enable you to control the display 
characteristics of an OpenGL Workpiece, Machine, or Machine/Cut Stock View. 
 
Floor/Wall Textures tab — The features on this tab enable you to specify custom texture 
files to be used for floor, ceiling and walls of an OpenGL Machine view. 
 
 
 
To View Attributes window
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View Attributes window, OpenGL Settings tab, Display 
Options 
Location: View menu > Attributes 

 
The features on this tab enable you to control the display characteristics of an OpenGL 
Workpiece, Machine, or Machine/Cut Stock View. The features on this tab are only 
available when Accelerated (OpenGL) is toggled "On". 
 
 

 
 
 

Perspective View — When Perspective View is toggled "On", a perspective view is 
displayed in Machine and Machine/Cut Stock views. 

 

Field of View Angle — This feature is only available when Perspective View is toggled 
"On". It enables you to control the Field of View Angle of the perspective view. Move 
the slider to the left to decrease the view angle and to the right to increase it. 
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Clipping Plane — This feature is only available when Perspective View is toggled 
"On". It enables you to control the position of the "clipping plane" in the perspective 
view. Move the slider to the left to move the "clipping plane" closer to the plane of the 
screen. Move it to the right to move the "clipping plane" further into the view (away from 
the plane of screen). All objects between the "clipping plane" and the plane of the screen 
are blanked from the display. For example, this feature could be used to blank parts of the 
machine (like doors) to better view the part on the machine. 

 

Translucency — This feature enables you to control the translucency characteristic of 
selected components. For example, this feature could be used to make certain parts of the 
machine (like doors, or enclosures) to better view the part on the machine. 

Before the Translucency slider will affect the display, the following conditions must be 
met:  

1. The component(s) must have the Mixed Mode attribute must be set to 
Translucent. (refer to Modeling window: Component Attributes tab in the 
VERICUT Help section, in the CGTech Help Library.) 

2. Draw Mode must be set to Mixed (refer to View Attributes window: General 
tab above). 

The Translucency slider can now be used to vary the translucency of the selected 
components. The following examples have the machine enclosure component set for 
using the Translucency slider. 

 

Example of Translucency slider all the way to the right (Less) 
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Example of Translucency slider at the midpoint 

 
 

Example of Translucency slider all the way to the left (More) 

 
 

Cut Stock Display — This feature enables you to control the way that the Cut Stock is 
displayed (and therefore the processing speed). Moving the slider to the left will display a 
"sharper" image of the Cut Stock but will result in longer processing times. Moving the 
slider to the right results in a Cut Stock display with a less sharp image, but processing 
time will be faster. This feature is only available when the View Type is either 
Workpiece, or Machine/Cut Stock. The Cut Stock Display slider is inactive when 
Coarse Cut Stock Image (described below) is toggled "On". 
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Coarse Cut Stock Image — This feature is only available when the View Type is either 
Workpiece, or Machine/Cut Stock. When toggled "On" (checkmark displayed), the cut 
stock image in the Machine/Cut Stock view is displayed as an approximate "block" 
image (also called the "lego" display). This image is only updated at the end of each 
setup, so that the subsequent setup has an approximate image of the cut stock. The "lego" 
image moves from setup-to-setup the same as a normal cut stock image.  

When toggled "On" in a Workpiece view, the cut stock image is displayed as an 
approximate "block" image during OpenGL motions (rotate, zoom, pan, etc.). The cut 
stock display during these actions is in the same state of cutting as the cut stock display in 
the Machine/Cut Stock view. 

When OK, or Apply, is pressed in the View Attributes window, the cut stock image 
changes depending on the change in the check-box state, and the Cut Stock Display 
slider becomes inactive. The check-box state is saved in the project setup's view 
attributes. The Coarse Cut Stock Image feature can be toggled On/Off at any time. 

Turning this feature "On" has no effect on the content of the cut stock model, collision 
checking, or project processing. This is a graphics display change only, for performance 
reasons. 

VERICUT features that query the cut stock via graphical picks in a Workpiece, or  
Machine/Cut Stock, view (such as X-caliper, Modeling, etc) continue to work, regardless 
of the image. 

 

To OpenGL Settings tab
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View Attributes window, OpenGL Settings tab, 
Floor/Wall Textures tab 
Location: View menu > Attributes 

 
The features on this tab enable you to specify custom texture files to be used for floor, 
ceiling and walls of an OpenGL Machine view. These custom textures are only visible in 
the VERICUT Graphics Area in Machine Views, when Accelerated (OpenGL)  is 
toggled "On" and Background Style is set to "Walls". 
 
 

 
 
 

Floor — Enter the \path\file name in the text field of the JPEG file containing the texture 
to be used for the floor, or click on Browse and use the Texture JPEG File selection 
window to specify the file. 
 
Ceiling — Enter the \path\file name in the text field of the JPEG file containing the 
texture to be used for the ceiling, or click on Browse and use the Texture JPEG File 
selection window to specify the file. 
 
Left/Right Walls — Enter the \path\file name in the text field of the JPEG file 
containing the texture to be used for the left and right walls, or click on Browse and use 
the Texture JPEG File selection window to specify the file. 
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Front/Back Walls — Enter the \path\file name in the text field of the JPEG file 
containing the texture to be used for the front and back walls, or click on Browse and use 
the Texture JPEG File selection window to specify the file. 
 

NOTES: 
The following information is related to how VERICUT uses the Floor, Ceiling, and Wall 
JPGs specified above. 

1. All images (floor, ceiling, and walls) use a 1:1 aspect ratio.  

2. VERICUT cuts given JPEG file images to a rectangle with sizes which are 
powers of two. For instance, image 1500x760 will be cut to 1024x512. Image 
760x760 will be cut to 512x512.  

3. Floor/ceiling/walls sizes are calculated based on the machine size in 
corresponding direction which is extended by some open space around the 
machine which is also calculated based on the overall machine size. 

 
 
Sample "standard" OpenGL Machine view: 
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Sample "custom" OpenGL Machine view: 
 

 
 
The custom texture files, specified using the View Attributes window: Floor/Walls 
Texture tab, only apply to the current setup and the specified texture files are stored 
with the setup in the project file. All OpenGL Machine views in the setup use the same 
texture files. 
 
Texture files for drawing floor, ceiling, and walls in an OpenGL Machine view can also 
be specified using the following Environment Variables as in V6.0: 

 
CGTECH_FLOOR_IMAGE 
CGTECH_CEILING_IMAGE 
CGTECH_X_WALL_IMAGE 
CGTECH_Y_WALL_IMAGE 

 
When texture files are specified using Environment Variables, they apply to all OpenGL 
Machine views with Background Style=Walls, not specific to a particular setup. For more 
information on these, and all VERICUT environment variables, see Environment 
Variables in the VERICUT Help section in the CGTech Help Library. 
 
The custom texture files, specified using the View Attributes window: Floor/Walls 
Texture tab will over-ride one set using one if the Environment Variables. If a custom 
texture file is not specified with either of these methods, standard VERICUT images will 
be used. 
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Consider the following example: 
 

1. No Floor texture file is specified on the View Attributes window: Floor/Walls 
Texture tab. 

2. VERICUT will then use any texture file specified using the 
CGTECH_FLOOR_IMAGE environment variable. 

3. If the environment variable has not been specified, VERICUT will use the default 
chess-board image will be used for the floor. 

 
The same hierarchy is true for the ceiling and the walls. 
 
 
 
To OpenGL Settings tab
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View Section window 
 
VERICUT Users: 
 VERICUT Location: View menu > Section 

VERICUT toolbar short cut:   

  

Mold and Die Users: 
Mold and Die Location:   Views and View Layouts page > Display Section 

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Change Views and View Layouts page > Display Section 

Notebook Feature:      

 

 
 

Opens the Section window enabling you to define section planes through a VERICUT 
model in a workpiece view. You can define as many section planes as desired, in any 
orientation. Section plane orientation and distance are described with respect to the active 
coordinate system.  Restore the original model by clicking anywhere off the part in the 
workpiece view, or click Restore on the Section window. You can continue cutting on the 
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sectioned model, or restore the original (un-sectioned) model. Machine cuts are applied to 
the entire model regardless of how it is displayed after sectioning. 

 

 
 

Section on mouse pick — Immediately sections the model through the point selected 
with mouse. The section plane orientation is controlled by the characteristics of the plane 
highlighted in the Section planes table. 

 
Section planes table: 

 On — Toggles on and off to activate/deactivate defined section planes in the table. 
Only the active planes will be used to determine the portion of the model that will be 
displayed after the section planes are applied. 

NOTE:  The on/off state of this toggle is only used in conjunction with the Section 
button below. It has no effect on which plane/direction vector is displayed in the 
active workpiece view. The plane /direction vector that is displayed in the active 
workpiece view is determined by the plane that is highlighted in the section planes 
table. 

Pl Type — Specifies section plane orientation. Standard options include six 
orientations that are perpendicular to axes of the active coordinate system (POS X, 
POS Y, POS Z, NEG X, NEG Y and NEG Z).  POS and NEG define the direction 
of the normal vector of the section plane with respect to the coordinate system axis. 
The normal vector points away from the portion of the part that will be displayed 
when it is sectioned. Using the Custom option, you can define a section plane at any 
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orientation by entering the I, J, and K components of the desired normal vector in the 
Normal I J K fields (see below). 

Normal I, Normal J, Normal K — Specifies the I J K coefficients of a vector 
perpendicular to the desired section plane. These values are automatically set when Pl 
Type is set to one of the six standard options and cannot be changed. When Pl Type is 
set to Custom, the values can be changed to define the direction vector of the desired 
section plane. Values entered do not have to define a unit vector (vector length=1). 
Any combination of values can be entered to define the normal vector. 

Distance — Distance along the normal vector (see above), measured from the active 
coordinate system origin to the desired location of the section plane. Key in a value or 
pick a point on the model with the mouse. A positive value is measured along the 
specified normal vector, a negative is measured in the reverse direction. 

Start / End — When selected, defines the starting and ending planes for automatic 
sectioning. (See "Automatic sectioning features" below). 

The following actions can be accomplished by either selecting the associated button 
in the Section window or selecting it from the pull-down that results from using the 
right mouse button while the cursor is in the section planes table. 

Add — Use to add additional section planes to the table. 

Delete — Use to delete the highlighted section plane from the table. 

Reverse — Use to reverse the direction vector of the highlighted plane to display the 
opposite side of the model after sectioning. 

  

Shortcut:  Right-click in the Section Planes Table  to display the following menu: 
 

 
These features provide the same functionality as those described above. 

 

Automatic sectioning features: 

This group of features displays a series of animated sectioned views, beginning with 
the plane identified as the "Start" plane (Start selected), and ending with the "End" 
plane (End selected). The start plane direction vector must point away from the end 
plane and the end plane vector must point away from the start plane for proper 
automatic sectioning to take place. Automatic section cuts are equally spaced. 

Cuts — The number of equally spaced section planes that will automatically be 
applied between the start and end section planes. 

Delay — Seconds of delay to pause between each automatic section cut display. 
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Auto Section — Begins the automatic sectioning sequence. To interrupt an automatic 

sectioning, press  (Stop), or click in the VERICUT main window and press the 
Escape <Esc> key. 

 

Section — Applies the active section plane(s) in the Section planes table to the model. 
The resulting "sectioned" model is displayed in all workpiece views. 

Restore — Restores the solid model from the sectioned display. The sectioned model is 
for display purposes only. When cutting has been performed with a sectioned view 
displayed, the results are the same as if the entire model was displayed.. 

Close — Closes the Section window. 
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Select/Store View window 
 
VERICUT Users: 
VERICUT Location: View menu > Select/Store 

  

Mold and Die Users: 
Mold and Die Location:   Change Views and View Layouts page > Custom Views 

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Change Views and View Layouts page > Custom Views 

Notebook Feature:      

  

Opens the Select/Store View window enabling you to store, modify and apply custom 
views. Defined views are shown in the "View List". Each custom view is stored with the 
View Type and orientation of the view that was active at the time it was stored. There is 
no limit to the number of views you can store. 

 

 
 

VERICUT Shortcut:  You can quickly reverse the orientation, or change the view to 
one of the standard or stored custom views by right-clicking on the view in the 
VERICUT graphics window, then selecting the desired view name using Select View 
option in the displayed menu. This shortcut is not available for Mold and Die. 
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View List — List of defined views. 

 

Shortcut:  Right-click in the View List to display the following menu: 
 

 
These features provide the same functionality as described below. 

 

Activate — Applies the View Type and orientation of the stored view highlighted in the 
View List to the active view in the VERICUT graphics window. 

Modify — Modifies the View Type and orientation of the highlighted view in the View 
List to match those of the active view in the VERICUT graphics window. 

Reset — Resets the active view in the VERICUT graphics area to the View Type and 
orientation that it had when the Select/Store View window was opened. 

Add — Adds a new view, after the highlighted view, to the View List. The new view will 
have the same View Type and orientation as the active view in the VERICUT graphics 
window. Double click on the view name to rename the view. Hit <enter> when you are 
through editing. 

Delete — Deletes the highlighted view from the View List. 

Delete All — Deletes all views from the View List. 

Close — Closes the Select /Store View window. 

 

VERICUT Shortcut:  You can quickly Add, Delete, or Activate views in the View 
List by right-clicking on a view and selecting desired action from the displayed menu.  
See the Graphics Area Right Mouse Button Shortcut Menus, in the Getting Started 
with VERICUT section of VERICUT Help for more information. This shortcut is not 
available for Mold and Die. 
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View Axes window 
Location: View menu > View Axes 

 

Opens a window to control when various axes and coordinate systems are displayed. 
Axes are created by VERICUT and are stored in the Preferences file. Coordinate Systems 
(CSYS) are user defined and are stored in the "setup". Once displayed, axes and 
coordinate system symbols remain displayed until toggled "Off" in the View Axes 
window. Solid lines indicate that an axis is parallel or pointing out of the screen. Dashed 
lines indicate that an axis is pointing into the screen. 

 

 
 

Shortcut: You can also change axes displayed by right-clicking in the view, and 
selecting from the Display Axes list in the menu that displays. See the Graphics Area 



VERICUT HELP – View menu 
 
 

Right Mouse Button Shortcut Menus, in the Getting Started with VERICUT section of 
VERICUT Help for more information. 

 

AXES 

Use the Color Pallet icons , to specify a "global" display color for each type of axis 
described below. 

Component — When selected, displays XcYcZc axes that representing the coordinate 
system of a component. Each component has its own local coordinate system.  

Model — When selected, displays XmYmZm axes that represent the coordinate system 
of a model. Each model has its own local coordinate system. 

Machine Origin — When selected, displays XmcYmcZmc axes that represent the 
coordinate system in which an NC machine is defined. 

Workpiece Origin — When selected, displays XwpYwpZwp axes that represent the 
coordinate system to which Stock, Fixture, and Design components are connected. 

• In a simulation where a machine IS NOT defined, such as when processing APT-
CLS tool path files, the workpiece coordinate origin is the origin of the non-
moving "Base" component to which Stock, Fixture, and Design components are 
connected. In previous VERICUT versions, this was known as the "World 
coordinate system" (XwYwZw axes). 

• In a simulation where a machine IS defined, such as when processing G-Code 
tool path files, the workpiece coordinate origin is the origin the machine 
component responsible for carrying the Stock, Fixture, and Design components. 

Tool Tip Zero — When toggled "On", displays the XToolTipYToolTipZToolTip axes 
that represent where the tool tip (the VERICUT control point) of the "active" tool would 
be located, relative to the "active" stock, if all linear axes were positioned at zero. The 
display is based on the actual Machine/Control configuration and therefore may be 
displayed as a right hand axis, a left hand axis or possibly even a non-orthogonal axis. If 
no tool has been loaded, VERICUT assumes a zero length tool. 

The following should be considered when using this feature: 

• Tool Tip Zero is only applicable when processing G-Code Data. 

• The Tool Tip Zero display is based on the "active" tool. If the machine being used 
has more than one tool component, the correct tool component must be set as 
active before valid results can be achieved. 

• The Tool Tip Zero display is based on the "active" stock. If more than one stock 
component on the machine, the correct stock component must be set as active 
before valid results can be achieved. 

• The Tool Tip Zero display shows where the tool tip is and therefore may not be 
particularly useful when programming a 5-axis machine in "gage-length" mode. 
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Driven Point Zero — When toggled "On", displays the "driven point" (identified by the 

 symbol) and the XDrivenPointYDrivenPointZDrivenPoint axes. 

The "driven point" is only displayed in the Machine View. Depending on the machine 
configuration, more than one Driven Point Zero axis may be displayed in the View Axes 
window as shown in the picture above. 

The initial "driven point" position is determined based on the following: 

• If there are no rotary/turret components attached to the "active" tool component, 
the initial driven point is the origin of the "active" tool component. 

• If there is 1 rotary/turret component attached to the "active" tool component, the 
initial driven point is the origin of the rotary/turret component. 

• If there are 2 rotary/turret components attached to the "active" tool component, 
the initial driven point is the intersection of the two rotary axes. 

• If there are more than 2 rotary/turret components attached to the "active" tool 
component, the initial driven point is the origin of the highest level rotary/turret 
component. 

The following offsets are then applied to the initial "driven point" (adjusted as needed for 
RTCP): 

• Gage Offset 

• Tool Nose Compensation Offset 

• Tool Length Compensation Offset 

• Turret Offset 

• Gage Pivot Offset 

• Pivot Offset (RTCP) 

• 3D Tool Length Comp Offset (Fanuc) 

The Driven Point Zero axes represent where the driven point of the "active" tool would 
be located, relative to the "active" stock, if all linear axes were positioned at zero. The 
display is based on the actual Machine/Control configuration and therefore may be 
displayed as a right hand axis, a left hand axis or possibly even a non-orthogonal axis. 
The Driven Point Zero axes are displayed in Workpiece, Machine and Machine/Cut 
Stock views. 

The following should be considered when using this feature: 

• Driven Point Zero is only applicable when processing G-Code Data. 

• The Driven Point Zero display is based on the "active" tool. If the machine being 
used has more than one tool component, the correct tool component must be set as 
active before valid results can be achieved. 
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• The Driven Point Zero display is based on the "active" stock. If more than one 
stock component on the machine, the correct stock component must be set as 
active before valid results can be achieved. 

• Some machine configurations do not conform to initial "driven point" rules 
described above and therefore will not produce useful results. An example of this 
would be Maho-Phillips machines using a two position head. The initial driven 
point could not be calculated correctly resulting in invalid results. 

• Dual turret machines typically will not have the active tool defined for both 
turrets, therefore the initial driven point can not be calculated correctly resulting 
in invalid results. 

• Some machine/controller combinations, like the one in the sample file 
bos5vm01.VcProject, may not produce the results that you might expect, but 
based on the above definitions, the displayed results are accurate. 

Spindle Direction — When toggled "On", a graphic is displayed indicating direction that 
the spindle is turning. 

  

Mill Example Lathe Example 

  

  

The Spindle Direction indicator can also be turned On/Off by right-clicking in the 
graphics window and selecting Display Axes > Spindle Direction from the pop-up menu 
that displays. 

Set Axes — When selected, all "axes" are toggled "On" and will be displayed. 

Clear Axes — When selected, all "axes" are toggled "Off" and will not be displayed. 
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NOTES:  
1. Axes display status is stored in the Preferences file. Axes that are displayed when 

exit a VERICUT session are displayed the next time you run VERICUT. 

2. Axes are drawn in the Foreground color by default. Use the Color Pallet icon 

 , for each axis type to change the display color of the individual axes. 

  

COORDINATE SYSTEMS (CSYS) 
Display Active Coord. Sys. — When toggled "On", a coordinate system with the name 
of the active coordinate system will display in the VERICUT Graphics area as shown 
below. Only the "active" coordinate system will display with the marker at its origin as 
shown. 

 

 
 

Coordinate System Table — The Coordinate System Table displays all coordinate 
systems defined for the "current setup".  Each CSYS in the table has a checkbox that 
toggles "On" and "Off", indicating whether it is displayed or not. By default, CSYS are 
drawn in the Foreground color. The color of the CSYS can be changed using the Color 
Pallet button, described below. The background color of each Coordinate System 
Name field indicates the color that the CSYS will be displayed. 

Set CSYS — When selected, all "coordinate systems" are toggled "On" and will be 
displayed. 

 (Color Pallet button) — Use to define the display color for a "coordinate 
system". To specify a color for a particular CSYS, click on the Coordinate System 
Name field, in the Coordinate System Table, so that it becomes highlighted. The 
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background color of the Coordinate System Name field indicates the current color of 
the CSYS. Click on the Color Pallet button and select the desired color from the color 
pallet that displays. 

Clear CSYS — When selected, all "coordinate systems" are toggled "Off" and will not 
be displayed. 

NOTES:  
1. Coordinate System display status is stored in the "setup".  

2. Axes are drawn in the Foreground color by default. Use the Color Pallet 

button ,  in the Coordinate Systems section of the View Axes 
window to change the display color of  individual coordinate systems. 

  

See also "VERICUT axes and coordinate systems" in the Using VERICUT section. 
Using VERICUT can be found in the CGTech Help Library. 
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View Toolbar window 
Location: View menu > Toolbar 

 

Opens a window to control when the Toolbar is displayed and the icons it contains. 
Toolbar icons provide quick and easy access to the most commonly-used VERICUT 
functions/features. The Toolbar can be closed, opened, or customized at any time. 

 

 
 

Display Toolbar — When selected, displays Toolbar groups on the VERICUT main 
window. 

Set All, Clear All — Turns on (or off) display of all Toolbar icons. Corresponding 
options are all selected (or cleared). 
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Toolbar groups: 

Toolbar Icons: Toolbar name: Functions (click for more info) 

 
Close Close Toolbar 

                        or 

File Open Project 

Save Project / Save Project As (See 
NOTE 8) 

New Project (See NOTE 1) 

Open In Process File 

Save In-Process / Save In-Process 
As (See NOTE 9) 

Working Directory 

Edit NC Program 

Custom Interface 

 
Simulation 
Settings 

Motion 

G-Code Settings 

APT Settings 

No Animation 

No Machine Simulation 

AutoSave 

                         or 

Configuration Save Machine /Save Machine As 
(See NOTE 10) 

Save Control / Save Control As 
(See NOTE 11) 

Machine Settings 

Component Tree 

Word Format 

Word Address 

Control Settings 

Control Advanced Options 
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Static View Zoom to Box / Zoom creates new 

View (See NOTE 2) 

Zoom In 

Zoom Out 

Fit / Fit All ( See NOTE 12) 

Refine Display (See NOTE 3) 

Last Refine Display (See NOTE 
4) 

Reverse 

 

 
 

 

 

Cut Options OptiPath 

Standard/FastMill Cut Modes 

Delete Detached Stock 

MDI 

 
Dynamic 
View 

Dynamic X/Y/Z/XY Rotation 

Dynamic Pan 

Dynamic Zoom 

Project Open Machine 

Open Control 

Setup Models 

NC Program 

Tools 

Output 

Setup Plan 

Coordinate Systems 

Project Tree 

 
Analysis AUTO-DIFF 

X-Caliper 

Toolpath Review 
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Die Sinking Simulation 

Comparator 

 
Display Workpiece View 

Machine/Cut Stock View 

Draw Shaded 

Draw Lines 

Draw Mixed 

Section 

Translucent (See NOTE 7) 

Color 

 
 

 

 

 

Info View NC Program 

Status 

Graphs 

VERICUT Log 

Clear Log File and Logger (See 
NOTE 6) 

 
Images Image Record 

Image Playback / AVI Playback 
 (See NOTE 5) 

View Capture 

Print View 

 
View Layout Use to set VERICUT views to the 

standard view layout shown on 
the icon. 

Single View Layout 

Two View Layout (Horizontal) 

Two View Layout (Vertical) 

Three View Layout (Vertical) 

Three View Layout (Horizontal) 

Four View Layout 
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NOTES:  

1. Right-click on the New Project icon to toggle between  (Inch) and  
(Millimeter) mode. 

2. Right-click on the icon to toggle between  (Zoom to Box) and   (Zoom 
creates new View) modes.  

3. Refine Display — When selected, refines the display to be a high-quality image. 
Refining the display can useful to see model details after model manipulation, 
such as zooming, rotating, panning, etc. This action occurs automatically any time 
cutting is started. 

4. Last Refine Display — When selected, returns a workpiece view to the last 
refined display image. This action is useful to quickly start cutting after 
manipulating the workpiece for viewing: zooming, rotating, panning, etc. 

5. Image Playback/AVI Playback — The active icon is set automatically based on 
the active image record output format (ref. File menu > Images > Record 
Movie). 

6. Clear Logfile and Logger — Clears both the VERICUT Log File and the Logger 
(Message Logger). 

7. Use the left mouse button on the Translucent icon to toggle Translucent "On" 
or "Off". When the Translucent icon is toggled "On", use the right mouse button 
on the icon to quickly toggle between Translucent "Normal" and Translucent 
"Extended" modes. The change is immediately applied to the "active" workpiece 
view. 

8. Right-click on the icon to toggle between  (Save Project) and   (Save 
Project As) modes. 

9. Right-click on the icon to toggle between  (Save In-Process) and  (Save 
In-Process As) modes. 

10. Right-click on the icon to toggle between  (Save Machine) and  (Save 
Machine As) modes. 

11. Right-click on the icon to toggle between  (SaveControl) and  (Save 
Control As) modes. 

12. Click the icon with the left mouse button to "fit" the active view. Click the icon 
with the right mouse button to "fit" all views. 

  

For additional information about the VERICUT functions accessed by Toolbar icons, 
refer to the function names in the VERICUT Menus and Features section of VERICUT 
Help. 
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Resolution 
Location: View menu > Resolution 

  

Controls the quality of cut model display. Increasing resolution displays a more accurate 
representation of the cut model, and requires more computer resources and processing 
time to display and manipulate the model. A coarse display resolution is automatically 
used when dynamically manipulating the model, such as rotation, zooming, etc. When the 
dynamic action is finished, the display is upgraded to the previous resolution. 

Options: 

Manual — A display resolution which allows most models to be manipulated with 
acceptable performance and display quality. 

Auto — Automatically sets display resolution based on viewing distance from the model. 
Resolution automatically increases when you zoom closer to see details on the model, 
and decreases as you zoom out. 
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Look & Feel 
Location: View menu > Look & Feel 

 

The Look & Feel features change the appearance of VERICUT's user interface. All 
windows are affected. The look and feel of VERICUT can be changed at any time. 

 

To change the user interface look and feel: 
1. Select View menu > Look and Feel. 

2. Choose the option, from the pull-down list, that provides the desired appearance. 

 

NOTE:  Not all options are available on all systems. 
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Options: 
 

Metal —  
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Motif — 
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Windows — 
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Windows Classic — 
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Text Larger — Use to make the text in VERICUT menus, message logger, windows, 
etc. larger. Each time you click on "Text Larger", the text gets incrementally larger to 
a maximum font size of "14 point". 
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Text Smaller — Use to make the text in VERICUT menus, message logger, 
windows, etc. smaller. Each time you click on "Text Smaller", the text gets 
incrementally smaller to a minimum font size of "6 point ". 
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Dynamic Controls 
Location: View menu > Dynamic Controls 

  

View menu > Dynamic Controls options enable you to use the same mouse actions 
while in VERICUT, that are required to perform dynamic pan, zoom or rotate in each of 
the supported CAD systems. This parameter is saved in the Preferences file. 

  

CATIA — Use CATIA's mouse action conventions for dynamic pan, zoom and rotate. 

Pro/E — Use Pro Engineer's mouse action conventions for dynamic pan, zoom and 
rotate. 

Unigraphics — Use Unigraphics' mouse action conventions for dynamic pan, zoom and 
rotate. 

VERICUT — Use VERICUT's standard mouse action conventions for dynamic pan, 
zoom and rotate. See Dynamic Zoom, Pan and Rotate in the Getting Started with 
VERICUT section for additional information. 

Wildfire — Use Pro Engineer Wildfire's mouse action conventions for dynamic pan, 
zoom and rotate. 

Reverse Mouse Wheel — Toggle On/Off to reverse the action of mouse wheel motion. 

 

The following table summarizes how each dynamic feature was implemented for each 
CAD system. 

  

 CATIA Pro/Engineer Unigraphics VERICUT Wildfire 

 Pan Middle mouse 
button, drag 

Hold Ctrl key, 
Right mouse 
button, drag 

Hold Shift key, 
Middle mouse 
button, drag 
(or, Middle & 
Right mouse 
button, drag) 

Right mouse 
button, drag 
(or, hold Shift 
key, any 
mouse button, 
drag) 

Hold down 
SHIFT, the 
middle mouse 
button, and 
drag the 
mouse. 

 Zoom 

Hold Middle 
mouse button, 
click Left or 
Right mouse 
button, drag: 

Hold Ctrl key, 
Left mouse 
button, drag: 

Down or Left 

Hold Ctrl key, 
Middle mouse 
button, drag (or 
Left & Middle 
mouse button, 

Rotate the 
thumbwheel: 

Toward you 
for larger, 
away for 

Hold down 
CTRL, the 
middle mouse 
button, and 
drag the 
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Up for larger 

Down for 
smaller 

for larger 

Up or Right for 
smaller 

drag smaller 

(or, hold Ctrl 
key, any 
mouse button, 
drag: 

Up for larger 

Down for 
smaller) 

mouse 
vertically. 

 Rotate 

Hold Middle 
mouse button, 
hold left or 
Right mouse 
button, drag 

Hold Ctrl key, 
Middle mouse 
button, drag 

Middle Mouse 
button, drag 

Left mouse 
button, drag 

(or, hold Shift 
& Ctrl keys, 
any mouse 
button, drag) 

Hold down the 
middle mouse 
button and 
drag the 
mouse. 

 

 

To change the dynamic controls behavior: 
1. Select View menu > Dynamic Controls. 

2. Choose the CAD System, from the pull-down list, that you want VERICUT to 
emulate. 
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Logger View Options 
View menu > Logger View Options 
 
Use the Logger View Options to specify what information that you want displayed in the 
logger, when you want to clear the Logger, or copy a Logger message to paste in another 
document.  
When these features are set before the simulation, only the selected type of information 
will be written to the Logger. These features can also be used after the simulation add or 
remove information from the Logger. 
 

Error — When toggled "On" (check displayed), error messages will be written out to the 
Logger. 

Warning — When toggled "On" (check displayed), warning messages will be written 
out to the Logger.  

Info — When toggled "On" (check displayed), informational messages will be written 
out to the Logger. 

Clear on Reset — When toggled "On" (check displayed), the contents of the Logger will 
be cleared whenever you do a Reset. 

Clear — Selecting this feature will immediately clear the Logger. Using this feature only 
clears the Logger window, not the VERICUT Log file. 

Copy Ctrl + C — Use this feature to copy the highlighted message(s) so that it can be 
pasted to a document.  

Pick a number of individual messages for copying by holding the Ctrl key down while 
picking.  

Pick a range of consecutive messages by selecting the first message in the range, and then 
hold the Shift key down while selecting the last message in the desired range. All of the 
messages between two messages that you selected will become highlighted. 



VERICUT HELP – Info menu 
 
 

Info Menu 
 

NC Program (Info) 
 
VERICUT Users: 
VERICUT Location: Info menu > NC Program 

VERICUT toolbar short cut:   

 
Mold and Die Users: 
Mold and Die Location:   Analyze, View Files, Print page > Display Tool Path Text 

Notebook Feature:       

 
Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print page > Display Grinding 
Program Text 

Notebook Feature:      

 

Opens a window displaying the NC program file being simulated. In this window, you 
can scroll through the entire file to see all the records, search for text forward and 
backward, print, and more. An arrow pointer indicates the current tool path record being 
processed. The window is updated when a new NC program file is processed, such as 
when a list of NC program files are simulated. (Ref. Project menu > NC Programs). 

The NC Program window is also one of the dockable windows enabling you to dock it 
inside the VERICUT main window if you choose. See Dockable Windows in the Getting 
Started with VERICUT section of VERICUT Help for additional information. 

NOTE:  When the NC Program window is docked, make sure that you click in the 
window so that it becomes the "active" window before using F1 to get help specific to the 
window. Otherwise F1 will go to the CGTech Help Library. 

 

Tip: 
You can edit the tool path file using the Edit menu > NC Program function in 
VERICUT, or Analysis and Viewing page > Edit the Tool Path File in Mold and Die. 
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The NC Program window will display as shown above for most types of programs. The 
NC Program window will display with a separate area for each channel for sync'd 
programs as shown below. You have the option of displaying these areas either vertically 
or horizontally. 
 
 

Tiled Vertical 
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  Tiled Horizontal 

 
 

 

Main Menu 

 
 

The menu located across the top of the NC Program (Info) window provides easy access 
to major NC Program (Info) functions. Each menu contains groups of related functions. 
Left-click on any menu name to display the list of functions in that menu group. Click on 
the function in the menu you want to use. The name of the current NC program file is 
also displayed in this area. 

 

File 
Save As — Save the current NC program file under a different name. 

Print — Displays a window enabling you to specify print characteristics and print the 
NC program. 

Mode — Use the features in this list to specify the "mode" that you want VERICUT 
to be in.  

NC Program — Standard VERICUT mode. 
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NC Program Review — Puts VERICUT in NC Program Review mode. See NC 
Program Review, in the Analysis menu section, in VERICUT Help for more 
information. 

NC Program Preview — Puts VERICUT in NC Program Review mode and 
displays the tool trace represented by the NC progam and the design model. This 
feature can be used without processing the NC Program first, as required by NC 
Program Review. See NC Program Preview, in the Analysis menu Section of 
VERICUT Help for more information. 

Exit — Closes the NC Program window. 

 

Edit 
Insert From MDI — Enables you to insert NC blocks from the NC Blocks List, in 
the MDI window, into the NC program displayed in the NC Program (Info) window. 

Selected Lines — Use to insert one, or more, highlighted blocks in the MDI 
window, NC Blocks List, after the selected block in the NC Program (Info) 
window. 

All Lines — Use to insert all blocks in the MDI window, NC Blocks List, after 
the selected block in the NC Program (Info) window. 

Cut — Cuts the highlighted text in the NC program listing and puts it in the paste 
buffer.  

Copy — Copies the highlighted text in the NC program listing to the paste buffer. 

Paste — Puts the contents of the paste buffer at the location of the cursor in the NC 
program listing. 

Restore — use to remove all edits from the NC program listing restoring it to its pre-
edited state. 

 

 

Shortcut:  Right-click in the NC Program Info window to display the following menu: 
 

 
These features provide the same functionality as those described above under Edit in 
the main menu. 
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Utilities 
Calculator — Opens the Calculator window enabling you to do mathematical 
calculations and conversions inside VERICUT. 

Colors — Opens the NC Program Color window enabling you specify colors for 
specific features (comments, variable, macros, etc.) in the NC Program listing.  

Block Renumber — Opens the Block Renumber window enabling you to renumber 
one, or more blocks, in the NC program and specify format characteristics to be used 
for block numbering. The formats specified must conform to the characteristics 
defined in the current control file.   

Check Syntax — Displays the Check Syntax window enabling you to check the 
displayed NC program for syntax errors. 

NOTE:  The Utilities features are only available for G-Code NC programs. 

 

 

Icon Bar 

 
 

The items in the Icon Bar enable you to search for specific items in the NC program 
listing, print the NC program listing, or enter, or exit, NC Program Review mode. 
Moving the cursor over the icon will display name of the option. 

 

  NC Program Review — Use this icon to switch between standard VERICUT 
mode and NC Program Review mode (ref .NC Program Review, in the Analysis menu 
section, in VERICUT Help for more information). 

  NC Program Preview — Use this icon to put VERICUT in NC Program Review 
mode and displays the tool trace represented by the NC progam and the design model. 
This feature can be used without processing the NC Program first, as required by NC 
Program Review. See NC Program Preview, in the Analysis menu Section of 
VERICUT Help for more information. 

  NC Program Syntax Check — Displays the Check Syntax window enabling you 
to check the displayed NC program for syntax errors. 

Line Number or Search Text — Use this text field to enter a line number or a string of 
text to search for. 
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  Goto Line Number — Moves the cursor in the NC program listing to the line 
number specified in the Line Number or Search Text field. 

  Search Forward — Searches forward in the NC program listing for the text string 
specified in the Line Number or Search Text field. 

  Search Backward — Searches backward in the NC program listing for the text 
string specified in the Line Number or Search Text field. 

Replacement Text — Use this text field to enter a "replacement text" string. 

  Replace One — Replace one occurrence of text string in the Line Number or 
Search Text field (or the highlighted text in the NC program listing) with the text string 
in the Replacement Text field. 

  Replace All — Replace all occurrences of the text string in the Line Number or 
Search Text field with the text string in the Replacement Text field. 

  Undo Highlighted Changes — Use this feature to undo changes made to the NC 
program. Highlight the change and then click on the icon to "undo" the change. 

  Print — Prints the NC program listing. 

  Tile Horizontal — Use to specify that multi-channel NC program listings display 
tiled horizontally. See the "Tiled Horizontal" picture above. 

   Tile Vertical — Use to specify that multi-channel NC program listings display 
tiled vertically. See the "Tiled Vertical" picture above. 

  Close Window — Closes the NC Program window. 

 



VERICUT HELP – Info menu 
 
 

 

Calculator window 
 

The Calculator window is accessed from the NC Program (Info) window by selecting 
Calculator, in the Utilities menu. 

The features in this window enable you to do mathematical calculations and conversions 
from inside VERICUT. Simply enter the value in the text field, and then click on the 
desired function button. 

You can also use the Calculator window to determine the current value of a variable. 
Enter #variable, where variable is the variable name, in the text field and VERICUT will 
return the current value of "variable". 

 
 

 
 

 
Functions 
sin — Returns the sin of the angle specified. Enter the angle, in degrees, in the text field. 

asin — Returns the arc sine of the value entered in the text field. The specified value 
must be in the range of -1.0 to 1.0. The returned value is in degrees, and is in the range of 
-90.0 to 90.0. 

sinh — Returns the hyperbolic cosine of the given angle. Enter the angle, in degrees, in 
the text field. 

exp — Returns the natural logarithm "e" raised to the specified power specified in the 
text field. 

cos — Returns the cosine of the specified angle. Returns the hyperbolic tangent of the 
given angle specified in degrees. 
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acos — Returns the arc cosine of the value entered in the text field. The specified value 
must be in the range of -1.0 to 1.0. The return value is in degrees, and is in the range of 
0.0 to 180.0. 

cosh — Returns the hyperbolic cosine of the specified angle. Enter the angle, in degrees, 
in the text field. 

ln — Returns the natural logarithm of the value entered in the text field. 

tan — Returns the tangent of the specified angle. Enter the angle, in degrees, in the text 
field. 

atan — Returns the arc tangent of the value entered in the text field. The specified value 
must be in the range of -1.0 to 1.0. The return value is in degrees, and is in the range of -
90.0 to 90.0. 

tanh — Returns the hyperbolic tangent of the specified angle. Enter the angle, in degrees, 
in the text field. 

log — Returns the base 10 logarithm of the value entered in the text field. The specified 
value must be positive otherwise zero is returned. 

1/x — The inverse key replaces the variable x with the value entered in the text field and 
returns the answer in the format of a decimal point fraction. 

x^2 — Returns the square of the value entered in the text field. 

sqrt — Returns the square root of the value entered in the text field. 

n! — Returns the factorial value (n!  =  1· 2· 3·  ·  · (n − 2)(n − 1)n ) of  the number 
entered in the text field. 

Radian To Degree — Returns the "degree" equivalent of the "radian" angle value 
entered in the text field. 

Degree To Radian — Returns the "radian" equivalent of the "degree" angle value 
entered in the text field. 

MM To Inch — Returns the "inch" equivalent of the "millimeter" value entered in the 
text field. 

Inch To MM — Returns the "millimeter" equivalent of the "inch" value entered in the 
text field. 

 
 
Close — Closes the Calculator window. 
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NC Program Colors window 
 

The NC Program Colors window is accessed from the NC Program (Info) window by 
selecting Colors, in the Utilities menu. 

The NC Program Colors window enables you to specify colors for specific features 
(comments, variable, macros, etc.) in the NC Program listing in the NC Program (Info) 
window. VERICUT uses the definitions in the Word Format table, for the current control 
file, to determine what words go into each of the NC program feature categories. The 
following are the Word Format settings that VERICUT uses. 

Comments:  Anything that falls between "Begin Comment" and "End Comment" 

Variables:    Type "Special", Sub Type "Variable Name" or "Variable Tag" 

Macros:        Type "Macro" or Type "Conditional" with "Word" related Subtype 

Operators:    Type "Math" or Type "Condition" with a math related Subtype, or   
   Type "Special" with SubType "Separator", or Type "Special" with 
    SubType "Begin/End Type II" 

Function:    Type "Function", or Type "Type II" 

Specials:     Type "Special" with SubType = "Skip", "End of block",  
     "Begin/End Data", "Console Message", "Ignore", "Sin84D_*", 
     and "Num VAR Define" 

 

 

  — Use the color pallet icon next, to each NC program feature, to display a color 
pallet and use it to select a color for the particular NC program feature. When you have 
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finished with color selection, use the OK button, described below, to apply the colors to 
the NC program listing in the NC Program (Info) window. 

Reset — Use the Reset button next to each NC program feature to return the color for the 
particular feature back to its default color. 

OK — Applies the color settings to the to the NC program text displayed in the NC 
Program (Info) window and closes the NC Program Colors window. 

Reset All — Use the Reset All button to return the color for all NC program features 
back to its default color. 

Cancel — Ignores your color setting changes and closes the NC Program Colors 
window. 

 

VERICUT uses the definitions in the Word Format table, for the current control file, to 
determine what words go into each of the NC program feature categories. The following 
are the Word Format settings that VERICUT uses. 

Comments:  Anything that falls between "Begin Comment" and "End Comment" 

Variables:    Type "Special", Sub Type "Variable Name" or "Variable Tag" 

Macros:        Type "Macro" or Type "Conditional" with "Word" related Subtype 

Operators:    Type "Math" or Type "Condition" with a math related Subtype, or   
   Type "Special" with SubType "Separator", or Type "Special" with 
    SubType "Begin/End Type II" 

Function:    Type "Function", or Type "Type II" 

Specials:     Type "Special" with SubType = "Skip", "End of block",  
     "Begin/End Data", "Console Message", "Ignore", "Sin84D_*", 
     and "Num VAR Define" 
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Block Renumber window 
 
The Block Renumber window is accessed from the NC Program (Info) window by 
selecting Block Renumber, in the Utilities menu. 
 
 

 
 
 
Renumber Settings 
 
Use the Renumber Settings options to specify where to start, and stop, renumbering. 
 

From Line — Use this feature to specify the line in the NC program to begin the 
renumbering. 

First Line — When toggled "On" renumbering will begin at the first line in the NC 
program. 

To Line — Use this feature to specify the line in the NC program to stop the 
renumbering. 
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Last Line — When toggled "On" renumbering will stop at the last line in the NC 
program. 

Renumber Lines Without Block Numbers Only — When toggled "On", only 
blocks within the specified range that do not currently have block numbers will be 
renumbered. 

Skip Lines Starting with String — Enables you to specify a string of characters, 
that when found at the start of the block, will cause VERICUT to skip the block 
during the renumbering process.  

Skip Line Containing String — Enables you to specify a string of characters, that 
when found anywhere within the block, will cause VERICUT to skip the block during 
the renumbering process. 

 
 

Block Format 
Use the Block Format options to specify the format, and number sequence, to use for 
block numbers. The formats specified must conform to the characteristics defined in the 
current control file. 
 

Start With — Use this feature to specify the starting number to use for the 
renumbering sequence. 

Interval — Use this feature to specify the increment between numbers to be used for 
the renumbering sequence. 

Precede Lines With String — Use this feature to specify a character, or string of 
characters, to be used before the block number. 

Number Of Spaces After Block Numbers — Use to specify the number of blank 
spaces to be used between the block number and the next item in the block. 

Insert Leading Zeros For Numbers — When toggled "On" leading zeros will be 
used in the block number.  

 
Remove Block Numbers — Removes all block numbers from the NC program file. 
Block numbers are identified by the characteristics defined in the current control file. 

 
OK — Applies the new block numbers, as specified, to the NC program file and closes 
the Block Renumber window. 

Cancel — Closes the Block Renumber window without changing the NC program file. 
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Check Syntax window 
 

The Check Syntax window is accessed from the NC Program (Info) window, or from the 
NC Program Review window: NC Program listing area, by selecting Check Syntax, in 

the Utilities menu, or using  (NC Program Syntax Check) in the icon bar in either 
of the windows. 

The features in this window enable you to check the NC program displayed in the NC 
Program (Info) window for syntax errors.  

NOTE:  This feature is not applicable to APT NC programs. 

 

 

 
 
 
Check Syntax Error List 
Line — This column contains the line in the NC Program listing that contains the syntax 
error. Click on the Line column header to sort The Syntax Error list by line number. 

Text — This column contains the text of the block in the NC program listing that 
contains the syntax error. 

Error — This column contains a description of the kind of syntax error found. Click on 
the Error column header to sort The Syntax Error list by error type. 
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Tip:  Clicking on any syntax error in the Check Syntax error list moves the cursor to the 
corresponding block in the NC program displayed in the NC Program (Info) window. 

 

Clear — Clears all errors from the Check Syntax error list. 

Settings — Displays the Word Format window: Syntax Check tab enabling you to view 
the current syntax checking settings and modify them if necessary. See Word Format 
window: Syntax Check tab, in the Configuration Menu section of VERICUT Help for 
more information. 

Units — Use to specify which word format string to check against in the Word Format 
table. The default is the units value specified in the current control.  Select either, Inch, 
or Millimeter. 

Check Next — Starting at the current cursor location, VERICUT searches the NC 
Program for the next syntax error and adds it to the Check Syntax error list.  

Check To End — Starting at the current cursor location, VERICUT searches to the end 
of NC Program and adds each syntax error that it finds to the Check Syntax error list. 

Check All — VERICUT checks the entire NC program and adds each syntax error that it 
finds to the Check Syntax error list. 

Close — Closes the Check Syntax window. 
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Status window 
 
VERICUT Users: 
VERICUT Location: Info menu > Status 

VERICUT toolbar short cut:  

 
Mold and Die Users: 
Mold and Die Location:   Preview and Optimize page > View Optimization Info 
While Cutting 

Notebook Feature:       

 
Cutter Grinder Users: 
Cutter Grinder Location:   View Simulation page > View Info While Grinding 

Notebook Feature:      

 

Opens a window that provides status information about the simulation, and what would 
be occurring on the NC machine. Status information includes: tool path record being 
processed, machine and tool tip locations, information about the cutting tool, machining 
conditions, errors and warnings detected by VERICUT. The Status window can be left 
open for monitoring, minimized, closed and opened at any time. Information displayed is 
configurable, and is updated after each tool path record is processed. You can re-
configure the window at any time. 

The Status window is also one of the dockable windows enabling you to dock it inside 
the VERICUT main window if you choose. See Dockable Windows in the Getting 
Started with VERICUT section of VERICUT Help for additional information. 

NOTE:  When the Status window is docked, make sure that you click in the window so 
that it becomes the "active" window before using F1 to get help specific to the window. 
Otherwise F1 will go to the CGTech Help Library. 
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 Configure — Displays the Status window in configuration mode enabling you to 
specify status features that you want displayed in the Status window. Click on the icon to 
enter configuration mode. Click the icon again to return to the normal display mode. 

 Close Window — Closes the Status window. 

 

Tips: 
1. Status is recorded by the File menu > Images > Record function, and can be 

seen in the Status window when playing back the Image file. 

2. You can send status information to a text Status file. To accomplish this, set the 
CGTECH_STATUS environment variable to the name of the file before or when 
VERICUT is executed. 
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Status window, configuration mode 
 

The Status window, in configuration mode, enables you to select the items you want 
displayed in Status window. Click in the box to the left of each feature you want included 
in the Status window display. When toggled "On", a checkmark is displayed. Click on the 
checkmark to toggle "Off" the feature. 

  

 
   

The following features are available for display in the Status window: 

SubSystem — When a machine with more than one subsystem is in use, this option 
controls which subsystem status to show. 

Program — The name of the current NC program. 

Program Rec.# — The line number of the current NC program record. 
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Program Record — Current NC Program record being processed. Both the record text 
and sequential line number in the file are shown. 

Change Rec.# — The line number of the last tool change record. 

Change Record — The last tool change record processed. Both the record text and 
sequential line number in the file are shown. 

Machine Axes — Locations of machine axes resulting from processing G-Code NC 
Program data. 

Local Axes — The display will be similar to the Machine Axes (only showing the axis 
that exists for that subsystem). The contents of the "Local Axes" fields will represent the 
current X, Y, Z, A, B, C, U, V, W, A2, B2, C2 axis within the local coordinates. 
Typically, this will correspond to the values entered in the MCD file (except when 
specifying machine coordinates, or incremental values). 

Tool Tip — Current X Y Z tool tip location and I J K tool axis orientation with respect to 
the active tool path coordinate system. 

Tool Sequence — Sequential number of the last tool change event. 

Tool Number — Tool number in use (if specified). Examples follow. 

 

Tool path type: Sample tool chg record: Status window "Number":

G-Code data T10M6 10 

APT  CUTTER/... none 

APT PPRINT/VERICUT-TC... none 

APT LOADTL/1 1 

UG CLS LOAD/TOOL,4,... 4 

  

Tool ID — ID of a tool retrieved from a VERICUT Tool Library file, if any. A blank 
field indicates the current tool did not come from a tool library. "OVERRIDE" indicates 
that the current tool has been specified via the Override feature. If the ID differs from 
the Number field value described above, the tool was specified via a tool list. 

Tool Geometry — Cutter shape geometry. The method used to define the cutter shape is 
shown in square brackets "[ ]" followed by the description. "PROFILE" indicates a 
profile type of cutter definition. 
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Tool Description — Description of a tool retrieved from a VERICUT Tool Library file. 
A blank field indicates a description for this tool was not defined in the library, or the tool 
did not come from a tool library. 

Errors — Quantity of errors detected by VERICUT. A blank field indicates no errors 
detected. Consult the Log file for details about the errors. 

Warnings — Similar to Errors above, except applies to warnings detected. 

Time — Time anticipated to machine the part (as simulated by VERICUT). To calculate 
anticipated machining time, VERICUT records time for tool motions based on specified 
cutting feed rates and rapid rates. 

Time % — Percentage of time in feed rate mode. This value can be helpful when 
judging tool path efficiency. For example, a high value suggests an efficient tool path, 
since a value less than 100 percent means that the tool is moving at rapid feed and is 
probably not removing material. 

Distance — Tool movement distance in inches or millimeters, depending in the 
VERICUT session configuration. 

Distance % — Percentage of tool movement distance in feed rate mode. Similar to the 
Time versus Time% relationship described above, this value can also be helpful when 
judging tool path efficiency. 

Feedrate — Current programmed feed rate. A blank field indicates no records that 
control feed rate that have been processed. 

Spindle — Current programmed spindle speed. A blank field indicates no records that 
control spindle speed that have been processed. 

Coolant — Current programmed coolant condition. A blank field indicates no records 
that control coolant that have been processed. 

Motion Type — Rapid / Linear / CW / CCW / Thread / Nurbs / Poly 

Abs/Inc — Absolute / Incremental 

Motion Plane — XY / YZ / ZX 

Units — Inch / Metric 

Spindle Mode — CSS / RPM 

Compensation — On / Off 

Cycle — Off / Drill / Face / Deep / Tap /Bore / Mill / Thru / Bore Orient / Bore Drag 

Interpolation — None / Polar / Cylindrical 

OptiPath Time — Time anticipated to machine the part with an optimized tool path file. 
This field is only updated when the current tool path if being optimized by OptiPath. To 
estimate machining time saved by OptiPath, compare this value against the Time field 
value. 

NOTE:  OP Time DOES NOT consider feedrates output as a result of 
Acceleration/Deceleration optimization adjustments. 
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OptiPath Feed — Optimized feed rate, as calculated by OptiPath. 

OptiPath Spindle — Optimized spindle speed, as calculated by OptiPath. 

  

The following features are in effect when OptiPath Mode is set to On, Prompt While 
Cutting or Learn From NC Program. They report maximum volume removal rate and 
chip thickness for each cut calculated by OptiPath for the programmed feedrate. 

Volume Removal — Volume Removal Rate is calculated for any Optimization Method 
and for any tool valid for OptiPath. 

Chip Thickness — Chip Thickness is calculated only if the Optimization Method for 
the current tool is either Chip Thickness, or Chip Thickness and Volume Removal. 
Chip Thickness is not calculated when OptiPath optimizes by any other method. When 
OptiPath Mode is set to Learn From NC Program, Chip Thickness is calculated only 
for tools, which have a convex profile. 

 

Cutter Comp Value — Current cutter compensation value. 

Air Time % — The percent of time spent cutting air. 

Polar Coordinates — Display the status of polar coordinate input (ON/OFF). 
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Graphs window 
VERICUT Location: Info menu > Graphs 

VERICUT toolbar short cut:   

  

The Graphs window enables you to display a Tool Use graph showing information 
related to tool use and/or the Cutting Conditions graph showing selected cutting 
conditions. Both the Tool Use graph and the Cutting Conditions graph are refreshed 
after each setup. 

  

 
  

Common Features: 
 Time Interval — Use to specify the time interval represented by the Tool Use graph 
display. Use the Time Interval text field to specify the time interval represented by the 
Tool Use graph.   

/2 — Use to reduce the displayed time interval by a factor of 1/2. 
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X2 — Use to increase the displayed time interval by a factor of 2. 

 Configure — Displays the Graphs window in configuration mode enabling you to 
specify graph display characteristics and features. Click on the icon to enter configuration 
mode. Click the icon again to return to the normal display mode. 

 Close Window — Closes the Graphs window. 

  

Tool Use Graph: 
When toggled "On", the Tool Use graph is displayed which shows the machining time 
spent by each simulated tool. Each tool that cuts the part is shown in the graph with its 
cut color. Tool changes are indicated by a spike in the graph line. Positioning the mouse 
cursor on or above a graph line displays data about that tool. A 4-axis turned part has 2 
graph lines; one for each turret. Machines with additional heads/sub-systems will have a 
graph line displayed for each. A gap in a graph line indicates idle time spent waiting for a 
turret/sub-system to synchronize. Positioning the mouse cursor above a gap in the graph 
displays the amount of idle time.  

 

Tool Use graph features: 

 
 
Sample Tool Use graphs: 
  

Tool Use graph from a milling NC Program: 
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Tool Use graph from 4-axis merged turning NC Program: 

 
  

Cutting Conditions Graph: 
When toggled "On", the Cutting Conditions graph is displayed which shows changes in 
the selected cutting condition features. The picture below shows the Cutting Conditions 
graph display for 4-axis merged turning NC Program, with the Feed Per Minute and 
Spindle Speed features toggled "On". 
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Cutting Condition graph features: 
Select any of the following "cutting condition" features to be displayed in the Cutting 
Conditions graph. Each feature can be toggled On/Off at any time and the graph will be 
immediately updated. 

Depth — Depth of cut. 

Width — Width of cut. 

Volume Removal Rate — Volume removal rate based on programmed values. 

Chip Thickness — Chip thickness based on programmed values. 

Feed Per Minute — Feed per minute based on programmed values. 

Feed Per Tooth — Feed per tooth based on programmed values. 

Feed Per Revolution — Feed per revolution based on programmed values. 

Spindle Speed — Spindle speed. 

Surface Speed — Surface speed. 

Contact Area — The area of the tool that is in contact with the material. 

OP Volume Removal Rate — Optimized volume removal rate, as calculated by 
OptiPath. 

OP Chip Thickness — Optimized chip thickness, as calculated by OptiPath. 

OP Feed Per Minute — Optimized feed per minute, as calculated by OptiPath. 

Op Feed Per Tooth — Optimized feed per tooth, as calculated by OptiPath. 

OP Feed Per Revolution — Optimized feed per revolution, as calculated by OptiPath. 

Show Tool Change — Use to show tool changes in the Cutting Conditions graph. Tool 
changes are represented by a vertical line, in the cut color, at the point of the tool change. 
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Graphs window, configuration mode 
  

The Graphs window, in configuration mode, enables you to specify graph display 
characteristics and features to be graphed. Many of the features are identical to the ones 
in the Graphs window and are described there.  

  

 
  

Tool Use — When toggled "On" (check mark displayed), displays the Tool Use graph 
which shows the machining time spent by each simulated tool. Each tool that cuts the part 
is shown in the graph with its cut color. Click in the box to the left of Tool Use to toggle 
the graph On/Off. 

Cutting Conditions — When toggled "On" (check mark displayed), displays the 
Cutting Conditions graph which shows changes in the selected cutting condition 
features. Click in the box to the left of Cutting Conditions to toggle the graph On/Off. 
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Select any of "cutting condition" features to be displayed in the Cutting Conditions 
graph from the list below the graph area. 

Color Pallets — Use the color pallet associated with each cutting condition feature to 
specify the color that is to represent the feature in the graph. Click on the icon to display 
the color pallet for your color selection. 

Min/Max values — Use the Min/Max values associated with each cutting condition 
feature to specify the lower/upper limits of the range of values representing the vertical 
component of the graph (see the picture below).  

Show Tool Change — Use to show tool changes in the Cutting Conditions graph. Tool 
changes are represented by a vertical line, in the cut color, at the point of the tool change 
(see the picture below). 

Set All — Select all available features to be displayed in the Cutting Conditions graph. 

Clear All — Clear all selected features. 

  

Sample Cutting Conditions graph: 
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Machine Offsets window 
VERICUT Location: Info menu > Machine Offsets 

  

 
  

Opens a window that displays the values that are set for each machine offset and whether 
the particular machine offset is currently active. If you "Single Step" through the 
toolpath, the displayed values update at the end of each motion. When you are using 
"Play to End", the displayed values are updated each time you "Stop" processing or 
when processing stops at the end of the NC program. The Machine Offsets window is 
intended for debugging purposes only. The window displays current values set for each 
offset and whether the offset is currently active. You cannot modify the values directly in 
the Machine Offsets window. The values must be edited in the table or macro in which 
they were originally set. 

 The offsets are grouped into 4 categories:  Work& Shift, Tool, Other, and Total 
Offsets, as shown in the Category column in the window above. Each Category can 
consist of a number of different machine offsets and are displayed in the Offsets column. 
The remaining columns indicate the offset values that are set/applied for each machine 
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axis. Each particular offset will only displayed if it contains non-zero values. If all offsets 
within a Category are zero, then the Category will not be displayed. The exception to this 
rule is the Total Offsets Category which will always be displayed. 

This window also contains a series of flags associated with offsets and transformations. 

 

SubSystem — All values displayed in the Machine Offsets window are specific to a 
particular subsystem. If the machine configuration has more than one subsystem, use this 
feature to select the desired subsystem. 

 

Offset Categories 
 
Work and Shift: 
These offsets are in a separate category because the DynamicWorkOffsets feature 
applies to these offsets. 

Base Work Offset — Base Work Offset is affected by the following macros: 

SetBaseWorkOffset 
CancelWorkOffsets 
EnableWorkShiftOffsets 
DisableWorkShiftOffsets 
CancelAllWorkOffsets 
BaseWorkOffsetValues 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

NOTE:  This offset is automatically applied during reset. 

 

Work Offset — Work Offset is affected by the following macros:  

WorkCoord 
AdditionalWorkCoord 
SetBaseWorkOffset 
CancelWorkOffsets 
EnableWorkShiftOffsets 
DisableWorkShiftOffsets 
CancelWorkOffsets 
CancelAllWorkOffset 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 NOTE:  This can also be set from the Configuration menu > Control Settings: 
Offsets tab. 
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Secondary Work Offset — Secondary Work Offset is affected by the following macros: 

SecondaryWorkCoord  
SecondaryRefWorkCoord 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

Shift 1 — Shift 1 is affected by the following macros: 

ChangeWorkCoord 
AbsoluteShift, IncrementalShift 
EnableWorkShiftOffsets 
DisableWorkShiftOffsets 
CancelShiftOffsets 
CancelAllWorkOffsets 
SiemensShiftOffsetA 
SiemensL137COffset 
SiemensL137CoffsetCancel 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

Shift 2 — Shift 2 is affected by the following macros: 

AbsoluteShiftNum 
OkumaCopyStart 
OkumaCopyEnd 
OkumaShiftRotate 
OkumaCancelShiftRotate 
SiemensShiftOffsetB 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

Shift 3 — Shift 3 is affected by the following macros: 

NumLengthCompX 
NumLengthCompY 
NumLengthCompZ 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

Total — The combined total of all of the above offsets. 
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Adjusted Total — The resulting total after the corresponding rotations have been 
applied. 

 

Tool:  
In many cases, an offset will be applied to the machine based on the tool offset and the 
orientation of the tool. The tool offset can actually be composed of several pieces; some 
of which are mutually exclusive. 

Gage Offset — This value is typically calculated from the tls file. It is the "Gage Offset" 
minus the "Ctrl Pt". You can override the value from the tls file with an entry in the Gage 
Offset Table. This value is typically set with a tool change. Its value can also be updated 
with a call to the ToolOffsetUpdate macro 

 

Tool Length Offset — This value is typically only used if the Programming Method is 
set to Tool Length Compensation. This value can, however, be used in all 3 Programming 
Methods. The value will be set based on the corresponding entry in the Tool Length 
Compensation table. If no entry exists, and the Programming Method is set to Tool 
Length Compensation, this value will be set to the Z value of the Input Program Zero + 
the Z value of the Gage Offset. Tool Length Offset is affected by the following 
ToolLengthComp... macros: 

ToolLengthCompUpdate 
ToolLengthCompPos 
ToolLengthCompNeg 
ToolLengthCompOff 
ToolLengthCompValue ToolLengthCompToolnum 
SiemensPlaneSelectionArg 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

Tool Nose Comp — Tool Nose Comp is affected by the following ToolNoseComp... 
macros: 

ToolNoseCompApply 
ToolNoseCompCancel 
ToolNoseCompToolNum 
ToolNoseCompValue 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

Turret Offset — The turret offset is defined to be the XYZ distance from the active tool 
to the center of its corresponding Turret. This offset can be turned on and off. When 
turned on, this offset will be set with calls to either TurretActivateTool or 
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TurretToolChange macros. It can also be reset to zero if the current gage offset is set to 
zero and the apply turret offset flag is set accordingly. This flag is set with the 
ApplyTurretOffset macro. 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

GagePivotOffset — This offset is used as an alternative approach to RTCP (Dynamic 
Tool Offsets). RTCP has been based on the concept of the spindle face being the driven 
point when there is no tool in the spindle. When a tool is loaded, and then rotated, both 
the gage offset and the pivot offset needs to be adjusted. When driving the center of the 
pivot, and then adjusting for the gage and pivot offset, the calculation is different. This 
offset is used for this latter approach. Its functionality is currently limited. The capability 
is turned on with the ApplyGagePivotOffset macro, and its value is updated whenever 
the tool offsets are updated. This capability is mutually exclusive with RTCP. 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

Current RTCP Pivot Offset — The pivot offset can set be set in the RTCP Pivot 
Offset Table. If the corresponding entry does not exist, it will be auto-calculated based 
on the active tool component and the position of the corresponding parent rotary 
components. The application of this offset can be turned on, or off, using the 
ApplyPivotOffset macro. When applied, it will be adjusted based on the orientation of 
the tool. It assumes that in its initial state, no offsets are to be applied. The initial state is 
set at start of processing, and can be updated with a call to the SetPivotOffset macro. 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

Applied Total — This is the sum of the Tool offsets, which are currently being applied.  

NOTE:  Not all of the offsets listed will be applied. For example: Gage Offset values 
might be specified, but may not be applied because the Programming Method is set to 
Gage Length.  

 

Adjusted Total — This value takes the applied total, possibly adjusts it based on the 
orientation of the tool, and then applies it to the corresponding axis. See the following 
macros: 

XToolOffsetCompName 
YToolOffsetCompName 
ZToolOffsetCompName 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 
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Other:    
Dynamic 3D Tool Offset — See Tool3dOffset in the VERICUT Macros section in the 
CGTech Help Library. 

 

3D Tool Length Comp — The Tool Length Offset as describe above, is an offset, which 
applies only to Z. There is special handling of this value within the software, and has 
therefore not been grouped with the Tool offsets. This offset can be applied to any axis. 
See FanucToolLengthComp and ToolLengthCompOff in the VERICUT Macros 
section, in the CGTech Help Library. 

 

Input Program Zero — This offset is typically set in the Input Program Zero (Special 
Z) table. The values are automatically activated during initialization, and can be updated 
with calls to UpdateIPZ and AutoUpdateIPZ macros.  When the Programming 
Method is set to Tool Length Compensation, the Z value of the IPZ will not be applied. 
In this programming method, the Z value might later be used in the calculation of the 
Tool Length Offset. 

 

Input Machine Zero — This offset is set in the Machine Zero table and is 
automatically activated during initialization. Typically, this offset is not used. 

 

Miscellaneous — Other offsets that might be applied – intentionally not defined. 

 

Total — Sum of the above offsets. 

 

Total Offsets:  
Sum of all offsets being applied.   

NOTE:  This does not include rotation planes. 

 

Active Translations/Rotations: 
The following become highlighted when the particular translation/rotation is active. 
RTCP Pivot Offset is shown in its "active" state in the sample Machine Offsets window 
shown at the start of this topic. 

Gage Offset — If the Programming Method is set to Tool Tip, the Gage Offset will be 
applied. 
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RTCP Pivot Offset — This flag is set if in RTCP mode and the pivot offset is applied. 
See macros: 

RtcpOn 
RtcpOff, RotaryControlPointOnOff 
ApplyPivotOffset 

This flag is also set if in a special Fanuc Tool Length Comp Mode and the apply pivot 
offset flag is set to 2. See macros: 

FanucToolLengthCompAxisOn 
ToolLengthCompOff 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

3D Rotation Planes — This flag is set if Rotation Planes are currently being applied. See 
macros: 

RotationPlane 
RotationPlane2 
RotationPlaneCancel 
RotationPlaneCancel2 
FidiaRotate 
FidiaRotate2 
FidiaRotateCancel 
FidiaRotateCancel2 
NumPlane 
VirtualYAxis 

 
For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 
 

Turret Offset — This flag is set with the ApplyTurretOffset macro. 

 

2D Rotations — 2D rotations are defined within the active plane (XY, YZ or ZX).  The 
2D rotation flag is set with calls to the following macros:  

RotateXYZ 
RotateCancel 
RotateOrigin 
RotateMacro 

 
For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 
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NOTES: 
1. Optimization is suspended when 2D Rotation is turned on. The following warning 

message is output: "Optimization turned off while 2D Rotation is active" when 
optimization is suspended for this reason. 

2. If  Debug Optimization is turned on, a DEBUG message will be printed on every 
line which is suspended for this reason. 

 
Mirroring — If mirroring about any axis is set, this mirror flag will be set. Mirroring is 
activated with calls to the following Mirror... macros:  

MirrorX 
MirrorY 
MirrorZ 
MirrorA 
MirrorB 
MirrorC 
MirrorA2 
MirrorB2 
MirrorC2 
MirrorXValue 
MirrorYValue 
MirrorZValue 
MirrorAValue 
MirrorBValue 
MirrorCValue 
MirrorA2Value 
MirrorB2Value 
MirrorC2Value 
MirrorCancel 
MirrorXCancel 
MirrorYCancel 
MirrorZCancel 
MirrorACancel 
MirrorBCancel 
MirrorCCancel 
MirrorA2Cancel 
MirrorB2Cancel 
MirrorC2Cancel 

 
For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

Gage Pivot Offset — This feature is turned on with the ApplyGagePivotOffset macro. 
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RPCP — This feature can be set using the Configuration menu > Control Settings: 
Rotary tab. It can also be set with the following macros: 

RpcpOn 
RpcpOff 
RotaryControlPointOnOff 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 
 

RTCP — This feature can be set using the Configuration menu > Control Settings: 
Rotary tab. It can also be set with the following macros: 

RtcpOn 
RtcpOff 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 
 
 
Rotation Plane Matrix: 
 

The Rotation Plane Matrix represents the cumulative effect of all translations and 
rotations currently applied to the rotation plane (also known as the working plane). Its 
twelve parameters reveal the geometric attributes of the local (transformed) coordinate 
system (CSYS) relative to the machine origin. This representation only includes 
translations and rotations resulting from using the RotationPlane... macros. The matrix 
values do not include the effect of using the Rpcp... macros or the VirtualXAxis / 
VirtualYAxis macros. 

For information about these, and all, VERICUT macros, see the VERICUT Macros 
section, in the CGTech Help Library. 

 

The format of the matrix table is as follows: 

 I J K D 

X I1 J1 K1 D1 

Y I2 J2 K2 D2 

Z I3 J3 K3 D3 

  

Each row represents an axis of the local CSYS. The first three columns represent the 
vector associated with each axis:  I1, J1, K1 as the positive X-axis vector; I2, J2, K2 as 
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the positive Y-axis vector; and I3, J3, K3 as the positive Z-axis vector. The fourth column 
values D1, D2, D3 represent the coordinates of the origin point of the local CSYS. 

 

NOTE:  If you prefer to see the Matrix Table displayed with the I, J, K along the vertical 
axis and the X, Y, Z along the horizontal axis, set the environment variable, 
CGTECH_MATRIX_FORMAT=VERTICAL. 
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Call Stack window 
VERICUT Location: Info menu > Call Stack 

 
The features in the Call Stack window enable you to track information like subroutine 
calls, and which subsystem is currently active. The picture below shows the current status 
of two subsystems. 
 

 
 
 

The following information is displayed for each subsystem: 

The processing status of the current record. 

Active Tool — Displays the name of the active tool component. 

Active Stock — Displays the name of the active stock component. 

NOTE:  The active stock defaults to the first stock in the component tree. If 
multiple stocks exists, the active stock needs to be set.  

Also see: ActivateToolSubsystem, and SetActiveStockName, in the VERICUT 
Macros section, in the CGTech Help Library. 

 
Each record displays the following information: 

Depth — Shows the depth, or level of subroutine calls. For example, in the picture 
above, Subsystem "2" shows 3 levels of subroutine calls. Depth 1 represents the main 
program, Depth 2 represents a subroutine (2001) which was called from the main 
program, and Depth 3 represents a subroutine (110) called from the Depth 2 
subroutine. 
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Subroutine — Shows either the name of the main program, or subroutine, 
represented by the record. 

NC Program Record — Shows the text of NC program record calling the 
subroutine. 

Line Number — Shows the number of the line in the file represented by the record. 

File Name — Shows the name of the file that the NC program, or subroutine, is in. 

 

  (Close Call Stack) — Closes the Call Stack window. 

 

Tip:  
The records in the Call Stack window are linked to the NC Program (Info) window. 
Clicking on the "calling" record in the Call Stack window will highlight the 
corresponding block in the NC Program (info) window. Clicking on a subroutine record 
in the Call Stack window, highlights the first line in the subroutine in the NC Program 
(Info) window.
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File Summary window 
  
VERICUT Users:  
VERICUT Location: Info menu > File Summary 

 

Mold and Die Users: 
Mold and Die Location:   Analyze, View Files, Print page > Show Files Used 

Notebook Feature:       

 

Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print page > Show Files Used 

Notebook Feature:      

  
Opens a window that provides a summary of files with their creation dates, and 
environment variables, currently being used by VERICUT. All standard text viewing 
features are supported, such as: search forward/backward, go to line number, print, etc. 
 
File Summary window: 
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Line Number or Search Text — Use this text field to enter a line number, or a string of 
text, to search for. 

 Goto Line Number — Moves the cursor in the file listing to the line number 
specified in the Line Number or Search Text field. 

 Search Forward — Searches forward in the file listing for the text string specified 
in the Line Number or Search Text field. 

 Search Backward — Searches backward in the file listing for the text string 
specified in the Line Number or Search Text field. 

 Print — Print the file. 

 Copy All Files — Displays the Copy Files window enabling you to copy any, or all, 
of the listed files to a specified directory. Click on the check boxes to select or deselect 
the files you want copied. 
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Copy Files window 
 

 
 

Use the "To the following directory" text field to specify the path to the directory, 
or use the Browse button and use the window that displays to select the directory, to 
receive the copied files. 

Copy — Use to complete the copy when you have finished selecting the files. 

Set All — Use to select all of the files in the list for copying. 

Clear All — Use to clear the check boxes for all of the files in the list. 

Cancel — Use to close the Copy Files window without copying any of the files. 

 

 Close Window — Closes the File Summary window. 
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G-Code Report 
Location: Info menu > G-Code Report 

 

Creates a G-Code Report file containing information about how the current NC control 
configuration will interpret a G-Code NC program file. Reported information includes: 
machine codes present in the NC Program and macros (actions) they will call, variables 
used (if any), cutting tools used, subroutines defined and referenced, and more. 

 

 
 

Click here to see a sample G-Code Report file. 
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Menu Bar: 
The menu bar located at the top of the window provides easy access to major functions. 
Each menu contains groups of related functions. Left-click on any menu name to display 
the list of functions in that menu. Click on the function in the menu you want to use. The 
name of the current file is also displayed in this area. 

 

File:  
Open — Open a file. 

Save — Save the current file. 

Save As — Save the current file under a different name. 

Print — Print the file. 

Exit — Close the window. 

Edit: 
Cut — Cuts the highlighted text in the file listing and puts it in the paste buffer.  

Copy — Copies the highlighted text in the file listing to the paste buffer. 

Paste — Puts the contents of the paste buffer at the location of the cursor in the file 
listing. 

 

Icon Bar: 
 

 
 

The items in the Icon Bar enable you to search for, and/or replace, specific items in the 
file listing, print the file, or exit the window. Moving the cursor over the icon will display 
name of the option. Each feature (from left to right) is described below. 

 

 Open File — Opens a file selection window enabling you to select another file. 

 Save File — Save the current file. 

Line Number or Search Text — Use this text field to enter a line number, or a string of 
text, to search for. 

 Goto Line Number — Moves the cursor in the file listing to the line number 
specified in the Line Number or Search Text field. 
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 Search Forward — Searches forward in the file listing for the text string specified 
in the Line Number or Search Text field. 

 Search Backward — Searches backward in the file listing for the text string 
specified in the Line Number or Search Text field. 

Replacement Text — Use this text field to enter a "replacement text" string. 

 Replace One — Replace one occurrence of text string in the Line Number or Search 
Text field (or the highlighted text in the file listing) with the text string in the 
Replacement Text field. 

 Replace All — Replace all occurrences of the text string in the Line Number or 
Search Text field with the text string in the Replacement Text field. 

 Print — Print the file. 

 Close Window — Closes the window. 

 
 
Shortcut:  Right-click in the Text File Edit window to display the following menu: 
 

 
 
These features provide the same functionality as those described under Edit in the menu 
bar.



VERICUT HELP – Info menu 
 
 

 

Control Report 
Location: Info menu > Control Report 

 

Creates a Control Report file containing information about how the current NC control 
configuration will interpret machine codes. Reported information includes all the G-
Codes the control is configured to handle and macros (actions) they will call, subroutines, 
and other supported control features. 

 

 
 

Click here to see a sample Control Report file. 
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Menu Bar: 
The menu bar located at the top of the window provides easy access to major functions. 
Each menu contains groups of related functions. Left-click on any menu name to display 
the list of functions in that menu. Click on the function in the menu you want to use. The 
name of the current file is also displayed in this area. 

 

File:  
Open — Open a file. 

Save — Save the current file. 

Save As — Save the current file under a different name. 

Print — Print the file. 

Exit — Close the window. 

Edit: 
Cut — Cuts the highlighted text in the file listing and puts it in the paste buffer.  

Copy — Copies the highlighted text in the file listing to the paste buffer. 

Paste — Puts the contents of the paste buffer at the location of the cursor in the file 
listing. 

 

Icon Bar: 
 

 
 

The items in the Icon Bar enable you to search for, and/or replace, specific items in the 
file listing, print the file, or exit the window. Moving the cursor over the icon will display 
name of the option. Each feature (from left to right) is described below. 

 

 Open File — Opens a file selection window enabling you to select another file. 

 Save File — Save the current file. 

Line Number or Search Text — Use this text field to enter a line number, or a string of 
text, to search for. 

 Goto Line Number — Moves the cursor in the file listing to the line number 
specified in the Line Number or Search Text field. 
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 Search Forward — Searches forward in the file listing for the text string specified 
in the Line Number or Search Text field. 

 Search Backward — Searches backward in the file listing for the text string 
specified in the Line Number or Search Text field. 

Replacement Text — Use this text field to enter a "replacement text" string. 

 Replace One — Replace one occurrence of text string in the Line Number or Search 
Text field (or the highlighted text in the file listing) with the text string in the 
Replacement Text field. 

 Replace All — Replace all occurrences of the text string in the Line Number or 
Search Text field with the text string in the Replacement Text field. 

 Print — Print the file. 

 Close Window — Closes the window. 

 
 
Shortcut:  Right-click in the Text File Edit window to display the following menu: 
 

 
 
These features provide the same functionality as those described under Edit in the menu 
bar.
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VERICUT Log 
  
VERICUT Users: 
VERICUT Location: Info menu > VERICUT Log 

Toolbar shortcut:  
  
Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print page > View Log File 

Notebook Feature:      

 
Opens a window containing the VERICUT Log file. This file contains session 
information, such as error, warning and informational messages about the verification 
session. In this window, you can view, print, change then name, or reset Log file 
contents. 
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File menu 
Open — Opens a file selection window enabling you to open an existing log file. 

Save As — Opens a file selection window enabling you to save the VERICUT Log 
file. 

Print — Opens a window enabling you specify page setup preferences, select a 
printer and print the VERICUT Log file. 

Reset Log File — Use to clear the contents of the VERICUT Log file. 

Exit — Closes the VERICUT Log window. 

 

Edit menu 
Copy — After highlighting the desired text in the VERICUT Log file, use this feature 
to copy the highlighted text to a paste buffer which can then be pasted to a text file, 
email, etc. 

 
Line Number or Search Text — Use this text field to enter a line number, or a string of 
text, to search for. 

 Goto Line Number — Moves the cursor in the file listing to the line number 
specified in the Line Number or Search Text field. 

 Search Forward — Searches forward in the file listing for the text string specified 
in the Line Number or Search Text field. 

 Search Backward — Searches backward in the file listing for the text string 
specified in the Line Number or Search Text field. 

 Print — Print the VERICUT Log file. 

 Close Window — Closes the VERICUT Log window. 
 
Click here to see a sample VERICUT Log file. 
 



VERICUT HELP – Info menu 
 
 

 

Clear Log File and Logger 
Location: Info menu > Clear Log File and Logger 

Toolbar shortcut:  

  

This feature enables you to clear both the Message area, also known as the "message 
logger", and the VERICUT Log file. 
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Project Menu 
 

Introduction to the Project Setup menu 
 

The features on the Project Setup menus provide the tools required for the day to day use 
of VERICUT for setting up jobs for verification and simulation. The following basic 
concepts are needed to understand the process of setting up a job for VERICUT. 

 

 
 

Project — A project consists of one or more setups (see Setup below) enabling you to 
simulate multiple operations in a single VERICUT session. Multiple Setups within a 
project can use the same, or different, machines. A Project with a single Setup is logically 
equivalent to the User file of past VERICUT releases. 
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Setup — A Setup is a collection of VERICUT settings and files (machine, control, tool 
library, etc.), NC program files, and Setup models (Stock, Fixture, Design) that define the 
machine operation to be simulated. A Setup is logically equivalent to the User file of past 
VERICUT releases. 

Current Setup — The Setup menu choices such as CNC Machine, NC Programs, etc., 
apply only to the Current Setup. A setup can be designated "current" either by selecting it 
using the Current Setup option in the Project menu, or by selecting it in the Project Tree. 
The "current" setup is indicated by a checkmark in the Current Setup menu and is 
displayed as bold in the Project Tree (See Setup 3 in the picture above). 

Active / Inactive Setup — A Setup can be designated as being in either an Active, or 
Inactive state. When a Setup is designated as Inactive, it is not simulated, as if it were not 
present in the overall process. An Inactive setup can however be designated as the 
"current" setup and modified. Inactive Setups are indicated by red text in both the Current 
Setup menu and in the Project Tree (See Setup 2 in the picture above). 
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Current Setup 
Location: Project menu > Current Setup 

  

Selecting Current Setup displays a pull-right menu showing a list of available Setups. A 
check mark is displayed next to the current setup (See Setup 3 in the picture below). 
Picking a setup on the list makes it the current one. Inactive setups are displayed in red 
text (See Setup 2 in the picture below). 
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Add New Setup 
Location: Project menu > Add New Setup  

  

Add New Setup appends a new setup after the current setup. All settings from the current 
setup are copied to the new setup. Once the new setup is added, it becomes the current 
setup. 
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Delete Current Setup 
Location: Project menu > Delete Current Setup 

  

Delete Current Setup deletes the current setup and makes the next setup in the list the 
current setup (Example 1). If the setup at the end of the list is deleted, then the previous 
setup becomes the current setup (Example 2). There must always be at least one setup in 
a project. Therefore the last remaining setup cannot be deleted. 

   

Example 1:   

 

Before using Delete Current 
Setup, Setup: 2 is the 
"current" setup. 

 

After using Delete Current 
Setup, Setup:2 is deleted and 
Setup:3 (the next in the list) 
 becomes the "current setup. 
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Example 2: 
   

 

Before using Delete Current 
Setup, Setup: 4 (the last in the 
list) is the "current" setup. 

 

After using Delete Current 
Setup, Setup:4 is deleted and 
Setup:3 (the previous in the 
list)  becomes the "current 
setup. 
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Import Setup 
Location: Project menu > Import Setup  

  

Copies a setup from either a pre-V6.0 user file or from a V6.0 project file and appends it 
after the current setup.  

  

 
  

Project File selection window — Use the Project file selection window to specify the 
project file that the setup is to be imported from. 

Setup List — After selecting the project file, a list of setups contained in the project file. 
Select one or more setups to be imported. Use the Shift and Ctrl keys on the keyboard to 
select multiple setups. 

Import — Use to import the highlighted setups into the "current" project file. 

Close — Closes the Import Setup window without importing any setups. 
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CNC Machine window 
Location: Project menu > CNC Machine  

  

CNC Machine opens a dialogue for selecting the Machine and Control file to use for the 
current setup. 

  

 
  

Machine 
Machine files contain data that describes NC machine construction, kinematics, and other 
properties. 

Enter the \path\file name in the text field of the Machine file to be used or click on the 
Browse button and use the file selection window that displays to specify the machine file.  

You can also click on the arrow button  at the end of the Machine text field to display 
a list of all the Machine files contained in the "library" directory of your VERICUT 
installation and select the desired Machine file from the list. 

  

Control 
Control files contain data that describes how the NC control processes machine code 
data. 

Enter the \path\file name in the text field of the Control file to be used or click on the 
Browse button and use the file selection window that displays to specify the control file.  

You can also click on the arrow button  at the end of the Control text field to display 
a list of all the Control files contained in the "library" directory of your VERICUT 
installation and select the desired Control file from the list. 
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Setup Models 
 

Define (Modeling window) 
VERICUT Users: 
VERICUT Location: Project menu > Setup Models > Define 

VERICUT toolbar short cut:  

  
Mold and Die Users: 
Mold and Die Location:   Analysis and Viewing page > Specify a Design Model 

Notebook Feature:      

 

Opens the Modeling window to define or import the models that represent the solid 
objects used in the simulation. VERICUT uses "components" to describe the function of 
various solid objects. Models provide 3-D size and shape for material removal and 
collision checking. To learn more, see "About modeling in VERICUT" in the Using 
VERICUT section. Using VERICUT can be found in the CGTech Help Library. 
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Active Component — Component active for editing. The active component is 
automatically set when you select items from the graphics area or Component Tree 
window. However, you can select a different component via picking it from the option 
list. 

Component Type — The active component's type is shown in an un-editable field for 
reference purposes. To change the component type, use the Component Tree window 
Edit menu. 

Selected — Identifies what is selected for editing: a Model or the Component. This 
option is automatically set when you select items from the graphics area or Component 
Tree window. However, you can change what is selected for editing via clicking the other 
option. 

 

Model tab — Features on this tab add and modify models attached to components to 
provide 3-D shape. The models can be simple parametric shapes, or refer to external 
model files. 

Position tab — Features on this tab move a component or model. 

Component Attributes tab — Features on this tab define the attributes of a component. 

Import tab — Features on this tab import IGES model files for use as stock, fixture, 
design, or machine component models. 

 

OK — Applies the changes and closes the Modeling window. 

Apply — Applies the changes and leaves the Modeling window open. 

Cancel — Closes the Modeling window without applying changes. 

 

Tips: 
1. Right-click shortcut menu: Features used to manipulate components are displayed 

in a shortcut menu when a component is selected and the right mouse button is 
clicked in the graphics area. Similarly, features used to manipulate models are 
displayed when a model is selected and the right mouse button is clicked. 

2. Delete components or models by selection the object in the graphics area, then use 
the <Delete> key on your keyboard 

3. Click repeatedly on a model in the graphics area to toggle selection between the 
model and its component. Refer to the Component Tree window to review what is 
selected. 

4. Using the center mouse button of a three button mouse, click repeatedly on a 
model in the graphics area to toggle selection between different models along the 
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line of sight from the pick point. Use this technique to select models hidden from 
view by an object in the foreground. 

 
 
Also see "Modeling in VERICUT", in the Using VERICUT section, in the CGTech Help 
Library.
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Modeling window, Model tab 
Location: Project menu > Setup Models > Define 

Toolbar short cut:   

 

Features on this tab are used to add and modify models attached to components to 
provide 3-D shape. The models can be simple parametric shapes, or refer to external 
model files. 

 

 
  

 

Type — Type of model being defined. The active choice configures the model 
description area below this option with the values needed to define the selected model. 
The table below lists the available model types and corresponding descriptions. 
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Model type: Appears in the Component Tree: Description 

Block 

 

 
 

Length (X) 
Width (Y) 
Height (Z) 
Color 

Cone 

 

 

Height (Z)  
Base Radius 
Top Radius 
Color 

Cylinder 
 

 

Height (Z) 
Radius 
Color 

Model File 

 

Model File,  
Sketcher,   
Normals*,  
Units,  
Color 

 
 
Block specific features: 
Length (X), Width (Y), Height (Z) — Dimensions of the block. 

Model Auto Block — This feature enables you to select a model file representing the 
design model and have VERICUT create a stock block enclosing the selected model. 
Selecting Model Auto Block displays the Model Auto Block file selection window 
enabling you to select the model file. Use the Units pull-down to specify the units (Inch 
or Millimeter) to be used. 

Path Auto Block — When defining a Block type model, this feature automatically 
defines and locates a stock block based on tool positions in the current tool path file(s). 
Rapid and APT-CLS "FROM" tool positions are ignored during this calculation. The 
block size and location guarantee that the tool path will cut the block. 

Use the text field to specify the offset to be applied to the block created using Model 
Auto Block or Path Auto Block (see above). The offset is applied to all dimensions. 

 

STL 

VERICUT Polygon 

VERICUT Solid 

Sweep 

SOR



VERICUT HELP – Project menu 
 

 
Cone specific features: 
Height (Z), Base Radius, Top Radius — Dimensions of the cone (height, radius at the 
base of the cone and the radius at the top of the cone). 

 
Cylinder specific features: 
Height (Z), Radius — Dimensions of the cylinder. 

 

Model File specific features: 
Model File — Enter the /path/filename of the model file or use the Browse button to 
display a file selection window and use it to select the model file. 

Sketcher — Displays the Profile Sketcher window enabling you to edit or create a 
"Sweep solid (.swp)" or "Revolve (.sor)" model file. This feature is only available when 
the selected file is a Revolve or Sweep file type. To create a new Revolve or Sweep 
model file, clear the Model File text field and press Sketcher, select the profile type 
(Revolve or Sweep) from the window that displays, then OK to display the Profile 
Sketcher window. Cancel dismisses the Profile Type window. 

Normals — This feature applies to STL file models only and indicates the direction in 
which surface normals defined in the STL data point, relative to the model. Select 
Inward, Outward, or Computed (let VERICUT determine the direction of the surface 
normals). 

Units —Units (Inch or Millimeter) of the model file.  

 

Common Features 
Color — Color of the model. Available colors are the Shade Colors defined on the Edit 
menu > Colors: Define tab. Models connected to the component have the option to 
"Inherit" or override the component's defined color. 

Add — Adds the model defined by the current window values to the active component. 

Visible — Toggles "on" or "off" to indicate whether or not the model file should be 
displayed in the graphics area. 

Preserve Stock Transition — Use to create the coordinate systems required for 
transitioning the cut stock(s) from one setup position to another. Preserve Stock 
Transition can be used to create the coordinate systems for each Stock component.  
Preserve Stock Transition is only active when a stock component model is selected.   

When Preserve Stock Transition is pressed, two coordinate systems named "Previous 
Setup name : Current Setup name : Active Stock component name" are created and added. 
Previous Setup name, Current Setup name and Active Stock component name are 
replaced by the actual names of these entities used in the project file, for example 
"Rough:Finish:Stock1". One CSYS is added to the current setup, attached to the Stock 
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Component parent of the selected model. It is created with Use for Cut Stock Transition 
toggled "On" (see the Define (Coordinate System window) section) , designating it as a 
coordinate system used for transitioning the cut stock from one setup position to another. 
The other CSYS is added to the first setup in the project, and is located at the origin of 
the stock component whose name matches current setup stock component. The following 
illustrates how to use Preserve Stock Transition: 

1. Configure Setup #1. 

2. Simulate. 

3. Configure Setup #2. 

4. Move cut stock into position using cut features and assembly modeling to position 
the cut stock 

5. Press Preserve Stock Transition. 

6. Simulate. 

7. Configure Setup #3. 

8. Move cut stock into position. 

9. Press Preserve Stock Transition. 

10. Simulate.  

11. and so on ... 

 
 
To Modeling window
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Modeling window, Position tab 
Location: Project menu > Setup Models > Define 

Toolbar short cut:   

 

Features on this tab move an object: component or model. 

 

 
 

Translate tab — Features on this tab translate the selected object via indicating "from" 
and "to" points to move the object. 

Rotate tab — Features on this tab rotate the selected object about a rotation center point. 

Assemble tab — Features on this tab move the object by assembling (mating or aligning) 
it with other objects. 

Matrix tab — Features on this tab move the selected object via a twelve parameter 
transformation matrix. 

CSYS tab — Features on this tab enable you to move a selected component/model from 
one coordinate system to another. 

Mirror tab — Features on this tab enable you to mirror a model about a specified axis 
(plane). 
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Location features 
The Location features are common to all of the above tabs and show the selected object's 
position and angle, and can be used to move the object or verify its current location. 
Values are shown relative to the parent component or machine origin, whichever is 
selected: Relative Location or Machine Location, respectively. 

Location Relative to Parent — When selected, it indicates that the object location is 
shown relative to the parent component origin. Examples follow. 

Positioning a component — component is moved relative to the parent component 
origin. 

Positioning a model — model is moved relative to the component origin. 

Location Relative to Machine Csys — When selected, it indicates that the object 
location is shown relative to the machine origin. 

Position — Specifies the absolute XYZ position of the object, separated by spaces. 

Angles — Specifies the absolute XYZ rotation of the object, separated by spaces. 

Undo — Returns the object to its previous location, or as it was when the Modeling 
window was opened. 

 
 
To Modeling window
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Modeling window, Position tab, Translate tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab translate the selected object via indicating "from" and "to" points to 
move the object. Movement occurs each time you press the Move button. If the applied 
movement is incorrect, press Undo (on the Position tab) to return the object to its 
previous location. 

 

 
  

Translate tab features 
From / To — Specifies the locations to move the object from and to, relative to the 
machine origin. XYZ values can be entered (separated by spaces), or selected by clicking 
in the field then clicking on a model. As you move the mouse over the VERICUT model, 
a crosshair and vector show you the pending pick-point location. Graphical selection 
supports picking corner points and midpoints of uncut model geometry, or virtually any 
point on machined features. 

  

Move — Moves the selected object by the incremental distance, as calculated from the 
"From" point to the "To" point location. 

 
 
To Position tab 
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Modeling window, Position tab, Rotate tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab rotate the selected object about a rotation center point. Movement 
occurs each time you press one of the rotation direction buttons: X+/X-, Y+/Y-, Z+/Z-. If 
the applied movement is incorrect, press Undo to return the object to its previous 
location. 

 

 
 

Rotate tab features 
Center of Rotation — Specifies XYZ point location about which to rotate the object. 
XYZ values can be entered (separated by spaces), or selected by clicking in the field then 

clicking a position on a model. To see the center of rotation, press . To remove the 
center of rotation symbol press the button again, or close the window. 

Increment — Specifies incremental degrees of rotation to apply when one of the rotation 
direction buttons are pressed. 

Rotation direction buttons — (X+/X-, Y+/Y-, Z+/Z-) When pressed, applies the 
incremental rotation specified in the Increment field. Rotation occurs about the Center 
of Rotation, relative to the machine origin. 

 
 
To Position tab 
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Modeling window, Position tab, Assemble tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab move the selected object by assembling (mating or aligning) it with 
other objects. Objects are assembled by mating or aligning one to three planar surfaces 
with surfaces on other models. If a non-planar surface is selected, VERICUT constructs a 
tangent plane at the pick point. The relationship of surfaces being mated or aligned is 
known as a "constraint".  

  

Follow these general steps to define a constraint for assembly: 

1. Choose the constraint type. 

2. Select a surface on the object to move. 

3. Select the surface to move the object relative to. 

  

 
 

Assemble tab features 
Constraint Type — Specifies how to constrain selected surfaces during object 
movement. After selecting two surfaces to define a constraint, VERICUT moves the 
object and highlights the satisfied constraint with a checkmark. Options: 

Mate — Moves the object so the selected surface opposes the surface selected on the 
second object (surface normals oppose each other). 

Align — Moves the object so the selected surface is aligned with the surface selected 
on the second object (surface normals point in the same direction). 
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Consider the starting condition below for the examples that follow. 

 
   

 

Mated surfaces — the left side of the magenta model is mated with the right side of the 
yellow model.  
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Aligned surfaces — the left side of the magenta model is aligned with the left side of the 
yellow model. 

   

 
  

Offset — Distance and direction in which to offset constrained surfaces, applied normal 
to the surface. 

 

Reset — Resets constraints to receive new data. 

Undo — Returns the object to its previous location, or as it was when the window was 
opened. 

 
 
To Position tab 
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Modeling window, Position tab, Matrix tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab move the selected object via a twelve parameter transformation 
matrix. If the applied movement is incorrect, press Undo (on the Position tab) to return 
the object to its previous location. 

  

 
 

Matrix tab features 
Matrix table — The transformation matrix table is similar to the matrix used in 
programming APT tool paths. Its twelve parameters reveal the geometric attributes of the 
local (transformed) coordinate system (CSYS) in terms of the machine origin.  

 

The format of the matrix table is as follows: 

  I J K D 

X I1 J1 K1 D1 

Y I2 J2 K2 D2 

Z I3 J3 K3 D3 

  

Each row represents an axis of the local CSYS. The first three columns represent the 
vector associated with each axis:  I1, J1, K1 as the positive X-axis vector; I2, J2,K2 as the 
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positive Y-axis vector; and I3, J3, K3 as the positive Z-axis vector. The fourth column 
values D1, D2, D3 represent the coordinates of the origin point of the local CSYS. 

NOTE:  If you prefer to see the Matrix Table displayed with the I, J, K along the vertical 
axis and the X, Y, Z along the horizontal axis, set the environment variable, 
CGTECH_MATRIX_FORMAT=VERTICAL. 

Update — Updates the object location to reflect the matrix table transformation. After 
updating, press OK or Apply to move the object. 

Apply Inverse On Update — When selected, inverts the matrix so that its twelve 
parameters reveal the geometrical attributes of the machine origin in terms of the local 
(transformed) coordinate system. 

 
 
To Position tab 
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Modeling window, Position tab, CSYS tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab enable you to translate the selected object from one coordinate 
system (CSYS) to another. Select the "From" CSYS and the "To" CSYS to move the 
object. Movement occurs each time you press the Move button. If the applied movement 
is incorrect, press Undo (on the Position tab) to return the object to its previous location. 

  

 
  

CSYS tab features 
From / To — Specifies the coordinate system to move the object from, and to. Select the 
appropriate CSYS from each of the pull-down lists. 

Move — Moves the selected object from the "From" CSYS to the "To" CSYS 
orientation. 

 
To Position tab
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Modeling window, Position tab, Mirror tab 
Location: Project menu > Setup Models > Define: Position tab 

 

Features on this tab enable you to mirror a model about a specified plane, of a specified 
coordinate system. If the applied movement is incorrect, press Undo (on the Position tab) 
to return the object to its previous location. 

 

 
 

Mirror tab features 
Mirror About — Use the features in the pull-down list to specify the plane that the 
model is to be mirrored about. 

Off — The Mirror attribute is turned off. 

YZ Plane (X direction) — The Mirror attribute is set to mirror about the YZ plane. 

  

Off YZ Plane (X direction) 
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ZX Plane (Y direction) — The Mirror attribute is set to mirror about the ZX plane. 

Off 

 

ZX Plane (Y direction) 

 

  

XY plane (Z direction) — The Mirror attribute is set to mirror about the XY plane. 

Off 

 

XY Plane (Z direction) 

 

  

  

Mirror Relative To — Use to specify the coordinate system that the plane that you want 
to mirror about is related to. For example, the XY plane of the model origin. The pull-
down list will contain the model origin (the default) and all available coordinate systems. 
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Mirror — After specifying the plane, and the coordinate system that it is relative to, 
press Mirror to make the mirror take place. 

 

NOTES:  
  

1. The following model types can be mirrored: 

VERICUT polygon files (polygon, sweep solid or solid of revolution (SOR) 

STL files 

VRML files 

2. The model is mirrored in its local coordinate system (not the active coordinate 
system) 

3. The mirror attribute is part of the model structure and is saved with the model 
data when saved to the project file or machine file. 

4. When VERICUT reads a Project file or machine file, the models that have the 
mirror attribute set will be mirrored when loaded. 

 
 
To Position tab
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Modeling window, Component Attributes tab 
Location: Project menu > Setup Models > Define 

Toolbar short cut:   

 

Features on this tab define the attributes of a component. VERICUT handles components 
and their solid models differently depending on the component's type and attributes. Most 
attributes apply to components used in building NC machines. 

 

 
 

Color — Color of the component. Available colors are determined by the colors defined 
on the Edit menu > Colors: Define tab. 

Visibility — Controls the views in which the component is visible. Options: 

Blanked — Component is blanked from all views and cannot be seen. 

Workpiece View — Component is seen in the workpiece view. 

Machine View — Component is seen in the machine view. 
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Both — Component is seen in both the workpiece and machine views. 

See also: VERICUT command records that control displaying/loading/removing model 

 

Machine group: 
VERICUT uses a "moving tool philosophy" to describe motion directions, and reflect 
how the machine maintains the tool-to-workpiece relationship. This philosophy is used 
regardless of whether the Tool or Stock component is actually moving. Examples follow. 
Consider a standard 3-axis vertical milling machine where the Z-axis moves the tool 
up/down, and the X or Y-axis moves the workpiece. 

Example 1: 
 Z+ command causes the Z-axis to carry the tool in the Z+ direction relative to the 
workpiece- therefore using the moving tool philosophy describes positive motion 
direction as "Z+". 
Example 2: 
X+ command causes the X-axis to carry the workpiece in the X- direction relative to 
the tool. In this case, the tool is considered to move in the X+ direction relative to the 
workpiece- therefore using the moving tool philosophy describes positive motion 
direction as "X+", even though the workpiece is moving in the X- direction. 

Motion Axis — Specifies the axis of motion for a linear, rotary or turret type component, 
relative to the component coordinate system. Use a "moving tool philosophy" to specify 
the motion axis and direction, even though the component may actually move on the 
machine instead of the tool. 

Linear motion component: the motion axis is the axis in which linear motion occurs. 

Rotary and turret components: the motion axis is the axis about which rotation 
occurs. The positive rotation direction is counterclockwise when viewed from the 
positive end of the motion axis towards the component origin. 

Tool and spindle components: the motion axis is the aligned with the tool axis, 
typically "Z". 

Disable Auto Direction — When toggled "On" (checked), disables VERICUT's sense of 
the "moving tool philosophy" for that particular component.  

When Disable Auto Direction is toggled "Off" (not checked), VERICUT checks to 
determine whether or not the component is "part side". A component is considered "part 
side", when one of its child components is a Stock component. If the component is "part 
side", VERICUT automatically reverses the direction of motion. 

This feature is intended for use in situations where a component starts connected to one 
machine component , then later gets disconnected and reconnected to a different machine 
component (for example, moving a "stock" component from one "fixture" component to a 
different "fixture" component). If moving the component changes the "part side/not part 
side" relationship of the components, Disable Auto Direction should be toggled "On" 
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(checked) causing the component motion direction to remain constant regardless of 
where the component is connected. 

If the relationship between two components is sometimes "part side", and sometimes "not 
part side", then the Disable Auto Direction should be used, and the component motion 
direction set explicitly with Reverse Direction feature (described below).   

In the example below, the machine is configured like: 

Base 

   Y 

      X 

         A 

             Fixture1 

         U 

            A2 

               Fixture2 
Sometimes the Stock is connected to Fixture1, and sometimes it is connected to Fixture 2. 
Components A, U, and A2 should have Disable Auto Direction toggled "On", and 
Reverse Direction should be used to control the component's motion direction. 

Reverse Direction — When toggled "On" (checked), reverses the component motion 
direction. 

Mixed Mode — Controls how the component is displayed when displayed in Mixed 
draw mode. 

Connect To — Component to which the active component is connected. The component 
being connected to is known as the "connect component". Components must be 
connected in the same way as they are in the real world. Improper connections cause 
incorrect NC machine movement and simulation, especially when rotary components are 
involved. 

Rapid Rate — Feed rate for motion-type components moving in rapid positioning mode 
(e.g. G0). For linear motion components the value entered is units/minute where "units" 
reflect the units of the tool path file. For rotary motion components the value entered is 
degrees/minute. 

SubSystem — Subsystem which commands a linear or rotary motion type component to 
move. Any alpha-numeric sub-system name can be entered (may include spaces) and is 
always considered as text. Enter "*" (without the quotes) for motion axes included in all 
machine subsystems. Subsystems are used in machines with multiple motion components 
that are commanded to move via the same G-Code word, for example "X". By default, a 
machine uses one subsystem for all motion components, assuming they are commanded 
to move via unique G-Code words. 

When multiple motion components are driven by the same G-Code word, such as can 
occur in 4-axis lathes or mills with multiple independently controlled heads, define 
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different subsystems to control which component moves when the motion command is 
processed. Then, configure the control so that other codes in the tool path activate the 
appropriate subsystem for movement. A full set of tables are available to support each 
machine subsystem. See the Sample-Demo Files section, in the CGTech Help Library 
for examples of machines that use multiple subsystems. 

Tool Index — Index number of a Tool component. When defining machines with 
multiple tool load positions, such as a multi-spindle mill or a turret lathe machine with 
tools loaded in the turret, define additional Tool components with different index 
numbers. Values entered are integer numbers. Use the "ActiveTool" macros to activate 
each Tool component for tool changes. For example, call "ActiveTool2" to activate the 
Tool component with Tool Index=2, and so on. 

Toolchain Parameters — Displays the Toolchain window enabling you to specify 
toolchain component characteristics. Toolchain Parameters is only active when the 
Active Component is Tool Chain. 

Turret Aid — Displays the Turret Aid window enabling you to specify turret component 
characteristics. Turret Aid is only active when the Active Component is A Turret, B 
Turret, or C Turret. 

 

Accel/Decel group: 
Acceleration / Deceleration — Velocity at which the NC machine component can 
accelerate (or decelerate). Values entered are units per second per second, where units 
could be inches or millimeters for linear axes, depending on the machine units, or degrees 
for rotary axes. 

Max Feed Velocity — Maximum speed axes can travel while in feed mode. The value 
entered is in units per minute, where units could be inches or millimeters for linear axes, 
depending on the machine units, or degrees for rotary axes. 

Max Velocity for Direction Change — Maximum feed rate for motions that cause an 
axis to decelerate to zero velocity, such as occurs when turning at a corner. 

NOTE:  These Accel /Decel settings are only used when calculating the Time displayed 
in the Status window. They are unrelated to the Accel / Decel settings in the OptiPath 
window. 

 

Machinable Fixture group: 
OK To Cut Into Fixture — Use this feature to specify when it is acceptable to cut into a 
fixture.  This feature is only active when  Component Type is Fixture. When toggled 
"On" (checked), cutter/fixture collisions are reported as described below: 

Milling and Tapping Cuts 
If  Maximum Milling Depth (described below) is set to 0, cutter/fixture 
collisions are not reported regardless of collision depth. 
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If  Maximum Milling Depth (described below) is set to any value other than 0, 
cutter/fixture collisions are only reported if the collision depth is greater than the 
specified value. 

Turning Cuts 
For turning cuts, cutter/fixture collisions are not reported regardless of collision 
depth. 

When OK To Cut Into Fixture is toggled "Off" (not checked), any cutter/fixture contact 
produces an error. 

Maximum Milling Depth — Use this feature to specify the maximum depth that a mill 
or tap cutter can cut into the fixture. This feature is only available when OK To Cut Into 
Fixture is toggled "On". 

The Maximum Milling Depth feature is only applicable to milling, or tapping cuts. For 
turning cuts, the Maximum Milling Depth setting is ignored. 

NOTES: 
1. The OK To Cut Into Fixture feature is only relevant for valid milling, tapping, 

or turning cuts. For instance, if a milling cutter collides with the fixture while in 
an invalid spindle state, this option will be ignored and the collision will be 
reported as usual. 

2. The behavior described above applies only for the cutter. Holder collisions and 
other machine component collisions are not affected by the check box state. 

3. Both settings are saved in the fixture component. 

 

 

To Modeling window
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Toolchain window 
Location: Project menu > Setup Models > Define: Component Attributes tab 

  

The features on this window are used to define toolchain characteristics. 

  

 
  

Number of Pockets — Use to define the number of tools in the toolchain. The 
VERICUT will automatically create this number of equally spaced tool components 
along the toolchain's perimeter geometry. The toolchain perimeter is defined by the first 
sweep model file attached to the toolchain component. This file is normally not displayed 
except for debugging purposes. Other models may be used to define the associated 
toolchain machine structure. 

 These tool components are named Pocket1, Pocket2, ..., PocketN.  They are created each 
time the machine definition file is loaded, are not saved, and may not be edited. The 
position of Pocket1 is defined by the start point of the first boundary geometry segment 
(line or arc). Pocket1 is also defined as the "select" or "exchange" position. The perimeter 
geometry is scaled about Pocket1 to achieve the pocket-to-pocket spacing entered in the 
GUI.  Normally this adjustment should be small. 

Pocket order — Use to define the direction for pocket numbering. Select Clockwise or 
Counter Clockwise from the pull-down list. 

Pocket-to-pocket time — Defines the time (in seconds) required to move the toolchain 
one position. 
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Tool exchange time — Use to define the time (in seconds) required to move the selected 
tool into the machine's spindle and return the unloaded tool to the toolchain. 

Pocket-to-pocket distance — Defines the distance between adjacent tool centers along 
the toolchain's perimeter. 

Replace tool in its original pocket — Use to specify where the tool being unloaded 
from the spindle is to be placed in the toolchain. When toggled "On", the unloaded tool is 
returned to its original pocket position. Otherwise, the tool being unloaded is placed in 
the pocket emptied by the tool being loaded. 

Display pockets in component tree — Use to specify whether or not the toolchain's 
associated tool components are displayed in the component tree. When toggled "On", tool 
components will be displayed in the component tree. The default is not to display the 
tools components since large toolchains can contain a hundred or more tools.   

Tool-to-tool collision checking — Use to specify collision checking when a tool is 
placed in the toolchain during a tool exchange. When toggled "On", the tool being 
unloaded and returned to the toolchain is checked for collisions with the tools in adjacent 
pocket positions.   

Tool length checking — When toggled "On", tool lengths are checked against the 
Maximum tool length value when they are initially put in the toolchain. If the tool length 
exceeds the Maximum tool length value, an error is output. 

Maximum tool length — Use to specify the maximum tool length value used for Tool 
length checking. 

 

 

See Toolchain Operation, in the Using VERICUT section , in the CGTech Help Library 
for more information. 
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Turret Aid window 
Location: Project menu > Setup Models > Define: Component Attributes tab 

  

The features on this window are used to define turret characteristics. 
 
 

 
 
 
The features in the upper portion of the Turret Aid window enable you to easily create a 
swept solid model of a turret. 

Number of Faces — Use to specify the number of faces on the perimeter of the turret. 

Inscribed Circle Radius — Use to specify the radius of the inscribed circle that will be 
used to determine the size of the turret. 

Zmin — Used to specify the starting location, along the Z-axis, to be used when creating 
a "swept" solid model of the turret. The distance between Zmin and Zmax determine the 
thickness of the turret. 

Zmax — Used to specify ending location along the Z-axis to be used when creating a 
"swept" solid model of the turret.  The distance between Zmin and Zmax determine the 
thickness of the turret. 
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File Name — Use to specify the file name for swept solid model file to be created. Enter 
the \path\filename in the File Name text field, or click on Browse and use the file 
selection window that displays to specify the file. 

Add Sweep Model — Creates a swept solid model using the above information and adds 
it to the Component Tree. 

 

 
 
The features in the lower portion of the Turret Aid window enable you to easily create 
tool components for the turret. 
 

Tool Component Name — Use to specify the base name for tool components to be 
created for the turret.  

Starting Tool Index — Use to specify the starting index number to be used for the tool 
components created. 

Starting Index Origin — The following features are used to describe the position of the 
first tool component on the turret. Think of the Starting Index origin as a polar location. 

R — Use to specify the radial distance from the turret origin that the tool components 
will be placed. 

A degrees— Use to specify the starting location polar angle, at which the first tool 
component is positioned. By default, if the number of faces is even, the starting 
location polar angle defaults to 0. If the number of faces is odd, the polar angle is 
.5(360/number of faces). That puts the default tool location at the center of a face in 
XY. 
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Z — Use to specify the Z location for the tool components. The default Z location is 
.5(Zmax-Zmin). 

Index Direction — Use to specify the direction around the turret that subsequent tool 
components will index from the first position. Choose Clockwise or Counterclockwise. 

Add Tool Component — Creates the tool components and adds them to the Component 
Tree. A tool component will be created for each face on the turret. The tool component 
positions will be rotated around the turret origin by "number of faces"/360, and 
positioned the radial distance (R) away from turret origin and indexed in the specified 
direction from the Starting Index Origin angle (A). Components will be named "tool 
component name"1, "tool component name"2, etc., depending on the Starting Tool Index 
number chosen. 

The turret model and tool components in the following Component tree were created 
using the information in the Turret Aid window shown at the top of this section. 

 

 
 

Close — Close the Tool Aid window. 

 
 
To Component Attributes tab
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Modeling window, Import tab 
Location: Project menu > Setup Models > Define 

Toolbar short cut:   

 

Features on this tab import IGES model files for use as stock, fixture, design, or machine 
component models. The component type determines how the converted IGES model will 
be used in VERICUT. An option is also available to create a solid model from an IGES 
surface. The surface can be used as is, or offset before converting it into a solid. During 
import, VERICUT converts the IGES model data into a VERICUT Polygon file (.ply 
extension) and automatically refers the converted file. This window functions similar to 
the IGES Converter window-ref. File menu > Convert > IGES. 

 

 
 

IGES File — Name of the file containing the IGES data to import. Either enter the 
/path/filename in the IGES File text field, or click on the Browse button and use the file 
selection window that displays to select the file. 
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Tolerance — Specifies the amount of chordal deviation allowed in 3-D space from the 
IGES surface when creating the converted surface. The converted surface is 
approximated using "facets", or triangles. 

 

 
 

Offset Surface group: 
Offset Surface — When active, creates a solid model from an open IGES surface. 

Offset Amount — Distance and direction in which to offset the design surface, as 
applied normal to the input surface. For example: ".100" applies an offset of .100 to the 
surface in the Z+ direction. A value like "-.100" applies the offset in the Z- direction, 
effectively "shrinking" the model. 

Base Location — Specifies the Z value of the plane to become the base of the solid 
model. The surface is projected along the Z-axis to this plane. 

Extend to Rectangle — When active, expands surface edges to create a rectangular base. 
The size of the rectangular base is determined by the X-Y bounding region of the surface 
data. 

Add — Adds the VERICUT polygon model defined to the active component. 

 
 
To Modeling window
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Load Stocks 
Location: Project menu > Setup Models > Load Stocks 

 

After cutting, selecting this option causes VERICUT to load new stock models for Stock 
components having models defined, but a cut stock model does not exist. This capability 
is used when simulating a series of parts being machined through multiple machining 
stages. This type of manufacturing is often referred to as "staged machining". 

  

In general, the following actions take place in staged machining: 

1. Simulate the first stage cutting operation. (Creates a "Cut Stock" workpiece that 
appears as  in the Component Tree window) 

2. Move (e.g. cut and paste) the cut stock to a different Stock component defined to 
represent the next cutting stage. 

3. Select Load Stocks to load a new uncut stock model in the first cutting stage. 

4. Continue cutting-typically cutting the first and second stages, but may cut all 
stages even though workpieces have not yet been placed in subsequent cutting 
stages. 

5. Repeat actions as required to cut a workpiece through all cutting stages required 
to complete the final part configuration. 
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Delete Detached Stock 
 
VERICUT Users: 
VERICUT Location: Project menu > Setup Models > Delete Detached Stock 

Toolbar short cut:  

  

Cutter Grinder Users: 
Cutter Grinder Location:   View Simulation page > Delete or Keep Material 

Notebook Feature:      

  

Opens the Delete Material window enabling you to delete or keep pieces of material. This 
feature is typically used to delete pieces of excess stock that have been cut free from the 
workpiece. However, pieces of other models can also be deleted. 

 

 
 

Items are selected for Delete/Keep in the Workpiece View. Any number of items can be 
selected. Selected items are immediately highlighted with the Error color. Once you click 
Delete (or Keep) the items are removed from all views. However, the selected items are 
not actually deleted until you click OK.  

NOTE:  Once model pieces are deleted, model pieces can not be restored. 

 

Update While Simulating — When toggled "On", VERICUT checks during the 
simulation for detached material based on the stock's relationship to all sibling and parent 
fixture models. If the detached stock does not intersect, or is not tangent to, a parent or 
sibling fixture model, then the piece is considered "unattached" and is automatically 
deleted. This logic applies to both milling and turning operations. 

For turning mode, VERICUT checks at the end of each block. For milling mode, 
VERICUT checks at each tool change, at the end of each file, whenever VERICUT is 
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stopped (except for "single step"), at Clamp/Unclamp events, and whenever the 
CheckForLooseMaterial macro is called. See the example in the next section. 

Tab Removal — Use this feature to remove tabs left on the machined part (used for 
holding the part during the machining process) from a VERICUT cut model. VERICUT 
will project the cutter used to cut the selected machined surface, through the bottom of 
the part, removing the tab area. More than one position on the machined surface may 
need to be selected to remove the entire tab area. 

 

Before Using Tab Removal   After Using Tab Removal 

 

  

  

 

 

OK — Use this feature to permanently delete the items selected for Delete/Keep, or 
activate Update while Simulating and close the Delete Material window. 

Delete — After selecting the items to be deleted (they will be highlighted), click Delete 
to remove selected items from all views. Click OK, described above, to permanently 
delete the items. 

You can also use Delete to delete the un-displayed portion of a sectioned view. Without 
selecting any items, click on Delete. You will be prompted with the message "The cut 
stock is sectioned. Delete the sectioned (invisible) material?" Yes/No". A "Yes" response 
permanently deletes all un-displayed (invisible) sectioned material. A "No" response does 
not. Using the Keep in this manner will produce the same results. 

Keep — After selecting the items to keep (they will be highlighted), click Keep to 
remove all un-selected items (not highlighted) from all views. Click OK, described 
above, to permanently delete the items. 

Unselect — Use this feature any time while selecting items for Delete/Keep to un-select 
all selected items (they will no longer be highlighted). This feature becomes inactive once 
you click on Delete/Keep. 

Cancel — Use to un-select all items, cancel any Delete/Keep action, and close the Delete 
Material window. 
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Delete Detached Stock - Update While Simulating 
Example 
 

Update While Simulating Toggled "Off": 
Notice that when Update While Simulating is toggled "Off", the pieces of excess stock 
that have been cut free from the workpiece remain displayed, as shown in the pictures 
below. 
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Update While Simulating Toggled "On": 
Notice that when Update While Simulating is toggled "On",  most of the pieces of 
excess stock that have been cut free from the workpiece have been automatically deleted, 
as shown in the picture below. The reason that they were not all automatically deleted is 
because of slight differences in the holding fixtures. In setups 2 and 3, the remaining 
excess stock pieces are at least partially in contact with the fixture so they were not 
automatically deleted.  
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Create Model File 
VERICUT Location: Project menu > Setup Models > Create Model File > Revolve / 
Sweep 
  

Opens the Profile Sketcher window enabling you to define a profile to be used to create 
a solid model either by rotating the profile about the Z-axis (Revolve), or by sweeping the 
profile along the Z-axis (Sweep).  

  

Revolve — Click this option to open the Profile Sketcher window in "solid of revolution" 
mode. 

Sweep — Click this option to open the Profile Sketcher window in "sweep solid" mode. 
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Profile Sketcher Features 
Locations:  

Project menu > Setup Models > Create Model File > Revolve 

Project menu > Setup Models > Create Model File > Sweep 
  

Project menu > Setup Models > Define > Model tab: Type=Model File > Sketcher > 
Revolve 

Project menu > Setup Models > Define > Model tab: Type=Model File > Sketcher > 
Sweep 
  

Project menu > Tools > Add(Modify) Cutter 
>Tool Component tab: 

Project menu > Tools > Add(Modify) Insert 
 >Tool Component tab: 

Project menu > Tools > Add(Modify) Holder 
>Tool Component tab: 

 

 

 (Revolve Profile) 

  

Project menu > Tools > Add(Modify) Holder 
>Tool Component tab: 

 (Sweep Profile) 

  

 

The Profile Sketcher provides an easy graphical means of describing a profile of  in 2-D 
drawing space. Profiles are sketched by connecting a series of lines and arc segments. 
You can select points, enter point/arc data into the Profile entity list, or pick then edit 
entity values in the list. You can also import the 2-D geometry from a DXF file. The 
profile displayed in the sketcher window is constantly updated regardless of how you 
supply profile entity data, making it easy to see what you've defined.  
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The Profile Sketcher can be opened in either "Revolve" mode, where an "open" 2D 
profile is rotated about the Z-axis to create a solid model or cutter/holder, 

  

 
  

or in "Sweep" mode, where a "closed" 2-D profile is "swept" a specified distance along 
the Z-axis to create a solid model or a cutter insert/holder. 
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The Profile Sketcher is accessible from Project menu > Setup Models > Create Model 
File > Revolve/Sweep and from Project menu > Setup Models > Define: Model tab to 
create profiles that can be rotated about an axis, or swept along an axis to create solid 
models. It is also accessible in Tool Manager to Add/Modify cutters, inserts and holders.  

The options available in the Profile sketcher will vary slightly depending on whether it 
was accessed from one of the Model menu windows or from Tool Manager. Most of the 
features are common regardless of where the window was accessed from and have 
identical functionality. Those features that are specific to a particular function are located 
at the bottom of the window are described in the Special Features section below.  

 

Common Features 
Entity list — Lists the point/arc entities that define the profile. The list is created by 
graphical selection, or by pressing Add to add entities to the list. Existing data can be 
edited directly in the Entity list.. 

Add / Delete — Adds (or deletes) a single entity to/from the Entity list. Once added, the 
entity type (Point or Arc) can be changed, or data values edited. 

Delete All — Deletes all entities in the Entity list. 

ImportDXF — Opens the DXF Geometry window enabling you import two 
dimensional tool geometry from files which comply with a de facto CAD system 
standard, the Data eXchange Format (DXF) to add (or modify) individual cutter (or 
holder) components in existing tool records. 

 

 
 
DXF File — Enter the /path/filename in the text field, or select Browse and use the 
file selection window that displays, to select the DXF file containing the desired 
profile. 

Import — Use to import the selected profile into the profile sketcher. 

Cancel — Use to close the DXF Geometry window without importing the profile. 
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Fillet Size — Use this text field to specify the size of the fillet to be created. Use with 
Create Fillet described below. 

Create Fillet — Use to create a fillet at the selected point. Use Fillet Size described 
above, to specify the size of the fillet. 

Remove Fillet — Use to remove the selected fillet. 

 

Shortcut: Clicking with the right mouse button in the Sketcher window (Revolve Profile 
or Revolve Sweep) displays the following shortcut menu: 

 
These features provide the same functionality as those described above under Common 
Features. 

 

Sketcher window — Displays the current defined tool profile (blue line), based on the 
entity list. The profile in the window is constantly updated to reflect current list data. The 
following symbols may be seen in the sketcher window: 

 Tool origin — The tool origin is assumed by VERICUT to be the control point, 
or driven point, on the tool. Typically, tool profiles are sketched relative to the tool 
origin to provide proper cutting by the tool. However, the tool origin can be relocated 
at any time via dragging the origin point. Tool origin display is controlled by the 

Origin  feature on the sketcher Toolbar (see below). 

 (blue dot) Entity point — This symbol indicates a point on the profile or an arc 
center point. You can change the profile shape by dragging entity points to different 
locations. The corresponding entity in the list is automatically updated. 

 (green dot) Selected entity point — This symbol indicates the entity selected for 
editing. The corresponding entity in the list is also highlighted for editing. 

  

NOTE:  Selecting a line segment in the Sketcher window selects both end points for 
editing. Drag the line segment to the desired location and both end points are 
automatically updated in the Sketcher window as well as in the Profile Entity List.  
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 (red dot)  Target selection point — This symbol follows the mouse and is the 
target for graphical selection. Values displayed with the Sketcher axes below the 
sketcher window reflect the target selection point location. 

 

Sketcher axes — Axes that depict the coordinate system in which the tool profile is 
being constructed. Values displayed with the axes reflect the target selection point 
location, relative to the tool origin. 

Arc / Pt — Controls the profile entity type being defined via graphical selection. 

Arc Direction — Controls the direction of an Arc being defined via graphical selection. 

Grid Size — When selected, displays a grid in the sketcher window. When a grid is 
displayed, target and selected points snap to the nearest grid line intersection. Grid 
spacing is specified in the data field located right of the GridSize label, and can be 
changed at any time. Clear the checkbox to remove the grid and select or drag points 
anywhere in the 2-D drawing space. 

Sketcher Message area — Located below the sketcher window, this un-editable text 
field displays error and informational messages to assist you with defining tool profiles. 
If actions in the Tool Manager, and/or sketcher, window are not as expected, check the 
VERICUT main window message area for additional relevant messages. 

Sketcher Toolbar — The icons on this Toolbar zoom in/out, fit, and pan the tool profile 
in the sketcher window. See the table below for details. Sketcher icons: 

 

Shortcut: The following keys provide instant access from the keyboard to dynamic 
viewing options (press and hold keys while dragging): Dynamic Zoom — <Ctrl>, 
Dynamic Pan — <Shift>. 

 

Icon: Name: Action: 

 Pan Pan/translate- drag mouse in the direction pan 

 Zoom In Zooms in approximately 20% each time it is clicked 

 Zoom Out Zooms out approximately 20% each time it is  clicked

 Fit Fits the tool in the sketcher window 
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 Origin When selected, displays the tool origin point 

 Undo Select to "undo" the previous action(s). 

 
Special Features 
The following are only available in the Sweep Profile window: 

Zmin / Zmax — Used to specify the starting and ending location along the Z-axis when 
creating a "swept" solid model. 

 

The following features are only available when the Sweep or Revolve Profile window is 
accessed from the Tool Manager. The specific features available will vary depending on 
the tool type (Mill, Turn, or Probe) and the tool component type (Revolved Cutter, Insert 
Cutter, or Holder) and the profile window type (Sweep or Revolve). 

Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 

Do Not Spin with Spindle — Toggle On, or Off, to specify whether or not the tool 
component spins with the spindle. For example, a milling tool holder would spin with the 
spindle, while a turning tool holder would not. 

Flute Length — Used to specify the length of the cutter having flutes, or teeth, that can 
remove material. 

Spindle Direction — Use to specify spindle direction for a specific revolved cutter. 
Choose CW (clockwise) or CCW (counterclockwise). 

Thickness — Used to specify the thickness of the insert or holder (sweep profile only). 

 

NOTE:  For additional information on these Tool Manager features, see the specific tool 
component in the Tool Add/Modify window. 
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DXF Geometry window 
Locations:  Profile Sketcher window > Import DXF 

                   Tool Manager window > File > Import > DXF Tool  

  

Opens the DXF Geometry window enabling you to import two dimensional geometry 
from files which comply with a de facto CAD system standard, the Data eXchange 
Format (DXF).  

The Profile Sketcher window is accessible Project menu > Setup Models > Create 
Model File > Revolve/Sweep and from Project menu > Setup Models > Define: Model 
tab to create profiles that can be rotated about an axis, or swept along an axis to create 
solid models. It is also accessible in Tool Manager to Add/Modify cutters, inserts and 
holders.  

 The options available in the DXF Geometry window will vary slightly depending on 
whether it was accessed from one of the Model menu windows, 

 

 

 
  



VERICUT HELP – Project menu 
 

 or from Tool Manager.  

 

 
  

Many of the features are common regardless of where the window was accessed from and 
have identical functionality, Those features that are specific to either of the Model menu 
windows or Tool Manager windows are noted in the feature descriptions below.  

 

Importing DXF Profile Data: 
DXF File — Use to specify the DXF file containing the tool data. Enter the /path/file 
name in the text field or click on Browse and use the Select DXF File window to specify 
the file. 

Mill / Turn — (Tool Manager only) Select Mill, or Turn to specify, the "type" of tool 
data being imported. 

Inch / Millimeter — (Tool Manager only) Select Inch, or Millimeter, to specify the 
"units" of the tool data being imported. 

Control at tip/ Control at DXF (0,0) — (Tool Manager only) Select Control at tip, or 
Control at DXF (0,0),  to specify the "control point" to be used for the tool data being 
imported. Control at tip puts the control point at the tip of the tool (the point on the 
profile with the lowest Z value is assumed to be the tip of the tool). Control at DXF (0,0) 
puts the control point at the 0,0 point of the profile. 

Component Table — 
After specifying the DXF file, a record is created in the Component Table for each layer 
contained in the file. You can re-order the records in the table by clicking on the button in 
the first column of the record and dragging it to the desired position. 
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DXF Layer — This column displays the name, or number, identifier of the layer. 

Profile — (Create Model File only) This column is used to identify the profile that is to 
be used. 

Cutter — (Tool Manager only) This column is used to identify the "cutter" geometry 
data to be imported. Click on the box in the appropriate layer row to activate it 
(checkmark is visible). 

Holder — (Tool Manager only) This column is used to identify "holder" geometry data 
to be imported. Click on the box in the appropriate layer row(s) to activate it (checkmark 
is visible). 

  

NOTE:  When the DXF Geometry window is accessed from the Tool Manager, only 
layers that have been indicated as "cutter" or "holder" will be imported. If the DXF 
window was accessed using Add > DXF Tool in the Tool Manager, only one "cutter" 
component can be imported, but multiple "holder" components can be imported for each 
tool record.  

  

Import — Imports the geometry data into the appropriate Profile Sketcher window, or in 
the case of Add > DXF Tool in the Tool Manager,  into the appropriate tool record/tool 
component. 

Cancel — Use to close the DXF Tool Geometry window. 

  

 

DXF File Requirements: 
Only the ENTITIES section of a DXF file is scanned by VERICUT. The BLOCKS 
section is ignored, so BLOCK references within the ENTITIES section will not be 
expanded. REPEAT entities are also ignored. The only geometric entity types processed 
are LINE, ARC, CIRCLE, POLYLINE, LWPOLYLINE, TRACE, SOLID, 3DLINE and 
3DFACE . 

 
For Creating Solid Models 
Import "open" 2D profiles to be rotated about the Z-axis to create "revolved" solid 
models. Putting the start and end points of the profile off of the Z-axis will result in a 
solid model that is open in the center like the one shown in the "Revolved Solid Model" 
picture below. To create the model with a solid center, make sure that the start and end 
points of the profile are on the Z-axis. 
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Open Profile 

 

Revolved 
Solid Model 
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Import "closed" 2-D profiles to be "swept" a specified distance along the Z-axis to create 
a solid model or a cutter insert/holder. 

   

Closed 
Profile 

 

Swept Solid 
model 

 

 

For Creating Cutters, Inserts and Holders 
VERICUT expects only one tool per DXF file. Each component (cutter or holder) of the 
tool should be on its own named or numbered layer. There can be no more than one cutter 
component, but multiple holder components are permitted. The DXF file may contain 
other layers which are unrelated to the definition of the tool's geometry. Within each 
component layer, LINEs, ARCs, CIRCLEs, POLYLINEs, LWPOLYLINEs, TRACEs, 
SOLIDs, 3DLINEs and 3DFACEs can be used to define the profile of the tool.  

For a milling tool, the Y coordinate of the DXF data corresponds to the tool's axis of 
rotation, known as the Z axis in VERICUT's Tool Manager. The X coordinate of the 
DXF data corresponds to the Tool Manager's X axis. An exception to this is a DXF file 
recognized by its use of layer names as being generated by TDM Systems', Tool Data 



VERICUT HELP – Project menu 
 

Management (TDM) system. In such a file, the X-axis is the tool's axis of rotation, with 
the tool tip on the right, and the Y coordinate is the radial distance from the rotation axis. 

 

DXF Data 

 

  

DXF Data from TDM  

 

In VERICUT 
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For a turning tool, the X coordinate of the DXF data corresponds to the lathe's axis of 
rotation, known as the Z axis in VERICUT's Tool Manager. The Y coordinate of the 
DXF data corresponds to the Tool Manager's X axis. 

  

In VERICUT 

 

 

DXF Data 
  

 
  

 

Cutter on Layer 1 

Holder on Layer2 
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NC Programs (NC Program window) 
 
VERICUT Users: 
VERICUT Location: Project menu > NC Programs 

Toolbar short cut:   

  

Mold and Die Users: 
Mold and Die Location:   Setup page > Select Tool Path Files and Tools 

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Setup page > Select Grinding Programs 

Notebook Feature:      

  

Opens a window to specify the NC program file(s) to simulate, and controls how 
VERICUT receives descriptions of cutting tools. In general, VERICUT can obtain 
descriptions of cutting tools by processing parametric cutter description records found in 
the NC program file, or can be configured to retrieve them from a VERICUT Tool 
Library file. 
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NC Program Type — Type of NC program file for VERICUT to simulate. By default, 
VERICUT simulates G-Code or "machine code data" NC programs destined for a 3-axis 
mill machine with a "Fanuc-like" control. Using this option, you can quickly configure 
VERICUT to simulate NC programs from all popular CAM systems. Options: 

G-Code Data — G-Code NC program file. With this choice, VERICUT uses a 
Machine file, Control file, and G-Code settings (ref. Project menu > Processing 
Options > G-Code > Settings) to interpret codes present in the file. 

VERICUT APT — Generic ASCII APT NC program file from virtually any source, 
including ACL format. 

NX CLS — NX CLS NC program file. 

CATIA APT — CATIA APT source NC program file. This file must be processed 
from CATIA using the CATUTIL function and typically has a ".APTSOURCE" 
extension. 

CV APT — ComputerVision APT NC program file. 

CADRA APT — CADRA APT NC program file. 

APT (RevPost) — ASCII APT NC program file created from reverse post-
processing G-Code data Refer to "Reverse post-process G-Codes to APT" in the 
Configuring For Toolpath Simulation section of Using VERICUT for more 
information. Using VERICUT can be found in the CGTech Help Library. 

Pro/MFG APT — Pro/Manufacturing APT NC program file. 

NCL APT — NCL APT NC program file. 

Siemens VNC 840D — Displays the VNCK Control and Main Toolpath window. 

See 840D Virtual NC Kernel and Interface (VNCK) in the Converters and 
CAD/CAM Interfaces section of the CGTech Help Library. 

 

In addition to the NC program types above, VERICUT's converters enable you to 
simulate NC programs from various CAM systems. See the following sections for more 
information: 

• File menu > Convert > Binary CL.  See the "Binary Converter" topic in the 
Converters and CAD/Cam Interfaces section. Converters and CAD/Cam 
Interfaces can be found in the CGTech Help Library. 

• "Reverse post-process G-Codes to APT" in the Configuring For Toolpath 
Simulation section of Using VERICUT for more information. Using VERICUT 
can be found in the CGTech Help Library. 
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Tool Change By — Controls how VERICUT receives descriptions of cutting tools. 

Cutter Desc. — Process parametric cutter descriptions in the NC program file. 
Examples: CUTTER and VERICUT-TC comment records. 

VERICUT TC — Process by PPRINT/VERICUT-TC cutter statements in the 
toolpath file. 

Tool Number — Process NC program records that reference tool or pocket numbers 
and retrieve associated tools from a Tool Library file. Examples: TnM6 (G-Code NC 
programs), LOADTL or LOAD TOOL, and TURRET. When using Tool Change by 
Tool Number, The tool number is matched with the pocket number (ex: tool #5 in 
pocket #5). 

List — Refer to a list of tool change event-to-tool ID references that retrieve 
associated tools from a Tool Library file. The list is accessed via the Use Tool List 
feature, as described later in this section. 

File Name — Use a tool from a Tool Library file as specified for each NC program 
file in the list. 

Tool Name — This option is only applicable when NC Program Type is set to NX 
CLS. Tool Name refers to the tool identifier in the TOOL PATH/ statement in the 
NX CLS file. 

Use Selected Files — When used in conjunction with the Use checkboxes in the 
Toolpath list, enabling you to select only specific toolpath files from the list for 
VERICUT processing. If this option is not checked on, all toolpaths in the list will be 
processed in the order that they appear in the list. 

Initial Tool — When active, VERICUT loads an initial tool from a Tool Library file. 
This action occurs automatically when the Project file is loaded, the NC program is 
rewound, or the model is reset. Choose the ID of desired tool using the option list next to 
this feature. This feature is useful when simulating NC programs for machines that have a 
tool loaded at the time tool processing is started, therefore do not have information about 
the first tool. 

You can also use this feature to preload multiple tools in a milling machine (e.g. tool 
change carousel), via selecting Initial Tool, but leaving the corresponding field blank.  If 
you specify a tool number, then that tool is forced in to all tool component positions. 

NOTES:  
1. This feature should not be used if you are using multiple toolpaths. 

2. This action also occurs when a "Turret" type component is present, such as 
commonly used with turret lathe setups. 

Tool Override — When active, overrides the current cutter description with a specified 
tool from a Tool Library file. This action occurs immediately. Choose the ID of desired 
tool using the option list next to this feature. VERICUT uses the override tool until you 
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select a different tool ID or clear the Tool Override checkbox. When cleared, the tool 
that would have been in use becomes the active tool. 

NC Progam list — Also known as the "toolpath list", displays all of the NC program 
files available in the project file. The NC Program list consists of some, or all, of the 
following columns of information depending on the way that the NC Program Type and 
Tool Change By options are set. 

Shortcut:  Right-click in the NC Program List to display the following menu: 
 

 
 

NOTES: 
1. The Add, Replace and Delete options are the same as the buttons described 

below. 

2. Copy / Paste enable you to copy the highlighted NC program and paste it at 
the end of NC Program List. 

3. The Origin option is the same as the NC Program Origin option described 
below. The Origin pull-down list will contain all available coordinate systems.  

4. The Edit option displays the NC Program Editor window with the 
highlighted NC program ready for editing. (ref. NC Program (edit) also in 
the VERICUT Help section, for additional information. 

5. If Use Selected Files  is toggled "On", Unselect All appears in the menu to 
enable you to uncheck all boxes in the Use column with a single pick. 

List Order buttons — NC programs are processed by VERICUT in listed order. List 
order is changed via left-dragging the List Order button in the first column of each 
toolpath entry in the list. Only NC programs that have not been simulated by VERICUT 
can be reordered.  Reset the model to reorder NC programs that have been already been 
simulated. 

Use — This column is only displayed when the Use Selected Files option, described 
above, is toggled "On". Use the checkboxes in this column to select certain files in the 
toolpath list for VERICUT processing. By default all toolpaths are selected (checked) for 
processing. 

NC Program — displays the path and file name of each toolpath currently available for 
VERICUT processing.  
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Tip: Double clicking on the NC program file name displays the NC Program Editor 
window with the NC program file ready for editing. 

 

NC Program Origin — Use to specify the coordinate system that corresponds to each 
toolpath. Change the CSYS by clicking on current value in the Toolpath Origin column 
then select the desired CSYS from the pull-down list of available coordinate systems. The 
option None makes the toolpath origin relative to the Workpiece Origin for CL Data, and 
relative to the Machine Origin for G-Code data. 

To change multiple Toolpath Origins at the same time, select the desired toolpaths using 
one of the following methods: 

Select multiple files in sequence — Click first file name in the sequence, then press 
and hold the <Shift> key while clicking the last file name. You can also click on the 
first file name in the sequence, while still holding down the mouse button, drag the 
cursor to the last file name in the sequence. 

Select additional files — Press and hold the <Control> key while selecting each 
additional file. 

With either method, selecting a file name a second time while holding down the 
<Control> key unselects the file. 

Then right-click in the list area and select Origin from the shortcut menu. Select the 
desired CSYS from the pull-down list to update the NC program Origin for all 
highlighted NC programs. 

Curve Fit — This column is only visible when Toolpath Type is set to G-Code Data. 
Use the check boxes in this column to select specific toolpaths for Curve Fitting. When 
you check one or more toolpaths for Curve Fit processing, the Curve Fit button, 
described below, becomes active enabling you to access the NC Program Curve Fitting 
Control window to set curve fit parameters and start the curve fit process. 

Tool ID — This column is only visible when Tool Change By is set to File Name. It 
specifies the ID of a tool from the current Tool Library file to use with each NC program 
file.  

Add — Opens a file selection window enabling you to add one or more NC program files 
to the list.  

Replace — Displays a file selection window enabling you to select a toolpath file to 
replace the selected (highlighted) toolpath file in the list. If there is only one toolpath in 
the list, you do not need to select (highlight) it. Just click on Replace to display the file 
selection window and pick the replacement file. VERICUT will replace the existing NC 
program file with the new one. You can also double click on an NC program file name in 
the list to display the "file selection box". To select multiple NC program files for 
replacement, use any combination of the techniques below. 



VERICUT HELP – Project menu 
 

Select multiple files in sequence — Click first file name in the sequence, then press 
and hold the <Shift> key while clicking the last file name-all files in between those 
selected are also selected. 

Select additional files — Press and hold the <Control> key while selecting each 
additional file. Selecting twice de-selects the file. 

Delete — Deletes the selected NC program file from the list. To select multiple NC 
program files for deletion, use any combination of the techniques described above under 
Replace. 

Clear — Clears the list of all NC program files. 

Curve Fit — Displays the NC Program Curve Fitting Control window that enables 
you to set parameters for use during curve fitting. See the NC Program Curve Fitting 
Control window topic, also in this section. 

Use Tool List — When Tool Change By=List, this feature opens a window to create 
and maintain a list of references that link tool change events to tools stored in a Tool 
Library file. You can use this list to supply tools from the library for sequential tool 
changes, or to replace tools specified for use in the NC program file. See the Tool 
Change List window topic, also in this section. 
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NC Program Curve Fitting Control window 
 

The curve fitting option is targeted at 3-axis G-Code NC programs containing long 
sequences of relatively short cutting motions. VERICUT detects sequences of planar 
motion and fits arcs (or NURBS) whenever the motion can conform to a specified 
tolerance. Arcs are only replaced along the machine's major axes (XY, YZ and XZ).  The 
resulting NC program files may be smaller, produce an improved surface finish, and 
process faster in VERICUT than the original NC program file. 

Curve fitting makes a single pass through the G-Code NC program(s) and writes new NC 
program file(s) containing the modified motions. The original NC program files are not 
changed. Curve fitting may be selectively applied to NC programs by checking the curve 
fit box in the NC Program list. 

 The "Curve Fit" button brings up the NC Program Curve Fitting Control window 
enabling parameters to be set and the curve fitting process to be executed. 
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Arc Fitting — Select this feature to fit arcs during Curve Fit processing. Selecting this 
feature also activates the Arc Fit Parameters described below. 

 NURBS Fitting — Select this feature to fit NURBS during Curve Fit processing. 
Selecting this feature also activates the NURBS Fit Parameters described below. 
NURBS Curve Fitting is supported for the Fanuc G6.2 (Generic control), the Siemens 
(BSPLINE format), and the Toshiba G6 machine controls. 

 Output NC Program — Specifies the name of the new G-Code NC program file 
containing the results of the curve fitting process. The Output NC Program file name 
must be different from that of the original NC program file name. Curve Fitting will not 
permit the original NC program file to be overwritten. When curve fitting multiple NC 
program files, a modified NC program file is output for each NC program file processed. 
Each output file has an ascending sequence number appended to the end of the base file 
name. For example: assume Output NC Program ="path.mcd" is entered (without the 
quotes). Curve Fit processing of 2 NC programs outputs the following files: 

 

path001.mcd => modified NC program from NC program 1 

path002.mcd => modified NC program from NC program 2 

 

If a dot "." is the last character of the output NC program file name, then three digits are 
appended to the file name as the extension. Continuing with the above example: assume 
Output NC Program ="path." is entered. Curve Fit processing of the same 2 NC programs 
outputs the following files: 

 

part.001 => modified NC program from NC program 1 

part.002 => modified NC program from NC program 2 

 

If an asterisk "*" is used in the output NC program file name, the original NC program 
file name is used as the output file name in place of the asterisk. If characters follow the 
asterisk, the input NC program file name extension is replaced with the characters 
following the asterisk.  
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Examples follow: 

Original NC program file: Output NC Program file 
name: 

Output file name: 

dir1/filename.mcd dir2/* dir2/filename.mcd 

dir1/filename.mcd dir2/*.filter dir2/filename.filter 

dir1/filename.mcd dir2/*cf dir2/filenamecf 

dir1/filename.mcd dir2/*cf.mcd dir2/filenamecf.mcd 

 filename.mcd *.cf filename.cf 

  

Only a single asterisk is acted on in the optimized NC program file name, with one 
exception: asterisk dot asterisk ("*.*"). This case behaves exactly like the single asterisk 
file name described above. This is NOT a regular expression replacement, therefore any 
characters before the asterisk are ignored and lost. When there is more than one asterisk, 
only the first one is replaced 

 

Examples follow: 

Original NC program file: Optimized NC Program 
file name: 

Output file name: 

dir1/filename.mcd dir2/*.* dir2/filename.mcd 

dir1/filename.mcd dir2/cf* dir2/filename.mcd 

dir1/filename.mcd dir2/cf*.ext dir2/filename.ext 

dir1/filename.mcd dir2/*cf.* dir2/filenamecf.* 

  

Arc Plane Selection — Check boxes for major planes where arc fitting is requested. 
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Arc Fit Parameters: 
The following options are only active when Arc Fitting has been selected above. 

Fit Tolerance — Maximum deviation allowed for the fitted arc from the NC program 
points being fitted.  All points replaced by a circular motion must be within this distance 
from the arc. In addition, the midpoint of all motion segments being replaced must be 
within this distance from the arc.  

Planar Tolerance — Maximum deviation from the plane formed by the motions being 
tested. Points within this tolerance are adjusted to the plane defined by the sequence.  

Minimum number of arc points — Lower limit on the number of points required to 
define an arc. 

Smallest Arc Radius — Lower limit on radius of arcs created.  Smaller arcs will remain 
a sequence of points.  

Largest Arc Radius — Upper limit on radius of arcs created.  Larger arcs will remain a 
sequence of points.  

  

NURBS Fit Parameters: 
The following options are only active when NURBS Fitting has been selected above. 

NURBS Tolerance — Maximum amount that the NURBS interpolated curve can deviate 
from the from the linear cut segments being replaced. 

Minimum number of NURBS points — Minimum number of linear cut segments 
required before a NURBS curve fit is attempted. 

NURBS Order (3or4) — Use to specify the "order of the NURBS. Select 3 or 4 
depending on what "order of NURBS" is supported by the machine controller. 

 Accel/Decel — This feature applies Accel/Decel settings from the NC machine 
configuration to adjust optimized feed rates. VERICUT looks ahead in the NC program 
file and slows the machine prior to direction changes, as well as changes feed rates based 
on the machine axes ability to accelerate and decelerate. For more information on the 
individual options, see Accel/Decel options on the OptiPath window. 

 Remove Colinear Points — When toggled "On", this feature eliminates colinear points 
during Curve Fit processing. 

 G-Code Output Options — Displays the General and OptiPath & Curve Fit tabs of 
the Control Settings window. 
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NOTES:  
1. If you happen leave the 12 tab Configuration menu > Control Settings window 

open and it gets hidden behind other windows then use  G-Code Output Options 
 you may see all 12 tabs instead of  just 2 tabs. This is because it is the same 
window, displayed differently depending on where it is called from. 

2. When you use F1 Help on the 2 tab G-Code Output Options window, the 
documentation for the 12 tab Configuration menu > Control Settings window 
will display. The information for the General and OptiPath & Curve fit tabs is the 
same for both cases. 

  

OK — Updates the settings saved with the job and dismisses the NC Program Curve 
Fitting Control window. 

Process — Updates the parameters and processes the files selected for curve fitting. 
Processing multiple NC programs may require running the Curve Fit process more than 
once if the NC programs require different Curve Fit tolerances. For example, one pass 
might be used for roughing NC programs and use a larger tolerance. A second pass would 
then be used for finish NC programs using a smaller tolerance.  

NOTE:  When using Curve Fit, you must take into account the tolerances used by the 
CAM system to create the original NC program(s). Using large Curve Fit tolerances may 
cause the tool to deviate an unacceptable amount from the intended surface. 

Upon completion of processing, the curve fit results are displayed in the following 
message: 

Number of arcs created = xxx  

Number of moves replaced = yyy 

Blocks read = nnn   

Blocks output = zzz 

Do you wish to use the new file(s) as the active NC program file(s)? 

A "Yes" answer will replace the list of NC programs for the current job with the modified 
NC program files produced by Curve Fit. A "No" answer will not replace the NC 
programs in the list. 

 Cancel — Dismisses the NC program Curve Fitting Control window without executing 
Curve Fitting or saving Curve Fit parameters. 

  

Curve Fitting with a Tool List 
When Tool Change By is set to List, the Use Tool List button is becomes active. The 
Tool Change List window will contain a Curve Fit column of check boxes. One or more 
of these boxes must be checked for the appropriate curve fitting to be processed. If the 
Curve Fit column is hidden, adjust the width of the visible columns. 
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Arc Quadrant Output 
Some machines require that circular blocks do not cross quadrant boundaries. To output 
this type of circular blocks, the macro CircleCurveFitQuadrants should be used as a 
Start of Processing Event macro. The default allows blocks to cross quadrant boundaries. 
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Tool Change List window 
 

Opened via pressing Use Tool List on the Project menu > NC Programs window, the 
features on this window maintain a list of references that link tool change events to tools 
stored in a Tool Library file. You can use this list to specify tools to use with sequential 
tool changes, or to replace tools specified for use in the tool path file. 

  

 
  

List Tool Change By — Specifies the tool change event used to build the tool list from. 
Select an option, and then press Build Tool List to have VERICUT automatically create 
the tool change event list. Options are: 

Cutter Desc. — Changes tools when parametric cutter description records in the tool 
path file are encountered, for example: CUTTER and VERICUT-TC comment 
records. 

VERICUT TC — Changes tools when VERICUT-TC statements in the toolpath file 
are encountered. 

Pocket Num. — Changes tools when tool path records that reference tool or pocket 
numbers are encountered, for example: TnM6 (G-Code tool paths), LOADTL or 
LOAD TOOL, and TURRET. 

Prog. Stop — Changes when "program stop" codes are encountered, for example: 
M0 (G-Code tool paths) and STOP. 

Pocket Num per File — Similar to Pocket Num., except creates additional entries in 
the list for duplicate tool numbers that appear in different tool path files. 
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Tool Change Event/Tool ID list — List of tool change events expected to occur during 
the simulation as indicated by the active List Tool Change By option (see above), and 
IDs of the tools to use for each. Event text must match the tool change record text exactly 
as it appears in the NC program file. Type or left-click and choose the tool ID from an 
option list. Right-click to add and delete tool list entries. For the Cutter Desc. and Prog. 
Stop options, the list represents the sequential order of tool changes found in the tool path 
file(s), and tools to use for each. A Pocket Num. list is a cross-reference index between 
tool or pocket numbers referenced in the tool path file(s) to tool IDs in a VERICUT Tool 
Library. A Pocket Num per File list is similar to Pocket Num., except creates additional 
entries in the list for duplicate tool numbers that appear in different tool path files. 

  

The Tool Change List consists of the following columns of information. 

  

Event — displays the tool change event. 

Cutter ID — the ID of the tool. 

Holder ID — the ID of the holder associated with the tool. 

Optipath Settings — the OptiPath settings associated with the tool. 

File # — the file in the Toolpath List that the tool is associated with. 

Curve Fit — this column is only visible when Toolpath Type in the Toolpath 
window is set to G-Code Data and one or more of the NC programs in the NC 
Programs list has Curve Fit toggled on. 

Initial Pocket — this column is related to the use of tool chains. It enables you to 
specify the pocket that the tool will be initially located. 

 

When using Tool Change by List, the default initial pocket numbers are assigned as 
follows. The first called tool is assigned to pocket 1, regardless of the tool number. The 
second called tool is assigned to pocket 2, and so on. You can then change the pocket 
number for each tool as necessary. When you do a Reset, the tool will display in the 
assigned pocket. This feature is useful when using large tools that could interfere with 
each other if located in adjacent pockets. Change the pocket location to ensure that all the 
tool changes are collision-free. Another use would be to optimize the tool change time for 
very short operations by minimizing the tool selection time. 

  

Add — Adds a new tool change event to the tool change event list. Event data can be 
entered, or in the case of tool component IDs and OptiPath settings-can be selected from 
option lists. 

Delete — Deletes the selected tool change event from the tool change event list. 

Clear — Clears all tool change events from the list. 
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NOTE:  Always reset VERICUT (press  (Reset Model) on the VERICUT main 
window) after making changes. 

  

Prompt for OptiPath Settings while building the tool list — When active, causes 
VERICUT to prompt for OptiPath settings during interactive tool path optimization. At 
each tool change event an Optimization Settings window opens. Configure this window 
as desired to optimize the cutting sequence, or choose "Do not optimize this tool". An 
OptiPath Library file is created as you go containing the optimization settings defined for 
each optimized tool. 

For more information about optimizing tool paths, see "About optimizing tool paths" in 
the Using VERICUT section. Using VERICUT can be found in the CGTech Help Library. 

Skip Duplicate Cutter Descriptions — When active, causes VERICUT to skip 
duplicate cutter descriptions when building the tool change event list. This feature is 
useful for suppressing redundant tool changes often output by CAM systems for different 
cutting operations by the same cutter. 

Build Tool List — Builds a tool list by scanning the files in the tool path list and looking 
for the tool change events specified by the List Tool Change By feature (see above). 
When multiple tool path files are listed, a comprehensive tool change events list is 
created with all tool change activity from all listed tool paths. Sample output is shown in 
the following image. 
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Tools (Tool Manager window) 
 
VERICUT Users: 
VERICUT Location: Project menu > Tools 

Toolbar shortcut to access the Tool Manager:   

  
Mold and Die Users: 
Mold and Die Location:   Setup page > Work Directory 

Notebook Feature:      

  
Cutter Grinder Users: 
Cutter Grinder Location:   Setup page > Create Wheels 

Notebook Feature:      

 

Opens a window to create and maintain VERICUT Tool Library files containing 
descriptions of cutting tools, or tool assemblies. Library tools are used by VERICUT 
when the Project menu > NC Program function is configured to do so.  
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In general, double-click on a tool component to modify, or key in supporting values into 
the associated data fields. Right-click to access shortcut menus for defining and 
modifying tools. Tools can be defined interactively in VERICUT, or outside of 
VERICUT by running the Tool Manager "toolman" command file. 

The Tool Manager main window is composed of 4 distinct areas (Menu Bar, Tool Table, 
Tool Display, and Message area), each with different user interaction. Each of these areas 
is discussed in detail in the topics that follow. 

The window header displays the current tool library file. This window can be resized like 
most other window, via dragging the window header, sides or corners. These areas are 
discussed in detail in the following topics. 

Tips: 
1. Right-click shortcut menus: Features used to manipulate tools, or tool 

assemblies, are displayed in a shortcut menu when the right mouse button is 
clicked in the Tool Table portion of Tool Manager window. 

Features used to manipulate the tool graphics are displayed in a shortcut menu 
when the right mouse button is clicked in the Tool Display area of Tool Manager 
window. 

2. You can move objects in the Tool Manager window via dragging them from one 
parent tool to another, or copy them via holding down the <Ctrl> key and 
dragging. 

 
 
Also see "Describing Cutting Tools", in the Using VERICUT section, in the CGTech 
Help Library.
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Tool Manager window, Menu Bar 
 

The menu bar, located across the top of the Tool Manager window, provides easy access 
to Tool Manager functions. Each menu item contains groups of related functions. Left-
click on any menu name to display the list of functions available for that menu item. If an 
arrow appears to the right of a function in a menu, move the mouse over the arrow to 
display a sub-menu of additional functions. Click on the function, in the menu, that you 
want to use. An expanded function list, for the Add menu is shown below. 

  

 
  

File menu 
Features in this menu are used to create new, open, or save tool libraries, generate Tool 
Manager Report files, and close the Tool Manager window. 

 

New — Use to create a new Tool Library file. 

Open — Use to open an existing Tool Library file. 

Merge — Opens the Merge Tool Library window enabling you to merge two tool 
libraries into one. 

Save — Use to save the current Tool Library file. 

Save As — Use to save the current Tool Library file with a new name/location. 

Save Selected Tool — Use to save the selected tool to a specified tool library file. 
Selecting Save Selected Tool displays a file selection window enabling you to specify a 
/path/filename for the tool library file.  

Import —  
OptiPath Library — Opens the Open OptiPath library file window, enabling you 
to import an existing OptiPath Library file.  
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DXF Tool — Opens the DXF Tool Geometry window enabling you to import two 
dimensional tool geometry from files which comply with a de facto CAD system 
standard, the Data eXchange Format (DXF).  

Export Selected Tool — Use to export highlighted tool in the specified format (STL or 
VRML). Displays a file selection window enabling you to specify a /path/filename for 
the file. 

Create from APT NC Program — Causes the Tool Manager to scan the tool path files 
for cutter statements (including CUTTER, PPRINT-VERICUT TC, etc), and create a tool 
library file named <user filename>.tls. The APT tool path tools replace the current tool 
library contents. Tools are numbered sequentially, beginning at 1. 

Create Report — Use to create and view a tool manager report. 

Choose one of the following report formats: 

Text — Create an inspection sequence report in text format. 

HTML — Create an inspection sequence report in HTML format. 

PDF — Create an inspection sequence report in PDF format. 

See Introduction to VERICUT Reports , in the Getting started section of VERICUT 
Help for information on report template files supplied with VERICUT. 

See Create a Report Using a Template, in the Using VERICUT section, in the CGTech 
Help Library for additional information. 

Report Template — Displays the Report Template window enabling you to select 
and/or modify an existing tool manager report template or create a new one. 

User-Defined Tag Values — Opens the User-Defined Tag Values window enabling you 
to assign/edit user-defined tag values used by the current tool manager report template. 

Close — Closes the Tool Manager window. 

  

Edit menu 
Features in this menu are used to edit tools in the library and their cutter/holder 
components. (Functions are also available via right-clicking on a tool component.) 

 

Turret Setup — Opens the Turret Setup window to enable you to load or change tools, 
or change tool positions in a turret. 

Modify — Opens the Tool Add/Modify window enabling you to modify the selected 
tool component (cutter, insert, probe tip, holder). The features displayed on the window 
will vary depending on the selected tool component. This option is not available when a 
tool is highlighted.  

Rename — Enables you to rename the highlighted tool/tool component. 

Delete — Deletes the selected tool/tool component. 
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Cut / Copy / Paste — Enables you to cut, copy or paste the selected tool/tool component 
within the same tool library file. 

Search Tool — Displays the Search Tool window. 

Search OptiPath — Displays the Search OptiPath Record window. 

Stack — Use to automatically stack tool components on top of each other. 

Automatic Gage Offset (Z) — When toggled "On" (checkmark is visible), VERICUT 
calculates the highest point on the Z-axis of the tool and uses it for the Gage Point 
whenever a tool component is modified. This feature only applies to milling tools. The 
state (On or Off) of Automatic Gage Offset (Z) is stored in the VERICUT Preferences 
file. 

 

 

View menu 
Features in this menu provide control over viewing tools in the display area, such as: 
view orientation, lighting, and symbols used to indicate driven point, gage point, etc. 

 

Orient — Opens the View Orient window enabling you to orient the view of a tool. 
Features include: rotate, zoom, pan, reverse, etc. 

Attributes — Opens the View Attributes window, enabling you to display/not display 
Driven Point, Gage Point, and Axes symbols, as well as define a light source direction 
vector for the Tool Display graphics window. 

Expand All — Expands all tools in the ID list displaying the tool components associated 
with each tool. 

Hide Tool Components — Closes all tools in the ID list displaying only the tools in the 
list but none of the tool components.  

Allocate Width to Columns — Adjusts the column with so that all of the columns are 
visible. 

In the following picture the Comments column and most of the Teeth column are hidden 
behind the Tool Display area. 
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Selecting Allocate Width to Columns causes VERICUT to adjust column width so that 
at least some of each column is visible in the Tool Table area as shown in the next 
picture.  

 
 

Now that all columns are visible, you can easily adjust the size of the Tool Manager 
window, and column widths, as needed. 

 
 
Add menu 
The features in this menu are used to add a new tool, or to add cutter, insert or holder tool 
components to the selected tool. The features available will vary depending on what is 
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selected in the Tool table. These features are also available via right-clicking on a tool 
and selecting from the shortcut menu.  

 

Milling Tool Wizard — Displays the Milling Tool Wizard window to assist you in 
defining Milling tools. 

Tool — 
New — Adds a new tool to the library. Select the tool type (Mill, Turn, Probe, Tap, 
or Water Jet), then key in a unique ID to start the new tool definition. 

Select Existing — Displays the Search Tool window. 

Tool Component — Displays the Tool Add/Modify window enabling you to add tool 
components to the highlighted tool. 

 

OptiPath — 
New — Displays the OptiPath window enabling you to define a new OptiPath 
record for the highlighted tool. 

Select Existing — Displays the Search OptiPath Record window. 

Driven Point — Use to add one or more a Driven Point records to the highlighted tool. 

Cutter Compensation — Use to add one or more cutter compensation records to the 
highlighted tool. 
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Merge Tool Library window 
 
Accessed from the Tool Manager: File menu, the features in the Merge Tool Library 
window enable you to quickly and easily merge two tool library files. 
 
 

 
 
 

Master Tool Library — Enter the /path/filename, of the master tool library file, in the 
Master Tool Library text field or use the Browse button to display a file selection 
window and use it to select the master tool library file. 

Update Tool Library — Enter the /path/filename, of the tool library file that will be 
merged into the master tool library file, in the Update Tool Library text field, or use the 
Browse button to display a file selection window and use it to select the update tool 
library file. 

For Duplicated IDs — Use to select one of the options to specify how duplicate tool IDs 
are to be handled during the merge operation. 

Discard All — When toggled "On", duplicate tool IDs in the Update Tool Library 
will be discarded. 

Overwrite All — When toggled "On", duplicate tool IDs in the Master Tool Library 
will be overwritten by the ones in the Update Tool Library. 

Prompt — When toggled "On", a window will display when a duplicate tool ID is 
encountered, enabling you to specify whether to Discard  the duplicate tool ID in the 
Update Tool Library, or Overwrite duplicate tool ID in the Master Tool Library, or 
to Quit the merge operation.   

Merged Tool Library — Enter the /path/filename, for the merged tool library file, in the 
Merged Tool Library text field, or use the Browse button to display a file selection 
window and use it to select the merged tool library file. 



VERICUT HELP – Project menu 
 

 

OK — Starts the merge operation and closes the Merge Tool Library window. 

Apply — Starts the merge operation and leaves the Merge Tool Library window open 
for additional merges. 

Cancel — Closes the Merge Tool Library window without doing the merge operation. 

 



VERICUT HELP – Project menu 
 

 

Milling Tool Wizard 
 

Accessed from the Tool Manager: Add menu, the features in the Milling Tool Wizard 
enables you to quickly and easily define tool assemblies for your tool library. 

  

 
  

ID (tool) — Use to key in a unique ID for the new milling tool. 

Description — Use to add a description for the milling tool / tool assembly. 

Append cutter shape to description — When toggled "on", adds the cutter shape 
description for the cutter defined below to the above description. 
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ID (holder) — Use the text field to enter an ID for the "holder" component. 

Holder Type 
None — Use to specify no "holder" component in the tool assembly.    

New — Displays a window enabling you to add an "extension" component to the tool 
assembly. See Tool Add/Modify window: Component tab, in Holder mode for 
details. 

Search Holder — Displays the Search Tool window enabling you to search for 
existing holders. 

Tip:  You can also use the CGTECH_REF_HOLDER_LIB environment variable to 
specify a reference Tool Library file. All holders in the file will be listed in the pull-
down list. See Environment Variables in the Getting Started with VERICUT section 
of VERICUT Help. 

 

ID (extension) — Use the text field to enter an ID for the "extension" component. 

Extension Type 
None — Use to specify no "extension" component in the tool assembly.   

New — Displays a window enabling you to add an "extension" component to the tool 
assembly. See Tool Add/Modify window: Component tab, in Holder mode for 
details. 

Search Holder — Displays the Search Tool window enabling you to search for 
existing extensions/holders.  

Tip:  You can also use the CGTECH_REF_EXTENSION_LIB environment variable 
to specify a reference Tool Library file. All extensions in the file will be listed in the 
pull-down list. See Environment Variables in the Getting Started with VERICUT 
section of VERICUT Help. 

 

ID (cutter) — Use the text field to enter an ID for the cutter component.  

Cutter Type 

None — Use to specify "no" cutter component in the tool assembly. 

New Revolved Cutter — Displays a window enabling you to add a revolved cutter 
component to the tool assembly. See Tool Add/Modify window: Component tab, in 
Revolved Cutter mode for details. 

New Insert — Displays the Milling Insert window enabling you to describe inserts 
and a cutter body to be added to the tool assembly.  

Search Revolved Cutter — Displays the Search Tool window enabling you to 
search for existing revolved cutters. 

Search Insert — Displays the Search Tool window enabling you to search for 
existing mill insert cutters. 
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Tip:  You can also use the CGTECH_REF_CUTTER_LIB environment variable to 
specify a reference Tool Library file. All holders in the file will be listed in the pull-
down list. See Environment Variables in the Getting Started with VERICUT section 
of VERICUT Help. 

L2 — Use the text field to enter the exposed length of the "extension" component. This 
distance is used to position the "holder" component along the tool's Z-axis. 

L1 — Use the text field to enter the exposed length of the "cutter" component. This 
distance is used to position the "extension/holder" component along the tool's Z-axis. 

Gage Point — Use the text field to enter the XYZ coordinates of the gage point. If only 
one value is entered, it will be applied to Z. 

Driven Point — Use the text field to enter the XYZ coordinates of the cutter's driven  
point. If only one value is entered, it will be applied to Z. 

Stack — When toggled "on", automatically stacks tool components on top of each other. 

 

New — Creates the new tool record and leaves the Milling Tool Wizard window open 
to create the next milling tool. 

Close — Use to close the Milling Tool Wizard window. 
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Milling Insert window 
 

Accessed from the Milling Tool Wizard window, the Milling Insert window enables 
you to quickly and easily define inserted milling tools for your tool library. 

  

 
  

General Insert 
 The General Insert features enable you to easily define "ISO standard", as well as 
"custom" tool insert shapes. The parameters and diagram will vary depending on the 
Insert Type selected from the pull-down list. Only the parameters required to describe a 
particular insert type will be displayed. Use the diagram to identify what measurement 
each parameter represents. 



VERICUT HELP – Project menu 
 

The following insert types are available in the pull-down list: 

  

A - 85 degree parallelogram 

B - 82 degree parallelogram 

C - 80 degree diamond 

C - 100 degree diamond 

D - 55 degree diamond 

E - 75 degree diamond 

H - Hexagon 

K - 55 degree parallelogram 

L - Rectangle 

M - 86 degree diamond 

O - Octagon 

P - Pentagon 

R - Round 

S - Square 

T - Triangle 

V - 35 degree diamond 

W - 80 degree trigon 

Custom diamond 

Custom parallelogram 

  

For additional information on these insert types, see General Insert features in the Tool 
Add/Modify Window, Common Features section. 

  

Cutter Body 
 The Cutter Body features enable you to easily define the cutter body and position the 
inserts. Enter the desired value in the text field for each parameter. Use the diagram to 
identify the measurement that each parameter represents. Use the Location Aids 
described below to position the inserts.  

Locate by nominal diameter    — Positions the center of the insert corner radius 
on the tool diameter. 
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Locate by outside diameter     — Positions the outside edge of the insert on the 
tool diameter. 

  

  

Add — Adds the defined inserts and cutter body to the tool library and closes the Milling 
Insert window.  

Close — Closes the Milling Insert window without adding inserts/cutter body to the tool 
library. 
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Turret Setup window 
 
Accessed from the Tool Manager: Edit menu, the features in the Turret Setup window 
enable you to load or change tools, or change tool positions in a turret. 
 
 

 
 

 
Turret Setup Table 
Each record in the Turret Setup Table represents a position on a turret.  

Turret — Indicates the name of the turret component. Records for all turrets in the 
machine configuration will be displayed in the Turret Setup Table. 

Index — Indicates the Index number of a turret tool position. 

Tool ID — Indicates the Tool ID of the tool loaded in that position in the turret. A 
blank field indicates that no tool is currently loaded in the position. 

When you select a record in the Turret Setup Table, the record becomes highlighted. The  
Tool Display area in Tool Manager updates to display the turret with all tools currently 
loaded in it. The tool represented by the selected record is marked in the turret display as 
well as becomes highlighted in the Tool Manager Tool Table. See the picture that 
follows. 
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To add, or change, a tool associated with the highlighted turret record, click in the Tool 
ID field for that record and select the desired tool from the pull-down list. The list will 
contain all tools in the current Tool Library and a blank field. 

Use the Position button, described below, to display the tool positioning window and use 
it to orient the tool correctly on the turret. 

 

OK — Use OK to accept your changes and close the Turret Setup window. 

Position — Displays the Turret Tool Positioning window enabling you to correctly 
position a tool on the turret. 

Cancel — Closes the Turret Setup window without accepting your changes. 
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Turret Tool Positioning window 
 
Accessed from the Turret Setup window: Position button, the features on the Turret 
Tool Positioning window enable you to correctly orient a tool (or tool assembly) on a 
turret, similar to orienting models. The features on the Turret Setup window tabs work 
the same as the features on the corresponding tab on the Tool Add/Modify window: 
Assembly tab. 
 
 

 
 
 

Translate tab — Features on this tab are used to translate the selected tool via indicating 
"from" and "to" points to move the tool. 

Rotate tab — Features on this tab are used to rotate the selected tool about a rotation 
center point. 

Assemble tab — The features on this tab enable you to assemble tools on a turret, by 
mating, or aligning, one to three planar surfaces with surfaces on the turret, similar to 
assembling tool assemblies or models. 

Matrix tab — Features on this tab move the selected tool via a twelve parameter 
transformation matrix. 

 

Undo — Returns the tool to its previous orientation, or as it was when the window was 
opened. 

Close — Closes the Turret Tool Positioning window. 
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Turret Tool Positioning window, Translate tab 
 

Features on this tab enable you to translate the selected tool (or tool assembly) via 
indicating "from" and "to" points to move the tool, similar to translating models. 
Movement occurs each time you press the Move button. If the applied movement is 
incorrect, press Undo (in the Turret Positioning window) to return the object to its 
previous location. 

Features on this tab work the same as the Translate tab features on the Tool 
Add/Modify window: Assembly tab. 
 

 
 
 
Translate tab features: 
From / To — Specifies the locations to move the tool "from",  and "to", relative to the 
tool origin. XYZ values can be entered (separated by spaces), or selected by clicking in 
the field then clicking on the tool in the Turret Display area. As you move the mouse over 
the tool, a crosshair and vector show you the pending pick-point location. 

Move — Moves the selected object by the incremental distance, as calculated from the 
"From" point to the "To" point location. 
 
 
To Turret Tool Positioning window
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Turret Tool Positioning window, Rotate tab 
 

Features on this tab are used to rotate the selected tool (or tool assembly) about a rotation 
center point, similar to rotating models. Movement occurs each time you press one of the 
rotation direction buttons: X+/X-, Y+/Y-, Z+/Z-. If the applied rotation is incorrect, press 
Undo (in the Turret Positioning window)  to return the object to its previous location. 

Features on this tab work the same as the Rotate tab features on the Tool Add/Modify 
window: Assembly tab. 
 
 

 
 
Rotate tab features: 
Center of Rotation — Specifies XYZ point location about which to rotate the tool. XYZ 
values can be entered in the Center of Rotation text field (separated by spaces), or 
selected by clicking in the Center of Rotation text field, then clicking on a tool in the 

Turret Display area. To see the center of rotation, press . To remove the center of 
rotation symbol press the button again, or close the window. 

Increment — Specifies incremental degrees of rotation to apply when one of the rotation 
direction buttons are pressed. 

Rotation buttons — (X+/X-, Y+/Y-, Z+/Z-) Applies the incremental degrees of rotation 
specified in the Increment field. Rotation occurs about the Center of Rotation relative 
to the tool origin. 
 
 
To Turret Tool Positioning window
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Turret Tool Positioning window, Assemble tab 
 

The features on this tab enable you to orient a tool (or tool assembly) on a turret, by 
mating, or aligning, one to three planar surfaces with surfaces on the turret, similar to 
assembling models. If a non-planar surface is selected, VERICUT constructs a tangent 
plane at the pick point. The relationship of surfaces being mated or aligned is known as a 
"constraint". If the applied movement is incorrect, press Undo (in the Turret Positioning 
window) to return the tool to its previous location. 

Features on this tab work the same as the Assemble tab features on the Tool 
Add/Modify window: Assembly tab. 

Follow these general steps to define a constraint for assembly: 

1. Choose the constraint type. 
2. In the Turret Display area, select a surface on the tool to move. 
3. Select the surface to move the tool relative to on the turret. 

 

 
 
Assemble tab features: 
Constraint Type — Specifies how to constrain selected surfaces during tool movement. 
After selecting two surfaces in the Turret Display area to define a constraint, VERICUT 
moves the tool and highlights the satisfied constraint with a checkmark.  

Options: 
Mate — Moves the tool so the selected surface opposes the surface selected on the 
turret (surface normals oppose each other). 

Align — Moves the tool so the selected surface is aligned with the surface selected 
on the turret (surface normals point in the same direction). 

Offset — Distance and direction in which to offset constrained surfaces, applied normal 
to the surface. 
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Reset — Resets constraints to receive new data. 

 

 

To Turret Tool Positioning window
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Turret Tool Positioning window, Matrix tab 
 
Features on this tab enable you to orient the selected tool (or tool assembly) via a twelve 
parameter transformation matrix, similar to orienting models with a matrix. If the applied 
movement is incorrect, press Undo (in the Turret Positioning window) to return the 
object to its previous location. 
Features on this tab work the same as the Matrix tab features on the Tool Add/Modify 
window: Assembly tab. 
 
 

 
 
 
Matrix tab features: 
Matrix table — The transformation matrix table is similar to the matrix used in 
programming APT tool paths. Its twelve parameters reveal the geometric attributes of the 
local (transformed) coordinate system (CSYS) in terms of the machine origin.  

 

The format of the matrix table is as follows: 

  I J K D 

X I1 J1 K1 D1 

Y I2 J2 K2 D2 

Z I3 J3 K3 D3 

  

Each row represents an axis of the local CSYS. The first three columns represent the 
vector associated with each axis:  I1, J1, K1 as the positive X-axis vector; I2, J2, K2 as 
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the positive Y-axis vector; and I3, J3, K3 as the positive Z-axis vector. The fourth column 
values D1, D2, D3 represent the coordinates of the origin point of the local CSYS. 

 

NOTE:  If you prefer to see the Matrix Table displayed with the I, J, K along the vertical 
axis and the X, Y, Z along the horizontal axis, set the environment variable, 
CGTECH_MATRIX_FORMAT=VERTICAL. 

 
Update — Updates the tool location to reflect the matrix table transformation. 

Apply Inverse On Update — When selected, inverts the matrix so that its twelve 
parameters reveal the geometrical attributes of the machine origin in terms of the local 
(transformed) coordinate system. 

 
 
To Turret Tool Positioning window
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Tool Manager window, Tool Table 
 

Table of tools defined in the Tool Library file. Tools listed in the table are arranged by 
ID, but can be sorted by any attribute via clicking on the table header. You can also 
search for tools in the library using the Search feature. Double-click the tool ID or click 
the + / - symbols to expand or collapse branches of a tool assembly to see its cutter/holder 
components. Stretch the window or use the scroll bars to see all the table data. 

  

 
  

Tool Table Data: 
ID — Alpha-numeric text that identifies the tool in the Tool Library. IDs typically 
correspond to tool or pocket numbers referenced by the tool change record that will call 
the tool from the library. For example, ID " 1" would normally be used for a tool called 
by a G-Code data block "T1M6", or an APT tool change record "LOADTL/1". However, 
you can use a tool list to cross-reference tools having IDs in a library that are different 
from those in the tool change record. See Project menu > NC Programs for details. 
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The following symbols are used in the Tool ID tree: 

  Tool    

  Tool Components:   

   Insert Cutter 

   Revolved Cutter 

   Probe Tip 

   Holder 

   OptiPath Record 

   Driven Point Record 

   Cutter Compensation Record 

    

  

Hint:  Use IDs and descriptions that make it easy for others to find tools they need. 

  

Description — Describes the tool or tool assembly. Any alpha-numeric text can be 
entered in this field. Special characters are not recommended. 

Units — Controls the unit measurement system (Inch or Millimeter) in which to describe 
the tool. If the tool units are different from the session units when loaded, then tool 
description values are converted appropriately. 

Gage Point — Specifies the location of the tool assembly gage point. By default, the 
gage point is located at the tool origin. Values entered move the gage point relative to the 
tool origin, or you can select a gage point by clicking in the Gage Point field then 
clicking on the tool in the Tool Display. As you move the mouse over the tool, a point 
and normal vector show you the pending pick-point location.  

When processing G-Code tool paths, VERICUT uses the gage point in the following two 
ways: 

Controls how the tool loads in the NC machine — When a tool is loaded for cutting, 
the gage point is located at the NC machine's Tool component origin. 

Sets the adjustment needed to drive the tool in "Tool Tip" and "Tool Length 
Compensation" programming methods — These programming methods enable an NC 
programmer to assume the positions in the tool path are controlling the tool, instead 
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of NC machine axis positions. VERICUT uses the gage point to determine where the 
driven point is (a.k.a. "control point") relative to the gage point. 

Missing or incorrect gage point values causes a tool to load incorrectly on a 3-D machine, 
or causes improper cutting.  

Sample gage points for milling tools: 

 
 

Sample gage points for turning tools: 
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The "Gage Point" view attribute displays a hollow target symbol  , at the gage point 
location (ref. Tool Manager: View menu > Attributes).  

NOTE:  Gage Offset table values can be used to override Tool Manager-defined Gage 
Offset values for setting the adjustment to calculate the driven control point (condition #2 
above). However, they do not affect how the tool is loaded in the NC machine (condition 
#1 above). 

When the Gage Offset table is used to adjust tool motions, the NC control must be 
configured to call the ToolOffsetAptAdj macro when a tool change occurs, or when the 
tool control point changes, to adjust the motions seen in Workpiece views. The 
ToolOffsetAptAdj macro allows the machine simulation to be driven with multiple tool 
control points, when a single tool control point was defined in the Tool Manager.  

If this macro is not called on or after the tool change command, or when the tool control 
point changes, then Workpiece views may not reflect the adjustment to the Tool 
Manager-defined Gage Offset. 

Orientation — Specifies the orientation of the tool assembly when loaded for cutting. 
Three values are entered (separated by spaces) to define the X, Y, Z rotation angles, 
respectively. Angle values are in degrees, relative to the tool origin. Rotation occurs 
about the tool's gage point. 

NOTE:  This feature is only applicable when NC Program Type is G-Code Data. 

 

Teeth — Automatically indicates the number of teeth of the tool referenced by the 
Optipath record selected from the OP Description pull-down list. 

NOTE: You have the ability to manually edit the number of teeth (either by typing in a 
value or selecting a value from the pull-down list) but be aware that if the number of 
teeth entered does not match the number of teeth specified in the OptiPath record, the tool 
will not be optimized. 

 

Comments — This field enables you to add comments related to the tool. The comment 
text is stored with the tool ID. 

  

Driven Point record — Specifies an offset for the tool control point, or "driven point". 
Material is removed based on motion commands and the tool shape relative to the control 
point. For milling tools, a positive value moves the control point in the positive tool axis 
direction (closer to the spindle), while a negative value moves the control point in the 
opposite direction.  

NOTE:  VERICUT material removal for milling tools does not support driven points 
with X- or Y- offsets, only Z-offset is allowed. If you wish to drive the machine with an 
X, or Y, offset driven point, and to have the correct  material removal, you should define 
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2 driven points for the tool. For example, to drive the machine with an X offset, create the  
1st driven point (0,0,0) and the 2nd (6,0,0). 

For turning tools, XYZ values (separated by spaces) are entered relative to the spindle 
axis (Z), and cross-slide axis (X). 

 

Sample Driven Point values for a milling tool: 

 
 

Sample Driven Point values for a turning tool: 

 
  

When defined, the "Driven Point" view attribute displays as a hollow target symbol  
 at the control point location. (Ref. Tool Manager: View menu > Attributes) 

Cutter Compensation record — Specifies the cutter compensation value for a particular 
tool. 

   

 

Shortcuts:  
1. Double click a tool component in the Tool Table to display the Tool Add/Modify 

window to enable modification of the tool. 

2. Right-click in the Tool Manager Tool Table to display a menu with the 
following features: 
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NOTES: 
1. Features Modify, Rename, Delete, Cut, Copy, Paste, Search Tool, and 

Search OptiPath provide the same functionality described above under Tool 
Manager window, Edit menu. 

2. Features Add Tool, Add Tool Component, Add OptiPath, Add Driven 
Point, and Add Cutter Compensation provide the same functionality 
described above under Tool Manager window, Add menu. 

3. The Spin Around feature is only available for inserted tools. It enables you to 
specify whether to spin the tool around the Tool Axis (for example a right 
angle holder), or around the Machine Spindle axis. Features Expand All and 
Hide Tool Components provide the same functionality as described under 
Tool Manager window, View Menu. 
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Tool Manager window, Tool Display 
 

Tool Display area — Displays the tool selected in the Tool Table. Colors distinguish 
holders from cutter components. Target symbols indicate the tool's driven point and gage 
point. Use the View Orient functions to visually manipulate the tool in the display area. 

 

 
 
 
Shortcuts:  
 

1. Double click a tool component in the Tool Display area to display the Tool 
Add/Modify window to enable modification of the tool. 
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2. Right-click in the Tool Manager Tool Display area  to display a menu with 
the following features: 

 

 
NOTES: 

1. See View Orient window, also in the VERICUT Help section for information 
on Fit, Reverse and Select View. 

2. A check next to Driven Point, Gage Point, or Axes, indicates that the feature 
is toggled "On" and the corresponding target marker, or axis, will be displayed 
in the Tool Display area. 
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Tool Manager window, Message Area 
 

The message area, also known as the "message logger", is located at the bottom of the 
Tool Manager window, and by default displays the most recent message VERICUT has 
provided. VERICUT provides error, warning, and informational messages to assist you 
while working in the Tool Manager. 

To review previous messages, click on the message line-the most recent message is listed 
last. Click again to close the message logger. 
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Tool Manager - Tool Add/Modify window 
Location:  

Project menu > Tools:    Add menu > Tool > New > Mill (or Turn, or Probe), or  

Add menu > Tool Component 

Edit menu > Modify 
 

Opened via adding or modifying tool/tool components, this window is used to describe 
tool component shape, color, location, and other attributes. Features displayed on the 
Components tab of this window will vary, depending on the tool/tool component type 
that you selected to add/modify. The Tool Component tab for a Revolved Cutter 
component type is shown below. 
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Tool Component tab — Features on this tab are used to define the shape of a tool 
component in a tool assembly. Features displayed on the Tool Component tab vary, 
depending on the tool/tool component type that you selected to add/modify.  

Assembly tab — Features on this tab are used translate or rotate a component in a tool 
assembly, or to move the selected component by assembling (mating or aligning) it with 
other objects in the tool assembly. 

  

Add — Use to apply the specified data to the new tool component. 

Modify — Use to apply the modified data to an existing tool component. 

Close — Close the Tool Add/Modify window without applying the data. 

 
Also see: Tool Add/Modify window, Common Features 
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Tool Add/Modify window, Tool Component tab 
 
Accessed from the Tool Add/Modify window, the features on this tab are used to define 
the shape of a tool component in a tool assembly. Features displayed on the Tool 
Component tab vary, depending on the tool/tool component type that you selected to 
add/modify.  
 

Revolved Cutter 
Mill Insert 
Turn Insert 
Probe Tip 
Tap 
Water Jet 
Holder 
 

Also see: Tool Add/Modify window, Common Features 
 
 
 
To Tool Add/Modify window
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Tool Add/Modify window, Tool Component tab 
(Revolved Cutter) 
 

Opened via adding, or modifying, a Revolved Cutter tool component, this tab is used to 
describe the shape of a selected "Cutter" component in a mill tool assembly. Options are 
available to define the cutter via parametric shapes, profile sketcher, or reference a cutter 
in another tool assembly. 

See Tool Add/Modify window, Assembly tab, also in this section, for information on 
positioning,  and orienting, a revolved cutter component in a milling tool assembly. 

 

 
 

Component Type — Use to specify the type of component you are creating. In this case 
a Revolved Cutter. 

ID — Use to specify the ID for the component you are creating. If not specified, 
VERICUT will assign a unique default ID. 
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Tool shape icons — Selecting an icon configures the bottom half of the window to 
define the selected cutter shape.  

 

Options: 

Icons Name Description 

 

 Flat Bottom End Mill 
Diameter (D) 

Height (H) 

 

 

 Ball Nose End Mill 
Diameter (D) 

Height (H) 

 

 

 Bull Nose End Mill Diameter (D), Corner 
Radius (R), Height (H) 

 

 

 Drill 
Diameter (D), Drill 
Point Angle (A), 
Height (H) 
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 7 Parameter D, R, E, F, A, B, H 

 

 

 10 Parameter D, R1, E1, F1, A, B, H, 
R2, E2, F2 

 

 Profile Opens the Profile Sketcher in "SOR" mode. 

 Reference Displays the Reference features enabling you to 
reference a mill cutter in another tool assembly. 

  

The following options are common to all Tool Add/Modify mill cutter windows 
except Reference: 

 
Flute Length — Length of the cutter having flutes, or teeth that can remove material. 
This value is measured from the bottom-most portion of the cutter. Zero assumes the 
entire cutter length has flutes, or teeth that can cut material. An error similar to "SHANK 
removed material..." is reported when the non-cutting portion of the cutter removes 
material. Material removed is shaded using the red Error color. 
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Shank Diameter — Diameter of the tool shank. 

Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 

Spindle Direction — Use to specify the appropriate spindle rotation direction for the 
tool. Choose either CW (clockwise) or CCW (counterclockwise). 

NOTE:  For revolved milling cutters, CW/CCW is defined looking down (negative Z) 
the tool axis. 

 

Tips for defining milling cutters: 
1. Diameter is measured from the intersection points of the cutter side with the 

bottom flat or angle. 

2. D is automatically calculated when D=0, and the corner radius (R) and side angle 
(B) are specified. (Good tip for defining tapered endmills.) 

3. E and F are automatically calculated when diameter and corner radius are 
specified. 
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Examples of milling cutter shapes that can be defined via the 7 Parameter option: 
 

 
 
 
 
To Tool Add/Modify window
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Tool Add/Modify window, Tool Component tab (Mill 
Insert) 
 

Opened via adding or modifying a milling Insert Cutter tool component, this tab is used 
to describe the insert shape for the "Cutter" component in a mill tool assembly. Options 
are available to define the cutter insert via ISO standard shapes, profile sketcher, or 
reference a cutter insert in another tool assembly. 

See Tool Add/Modify window, Assembly tab, also in this section, for information on 
positioning,  and orienting, a mill insert component in a milling tool assembly. 

 

 
 

Component Type — Use to specify the type of component you are creating. In this case 
an Insert Cutter for a milling tool. 

ID — Use to specify the ID for the component you are creating. If not specified, 
VERICUT will assign a unique default ID. 
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Tool shape icons — Selecting an icon configures the bottom half of the window to 
define the selected cutter shape.  

 

Options: 

Icons Name Description 

 
General Insert Displays the General Insert features enabling you 

to define ISO standard insert shapes. 

 
Profile (sweep) Opens the Profile Sketcher in "sweep" mode. 

 
Reference Displays the Reference features enabling you to 

reference an insert in another tool assembly. 

 
Model File Displays the Model File features enabling you to 

specify a model file to be used as an insert. 

 

NOTES:   
1. For inserted milling cutters, tool spinning direction is determined by the insert 

thickness direction. 

2. VERICUT uses a pre-defined "Relief Angle" of  5 degrees for all tool inserts 
created with Tool Manager. 

 
 
To Tool Add/Modify window 
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Tool Add/Modify window, Tool Component tab (Turn 
Insert) 
 

Opened via adding or modifying a turning Insert Cutter tool component, this tab is used 
to describe the insert shape for the "Cutter" component in a turning tool assembly. 
Options are available to define the cutter insert via ISO standard shapes, profile sketcher, 
or reference a cutter insert in another tool assembly. 

See Tool Add/Modify window, Assembly tab, also in this section, for information on 
positioning,  and orienting, a turn insert component in a turning tool assembly. 

 

 
 

Component Type — Use to specify the type of component you are creating. In this case 
an Insert Cutter for a turning tool. 

ID — Use to specify the ID for the component you are creating. If not specified, 
VERICUT will assign a unique default ID. 
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Tool shape icons — Selecting an icon configures the bottom half of the window to 
define the selected cutter shape.  

 

Options: 

Icons Name Description 

 

 
General Insert Displays the General Insert features enabling you 

to define ISO standard insert shapes. 

 

 
Groove Insert Displays the Groove Insert features enabling you to 

define ISO standard groove insert shapes. 

 

 
Thread Insert Displays the Thread Insert features enabling you to 

define ISO standard thread insert shapes. 

 

 
 

Profile (sweep) Opens the Profile Sketcher in "sweep" mode. 

 

 
 

Reference Displays the Reference features enabling you to 
reference an insert in another tool assembly. 

 

 
Model File Displays the Model File features enabling you to 

specify a model file to be used as an insert. 

 
 
NOTE:  VERICUT uses a pre-defined "Relief Angle" of  5 degrees for all tool inserts 
created with Tool Manager. 
 
 
To Tool Add/Modify window
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Tool Add/Modify window, Tool Component tab (Probe 
Tip) 
 

Opened via adding or modifying a probe tip tool component, this tab is used to describe 
the shape of a probe tip component in a probe tool assembly. 

See Tool Add/Modify window, Assembly tab, also in this section, for information on 
positioning,  and orienting, a probe tip component in a probe tool assembly. 

 

 
 

Component Type — Use to specify the type of component you are creating. In this case 
a Probe Tip. 

ID — Use to specify the ID for the component you are creating. If not specified, 
VERICUT will assign a unique default ID. 
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Sphere Diameter — Diameter of the sphere at the end of the probe tip. 

Stem Diameter — Diameter of the probe tip stem. 

Probe Length — Length of the probe tip. 

Maximum RPM — The maximum speed that a probe tool can spin before a spindle 
On/Off error is output. The default value is 0. 

Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 
 
 
To Tool Add/Modify window 
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Tool Add/Modify window, Tool Component tab (Tap) 
 

Opened via adding, or modifying, a tap tool component, this window is used to describe 
the shape, position and orientation of a tap component in a tap tool assembly. 

See Tool Add/Modify window, Assembly tab, also in this section, for information on 
positioning,  and orienting, a tap component in a tap tool assembly. 

 

 
 

Component Type — Use to specify the type of component you are creating. In this case 
a Tap. 

ID — Use to specify the ID for the component you are creating. If not specified, 
VERICUT will assign a unique default ID. 
 
Required Parameters 
 
Major Diameter — Major diameter of the tap. Specify the diameter in either inches or 
millimeters, or by the screw thread size (i.e, #4, #6, #8, etc.). 
Thread — Thread pitch of the tap. Specify in threads/inch, or threads/millimeter, or by 
thread pitch value. 
Thread Length — Distance from tip to last full thread. Specify in inches or millimeters. 
Overall Length — Overall Length of the tap. Specify in inches or millimeters. 
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Style — Specify the tap style. Select Taper, Plug, or Bottom from the pull-down list. 
Direction — Direction of rotation for the tap. Choose Right or Left. 
 
Optional Parameters 
 
Minor Diameter — Diameter at the root (valley) of thread. Specify in inches or 
millimeters. 
Shank Diameter — Diameter of shaft above full thread. Specify in inches or 
millimeters. 
Lead Tolerance — Lead tolerance expressed as a percentage of the thread's lead value. 
Neck  Diameter — Reduced diameter between thread length and neck length. Specify in 
inches or millimeters. 
Neck Length — Distance from tip to top of reduced diameter. Specify in inches or 
millimeters. 
Tip Diameter — Diameter of tip of the cutter. Specify in inches or millimeters. 
Forms — Use to specify the thread for. Select Unified (Inch), ISO (Metric), 
Whitworth (British Standard), or Buttress from the pull-down list. 
 
Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 
 
 
 
To Tool Add/Modify window
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Tool Add/Modify window, Tool Component tab (Water 
Jet) 
 

Opened via adding or modifying a water jet tool component, this tab is used to describe 
the shape of a waterjet component in a water jet tool assembly. 

See Tool Add/Modify window, Assembly tab, also in this section, for information on 
positioning,  and orienting, a water jet component in a water jet tool assembly. 

 
 

 
 
 

Component Type — Use to specify the type of component you are creating. In this case 
a Water Jet. 

ID — Use to specify the ID for the component you are creating. If not specified, 
VERICUT will assign a unique default ID. 
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Diameter — Use to specify the cylindrical diameter of the water jet when the jet is on. 

Length — Use to specify the maximum length of the water jet.  

Minimum Cutting Zone — Use to specify the minimum distance from the Water Jet 
component origin, along the component's Z axis, where cutting is desired. 

Maximum Cutting Zone — Use to specify the maximum distance from the Water Jet 
component origin, along the component's Z axis, where cutting is desired. 

Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 
 
 
 
To Tool Add/Modify window
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Tool Add/Modify window, Tool Component tab 
(Holder) 
 

Opened via adding or modifying a Holder tool component, this window is used to 
describe the shape of a selected "Holder" component in a tool assembly. Options are 
available to define the holder via parametric shapes, profile sketcher, or reference a 
holder in another tool assembly. More than one holder can be used in a tool assembly. An 
error similar to "HOLDER removed material..." is reported when the non-cutting portion 
of the cutter removes material. Material removed is shaded using the red Error color. 

See Tool Add/Modify window, Assembly tab, also in this section, for information on 
positioning,  and orienting, a holder component in a tool assembly. 

 

 
 

Component Type — Use to specify the type of component you are creating. In this case 
a Holder. 
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ID — Use to specify the ID for the component you are creating. If not specified, 
VERICUT will assign a unique default ID. 

 
Holder icons — Selecting an icon configures the bottom half of the window with the 
parameters required to define the holder shape.  

Options: 

Icons Name Description 

 

 

 
Block 

Length (L) 

Width (W) 

Height (H) 

 

 

 

 
Cylinder 

Radius (R) 

Height (H) 

Tolerance 

 

 

 

 
Cone 

Bottom Radius (R1) 

Top Radius (R2) 

Height (H) 

Tolerance 
 

 

 
 

Profile - SOR Opens the Profile Sketcher in "SOR" mode. 

 

 

Profile - Sweep Opens the Profile Sketcher in "Sweep" mode.
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Reference 

 

Displays the Reference features enabling you 
to reference a holder in another tool 
assembly. 

 

 
 

Model File Displays the Model File features enabling 
you to select a model file to define the holder.

 

The following option is common to all Tool Add/Modify Holder windows: 
Do Not Spin with Spindle — When toggled "On", indicates that the holder component 
does not spin. 

 

The following option is common to all Tool Add/Modify Holder windows except 
Reference: 
Color — Color that the tool component is to be displayed in VERICUT. For additional 
information, see Tool Display Colors in the Tool Add/Modify window, Common 
Features section. 

 

 

To Tool Add/Modify window 
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Tool Add/Modify window, Common Features 
 

Profile Sketcher Features 
  

See Profile Sketcher Features in the Setup Models section above. 
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Reference feature 
 

Tool Add/Modify, Reference feature enables you to "reference" a tool component in 
another tool library file for use in the current tool library file. 

 
Reference features: 
Reference File — Enter the /path/filename of the tool library file containing the tool 
component to be referenced in the text field or use the Pick button to display the 
Reference Id Pick List window and use it to select the tool library file. 

Reference ID — Enter tool ID of the tool component to be referenced in the text field or 
use the Pick button to display the Reference Id Pick List window and use it to select the 
tool component to be referenced. 

Pick — Displays the Reference Id Pick List window enabling you to select the tool 
component to be referenced from the list. The first time that Pick is selected during a 
VERICUT session, a standard file selection window is displayed so that you can select a 
tool library file. After the tool library file has been selected, the Reference ID Pick List 
window is displayed so that you can select the tool component.  

On subsequent selections of the Pick button during a session, the Reference Id Pick List 
window is displayed with the previously selected tool library file. Enter the 
/path/filename in the Tool Library text field or use the Browse button to display a file 
selection window and use it to change the tool library file. 

Sample Reference ID Pick List window: 

 



VERICUT HELP – Project menu 
 

 

General Insert features 
  

General Insert features enables you to define "ISO standard", as well as "custom" tool 
insert shapes. The parameters and diagram will vary depending on the Insert Type 
selected from the list. Only the parameters required to describe a particular insert type 
will be displayed.  

NOTE:  VERICUT uses a pre-defined "Relief Angle" of  5 degrees for all tool inserts 
created with Tool Manager. 

 

Insert Type Parameter Description 

A - 85 degree parallelogram 

L - Length 

W - Width 

Thickness 

R - Corner Radius 

A  - Lead Angle 

Driven Point* 

Color * 
 

B - 82 degree parallelogram 

L - Length 

W - Width 

Thickness 

R - Corner Radius 

A  - Lead Angle 

Driven Point* 

Color * 
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C - 80 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 

 

C - 100 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 

 

D - 55 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 
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E - 75 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 

 

H - Hexagon 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 

 

K - 55 degree parallelogram 

L - Length 

W - Width 

Thickness 

R - Corner Radius 

A  - Lead Angle 

Driven Point* 

Color * 
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L - Rectangle 

L - Length 

W - Width 

Thickness 

R - Corner Radius 

A  - Lead Angle 

Driven Point* 

Color * 
 

M - 86 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 

 

O - Octagon 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 
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P - Pentagon 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 

 

R - Round 

D - Inscribed Diameter 

Thickness 

Driven Point* 

Color * 

 

S - Square 

L - Length 

Thickness 

R - Corner Radius 

A  - Lead Angle 

Driven Point* 

Color * 
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T - Triangle 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 

 

V - 35 degree diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 

W - 80 degree trigon 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 
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Custom diamond 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

A - Lead Angle 

T - Tip Angle 

Driven Point* 

Color * 
 

Custom parallelogram 

L - Length 

W - Width 

Thickness 

R - Corner Radius 

A - Lead Angle 

Driven Point* 

Color * 
 

 
*Driven Point — Use to specify the driven point for the insert. Select the desired driven 
point from the pull-down list. 

 
* Color* — Color that the tool component is to be displayed in VERICUT. For 
additional information, see Tool Display Colors in the Tool Add/Modify window, 
Common Features section. 

  

Location Aids  
 These features are only available for mill Inserts. They enable you to easily position the 
insert with respect to the tool diameter. 
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  (Diameter) — Use this text field to specify the diameter of the tool. 

Locate by nominal diameter    — Positions the center of the insert corner radius 
on the tool diameter. 

Locate by outside diameter  — Positions the outside edge of the insert on the 
tool diameter. 
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Groove Insert features 
  

Groove Insert features enables you to define "ISO standard" groove insert shapes. The 
parameters and diagram will vary depending on the Insert Type selected from the list. 
Only the parameters required to describe a particular insert type will be displayed. 
Groove Insert features are only available for defining turning cutters. 

NOTE:  VERICUT uses a pre-defined "Relief Angle" of  5 degrees for all tool inserts 
created with Tool Manager. 

 

Insert Type Parameter Description 

Square, double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

C 

D 

Driven Point* 

Color * 

Radius, double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

D 

Driven Point* 

Color * 
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40 degree V, double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

C 

D 

Driven Point* 

Color * 

45 degree chamfer, 
double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

C 

D 

Driven Point* 

Color * 

Square, single end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

C 

D 

Driven Point* 

Color * 
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Chamfer, single end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

C 

D 

A - Chamfer Angle 

Driven Point* 

Color * 

Round, single end 

L - Length 

Thickness 

R - Corner Radius 

C 

Driven Point* 

Color * 

Radius, single end 

L - Length 

Thickness 

R - Corner Radius 

C 

Driven Point* 

Color * 

  

*Driven Point — Use to specify the driven point for the insert. Select the desired driven 
point from the pull-down list. 
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* Color — Color that the tool component is to be displayed in VERICUT. Color that the 
tool component is to be displayed in VERICUT. For additional information, see Tool 
Display Colors in the Tool Add/Modify window, Common Features section. 
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Thread Insert features 
 

Thread Insert features enables you to define "ISO standard" thread insert shapes. The 
parameters and diagram will vary depending on the Insert Type selected from the list. 
Only the parameters required to describe a particular insert type will be displayed. Thread 
Insert features is only available for defining turning cutters. 

NOTE:  VERICUT uses a pre-defined "Relief Angle" of  5 degrees for all tool inserts 
created with Tool Manager. 

 

Insert Type Parameter Description 

55 degree, triangle 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

Driven Point* 

Color * 

 

60 degree, triangle 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

Driven Point* 

Color * 
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30 degree, trapeze triangle 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

F – Flat 

Driven Point* 

Color * 
 

ACME, triangle 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

F – Flat 

Driven Point* 

Color * 
 

Buttress, triangle, right 
hand 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

F – Flat 

Driven Point* 

Color * 
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Buttress, triangle, left hand 

D - Inscribed Diameter 

Thickness 

R - Corner Radius 

E 

F – Flat 

Driven Point* 

Color * 
 

60 degree, double end, 
asymmetric 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

E 

Driven Point* 

Color * 
 

60 degree, double end, 
symmetric 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

E 

Driven Point* 

Color * 
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ACME, double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

E 

F – Flat 

Driven Point* 

Color *  

Buttress, double end 

W - Width 

L - Length 

Thickness 

R - Corner Radius 

E 

F – Flat 

Driven Point* 

Color *  

  

*Driven Point — Use to specify the driven point for turning inserts. It is not applicable 
to milling inserts. Select the desired driven point from the pull-down list. 

 
* Color — Color that the tool component is to be displayed in VERICUT. Color that the 
tool component is to be displayed in VERICUT. For additional information, see Tool 
Display Colors in the Tool Add/Modify window, Common Features section. 
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Model File features 
 
Model File — Enter the /path/filename of the model file or use the Browse button to 
display a file selection window and use it to select the model file. 

Sketcher — Displays the Profile Sketcher window enabling you to edit or create a 
"swept solid (.swp)" or "solid of revolution (.sor)" model file. This feature is only 
available the selected file is a SOR or SWEEP file type. To create a new SOR or SWEEP 
model file, clear the Model File text field and press Sketcher. 

Normals — This feature applies to STL file models only and indicates the direction in 
which surface normals defined in the STL data point, relative to the model. Select 
Inward, Outward, or Computed (let VERICUT determine the direction of the surface 
normals). 

Color — Color that the tool component is to be displayed in VERICUT. Color that the 
tool component is to be displayed in VERICUT. For additional information, see Tool 
Display Colors in the Tool Add/Modify window, Common Features section. 
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Add DXF Tool window 
 
See DXF Geometry window in the Setup Models section above. 
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Tool Manager View Attributes window 
 

 
  

The following features enable you to control view attributes related to the Tool Manager, 
Tool Display area. 

Driven Point — Use to display/not display the driven point symbol . 

Gage Point — Use to display/not display the gage point symbol . 

Axes — Use to display/not display the axes representing the tool origin. 

Light (IJK) — I J K vector direction in which the light source points. The three values 
are separated by spaces. 
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Tool Display Colors 
 

The display color for tools (cutters and holders) in all VERICUT views is determined by 
the conditions described below: 

If a tool component (cutter or holder) has a specific color defined in Tool Manager, then 
this color is used to display the component in all views. The cuts made by the cutter are 
also shaded with this color when Color Method, on the Color window: Cut Colors tab, 
is set to "Tool Color". Available colors are defined in the Shade Colors list on the Edit 
menu > Color window: Define tab. 

If a tool component (cutter or holder) is defined with "Inherit" as the color in Tool 
Manager, then it will be displayed using a "default" color. The "default" color is defined 
as the color of the tool's first cutter component or, if the color of the tool's first cutter 
component is defined as "Inherit", the "default" color is defined as the current cut color 
from the Cut Color Table on the Color window: Cut Colors tab. 

An inserted milling cutter, created by spinning several inserts, is displayed in the 
"default" color. 

 

Turrets and Tool Chains 
Tools in turrets and tool chains are displayed according to the following: 

1. Tool holders with color set to "inherit" will always be colored with color index #5 
in the Shade Color list (ref. Color window: Define tab, also in the VERICUT 
Help section). The same color displayed in Tool Manager.  

2. Inserts with color set to "inherit" will be colored with color index #7 in the Shade 
Color list when initially loaded into a turret or tool chain. The same color 
displayed in Tool Manager. 

3. Inserts with color set to "inherit" will be colored from the Cut Color Table (ref. 
Color window: Cut Colors tab, also in the VERICUT Help section) when the 
tool is used to cut. VERICUT does not know the tool's sequence until it is used to 
cut. The tools will then this color if on a turret or tool chain.  

4. Tool components with specified color will always be displayed the specified 
color. 
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Tool Add/Modify window, Assembly tab 
Location:  Project menu > Tools:  Add menu > Add Tool Component, or  

Project menu > Tools: Edit menu > Modify 
 

Features on this tab are used translate or rotate a component in a tool assembly, or to 
move the selected component by assembling (mating or aligning) it with other objects in 
the tool assembly. 
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Translate tab — Features in this group translate the selected tool component via 
indicating "from" and "to" points to move the tool component. 

Rotate tab — Features on this tab rotate the selected tool component about a rotation 
center point. 

Assemble tab — Features on this tab enable you to assemble tools by mating or aligning 
one to three planar surfaces with surfaces on other tool components, similar to 
assembling models. 

Matrix tab — Features on this tab move the selected tool component via a twelve 
parameter transformation matrix. 

Csys tab — Features on this tab enable you to move a selected tool component from one 
coordinate system to another. 

 

Position — Specifies the absolute XYZ position of the tool component relative to the 
tool origin. Values in this field are separated by spaces. 

Angles — Specifies the absolute XYZ rotation of the tool component relative to the tool 
origin. Values in this field are separated by spaces. 

Undo — Returns the tool component to its previous location, or as it was when the 
window was opened. 

 

Add — Adds the defined tool component to the Tool Manager and closes the Tool 
Add/Modify window. 

Modify — Adds the modified tool component to the Tool Manager and closes the Tool 
Add/Modify window. 

Close — Closes the Tool Add/Modify window without adding/ modifying the tool. 

 
 
To Add/Modify window
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Tool Add/Modify window, Assembly tab, Translate tab 
Location:  Project menu > Tools:  Add menu > Add Tool Component: Assembly tab 

or  

Project menu > Tools: Edit menu > Modify: Assembly tab 
 

Features on this tab are used to translate the selected tool component via indicating 
"from" and "to" points to move the object. Movement occurs each time you press the 
Move button. If the applied movement is incorrect, press Undo (on the Assembly tab) to 
return the object to its previous location. 

Features on this tab work the same as the Translate tab features for modeling. 

 

 
 

Translate tab features: 
From / To — Specifies the locations to move the tool component from and to, relative to 
the tool origin. XYZ values can be entered (separated by spaces), or selected by clicking 
in the field then clicking on a tool component shape. As you move the mouse over the 
tool, a crosshair and vector show you the pending pick-point location. 

Move — Moves the selected object by the incremental distance, as calculated from the 
"From" point to the "To" point location. 

 
 
To Assembly tab
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Tool Add/Modify window, Assembly tab, Rotate tab 
Location:  Project menu > Tools:  Add menu > Add Tool Component: Assembly tab 

or  

Project menu > Tools: Edit menu > Modify: Assembly tab 
 

Features on this tab are used to rotate the selected tool component about a rotation center 
point. Movement occurs each time you press one of the rotation direction buttons: X+/X-, 
Y+/Y-, Z+/Z-. If the applied rotation is incorrect, press Undo (on the Assembly tab) to 
return the object to its previous location. 

Features on this tab work the same as the Rotate tab features for modeling. 

 

 
 
Rotate tab features: 
Center of Rotation — Specifies XYZ point location about which to rotate the tool 
component. XYZ values can be entered in the Center of Rotation text field (separated 
by spaces), or selected by clicking in the Center of Rotation text field, then clicking on a 

tool component in the Tool Display area. To see the center of rotation, press . To 
remove the center of rotation symbol press the button again, or close the window. 

Increment — Specifies incremental degrees of rotation to apply when one of the rotation 
direction buttons are pressed. 

Rotation buttons — (X+/X-, Y+/Y-, Z+/Z-) Applies the incremental degrees of rotation 
specified in the Increment field. Rotation occurs about the Center of Rotation relative 
to the tool origin. 

 
To Assembly tab
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Tool Add/Modify window, Assembly tab, Assemble tab 
Location:  Project menu > Tools:  Add menu > Add Tool Component: Assembly tab 

or  

Project menu > Tools: Edit menu > Modify: Assembly tab 
 

The features on this tab enable you to assemble tool components, by mating or aligning 
one to three planar surfaces with surfaces on other tool components, similar to 
assembling models. If a non-planar surface is selected, VERICUT constructs a tangent 
plane at the pick point. The relationship of surfaces being mated or aligned is known as a 
"constraint". If the applied movement is incorrect, press Undo (on the Assembly tab) to 
return the object to its previous location. 

Features on this tab work the same as the Assemble tab features for modeling. 

Follow these general steps to define a constraint for assembly: 

1. Choose the constraint type. 

2. Select a surface on the object to move. 

3. Select the surface to move the object relative to. 

 

 
 
Assemble tab features: 
Constraint Type — Specifies how to constrain selected surfaces during tool component 
movement. After selecting two surfaces to define a constraint, VERICUT moves the tool 
component and highlights the satisfied constraint with a checkmark.  

Options: 
Mate — Moves the tool component so the selected surface opposes the surface 
selected on the second tool component (surface normals oppose each other). 
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Align — Moves the tool component so the selected surface is aligned with the surface 
selected on the second tool component (surface normals point in the same direction). 

Offset — Distance and direction in which to offset constrained surfaces, applied normal 
to the surface. 

 

Reset — Resets constraints to receive new data. 

Undo — Returns the object to its previous location, or as it was when the window was 
opened. 
 
 
To Assembly tab
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Tool Add/Modify window, Assembly tab, Matrix tab 
Location:  Project menu > Tools:  Add menu > Add Tool Component: Assembly tab 

or  

Project menu > Tools: Edit menu > Modify: Assembly tab 
 
Features on this tab move the selected component via a twelve parameter transformation 
matrix. If the applied movement is incorrect, press Undo (on the Assembly tab) to return 
the object to its previous location. 
Features on this tab work the same as the Matrix tab features for modeling. 
 

 
 
Matrix tab features: 
Matrix table — The transformation matrix table is similar to the matrix used in 
programming APT tool paths. Its twelve parameters reveal the geometric attributes of the 
local (transformed) coordinate system (CSYS) in terms of the machine origin.  

 

The format of the matrix table is as follows: 

  I J K D 

X I1 J1 K1 D1 

Y I2 J2 K2 D2 

Z I3 J3 K3 D3 
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Each row represents an axis of the local CSYS. The first three columns represent the 
vector associated with each axis:  I1, J1, K1 as the positive X-axis vector; I2, J2, K2 as 
the positive Y-axis vector; and I3, J3, K3 as the positive Z-axis vector. The fourth column 
values D1, D2, D3 represent the coordinates of the origin point of the local CSYS. 

 

NOTE:  If you prefer to see the Matrix Table displayed with the I, J, K along the vertical 
axis and the X, Y, Z along the horizontal axis, set the environment variable, 
CGTECH_MATRIX_FORMAT=VERTICAL. 

 
Update — Updates the tool component location to reflect the matrix table 
transformation.  

Apply Inverse On Update — When selected, inverts the matrix so that its twelve 
parameters reveal the geometrical attributes of the machine origin in terms of the local 
(transformed) coordinate system. 

 
 
To Assembly tab
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Tool Add/Modify window, Assembly tab, CSYS tab 
Location:  Project menu > Tools:  Add menu > Add Tool Component: Assembly tab 

or  

Project menu > Tools: Edit menu > Modify: Assembly tab 
 
Features on this tab enable you to translate the selected tool component from one 
coordinate system (CSYS) to another. Select the "From" CSYS and the "To" CSYS to 
move the object. Movement occurs each time you press the Move button. If the applied 
movement is incorrect, press Undo to return the tool component to its previous location. 

Features on this tab work the same as the CSYS tab features for modeling. 
 

 
  

CSYS tab features: 
From / To — Specifies the coordinate system to move the tool component from, and to. 
Select the appropriate CSYS from each of the pull-down lists. 

Move — Moves the selected tool component from the "From" CSYS to the "To" CSYS 
orientation. 

 
 
To Assembly tab
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Search Tool window 
Location:  Project menu > Tools:     Add menu > Tool > Find Existing or  

Edit menu > Search Tool  
  

Search Tool enables you to search existing tool libraries for tools with the specific 
attributes. 
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Libraries group: 
Files — Use to search one or more tool library files for tools meeting the specified search 
criteria.  

Directories — Use to search one or more directories of tool library files for tools 
meeting the specified search criteria. 

Browse — Displays a selection window to assist you in selecting the files/directories to 
be searched.  

  

Tool group: 
ID — Search for the specified tool ID. 

Description — Search for a specified string of text within the tool's Description field. 

Comments — Search for a specified string of text within the tool's Comment field. 

Units — Select Any, Inch or Millimeter from the pull-down list. 

Component Type — Use to search for tools that include a specific tool component type. 
Select Any, Revolved Cutter, Insert Cutter, Probe Tip, or Holder from the pull-down list. 

Teeth — Use to search for tools containing cutters with a specific number (or within 
range of) of teeth. 

  

Revolved Cutter group: 
Diameter — Use to search for revolved cutters with a specific diameter (or within a 
diameter range). 

Flute Length — Use to search for revolved cutters with a specific flute length (or within 
a flute length range). 

Height — Use to search for revolved cutters with a specific height (or within a height 
range). 

Corner Radius — Use to search for revolved cutters with a specific corner radius (or 
corner radii within a range). 

  

Insert Cutter group: 
Insert Style — Use to search for a specific insert style (General, Groove, or Thread). 
Select one of the following insert styles from the pull-down list" 
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Insert Style Description 

Any   

GENERAL INSERT A 85 Degree Parallelogram 

 

GENERAL INSERT B 82 Degree Parallelogram 

 

GENERAL INSERT C 80 Degree Diamond 

 

GENERAL INSERT C 100 100 Degree Diamond 

 

GENERAL INSERT D 55 Degree Diamond 

 

GENERAL INSERT E 75 Degree Diamond 
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GENERAL INSERT H Hexagon 

 

GENERAL INSERT K 55 Degree Parallelogram 

 

GENERAL INSERT L Rectangle 

 

GENERAL INSERT M 86 Degree Diamond 

 

GENERAL INSERT O Octagon 

 

GENERAL INSERT P Pentagon 

 

GENERAL INSERT R Round 
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GENERAL INSERT S Square 

 

GENERAL INSERT T Triangle 

 

GENERAL INSERT V 35 Degree Diamond 

 

GENERAL INSERT W 80 Degree Trigon 

 

GENERAL INSERT CD Custom Diamond 

 

GENERAL INSERT CP Custom Parallelogram 

 

GROOVE INSERT S2 Square, double end 
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GROOVE INSERT R2 Radius, double end 

 

GROOVE INSERT V2 40 Degree V, double end 

 

GROOVE INSERT C2 45 Degree Chamfer, double end 

 

GROOVE INSERT S1 Square, single end 

 

GROOVE INSERT C1 Chamfer, single end 

 

GROOVE INSERT O1 Round, single end 

 

GROOVE INSERT R1 Radius, single end 
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THREAD INSERT T55 55 Degree, triangle 

6

THREAD INSERT T60 60 Degree, triangle 

 

THREAD INSERT TT 30 Degree, trapeze triangle 

 

THREAD INSERT TA ACME, triangle 

 

THREAD INSERT TBR Buttress, triangle, right hand 

 

THREAD INSERT TBL Buttress, triangle, left hand 

 

THREAD INSERT A60 60 Degree, double end, asymmetrical 
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THREAD INSERT S60 60 Degree, double end, symmetric 

 

THREAD INSERT DA ACME, double end 

 

THREAD INSERT TDB Buttress, double end 

 

  

 

Insert Size — Use to search for insert cutters with a specific insert size (or within a range 
of insert sizes). 

Thickness — Use to search for insert cutters with a specific thickness (or within a 
thickness range). 

Corner Radius — Use to search for insert cutters with a specific corner radius (or corner 
radii within a range). 

  

Probe Tip group: 
Sphere Diameter — Use to search for probe tips with a specific sphere diameter (or 
within a diameter range). 

Stem Diameter — Use to search for probe tips with a specific stem diameter (or within a 
diameter range). 

Probe Length — Use to search for probe tips with a specific length (or within a length 
range). 
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Holder group: 
ID — Use to search for a holder with a specific ID. 

Search — Start the search of the specified tool library (libraries) based on the attributes 
specified above. 

  

Tool List: 
Displays a list of the tools found during the search. The Tool List display and interaction 
is the same as the Tool Table in the Tool Manager, with the one exception that the tool 
library file name is also displayed here. 

  

Duplicate — Duplicates the selected tool in the current tool library. 

Reference — Creates a reference to the selected tool in the current tool library. 

Close — Closes the Search Tool window. 
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OptiPath window 
 
VERICUT Users: 
Location:   Project menu > Tools:    Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

Mold and Die Users: 
Mold and Die Location:   Other Settings page > Add/Modify Speed and Feed Settings 

Notebook Feature:      

 

Opens a window enabling you to create and maintain OptiPath records that describe how 
to optimize feed rates and/or spindle speeds for various tools and cutting conditions. The 
OptiPath data is used by VERICUT during tool path optimization. The OptiPath window 
shows the optimization values for the selected tool. 
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OptiPath record data 
Description — Use to enter a description for the OptiPath record. 

Material — Stock material to be cut. Enter a new material name, or click on the 
arrow to select from a list of materials defined in the library. Any combination of 
alpha or numeric characters can be used. 

Machine — NC machine that will be used to cut the workpiece. Enter a new machine 
name, or click on the arrow to select from a list of machines defined in the library. 
Any combination of alpha or numeric characters can be used. 

Teeth — Displays the number of teeth that the tool has. 

Unit Power — Power that is required to remove one cubic unit of material per minute. 
The power specification differs, depending on the units set for the OptiPath record (ref. 
Settings tab below). 

Accel/Decel — When active and a G-Code tool path is being optimized, this feature 
applies Accel/Decel settings from the NC machine configuration to adjust optimized feed 
rates. VERICUT looks ahead in the tool path file and slows the machine prior to direction 
changes, as well as changes feed rates based on the machine axes ability to accelerate and 
decelerate.  

Options: 

Off — Does not adjust optimized feed rates for acceleration/deceleration. 

Exact Stop — Assumes all axes must stop and be positioned exactly at the 
programmed location before the next block is processed. This option is recommended 
when sharp corners are required between motion blocks. 

Continuous — Allows small errors in positioning in order to maintain a more 
constant velocity during corners or direction changes. 

NOTES:  
1. The block preceding an un-optimized block is not processed through Accel/Decel 

logic. 

2. Accel/Decel settings apply to all linear and circular motions, including those in 
air. 

3. These  Accel / Decel setting are used to calculate OptiPath feedrates and cycle 
times. They are unrelated to the Accel / Decel settings in the in the Modeling 
window: Component Attributes tab.  

 

OptiPath Cutter Shape Graphic — The cutter shape automatically displays for the tool 
in the Tool Library that the OptiPath record is associated with. VERICUT refers to the 
cutter shape to calculate material removal volume and other machining related data via 
features on the OptiPath Manager Feed/Speed tab. 
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Feed/Speed tab — Features on this tab are used to describe and test various cutting 
conditions to optimize, as well as control how optimization will be performed for the 
selected tool. 

Tip:  Watch the white message area in the middle of the OptiPath window for hints on 
using Optimization Method features as you select them on the Feed/Speed tab. 

Settings tab — Features on this tab specify important settings for the optimization 
process, such as: the OptiPath record units, when to add (interpolate) more cuts, 
resolution, minimum/maximum optimized feed rates, how to optimize circle and NURBS 
motions, and more. 

Limits tab — The features on this tab enable you to specify limits for cutting 
characteristics (feedrate, cut depth, volume removal rate, chip thickness, surface speed 
and RPM) for milling cutters and drills. It does not apply to turning tools. 

Hard Material tab — The features on this tab enable you to adjust the optimized feed rate 
for ‘hostile’ cutting conditions (non-climb, thin radial width, and side-loaded cuts) when 
cutting hard materials. 

Plunge tab — The features on this tab control the optimized feed rate for motions along 
the tool axis that plunge into or retract from material. 

Entry/Exit tab — The features on this tab control the optimized feed rate for entering and 
exiting material. 

Angle tab — The features on this tab adjust the optimized feed rate for 3-axis linear cuts 
ramping in material. 

Depth Table tab — The features on this tab controls how optimized feed rates are 
calculated for cutting at various depths during Optimize by Tables optimization. 

Width Table tab — The features on this tab adjust the optimized feed rate for cuts that are 
less than full cutter width during Optimize by Tables optimization. 

  

Add — Adds the OptiPath data and optimization parameters to the newly created 
OptiPath record. 

Modify — Applies the modified OptiPath data and optimization parameters to an 
existing OptiPath record. 

Close— Closes the OptiPath Manager window. 

 

See "Overview of Optimizing NC Programs" in the Using VERICUT section, in the 
CGTech Help Library for information about using OptiPath to optimize your NC 
programs. 
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OptiPath window, Feed/Speed tab 
Location:   Project menu > Tools:    Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

 

Features on this tab are used to describe and test various cutting conditions to optimize, 
as well as control how optimization will be performed for the selected tool. As methods 
are selected, some of the features become locked (unavailable for editing). However, they 
respond to show you the relationships between feed per tooth, RPM, cutter shape, and 
feed rate through various cutting conditions. In general, this is a three step process: 

1. Configure the features in the Cutting Condition group to represent a known 
successful cutting condition which is typical for the tool. 

2. Select the desired optimization method(s). 

3. Again use the Cutting Condition group to test how optimization will be 
performed. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
window for proper optimization values. 
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Cutting Condition group: 
This group of features is used to describe and test various machining conditions to 
optimize. You can enter or adjust the sliders to set the desired values. As values change, 
the cutter graphic is updated to reflect the current cutting condition. The unit of measure 
for the values is determined by the units selected on the Settings tab. 

NOTE:  If the sliders don't go far enough to reach the desired value or the value in the 
corresponding data field turns red, then another optimization setting is limiting input. If 
all settings on the Feed/Speed tab look okay, then check values on the Settings tab, such 
as Maximum/Minimum Cut feed rates. 

Axial Depth / Radial Width — Depth and width of cut. 

Feed per Minute — Feed rate calculated from feed per tooth, spindle speed, and number 
of cutting teeth on the cutter. 

Feed per Tooth — Thickness of material or "chip load" removed by each tooth on the 
cutter. 

  

Optimization Method group: 
This group of features is used to control how optimization will be performed for the 
selected tool. Note that all methods optimize air cuts (tool motions not in contact with 
material). However, the Air Cut Feed Rate method optimizes only the cuts entirely in 
air. 

 

Tips:   
1. Watch the white message area in the middle of the OptiPath window for hints on 

using Optimization Method features as you select them on the Feed/Speed tab. 

2. When Chip Thickness and Volume Removal methods are combined (both 
selected), VERICUT calculates optimized feed rates for each, then uses the feed 
rate having the smaller value. This has the affect of protecting you against 
excessive chip thickness or volume conditions that can occur using only one of 
these optimization methods. 

 

Chip Thickness — When selected, optimizes cutting by flat, ball, and bull nose endmills 
based on maintaining a specified chip thickness. This method increases the feed rate 
when width of cut is less than 50% cutter diameter, or when depth of cut is less than the 
tool corner radius. Good for optimizing high speed machining and for semi-finishing and 
finishing operations using carbide cutting tools where the danger of "chip thinning" 
exists. It is especially effective for mold and die applications machining hard materials. 
Use the slidebar or enter the chip thickness in the data field. If unknown, unselect all 
optimization methods and use the Cutting Condition sliders to calculate it. For more 
information on chip thinning, see "The Chip Thinning Problem" in the Using 
VERICUT section. Using VERICUT can be found in the CGTech Help Library. 
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Volume Removal — When selected, optimizes based on a constant volume of material 
to be removed. This option is good for optimizing tools that encounter widely varying 
cutting conditions, such as hogging or roughing operations that cut at different cut depths 
and widths. Use the slide bar or enter the volume removal rate (cubic units) in the data 
field. If unknown, unselect all optimization methods and use the Cutting Condition 
sliders to calculate it. 

Spindle Speed — When selected, outputs spindle speed values that support optimized 
feed rates. This value is also considered for Cutting Condition calculations (see above). 
Use the slide bar or enter the spindle speed (revolutions per minute) in the data field. 

Surface Speed — When selected, optimizes feed rates and spindle speeds based on 
constant surface speed (CSS). Good for optimizing finish machining by ball or bull-nosed 
endmills and high speed machining, this option varies spindle speeds to maintain a 
constant surface speed at the maximum tool contact diameter. Feed rates are adjusted to 
maintain a constant feed per tooth ("chip load") in material. Use the slide bar or enter the 
CSS value in feet/minute (FM) for inch tool paths, meters/minute (MM) for metric tool 
paths. If unknown, unselect all optimization methods and use the Cutting Condition 
sliders to calculate it. Use features on the Spindle tab to limit RPM fluctuations and 
specify the feed per tooth load to be maintained. 

NOTE:   CSS optimization is for use on high speed NC machines capable of varying 
spindle speed quickly without harming spindle motor hardware. 

Spindle Power — Power required that is required to remove material. The value entered 
differs depending on the active units for the OptiPath record: 

Inch units => horsepower required to remove 1 cubic inch of material 

Metric units => kilowatts required to remove 1 cubic centimeter of material per 
second 

Air Cut Feed Rate — This option is useful for reducing time of proven tool paths, 
without affecting cutting feed rates and resulting surface finishes. When the checkbox is 
cleared, this feature controls the feed rate used by all other optimization methods to 
optimize air cuts. 

Default option — when selected, the air cut feed rate is determined as follows: 

G-Code tool path = Max Feed Velocity of the machine's X-axis. 

APT tool path = Fast Feed value. 

To specify an air cut feed rate value, clear the Default checkbox and enter a value in the 
data field. The feed rate entered should reflect the maximum speed at which machine 
axes can move simultaneously in feed mode (e.g. G01). 

Optimize by Tables — When selected, optimizes based on specified feed rates for 
various cut depths, widths, and angles. This option is good for optimizing tools used in 
hogging or roughing operations where more control over cutting feed rates for various cut 
depths, widths, or angles is desired. Use the features on the Depth Table, Width Table, 
and Angle tabs to configure settings for this method. 
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Fill — Automatically fills table data fields with values calculated using the Cutting 
Condition sliders. The following values are supplied: 

Depth Table => defines five equally spaced cut depths based on cutter height and a 
cutting feed rate for each, based on volume of material removed. Also supplies the 
calculated volume removal rate for the value for Max.Volume Removal Rate. 

Width Table => calculates a percentage of calculated feed rate for each % Width 
value based on volume of material removed. 

 
 
To OptiPath window



VERICUT HELP – Project menu 
 

 

OptiPath window, Settings tab 
Location:  Project menu > Tools:     Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

 

Features on this tab specify important settings for the optimization process, such as: the 
OptiPath record units, when to add (interpolate) more cuts, resolution, 
minimum/maximum optimized feed rates, how to optimize circle and NURBS motions, 
and more. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

 

 
 

Modify Existing Cuts Only — When selected, this option calculates the most efficient 
feed rate for each motion. VERICUT uses the Resolution value (see below) to divide 
each motion into samples and calculates an optimum feed rate for each sample. The feed 
rate calculated for the sample with the most severe cutting conditions is retained as the 
optimized feed rate for that motion. This option is recommended when disk space is 
limited for storing optimized tool path data, or when tool positions are relatively close 
together. A tool path optimized with this choice has more efficient feed rates and the 
same or slightly more records than the original. 
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Sample optimization results using the Modify Existing Cuts Only option: 

 
 

Add More Cuts — Similar to Modify Existing Cuts Only except motions are divided 
up when cutting conditions warrant feed rate changes. A tool path optimized with this 
choice has very efficient feed rates, but many more records than the original. The 
Minimum Feedrate Change value (see below) controls the quantity of feed rates output 
to the optimized tool path file. This option is recommended when disk space is ample, or 
when optimizing widely varying cutting conditions, such as: intermittent cutting, deep 
versus shallow cuts, etc. 
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Sample optimization results using the Add More Cuts option: 

 
 

Inch / Millimeter options — Controls the unit measurement system in which 
optimization data is entered. If the OptiPath record units are different from the session 
units, the record values are converted appropriately when loaded. 

Resolution — Controls the frequency or "sampling distance" used to analyze each tool 
path motion. Each feed rate controlled motion is partitioned into samples based on this 
distance. The samples are then analyzed during feed rate calculation.  

Options: 
Distance — Uses the sampling distance in the corresponding data field. Distance is 
measured along the tool motion. Using a resolution equal to 1/2 to 1/4 of the tool 
diameter is recommended. 

Auto — Automatically calculates the resolution distance based on the size of the 
cutting tool relative to the displayed model. This choice is recommended when little 
or no knowledge of cutting methods or feed rates is available. 
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Example of Resolution applied when optimizing tool path motions: 

 
 

Minimum Feedrate Change — Specifies the minimum change from the current 
optimized feed rate that will cause a new optimized feed rate to be output. This feature 
controls the quantity of feed rates output to the optimized tool path file. A small value 
causes more optimized feed rates to be output than when a larger value is entered. 

Default option — When selected, sets the default Minimum Feedrate Change = 1 IPM or 
25 MMPM, whichever applies. 

Clean-up Feedrate — Feed rate used when the tool is adjacent to, but not removing 
material. This condition is commonly referred to as a "spring pass". 

Default option — When selected, sets the default clean-up feed rate as follows: 

G-code tool path => 50% of the Max Feed Velocity of the machine's X-axis. 

APT tool path => 50% of the Fast Feed value. 

 

Tip: Set the Clean-up Feedrate to be less than the Air Cut Feedrate, since actual 
cutting leaves small amounts of material from tool deflection. 

 
Circle Feedrate — Controls when and how feed rates are optimized for circular motions 
(e.g. G02-3). Circle feed rate optimization produces a single optimized feed rate for the 
entire circular motion regardless of the active Modify Existing Cuts Only or Add More 
Cuts option.  

Options: 
Programmed — Uses the original programmed feed rate. 

Fixed — Uses the feed rate in the corresponding data field. 

Optimize — Calculates an optimized feed rate based on the maximum material 
removed throughout the circular motion. 
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Break-up — OptiPath will attempt to break up circles only if both this option and the 
Add More Cuts option has been selected. 

For APT, only one output format is supported: 

CIRCLE/ xc, yc, zc, i, j, k, rad      - defines circle center, plane and radius 

GOTO/x,y,z,ijk                             - defines the ending point of the motion 

 

Circle feed rates are not optimized under the conditions listed below. These circles 
receive the original programmed feed rate. 

• helical (spiral) circle motions 

• circle motion where the tool axis is not perpendicular to the circle axis 

• G-code data circle motion programmed in inverse time feed rate mode (e.g. 
G93) 

 
Radius Control — When toggled On, OptiPath adjusts the feedrate for circular motions. 
During circle motions, OptiPath determines the maximum contact point away from the 
tool center line and adjusts the feed rate so the desired feed rate is achieved at that point. 
Radius Control is only available when Circle Feedrate is set to Optimize or Break-up. 

NOTE:  If the effective cutting radius, R, is bigger than the circle radius, r, OptiPath 
adjusts (lowers) the feedrate by the factor r/R which is < 1. If R is less than r (r/R > 1), no 
adjustment is done (OptiPath will not increase the feedrate calculated based on the tool 
center). 

NURBS Feedrate — Controls when and how to optimize NURBS motion feed rates 
(e.g. G06, G06.2). The active Modify Existing Cuts Only or Add More Cuts option 
does not affect feed rates calculated by this feature.  

Options: 
Programmed — Uses the original programmed feed rate. 

One Feedrate — Calculates the most efficient feed rate for NURBS motions. The 
feed rate calculated for the most severe cutting condition used as the optimized feed 
rate. 

Multi Feedrate — Calculates multiple feed rates for NURBS motions when cutting 
conditions warrant feed rate changes. 

Feedrate Wear Reduction — Reduces the calculated feed rate based on the amount of 
material that has been removed. The value entered is the percentage of reduction to be 
applied after each cubic unit of material removed. Zero indicates no adjustment for wear. 

Example: assume "Feedrate Wear Reduction=.2". The calculated feed rate is reduced 
.2% after each cubic unit of material has been removed. After five cubic units removed 
the calculated feed rate is reduced 1% (.2% x 5). 
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Minimum RPM Change — Specifies the minimum change from the current optimized 
spindle speed required to output a new spindle speed. This feature controls the quantity of 
spindle speed changes output to the optimized tool path file. Small Minimum RPM 
Change values, cause more spindle speed changes to be output than larger values.  

Tip: Start with a value such that only 3-4 changes can occur across the RPM range. 

Default option — When selected, sets the default minimum RPM change = 1000. 

 
 
To OptiPath window
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OptiPath window, Limits tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool            
component is highlighted) 

 

The features on this tab enable you to specify limits for cutting characteristics (feedrate, 
cut depth, volume removal rate, chip thickness, surface speed and RPM) for milling 
cutters and drills. It does not apply to turning tools. 

After configuring the features on this tab, be sure to review the other tabs in the 
OptiPath Manager window for proper optimization values. 

 

 
 

Minimum Cut Feedrate — Specifies the minimum optimized feed rates that can be 
output when removing material. 

Default option — When selected, sets the default minimum feed rate = 1 IPM or 25 
MMPM. 

Maximum Cut Feedrate — Specifies the maximum optimized feed rates that can be 
output when removing material. 

Default option — When selected, sets the default maximum feed rate as follows: 

G-Code tool path => 45% of the Max Feed Velocity of the machine's X-axis. 
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APT tool path => 45% of the Fast Feed value. 

Maximum Cut Depth — Specifies the maximum cut depth that can be output when 
removing material. 

Ignore — When selected, the Maximum Cut Depth limit is ignored. 

Maximum Volume Removal Rate — Specifies the maximum volume removal rate that 
can be output when removing material. 

Ignore — When selected, the Maximum Volume Removal Rate limit is ignored. 

Maximum Chip Thickness — Specifies the maximum chip thickness that can be output 
when removing material. 

Ignore — When selected, the Maximum Chip Thickness limit is ignored. 

Maximum Surface Speed — Specifies the maximum surface speed rate that can be 
output when removing material. 

Ignore — When selected, the Maximum Surface Speed limit is ignored. 

Minimum RPM — Specifies the minimum spindle speed that can be output during 
optimization. 

Default option — When selected, sets the default minimum RPM as follows: 

G-Code tool path => machine spindle minimum set by SpindleSpeedMin macro, 
if not set then 100 RPM. 

APT tool path => 100 RPM. 

Maximum RPM — Specifies the maximum spindle speed that can be output during 
optimization. 

Default option — When selected, sets the default maximum RPM as follows: 

G-Code tool path => machine spindle maximum set by SpindleSpeedMax macro, 
if not set then 20000 RPM. 

APT tool path => 20000 RPM. 

 
 
To OptiPath window
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OptiPath window, Hard Material tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

Features on this tab enable you to specify feedrate adjustment factors for special cutting 
conditions encountered during the optimization process 

Feedrates may need to be adjusted (typically slower than what OptiPath would normally 
calculate) based on the following 'hostile' conditions when cutting hard materials. 

These hostile conditions generally occur when cutting hard or difficult to machine 
materials such as tool steel, stainless steel, and high temperature alloys. Since there is no 
good scientific or empirical information to apply to these hostile conditions, the 
following features enable you to adjust the feed rates under each of these Hard Material 
conditions. 

After configuring the features on this tab, be sure to review the other tabs in the 
OptiPath Manager window for proper optimization values. 

 

 
 

Each feature consists of a checkbox to toggle the feature On/Off, and a numeric field 
enabling you to enter a factor to be applied to the calculated feed rate for each of these 
conditions. The number represents a percentage of the calculated feed rate.  
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When a feature is toggled "On", the factor is applied to the calculated feedrate each time 
that the particular condition is detected. 

Since these cutting conditions are not mutually exclusive, any combination (or all) of the 
features can be toggled "On" at the same time and any, or all, of the factors may be 
applied to the same calculated feed rate as appropriate for the cutting conditions. 

 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values.  

 

Adjust Feedrate for Non-Climb Cut —  
Non-Climb, or "Conventional", cutting occurs when the cutter tooth enters material close 
to parallel to the direction of motion. See the following diagram: 

 
The cutting condition worsens as the tooth entry angle decreases. When the tooth entry 
angle is near zero the cutting edge contacts material parallel to the direction of motion 
and requires excessive force to push the edge into material. The tooth finally enters 
material when pressure between the cutter and material increases and the tooth rotates 
past the tangent contact.  

The picture below shows the worst condition. 
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Adjust Feedrate for Thin Radial Width Cut — 
A thin radial width cut, typically only has one tooth engaged in material. When the width 
of material becomes so small that only one tooth of the cutter is engaged, the tool is no 
longer well supported and an otherwise reasonable feed rate becomes too aggressive. As 
the spindle spins the tool transitions between a tooth engaged and cutting, and no tooth 
engaged, causing the tooth to "bang" into material each time it enters. This "banging" 
causes premature cutting edge breakdown and reduces tool life. 

Determining the number of teeth engaged depends on the number of teeth in the cutter, 
the material contact axial depth, the width and location of the contact, and the flute helix 
angle. 

 
 

 

Adjust Feedrate for Side-Loaded Cut — 
A side-loaded cut, is a condition where material is exclusively on the "climb" side of the 
cutter 

When the tool is cutting with all material on the right of the tool center (for a clockwise 
rotating spindle), the cutting pressure forces the tool to deflect in the opposite direction. 
The deflection seriously affects cutting performance, increases cutting forces, and causes 
premature edge breakdown. 

 

 

To OptiPath window 
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OptiPath window, Plunge tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

The features on this tab control the optimized feed rate for motions along the tool axis 
that plunge into or retract from material. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

 

 
 

Plunge Feedrate — Controls when and how feed rates are calculated for plunging along 
the tool axis into material.  

Options: 
Off — Disable plunge feed rate control. 

Feed/Minute — Uses the feed rate entered in the corresponding data field. 

% of Prog. — Adjusts programmed feed rates based on the percentage entered in the 
corresponding data field. 100% uses the programmed feed rate as is, 50% cuts the 
feed rate in half, etc. 
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NOTE:  Plunge Feedrate overrides Angle table feed rate for 90 degree cutting angle 
(plunge motion), or the Entry Feedrate for entry on plunge motions. 

 

Clearance Distance — Specifies the distance from material to instate the feed rate for 
plunging. 

Retract Feedrate — Controls when and how the feed rates are calculated for retracting 
along the tool axis away from material.  

Options: 
Off — Disable retract feed rate control. 

Feed/Minute — Uses the feed rate entered in the corresponding data field. 

% of Prog. — Adjusts the programmed feed rate based on the percentage entered in 
the corresponding data field. 100% uses the programmed feed rate as is, 50% cuts 
feed rate in half, etc. 

NOTE:  Retract Feedrate overrides Angle table feedrate for -90 degree cutting angle 
(retract motion). 

 
 
To OptiPath window
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OptiPath window, Entry/Exit tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

The features on this tab control the optimized feed rate for entering and exiting material. 
The feed rate takes affect at a specified distance from material contact and remains in 
affect until the tool has cut a specified distance into material, or the entry motion ends. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

 

 
 
Entry Feedrate — Use to specify when, and how, feed rates are calculated for entering 
material.  

Options: 
Off — Turns off Entry (or Exit) Feedrate calculation and application during 
optimization. 

Feed/Minute — Uses the feed rate entered in the corresponding data field. 
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% of Prog. — Adjusts the programmed feed rate based on the percentage entered in 
the corresponding data field. 100% uses the programmed feed rate as is, 50% cuts 
feed rate in half, etc. 

% of Calc. — Similar to % of Prog., except adjusts the calculated feed rate. 

 

Clearance Distance — Use to specify the distance before entering material to start 
applying the specified Entry Feedrate. 

Cut Distance — Use to specify the distance to cut into material, using the Entry 
Feedrate, before normal feed rate optimization resumes. 

 

Effect of Entry Feedrate applied on a motion entering material: 

 

 
 

NOTES: 
1. When entry motions are optimized with the Modify Existing Cuts Only option, 

calculated entry feed rates are considered among other cutting conditions to 
determine the appropriate feed rate for motions which enter material. 

2. Plunge Feedrate overrides entry controlled feed rate for entry on plunge motion. 

 

Exit Feedrate — Use to specify when, and how,  feed rates are calculated for exiting 
material. Options are same as described above for Entry Feedrate. 

Clearance Distance — Specifies the distance before breaking out of material to start 
using the Exit Feedrate. 
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Cut Distance — Specifies the distance after breaking free from material to continue 
using the Exit Feedrate, after which the Air Cut Feedrate begins. 
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Effect of Exit Feedrate applied on a motion exiting material: 

 
 
 
 
 
To OptiPath window

Key to feedrates shown below: 

Optimized 
Exit Feedrate
Air Cut 

     Cut Distance 
Clearance Distance 
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OptiPath window, Angle tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

The features on this tab adjust the optimized feed rate for 3-axis linear cuts ramping in 
material. While these features are normally used to reduce the feed rate for ramping 
downward, they can also be used to affect feed rates for upward ramping motions. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

 

 
 

Adjust Feedrate for Entry Angle — When active, adjusts feed rates for ramping 
motions based on the table configuration. 

Angle table — Table of cut angles and corresponding % feed rate adjustments to apply 
when the tool ramps into material. Values can be entered or supplied via dragging the 
control points on the graph. Add after, or delete table entries via right-clicking on them 
and choosing the appropriate option (or use the Add / Delete buttons below the table). 
Cuts at angles less than the minimum listed in the table receive the adjustment specified 
for the minimum angle. Similarly, when the maximum specified cut angle is exceeded, 
the adjustment specified for the maximum angle is used. 
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Angle column — Lists up to five cut angles (in descending order) that describe the range 
of expected cut angles to adjust. Values can be from -90 to 90, where "0" represents 
horizontal milling, "90" represents plunge motion along the tool axis, and "-90" 
represents retract motion. 

% Feedrate column — Lists % feed rate adjustments to apply to calculated feed rates 
when ramping in material at the corresponding angle. 100% uses the calculated feed rate 
as is, 50% cuts feed rate in half, etc. 

 

Sample Angle table: 

 
 

NOTES:  
1. Angle adjusted feedrate for 90 degree cutting angle is overridden by Plunge 

Feedrate if active. 

2. Planar milling motions (0 degree angle) are not adjusted. 

 
 
 
To OptiPath window
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OptiPath window, Depth Table tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

The features on this tab controls how optimized feed rates are calculated for cutting at 
various depths during Optimize by Tables optimization. The calculated feed rate can be 
used as calculated, or adjusted using the Angle and/or Width tables, as well as features 
on other tabs in this window. 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

 

 
 

Feedrate value type option list — Controls the how to interpret the feed rates in the 
Depth table.  

Options: 
Feed/Minute — Calculates optimized feed rates based on absolute feed rates 
specified for various cut depths. Specify feed in units specified on the Settings tab. 
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% of Prog. — Calculates optimized feed rates based on percentages of programmed 
feed rates specified for various cut depths. "100" uses the programmed feed rate as is, 
"50" cuts the feed rate in half, etc. 

Feed/Tooth — Calculates optimized feed rates based on feed per tooth, or chip load 
specified for various cut depths. Specify feed per tooth in units used by the tool path 
file (IPR or MMPR). 

Depth table — Table of cut depths and corresponding feed rates to apply when cutting at 
a specified depth. Values can be entered or supplied via dragging the control points on 
the graph. Add after, or delete table entries via right-clicking on them and choosing the 
appropriate option (or use the Add / Delete buttons below the table). Cuts at depths less 
than the minimum listed depth in the table receive the feed rate specified for the 
minimum depth. 

Depth column — Lists up to five cut depths (in descending order) that describe the range 
of cutting by the tool. 

Feedrate column — Lists feed rates to apply when the tool is cutting at the 
corresponding depths. Feed rate values are interpreted differently based on the active 
feed rate value type option (see "Feedrate value type option list" above). 

 

Sample Depth table: 

 
  

Tip: Un-select all optimization methods and use the Cutting Condition sliders to 
determine appropriate feeds and speeds for a known successful cutting condition, then 
select Optimize by Tables and press Fill to automatically enter Depth Table values. 

  

Feedrate Control Options — Controls when and how volume removal rate is 
considered in feed rate calculations during optimization by tables.  

Options: 
Off — Disable volume removal rate considerations. 
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Const. Volume Below Min. Depth — Specifies a constant volume of material is to 
be removed when the depth of cut is less than the lowest Depth table entry. The 
volume removal rate is expressed in cubic units, where “units” refers to the units 
specified on the Settings tab. If unknown, un-select all optimization methods and use 
the Cutting Condition sliders to calculate it. 

The example below shows the affect of Constant Volume Below Minimum Depth 
on feed rate calculations for a ball-nose endmill when the lowest Depth Table entry is 
equal to the radius of the tool. 

  

 
  

Max. Volume Removal Rate — Specifies the maximum volume removal for the 
tool. Optimized feed rates are bounded such that the rate at which material is removed 
never exceeds this value. The volume removal rate is expressed in cubic units, where 
"units" refers to the units specified on the Settings tab. If unknown, un-select all 
optimization methods and use the Cutting Condition sliders to calculate it. 

 
 
 
To OptiPath window



VERICUT HELP – Project menu 
 

 

OptiPath window, Width Table tab 
Location: Project menu > Tools:      Add menu > OptiPath > New, or  

Edit menu > Modify (when an OptiPath tool 
component is highlighted) 

  

The features on this tab adjust the optimized feed rate for cuts that are less than full cutter 
width during Optimize by Tables optimization. When the tool is cutting with less than 
full diameter the feed rate can typically be higher than for a full width cut, also know as a 
"slot cut". 

After configuring the features on this tab, be sure to review the other tabs in the OptiPath 
Manager window for proper optimization values. 

 

 
 

On — When selected, adjusts feed rates for cuts of varying width based on the Width 
table configuration. 

Width table — Table of cut widths and corresponding % feed rate adjustments to apply 
when removing material with the specified cutter width. Values can be entered or 
supplied via dragging the control points on the graph. Add after, or delete table entries 
via right-clicking on them and choosing the appropriate option (or use the Add / Delete 
buttons below the table). Cuts at widths less than the minimum listed in the table receive 
the adjustment specified for the minimum width. 
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% Width column — Lists up to five cut widths (in increasing order) that describe 
the range of expected cut widths to adjust.  

% Feedrate column — Lists % feed rate adjustments to apply to calculated feed 
rates when removing material with the corresponding cut width. 100% uses the 
calculated feed rate as is, 50% cuts feed rate in half, etc. 

 

Sample Width table: 

 
 
 
 
To OptiPath window
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Search OptiPath Record window 
Location: Project menu > Tools:      Add menu > OptiPath > Find Existing or  

Edit menu > Search OptiPath  
  

Search OptiPath Record enables you to search existing tool/OptiPath libraries for records 
with specific attributes. 

  

 
  

Libraries: 
Files — Use to specify one, or more, tool/OptiPath library files to be searched for 
OptiPath Records meeting the specified search criteria.  

Directories — Use to specify one, or more, directories of tool/OptiPath library files for 
OptiPath records meeting the specified search criteria. 

Browse — Displays a file selection window to assist you in selecting the files/directories 
to be searched.  

NOTE:  By default, if no library file(s)/directories are specified, VERICUT searches the 
"current" Tool Library file. 

  

Search Attributes: 
Description — Search for existing OptiPath records containing a specified string of text 
within the record's Description field. 
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Material — Search for existing OptiPath records containing a specific material type. 

Machine — Search for existing OptiPath records containing a specific machine type. 

  

Search — Start the search of the specified library files/directories, based on the search 
attributes specified above. OptiPath records found matching the search attributes are 
written to the OptiPath Record List. 

Show All — Displays all OptiPath records found in the specified library 
file(s)/directories in the OptiPath Record List. 

  

OptiPath Record List: 
Displays a list of Optipath records found during the search. For each record in the list, the 
Material, the Machine description, and the tool Description, are displayed. The Tool 
Referenced column is only used for  OptiPath records in the "current" tool library. 

  

Add/Modify — Opens the OptiPath window, populated with the data from the selected 
OptiPath record, ready for modifying. If no changes are required, select Add in the 
Optipath window to add the OptiPath record to the "current" tool library. 

Reference — Creates a reference to the selected OptiPath record in the "current" tool 
library. This feature is grayed out for OptiPath records in external files. 

Delete — Enables you to delete the selected OptiPath record in the "current" tool library. 
This feature is grayed out for OptiPath records in external files.  

Close — Closes the Search OptiPath Record window. 
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Processing Options 

Activate 
Location: Project menu > Processing Options > Activate 

  

Activate enables you to set the state of the current setup to active/inactive. An active state 
is indicated by a check mark. 
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Motion window 
  

VERICUT Users: 
VERICUT Location: Project menu > Processing Options > Motion 

VERICUT toolbar short cut:   

  

Mold and Die Users: 
Mold and Die Location:   Advanced Options page > Simulation Settings 

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Advanced Options page > Simulation Settings 

Notebook Feature:      

 

Opens a window used to control the simulation of tool path and machine motions. 
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Start At/Stop At group: 
Start At — Specifies the line, or tool path record at which cutting simulation starts. 
VERICUT fast forwards from the beginning of the NC program to the specified 
line/record while internally processing intermediate tool path records to store values for 
the current feed rate, spindle speed, coolant, tool description, and tool location.  

Options are:  
Beginning — Start processing at the beginning of the first file. 

Line Number — Start processing at the specified line number of selected toolpath 
file. 

NOTE:  A list of all NC programs and job subroutine files defined for the current 
job will display enabling you to select the toolpath file. 

Line Number (Directly) — Start processing at the specified line number without 
internally processing intermediate tool path records. This line number only applies to 
the first toolpath (or the first active toolpath if Use Selected Files, in the Project 
>NC Program window, is being used to select only specific toolpath files from the 
list for VERICUT processing). 

Text — Start processing on the line that contains the specified text. 

Tool ID — Start processing when the specified tool is loaded. 

 

Stop At — Provides options for stopping tool path processing. When applicable, enter 
supporting "stop at" text or values in the field next to this feature. Text entered is not case 
sensitive. 

End — Stop processing at the end of the last toolpath file. 

Num of Cuts — Stop processing after the specified number of cuts. 

Line Number — Stop processing at the specified line number of the selected 
toolpath file. 

NOTE:  A list of all toolpath and job subroutine files defined for the current job will 
display enabling you to select the toolpath file. 

Text — Stop processing on the line that contains the specified text. 

Tool Change — Stop processing when a tool change occurs. 

Program Stop — Stop processing when a "program stop" record is encountered in 
the tool path. Examples of such records include: M0 (G-Code tool paths) or STOP. 

Optional Stop — Stop processing when an "optional stop" record is encountered in 
the tool path. Examples of such records include: M1 (G-Code tool paths) or OPSTOP. 

End of each File — Stop processing at the end of each toolpath file. 

End of each Setup — Stop processing at the end of each setup. 
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Stop At Max Errors / Stop At Max Warnings — Number of errors (or warnings) 
which, if detected, stops tool path processing. Toggle "On" and specify the Max 
Error/Max Warning value. 

 
  
Motion group: 
Fast Feed — Feed rate threshold at which material removal is unsafe (likely to cause tool 
breakage, machine malfunction, or part damage). For example, if the maximum feedrate 
allowed is 180, Fast Feed should be set to 181 or greater. Material removed under these 
conditions is shaded in the Error color (typically red) and causes a "Fast feed rate" error. 

 

 
 

No Animation — Enables you to reduce processing time. When toggled "On", the 
graphics display is not updated until either processing is complete or you Stop the 
processing. At that time the cut model is displayed in it "final" state or the state that it 
was in when processing was stopped. You can also toggle No Animation On/Off using 

the No Animation icon, , in the VERICUT toolbar. 
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Skip Cut — Quantity of animated tool motions to skip before updating the display. Enter 
"0" to display each tool motion. Skipping cuts increases animation speed since the 
display is not constantly updated. The cut model is unaffected. 

Tool Spindle Always On — When toggled On, VERICUT will assume that the spindle 
is always on and will not check for spindle status (on/off) or output error messages 
related to cutting with the spindle off. 

Drill Cycle — Controls when and how to simulate canned tool axis cycles (e.g. G8n, 
"CYCLE"). While VERICUT simulates most popular cycle motions, there are also 
capabilities to add more and change how existing cycles are interpreted. See "About 
configuring for cycle simulation" in the Using VERICUT section for more information. 
Using VERICUT can be found in the CGTech Help Library. 

Options: 
Ignore — Ignores cycle motions- the tool moves to each cycle position without 
performing cycle motions. 

Bottom Only — Simulates cycle motions for a hole with one full depth motion- 
pecking or chip-breaking motions are not simulated. 

Full Motion — Simulates all cycle motions, including pecking or chip-breaking 
motions. 

NOTE:  When the "Bottom Only" or "Ignore" options are used, certain motions 
(and checks) are ignored.  This means that there will be no RAPID checks, no 
material removal, no limit checks, no collision checks, no redraws, etc. Because of it's 
importance, checks related to "RAPID to the R-plane" motions are included when 
 "Bottom Only" is selected, but not when "Ignore" is selected. 

 

Need help troubleshooting cycle motion errors?    For assistance with diagnosing error 
messages and conditions, visit the VERICUT Users’ Forum or contact CGTech technical 
support via our website, just click on the support link. 

Check Spindle Direction — When toggled On, VERICUT check for spindle direction 
against the "valid" direction of the tool.  

For turning tools, "valid" direction is based on the turning tool orientation. Spindle 
direction, (CW or CCW), is determined looking down the Z-axis of the spindle. It is 
assumed that revolving stock material should come onto the insert in the direction of 
positive Y-axis of the tool component. If spindle direction is wrong, or spindle speed is 
not defined, an error is reported to VERICUT logger. Only one error per spindle is 
reported for each operation turning the spindle On or Off. 

The error is reported only if turning tool removes material from stock. For air moves, no 
errors are reported. Also, if an insert removes material in a motion that crosses the 
spindle Z-axis, no error is reported (in this case, one part of the insert is always on the 
correct side, while the other part is on the wrong side, therefore there is no preferable 
spindle direction). 

http://cgtech.com/forum/
http://cgtech.com/
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For milling tools, the direction of the tool spindle (either spindle component or tool 
component attribute) is checked with the "valid" direction of the tool in the spindle. Tool 
spindle direction (CW / CCW) is defined looking down (negative Z) the tool axis. For 
revolved milling cutters, "valid" direction is based on the setting of Spindle Direction 
(clockwise or counterclockwise) in the tool definition. For inserted milling cutters, 
"valid" direction is based on the insert thickness direction. 

If the direction of the spindle does not match the direction of the tool, then an error is 
reported whenever the tool removes material. The tool removes material in the error color 
(similar to the behavior for turning spindle direction error). The check is done and the 
error reported only when the tool removes material. Motion that does not remove material 
does not report an error.  

The check is done for G-Code only. 

Min. Motion Dist. / Max. Motion Dist. — Enables you to specify a minimum and 
maximum value, defining the range of the Animation Speed slider. The animation speed 
is interpolated between these two values. 

Check Cutting Limits — Toggle On, to have VERICUT do the cutting limit checks 
during simulation. Cutting limit values are set in the OptiPath window, Settings tab.  

FastMill — Toggle "On" to process the toolpath in FastMill mode. You can also use the 

FastMill icon , in the Toolbar to turn on FastMill mode. 

 

NOTES:  
1. FastMill: 

• does "fixed axis" material removal in any tool orientation. 

• does not do "undercuts". FastMill automatically switches to standard material 
removal when required. 

• can be turned On/Off at any time.  

• can be used with/without tool animation. Toggle No Animation, described 
above, "On" for fastest processing. 

• is compatible with OptiPath, AUTO-DIFF, Model Export, as well as X-
Caliper and any other feature that uses the cut model database. 

2. FastMill is not effective when: 

• The tool axis changes frequently. 

• The cutter "undercuts", such as when using a dovetail or wheel cutter. 

• Cutter height is less than the cut depth resulting in an undercut condition.  

3. Replace Material When Stepping Back (ref. Replace Material When Stepping 
Back, on the Properties window: General tab, in the File menu section, also in the 
VERICUT Help section) and FastMill mode are mutually exclusive. 
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When Replace Material When Stepping Back is toggled "On", VERICUT will 
turn FastMill "Off" Conversely, if FastMill is toggled "On", VERICUT will turn 
Replace Material When Stepping Back "Off. VERICUT will display a pop-up 
notification when these situations occur.  

 

Ignore Undercuts — Works in conjunction with FastMill, described above. When 
toggled "On" (default), VERICUT does not check each motion for "undercut" conditions 
allowing for faster processing in those cases where you are sure that there are no 
"undercut" conditions in the toolpath. Toggle "Off" when you want VERICUT to check 
for "undercut" conditions as it processes each motion. 

NOTE:  This feature is only active when FastMill is toggled "On". 

TIP:   Place the cursor over the text field, pull-down menu, or checkbox, for any of the 
options in the Motion Group to see a summary of its function. 

  
 
Tool group: 
Tool Display — Controls when and how the tool is displayed. Options are: Off (do not 
display the tool), Solid, or Translucent. Material removal is not affected by this choice. 

Min. Cutter Height — Default height used when the current tool description does not 
specify height, or when specified height is less than this value. Affects milling cutters 
only. 

Control Point — Controls how milling tools are driven. By default, VERICUT drives 
the tool tip. Material is removed based on tool path motion commands and the tool shape, 
relative to the control point.  

Options: 
Tool Tip — Point located at the bottom-center of the cutter. 

Corner Radius — Point located a distance equal to the cutter corner radius up from 
the tool tip. With ball nose endmills, this point is commonly referred to as the "ball 
center". 
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NOTES:  

1. If Corner Radius is used with non-ball nosed endmills, the offset is calculated 
along the tool axis, from the tool tip to the center of the first arc encountered in 
the tool profile. 

2. To specify a milling tool control point other the tool tip of corner radius, define 
tools via the Tool Manager and specify a control point offset via the tool's 
Properties. 

3. This feature is not applicable to turning tools. Instead, define tools via the Tool 
Manager and specify a control point offset via tool Properties. 

 
Display Holders in Workpiece View — When toggled "On", instructs VERICUT to 
display defined tool holders and detect collisions they may have. Holders are non-modal 
and are applied only to the active cutter. An error similar to "HOLDER "Holder2" of the 
tool "1" collided..." is output for tool holder collisions, the Collision status light displays 
red, and the collision area is shaded using the red Error color in the graphics area.  
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Calculate Min. Cutter Extension — When active, calculates the minimum height 
required to avoid shank/holder collisions with the stock and all fixtures in a Workpiece 
view, for both standard VERICUT, and FastMill mode. 

When toggled on, all holders move down to the bottom of the cutter. The first holder and 
any holders above it are processed independently, so one sees both the first and 
subsequent holders move down to the same location and the cutter will not be seen. As 
cutting starts, the holders move up as needed to avoid a collision with stock. 

If potential holder collisions are detected during the simulation, VERICUT extends the 
cutter to avoid the collision and adds this amount to the calculated height. The calculated 
extension amount is automatically applied to the existing Gage Point Z value. 

Note that when these calculations are being performed, tool holder collisions are not 
reported since VERICUT extends the cutter to avoid the collision.  

If desired, you can include additional clearance in the calculation via specifying Holder 
Clearance (see below). The final calculated height for each tool is displayed in the Log 
file Tool Summary section under the "Min" column heading. 

Holder Clearance — Specifies clearance to add when calculating minimum cutter 
extension (see above). The clearance value is also included in the Log file minimum 
height values. 
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NOTE:  This feature is only active when Calculate Min. Cutter Extension is toggled 
"On". 

OK — Applies the changes and closes the Motion window. 

Apply — Applies the changes and leaves the Motion window open. 

Cancel — Closes the Motion window without applying changes. 
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G-Code (G-Code Settings window) 
 
VERICUT Users: 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:  

 

Mold and Die Users: 
Mold and Die Location:   Advanced Options page > Job Settings 

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Advanced Options page > Job Settings 

Notebook Feature:      

  
Opens a window to configure settings to support processing G-Code NC program files. 
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Settings tab — Features on this tab provide important settings for G-Code simulation, 
such as: the G-Code programming method, when cutter compensation (CDC) codes are 
processed, tool path scanning, and tolerances used for simulating rotary motions. 

Collision Detect tab — Features on this tab control when collisions between machine 
components are detected, which components are protected, and tolerances used for 
detecting collisions. 

Travel Limits tab — Features on this tab define how far each machine axis can go, and 
control when travel limit errors are detected. 

Tables tab — Features on this tab are used to specify work offsets and machine locations 
specific to the current tool path file(s) and to store tool-related offset and compensation 
register data. 

Subroutines tab — The features on this tab are used to specify names of external files 
containing subroutines that can be accessed by VERICUT. 

Block Skip tab — Features on this tab control which levels of block skipping are 
recognized, and specify the block skip character. 

Sync tab — The features on this tab enable you to select which Sync Sub-system is to be 
used. This setting is only applicable if Sync Method on the Control Settings window, 
Sync tab is set to something other then None. This feature is intended as a debugging tool 
enabling you to easily select which sync program they want to run rather then running 
them together at the same time. 

WireEDM tab — Features on this tab configure VERICUT for wire EDM simulations. 

 

OK — Applies the changes and closes the G-Code Settings window. 

Apply — Applies the changes and leaves the G-Code Settings window open. 

Cancel — Closes the G-Code Settings window without applying changes. 
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G-Code Settings window, Settings tab 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:  

 

Features on the Settings tab provide important settings for G-Code simulation, such as: 
the G-Code programming method, when cutter compensation (CDC) codes are processed, 
tool path scanning, and tolerances used for simulating rotary motions. 

 

 
 

Programming Method — Describes the relationship between cutting tools and what is 
being driven by tool path file motion commands. (Take care NOT to describe the 
relationship between cutting tools and the driven point controlled by a CAM system.) 
Options: 

Tool Tip — XYZ values represent tool tip positions (center of the tool tip) at all 
times. 

NOTE:  Tool length compensation codes (G43ZnHn/G49) do not appear in tool tip 
programmed tool paths. If these codes are present, use the Tool Length 
Compensation programming method. 

Gage Length — XYZ values represent gage point positions. The gage point is 
typically the spindle face, where the centerline of the tool intersects the machine gage 
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line. Gage length values must be supplied using Gage Offset in Tool Manager, or 
via entries in a Gage Offset table. 

Tool Length Compensation — With comp. active (e.g. G43ZnHn) XYZ values 
represent tool tip positions relative to program zero. With comp. cancelled XYZ 
values represent machine gage point positions relative to machine zero. Use an Input 
Program Zero table to describe where the part zero is. VERICUT automatically 
calculates "H" offset values, or enters values in a Tool Length Compensation table. 
For proper tool loading on a 3-D machine supply gage offset values as described 
above for Gage Length programming method. 

 

 
 

Process Cutter Comp. — When active, applies cutter compensation, or "CDC" offsets 
to the programmed tool path. Enter CDC offset values in a Cutter compensation table, 
as described under Cutter Compensation Table in the Tables for Processing G-Codes 
section in the CGTech Help Library. Output Precision (refer to Control Settings 
window: Motion tab for more information) is used to specify the accuracy for 
calculating CDC offset tool positions. 

Options: 
Off — Ignore CDC related codes in the NC program file.  

On – Default to Zero — Process CDC related codes in the NC program file. Default 
to zero if no Cutter compensation value is specified. 

On – Default to Full Radius — Process CDC related codes in the NC program file. 
Default to the full tool radius value if no cutter compensation value is specified. 

NOTE:  Tool paths can not be optimized when CDC offsets are being simulated. 
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Scan NC Program Files — When active, performs a "scan pass" on NC program files to 
identify jump destinations for looping-branching logic. Tool paths with this type of logic 
must be scanned for proper simulation in VERICUT. 

Ignore Data after Column — When toggled "On", specifies the G-Code data column 
number to begin ignoring remaining data in the block. Use this feature when unmarked 
comments are permitted in designated columns of the G-Code data. Enter the number of 
the last valid G-Code data column in the text field next to this feature. 

Apply Acceleration to Cycle Time — When toggled "On", uses the Accel/Decel 
parameters, as set on the Modeling window: Component Attributes tab (ref. Modeling 
window: Component Attributes tab, also in the VERICUT Help section) when 
calculating the Time displayed in the Status window. 

Initialize Machine/Control between NC Programs — Enables you to specify whether 
or not to reset the control's states, variables, etc. between NC program files during 
processing. When toggled "On" (the default), VERICUT resets these values between NC 
program files. This condition is consistent with prior releases. Toggle "Off" to retain 
these values between NC program files.    

Rotary Feed Motion Tol — Tolerance used to calculate intermediate tool positions 
resulting from processing rotary motion when Output Intermediate Points is active (ref. 
Configuration menu > Control Settings: Rotary tab). Decreasing this value increases 
the quantity of intermediate points calculated, and decreases simulation speed. 

Rotary Rapid Motion Tol — Similar to Rotary Feed Motion Tol, except applies to 
rapid rotary motions. 

 

Machine Simulation On — When toggled "On", simulates machine tool motions when a 
3-D machine is displayed in a machine view.  

Shortcut: You can quickly toggle Machine Simulation On, "On" or "Off" by clicking 

on the No Machine Simulation icon  in the toolbar. 

 
Floor/Wall Orient Up — Use to specify which way is "up" (towards the ceiling) for a 
machine when a machine view displays walls in the background. (Ref. View menu > 
Attributes: Background). The up direction is relative to the machine origin. Select the 
appropriate axis direction from the pull-down list. 
 
 
To G-Code Settings window 
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G-Code Settings window, Collision Detect tab 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:  

 

Features on this tab control when collisions between machine components are detected, 
which components are protected, and tolerances used for detecting collisions. 

 

 
 

Colliding components are highlighted using the red Error color, and errors are issued to 
the Log file identifying collision causing block(s) and machine components. 
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Collision Detection — When toggled "On", detects collisions between specified 
components. 

Ignore Collision between Cutter and Stock — Controls when collisions between the 
cutter and the Stock component are ignored. This feature is useful when collision 
detection is desired between the stock and shank or holder portions of the tool assembly 
in the machine view, but not with the cutter.  

Options are: 
No — (default) Does not ignore cutter-stock collisions. All collisions are reported. 

All Tools — Ignores cutter-stock collisions for all tools, even inactive tools in multi-
tool machines. 

Active Tool — Ignores cutter-stock collisions for the active tool. However, collisions 
between stock and inactive tools are detected. 

Default Near Miss — Specifies the default collision tolerance applied to all collision 
cases when Set All is pressed (see below). 

Set All — Sets the default collision tolerance for all collision cases to the Default Near 
Miss value. You can edit the supplied tolerance for individual cases. 

 

Component/Component collision list 
Lists the component-to-component collision cases that are checked when collision 
detection is turned on. 

NOTE:  Records displayed in pink come from the machine file and can not be edited. 
Records displayed in white are part of the setup and can be edited.  

Component1/Component 2 — These features are used to specify the component-to-
component collision cases to check. The Near Miss value controls how close the 
components are permitted to be before reporting a collision. Clicking on a component 
field in a record displays a pull-down list of component to choose from. 

NOTE:  Do not configure for collision detection between components that move 
(slide or rotate) against each other, such as connected motion axes. In these cases, 
errors may occur each time the components move. 

Sub-Components — Toggle On/Off to include Sub-Components of 
Component1/Component2 during collision checking. 

Near Miss — Specifies the tolerance to use for collision checking. Enter a positive 
value to be alerted if components come near each other within the specified clearance, 
zero to indicate components may not touch, or a negative value if components are 
expected to collide by the specified value.  

NOTE:  "Near Miss" tolerances are not supported for collision checking against the 
cut model. The accuracy of collisions with the cut stock is dependent on the "Cutting 
Tolerance". 
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Add — Adds a new collision case record to the list. The new record is added after the 
highlighted record. 

Delete — Deletes the selected collision case record from the list. Records displayed in 
pink come from the machine file and can not be deleted. 

 

Shortcut:  You can right-click in the Component/Component collision list to display a 
menu containing Add and Delete. These provide the same functionality described above. 
 
 
 
To G-Code Settings window



VERICUT HELP – Project menu 
 

 

G-Code Settings window, Travel Limits tab 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:  

 

Features on this tab define how far each machine axis can go, and control when travel 
limit errors are detected. 

 

 
 

Overtravel errors cause the violating machine component to "light up" in the Overtravel 
Color and errors are output to the Log file identifying the problem component. 
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Log Error for Over Travel — When active, turns on overtravel detection (travel limit 
checking). Components that move beyond specified limits are highlighted in the 
Overtravel Color and errors are issued to the Log file identifying error causing block(s) 
and machine components. 

Allow Motion Beyond Limit — When toggled "On", axes are allowed to freely travel 
beyond defined limits. When toggled "Off", an axis is never allowed to travel beyond the 
defined limit. 

Overtravel Color — Use to specify the color in which components that move past their 
specified limits are shaded. Available shade colors are defined on the Edit menu > 
Colors: Define tab. 

 

Travel Limit Record Table 
List of travel limit records in which each record consist of a group number, motion 
component (and its axis limits), travel limit condition and an ignore switch. These records 
come from the machine file and can not be edited. 

 

Group — Indicates the travel limits record group that is currently active A specific group 
is of travel limit records is activated by using the TravelLimitsGroup macro. For 
information on the TravelLimitsGroup macro, and all VERICUT macros, see VERICUT 
Macros in the CGTech Help Library. 

Component —  Indicates a motion component for travel limit checking. 

Minimum / Maximum — Indicates the minimum, and maximum, travel limits for the 
motion axis specified in the record. 

The next three columns in the Travel Limit Record Table indicate conditions when the 
travel limit record is used. The condition can be set to "OFF" indicating no special 
condition for this record or set to a motion component on the machine.  

When a motion component is specified, then the travel limit record is used if the axis of 
the conditional component is within the conditional minimum and maximum limit values. 

Component (C) —  Indicates a condition when the travel limit record is used. It is set to 
"OFF" to indicate no special condition for this record, or to a conditional motion 
component on the machine. 

Minimum (C) / Maximum (C) — Indicates the minimum, and maximum, travel limits 
for the conditional motion component (Component (C)) that will cause the travel limit 
record to be used. 

Ignore — When toggled "On", over travel checking is ignored for the corresponding 
axis. 

 
 
 
To G-Code Settings window
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G-Code Settings window, Tables tab 
 VERICUT Location: Project menu > Processing Options > G-Code > Settings 

 VERICUT toolbar short cut:   

  

Features on the Tables tab are used to specify "Job Tables" to store work offsets and 
machine locations specific to the current tool path file(s) and "Tool Tables" to store tool-
related offset and compensation data. 

NOTE:  The values set in a "Job Table" are used to override "standard" values that 
were set in a Machine Table for the current NC program file(s). 

  

 
  

Tables list — A list of tables that are currently defined. The Machine Settings tables list 
will contain only "machine" tables. The G-Code Settings tables list will contain both 
"job" tables and "tool" tables. 

Add/Modify — Use to access the Add/Modify Tables window enabling you to add 
additional tables or modify existing tables. To Add a table, simply click on Add/Modify. 
To modify an existing table, select the table to be modified from the Tables list and click 
on Add/Modify. (You can also "double-click" on the table in the Tables list.) 
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Delete — Deletes the selected table entry from the Tables list. If it is the last entry for a 
particular table, then the table is also deleted. 

  

Job Table and Tool Table values are stored in the Project file. 

The following Job Tables can be added or modified with the G-Code Settings window, 
Tables tab: 

 

Base Work Offset 
Initial Machine Location 
Machine Zero             (obsolete, formerly Input Machine Zero) 
Machine Reference Location 
Tool Change Location 
Tool Change Retraction 
Turret Rotations 
Work Offsets 
Program Zero 
Input Program Zero (Special Z)              (formerly Input Program Zero) 
RTCP Pivot Offset 
RPCP Pivot Offset 

  

The following Tool Tables can be added or modified with the G-Code Settings window, 
Tables tab: 

Cutter Compensation 
Gage Offset 
Probe Offset 
Tool Length Compensation 
Tool Nose Compensation 

 

See the Tables for Processing G-Codes section, in the CGTech Help Library, for 
additional information on VERICUT tables. 

Also see "Building NC Machines", in the Using VERICUT section, in the CGTech Help 
Library. 

 
 
To G-Code Settings window



VERICUT HELP – Project menu 
 

 

Add/Modify Tables window 
  

The following discussion applies to both the Add/Modify Machine Table window, 
accessed from the Machine Settings window: Tables tab and to the Add/Modify G-
Code Table window, accessed from the G-Code Settings window: Tables tab. 

  

 
  

Table Name — Use to identify the table to be added, or modified, if it already exists. 
The Table Name list in the Add/Modify Machine Table window will only contain 
"machine" tables. The Table Name list in the Add/Modify G-Code Table window will 
contain both "job" tables and "tool" tables. 

SubSystem ID — Use to specify ID of the machine subsystem for which the table is 
being defined. 

Register — The Register number that will be used by VERICUT to access corresponding 
table data. For "tool" tables, this number typically corresponds to a tool or offset register 
number. For "job" and "machine" tables, the Register number may correspond to an 
offset register number, or an integer value, as required by a particular table. 
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SubRegister — Use of this feature enables you to access multiple sub-values for the 
same tool from tool related tables. For example, groove tools often have multiple 
"driven" points, which then correspond to multiple gage offsets, and possibly multiple 
Cutter Comp values, Tool Nose Comp values, and Tool Length Comp values. 

This feature can also be used for Work Offset Tables for controls, like Yasnac, that 
support the sub-register feature. 

SubRegister is only active when the selected "Table Name" identifies a "tool" related 
table or for Work Offset tables. 

 
Select From/To and Enter Values: 

These features are only active for the following tables: 

Input Program Zero 
Input Machine Zero 
Base Work Offset 
Work Offsets 
RTCP Pivot Offset 
RPCP Pivot Offset 

For the above tables, VERICUT provides two ways to enter table values.  

 

Select From/To Locations — Enables you to specify table values based on a "relational" 
offset between a "from" point and a "to" point. The "from" and "to" points are designated 
by specifying a particular component or CSYS. VERICUT will use the origin of the 
component/CSYS as the point. You can also specify an offset from the specified 
component/CSYS origin point. Once this relationship has been established, you can 
change the machine configuration or the location of the CSYS origin and the table values 
will updated automatically during the initial Single Step or during Play to End. 

For example:  After Input Program Zero has been defined to be the offset from the Tool 
Component to the "Program Zero" CSYS, you can change the machine configuration, or 
change the location of  "Program Zero" CSYS, and the Input Program Zero offset values 
will be updated automatically during the initial Single Step or during Play to End. 

NOTE:  The offsets are calculated based on where the corresponding origin points are 
located when all linear axes are driven to machine zero (zero with no offsets in place). 

 

When Select From/To Locations is toggled "On", the From/To Feature/Name lists and 
the Offset text fields become activated. Use the From/To Feature lists to specify 
whether the point is associated with a Component or a CSYS (coordinate system). Use 
the From/To Name lists to specify a specific component or coordinate system. 

NOTE:  Only the coordinate systems that have been defined with reference to a machine 
component (i.e., visible in a Machine or Machine/Cut Stock view when Coordinate 
System axis is toggled "on") will appear in the CSYS/Names lists. See the discussion for 
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Project menu > Coordinate Systems for more information on VERICUT Coordinate 
Systems. 

 

Use the Offset text fields to enter 3 values, separated by spaces, representing the X, Y, 
and Z offset from the specified origin point. You can also click on the "select" button 

, then  pick a point in the graphics display area. You can pick the point in either a 
workpiece or machine view. VERICUT will calculate the Offset value between the 
selected point and the designated Feature/Name origin point. Offset is only active when 
Feature is set to Component. 

 

Calculate Relative to Location — This feature enables you to have a relational offset 
recalculated in the machine position where the offset will be used. The new position is 
immediately calculated and stored and therefore is not dependent on the machine position 
when the offset is activated.  

TIP:   See tombstone_work_offsets_single_part.vcproject and 
tombstone_work_offsets_multiple_parts.vcproject in the Sample-Demo Files section, 
in the CGTech Help Library for examples of using this feature. 

 

Additional Offset — Use this text field to specify an additional offset value. 

 

Enter Offset (or select 2 points) — when toggled "On", the Values 
(XYZABCUVWABC) text field is activated enabling you to enter one to twelve numeric 
values as required by the specific table. Multiple value entries require spaces between the 
values.  

You can also click on the "select" button , then  pick two points in the graphics 
display area. You can pick the points in either a workpiece or machine view. VERICUT 
will calculate the Offset value between the selected points. 

For all other tables, Select From/To and Enter Offset (or select 2 points) are both 
inactive. Enter the values in the Values (XYZABCUVWABC) text field as described for 
Enter Offset (or select 2 points) above. 
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In the sample window shown above, the current table is the Work Offsets table. The 
current table entry is register "54", and contains the values "-14.95 -8 -17.25". The table 
is applicable to subsystem "1" of the machine. 

 

The following tables support "axis values" (up to 12 values – XYZABCUVWABC): 

Base Work Offset 
Initial Machine Location 
Machine Zero 
Machine Reference Location 
Tool Change Location 
Tool Change Retraction 
Work Offsets 
Program Zero 
Input Program Zero 

 

VERICUT supports two ways to input values into these tables from the Add/Modify 
Table window.  Both use the Values (XYZABCUVWABC) text field, but use a 
different syntax): 

Traditional format: values are entered in the order specified (XYZABCUVWABC) 
and are separated by spaces.  

WORD/VALUE format (X10 C45) 
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In either case, the resulting display of the axis values will be in the WORD/VALUE 
format.  Only non-zero values will be displayed. In the case of all zero's, X0 Y0 Z0 will 
be displayed. 

The WORD/VALUE format has the following rules: 

1. Valid Words are:  X, Y, Z, A, B, C, U, V, W, AA, BB, CC 
2. Mixed formats are not allowed. You can use either the Traditional format, or the  

WORD/VALUE format. 
3. The Words can be entered in any order. 
4. You only need to specify words with non-zero values.   
5. If a word is specified twice, the last value specified will be used. 
6. If all values are zero, you can leave the field blank.  In this case, the display will 

be X0 Y0 Z0. 
 
 

See the Tables for Processing G-Codes section, in the CGTech Help Library, for 
additional information on VERICUT tables. 

Also see "Building NC Machines", in the Using VERICUT section, in the CGTech Help 
Library.
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G-Code Settings window, Subroutines tab 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:  

 

The features on the Subroutines tab are used to specify names of external files containing 
subroutines that can be accessed by VERICUT. 

 

 
 

File Names list — List of external files containing subs accessible to VERICUT. 

 

Add — Opens the Job Subroutine Files selection box enabling you to add external 
subroutine files to the File Names list.  

Replace — Opens the Job Subroutine Files selection box enabling you to replace the 
highlighted subroutine file in the File Names list with another.  

Delete — Deletes the highlighted subroutine file from the File Names list. 

Delete All — Deletes all subroutines files from the File Names list. 
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Shortcut: Right-click in the File Names list area to display a shortcut menu with the 
following features: 

 
Add — Opens the Job Subroutine Files selection box enabling you to add external 
subroutine files to the File Names list. (Same as Add described above.) 

Replace — Opens the Job Subroutine Files selection box enabling you to replace 
the highlighted subroutine file in the File Names list with another. (Same as Replace 
described above.) 

Delete — Deletes the highlighted subroutine file from the File Names list. (Same as 
Delete described above.) 

Edit — Displays the of the highlighted subroutine file in a text editing window. 
Standard text editing features are provided, such as: copy/cut, paste, search, etc. (ref. 
Text File (edit) on the Edit Menu section of VERICUT Help for more information on 
using the editing features) 

 
 
 
To G-Code Settings window
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G-Code Settings window, Block Skip tab 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:  

 

Features on the Block Skip tab control which levels of block skipping are recognized, and 
specify the block skip character. 

 

 
 

Block Skip Character — Character which causes the block to be skipped. This character 
must be the first character in the data block for skipping to occur. 

Apply Switch Value — Controls when block skip switch values are referenced by 
VERICUT. 

Options: 
Immediate — Reference switch settings when VERICUT is reset, upon loading a 
new Project file, and any time tool path processing is started. 

On Reset — Reference switch settings only when VERICUT is reset, or upon 
loading a new Project file. 
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Switch 1-9 — When active, processing is skipped for blocks beginning with the 
designated block skip switch. For example, "Switch 2" corresponds to blocks beginning 
with "/2", "Switch 3" corresponds to blocks with "/3", and so on. 

 
 
To G-Code Settings window
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G-Code Settings window, Sync tab 
 VERICUT Location: Project menu > Processing Options > G-Code > Settings 

 VERICUT toolbar short cut:  

  

The features on this tab enable you to select which Sync Sub-system is to be used. This 
setting is only applicable if Sync Method on the Control Settings window, Sync tab is 
set to something other then None. The features on the Control Settings window, Sync 
tab are used to set up the sync environment. 

The features on this tab are intended as a debugging tool enabling you to easily turn off 
one or more sync'd  subsystems rather then running them all at the same time. VERICUT 
still runs through the "Sync" logic but a subsystem that is turned off, behaves like it is in 
a permanent "Wait" state. 

  

 
 

Use — The checkbox in this field enables you to toggle a particular Sync Subsystem on, 
or off. When toggled "Off", VERICUT runs through the "Sync" logic but behaves like it 
is in a permanent "Wait" state. 

Input Channel — This field shows what is driving each channel. The information 
displayed here will be different depending on the Sync Method being used. The above 
picture illustrates a Fanuc control where each channel is driven by a separate NC 
program. 

Sync Subsystem IDs — This field shows the ID of the sync subsystem that the record 
represents. 

 

To G-Code Settings window
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G-Code Settings window, WireEDM tab 
VERICUT Location: Project menu > Processing Options > G-Code > Settings 

VERICUT toolbar short cut:      

 

Features on the WireEDM tab configure VERICUT for wire EDM simulations. 

 

 
 

Wire Diameter — Specifies the effective cutting diameter of the wire. 

Work Table to XY Plane — Distance from the top of the work table (machine Z zero) 
to the XY reference plane, as measured along the machine Z-axis. This value is usually 
zero, but can be a positive or negative value. The XY reference plane is the Z-axis height 
at which the tool path file X and Y values are driven. 

XY Plane to UV Plane — Distance from the XY reference plane to the UV reference 
plane, as measured along the machine Z-axis. This value must be a positive value. This 
setting is only used when the tool path file contains U and V-axis values to control the 
wire angle. The UV reference plane is the Z-axis height at which the tool path file U and 
V values are driven. 

 
 
To G-Code Settings window
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G-Code (Variables window) 
Location: Project menu > Processing Options > G-Code > Variables 

 

Features on the Variables window, are used to initialize, maintain, and monitor G-Code 
variables. Variables are assumed to have zero for a default value. However, you can 
initialize variables with any numeric or text value. When this window is open during 
processing, it gives immediate feedback when variables are set or changed by the tool 
path file. Variables are saved to the .usr file if an initial value or a description is entered, 
or if the variable is included in the Tracking Variables list. 

 

 
 

Tracking Variables: 
The Tracking Variables portion of the Variables window enables you to easily track 
variables of special interest without having to scroll through all variables in the Variables 
List. The following information is displayed for all variables selected for tracking: 

Name — Name of the variable being tracked. 

SubSystem — Indicates the subsystem (if any) that the variable being tracked is 
associated with.  
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NOTE:  SubSystem in this case pertains to the subsystems defined in the Variables 
window variable tree, NOT the subsystems defined by the machine. 

 

Subroutine — Subroutine (if any) that the variable being tracked is associated with. 

Description — Description of the variable being tracked. 

Type — Type of variable (Number, Text or Array) 

Current Value — The current value of the variable. 

Initial Value — The initial value of the variable. 

 — Use to add the highlighted variable in the Variables List to the Tracking 
Variables list. 

 — Use to remove the highlighted variable(s) from the Tracking Variables list. 

TIP: Use one of the following methods to highlight multiple variables in the 
Tracking Variables list. 

1. Use the "Shift" key to select a consecutive range of blocks. Click on the 
first block in the range so that it becomes highlighted, and then while 
holding down the "Shift" key, click on the last block in the range. All of 
the blocks between the first and last should now be highlighted. 

You can also click on the first variable in the list , then while keeping the 
mouse button depressed, drag the cursor to the last variable in the range. 

2. Use the "Ctrl" key to select multiple individual blocks. Click on the first 
block so that it becomes highlighted, and then while holding down the 
"Ctrl" key, select additional blocks. Each block will become highlighted 
when it is selected.  

  

Variables List: 
The Variables List, located in the lower portion of the Variables window, displays all 
variables initialized and encountered during tool path processing. 

Name — The Name column displays a tree structure showing a list of all variables, and 
how each variable relates to the overall structure of the NC program (subsystem, 
toolpath, subroutines, etc.). Tree is constantly updated as the toolpath is processed. 

Description — Description of the variable. This field enables you to enter a description 
for the NC Variable. This feature allows you  to document variables for later use, as well 
as simplifying the tracking of states. Instead of just seeing  4001, a more meaningful 
"Motion Type" description can be added. Descriptions that end with an " * "  has been 
automatically generated by VERICUT.  Automatically generated descriptions can result 
from any of the following: 

Setting a variable on the Events window. 
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Setting a variable on the Word/Address window. 

Calling one of the Autoset… macros. 

Calling the SetDynamicVars macro. 

Type — Type of variable (Number, Text,  Number Array, String Array, Frame, or 
Frame Array); also indicates the type of data that can be assigned to the variable.  

Current Value — The current value of the variable. 

Initial Value — The initial value of the variable. 

NOTE:  It is possible to create a variable with no defined values. This is done by adding 
a variable with either a description, or by adding the variable to the tracking variable list. 
This is significant because VERICUT treats variables differently depending on whether 
the variable exists (defined within VERICUT) versus whether the variable has an 
undefined value. 

If you try to access a non-existing variable (a variable that does not show up in variables 
window), VERICUT outputs an error message saying; "un-initialized variable, defaulting 
to zero". 

When you call a G65 subroutine, variables 1-33 get initialized to "undefined" or "vacant" 
except those, which are set on the call to the subroutine. If you try to access an 
"undefined" variable, then VERICUT does not output an error message, or default to 
zero. 

See "Notes about un-initialized variables" in the Using VERICUT section for additional 
information. Using VERICUT can be found in the CGTech Help Library. 

 

Add — Opens the Variable Add window enabling you specify the characteristics of a 
new variable and add it to the variable list. 

Delete — Deletes the highlighted variable from the variable list. 

Delete All — Deletes all variables in the variable list. 

Close — Close the Variables window. 

 

Shortcut:  Right-click in the Variables List to display the following menu: 
 

 
NOTES: 
1. Features  Add, Delete, and Delete All provide the same functionality as above 

under Variables List. 
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2. Feature Variable modify opens the Variable Modify window enabling you to 
modify the characteristics of array variables. This feature is only active when an 
array variable is highlighted. 
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Variable Add window 
 

Accessed by selecting Add in the Variables window, the features in this window enable 
you to specify the characteristics of a new variable and add it to the variable list. The 
Variable Add window will look different depending on the "type" of variable being 
defined. 

  

 
 

Name — Name of the variable. 

SubSystem — Use this feature to specify the subsystem that the variable is associated 
with. 

NOTE:  SubSystem in this case pertains to the subsystems defined in the Variables 
window variable tree, NOT the subsystems defined by the machine. 

 
Description — Use this field to add descriptive information about the variable  

 
Type — Select the Type of variable from the pull-down list; also indicates the type of 
data that can be assigned to the variable.  

Options: 
Number — the variable is real number. For example, value ="0010" => the numeric 
value "10" is used. 

Text — the variable is a text string. For example, value ="0010" => the text string 
"0010" is used. 



VERICUT HELP – Project menu 
 

Number Array — The variable is an array. When Number Array is selected as the 
variable type, an Array Dimension field and an array table are added to the Add 
Variable window. 

 

 
 
Array Dimension — Use to specify the dimensions of the array that the variable 
represents, for example "3, 4", for a 3x4 array. 

Array Table — Use the array table to initialize specific array values if desired. 
VERICUT automatically adjusts the size if the array based on the dimension set 
with Array Dimension and all values are defaulted to 0.  

  

NOTES ON USING ARRAY VARIABLES: 
1. Non-numeric variables must be defined in the Words window to enable proper 

parsing. 

2. In the Variables window, Type must be set to Array, and Array Dimension 
must also be defined. 

3. In the MCD file, the syntax must be of the form:  name[2,1]=5  where the square 
brackets are left and right precedence, and indexes are separated by commas. 
Each index can also be defined as an expression. For example: name[#7+1,1]=3. 

4. Array variables are also supported in the Word Address window as a variable to 
be set. Non-numeric variables can not be used with override values. 
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String Array — The variable is an array. When String Array is selected as the variable 
type, an Array Dimension field and an array table are added to the Add Variable 
window. 

Array Dimension — Use to specify the dimensions of the array that the variable 
represents, for example "3, 4", for a 3 x 4 array. 

Array Table — Use the array table to initialize specific array values if desired. 
VERICUT automatically adjusts the size if the array based on the dimension set with 
Array Dimension and all values are defaulted to 0.  

 
Frame — When Frame is selected as the variable type, a frame table is added to the Add 
Variable window. 

 

 
 

Frame Table — Use the array table to initialize specific frame values if desired. 
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Frame Array — The variable is an array. When Frame Array is selected as the variable 
type, an Array Dimension field and a frame array table are added to the Add Variable 
window. 

 
 
Array Dimension — Use to specify the dimensions of the array that the variable 
represents, for example "3, 4", for a 3x4 array. 

Array Table — Use the array table to initialize specific array values if desired. 
VERICUT automatically adjusts the size if the array based on the dimension set with 
Array Dimension and all values are defaulted to 0.  

 

OK — Adds the variable to the Variables List in the G-Code Variable window and 
dismisses the Add Variable window. 

Apply — Adds the variable to the Variables List in the G-Code Variable window and 
leaves the Add Variable window open enabling you to specify additional variables. 

Cancel — Dismisses the Add Variable window without adding the variable to the 
Variables List in the G-Code Variable window. 
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Variable Modify window 
The Variable Modify window is accessed by selecting Variable Modify in the Variables 
window,  right mouse button shortcut menu. The features in this window enable you to 
modify the characteristics of an existing array variable. 

The Variable Modify window will look different depending on the "type" of array 
variable (Number Array, String Array, or Frame Array) being modified. 

The features available in the Variable Modify window are identical to the ones described 
above under Variable Add window  for Types:  Number Array, String Array , and Frame 
Array. 

 
 



VERICUT HELP – Project menu 
 

 

G-Code (Process Options window) 
Location:  Project menu > Processing Options > G-Code > Process Options 

  

Opens a window enabling you to configure the settings required to support processing of 
G-Code NC program files. 

  

 
  

G-Code Output Files tab — Features on this tab are used to control conversion, or 
"reverse post-processing" of G-Code NC program files, and specify the names of files 
resulting from this process. 

Messages tab — Features on this tab are used to set the destination and format of 
messages output during a simulation. 

Debug tab — Features on this tab are used to select what debug messages to send to 
output. 

User Defined tab — Features on this tab are used to configure user defined control 
settings supplied via a custom CME file. 
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OK — Applies the changes and closes the Process Options window. 

Apply — Applies the changes and leaves the Process Options window open. 

Cancel — Closes the Process Options window without applying changes. 
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Process Options window, G-Code Output Files tab 
Location:  Project menu > Processing Options > G-Code > Process Options 

  

Features on this tab are used to control conversion, or "reverse post-processing" of G-
Code NC program files, and specify the names of files resulting from this process. 

  

 
  

APT Output File — Name of the file to receive ASCII APT tool path records resulting 
when Create APT Output File is active (see below). If blank, the file is not created. 

G-Code Log File — Name of the G-Code Log file to receive error, warning and 
informational messages about G-Code processing. If blank, the file is not created. 

Create APT Output File — When active, converts the G-Code NC Program data into 
ASCII APT NC Program records. Converted data is stored in the specified APT Output 
file (see above). 

View APT Output File — Opens a window containing the APT Output file with ASCII 
APT tool path records created when Create APT Output File is active (see above). 

For information about APT NC Program records and formats, see "Supported APT-CLS 
records".  



VERICUT HELP – Project menu 
 

View G-Code Log File — Opens a window containing the G-Code Log file. This file 
contains information, such as error, warning and informational messages about G-Code 
processing. In this window, you can view, edit, or reset the G-Code Log file contents. 

 
 
To Process Options window
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Process Options window, Messages tab 
Location:  Project menu > Processing Options > G-Code > Process Options 

  

Features on this tab are used to set the destination and format of messages output during a 
simulation.  

  

 
  

Send Error Messages — Destination of messages about errors-potentially severe 
problems that will most likely produce incorrect results on the machine tool. 

Send Warning Messages — Destination of messages about possible problems. 
Scrutinize warnings to decide if they will actually impact the machining process. 

Send Info Messages — Destination of messages providing information about files used, 
the time and date that the process started, etc. 

Send Debug Messages — Destination of debug messages providing additional 
information related to internal calculations, conditions, and variable values. The types of 
debug messages which appear are controlled via Process Options window: Debug tab. 

Send Control Setting Messages — Destination of messages showing the control settings 
in effect when the tool path file was processed. 

Send Input Messages — Destination of messages showing the input tool path file 
records processed. 
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Send Output Messages — Destination of messages showing the converted tool path 
records resulting from reverse-postprocessing. When Create APT Output File is active 
on the Process Options window: G-Code Output Files tab, output messages are sent to 
the APT Output File specified on the same window. By default, these records are in 
ASCII APT format. However, using the C Macro Extension – Application 
Programming Interface, or CME–API (ref. CME-API in the VERICUT Development 
Tools section, in the CGTech Help Library), other output file formats are obtainable. 

Output Filenames Format — Controls how names of files used by VERICUT are 
shown. 

Options:  

Filename Only 
Full Path Names — includes full directory path). 

Output Block Sequence Numbers — Controls when block sequence numbers are 
included with APT output records resulting from conversion. The sequence numbers 
appear in columns 73-80, and are useful for general reference or debugging purposes. 
Options: 

Yes — output block sequence numbers 

No — don't output block sequence numbers 

Output "Word is not defined" Errors — When set to Yes, outputs the "Word is not 
defined" error message when G-Code words are encountered that the control is not set up 
to process. To prevent these errors from appearing, ensure this feature is set to No. 

  

Messages can be sent to the destinations listed below: 

• to  APT Output 

• to G-Code Log (not available for Send Output Messages) 

• to Logger  (not available for Send Output Messages) 

• to APT Output and G-Code Log 

• to APT Output and Logger 

• to G-Code Log and Logger (not available for Send Output Messages) 

• to APT Output, G-Code Log and Logger 

• to Nowhere (not available for Send Error Messages, Send Warning Messages or 
Send Output Messages) 

 NOTE:  Not all destination choices are available for all message types. 

 
 
To Process Options window
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Process Options window, Debug tab 
Location:  Project menu > Processing Options > G-Code > Process Options 

  

Features on this tab are used to select what debug messages to send to output. Debug 
messages can provide additional information that may be helpful debugging development 
of files used to simulate G-Code NC programs and simulate machine tool motions. Set 
each Debug Message to either Yes (send to output) or No (don't send to output). The 
output destination for debug messages is controlled by "Send Debug Messages" on the 
Process Options window: Messages tab. 

  

 
  

Debug Offsets — When selected, outputs debug messages about offset value changes, 
including: coordinate system offsets/shifts, compensation values in use, etc. 
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Debug Delta Information — When selected, outputs debug messages about rotating the 
tool position. 

Debug Rate Calculations — When selected, outputs debug messages about rate 
calculations related to tool movement. 

Debug Loop Logic — When selected, outputs debug messages about values calculated 
by looping or branching logic. 

Debug Macro Arguments — When selected, outputs the macro name, the word, the text 
string value, and the numeric value for the macro being called. 

Debug Intersect Points — When selected, outputs debug messages related to intersect 
points calculated by CDC calculations. 

Debug Cutter Compensation — When selected, outputs debug messages about CDC 
tool offset positions. 

Debug Cycle Values — When selected, outputs debug messages related to processing 
canned tool axis cycles. 

Debug Substitution — When to selected, outputs debug messages related to string 
substitutions (ref. Configuration menu > Adv. Options: Substitute tab). 

Debug Variables — When selected, outputs debug messages about changes to variable 
values. See also: Project menu > Processing Options > G-Code > Variables window. 

Debug Turning — When selected, outputs debug messages associated with turning, for 
example the distance from the turning axis to the tool control point and calculations 
related to the use of constant surface speed. 

Debug Wire EDM — When selected, outputs debug messages associated with wire 
EDM machining. 

Debug OptiPath — When this is turned on, a descriptive message will be printed 
whenever machine simulation determines a block is non-optimizable. 

Debug Control API — When turned on, debug messages related to the API Interface for 
the Heidenhain iTNC Controller are output. 

See API Interface for the Heidenhain iTNC Controller, in the VERICUT Development 
Tools section, in the CGTech Help Library. 

Debug Timing — When turned on, time related debug messages [Delta time (time for 
this block), Total time, and Time Attributes (information used to calculate Delta time)] 
are output for each block. 

Debug Active Components — When turned on, the Active Subsystem, Active Tool 
Component name, and Active Stock Component name will be printed on each block. 
Also, the Active Spindle Component name will be printed whenever it is used or set. 

 
 
To Process Options window
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Process Options window, User Defined tab 
Location:  Project menu > Processing Options > G-Code > Process Options 

  

Features on this tab are used to configure user defined control settings supplied via a 
custom CME file. This window will appear differently, depending on the CME file in 
use. CME files are created using the C Macro Extension – Application Programming 
Interface, or CME–API (ref. CME-API in the VERICUT Development Tools section, 
in the CGTech Help Library), and specified for use in VERICUT via Dev Kit CME tab 
of the Advanced Control Options window (ref. Advanced Control Option window: 
Dev Kit CME tab, in the Configuration Menu section of VERICUT Help). 

  

 
  

NOTE:  Developer's Kit-defined settings can also appear on the User Defined (CTRL) 
tab of the Control Settings window, as determined by the developer. 

 
 
To Process Options window
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APT Settings window 
Location:  Project menu > Process Options > APT Settings 

VERICUT toolbar short cut:  

 

Opens a window to configure settings to support processing APT-CLS tool path files. 

 

 
 

Motion tab — Features on this tab provide important settings for APT-CLS tool path 
simulation, such as: how circle and rapid motions are simulated, default tool path units, 
and more. 

Rotary tab — Features on this tab provide control over rotary motions simulated for 
APT-CLS tool paths. 
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Turning tab — Features on this tab provide control over lathe turning motions simulated 
for APT-CLS tool paths. 

Cycles tab — Features on this tab enable you to change how VERICUT simulates APT 
or CLS tool path canned cycles, also known as "fixed tool axis cycles". 

 

OK — Saves the settings and closes the APT Settings window. 

CANCEL — Closes the APT Settings window without saving setting changes. 
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APT Settings window, Motion tab 
Location:  Project menu > Process Options > APT Settings 

VERICUT toolbar short cut:  

 

Features on this tab provide important settings for APT-CLS tool path simulation, such 
as: how circle and rapid motions are simulated, default tool path units, and more. 

 

 
 

Default Toolpath Units — Default unit measurement system for tool path files that do 
not contain a "UNITS" record. If the tool path file units differ from the session units, 
values in the tool path are converted appropriately while being processed. 

MULTAX — When selected, interprets six parameter GOTO records as 
GOTO/x,y,z,i,j,k where i,j,k is tool axis orientation (superseded by MULTAX/OFF). 
Clearing this checkbox interprets these records as GOTO/x1,y1,z1,x2,y2,z2 - two point 
locations (superseded by MULTAX/ON). 
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Max Tool Axis Angle — Maximum angle (in degrees) along a multi-axis motion to 
display intermediate tool positions. A value of "0" (default) does not display intermediate 
positions on multi-axis motions. The cut model is unaffected by this feature. 

Tool Axis Reset Angle — Minimum angle (in degrees) which is considered a positioning 
move. Multi-axis motions having angles equal to or greater than the reset angle do not 
remove material. Instead, the tool display is turned off through the multi-axis motion, 
then turned on after the multi-axis destination is reached. Cutting resumes at the new tool 
position. 

Closed Circle Tolerance — The Closed Circle Tolerance value is used by VERICUT to 
determine whether a circular motion should go around the whole circle, or just around a 
small arc of the circle. 

A value of zero in this field causes VERICUT to check whether a circle is meant to be a 
complete loop using the same method it has used for many years. 

A non-zero value causes VERICUT to use a new method for determining whether a circle 
is meant to be a complete loop. VERICUT compares the specified Closed Circle 
Tolerance value with the distance between a circle's start, and end, points. If the distance 
is less than the specified tolerance, VERICUT assumes that the tool must move round the 
whole circle. If the distance is greater than the specified tolerance, then VERICUT moves 
the tool around a small arc of the circle. 

Process Circles — When selected, processes CIRCLE records to simulate the arc 
motion. Clear this checkbox to ignore "CIRCLE" records, such as necessary when 
CIRCLE records are accompanied by their representative chordal GOTO points.  

NOTE: Simulating circle motions increases performance dramatically over processing 
chordal GOTO points. 

Reverse Circles — When selected, reverses CIRCLE record motions. Clear this 
checkbox to simulate circle motions in the direction programmed. (Circle IJK values 
determine circle direction.) 

Detect Chordal GOTOs — When this option and Process Circles are selected, the 
chordal GOTO points which follow CIRCLE records motions are processed to simulate 
an arc, or circle motion. Clear this checkbox to process the GOTOs as linear tool 
positions. 

Reset Tool Change — When selected, resets the tool display following a tool change. 
This action turns off the tool display until after the tool is changed and the following 
motion is processed. The new tool appears at the end of the motion following the tool 
change. This option is recommended when simulating tool paths for NC machines that 
automatically retract the tool during a tool change. Clear this checkbox to have 
VERICUT change the tool at its current location when a tool change command is 
encountered. 

Process NX or CATIA Matrix — When selected, processes these tool path matrix 
records to transform the tool path to its base coordinate system: CATIA0 or  MSYS. 
Clear this checkbox to ignore tool path matrix records. This feature is useful to 
automatically orient tool paths to models imported from the same CAD/CAM system. 
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Ignore unrecognized Major words — When toggled on, VERICUT ignores 
unrecognized APT major words and no warning messages are output to the VERICUT 
main window message area, or in the Log file. 

Default CLEARP — Distance to retract along the tool axis when a RETRCT record is 
encountered prior to establishing the retract plane. The default CLEARP condition is 
"off" until a CLEARP record defining a clearance plane is encountered. 

RAPID Motion — Controls how to simulate rapid positioning motions. Options: 

Linear — Move in a straight line. 

Square — Move with "squared off" motion, where Z motions are processed 
independently from X and Y. 

 

 
 

GOHOME Motion — Controls how the tool is returned to the home position when a 
GOHOME record is processed. Options: 

FROM — Move in a straight line to the home position. 

Retract — Move with squared off motion, where the tool is first retracted the distance 
specified by the GOHOME R Dist value, then moved to the home position. 

GOHOME R Dist — When simulating GOHOME record motions via the "Retract" 
option (see above), this value specifies the distance to retract before going to the home 
position. 

 
 
To APT Settings window
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APT Settings window, Rotary tab 
Location:  Project menu > Process Options > APT Settings 

VERICUT toolbar short cut:  

 

Features on this tab provide control over rotary motions simulated for APT-CLS tool 
paths. Note that while machines often rotate the workpiece, in a VERICUT Workpiece 
view the workpiece is fixed and the tool is seen rotating about the workpiece. Both rotary 
cut paths are identical. 

 

 



VERICUT HELP – Project menu 
 

 

"ROTATE/BAXIS,ATANGL,90" as seen on a machine with a "B" rotary table, and 
simulated by VERICUT in a Workpiece view: 

 

 
 

ROTATE, ROTABL, ROTHED — These features control when and how to simulate 
motion caused by the corresponding ROTATE, ROTABL, or ROTHED records, 
respectively. "BAXIS" is the default rotation axis when not specified. The rotary pivot 
point is defined by the Rotation Center. When absolute or incremental rotation is not 
specified, the Angle Value determines how to apply the rotary value. 

Options: 
Ignore — Ignores the rotary command. (Default) 

Rotate — Rotates while cutting. Tool path motions that follow are expected to have 
the rotation applied. 

Rotate/Apply — Similar to Rotate, except also applies the rotated coordinate system 
to subsequent tool path motions. Tool path motions that follow are NOT expected to 
have the rotation applied. 

Position — Rotates without cutting, also known as "positioning". The tool disappears 
from its initial position, then appears at the rotated position. Tool path motions that 
follow are expected to have the rotation applied. 

Position/Apply — Similar to Position, except also applies the rotated coordinate 
system to subsequent tool path motions. Tool path motions that follow are NOT 
expected to have the rotation applied. 

Rotation Center — Center of rotation for rotary motions simulated via the ROTATE, 
ROTABL, or ROTHED features (see above). 

Philosophy — Describes what is being commanded to rotate for rotary motions 
simulated via the ROTATE, ROTABL, or ROTHED features (see above): Table 
(default), or Tool. Changing the rotation philosophy has the affect of reversing rotation 
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direction. Note that ROTHED angle values are always assumed to use a rotating Table 
philosophy. 

Angle Value — Controls how angle values are applied for rotary motions simulated via 
the ROTATE, ROTABL, or ROTHED features (see above) when the commands do not 
specify "ATANGL" or "INCR". 

Options: 
Relative — Incremental angle values. 

Absolute — Absolute angle locations. (Default) 

Note that ROTHED angle values are always assumed to be Absolute. 

Direction — Direction of rotation for simulating for rotary motions simulated via the 
ROTATE, ROTABL, or ROTHED features (see above). 

Options: 
Shortest — Direction which travels the shortest distance. (Default) 

CW — Always clockwise. 

CCW — Always counterclockwise. 

Linear — Refers to angles on a linear axis "wrapped" around the rotary component. 
Rotary values specify absolute locations along the linear-rotary axis, while the sign (+ 
/ -) controls which end of the linear axis is used. 

Detect 4-Axis Rotary Motion — When selected, simulates an arc cut for multi-axis 
motions that fit within an arc path. Clear this checkbox to simulate each multi-axis 
motion independently- recommended when simulating 5-axis contouring-type motions. 
The Interpolation Tolerance value is used to determine which motions are simulated in 
the 4-axis cut. 

 

 
 
 
To APT Settings window
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APT Settings window, Turning tab 
Location:  Project menu > Process Options > APT Settings 

VERICUT toolbar short cut:  

 

Features on this tab provide control over lathe turning motions simulated for APT-CLS 
tool paths. 

 
 

GOTO Format — Specifies how turning GOTO record values are to be displayed in a 
Workpiece view. In this view, VERICUT simulates turning motion in the ZX plane, 
where Z is the spindle-axis, and X is the cross-slide-axis. This feature acts like a post-
processor for turning tool position data. 

Example 1- Assume you have a turning tool path programmed in GOTO/x,y format. By 
default, GOTO Format "#zval, #xval" displays the first GOTO value as Z-axis motion, 
and the second value as X-axis motion. 
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Example 2- Assume you have a turning tool path that was reversed post-processed from 
G-Code data such that GOTO records are in GOTO/x,0,z format (center value is "zero"). 
For VERICUT to process this correctly, set GOTO Format= #xval, #yval, #zval. 

 

To APT Settings window 
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APT Settings window, Cycles tab 
Location:  Project menu > Process Options > APT Settings 

VERICUT toolbar short cut:  

 

Features on this tab enable you to change how VERICUT simulates the APT or CLS 
CYCLE records to simulate tool path canned cycles, also known as "fixed tool axis 
cycles". The Drill Cycle feature controls when and how these records are simulated. 

 

 
 

Cycle Set — Controls which cycle definition set(s) are considered by VERICUT when 
processing APT tool paths. If you add a new cycle set, for a different flavor of APT or a 
different post-processor, you can give it any name you wish and it will appear in this list. 
"ALL" considers all cycle sets defined for use. 

Cycle Definitions — Opens the Cycles window enabling you to maintain cycle and 
modals definitions used to interpret "CYCLE" records. This feature is especially useful if 
simulated cycle motions are not displayed as expected. When VERICUT can not find 
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definitions to interpret a CYCLE record, an error similar to "Invalid CYCLE record" 
error is issued. In these cases, cycle definitions must be modified to interpret the cycle 
data. 

 For more information about configuring VERICUT to interpret cycle commands, see 
"About configuring for cycle simulation" in the Using VERICUT section. Using 
VERICUT can be found in the CGTech Help Library. 

 
 
To APT Settings window 
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Cycles window 
 
Accessed using the Cycle Definitions button on the APT Settings window, Cycles tab, 
the Cycles window features enable you to maintain cycle and modals definitions used to 
interpret "CYCLE" records. This feature is especially useful if simulated cycle motions 
are not displayed as expected. When VERICUT can not find definitions to interpret a 
CYCLE record, an error similar to "Invalid CYCLE record" error is issued. In these 
cases, cycle definitions must be modified to correctly interpret the cycle data. 
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Menu Bar: 
The menu bar located at the top of the window provides easy access to major functions. 
Left-click on any menu name to display the list of functions in that menu. Click on the 
function in the menu you want to use. 

Edit: 
Cut — Cuts the highlighted text in the file listing and puts it in the paste buffer.  

Copy — Copies the highlighted text in the file listing to the paste buffer. 

Paste — Puts the contents of the paste buffer at the location of the cursor in the file 
listing. 

 

Icon Bar: 

 
The items in the Icon Bar enable you to search for, and/or replace, specific items in the 
file listing, print the file, or exit the window. Moving the cursor over the icon will display 
name of the option. Each feature (from left to right) is described below. 

 

Line Number or Search Text — Use this text field to enter a line number, or a string of 
text, to search for. 

 Goto Line Number — Moves the cursor in the file listing to the line number 
specified in the Line Number or Search Text field. 

 Search Forward — Searches forward in the file listing for the text string specified 
in the Line Number or Search Text field. 

 Search Backward — Searches backward in the file listing for the text string 
specified in the Line Number or Search Text field. 

Replacement Text — Use this text field to enter a "replacement text" string. 

 Replace One — Replace one occurrence of text string in the Line Number or Search 
Text field (or the highlighted text in the file listing) with the text string in the 
Replacement Text field. 

 Replace All — Replace all occurrences of the text string in the Line Number or 
Search Text field with the text string in the Replacement Text field. 

 Print — Print the file. 
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OK — Accepts the changes and closes the Cycles window. 

Cancel — Closes the Cycles window with out accepting the changes.  

 
 
Shortcut:  Right-click in the Cycles window to display the following menu: 
 

 
 
These features provide the same functionality as those available under Edit in the menu 
bar.
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Supported APT-CLS tool path records 
APT tool path records typically contain a major vocabulary word followed by a slash 
("/"), then a combination of data and/or minor vocabulary words. APT records can be 
preceded by leading spaces or tabs. Spaces can appear anywhere in the record. APT 
record data typically ends prior to column 72. However, a "$" at the end of a record 
continues onto the following line. 

The APT tool path records processed by VERICUT are listed below in alphabetical order. 
See the appropriate section for details. Records not listed are typically ignored by 
VERICUT. 

  
ARC record 
Causes circular motion. The format of this record is similar to CIRCLE record, except 
specifies the arc end point via an additional set of X, Y, Z values. 

 
CATIA0 record 
Specifies a CATIA-style twelve parameter tool path transformation matrix. VERICUT 
processes this record when Process Matrix, on the APT Settings window: Motion tab, 
is active. 

Example: 
$$*CATIA0  

$$*AXS2 

$$ .00000 .00000 1.00000 -6.59040  

$$ .99360 .11299 .00000 -16.50458  

$$ -.11299 .99360 .00000 -3.32025  

 
CHGTOOL record 
Specifies the tool number to be changed into the spindle, same as LOADTL record. This 
record is not processed by default, however, you can use Tool Change By, in the NC 
Program window, to process this record and retrieve cutting tool descriptions from a 
VERICUT tool library. 

Format: 
CHGTOOL/n[,any text] 
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CIRCLE record 
Causes circular motion. The GOTO point preceding the CIRCLE record defines the start 
of the circular motion. The GOTO following the CIRCLE defines the circular motion 
end. Helical motion is generated when the end point measured along the tool axis differs 
from the start point. This record is processed when Process Circles, on the APT Settings 
window: Motion tab, is active. 

Formats: 
CIRCLE/x,y,z,i,j,k,r[,n,n,n,n] - where "x,y,z" defines the circle center point, "i,j,k" is 
the axis orientation. "r" is the circle radius, but is not used since the radius is 
computed from the start, end and center points. The vector defines the positive Z-axis 
of counter-clockwise motion following the right-hand rule. In the 11 parameter 
format, VERICUT only uses the first 7 parameters. 

Examples: 
CIRCLE/1,2,3,0,0,1,5 - CCW circle motion about point 1,2,3, radius of 5 

CIRCLE/1,2,3,0,0,-1,5 - as above, except CW arc motion 

 
CLEARP record 
Defines a clearance plane used by subsequent RETRCT records. See also: Default 
CLEARP on the APT Settings window: Motion tab. 

Formats: 
CLEARP/OFF 

CLEARP/value 

CLEARP/XYPLAN(YZPLAN or ZXPLAN),value - establish a clearance plane 
parallel to the part coordinate XY, YZ, or ZX plane, respectively at "value" distance 
from the part coordinate system origin. Only one plane may be active at one time. If 
no plane option is specified, XYPLAN is assumed. 

CLEARP/PERPTO,value - establishes a clearance plane perpendicular to the tool axis 
at "value" distance from the part coordinate system origin. Clearance plane distance is 
measured in the direction of the tool axis. Changing the tool axis vector changes the 
clearance plane. 

 

CLRPLN record 
Defines a clearance plane, same as CLEARP record. 

 

CLRSRF record 
Defines a clearance plane, same as CLEARP record. 
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CNTRL record 
Defines a control point for use with a NURBS record. 

Formats: 
CNTRL/x,y,z[,i,j,k][,WEIGHT,w] - where "x,y,x" are the control points (or poles) for 
tool position, optional "i,j,k" values control the tool axis, and optional "w" specifies 
the weights. 

 

CONT record 
GOTO continuation record, similar to GOTO record. 

Formats: 
CONT/x,y,z 

x,y,z 

: 

CONT/x,y,z,i,j,k 

x,y,z,i,j,k 

: 

 

COOLNT record 
Controls coolant usage. Text following the slash is displayed in the Status window as the 
current coolant condition. 

Formats: 
COOLNT/any text 

COOLNT/ON[,any text] 

COOLNT/OFF 

 

CSYS record 
Specifies a ProManufacturing-style twelve parameter tool path transformation matrix. 
VERICUT processes this record when conditions are suitable. A more detailed 
explanation follows. The "$$->FEATNO" record resets back to the identity matrix, and 
"$$->END" ends TRANS/ROTATE/CSYS actions. 

Example: 
$$-> CSYS / 1.0000000000, 0.0000000000, 0.0000000000, 0.0000000000, $ 

0.0000000000, 1.0000000000, 0.0000000000, 0.0000000000, $ 

0.0000000000, 0.0000000000, 1.0000000000, 0.0000000000 
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ProManufacturing APT has combinations of options that determine how ROTATE, 
TRANS, and CSYS are applied. For VERICUT to determine how to apply these 
transformations, all records are processed concurrently. The table below describes cases 
where ROTATE, TRANS, and CSYS are processed. VERICUT ignores these records 
for cases that are not described in the table. 

"ROTATE" 
record present 

"TRANS" 
record present

"$$->TRANS" 
present 

Action 

No No No Ignore CSYS and TRANS 

No No Yes Apply TRANS 

No Yes No Apply CSYS 

Yes No Yes Add TRANS to CSYS, then apply 
CSYS 

Yes Yes No Apply CSYS 

 

CUTCOM record 
CUTCOM record supports cutter compensation for ProManufacturing CL data. If 
VERICUT encounters: 

$$-> CUTCOM_GEOMETRY_TYPE / OUTPUT_ON_PROFILE 

Then sees a CUTCOM/LEFT, or CUTCOM/RIGHT, it reads ahead to the 
CUTCOM/OFF. The profile is then offset to the left or right by the cutter radius and 
VERICUT re-reads the APT, making adjustments as required. The algorithm used is not 
intended to match any particular postprocessor or controller. 

  

If OptiPath is being used, the OUTPUT_ON_PROFILE gets replaced by 
OUTPUT_ON_CENTER in the generated file, and the subsequent GOTOs refer to the 
cutter centerline. 

 

CUTTER record 
Describes the shape of the cutting tool. 

This record is processed by default, however, you can use Tool Change By, in the NC 
Program window, to ignore these and process other records in the tool path file to 
retrieve cutting tool descriptions from a VERICUT tool library. 
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Formats: 
CUTTER/d,r,e,f,a,b,h 

CUTTER/d,r,h 

CUTTER/d,r (requires Min. Cutter Height > 0) 

CUTTER/d (requires Min. Cutter Height > 0) 

CUTTER/XCUT(SHANK or HOLDER),...profile description 

The table below and figures that follow describe how the values "d" through "h" are 
interpreted, based on if the cutter is used for milling or turning. 

 

Value Milling Cutter Turning Cutter 

d diameter nose diameter 

r corner radius not used 

e dist. from tool centerline to corner 
radius center 

not used 

f dist. from tool tip to corner radius 
center 

not used 

a base angle tool angle- degrees from spindle axis 

b side angle side angle- degrees from tool centerline 
to its side 

h height height- measured from tool tip along its 
centerline 
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Generic 7 Parameter Mill Cutter Definition: CUTTER/d,r,e,f,a,b,h 

 
 

Generic 4 Parameter Turn Cutter Definition: CUTTER/d,0,0,0,a,b,h (or 
CUTTER/d,,,,a,b,h) 

 
 

CYCLE record 
Describes a canned tool axis cycle motion (e.g. drilling, reaming, boring, etc.) that is to 
be repeated at subsequent motion locations. The Drill Cycle feature, in the Motion 
window, controls when and how these records are simulated. 

Formats: 
CYCLE/<parameters> - where "<parameters>" provide information about how the 
canned motion is to be applied. 

If canned cycle motions are not displayed as expected ensure that Drill Cycle is not 
set to Ignore. If cycle simulation is still not correct, use Cycle Def on the APT 
Settings window: Cycles tab to configure how VERICUT interprets canned cycle 
commands. 
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CYLNDR record 
Causes circular motion, same as CIRCLE record. 

 

END record 
Ends the tool path transformation matrix caused by a combination of CSYS, ROTATE 
and TRANS records. VERICUT processes this record when conditions are suitable. See 
"CSYS record" for details. 

 

FEATNO record 
Resets the tool path transformation matrix caused by a combination of CSYS, ROTATE 
and TRANS records back to the identity matrix. VERICUT processes this record when 
conditions are suitable. See "CSYS record" for details. 

 

FEDRAT record 
This record sets the feed rate, or speed at which the tool moves. Text following the slash 
is displayed in the Status window as the current feedrate condition. 

By default, a zero feedrate is used until a FEDRAT record is processed. The active feed 
rate value is used until another FEDRAT record is encountered. A RAPID motion 
overrides the active FEDRAT for that motion only. 

Formats: 
FEDRAT/value[,IPM] also: IPR, MMPM, MMPR - where “value” represents 
feedrate in the current mode. The feedrate value, and mode if specified, are displayed 
in the Status window Feedrate field. 

 

FROM record 
This record establishes where the tool is starting from. There is typically one record of 
this type per tool path file and it usually precedes any other motion record in the file. If a 
FROM record is not encountered, then the first GOTO point location is assumed to be the 
"from" position. 

Formats: 

FROM/x,y,z[,i,j,k] - where "x,y,z" is the starting point and "i,j,k" represents the 
starting tool axis vector. If no ijk information is found, then a tool axis of 0,0,1 is 
assumed. 
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GODLTA record 
Designates incremental cutter movement relative to the current cutter location. 

Formats: 
GODLTA/x,y,z - specifies the incremental distance along each axis to move the tool 
from its current location. For example, if the tool is currently at 4, 5, 6 in xyz when 
GODLTA/1,2,3 is processed, the tool moves to x=5 (4+1), y=7 (5+2), and z=9 (6+3). 

GODLTA/value - moves the cutter along the tool axis the specified amount. 

If there is a transformation active, such as by a previous rotary motion command or a 
stock transformation, then the GODLTA values are transformed accordingly. 

 

GOFWD record 
Designates forward cutter movement relative to the current cutter location. VERICUT 
considers this record only when processing motion generated by GOFWD used with 
CIRCLE or CYLNDR records. Numerous formats are recognized, many of which also 
consider the INDIRV record to determine the "forward" motion direction. 

 

GOHOME record 
Specifies that the cutter return to the home position. The home position is assumed to be 
the location specified by the last FROM record processed. If a FROM record has not been 
processed, then 0, 0, 0 is used. 

Formats: 
GOHOME - move all axes to the home position. The GOHOME Motion feature, on 
the APT Settings window: Motion tab, controls if the cutter is moved in a straight 
line, or is retracted prior to going home. 

GOHOME/XAXIS(YAXIS or ZAXIS) - treated as GOTO statements with the 
specified AXIS element set to the FROM value for that axis. The other two elements 
are set to the current tool path position values. 

 

GOTO record 
Designates a position where the tool is moved to. 

Formats: 

GOTO/x,y,z[,i,j,k] - where "x,y,z" represent the ending location of the tool motion 
and optional "i,j,k" values control the tool axis in multi-axis movements. "0,0,1" tool 
axis orientation is assumed. "GOTO/" text is optional after the first GOTO motion,  
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for example: 

GOTO/x,y,z[,i,j,k] 

x,y,z[,i,j,k] 

: 

 

HEAD record 
Found in tool paths for mill-turn and 4-axis lathe machines, the "HEAD" record specifies 
which machining head is in use. 

Formats: 
HEAD/1- head 1 active 

HEAD/2- head 2 active 

HEAD/BOTH- head 1 active 

HEAD/OFF- head 1 active 

When head 2 is active the tool is changed via a "LOADTL" or "TURRET" record, 
VERICUT prepends the tool ID specified by the LOADTL/TURRET record with the 
characters "2_" to retrieve tools defined for use by head 2. 

Example 1: 
HEAD/1 

TURRET/1 

Looks for ID "1" in the Tool Library (interpreted as tool 1 for use by head 1). 

Example 2: 
HEAD/2 

TURRET/1 

Looks for ID "2_1" in the Tool Library (interpreted as tool 1 for use by head 2). 

 

INDIRV record 
Vector coefficients describing the "forward" motion direction. VERICUT considers this 
record only when processing motion generated by a GOFWD record used with CIRCLE 
or CYLNDR records. 

Format: 
INDIRV/i,j,k 
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KNOT record 
Defines a knot parameter for use with a NURBS record. 

Format: 
KNOT/t1,...,t(n-p+2) - where "t1" - "t(n-p+2)" are the knot parameters. 

 

LOAD/TOOL record 
Specifies the tool number to be changed into the spindle, same as LOADTL record. This 
record is not processed by default, however, you can use Tool Change By, in the NC 
Program window, to process this record and retrieve cutting tool descriptions from a 
VERICUT tool library. 

Format: 
LOAD/TOOL,n[,any text] 

See also HEAD record for information about how the Pro/MFG APT "HEAD" record 
affects how this record is used to retrieve tool from a VERICUT tool library. 

 

LOAD/WIRE record 
For wire EDM machining- causes the wire to be loaded-sets cutting mode in VERICUT 
for wire EDM machining. See also UNLOAD/WIRE record. 

 

LOADTL record 
Specifies the tool number, or pocket number of the tool to be changed into the spindle. 
Optionally, this record may also specify tool length or other aspects about the tool, 
however, VERICUT ignores all parameters following the tool number. 

This record is not processed by default, however, you can use Tool Change By, in the 
NC Program window,  to process this record and retrieve cutting tool descriptions from 
a VERICUT tool library. 

Format: 
LOADTL/n[,any text] - where "n" is the index number of the tool (number or alpha-
numeric). Leading zeros in the tool ID are also ignored, for example "LOADTL/01" 
is interpreted as "LOADTL/1". Any text following the "/" or number data after tool 
ID is ignored, for example "LOADTL/2,LENGTH,6.500" is interpreted as 
"LOADTL/2". 

See also HEAD record for information about how the Pro/MFG APT "HEAD" record 
affects how this record is used to retrieve tools from a VERICUT tool library. 
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MODE record 
Identifies the machining to be performed: mill or turn. 

Formats: 
MODE/MILL(TURN) 

 

MOVARC record 
Causes circular motion, same as CIRCLE record. 

 

MSYS record 
Specifies an NX-style nine parameter tool path transformation matrix. VERICUT 
processes this record when Process Matrix, on the APT Settings window: Motion tab, is 
active. 

 

MULTAX record 
Determines if subsequent GOTO motions are multi-axis motions. The multi-axis 
condition is modal. When multi-axis mode is on it remains on until another MULTAX 
record turns it off. 

Formats: 
MULTAX/ON 

MULTAX/OFF 

 

NURBS record 
Defines a NURBS B-spline motion command. NURBS motion commands also utilize the 
CNTRL record and KNOT record as part of the B-spline definition. 

Format: 
NURBS/[p]- where "p" indicates the B-spline order. The "NURBS" record typically 
spans multiple lines and includes a number of other record types, such as "KNOT", 
"CNTRL", etc. 

Example: 

NURBS/  

KNOT/1.0000000  

CNTRL/61.2424,93.2577,-31.6260  

:  

CNTRL/59.8775,93.2224,-31.6263  
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PPRINT record (general purpose) 

Comment record that typically has no affect on tool motion. "PPRINT" resides in 
columns 1-6. Text following "PPRINT" is typically ignored by VERICUT, however, 
some PPRINT records can perform VERICUT actions. See also "Controlling 
VERICUT with comment records" in the Using VERICUT section. Using VERICUT 
can be found in the CGTech Help Library. 

 

PPRINT/ATP CBOX record 
Defines a stock block via min/max corner points. This record is processed by VERICUT 
when a stock model is loaded and the model is not yet cut. A new stock block is defined 
and fit into all displayed views. 

Format: 
PPRINT/ATP CBOX xmin,ymin,zmin,xmax,ymax,zmax 

Example: 
PPRINT/ATP CBOX -1,-2,-1,5,7,2 -defines a 6 x 9 x 3 block positioned X= -1, Y= -
2, Z= -1 

 

PPRINT TOOL AXIS record 
Specifies a new tool axis orientation to be applied to subsequent tool positions. The 
specified tool axis is modal and remains in effect until another tool axis orientation is 
specified. 

Example: 
PPRINT TOOL AXIS= XAX=-1.0000 YAX=.0000 ZAX=.0000 

 

PPRINT/VERICUT record 
(or PPRINTVERICUT) Sets a VERICUT user value, or performs a VERICUT 
command or action. PPRINT/VERICUT text must be between columns 1-72. PPRINT 
data can span multiple PPRINT records via ending each PPRINT to be continued in a 
dollar sign. The next line must be a PPRINT/VERICUT record with the same keyword as 
the previous line. Words in PPRINT data can not be split by the dollar sign. Examples are 
provided in the sections that follow. 

See also "Controlling VERICUT with comment records" in the Using VERICUT 
section. Using VERICUT can be found in the CGTech Help Library. 
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RAPID record 
Overrides the current feed rate and causes a machine tool to move as fast as possible. 
When the RAPID record is processed by VERICUT, the motion following the RAPID 
moves the tool using the Fast Feed setting in the Motion window. 

For example, assume the file below is processed while Fast Feed=100. 

RAPID 

GOTO/1,2,3 

FEDRAT/20 

GOTO/2,3,4 

RAPID 

GOTO/3,4,5 

GOTO/4,5,6 

The motions are simulated by VERICUT as follows: 

feed rate from the current tool location to 1,2,3: 100 

feed rate from 1,2,3 to 2,3,4: 20 

feed rate from 2,3,4 to 3,4,5: 100 

feed rate from 3,4,5 to 4,5,6: 20 

In both examples below, motion from 1, 2, 3 to 4, 5, 6 uses a feed rate of "20": 

Example 1: 
FROM/1,2,3 

RAPID 

FEDRAT/20 

GOTO/4,5,6 

In example 1, a FEDRAT record immediately follows the RAPID record before a motion 
is encountered. Under this condition, the FEDRAT value overrides a RAPID record. 

Example 2: 
RAPID 

FROM/1,2,3 

FEDRAT/20 

GOTO/4,5,6 

In example 2, a FROM record is not considered to be a motion record. Therefore, the 
RAPID record has no affect. 
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RETRCT record 
Retracts the cutter along the tool axis to a specified clearance plane, or by a specified 
amount. 

Formats: 
RETRCT- retract the tool along the tool axis until it reaches the clearance plane 
defined by the previous CLEARP or CLRSRF record 

RETRCT/value- retract along the tool axis the specified amount 

RETRCT/ON- retract to the Z level prior to a cycle record. 

Example: 
GOTO/1,2,3 

RETRCT/ON 

CYCLE/DRILL,1.0,3,IPM,.1 $$ Retracts to Z=3 between cycle positions. 

 

ROTABL record 
Specifies a table rotation. Unless otherwise specified, rotation about the Y-axis is 
assumed. This record is processed when the ROTABL setting, on the APT Settings 
window: Rotary tab, is active. Otherwise, ROTABL is ignored. 

Formats: 
ROTABL/AAXIS(BAXIS or CAXIS),value 

ROTABL/AAXIS(BAXIS or CAXIS),ATANGL,value 

ROTABL/AAXIS(BAXIS or CAXIS),INCR,value 

ROTABL/ATANGL,value 

ROTABL/INCR,value 

 

ROTATE record 
Similar to the ROTABL record, this record specifies a table rotation. ROTATE is 
handled differently, depending on the active setting of NC Program Type, in the NC 
Program window. 

1. Non-ProManufacturing tool path types - when the ROTATE setting, on the APT 
Settings window: Rotary tab, is active the rotary action is simulated by 
VERICUT. Otherwise, ROTATE is ignored. 

2. Pro/MFG APT tool path types- ROTATE is considered along with TRAN and 
CSYS when determining if the tool path is to be transformed. See "CSYS record" 
for details. The "$$->FEATNO" record resets back to the identity matrix, and 
"$$->END" ends TRANS/ROTATE/CSYS actions. 



VERICUT HELP – Project menu 
 

Formats: 
ROTATE/AAXIS(BAXIS or CAXIS),value 

ROTATE/AAXIS(BAXIS or CAXIS),ATANGL,value 

ROTATE/AAXIS(BAXIS or CAXIS),INCR,value 

ROTATE/ATANGL,value 

ROTATE/INCR,value 

 

ROTHED record 
Specifies a head rotation. This record is processed when the ROTHED setting, on the 
APT Settings window: Rotary tab, is active. Otherwise, ROTHED is ignored. 

Formats: 
ROTHED/ATANGL,value 

ROTHED/value 

 

SET/MODE record 
This record specifies the machining to be performed: mill or turn. 

Formats: 
SET/MODE,MILL 

SET/MODE,TURN 

 

SPINDL record 
Specifies spindle rotation speed (RPM); direction and gear ranges may also be specified. 
Text following the slash is displayed in the Status window as the current spindle 
condition. 

Formats: 
SPINDL 

SPINDL/rpm[,any text] 

SPINDL/[any text,]rpm 

 

SPNDL record 
Specifies spindle rotation speed (RPM), same as SPINDL record. 
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STOP record 
Stops the NC machine at its current location. This record commonly indicates an operator 
function follows, such as: changing the tool, changing the part-fixture setup, etc. 

 

SURFACE record 
Causes circular motion, same as CIRCLE record. 

 

TLAXIS record 
Specifies a new tool axis orientation. The new orientation is modal and is applied to 
following GOTO points that do not have I, J, K values. VERICUT processes this record 
when NC Program Type, in the NC Program window, is set to CATIA APT. 

Example: 
TLAXIS/ .000000, 1.000000, .000000 

 

TRANS record 
Specifies a three parameter tool path translation. VERICUT processes this record when 
NC Program Type, in the NC Program window, is set to Pro/MFG APT and 
conditions are suitable. The presence of ROTATE and TRANS records affect when 
VERICUT processes a TRANS record. See "CSYS record" for details. 

Format: 
TRANS / dx, dy, dz 

where "dx, dy, dz" are the distances in X, Y, and Z to translate the tool positions that 
follow. The "$$->FEATNO" record resets back to the identity matrix, and "$$-
>END" ends TRANS/ROTATE/CSYS actions. 

 

TURRET record 
Similar to LOADTL record, this record often appears in tool paths for turning operations 
to specify the tool number to be changed into location for cutting. This record is not 
processed by default, however, you can use Tool Change By, in the NC Program 
window, to process this record and retrieve cutting tool descriptions from a VERICUT 
tool library. 

The number following "TURRET" is often a composite of two numbers: a tool number 
and offset number. However, VERICUT simply interprets the entire number as a tool 
number. For example, while "TURRET/0101" may indicate tool 01 is used with offset 
01), VERICUT interprets this to mean tool 0101 (or 101) is to be used from the 
VERICUT tool library. 
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Formats: 
TURRET/n[,any text] 

TURRET/FACE,n[,any text] 

See also HEAD record for information about how the Pro/MFG APT "HEAD" record 
affects how this record is used to retrieve tools from a VERICUT tool library. 

 

UNITS record 
Sets the unit measurement system of the data in the tool path file: inches or millimeters. 

Formats: 
UNITS/INCHES 

UNITS/MM 

 

UNLOAD/WIRE record 
For wire EDM machining- causes the wire to be unloaded-sets non-cutting mode in 
VERICUT for wire EDM machining. See also LOAD/WIRE record. 

 

VECTOR record 
Designates a position where the tool is moved to, same as GOTO record. 
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Output window 
Location:  Project menu > Output 

VERICUT toolbar short cut:   

Opens the VERICUT Output files window to setup, create, or view VERICUT's many 
output files. 

  

 
   

In Process tab — Features on this tab control automatic saving of In Process files, or "IP 
files". The features on this tab provide the same functionality as the AutoSave window, 
In Process tab found in the File section. 

View Capture tab — Features on this tab control automatic saving of View Capture 
image files (JPEG, PS, EPSF, or TIFF files). 

VERICUT Solid tab — Features on this tab control automatic saving of VERICUT Solid 
(vct.) files. 
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General tab — Features on this tab enable you to specify and view VERICUT Log files, 
and OptiPath modified (optimized) NC Program files. It also provides access to the 
OptiPath Control window.  

G-Code Files tab — Use the features on this tab to specify and view the G-Code Log file 
and the APT Output file. 

Movie tab — Use the features on this tab to specify an output file, record, and view 
VERICUT Image files or AVI files. 

   

OK — Saves all tab settings and closes the VERICUT Output Files window. 

Apply — Saves all tab settings and leaves the VERICUT Output Files window open. 

Cancel — Closes the VERICUT Output Files window without saving settings. 
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Output window, In Process tab 
Location:   Project menu > Output window 

VERICUT toolbar short cut:  

  

Features on this tab control automatic saving of In Process files, or "IP files". 

  

 
  

Auto Save options 
These options control when VERICUT automatically saves IP files. Click on the box to 
the left of the event to toggle On/Off. Each selected event causes a file to be saved when 
that event occurs. 

Options: 
Cutter Change — When toggled "On", an In Process file is saved whenever the cutter 
has been changed. 

# of Cuts — When toggled "On", an In Process file is saved after a specified number of 
cuts. Enter the number of cuts in the # of Cuts text field. 
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File End — When toggled "On", an In Process file is saved at the end of tool path 
processing. Choose either End of each File (end of each toolpath file) or End (end of the 
NC program) from the pull-down list. 

In Process File — Use to specify the base name for In Process files saved. Enter the 
\path\filename in the In Process File text field, or click on Browse and use the selection 
window that displays to specify the file. 

Unique file names are maintained by appending the tool path number and line number of 
the record causing the event to the end of the base file name. Naming convention for 
auto-saving files is: <IPfilename>n1_n2.ip where "<IPfilename>" is the name specified 
in the In Process File field, "n1"=sequential tool path number, and "n2"=number of the 
record causing the auto-save event. 

The following examples assume the Output window configuration shown below. 

 

 
  

Example 1:  One tool path processed, tool change on record #10 => test1_10.ip 

Example 2:  Two tool paths processed, tool change on record #10 in both tool paths => 
test1_10.ip (from tool change in tool path #1), test2_10.ip (from tool change in tool path 
#2) 

Example 3: Two tool paths processed, tool path one tool change on record #10, tool path 
two tool change on record #5 => test1_10.ip (from tool change in tool path #1), test2_5.ip 
(from tool change in tool path #2) 
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Auto Error options 

Options: 
On — When active, VERICUT automatically saves an IP file when an error is detected. 

In Process File — Specifies the base name for IP files saved due to errors. Similar to In 
Process File for the Auto Save options (see above), unique file names are maintained by 
appending the line number of the record causing the error to the end of the specified IP 
file name. 

 
 
To Output window
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Output window, View Capture tab 
Location:  Project menu > Output 

VERICUT toolbar short cut:  

  

Features on this tab control automatic saving of View Capture image files (JPEG, PS, 
EPSF, or TIFF). 

  

 
  

Print Command — When toggled "Off", sends graphical data to the specified View 
Capture image file. When toggled "On", executes the print command that sends raw 
graphical image data to the printer. 

By default, the "prshade" command executes the "prshade" command file containing 
operating system commands typically used to print images on your computer. If printing 
fails, correct the entry in the Print Command field, or use an ASCII text editor (NOT a 
word processor) to edit the "prshade" command file to have the proper print command for 
your computer/printer. 

Properties — Opens the View Capture window to access settings for file formatting and 
printing. 
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 Auto Save options 
These options control when VERICUT automatically saves View Capture image files. 
Click on the box to the left of the event to toggle On/Off. Each selected event causes a 
file to be saved when that event occurs.  

Options: 
Cutter Change — When toggled "On", a View Capture image file is saved whenever the 
cutter has been changed. 

# of Cuts — When toggled "On", a View Capture image file is saved after a specified 
number of cuts. Enter the number of cuts in the # of Cuts text field. 

File End — When toggled "On", a View Capture image file is saved at the end of tool 
path processing. Choose either End of each File (end of each toolpath file) or End (end 
of the NC program) from the pull-down list. 

View Capture File — Use to specify the base name for View Capture image files saved 
as a result of using the Auto Save options described above, when the Print Command 
checkbox is toggled "Off". Enter the \path\file name in the View Capture File text field, 
or click on Browse and use the selection window that displays to specify the file. The 
naming convention used for saved files is the same as described for In Process files. See 
the In Process tab section for details. 

  

Auto Error options 
These options control when VERICUT automatically saves View Capture files due to 
errors. 

Options: 
On — When toggled "On", VERICUT automatically saves a View Capture image file 
when an error is detected. 

View Capture File — Use to specify the base name for View Capture image files 
automatically saved as a result of errors detected when AutoError On is toggled "On", 
and the Print Command checkbox is toggled "Off". Enter the \path\file name in the 
View Capture File text field, or click on Browse and use the Save File selection window 
that displays to specify the file. The naming convention used for saved files is the same 
as described for In Process files. See the In Process tab section for details. 

 
 
To Output window
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Output window, VERICUT Solid tab 
Location:   Project menu > Output 

VERICUT toolbar short cut:   

  

Features on this tab control automatic saving of VERICUT Solid (vct.) files. 

  

 
  

Auto Save options 
These options control when VERICUT automatically saves VERICUT Solid files. Click 
on the box to the left of the event to toggle On/Off. Each selected event causes a file to be 
saved when that event occurs.  

Options: 
Cutter Change — When toggled "On", a VERICUT Solid file is saved whenever the 
cutter has been changed. 

# of Cuts — When toggled "On", a VERICUT Solid file is saved after a specified 
number of cuts. Enter the number of cuts in the # of Cuts text field. 
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File End — When toggled "On", a VERICUT Solid file is saved at the end of tool path 
processing. Choose either End of each File (end of each toolpath file) or End (end of the 
NC program) from the pull-down list. 

VERICUT Solid File — Use to specify the base name for VERICUT Solid files saved 
due to Auto Save options. Enter the \path\filename in the VERICUT Solid File text 
field, or click on Browse and use the file selection window that displays to specify the 
file. 

  

AutoError options 
Use these options to specify whether or not VERICUT automatically saves VERICUT 
Solid files when an error is detected. 

Options: 
On — When toggled "On", VERICUT automatically saves a VERICUT Solid file when 
an error is detected.  

VERICUT Solid File — Use to specify the base name for VERICUT Solid files saved 
when AutoError On is active. Enter the \path\file name in the VERICUT Solid File text 
field, or click on Browse and use the file selection window that displays to specify the 
file. 

NOTE: The naming convention used for saved VERICUT Solid files is the same as 
described for In Process files. See the In Process tab section for details. 

 
 
To Output window
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Output window, General tab 
Location:  Project menu > Output 

VERICUT toolbar short cut:  

  

Features on this tab enable you to specify and view VERICUT Log files, and OptiPath 
modified (optimized) NC Program files. It also provides access to the OptiPath Control 
window. 

  

 
  

Log File 
Use to specify the name of the VERICUT Log file. Enter the \path\file name in the Log 
File text field, or click on Browse and use the file selection window that displays to 
specify the file. 

View — Opens a window containing the VERICUT Log file. This file contains session 
information, such as error, warning and informational messages about the verification 
session. Standard text editing features are provided, such as: copy/cut, paste, search, etc. 
For more information on using the editing features, see Text File under Edit menu. 
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OptiPath 
Use to specify the name of the Optimized file. Enter the \path\filename in the OptiPath 
text field, or click on Browse and use the file selection window that displays to specify 
the file. 

Settings — Displays the OptiPath Control window. 

View — Opens a window containing the optimized NC program file. Standard text 
editing features are provided, such as: copy/cut, paste, search, etc. For more information 
on using the editing features, see Text File under Edit menu. 

 
 
To Output window
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Output window, G-Code Files tab 
Location:   Project menu > Output 

VERICUT toolbar short cut:   

  

Use the features on this tab to specify, and view, Control Reports, APT Output Files and 
the G-Code Log Files. 

  

 
  

Control Report 
Enter the \ path\filename of the Control Report file in the Control Report text field, or 
use the Browse button and use the file selection window that displays to specify it. This 
file contains information about how the current NC control configuration will interpret 
various codes.  

View — Opens a window containing the Control Report file. In this window, you can 
view, edit, or reset the Control Report file contents. Standard text editing features are 
provided, such as: copy/cut, paste, search, etc. For more information on using the editing 
features, see Text File under Edit menu. 
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APT Output File 
Enter the \path\filename of the APT Output file in the APT Output File text field, or use 
the Browse button and use the file selection window that displays to specify it. This file 
contains information, such as error, warning and informational messages about G-Code 
processing.  

View — Opens a window containing the APT Output file with ASCII APT tool path 
records created when Create APT Output File is active (ref. Process Options window: 
G-Code Output Files tab). Standard text editing features are provided, such as: 
copy/cut, paste, search, etc. For more information on using the editing features, see Text 
File under Edit menu. 

  

G-Code Log File 
Enter the \path\filename of the G-Code Log file in the G-Code Log File text field, or use 
the Browse button and use the file selection window that displays to specify it. This file 
contains information, such as error, warning and informational messages about G-Code 
processing.  

View — Opens a window containing the G-Code Log file. In this window, you can view, 
edit, or reset the G-Code Log file contents. Standard text editing features are provided, 
such as: copy/cut, paste, search, etc. For more information on using the editing features, 
see Text File under Edit menu. 

 

Click here to see a sample G-Code Log file. 
 
 
To Output window 
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Output window, Movie tab 
Location:   Project menu > Output 

VERICUT toolbar short cut:   

  

Use the features on this tab to specify an output file, record, and view VERICUT Image 
files or AVI files. 

  

 
  

Movie 
Use to specify the name of the Image/AVI output file. Enter the \path\filename in the 
Movie text field, or click on Browse and use the file selection window that displays to 
specify the file.  

Settings — Displays the Image Record window. 

View — Opens a "VERICUT Player" window (or "AVI Player" window) to load and 
play back an Image file (or AVI file). The type of "player" window that opens depends on 
the Output Format setting in the Record Movie window. 

 
To Output window
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Report (Report Template window) 
Location: Project menu > Report > Report Template >Edit in the main VERICUT 
window. 

                 File > Report Template in the Inspection Sequence window. 

                 File > Report Template in the Tool Manager window. 

  

Opens the Report Template window enabling you to define a new, or modify an existing, 
report template.  

  

 
  

The Menu Bar 
File 

New — Displays an empty Report Template window enabling you to create a 
new report template file.  

Open — Displays a file selection window enabling you to open an existing report 
template file. The "current" report template file is stored in the Preferences file. 

Save — Opens a window enabling you to save the current report template file. 

Save As — Opens a window enabling you to save the current report template file 
under a different name or path.  

Recent Files — Provides a list of recently opened Report Template files. To open 
a file in the list, select the desired file. List contents are stored in the Preferences 
file.  

Close — Closes the Report Template window without saving the report template 
file. 

 

Edit 
Add — Enables you to add records to a new or existing report template file.  

Edit — Enables you edit the content of the highlighted record. This feature is 
only available for the Page Layout tab. 
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Delete — Enables you to delete the highlighted record from the report template 
file. 

 

The Tabs 
Page Layout tab — Features on this tab enable you to specify or modify the 
content and page layout of a report template. 

Styles tab — Features on this tab enable you to specify display characteristics 
(font, font size, color, etc.) to be used for the report template. 

User-Defined Tags tab — Features on this tab enable you to specify "generic" 
records included in a report template that will be updated with information 
specific to a particular user file at the time the report is created. The user file 
specific information can be associated with the User-Defined Tag using the User-
Defined Tag Values window. If all User-Defined Tag values are not defined 
prior to creating a report, you will be prompted for any missing information at the 
time the report is created. 

Page Setup tab — Features on this tab enable you to specify or modify page 
format characteristics such as margins, orientation and paper size. The features on 
this tab are intended to be use with PDF format reports, although it may also be 
useful for HTML format reports with certain web browsers. 

  

 
Also see "Working with VERICUT Reports", in the Using VERICUT section, in the 
CGTech Help Library.
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Report Template window, Page Layout tab  
Location:  Project menu > Report > Report Template >Edit in the main VERICUT 
window. 

                File > Report Template in the Inspection Sequence window. 

              File > Report Template in the Tool Manager window. 
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The Menu Bar 
 
File 
See Report Template window, above, for a description of the File features. 

 

Edit 
Add — Enables you to add records to a new or existing report template file. The 
following features are available for use in report templates: 

NOTE:  When starting a new report template, Add will not become active until at least 
one style record has been added using the Styles tab. 

Text 
Use to add text related records to a report template. Select the desired option from the 
pull-down list. The options in the list will vary depending on where you accessed the 
Report Template window (VERICUT main window, Tool Manager window, or the 
Inspection Sequence window). 

String — Adds a record to write out a specified text string. Enter the text in the 
"Content" field of the record. 

 

Date — Adds a record to write out the date with the format selected from the 
pull-down list. 

Short — "12/24/03" 
Medium — "Dec 24, 2003" 
Long — "December 24, 2003" 
Full — "Wednesday, December 24, 2003" 
 

Time — Adds a record to write out the time with the format selected from the 
pull-down list. 

Short — "10:49 AM" 
Medium — "10:49:48 AM" 
Long — "10:49:48 AM PST" 
 

Page Number — Adds a record to write out page numbers with the format 
selected from the pull-down list. 

# — "1" 
Page # — "Page 1" 
Page # of # — "Page 1 of 3" 
 



VERICUT HELP – Project menu 
 

File Name  
Adds a record to write out the file name of the file type selected from the pull-
down list. Choose either, Full Path (to write out the file name in the format 
/path/filename), or File Name (to write out the file name only), then select the file 
type from the pull-down list. 

Project File — Adds a record to write out the file name of the "current" 
Project file. 
Machine File — Adds a record to write out the file name of the "current" 
Machine file.  
Control File — Adds a record to write out the file name of the "current" 
Control file.  
Tool Library File — Adds a record to write out the file name of the "current" 
Tool Library file.  
Design Model File — Adds a record to write out the file name of the 
"current" Design Model file.  
NC Program — Adds a record to write out the file name of the "current" NC 
Program File.  
Log File — Adds a record to write out the file name of the "current" Log file. 
Optimized NC Program File — Adds a record to write out the file name of 
the "current" Optimized Toolpath file.  
 

Process Data — Adds a record to write out "process" related data of the type 
selected from the pull-down list. 

Material — Adds a record to write out the "material" specified on the 
OptiPath Control window, Settings tab. 
Machine — Adds a record to write out the "machine" specified on the 
OptiPath Control window, Settings tab.  
Total Time — Adds a record to write out the total time anticipated to 
machine the part (as simulated by VERICUT). 
Total Number of Errors — Adds a record to write out the number of errors 
detected by VERICUT. 
Total Number of Warnings — Adds a record to write out the number of 
warning detected by VERICUT.  
Total Optimized Time —Adds a record to write out the total time anticipated 
to machine the part (as simulated by VERICUT) using optimized toolpath 
files.  
Total Time Difference— Adds a record to write out the total time difference 
between Total Time and Total Optimized Time.   
Total Distance — Adds a record to write out the total tool movement 
distance. 
Total Cut Distance % — Adds a record to write out the total percentage of 
tool movement distance that occurred while in feed rate mode. 
Total Volume Removed — Adds a record to write out the total volume of 
material removed. 
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Stock Envelope — Adds a record to write out the rough dimensions of the 
stock. 
 

Tool Change Data — Adds a record to write out "tool" related data, of the type 
selected from the pull-down list, for the current tool. 

Seq — Adds a record to write out the sequential number of the last tool 
change event. 
Record — Adds a record to write out the last tool change record processed. 
Includes both the sequential line number and the record text. 
Tool Description — Adds a record to write out the tool ID and description of 
a tool retrieved from a VERICUT Tool Library file. A blank field indicates a 
description for this tool was not defined in the library, or the tool did not come 
from a tool library.  
Cutter Info — Adds a record to write out cutter shape geometry data. 
Includes both the method used to define the cutter shape (shown in square 
brackets "[ ]", for example [Profile]  indicates a profile type of cutter 
definition) followed by the parameter values used to describe the cutter. 
Cutter Height — Adds a record to write out the height of the cutter. 
Flute Length — Adds a record to write out the flute length of the cutter. 
Gage Point — Adds a record to write out the cutter's gage point value. 
OptiPath Record — Adds a record to write out the OptiPath tool description 
and the number of teeth for the tool 
Optimized By — Adds a record to write out the optimization method used for 
the tool. 
Original Time — Adds a record to write out the anticipated cutting time (as 
simulated by VERICUT) for the tool. 
Optimized Time — Adds a record to write out the anticipated optimized 
cutting time (as simulated by VERICUT) for the tool. 
Time Difference — Adds a record to write out the difference between the 
optimized and un-optimized cutting times for the tool 
Distance — Adds a record to write out the tool movement distance. 
Distance % — Adds a record to write out the percentage of tool movement 
distance while in feedrate mode. 
Volume Removed — Adds a record to write out the volume of material 
removed by the tool. 
Errors — Adds a record to write out the number of errors detected by 
VERICUT for the tool. 
Warnings — Adds a record to write out the number of warnings output by 
VERICUT for the tool. 
Min Extension — Adds a record to write out the minimum height required to 
avoid shank/holder collisions with the tool. 
Tool ID — Adds a record to write out the Tool ID of the "current" tool. 
Driven Point — Adds a record to write out the driven point of the "current" 
tool. 
Teeth — Adds a record to write out the number of teeth (flutes) of the 
"current" tool. 
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Cutter ID — Adds a record to write out the Cutter ID of the "current" tool 
assembly. 
Holder ID — Adds a record to write out the Holder ID of the "current" tool 
assembly. 
Cutter Diameter — Adds a record to write out the diameter of the "current" 
tool. 
Cutter Stick-out — Adds a record to write out the "cutter stick-out" value 
(distance from the tip of the tool to the lowest point on the holder) of the 
"current" tool. 
Cutter Compensation — Adds a record to write out the cutter compensation 
value of the "current" tool. 
Comments — Adds a record to write out the Tool Manager Comments of the 
"current" tool. 
Air Time % — Adds a record to write out the percent of time that the 
"current" tool spent cutting air. 
Axial Depth — Adds a record to write out the depth of cut. 
Radial Width — Adds a record to write out the width of cut. 
Maximum Spindle Speed — Adds a record to write out the maximum 
spindle speed. 
Minimum Spindle Speed — Adds a record to write out the minimum spindle 
speed. 
Maximum Feedrate — Adds a record to write out the maximum feedrate. 
Minimum Feedrate — Adds a record to write out the minimum feedrate. 
 

User-Defined Tags — 
Add User-Defined Tag — Adds a record to write out the value of a "text 
type" User Defined Tag. Use Add User-Defined Tag, to create a new "text 
type" User-Defined Tag, or select an existing User-Defined Tag from the pull-
down list. 

 

Table — Displays a window enabling you to add a VERICUT generated table, or 
"custom" table, to a report template. Choose one of the following table types from the 
Table pull-down list. Each type in detail in a separate section below. 

Custom Table — Displays the Custom Table window enabling you to output a 
table of your own design to a VERICUT report. 

File Summary Table — Displays the File Summary Table window enabling you 
to output a VERICUT generated file summary table to a VERICUT report. 

Tool Summary Table — Displays the Tool Summary Table window enabling 
you to output a VERICUT generated tool summary table to a VERICUT report. 

View Capture Table — Displays the View Capture Table window enabling you 
to output a VERICUT generated table containing View Capture images specified 
using the features on  the File > AutoSave: View Capture tab.  
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Tools Table — Displays the Tools Table window enabling you to output a 
VERICUT generated tool table to tool library report.  

The Tools Table window is only available when the Report Template window 
was accessed from the Tool Manager menu bar (File menu > Report Template). 

Inspection Features Table — Displays the Inspection Features Table window 
enabling you to output a VERICUT generated inspection features table to an 
inspection report. 

The Inspection Features Table window is only available when the Report 
Template window was accessed from the Inspection window menu bar (File 
menu > Report Template). 

or choose one of the existing (if any) "table type" User-Defined Tags at the bottom of 
the list. 

 

Picture — Displays the Picture window enabling you to add VERICUT generated 
pictures, or custom pictures from a file, to a report template. 

Page Break — Enables you to manually add page breaks to control printed output. 

Start Toolpath Loop — Use to mark the "start" of a group of records that will be output 
for each toolpath in user files containing multiple toolpaths. 

End Toolpath Loop — Use to mark the "end" of a group of records that will be output 
for each toolpath in project files containing multiple toolpaths. 

Start Tool Change Loop — Use to mark the "start" of a group of records that will be 
output at each tool change. 

End Tool Change Loop — Use to mark the "end" of a group of records that will be 
output at each tool change. 

Start View Loop — Use to mark the "start" of a multiple image Setup Plan. 

End View Loop — Use to mark the "end" of a multiple image Setup Plan. 

 

 NOTE:   PageBreak, Start Toolpath Loop, End Toolpath Loop, Start Tool Change 
Loop, End Tool Change Loop, Start View Loop, and End View Loop cannot be 
edited. They can only be deleted. 

 

The Record Table 
Each record in the table consists of five columns of information. Click on any column in 
a row to highlight a record for editing. The order of the records in the table can be 
changed by clicking on the square button at the beginning of the record and dragging the 
record to the desired position. Each record in the table consists of the following 
information: 
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Category — Use the options in this column to specify what "part" of the report the 
record is to be included. With the record highlighted, click on the record "category" and 
select from the pull-down list (Body, Page Header, Page Footer, First Page Header, or 
First Page Footer). 

Type — Indicates the record type. With the record highlighted, double click Table or 
Picture to display the corresponding window for editing the record. 

Content — Indicates the "content" of the record. With the record highlighted, double 
click on the content of a Table or Picture record to display the corresponding window for 
editing the record. Double click on the "content' of a text string record to add or modify 
the text. 

Alignment — Indicates how the information will be aligned horizontally in the report. 
With the record highlighted, click on the record "category" and select from the pull-down 
list (Body, Page Header, Page Footer, First Page Header, or First Page Footer). 

Style — Indicates the "style" to be used for the record.  With the record highlighted, click 
on the record "style" and select from the pull-down list. The list will contain all for the 
styles that have been defined, using the Styles tab, for the current report template. 

 

Shortcut:  Right-click in the Record Table to display the following menu: 
 

 
 

 

NOTE:  These features provide the same functionality as those described above 
under Edit in the main menu. The third level features (Date, Time, Page Number, 
etc.) each have an additional pull-down list of features as described above under Edit. 

 

 

To Report Template window 
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Custom Table window 
 

The features in the Custom Table window enable you to output a table of your own 
design to a VERICUT Report.  

 

 
 

Table — Custom Table 

TIP:  The Table field is editable so that you can create a user defined table tag which  
will enable you to populate the table with the contents of a text file. See Using Data 
from a File in a Report, in the Using VERICUT section, in the CGTech Help Library 
for additional information. 

No. of Columns — Enter the number of columns that you want in the table. 

No. of Rows — Enter the number of rows that you want in the table. 

 
Once you specify the number of columns and rows that you want in the table, pressing 
OK, expands the window as shown below so that you can define the contents of the table. 
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Right-clicking in any of the table cells displays a pop-up menu with the following 
options: 

InsertRow — Use to insert an additional blank row into the table. 
Insert Column — Use to insert an additional blank column into the table 
Delete Row — Use to delete the row containing the highlighted cell. 
Delete Column — Use to delete the column containing the highlighted cell. 
Insert Text — Select the desired feature from the pull-right list. Each of the features 
is described above in the Report Template window, Edit menu bar, under Text.  

Repeat to define the contents of each table cell. 

Alignment — Left-click in each cell in the alignment row and choose Left, Center, or 
Right from the pull-down list to specify how you want the data in that column to be 
positioned.  
 
The following picture shows an example of a finished "custom table" record. 
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The remainder of the window features (Table Width, Border Size, Thumbnail Width, 
Row Height, Maximum Rows/Page, OK, and Cancel) are common to all table 
windows and are described in the Common Table Features section below. 
 
 
Example Results 
Using a Custom Table defined as shown in the picture above will result in a table in the 
VERICUT Report similar to the following picture. 
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File Summary Table window 
 
File Summary Table — Displays the File Summary Table window enabling you to 
output a VERICUT generated file summary table to a VERICUT report. 
 

 
 

 
Table — File Summary Table 

View Capture Data List 
Each row in the File Summary Data List represents a column that will be displayed in a 
File Summary table in a VERICUT Report. The first row in the File Summary Data List 
is used to define the first column in the File Summary table. The second row in the File 
Summary Data List defines the second column in the File Summary table. 

The order of the rows in the File Summary Data List can be changed by clicking on 
square button at the beginning of any row and dragging the row to the desired position in 
the list. 

Column — The features in this column are used to specify the type of data that is to 
be displayed in this column of the report. 

File Type — Adds the file type (Project File, Machine File, Control File, etc.) to 
the File summary table record. 

File Name — Adds the /path/filename of the file to the File Summary table 
record. 
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Header — Use to define the column header to be used for the column in the File 
Summary table. Clicking on the "Header" item in a highlighted row, will put it in edit 
mode so you can enter a header label that is most meaningful in your work place. 

Alignment — Left-click in the Alignment cell in a highlighted row and choose Left, 
Center, or Right from the pull-down list to specify how you want the data in that 
column of the File summary table to be positioned. 
 

Add — Use to add a row after the highlighted row in the File Summary Data List. 

Delete — Use to delete the highlighted row from the File Summary Data List. 

 
The remainder of the window features (Table Width, Border Size, Thumbnail Width, 
Thumbnail Height, Maximum Rows/Page, OK, and Cancel) are common to all table 
windows and are described in the Common Table Features section below. 
 
 
Example Results 
Using a File Summary Table defined as shown in the picture above will result in a table 
in the VERICUT Report similar to the following picture. 
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Tool Summary Table window 
 

Tool Summary Table — Displays the Tool Summary Table window enabling you to 
output a VERICUT generated tool summary table to a VERICUT report. 

 

 
 

Table — Tool Summary Table 

Tool Data List 
Each row in the Tool Data List represents a column that will be displayed in the Tool 
Summary table in a VERICUT Report. The first row in the Tool Data List is used to 
define the first column in the Tool Summary table. The second row in the Tool Data List 
defines the second column in the Tool Summary table, and so on. 
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The order of the rows in the Tool Data List can be changed in a couple of ways. Clicking 
on one of the column headings (Column, Header, Alignment) in the Tool Data List will 
sort the table's rows alphabetically by the items contained in the column. Secondly, you 
can click on square button at the beginning of any row and drag the row to the desired 
position in the list. 

Column — The features in this column are used to specify the type of data that is to 
be displayed in this column of the report. Clicking on the "Column" item in a 
highlighted row, will display a pull-down list of data types that you can select from. 
The following are the data types that are available for use in a Tool Summary table.  

Thumbnail — Use to display an image of the tool, in a Tool Summary table 
record. 

View Capture — Use to output an image at the end of each cutting sequence, in a 
Tool Summary table record. View Capture, in the AutoSave window, must have 
both Cutter Change and File End : End of Each File toggled "On". 

See AutoSave window: View Capture tab, also in VERICUT Help, for 
additional information. 

Seq — Use to add the sequence number of the tool change event, to a Tool 
Summary table record. 

Record — Use to add the tool change record processed, to a Tool Summary table 
record. Includes both the sequential line number and the record text. 

Tool Description — Use to add a description of a tool retrieved from a 
VERICUT Tool Library file, to a Tool Summary table record. A blank field 
indicates a description for this tool was not defined in the library, or the tool did 
not come from a tool library. 

Cutter Info — Use to add cutter shape geometry data, to a Tool Summary table 
record. Includes both the method used to define the cutter shape (shown in square 
brackets "[ ]", for example [Profile]  indicates a profile type of cutter definition) 
followed by the parameter values used to describe the cutter. 

Cutter Height — Use to add the height of the cutter to a Tool Summary table 
record. 

Flute Length — Use to add the flute length of the cutter to a Tool Summary table 
record. 

Gage Point — Use to add the cutter's gage point value to a Tool Summary table 
record. 

OptiPath Record — Use to add the OptiPath tool description for the tool to a 
Tool Summary table record. 

Optimized By — Use to add the optimization method used for the tool to a Tool 
Summary table record. 

Original Time — Use to add the anticipated cutting time (as calculated by 
VERICUT) for the tool to a Tool Summary table. 
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Optimized Time —Use to add the anticipated optimized cutting time (as 
calculated by VERICUT) for the tool to the Tool Summary table record. 

Time Difference — Use to add the difference between the optimized, and un-
optimized, cutting times for the tool to a Tool Summary table record. 

Distance — Use to add the tool movement distance to a Tool summary table. 

Distance % — Use to add the percentage of the tool movement distance that 
occurred while in feedrate mode to a Tool Summary table record. 

Volume Removed — Use to add the volume of material removed by the tool to a 
Tool Summary table record. 

Errors — Use to add the number of errors detected by VERICUT for the tool to a 
Tool Summary table record. 

Warnings — Use to add the number of warnings output by VERICUT for the 
tool to a Tool Summary table record. 

Min Extension — Use to add the minimum cutter height required to avoid 
shank/holder collisions with the tool to a Tool Summary table record. 

Tool ID — Use to add the Tool ID of the tool to a Tool Summary table record. 

Driven Point — Use to add the driven point of the tool to a Tool Summary table 
record. 

Teeth — Use to add the number of teeth (flutes) of the tool to a Tool Summary 
table record.. 

Cutter ID — Use to add the Cutter ID(s) of the cutter/inserts used in the tool 
assembly to a Tool Summary record. 

Holder ID — Use to add the Holder ID(s) of the holders used in the tool 
assembly to a Tool Summary table record. 

Cutter Diameter — Use to add the diameter of the tool to a Tool Summary table 
record. 

Cutter Stick-out — Use to add the "cutter stick-out" value (distance from the tip 
of the tool to the lowest point on the holder) of the tool to a Tool Summary table 
record. 

Cutter Compensation — Use to add the cutter compensation value of the tool to 
a Tool Summary table record. 

Comments — Use to add the Comments from the Tool Manager for the tool to a 
Tool Summary table record. 

Air Time % — Use to add the percent of time that the tool spent cutting air to a 
Tool Summary table record. 
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Header — Use to define the column header to be used for the record in the Tool 
Summary table. Clicking on the "Header" item in a highlighted row, will put it in edit 
mode so you can enter a header label that is most meaningful in your work place. 

Alignment — Left-click in the Alignment cell in a highlighted row and choose Left, 
Center, or Right from the pull-down list to specify how you want the data in that 
column of the Tool Summary table to be positioned. 

 

Add — Use to add a row after the highlighted row in the Tool Data List. 

Delete — Use to delete the highlighted row from the Tool Data List. 

The remainder of the window features (Table Width, Border Size, Thumbnail Width, 
Thumbnail Height, Maximum Rows/Page, OK, and Cancel) are common to all table 
windows and are described in the Common Table Features section below. 
 
 
Example Results 
Using a Tool Summary Table defined as shown in the picture above will result in a table 
in the VERICUT Report similar to the following picture. 
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View Capture Table window 
 

View Capture Table — Displays the View Capture Table window enabling you to 
output a VERICUT generated table containing View Capture images, as specified on the 
File > AutoSave: View Capture tab, to a VERICUT Report.  

 

 
 
Table — View Capture Table 

View Capture Data List 
Each row in the View Capture Data List represents a column that will be displayed in the 
View Capture table in a VERICUT Report. The first row in the View Capture Data List is 
used to define the first column in the View Capture table. The second row in the View 
Capture Data List defines the second column in the View Capture table. 

The order of the rows in the View Capture Data List can be changed by clicking on 
square button at the beginning of any row and dragging the row to the desired position in 
the list. 

Column — The features in this column are used to specify the type of data that is to 
be displayed in this column of the report. 

Thumbnail — Displays a View Capture image to a View Capture table record. 

Comments — Displays VERICUT generated comments about the image. 
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Header — Use to define the column header to be used for the column in the View 
Capture table. Clicking on the "Header" item in a highlighted row, will put it in edit 
mode so you can enter a header label that is most meaningful in your work place. 

Alignment — Left-click in the Alignment cell in a highlighted row and choose Left, 
Center, or Right from the pull-down list to specify how you want the data in that 
column of the View Capture table to be positioned. 
 

Add — Use to add a row after the highlighted row in the View Capture Data List. 

Delete — Use to delete the highlighted row from the View Capture Data List. 

The remainder of the window features (Table Width, Border Size, Thumbnail Width, 
Thumbnail Height, Maximum Rows/Page, OK, and Cancel) are common to all table 
windows and are described in the Common Table Features section below. 
 
 
Example Results 
Using a View Capture Table defined as shown in the picture above will result in a table 
in the VERICUT  Report similar to the following picture. 
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Tools Table window 
 

Tools Table — Displays the Tools Table window enabling you to create a tool library 
report. The Tools Table window is only available when the Report Template window was 
accessed from the Tool Manager menu bar (File menu > Report Template). 

NOTE:  Report templates containing Tools Tables should only be used  for creating 
tool library reports from the Tool Manager window. Using them to create reports 
from other VERICUT applications will result in incorrect data being displayed in the 
report. 
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Table — tools 

Tool Data List 
Each row in the Tool Data List represents a column that will be displayed in the Tool 
Library Report. The first row in the Tool Data List is used to define the first column in 
the Tool Library Report. The second row in the Tool Data List defines the second column 
in the Tool Library Report, and so on. 

The order of the rows in the Tool Data List can be changed in a couple of ways. Clicking 
on one of the column headings (Column, Header, Alignment) in the Tool Data List will 
sort the table's rows alphabetically by the items contained in the column. Secondly, you 
can click on square button at the beginning of any row and drag the row to the desired 
position in the list. 

Column — The features in this column are used to specify the type of data that is to 
be displayed in this column of the report. Clicking on the "Column" item in a 
highlighted row, will display a pull-down list of data types that you can select from. 
The following are the data types that are available for use in a Tool Library Report. 

Thumbnail — Use to display a thumbnail image of the tool, in a Tool Library 
Report. 

ID — Use to display the alpha-numeric text that identifies the tool in the Tool 
Library, in a Tool Library Report.  

Description — Use to display the description of the tool in a Tool Library 
Report. 

Gage Point — Use to display the location of the gage point of the tool assembly,  
in a Tool Library Report. 

Driven Point — Use to display the offset for the tool control point, or "driven 
point", in a Tool Library Report. 

Type — Use to display the type of tool (Mill, Turn, Probe, etc.), in a Tool Library 
Report. 

Flute Length — Use to display the tool's flute length in a Tool Library Report. 

Cutter Geometry — Use to display the cutter geometry (for example, Bull Nose: 
1.5, 0.0625, 3.25)  in a Tool Library Report. 

OptiPath Description — Use to display the description from an OptiPath record 
associated with the tool, in a Tool Library Report. 

Teeth — Use to display the number of teeth that the tool has, in a Tool Library 
Report. 

Comments — Use to display  any comments from the tool library tool record, in 
a Tool Library Report. 

Cutter Compensation — Use to display the cutter compensation value of the 
tool in a Tool Library Report. 
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Cutter ID — Use to display the ID(s) of the cutter(s) used in the tool assembly, 
in a Tool Library Report. 

Holder ID — Use to display the ID(s) of the holder(s) used in the tool assembly, 
in a Tool Library Report. 

Cutter Diameter — Use to display the diameter of the cutter in a Tool Library 
Report. 

Cutter Height — Use to display the height of the cutter in a Tool Library Report. 

Cutter Stick-out — Use to display the "cutter stick-out" value (distance from the 
tip of the tool to the lowest point on the holder) of the tool, in a Tool Library 
Report. 

See Tool Manager window, also in VERICUT Help, for additional information on 
these data types. 

Header — Use to define the column header to be used for the record in the Tool 
Library Report. Clicking on the "Header" item in a highlighted row, will put it in edit 
mode so you can enter a header label that is most meaningful in your work place. 

Alignment — Left-click in the Alignment cell in a highlighted row and choose Left, 
Center, or Right from the pull-down list to specify how you want the data in that 
column of the Tool Library Report to be positioned. 

 

Add — Use to add a row after the highlighted row in the Tool Data List. 

Delete — Use to delete the highlighted row from the Tool Data List. 

The remainder of the window features (Table Width, Border Size, Thumbnail Width, 
Thumbnail Height, Maximum Rows/Page, OK, and Cancel) are common to all table 
windows and are described in the Common Table Features section below. 
 
 
Example Results 
Using a Tools Table defined as shown in the picture above will result in a table in the 
Tool Library Report similar to the following picture. 
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Inspection Features Table window 
 

Inspection Features Table — Displays the Inspection Features Table window enabling 
you to create an inspection report. The Inspection Features Table window is only 
available when the Report Template window was accessed from the Inspection window 
menu bar (File menu > Report Template). 

NOTE:  Report templates containing Inspection Feature Tables should only be used 
for creating inspection reports from the Inspection window. Using them to create 
reports from other VERICUT applications will result in incorrect data being 
displayed in the report. 

 

 
 

Table — Inspection Features 

Inspection Feature List 
Each row in the Inspection Features List represents a column that will be displayed in the 
Inspection Report. The first row in the Inspection Features Table is used to define the 
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first column in the Inspection Report. The second row in the Inspection Feature List  
defines the second column in the Inspection Report, and so on. 

The order of the Inspection Feature List's rows can be changed in a couple of ways. 
Clicking on one of the column headings (Column, Header, Alignment) in the Inspection 
Feature List will sort the table's rows alphabetically by the items contained in the column. 
Secondly, you can click on square button at the beginning of any row and drag the row to 
the desired position in the list. 

Column — The features in this column are used to specify the type of data that is to 
be displayed in this column of the report. Clicking on the "Column" item in a 
highlighted row, will display a pull-down list of data types that you can select from. 
The following are the data types that are available for use in an Inspection Report. 

Symbol — Use to display the symbol of the type of measurement that the record 
represents, for example  for a floor thickness, in an Inspection Report. 

Feature — Use to display a very brief description of the type of feature the 
record represents, for example "Floor Thickness", in an Inspection Report. 

Identifier — Use to display the feature identifier associated with the inspection 
record, for example, A1, in an Inspection Report. 

Instrument — Use to display the type of instrument that is to be used to check 
the dimension, for example, "Ultrasonic", in an Inspection Report. 

Dimension — Use to display the expected dimension in an Inspection Report. 

Tolerance — Use to display the acceptable tolerance value, or range of values, in 
an Inspection Report. 

Geo. Tolerance — The geometric tolerance specification associated with the 
record, for example,  , in an Inspection Report. 

Measurement — Use to display the inspector's actual measurement in an 
Inspection Report. 

Tool ID — Use to display the identifier of the tool that cut the feature, in an 
Inspection Report. 

See VERICUT Inspection, in the Analysis menu section of VERICUT Help for 
additional information on these data types. 

Header — Use to define the column header to be used for the record in the 
Inspection Report. Clicking on the "Header" item in a highlighted row, will put it in 
edit mode so you can enter a header label that is most meaningful in your work place. 

Alignment — Left-click in the Alignment cell in a highlighted row and choose Left, 
Center, or Right from the pull-down list to specify how you want the data in that 
column of the Inspection Report to be positioned. 

Add — Use to add a row after the highlighted row in the Inspection Feature List. 

Delete — Use to delete the highlighted row from the Inspection Feature List. 
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The remainder of the window features (Table Width, Border Size, Thumbnail Width, 
Thumbnail Height, Maximum Rows/Page, OK, and Cancel) are common to all table 
windows and are described in the Common Table Features section below. 
 
 
Example Results 
Using an Inspection Features Table defined as shown in the picture above will result in a 
table in the Inspection Report similar to the following picture. 
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Common Table Features 
 
The following features are common to all table types except where noted below. 

Table Width — Use to specify the table width relative to the window/page width. 
 Enter the Table width as a percentage of the window/page width. 

Border Size — Use to specify a border size for a "custom" table. Enter the border 
size in pixels. 

Thumbnail Width — Use to specify the width of "images" included in tables. 
Toggle "On" and enter the width value in pixels. 

Thumbnail Height — Use to specify the width of "images" included in tables. 
Toggle "On" and enter the width value in pixels. 

NOTES:  The following rules apply to Thumbnail Width/Thumbnail Height: 

1. If only one of the Thumbnail dimensions is toggled "On", the active 
dimension will be used and the other direction dimension will be scaled to 
maintain the image aspect ratio. 

2. If neither of the Thumbnail dimensions is toggled "On", the native image size 
will be used. 

Row Height —Use to specify the row height for a "custom" table. Toggle "On" and 
enter the height value in pixels. This feature is only available in the Custom Table 
window. 

Maximum Rows/Page — Use to specify the maximum number of rows per page 
when printing a "custom" table. 

Group Data by Tool — When toggled "On", the Tool Summary Table will group 
sequences using the same tool. When toggled "Off", the Tool Summary Table will list 
tools sequence by sequence. This feature is only available in the Tool Summary Table 
window. 

 

OK — Creates a table record, as specified, in the report template and closes the Table 
window.  

Cancel — Closes the Table window without creating a table record in the report  
template. 
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Picture window 
 

Picture — Displays a window enabling you to add VERICUT generated pictures, or 
custom pictures from a file, to a report template. 

 

 
 

Picture — Use to specify the type of picture to add. Select one of the picture types 
from the pull-down list. 

Add a custom image using: 

From File — outputs the image from the specified file. 

or choose one of the VERICUT generated pictures: 

Tool Use Graph — outputs a Tool Use graph image. 
Cutting Graph — outputs a Cutting Conditions graph image. 
Start of Process Image — outputs an image at the start of processing. When 
included within a "tool change loop", an image of the part at the start of 
cutting with current tool is output. When included within a "toolpath loop", an  
image of the part at the start of the current toolpath is output. 
End of Process Image — outputs an image at the end of processing. When 
included within a "tool change loop", an image of the part at the end of cutting 
with current tool is output. When included within a "toolpath loop", an image 
of the part at the end of the current toolpath is output. 

Tool Image — outputs an image of the current tool. When included within a 
"tool change loop", an image of the current tool is output at each tool change. 

Setup Plan — outputs a setup plan image. Multiple image setup plans can be 
output by using a Start View Loop record before the Setup Plan record and 
an End View Loop record after. 

or choose one of the existing (if any) "picture type" User-Defined Tags at the 
bottom of the list. 
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File — Enter the /path/filename of the image file, or use Browse to display a file 
selection window and use it to pick the image file. This feature is only active when 
Picture is set to From File. 

Border Size — Use to add a border to the image. Enter the border size in pixels. 

Width — Use to specify the width for the displayed image. Toggle "On" and enter 
the width value in pixels. 

Height — Use to specify the height for the displayed image. Toggle "On" and enter 
the height value in pixels. 

NOTES:  The following rules apply to Width/Height: 

1. If only one of the dimensions is toggled "On", the active dimension will be 
used and the other direction dimension will be scaled to maintain the image 
aspect ratio. 

2. If neither of the dimensions is toggled "On", the native image size will be 
used. 

 

OK — Adds the picture record, as specified, to the template and closes the Picture 
window. 

Cancel — Closes the Picture window without adding a picture record to the template. 
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Report Template window, Styles tab 
Location:  Project menu > Report > Report Template >Edit in the main VERICUT 
window. 

                File > Report Template in the Inspection Sequence window. 

                File > Report Template in the Tool Manager window. 

  

 
 

The Menu Bar 
 
File 
See Report Template window for a description of the File features. 

 

Edit 
Add — Enables you to add "style" records to a report template file.  

Delete — Enables you to delete "style" records from a report template file.  

NOTE:  Add and Delete can also accessed using the Add or Delete button at the bottom 
of the Styles tab or by right-clicking in the Style Record table and selecting Add or 
Delete. 
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The Style Record Table 
Each record in the table consists of nine columns of information describing a particular 
style record. Click on any column in a row to highlight a record for editing. Each record 
in the table consists of the following information: 

 

Style Name — The name used to identify a particular style record, These are the 
items that will appear in the Style pull-down list, in the record table, on the Page 
Layout tab. 

Font — Indicates the font type to be used for the style record. With the record 
highlighted, click on the Font field and select from the pull-down list. 

Size — Indicates the font size to be used for the style record. With the record 
highlighted, click on the Size field and either select from the pull-down list or type in 
a font size. 

Bold — Toggle the "Bold" characteristic "On/Off" for the style record. 

Italic — Toggle the "Italic" characteristic "On/Off" for the style record. 

Underline — Toggle the "Underline" characteristic "On/Off" for the style record. 

Font Color — With the record highlighted, double click on the Font Color field to 
display a color pallet. (You can also right-click on a "color" field and select Set Color 
to display the color pallet.) Click on the desired font color in the pallet. Click on the 
X in the upper right corner of the color pallet to dismiss the pallet. 

Background Color — With the record highlighted, double click on the Background 
Color field to display a color pallet. (You can also right-click on a "color" field and 
select Set Color to display the color pallet.) Click on the desired background color in 
the pallet. Click on the X in the upper right corner of the color pallet to dismiss the 
pallet. 

Border Size — Indicates the border size to be used for the style record. With the 
record highlighted, click on the border size and type in a font size (in pixels). 

 

Shortcut:  Right-click in the Style Record Table to display the following menu: 

 

 
 

NOTES: 
1. Feature Set Color provides the same functionality as described above for Font 

Color. 
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2. Features Add and Delete provide the same functionality as described above 
under Edit in the menu bar. 

 

 

To Report Template window 
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Report Template window, User-Defined Tags tab 
Location:  Project menu > Report > Report Template >Edit in the main VERICUT 
window. 

                File > Report Template in the Inspection Sequence window. 

                File > Report Template in the Tool Manager window. 

  

User-Defined Tags enable you to define "generic" records in a report template, whose 
value is specified at the time that the template is used to create a report. User-Defined 
Tag values can be defined in the User-Defined Tags window or by using PPRINT data 
in the toolpath file. 

  

 
 

The Menu Bar 
 
File 
See Report Template window for a description of the File features. 

 

Edit 
Add — Enables you to add "User-Defined Tag" records to a report template file.  

Delete — Enables you to delete "User-Defined" records from a report template file.  

  

NOTE:  Add and Delete can also accessed using the Add or Delete button at the bottom 
of the User-Defined Tags tab or by right clicking in the User-Defined Tags Record table 
and selecting Add or Delete. 
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The User-Defined Tag Record Table 
Each record in the table consists of a Tag Name that is used to identify the record and a 
Type (Text, Table or Picture from File). Click on any column in a row to highlight a 
record for editing. Each record in the table consists of the following information: 

Tag Name — The name used to identify a particular User-Defined Tag record. After 
adding a User-Defined Tag record, type in a unique tag name.  

Type — Indicates the "type" of information represented by the tag. After adding a 
and naming a User-Defined Tag record, click in the Type field and select the 
appropriate data type (Text, Table, or Picture From File) from the pull-down list. 

 

NOTE:  Tag Name and Type can be edited by highlighting the record, then clicking 
the appropriate field and either editing the text or selecting the desired Type from the 
pull-down list. Once a Tag Name is referenced in a report template, the User-Defined 
Tag record can no longer be edited. 

 

Shortcut:  Right-click in the User-Defined Tag Record Table to display the following 
menu: 
 

 
NOTE:  These features provide the same functionality as those described above 
under Edit in the menu bar. 

 

 
To Report Template window
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Report Template window, Page Setup tab 
 

Features on this tab enable you to specify or modify page format characteristics such as 
margins, orientation and paper size. The features on this tab are intended to be use with 
PDF format reports, although it may also be useful for HTML format reports with certain 
web browsers. 

 

 
 
 
 
To Report Template window
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User-Defined Tag Values window 
Location:  Project menu > Report > User-Defined Tag Values 

                File > User-Defined Tag Values in the Inspection Sequence window. 

                File > User-Defined Tag Values in the Tool Manager window. 

  

Opens the User-Defined Tags window enabling you to assign job specific information to  
"generic" User-Defined Tags (ref. Report Template window: User Defined Tag tab, also 
in the VERICUT Help section), prior to creating a report. Double click on a Tag Value 
field to enter, or edit, the tag value.  

Once User Defined Tag values have been specified, they are stored in the project file. 
Use the check boxes in the Global column to specify whether a User Defined Tag value 
applies to the project or to a particular setup. When toggled On (checkmark visible), the 
User Defined Tag value is saved at the project level. When toggled Off, the User Defined 
Tag value is saved with the setup.  

If  User Defined Tag values are not specified prior to creating a report, you will be 
prompted for them at the time the report is created.  

You can also specify User-Defined Tag Values using PPRINT statements in the toolpath 
file. 
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Setup Plan 
 

Introduction to Setup Plan 
 
Setup Plan enables you to create a setup plan image, including notes and dimensions, 
which can be included in a VERICUT report. 
 
 

 
 
 
Important Concepts 
 
 

Setup Plan View — The Setup Plan View defines the spatial relationship between the 
model and paper and affects how the image appears on the paper, i.e. the orientation and 
position of the model in the jpeg image. It is represented on screen by the spatial 
relationship between the models and the paper-edge rectangle (also referred to as the 
"plan rectangle"). 
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Dimension Plane — The dimension plane (also referred to as "the glass") is the plane 
that all dimensions are projected into. This affects how dimensions display on the screen, 
how dimension values are calculated, and defines the meaning of "horizontal" (X-axis of 
the Csys) and "vertical" (Y-axis of the Csys), etc. 

Viewport Image — The viewport image is the orientation of the image in the VERICUT 
viewport and is manipulated using VERICUT's view controls. The viewport image does 
not affect the Setup Plan View or the dimension plane. 
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Select View window 
Location:  Project menu > Report > Setup Plan 

 
The Select View window enables you to specify the initial view that you want to create 
the setup plan in. The view choices in the list will include:  Active View (The view that is 
currently active in the VERICUT session. This is the default.); Standard Views (XY, YX, 
YZ, ZY, ZX, XZ, V-ISO and H-ISO); and any custom views previously defined in the 
Select View window, or in the Select/Store View window, for the current setup. See 
Select/Store View window, also in the VERICUT Help section, for additional 
information. 
 
NOTE:  Selecting one of the standard views (XY, YX, YZ, ZY, ZX, XZ, V-ISO or H-
ISO) specifies only the view orientation. The view type (Machine or Workpiece) is 
determined by the view that is currently active in the VERICUT session. 
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OK — After selecting the initial view for the setup plan, click OK. The following will 
happen: 

1. View 1 in VERICUT will change to the selected view.  

2. The "plan rectangle", representing the default plan size is displayed on the glass (a 
plane, referred to as "the glass", parallel to the view that setup plan record is 
associated with) in the specified view. See the picture below. The "plan rectangle" 
is drawn on the glass in the Clip Box color specified on the Settings tab. 

3. Unless you selected an existing custom view previously defined in the 
Select/Store View window, a new "Setup Plan" view will be created and will be 
added to the Select/Store View window. If you selected a previously defined 
view, the original view name will be used in the Setup Plan record. 

New views will be added to both the Select/Store View window and the Select 
View window, even if a setup plan record is not actually created for the initial 
view selected (selecting Cancel in the Setup Plan window). 

4. The Setup Plan window displays, enabling you to continue the process of creating 
a setup plan. 

 
 

Setup Plan view with "plan rectangle" 
 

 
 

Cancel — Use Cancel to close the Select View window without any further action to 
create a setup plan. 
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NOTE:  The Select View window only displays when you select Project menu > 
Report > Setup Plan when no setup plan records exist for the current setup. If one, or 
more, setup plan records already exist the Setup Plan window opens immediately.
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Setup Plan window 
Location:  Project menu > Report > Setup Plan 

VERICUT toolbar short cut:  
 
 
The features in the Setup Plan window enable you to add new dimensions or notes to, or 
edit existing dimensions or notes in, a setup plan. The dimensions are placed on a 
dimension plane (referred to as "the glass") represented by the XY plane of the specified 
Csys. 
Once the Setup Plan is created it can be included in a VERICUT report. See the Adding a 
Setup Plan Image to a Report topic below for information about adding Setup Plan 
information to VERICUT Reports. 
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Setup Plan Table 
Each record in the Setup Plan Table represents a setup plan image that can be added to a 
VERICUT report. Each record consists of the following columns of data: 

Plan Size — Sets the size of the "plan rectangle" drawn on the glass. Choose (A, B, 
C, A1, A2, or A3) from the pull-down list. (Default = A for inch, A1 for mm) 

Orient — Sets the orientation of the "plan rectangle" drawn on the glass. Choose 
(Portrait, or Landscape) from the pull-down list. (Default = Landscape) 

View — Defines the orientation of the setup plan image in VERICUT's 3D space. 
Select the desired view from the pull-down list. The list contains all views defined in 
the View menu > Select/Store View window for the current setup. 

Csys — Used to define the dimension plane, represented by the XY plane of the 
Csys, and the meaning of "horizontal" (X-axis of the Csys) and "vertical" (Y-axis of 
the Csys). The default is View Csys, the coordinate system that defines the view for 
the current setup plan record.  

Scale — Sets the size of the "plan rectangle" relative to VERICUT's 3D space. Enter 
the desired scaling factor in the number field. (Default = 1) 

Clip — Use to activate the "clip image rectangle" that will be used to determine what 
will be displayed in the setup plan image in the setup plan report. 

When toggled "On", (checkmark displayed) a re-sizable "clip image rectangle" is 
displayed on the on the glass is drawn on the glass in the Clip Box color specified on 
the Settings tab. The image that appears in the setup plan report is clipped (contained) 
by this rectangle. 
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To change the size and location of the "clip image rectangle, hold the cursor over any 
of the four corners, or over the midpoint of any of the rectangle's sides so that a red 
dot displays as shown in the picture below. Also notice that the rectangle changes to 
the Selection color defined on the Settings tab. 

 

 
 

Left click on the dot and drag it to modify the "clip image rectangle". Repeat the 
"click and drag" using the other available red dot control points until the desired "clip 
image rectangle" size, shape, and location is achieved. 
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Setup Plan Table Right Mouse Button Menu 
Right-click in the Setup Plan Table to display the following menu: 
 

 
 

Restore View — This feature enables you to easily return a rotated view in the 
VERICUT graphics area to the view orientation specified in the highlighted setup 
plan record. 

Modify View — Modifies the View Type and orientation of the view in the 
highlighted record in the Setup Plan Table to match those of View 1 in the 
VERICUT graphics window. This feature provides the same functionality as 
Modify in the Select/Store View window. 

Fit To Paper — Use to "fit" the VERICUT view to the size of the setup plan 
paper. See the pictures below. 

 

VERICUT view before using Fit To Paper 

 
 



VERICUT HELP – Project menu 
 

VERICUT view after using Fit To Paper 

 
 

When a record is selected in Setup Plan Table: 

1. The selected record becomes highlighted. 

2. The View 1 display in VERICUT switches to the view associated with the 
selected record. 

3. A rectangle representing the plan size, and its scale in the view, is drawn on 
the glass in the Clip Box color specified on the Settings tab. 

4. If the Clip checkbox in the in the setup plan record is toggled "On" (checked) 
a re-sizable "clip image rectangle" is drawn on the glass in the Clip Box color 
specified on the Settings tab. 

5. Dimensions/notes associated with the record are drawn on the glass. 

 

 

Stored Views — Opens the Select /Store View window (ref. Select/Store View window, 
also in the VERICUT Help section). 

Add — Adds a setup plan record to the Setup Plan Table. 

Delete — Deletes the highlighted setup plan record from the table. 

 

 

Linear tab — Use the features on this tab to add, or modify, linear dimensions in the 
highlighted setup plan record. 

Radial tab — Use the features on this tab to put radial dimensions on the highlighted 
setup plan record. 
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Angular tab — Use the features on this tab to put angular dimensions on the highlighted 
setup plan record. 

Note tab — Use the features on this tab to put notes on the highlighted plan record. 

Settings tab — Use the features on this tab to define characteristics to be used for notes 
and dimensions (number format, font, font size, etc.). 

 

 

OK — Saves all setup plan records and closes the Setup Plan window. 

Apply — Saves all setup plan records and leaves the Setup Plan window open for 
additional work. 

Recalculate — Selecting Recalculate causes VERICUT to re-calculate all dimension 
values, and apply the "current" settings on the Settings tab to all dimensions and notes in 
the highlighted setup plan record. 

NOTE:  Any dimension text values that were manually entered, for example "not to 
scale" dimensions will be overwritten by VERICUT calculated values when 
Recalculate is used. 

Cancel — Closes the Setup Plan window without saving setup plan records. 

 

NOTES: 
1. Setup Plan data is saved per setup in the project file. 

2. Image (not glass) is clipped in HTML/PDF output based on the status (checked/ 
not checked) of the Clip checkbox in the setup plan record, and "clip image 
rectangle" size and position. 

3. See the Adding a Setup Plan Image to a Report topic below for information about 
adding Setup Plan information to VERICUT Reports. 
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Setup Plan window, Linear tab 
Location:  Project menu > Report > Setup Plan 

 
The features on the Linear tab enable you to add linear dimensions to, or modify existing 
linear dimensions in, the setup plan record. 
 

 
 
 
Dimension Type — Use to specify the type of linear dimension that you want to create. 

Horizontal — Dimensions the horizontal distance between Point 1 and Point 2. 
Vertical — Dimensions the vertical distance between Point 1 and Point 2. 
Shortest — Dimensions the straight line distance between Point 1 and Point 2. 

 
In the following picture, all three dimensions were defined using the same two points (the 
mid-points of the edges). Each of the three dimensions was created using a different 
Dimension Type as shown in the picture.  
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Arrow — Use to specify the type of arrow to be used for the dimension. 

Inside — Place the arrows between the two points. 
Outside — Place the arrows outside of the measured points. 
None — Do not use arrows for the dimension. Display only a line between the two 
points. 

The following picture illustrates the difference between Inside, Outside, and None. 
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Point 1 — Choose one of the construction methods from the pull-down list, then click the 

arrow  to enter "pick" mode and follow the prompts below the message area (logger) 
to define the point. The following construction methods are available: 

Point — Use to select a point. 

Vector/Plane — Define a point represented by the intersection of a vector with a 
plane. 

3 Planes — Define a point represented by the intersection of three planes. 

Circle — Define a point represented by the center of a circle. 

CSYS Origin — Define a point represented by the origin of a coordinate system 
(CSYS). 

Once you have finished picking the geometry required to satisfy the chosen construction 
method, VERICUT will display the point in View 1 and display a red check next to Point 
1 on the Linear tab, as shown in the Linear tab picture above, to indicate that Point 1 has 
been selected. VERICUT will also automatically activate "pick" mode for Point 2. 

If you want to re-select Point 1, repeat the above steps. 

 

Point 2 — Choose one of the construction methods from the pull-down list, then click the 

arrow  to enter "pick" mode and follow the prompts below the message area (logger) 
to define the point. The following construction methods are available: 

Point — Use to select a point. 

Vector/Plane — Define a point represented by the intersection of a vector with a 
plane. 

3 Planes — Define a point represented by the intersection of three planes. 

Circle — Define a point represented by the center of a circle. 

CSYS Origin — Define a point represented by the origin of a coordinate system 
(CSYS). 

Once you have finished picking the geometry required to satisfy the chosen construction 
method, VERICUT will display the point in View 1 and display a red check next to Point 
2 on the Linear tab, as shown in the Linear tab picture above, to indicate that Point 2 has 
been selected. VERICUT will also automatically activate "pick" mode for Text. 

If you want to re-select Point 2, repeat the above steps. 
 
Text — VERICUT will automatically fill in the dimension in the Text text field after you 
select Point 1 and Point 2. Pick the position in View 1 where you want the dimension 
text placed.  
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If you want to move the text position, click the arrow   to enter "pick" mode, then 
pick the new location in  View 1. 

You also have the option of adding to the text, for example adding a tolerance value. If 
the text that you add is typical of all linear dimensions, use the Number Label feature on 
the Settings tab to have VERICUT automatically add the additional text to all linear 
dimensions. 

You can also override the value that VERICUT enters, for example to create a "not to 
scale" dimension. 

In either case, when you finish editing the text, click the arrow  to enter "pick" mode, 
then pick the position in View 1 where you want the dimension text placed. 

 
Add — Use to add the dimension to the setup plan record. The dimension will display in 
View 1 in the Dimension color specified on the Settings tab. 

Modify — The Add button changes to Modify when you are in "edit" mode. Use 
Modify to add your changes to the setup plan record.  

To enter "edit" mode, simply select an existing dimension or note in View 1 so that it 
becomes highlighted in the Edit color specified on the Settings tab. VERICUT will 
automatically display the correct tab for editing the selected dimension or note. Use the 
tab features to change the dimension as desired. When finished with your changes, use 
the Modify button to add the changes to the setup plan record and display the modified 
dimension in View 1 in the Dimension color specified on the Settings tab. 

See the Tips on Editing Setup Plan Dimensions topic below for additional information. 

Delete — Use when in "edit" mode to delete the selected (highlighted) dimension from 
the setup plan record. 

Cancel — Use to cancel the current selections for the dimension, and return it to its 
original condition. In "add" mode the dimension returns to the un-defined condition. In 
"edit" mode the dimension returns to its un-edited condition. 
 
Steps for creating a linear dimension 
 

1. Choose the dimension type. 
2. Choose the arrow type. 
3. Pick the start point of the linear dimension (Point 1). 
4. Pick the end point of the linear dimension (Point 2). 
5. Pick the location for the dimension text. 
6. Select Add to accept the current selections and add the linear dimension to the 

setup plan record. 
 
To Setup Plan window
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Setup Plan window, Radial tab 
Location:  Project menu > Report > Setup Plan 

 
The features on this tab enable you to add new radial dimensions to, or edit existing 
radial dimensions in, a setup plan record. 
 
 

 
 
 

Dimension Type — Use to specify the type of radial dimension that you want to create. 

Radius — Display the dimension using the radius value. 

Diameter — Display the dimension using the diameter value. 

Arrow — Use to specify the type of arrow to be used for the dimension. 

Inside — Places the arrow inside of the radial entity being dimensioned. 

Outside — Places the arrow outside of the radial entity being dimensioned. 

None — Do not use arrows for the dimension. Only display a line outside of the 
radial entity being dimensioned. 
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The following picture illustrates the difference between Inside, Outside, and None when 
creating Radius dimensions. 

 
 

 

The following picture illustrates the difference between Inside, Outside, and None when 
creating Diameter dimensions. 
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Center Point — Choose one of the construction methods from the pull-down list, then 

click the arrow  to enter "pick" mode and follow the prompts below the message area 
(logger) to define the point representing the center of the circle/arc being dimensioned. 
The following construction methods are available: 

Point — Use to select a point. 

Vector/Plane — Define a point represented by the intersection of a vector with a 
plane. 

3 Planes — Define a point represented by the intersection of three planes. 

Circle — Define a point represented by the center of a circle. 

CSYS Origin— Define a point represented by the origin of a coordinate system 
(CSYS). 

Once you have finished picking the geometry required to satisfy the chosen construction 
method, VERICUT will display the point in View 1 and display a red check next to 
Center Point on the Radial tab, as shown in the Radial tab picture above, to indicate that 
the center point has been selected. VERICUT will also automatically activate "pick" 
mode for Point on Radius. 

If you want to re-select Point 1, repeat the above steps. 

 

Point on Radius — Choose one of the construction methods from the pull-down list, 

then click the arrow  to enter "pick" mode and follow the prompts below the message 
area (logger) to define a point on the circle/arc being dimensioned. The following 
construction methods are available: 

Point — Use to select a point. 

Vector/Plane — Define a point represented by the intersection of a vector with a 
plane. 

3 Planes — Define a point represented by the intersection of three planes. 

Circle — Define a point represented by the center of a circle. 

CSYS Origin — Define a point represented by the origin of a coordinate system 
(CSYS). 

Once you have finished picking the geometry required to satisfy the chosen construction 
method, VERICUT will display the point in View 1 and display a red check next to Point 
on Radius on the Radial tab, as shown in the Radial tab picture above, to indicate that 
point on the circle/arc being dimensioned has been selected. VERICUT will also 
automatically activate "pick" mode for Text. 

If you want to re-select Point 2, repeat the above steps. 
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Text — VERICUT will automatically fill in the dimension in the Text text field after you 
select Center Point and Point on Radius. Pick the position in View 1 where you want 
the dimension text placed.  

If you want to move the text position, click the arrow   to enter "pick" mode, then 
pick the new location in View 1. 

You also have the option of adding to the text, for example adding a tolerance value. If 
the text that you add is typical of all radial dimensions, use the Number Label feature on 
the Settings tab to have VERICUT automatically add the additional text to all radial 
dimensions. 

You can also override the value that VERICUT enters, for example to create a "not to 
scale" dimension. 

In either case, when you finish editing the text, click the arrow  to enter "pick" mode, 
then pick the position in View 1 where you want the dimension text placed. 

Add — Use to add the dimension to the setup plan record. The dimension will display in 
View 1 in the Dimension color specified on the Settings tab. 

Modify — The Add button changes to Modify when you are in "edit" mode. Use 
Modify to add your changes to the setup plan record.  

To enter "edit" mode, simply select an existing dimension or note in View 1 so that it 
becomes highlighted in the Edit color specified on the Settings tab. VERICUT will 
automatically display the correct tab for editing the selected dimension or note. Use the 
tab features to change the dimension as desired. When finished with your changes, use 
the Modify button to add the changes to the setup plan record and display the modified 
dimension in View 1 in the Dimension color specified on the Settings tab. 

See the Tips on Editing Setup Plan Dimensions topic below for additional information. 

Delete — Use when in "edit" mode to delete the selected (highlighted) dimension from 
the setup plan record. 

Cancel — Use to cancel the current selections for the dimension, and return it to its 
original condition. In "add" mode the dimension returns to the un-defined condition. In 
"edit" mode the dimension returns to its un-edited condition. 
 

Steps for creating a radial dimension 
1. Choose the dimension type. 
2. Choose the arrow type. 
3. Pick the center point of the circle/arc being dimensioned (CenterPoint). 
4. Pick a point on the circle/arc being dimensioned (Point on Radius). 
5. Pick the location for the dimension text. 
6. Select Add to accept the current selections and add the radial dimension to the 

setup plan record. 

 

To Setup Plan window
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Setup Plan window, Angular tab 
Location:  Project menu > Report > Setup Plan 

 
The features on this tab enable you to add new angular dimensions to, or edit existing 
angular dimensions in, a setup plan record. 
 
 
 

 
 

 

Dimension Type — Use to specify the type of angular dimension that you want to create. 

Smaller — Displays the smaller of the two angles defined using the three points 
specified below. For example the same three points could define both a 30 degree and 
a 150 degree angle. Use Smaller to dimension the 30 degree angle. 

Larger — Displays the larger of the two angles defined using the three points 
specified below. For example the same three points could define both a 30 degree and 
a 150 degree angle. Use Larger to dimension the 150 degree angle. 
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The following picture illustrates the difference between Smaller and Larger. 

 
 

Arrow — Use to specify the type of arrow to be used for the dimension. 

Inside — Place the arrows between the lines defining the angle. 

Outside — Place the arrows outside of the lines defining the angle. 

None — Do not use arrows for the dimension. Only an arc displays between the lines 
defining the angle. 

 

The following picture illustrates the difference between Inside, Outside, and None. 
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Point 1 — Choose one of the construction methods from the pull-down list, then click the 

arrow  to enter "pick" mode and follow the prompts below the message area (logger) 
to define a  point on the line representing one side of the angle. The following 
construction methods are available: 

Point — Use to select a point. 

Vector/Plane — Define a point represented by the intersection of a vector with a 
plane. 

3 Planes — Define a point represented by the intersection of three planes. 

Circle — Define a point represented by the center of a circle. 

CSYS Origin — Define a point represented by the origin of a coordinate system 
(CSYS). 

Once you have finished picking the geometry required to satisfy the chosen construction 
method, VERICUT will display the point in View 1 and display a red check next to Point 
1 on the Angular tab, as shown in the Angular tab picture above, to indicate that a point 
on a line representing the first side of the angle being dimensioned has been selected. 
VERICUT will also automatically activate "pick" mode for Point 2. 

If you want to re-select Point 1, repeat the above steps. 

 

Point 2 — Choose one of the construction methods from the pull-down list, then click the 

arrow  to enter "pick" mode and follow the prompts below the message area (logger) 
to define a point on the line representing the other side of the angle. The following 
construction methods are available: 

Point — Use to select a point. 

Vector/Plane — Define a point represented by the intersection of a vector with a 
plane. 

3 Planes — Define a point represented by the intersection of three planes. 

Circle — Define a point represented by the center of a circle. 

CSYS Origin — Define a point represented by the origin of a coordinate system 
(CSYS). 

Once you have finished picking the geometry required to satisfy the chosen construction 
method, VERICUT will display the point in View 1 and display a red check next to Point 
2 on the Angular tab, as shown in the Angular tab picture above, to indicate that a point 
on a line representing the second side of the angle has been selected. VERICUT will also 
automatically activate "pick" mode for Center Point. 

If you want to re-select Point 2, repeat the above steps. 
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Center Point — Choose one of the construction methods from the pull-down list, then 

click the arrow  to enter "pick" mode and follow the prompts below the message area 
(logger) to define the point representing the vertex of the angle. The following 
construction methods are available: 

Point — Use to select a point. 

Vector/Plane — Define a point represented by the intersection of a vector with a 
plane. 

3 Planes — Define a point represented by the intersection of three planes. 

Circle — Define a point represented by the center of a circle. 

CSYS Origin — Define a point represented by the origin of a coordinate system 
(CSYS). 

Once you have finished picking the geometry required to satisfy the chosen construction 
method, VERICUT will display the point in View 1 and display a red check next to 
Center Point on the Angular tab, as shown in the Angular tab picture above, to indicate 
that point representing the vertex of the angle being dimensioned has been selected. 
VERICUT will also automatically activate "pick" mode for Text. 

If you want to re-select Center Point, repeat the above steps. 

 

Text — VERICUT will automatically fill in the dimension in the Text text field after you 
select Point 1, Point 2, and Center Point. Pick the position in View 1 where you want 
the dimension text placed.  

If you want to move the text position, click the arrow   to enter "pick" mode, then 
pick the new location in View 1. 

You also have the option of adding to the text, for example adding a tolerance value. If 
the text that you add is typical of all angular dimensions, use the Number Label feature 
on the Settings tab to have VERICUT automatically add the additional text to all angular 
dimensions. 

You can also override the value that VERICUT enters, for example to create a "not to 
scale" dimension. 

In either case, when you finish editing the text, click the arrow  to enter "pick" mode, 
then pick the position in View 1 where you want the dimension text placed. 

 
Add — Use to add the dimension to the setup plan record. The dimension will display in 
View 1 in the Dimension color specified on the Settings tab. 

Modify — The Add button changes to Modify when you are in "edit" mode. Use 
Modify to add your changes to the setup plan record.  

To enter "edit" mode, simply select an existing dimension or note in View 1 so that it 
becomes highlighted in the Edit color specified on the Settings tab. VERICUT will 
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automatically display the correct tab for editing the selected dimension or note. Use the 
tab features to change the dimension as desired. When finished with your changes, use 
the Modify button to add the changes to the setup plan record and display the modified 
dimension in View 1 in the Dimension color specified on the Settings tab. 

See the Tips on Editing Setup Plan Dimensions topic below for additional information. 

Delete — Use when in "edit" mode to delete the selected (highlighted) dimension from 
the setup plan record. 

Cancel — Use to cancel the current selections for the dimension, and return it to its 
original condition. In "add" mode the dimension returns to the un-defined condition. In 
"edit" mode the dimension returns to its un-edited condition. 
 

Steps for creating a radial dimension 
1. Choose the dimension type. 
2. Choose the arrow type. 
3. Pick a point on a line representing one side of the angle (Point 1). 
4. Pick a point on a line representing the second side of the angle (Point 2). 
5. Pick the point representing the vertex of the angle being dimensioned 

(CenterPoint). 
6. Pick the location for the dimension text. 
7. Select Add to accept the current selections and add the radial dimension to the 

setup plan record. 
 
 
To Setup Plan window
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Setup Plan window, Note tab 
Location:  Project menu > Report > Setup Plan 

 
The features on this tab enable you to add new notes to, or edit existing notes in, a setup 
plan record. 
 
 

 
 
 

Note — Select the style of note that you want to add from the pull-down list. Select one 
of the following styles: 

Text — Use to add a text only note to the setup plan. 

Text with Leader — Use to add a text note with a leader to the setup plan. 

Section Indicator — Use to add a section indicator with label to the setup plan. 
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The following picture illustrates the difference between Text, Text with Leader, and 
Section Indicator when creating notes. 

 
 
Text — Use the text field to specify the text associated with the note, or section indicator 
label. 

Then click the arrow , to enter "pick" mode, and pick the location in View 1 where 
you want the note/section indicator text placed. 

Leader Start — Click the arrow ,  to enter "pick" mode, then pick the location in 
View 1 where you want the note leader to start. This is the end of the leader with the 
arrow. 

When creating Section Indicators, this feature is used to specify the start location of the 
section indicator. The relationship between this location and the one specified using 
Leader End (described below) are used to indicate the length and orientation if the linear 
portion of the section indicator. 

The relationship between the linear portion of the section indicator and the location that 
you picked to position the section leader text determines the direction of the section 
indicator arrows. The arrows will always point away from the text pick location.  

Leader End — Click the arrow , to enter "pick" mode then pick the location in View 
1 where you want the note leader to end. This is the straight end of the leader. 

When creating Section Indicators, this feature is used to specify the end location of the 
section indicator. The relationship between this location and the one specified using 
Leader Start (described above) are used to indicate the length and orientation if the 
section indicator. 
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The relationship between the linear portion of the section indicator and the location that 
you picked to position the section leader text determines the direction of the section 
indicator arrows. The arrows will always point away from the text pick location.  

 

Add — Use to add the note/section indicator to the setup plan record. The notes will 
display in View 1 in the Text color specified on the Settings tab. The note leader , or 
section indicator will display in the Dimension color specified on the Settings tab. 

Modify — The Add button changes to Modify when you are in "edit" mode. Use 
Modify to add your changes to the setup plan record. 

To enter "edit" mode, simply select an existing note, or section indicator, in View 1 so 
that it becomes highlighted in the Edit color specified on the Settings tab. VERICUT will 
automatically display the correct tab for editing the selected note. Use the tab features to 
change the note/section indicator as desired. When finished with your changes, use the 
Modify button to add the changes to the setup plan record and display the modified 
dimension in View 1 in the colors specified on the Settings tab. 

See the  Tips on Editing Setup Plan Dimensions topic below for additional information. 

Delete — Use when in "edit" mode to delete the selected (highlighted) dimension from 
the setup plan record. 

Cancel — Use to cancel the current selections for the dimension, and return it to its 
original condition. In "add" mode the dimension returns to the un-defined condition. In 
"edit" mode the dimension returns to its un-edited condition. 
 
 
Steps for creating a note: 

 
1. Choose the Note type (Text or Text with Leader). 
2. Enter the note text in the text field. 

3. Click on  , then pick the position in View 1 where you want the note placed. 
 

If you are creating a Text with Leader note, continue with the following: 

4. Click on the Leader Start   , then pick the start point of the Note leader. 

5. Click on the Leader End   , then pick the end point of the Note leader. 
6. Select Add to accept the current selections and add the note to the setup plan 

record. 
 
 
Steps for creating a section indicator: 
 

1. Set Note type to Section Indicator. 
2. Enter the text associated with the section indicator in the text field. 
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3. Click on  , then pick the position in View 1 where you want the section 
indicator text to be  placed. 

4. Click on the Leader Start   , then pick the location in View 1 where you 
want the section indicator to start. 

5. Click on the Leader End   , then pick the location in View 1 where you want 
the section indicator to end. 

6. Select Add to accept the current selections and add the note to the setup plan 
record. 

 
 
 
To Setup Plan window 
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Setup Plan window, Settings tab 
Location:  Project menu > Report > Setup Plan 

 
The features on this tab enable you to specify, or edit existing, text characteristics 
(format, font, color, etc.), to be used in the setup plan. 
 

 
 

Number Format — Use the Number Format features to specify how numbers are to be 
displayed in the Setup Plan. 

Decimal Places — Use to specify the number of decimal places to be displayed. 

Trailing Zeros — When toggled "On" trailing zeros will be displayed. 

Number Label — Enables you to append the specified characters to the end of a 
number (i.e., in, mm. TYP, etc.). This feature only appends to VERICUT calculated 
values. They will not append to user entered values (for example, when creating "not 
to scale" dimensions). 

Linear — Use to specify the characters to be added at the end of linear 
dimensions. 

Radial — Use to specify the characters to be added at the end of radial 
dimensions. 

Angular — Use to specify the characters to be added at the end of angular 
dimensions. 
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Fonts — Use the Fonts features to specify the font characteristics (font, style, and size) to 
be displayed in the Setup Plan. 

Note — Use the following to specify font characteristics to be used for Notes.  

Font —  Select the desired font from the pull-down list. 
Style — Select Plain, Bold, or Italic from the pull-down list. 

Size — Select the desired font size from the pull-down list. 

Dimension — Use the following to specify font characteristics to be used for 
Dimensions. 

Font —  Select the desired font from the pull-down list. 
Style — Select Plain, Bold, or Italic from the pull-down list. 

Size — Select the desired font size from the pull-down list. 

 
Colors — Use to specify colors for specific Setup Plan entities. Click on the color pallet 

icon,   associated with each entity type (Selection, Edit, etc.) to display a color 
selection pallet. Use it to select the desired color for the entity type. The entity type label 
on the Settings tab will display in the currently selected color so that you can tell at a 
glance what the current setting is. 

Selection — Use to specify the selection (highlight) color to display dimensions and 
notes when you hold the cursor over them, to assist in selecting existing entities 
editing. 

Edit — Use to specify the color to display dimensions and notes when they are in edit 
mode. 

Clip Box — Use to specify the color to display the clip box (ref. "Clip" in the Setup 
Plan window).  

Dimension — Use to specify the color to display dimension lines, note leaders, and 
section markers. 

Text — Use to specify the color to display the text in dimensions, notes and section 
indicators.  

 
 

To Setup Plan window 
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Things to Remember When Working With Setup Plan 
 
The following things should be kept in mind when working with Setup Plan. 

• Setup Plan always displays in the first viewport.  

• A setup plan is always controlled by a stored view. You either select one that 
exists, or one is automatically created for you.  

• If you choose Active View, or one of the internal views (XY, YX, etc.), from the 
first dialog, then a stored view is automatically created. The content of the 
currently highlighted view determines the setup plan's view type and attributes for 
automatically created stored view.  

• Do not use an OpenGL machine view for Setup Plan. 

• All dimensions are 2D, projected into a dimension plane. They are either 
projected into the stored view's plane, or they are projected into the XY place of a 
selected CSYS. Depends on your choice in the CSYS column of the Setup Plan 
table.  

• All dimensions are point-to-point. They do not dimension "features". They are all 
constructed from points projected into the dimension plane. Each dimension type 
has point-constructor choices.  

• The dimension text field is text, not numeric. You can enter any text string you 
want to into a dimension text field. When the dimension is initially created the 
text field is filled by a calculated number. The text field is re-calculated during 
modification if: 

a. the text field is blanked 
b. an end-point is moved 
c. the Recalculate button is pressed.  

• Setup plan "settings" are saved in the preferences file (cgtech_xx_user.prefs, 
where xx is the VERICUT version number).  
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Tips on Editing Setup Plan Dimensions 
 
The following is intended to get you started with using Setup Plan window "Edit" mode. 
 
 
To enter edit mode:  
Select an existing dimension or note in the view so that it becomes highlighted. 
VERICUT will automatically display the correct tab for editing the selected dimension.  
 
Use the tab features to change the dimension as desired. Most of the features just required 
selecting a different option from the pull-down list. The ones shown below may be 
slightly less obvious.  
 

Editing a point: 
In "edit" mode, select the dimension in the view so that it becomes highlighted. 
Changing a point in a dimension is just like creating it initially. For the point that you 
want to edit: 
Choose one of the construction methods from the pull-down list, then click the arrow 

 and follow the prompts in the message area to define the new point.  
 
Changing the position of the dimension text: 
In "edit" mode, select the dimension in the view so that it becomes highlighted. 

Click the arrow  next to Text,  then pick the location in the view where you want 
the dimension moved to. You can move the location of the dimension closer, or 
further away, than its current position depending on the new location that you pick. 
You can also move just the text associated with the dimension to another position 
along the current dimension line. 

 
Add changes to the Setup Plan record: 
When finished with your changes for a dimension, use the Modify button to add the 
changes to the setup plan record.  
Use OK or Apply in the Setup Plan window to save the setup plan to the project file. 
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Adding a Setup Plan Image to a Report. 
 

The following provides an overview of the steps needed to add a setup plan to a report. 

1. Use  View menu > Select/Store to display the Select/Store View window and use 
it to create the views that you want in the setup plan. 

2. Use Project menu > Report > Setup Plan, or click on  (Setup Plan) in the 
toolbar, to display the Setup Plan window and use it's features to create the setup 
plan record(s) (images) that you want in the Setup Plan report. 

3. Use Project menu > Report > Report Template > Edit  to display the Report 
Template window and use it's features to create a new, or modify an existing 
report template, to include the Setup Plan image, or images.  

Single Image Setup Plan 

• On the Report Template window: Page Layout tab select the record that 
you want the Setup Plan added after so that it becomes highlighted. 

• In the Report Template window menubar select Edit > Add > Picture to 
display the Picture window. 

• In the Picture window, select Setup Plan from the pull-down list, then 
OK. The Setup Plan record will be added to the report template. 

• Save the report template. 

NOTE:  If you use this approach for a multiple image setup plan, only the 
first record in the Setup Plan table will be included in the report. 
 

Multiple Image Setup Plan 

• On the Report Template window: Page Layout tab select the record that 
you want the Setup Plan added after so that it become highlighted. 

• In the Report Template window menubar select Edit > Add > Start View 
Loop to add the Start View Loop record to the report template. 

• In the Report Template window menubar select Edit > Add > Picture to 
display the Picture window. 

• In the Picture window, select Setup Plan from the pull-down list, then 
OK. The Setup Plan record will be added to the report template. 

• In the Report Template window menubar select Edit > Add > End View 
Loop to add the End View Loop record to the report template. 

• Save the report template. 

4. Use File menu > Create Report > (format) to generate the report. 



VERICUT HELP – Project menu 
 

 

MDI window 
Location:  Project menu > MDI 

VERICUT toolbar short cut:   

 

Opens a window enabling you to manually enter and process blocks of G-Code data. The 
MDI, or "Manual Data Input" function provides a quick and easy way of verifying that 
the machine/control combination responds to G-Code data commands as expected. 
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Menu Bar 
 
File Menu 
The features in the File menu enable you to import, export or print NC blocks created in 
the NC Blocks table. 

Options: 
Open — Opens a file selection window enabling you to specify a text, or .mcd, file to 
populate the NC Blocks table. 

Save — Saves (updates) an existing text (.mcd) file with the current NC blocks. 

Save As — Opens a window enabling you to save the contents of the NC Blocks 
table to a new file. 

Print — Opens a window enabling you to print the NC Blocks table. 

Close — Closes the MDI window. 

 
 
Edit Menu 
The features in the Edit menu enable you to manipulate blocks in the NC Block table. 

Options: 
Copy — Use to copy the highlighted block(s) in the NC Block table to the Windows 
clipboard.  

Paste — Use to paste a copied block(s) after the highlighted block in the NC Block 
table. 

Delete — Use to delete the highlighted block(s) from the NC Block table 

Clear All — Use to clear all blocks from the NC Block table. 

 
 
Main Window 
Remove Material — Use to activate/de-activate VERICUT material removal. 

When toggled "On" (check), material removal as well as machine motion will be 
displayed. 

When toggled "Off" (no check), only machine components are positioned to specified 
location and no cutting is performed. This is useful for positioning the tool at specific 
location before cutting, or to verify the actual tool position before executing new 
blocks. 

SubSystem ID — Use this feature to specify which machine subsystem the G-Code data 
command is to be applied to. 
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Machine Motion Jog 
The Machine Motion Jog features enable you to incrementally jog the position of the 
VERICUT machine in the same way that you can jog the real machine. 

 
Axis — Indicates the current axis that the "Jog" feature will apply to. To change the 
current axis, simply select it from the pull-down list. The Axis list includes all machine 
moving axes as well as the Tool Axis.  

The current axis position (linear or rotary), with respect to the Axis "zero" position, is 
displayed in text field next to Axis. 

Use the  (increase) and   (decrease) buttons to jog the machine the specified "Jog 
Distance" each time you press them. You can also press and hold the button down to 
repeatedly move the specified distance. 

Jog Distance — Use to set the distance the axis position will move by a single click on 
increase/decrease buttons. 

NOTE:   Moving the machine axes with Machine Motion Jog will not produce a block 
in the NC Blocks table until the Save Location as NC Block button is pressed.  

 

Move to Pick Location 
The Move to Pick Location features enable you to position a tool component at a 
specific point by picking on stock, or machine models and components, displayed in the 
VERICUT Graphics Area. 

 

 Pick Point — enables you to position the tool at any point in a Workpiece or 
Machine view.  VERICUT will use the selected point and a vector normal to the surface 
of model or stock at the selected point. Moving the cursor in the view over model will 
display the point and vector associated with the current position.  Click the left mouse 
button to select the point. 

  Pick Vertex — enables you to easily position a tool on one of the six key points 
associated with the triangles representing the faces of an uncut model (machine, fixture 
components or stock model before cutting). For each triangle, the points consist of the 
three vertices and the midpoint of each of the triangle's three sides. VERICUT selects the 
point closest to your mouse pick. Moving the cursor in the view over model will display 
the nearest triangle side and point. Click the left mouse button to select the point. 
VERICUT will use the selected point and a vector normal to the surface of model or 
stock at the selected point. If the mouse pick is over the cut stock, Pick Vertex works in 
the same way as the Pick Point feature described above. 



VERICUT HELP – Project menu 
 

 

 

Pick Vertex Example 

 
 

  Pick Circle — enables you to position a tool at a point along the axis of a 
cylinder. This feature requires two picks. The first pick designates the plane that the point 
is to be in. The second pick is the cylindrical feature whose axis the point lies along. 
VERICUT will use the point where the axis of the cylindrical feature intersects the plane. 
The associated vector is defined by the cylindrical axis. 

  Pick Model Origin — enables you to position the tool at a point represented by 
the origin of a model's coordinate system. The vector is defined as the model coordinate 
system's Z-axis. Placing the cursor over any model will display the model's coordinate 
system. Select the model using the left mouse button. 

  Pick CSYS Origin — enables you to position a tool at a point represented by the 
origin of any displayed coordinate system. VERICUT uses the coordinate system axis 
closest to the pick point as the vector. Move the cursor near one of the coordinate 
system's axis and an arrow representing the vector will display along the axis. Click with 
the left mouse button select the origin point and vector. 
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Pick CSYS Origin Example 
Notice the cursor positioned near the Y-axis of the CSYS and the arrow displayed on the 
axis indicating that it will be used as the vector. 

 

  Pick Component Origin — enables you to position the tool at a point represented 
by the origin of a component's coordinate system. The vector is defined as the component 
coordinate system's Z-axis. Placing the cursor over any component will display the 
component's coordinate system. Select the component using the left mouse button. 

  Pick Next Side Plane — when active, this feature enables you to select a plane to 
position the side of the tool to. Activate "Pick Next Side Plane" mode by: 

1. Use the Pick Base Plane feature, described below, to select a base plane. 

2. Toggle Modal Base Plane, described below, "On". 

3. Set Tool Orientation, described below, to Tangent. 

4. Position the tool using any of the above methods. At this point the Pick Next Side 
Plane icon should be active. 

Note that the order in which these steps are carried out is important. 

After completing the above steps, the tool is positioned tangent to the surface at the pick 
point. This tangent plane can be driven along for the next motion if the next pick is in 
"Pick Next Side Plane" mode. After the motion to the "next side plane" is completed, the 
previous "side plane" is replaced by current "next side plane" and tool is ready to be 
driven to the next "Pick Next Side Plane" location. You can continue driving the tool 
along in this manner as long as you continue selecting "Pick Next Side Plane" locations. 
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Tool Orientation — Use to specify the tool vector orientation in relation to the picked 
vector (using any of 6 methods specified above). Choose either Normal, or Tangent.  

Normal specifies that tool vector is set to the pick vector value. Tangent specifies that 
tool vector will be aligned tangent to the plane created by crossing last tool vector and 
pick vector.  The tool position will be offset by maximum tool radius from the plane.  
Using a Tangent orientation with the Pick Point method will position the tool tangent to 
a wall by using one mouse click on the wall. Tool Tangent Offset can be applied in 
addition to tool radius offset. 

Tool Axis Offset — Use to specify a value representing a distance offset the tool along 
the tool axis vector. A positive value moves up the tool axis from the tool pick point. A 
negative value moves down the tool axis from the pick point. 

Tool Tangent Offset — Use to specify a value representing an offset of the tool in radial 
direction (perpendicular to the tool axis), in addition to tool radius, when Tangent tool 
orientation is active. This offset can be used to prevent scratching a part when positioning 
tool tangent to wall (positive value), or for cutting a wall (negative value). 

Orient Tool Axis — Use to change tool axis orientation. When the box is checked and 
machine has 5 axis capabilities, the tool axis will be set based on pick vector value and 
Tool Orientation method. If the box is not checked, the tool axis vector remains 
unchanged while changing to the position to pick point. 

Alternate — Use this button to orient the tool using alternative rotary axes solution.  
When tool axis vector is resolved on a pick, the shortest route for rotary axes is applied.  
To find what the alternative solution is, use this button. This button is active only after a 
change to the tool axis vector.  Subsequent use of this button toggles from one possible 
solution, to another. 

Modal Base Plane — Use this check box to specify a modal base plane is to be used as 
the reference for Tool Axis Offset. If box is checked, tool positions for all pick generated 
motions are offset relative to the specified modal base plane. Use Pick Base Plane, 
described below, to select the plane. If the box is unchecked, tool positions for all pick 
generated motions are offset relative to current pick point. 

  Pick Base Plane — Use to select a modal base plane (see above) to establish a 
common base for Tool Axis Offset. This icon is in same group with other Move to Pick 
Location icons (deactivates the others when pressed) but it is a one shot pick (becomes 
inactive after each successful pick). 

 

Always Save Location — Use this feature to simplify NC block generation. When the 
check box is checked, an NC block is created in NC Block Entry text field for every 
resolved pick location and is saved in NC Blocks List. If the box is not checked, you 
must use the Save Location to List button, at each pick location, to create an NC block 
and store it in NC Block List. This feature is not applicable when Machine Motion Jog 
is being used since a single jog does not create any NC Block information to save. 
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Save Location to List — Use to create an NC block from the current pick location and 
save it in NC Block List. 
 

NOTE:  The Save Location to List button does not execute the block in NC Block 
Entry text field. It simply creates the NC block and stores it in the NC Block List. 

In Machine Motion Jog mode, it is important to create NC blocks for each desired 
machine position before jogging the machine to the next location. In this case, after using 
Save Location to List to create the block and store it in the NC Block List, make sure 
that the newly added block is highlighted, and then press Play Selected NC Blocks to 
process the NC block and update the control with the machine component's current 
location. 

In Move to Pick Location mode, the machine moves to the pick location (at the mouse 
click) and this location is processed through the control, and all other possible 
translations, before actual machine axes are defined and positioned. 

 
NC Blocks List — the list contains a sequence of  NC blocks that have been created. The 
list enables you to select a block, or sequence of blocks, in order to delete, copy and 
paste, or execute the selected block(s). A right mouse click displays a pop-up menu with 
features that enable you to edit, or execute, blocks in the list. Edit the content of a block 
by double clicking on the block to put it in "edit" mode, then make the necessary 
changes. 
 

Shortcut:  Right-click in the NC Block List to display the following menu: 

 

 
 

NOTE:  Copy, Paste, Delete and Clear All are described in the Edit Menu section 
above. Play Selected NC Blocks and Play All NC Blocks are described below. 
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Manipulating blocks in the in the NC Block List: 
3. Use the "Shift" key to select a consecutive range of blocks. Click on the first 

block in the range so that it becomes highlighted, and then while holding down 
the "Shift" key, click on the last block in the range. All of the blocks between the 
first and last should now be highlighted. 

4. Use the "Ctrl" key to select multiple individual blocks. Click on the first block so 
that it becomes highlighted, and then while holding down the "Ctrl" key, select 
additional blocks. Each block will become highlighted when it is selected. 

5. Re-order blocks in the NC Block List by left-clicking on the square button at the 
beginning of the row and drag the row (while keeping the left mouse button 
depressed) to the desired position. 

 

NC Block Entry — is a text buffer where an internally generated NC block is displayed, 
or an NC block can manually be entered.  Use the Add to List button to add the block 
displayed in the NC Block Entry text field to the NC Block List. 

Add to List — Use to add the contents of the NC Block Entry text field to the NC Block 
List. 

Play Selected NC Blocks — Use this button to execute a single NC block, or a selected 
sequence of blocks, in NC Block List. 
 
Play All NC Blocks — Use this button to execute all blocks in the NC Block List. 
 

NOTES:  
1. Use of Machine Motion Jog and Play All NC Blocks require a Machine 

Simulation license. 

2. Do not attempt to use MDI before machine construction is complete. If the Stock, 
Tool, and all motion components are not present in the machine definition, the 
machine may not respond to motion commands as expected. 

3. After adding motion type components to a machine, always press   (Reset 
Model) before using MDI to test machine movements. 

4. Calls to subroutines and NC macros are not supported while in Move to Pick 
Location mode. Use a short test tool path file instead. Calls to subroutines and 
NC macros are supported while in Machine Motion Jog mode. 

5. See Manually Moving the Machine via MDI, in the Using VERICUT section, in 
the CGTech Help Library for more information on using the MDI window 
features. 

 
Also see "Manually Moving the Machine via MDI", in the Using VERICUT section, in 
the CGTech Help Library.
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Coordinate Systems 
 

Define (Coordinate System window) 
Location:  Project menu > Coordinate Systems > Define 

Toolbar shortcut:   

 

Opens a window enabling you to define a coordinate system, also known as a "CSYS". 
The active CSYS applies to X-caliper measurements, Section plane values, and tool path 
motions (except when orientations are defined in a tool path list). To see axes 
representing the active CSYS (XcsYcsZcs), select View menu > View Axes: 
Coordinate System. A user-defined CSYS is typically used to locate an APT or CLS 
tool path for proper relationship to the workpiece. You can also use a user-defined CSYS 
for defining section planes, or for gathering measurement data. Use Project menu > 
Coordinate Systems > Active Coordinate System to activate the desired coordinate 
system. 

NOTES: 
1. Defining a CSYS is not recommended to locate G-Code tool paths simulated on a 

3-D machine, as this can cause the workpiece to move in the machine view. 
Instead, use an Input Program Zero table, or Work Offsets table if work 
offsets are present in the tool path file. 

2. Coordinate systems specified under NC Program Origin on the NC Program 
window, override the active user-defined CSYS. 

3. VERICUT can also be configured to process the following APT-CLS tool path 
records to set the tool path CSYS: CATIA0, MSYS, VERICUT-MATRIX. 
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Coordinate System Name— Enables you to add a new CSYS or select an existing 
CSYS from the list for modification or deletion. Enter a name in the top position of the 
Coordinate System Name list to create a new CSYS, or use New (described below) to 
create a new CSYS and let VERICUT automatically supply a unique name. 

New — Adds a new CSYS to the Coordinate System Name list. VERICUT 
automatically provides a unique name to the CSYS. The following user actions also 
automatically add a new CSYS: 

• Translate tab: pressing Move 

• Rotate tab: pressing one of the rotation direction buttons (X+/X-, Y+/Y-, Z+/Z-) 
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• Construct tab: pressing Update 

• When VERICUT processes one of the following APT-CLS tool path records to 
set the tool path CSYS: CATIA0, MSYS, VERICUT-MATRIX. The coordinate 
system is relative to the first stock's machine component parent. The coordinate 
system is named "filename_nn" where filename is the name of the toolpath file 
and nn is the file's line number containing the matrix definition. Additional 
coordinate systems are not created for matrices with identical values. 

Delete — Deletes the selected CSYS from the Coordinate System Name list. 

CSYS from File — Displays a file selection box enabling you to specify the CSYS file 
to be used. VERICUT will read the file and creates CSYS's attached to the selected 
component (typically the Stock). The Create CSYS While Simulating feature 
(described below) must be toggled Off when using CSYS from File. This functionality is 
also available via the csys_file command line option. 

Attach Coordinate System To — Enables you to attach a CSYS to a particular 
component so that if the component gets repositioned, the CSYS also gets repositioned, 
maintaining the defined relationship. Select the component from the pull-down list. 

Use for Cut Stock Transition — Use to designate that the coordinate system is used for 
transitioning the cut stock(s) from one setup position to another. Stock transition 
coordinate systems can be created for each Stock component. 

 

CSYS Construct/Modify features: 
The features on the following tabs enable you construct a new, or modify an existing 
CSYS. 

Translate tab — Features on this tab enable you to translate the selected CSYS via 
indicating "from" and "to" points to move the CSYS. Movement occurs each time you 
press the Move button. If the applied rotation is incorrect, press Undo to return the object 
to its previous location. 

Rotate tab — Features on this tab enable you to rotate the selected CSYS about a rotation 
center point. Movement occurs each time you press one of the rotation direction buttons: 
X+/X-, Y+/Y-, Z+/Z-. If the applied rotation is incorrect, press Undo to return the object 
to its previous location. 

Construct tab — Features on this tab enable you to construct a CSYS via defining 3 
points. Each point can be defined using points, planes, vectors, or the center of a hole or 
boss. 

Matrix tab — Features on this tab move the selected CSYS via a twelve parameter 
transformation matrix. 
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Display features: 
These features enable you to override the "global" visibility and color characteristics, as 
set with View menu > Axes: Coordinate System, for the individual coordinate system 
currently displayed in the Coordinate System Name list. 

Visible — When coordinate systems are displayed using View menu > View Axes: 
Coordinate System, Visible enables you to toggle the display of an individual 
coordinate system "Off/On".  

 — Enables you to override the "global" coordinate system display color set using 
View menu > View Axes: Coordinate System, for an individual coordinate system. 
Click on the Color Pallet icon, then select the desired color from the chart. 

 

Location features: 
These features show the selected CSYS's position and angle, and can be used to move the 
CSYS or verify its current location. Values shown are relative to the workpiece origin. 

Position — Specifies the absolute XYZ position of the CSYS, separated by spaces. 

Component Origin — Enables you to position the origin of the coordinate system 
currently displayed in the Coordinate System Name list at the origin of the selected 
component. Toggle Component Origin "On", click in the Position field so that it 
becomes highlighted yellow, then select the desired component in the graphics area. Press 
Apply to move the coordinate system. 

Angles — Specifies the absolute XYZ rotation of the CSYS, separated by spaces. 

Undo — Returns the CSYS to its previous location, or as it was when the Coordinate 
System window was opened. 

Reverse X — Reverses the X axis of the "active" coordinate system. (See note below) 

Reverse Y — Reverses the Y axis of the "active" coordinate system. (See note below) 

Reverse Z — Reverses the Z axis of the "active" coordinate system. (See note below) 

  

NOTE:  In order to maintain a right handed csys, the following will occur when an axis 
is reversed: 

If the X axis is reversed, then the Z axis is also reversed. 

If the Y axis is reversed, then the X axis is also reversed. 

If the Z axis is reversed, then the Y axis is also reversed. 

  

Create CSYS While Simulating — When toggled On (the default), coordinate systems 
are unconditionally created when a matrix statement is encountered in the NC program 
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being simulated. The coordinate systems are attached to the stock's parent ( the "attach" 
component). This feature must be toggled Off when creating them on your own or  using 
the CSYS from File feature (described above). 

 

OK — Applies the changes and closes the Coordinate System window. 

Apply — Applies the changes and leaves the Coordinate System window open. 

Cancel — Closes the Coordinate System window without applying changes. 
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Coordinate System window, Translate tab 
Location:  Project menu > Coord. System > Define 

Toolbar shortcut:   

  

Features on this tab enable you to translate the selected CSYS via indicating "from" and 
"to" points to move the CSYS. Movement occurs each time you press the Move button. 

  

 
  

From / To — Specifies the locations to move the CSYS from and to, relative to the 
workpiece origin. XYZ values can be entered (separated by spaces), or selected by 
clicking in the field then clicking on a model. As you move the mouse over the 
VERICUT model, a crosshair and vector show you the pending pick-point location. 
Graphical selection supports picking corner points and midpoints of uncut model 
geometry, or virtually any point on machined features. 

Move — Moves the selected CSYS by the incremental distance, as calculated from the 
"From" point to the "To" point location. 

Local Translation — When toggled "on", From/To values are relative to the current 
CSYS.  

NOTE:  This feature is useful when trying to align a CSYS to the center of a machined 
hole. 

 
 
To Coordinate System window 
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Coordinate System window, Rotate tab 
Location:  Project menu > Coord. System > Define 

Toolbar shortcut:   

  

Features on this tab rotate the selected CSYS about a rotation center point. Movement 
occurs each time you press one of the rotation direction buttons: X+/X-, Y+/Y-, Z+/Z-. 

  

 
  

Center of Rotation — Specifies XYZ point location about which to rotate the CSYS. 
XYZ values can be entered (separated by spaces), or selected by clicking in the field then 

clicking on a model. To see the center of rotation, press . To remove the center of 
rotation symbol press the button again, or close the Coordinate System window. 

Increment — Specifies incremental degrees of rotation to apply when one of the rotation 
direction buttons are pressed. 

Rotation direction buttons — (X+/X-, Y+/Y-, Z+/Z-) When pressed, applies the 
incremental rotation specified in the Increment field. Rotation occurs about the Center 
of Rotation, relative to the workpiece origin. 

Local Rotation — When toggled "on", the incremental rotation values are relative to the 
current CSYS.  

NOTE:  This feature is useful when trying to align a CSYS to the center of a machined 
hole. 

 
 
To Coordinate System window 



VERICUT HELP – Project menu 
 

 

Coordinate System window, Construct tab 
Location:  Project menu > Coord. System > Define 

Toolbar shortcut:   

  

The features on this tab enable you to construct a CSYS via a point representing the 
CSYS origin, and two direction vectors representing the axes of the CSYS. Each can be 
defined using points, planes and vectors. 

  

 
  

 While the Construct tab is active, a marker is displayed in the graphics area (see the 
picture below) showing the current position/orientation of the axis being constructed 
based on the Construct tab settings. The display is updated each time you change a value 
on the Construct tab. The marker is automatically clears when you leave the Construct 
tab. 
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Origin (XYZ) — Use these features to define a point representing the origin of the 
CSYS.  

Primary Axis (IJK) — Use these features to define a point or vector representing the 
direction of the CSYS primary axis.  

Secondary Axis (IJK) — Use these features to define a point or vector representing the 
direction of the CSYS secondary axis. 

 

For each of the items above, you can either enter the coordinates of the point, separated 
by spaces, in the text field or select one of the construction methods and pick geometry in 
the graphics area to define the item. Choose one of the construction methods from the 

pull-down list, then click the arrow  and follow the prompts in the message area to 
define the item. The following construction methods are available: 

Point — Use to select a point. 

Vector/Plane — Define a point represented by the intersection of a vector with a 
plane. 

3 Planes — Define a point represented by the intersection of three planes. 

Circle — Define a point represented by the center of a circle. 

CSYS Origin — Define a point represented by the origin of an existing coordinate 
system. 

NOTE:  When using one of the point construction methods to define the Primary or 
Secondary Axis, the origin is subtracted from the generated point to define the 
direction vector representing the axis. 

Vector — Define the direction of a CSYS axis by selecting a vector. (not available 
for Origin) 

Plane/Plane — Define the direction of a CSYS axis by a vector represented by the 
intersection of two planes. (not available for Origin) 

 Axis Order — Choose from the pull-down list to assign X, Y or Z to the Primary and 
Secondary axes of the CSYS. 

XY — assigns the Primary Axis to be X and the Secondary Axis to be Y. 

YZ — assigns the Primary Axis to be Y and the Secondary Axis to be Z. 

ZX — assigns the Primary Axis to be Z and the Secondary Axis to be X. 

  

Update — Use the values selected above to update an existing CSYS, or create a new 
CSYS. When the Update button is pressed the following occurs: 
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1. The Primary Axis and the Secondary Axis are crossed to determine the third axis. 

2. The third axis is then crossed with the Primary Axis to ensure that the Secondary 
Axis is orthogonal. 

3. The CSYS currently active in the Coordinate System window is updated with the 
resultant orthogonal coordinate system and the origin. If no CSYS is currently 
active, VERICUT creates a new CSYS and automatically assigns it a unique 
name. 

 
 
To Coordinate System window 
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Coordinate System window, Matrix tab 
Location:  Project menu > Coord. System > Define 

Toolbar shortcut:   

  

Features on this tab enable you to move the selected CSYS via a twelve parameter 
transformation matrix. 

  

 
  

Matrix Table — The transformation matrix table is similar to the matrix used in 
programming APT tool paths. Its twelve parameters reveal the geometrical attributes of 
the local (transformed) coordinate system (CSYS) in terms of the workpiece origin.  

 

The format of the matrix table is as follows: 

 I J K D 

X I1 J1 K1 D1 

Y I2 J2 K2 D2 

Z I3 J3 K3 D3 

  

Each row represents an axis of the local CSYS. The first three columns represent the 
vector associated with each axis:  I1, J1, K1 as the positive X-axis vector; I2, J2,K2 as the 
positive Y-axis vector; and I3, J3, K3 as the positive Z-axis vector. The fourth column 
values D1, D2, D3 represent the coordinates of the origin point of the local CSYS. 
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NOTE:  If you prefer to see the Matrix Table displayed with the I, J, K along the vertical 
axis and the X, Y, Z along the horizontal axis, set the environment variable, 
CGTECH_MATRIX_FORMAT=VERTICAL. 

  

Update — Updates the CSYS location to reflect the matrix table transformation. After 
updating, press OK or Apply to move the object. 

Apply Inverse On Update — When selected, inverts the matrix so that its twelve 
parameters reveal the geometrical attributes of the workpiece origin in terms of the local 
(transformed) coordinate system. 

 
 
 
To Coordinate System window
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Set Active Coordinate System 
Location:  Project menu > Coordinate Systems > Set Active Coord. Sys. 

  

You control the "active" coordinate system, or "CSYS", that VERICUT uses for 
simulating tool path motions, X-Caliper measurements, and sectioning models. A user-
defined coordinate system is typically used to locate an APT or CLS tool path in the 
proper orientation to the workpiece. 

To make an existing CSYS the "active" CSYS, use Project menu > Coordinate Systems 
> Set Active Coord. Sys. and then select the desired CSYS from the list of available 
coordinate systems. If Display Active Coord. Sys., in the View Axes window, is toggled 
"On", a coordinate system with the name of the active coordinate system will display in 
the VERICUT Graphics area as shown below. Only the "active" coordinate system will 
display with the marker at its origin as shown. 

 

 
 

Shortcut: You can also change the active coordinate system by right-clicking in the 
view, and selecting Set Active Coord. Sys.  and selecting the desired coordinate system 
from the displayed list. See Graphics Area Right Mouse Button Shortcut Menus, in 
the Getting Started with VERICUT section of VERICUT Help for additional information. 

  

Use Project menu > Coordinate Systems > Define... to create additional coordinate 
systems. 

 



VERICUT HELP – Project menu 
 

 

Project Tree 
Location:  Project menu > Project Tree 

 VERICUT toolbar short cut:   

  

The Project Tree is one of the dockable windows enabling you to dock it inside the 
VERICUT main window if you choose. See Dockable Windows in the Getting Started 
with VERICUT section of VERICUT Help for additional information. 

NOTE:  When the Project Tree window is docked, make sure that you click in the 
window so that it becomes the "active" window before using F1 to get help specific to the 
window. Otherwise F1 will go to the CGTech Help Library. 

 The Project Tree shows all Setups and each Setup's configuration in a tree hierarchy. A 
project can consist of one or more setups. VERICUT processes each "active" setup 
sequentially, starting at the top of the tree.   The functionality available in the Project 
Tree duplicates the functionality available in the Project menu, but in a more visual tree 
format.  

 The following examples describe some of the information available to you from the way 
that the items in the Project Tree are displayed. 

 Project Tree Example 1:  "New" project with a single setup. 

 

The picture at the left shows the 
Project Tree for a "new" project 
containing a single setup. Since it is 
the only setup, it is by default the 
"current" setup, indicated by the 
bold text. 

  

The red text here indicates that no 
data has been assigned to any of 
these items.  

  

The initial machine is defined with 
Stock, Design and Fixture 
components but no models have 
been assigned 
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Project Tree Example 2: A project with multiple setups. 

 

 

The picture at the left shows the 
Project Tree for a two setup job. 

Both setups are fully defined. 

 

Setup: 1 is displayed in black text 
indicating that it is in an "active" 
state. The bold text indicated that 
Setup 1 is the "current" setup. 

 

The NC Subroutines label in Setup: 
1 is displayed in red text indicating 
that no subroutines are used for 
Setup 1. 

 

 

 

 

All of the items in Setup: 2 are 
displayed in red text indicating that 
Setup 2 is in an "inactive" state. 
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Each item in the Project Tree has a Right Mouse Button Shortcut menu containing 
features specific to the particular item.  

Project Branch 

Setup Branch 

CNC Machine Branch 

Control Branch 

Machine Branch 

Attach Component 

Component Branch 

Model 

Coordinate Systems Branch 

Coordinate System 

Tooling 

NC Program branch 

NC Program file 

NC Subroutines branch 

NC Subroutine file 

Saved IP Files branch 

IP file 

 

For more information on these, and all, VERICUT Right Mouse Button Shortcut menus, 
see Right Mouse Button Shortcut menus in the Getting Started with VERICUT 
section of VERICUT Help. 
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Project Tree Right Mouse Button Shortcut Menus 
 

Each item in the Project Tree has a right mouse button shortcut menu containing features 
specific to the particular item.  

NOTE:  Any item shown in bold a Project Tree right mouse button shortcut menu can 
also be reached directly by double clicking on the item (branch, component, model, etc.) 
in the Project Tree that you right -clicked on to display the shortcut menu. For example, 
double-clicking on the Project branch in the Project Tree displays the Open Project 
window, just like clicking on Open in the shortcut menu shown in below. 

 

Project Branch  
Right-click on the Project branch in the Project Tree window to display the following 
menu: 

 
 

New — Use to create a new project file. (ref. New Project, in the File Menu section of 
VERICUT Help) 

Open — Displays the Open Project file selection window enabling you to open an 
existing project file.  

Save — Use to save an existing project file with the current VERICUT session settings. 

Save As — Opens the Save Project as window, enabling you to save the current project 
file under a different name, or in a different location. 

Unit — Enables you to change the units of the current project file. A check indicates the 
"current" units. 

Import Setup — Opens the Setup Import window, enabling you to copy a setup from 
either a pre-V6.0 user file, or from a V6.x project file, and append it 
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after the current setup. (ref. Import Setup, in the Project Menu section of VERICUT 
Help. 

 

Motion — Opens the Motion window. (ref. Motion window, in the Project Menu section 
of VERICUT Help. 

APT Cycles — Opens the Cycles window enabling you to maintain cycle and modal 
definitions. (ref. Cycle Definitions, in the APT Settings window: Cycle tab section of 
VERICUT Help) 

Expand all Children — Expands all branches of the Project Tree. 

Recent — Displays a list of recently used project files that you can select from. 

Close — Closes the Project Tree window. 

 
Shortcut:  Double clicking on the Project Branch will open the Open Project file 
selection window. 
 
 

Setup Branch 
Right-click on a Setup branch in the Project Tree window to display the following 
menu: 
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Active — Use to designate whether the setup is "active", or "inactive". (ref. Introduction 
to the Project Setup menu, in the Project Menu section of VERICUT Help. 

Cut — Cuts the highlighted setup in the Project Tree and puts it in the paste buffer. 

Copy — Copies the highlighted setup in the Project Tree to the paste buffer. 

Paste — Puts the contents of the paste buffer after the highlighted setup in the Project 
Tree. 

Delete — Deletes the highlighted setup from the Project Tree. 

Rename — Use to rename the highlighted setup. 

Properties  — Opens the Properties window. (ref. Properties window, in the File Menu 
section of VERICUT Help) 

Report > 
Report Template > Edit — Opens the Report Template window. (ref. Report 
Template window, in the Project Menu section of VERICUT Help. 

User-Defined Tag Values — Opens the User-Defined Tag Values window. (ref. 
User-Defined Tag Values window, in the Project Menu section of VERICUT Help. 

Setup Plan — Opens the Setup Plan window. (ref. Setup Plan window, in the 
Project Menu section of VERICUT Help. 

Motion — Opens the Motion window. (ref. Motion window, in the Project Menu section 
of VERICUT Help. 

G-Code > 
Settings — Opens the G-Code Settings window. (ref. G-Code Settings window, in 
the Project Menu section of VERICUT Help. 

Variables — Opens the Variables window. (ref. Variables window, in the Project 
Menu section of VERICUT Help. 

Process Options — Opens the Process Options window. (ref. Process Options 
window, in the Project Menu section of VERICUT Help. 

APT Settings — Opens the APT Settings window. (ref. APT Settings window, in the 
Project Menu section of VERICUT Help) 

Coordinate Systems > 

Define — Opens the Coordinate System window. (ref. Coordinate Systems  
window, in the Project Menu section of VERICUT Help) 

Active — Displays a list of all available coordinate systems that you can choose 
from. A check indicates the active coordinate system. 
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Section — Opens the Section window. (ref. View Section window, in the View Menu 
section of VERICUT Help) 

Inspection — Opens the Inspection window. (ref. VERICUT Inspection, in the 
Analysis Menu section of VERICUT Help) 

Die Sinking — Opens the Die Sinking Simulation  window. (ref. Die Sinking 
Simulation window, in the Analysis Menu section of VERICUT Help) 

Expand all Children — Expands all branches of a Setup branch. 

 
Shortcut:  Double clicking on the Project Branch will open the Motion window. 
 
 
CNC Machine Branch 
Right-click on a CNC Machine branch in the Project Tree window to display the 
following menu: 

  

 
  

CNC Machine — Opens the CNC Machine window. (ref. CNC Machine window, in 
the Project menu section of VERICUT Help) 

MDI — Opens the MDI window. (ref. to MDI window, in the Project menu section of 
VERICUT Help) 

G-Code Settings — Opens the G-Code Settings window. (ref. G-Code Settings 
window, in the Project Menu section of VERICUT Help. 

Variables — Opens the Variables window. (ref. Variables window, in the Project Menu 
section of VERICUT Help. 

Process Options — Opens the Process Options window. (ref. Process Options window, 
in the Project Menu section of VERICUT Help. 

Expand All Children — Expands all branches of a CNC Machine branch. 

 
Shortcut:  Double clicking on a CNC Machine Branch will open CNC Machine 
window. 
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Control Branch 
Right-click on a Control branch in the Project Tree window to display the following 
menu: 

 

 
 

Open — Opens the Open Control file selection window enabling you to open a control 
file. (ref. Open (Control file), in the Configuration Menu section of VERICUT Help. 

Cut — Cuts the highlighted control file from the Project Tree and puts it in the paste 
buffer. 

Copy — Copies the highlighted control file from the Project Tree to the paste buffer. 

Paste — Uses the contents of the paste buffer to replace the highlighted control file in the 
Project Tree. 

Delete — Deletes the highlighted control file from the Project Tree. 

MDI — Opens the MDI window. (ref. to MDI window, in the Project menu section of 
VERICUT Help) 

G-Code Settings — Opens the G-Code Settings window. (ref. G-Code Settings 
window, in the Project Menu section of VERICUT Help. 

Variables — Opens the Variables window. (ref. Variables window, in the Project Menu 
section of VERICUT Help. 

Process Options — Opens the Process Options window. (ref. Process Options window, 
in the Project Menu section of VERICUT Help. 

 
Shortcut:  Double clicking on a Control Branch will open the Open Control file 
selection window enabling you to open a control file. 
 



VERICUT HELP – Project menu 
 

  

Machine Branch 
Right-click on a Machine branch in the Project Tree window to display the following 
menu: 

 

 
  
Open — Opens the Open Machine file selection window enabling you to open a machine  
file. (ref. Open (Machine file), in the Configuration Menu section of VERICUT Help. 

Cut — Cuts the highlighted machine file from the Project Tree and puts it in the paste 
buffer. 

Copy — Copies the highlighted machine file from the Project Tree to the paste buffer. 

Paste — Uses the contents of the paste buffer to replace the highlighted machine file in 
the Project Tree. 

Delete — Deletes the highlighted machine file from the Project Tree. 

G-Code Settings —  Opens the G-Code Settings window. (ref. G-Code Settings 
window, in the Project Menu section of VERICUT Help. 

Expand All Children — Expands all branches of a Machine branch. 

 
Shortcut:  Double clicking on a Machine Branch will open the Open Machine file 
selection window enabling you to open a machine file. 
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Attach Component Branch 
Right-click on an Attach Component branch in the Project Tree window to display the 
following menu: 

 

 
 
 

Paste — Use  to paste the contents of the paste buffer to the Attach Component. 

Append —Use to connect the selected component to the Attach Component. (ref. 
Component Tree window: Component Menu, in the Configuration Menu section of 
VERICUT Help) 

Expand All Children — Expands all branches below the Attach Component. 
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Component Branch 
Right-click on a Component branch (Fixture, Stock, Design) in the Project Tree window 
to display the following menu: 

 
 
  

Component Attributes — Opens the Modeling window: Component Attributes tab. (ref. 
Modeling window: Component Attributes tab in the Project Menu section of 
VERICUT Help) 
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Cut — Cuts the highlighted component branch from the Project Tree and puts it in the 
paste buffer. 

Copy — Copies the highlighted component branch from the Project Tree to the paste 
buffer. 

Paste — Uses the contents of the paste buffer to replace the highlighted component 
branch in the Project Tree. 

Delete — Deletes the highlighted component branch from the Project Tree. 

Rename — Use to rename the highlighted component branch. 

Append —Use to connect the selected component to the component branch. (ref. 
Component Tree window: Component Menu, in the Configuration Menu section of 
VERICUT Help) 

Visibility — Use the Visibility features to specify whether or not a component branch is 
visible, and in what views. The check indicates the "current" visibility status. 

Blank — The highlighted component branch is not visible in any view. When 
Visibility is set to "Blank" for a component, the icon representing the component in 
the Project Tree will be displayed in gray  instead if a color. 

Workpiece View — The highlighted component branch is only visible in a 
Workpiece View. 

Machine View — The highlighted component branch is only visible in a Machine  
View (Machine, or Machine/Cut Stock). 

Both — The highlighted component branch is visible in any view. 

Expand All Children — Expands all branches of a Component branch. 

 
Shortcut:  Double clicking on a Component Branch will open the Modeling window: 
Component Attributes tab. 
 
 
Models Branch 
Right-click on a Models Branch in the Project Tree window to display the following 
feature: 

  

 
 
Expand All Children — Use to paste the contents of the paste buffer to the Attach 
Component. 
 
Shortcut:  Double clicking on a Models Branch will open the Modeling window: Model 
tab. (ref. Modeling window: Model tab in the Project Menu section of VERICUT Help) 
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Model 
Right-click on a Model in the Project Tree window to display the following menu: 

 
  

Modify — Opens the Modeling window: Model tab. (ref. Modeling window: Model tab 
in the Project Menu section of VERICUT Help) 

Cut — Cuts the highlighted model from the Project Tree and puts it in the paste buffer. 

Copy — Copies the highlighted model from the Project Tree to the paste buffer. 

Paste — Uses the contents of the paste buffer to replace the highlighted model in the 
project tree. 

Delete — Deletes the highlighted model from the Project Tree. 

Visible — Use to make the highlighted model visible, or not visible in the VERICUT 
graphics area. The Visible icon will indicate the visibility status of the model.  
indicates "visible",  indicates "not visible". Click on Visible to toggle between the two 
modes. In the Project Tree, any model in the "not visible" state will be displayed in gray 
instead if a color. 

 
Shortcut:  Double clicking on a Model in the Project Tree window will open the 
Modeling window: Model tab. 
 
 
Coordinate Systems Branch 
 Right-click on a Coordinate Systems branch in the Project Tree window to display the 
following menu: 

 

 
 
 
Modify — Opens the Coordinate System window. (ref. Coordinate System window in 
the Project Menu section of VERICUT Help. 
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Paste — Use  to paste the contents of the paste buffer to the Coordinate Systems branch. 
Delete All — Deletes all coordinate systems from the Coordinate System branch. 
Expand All Children — Expands the Coordinate System branch showing all coordinate 
systems available in the setup. 
 
Shortcut:  Double clicking on a Coordinate Systems Branch will open the Coordinate 
System window. 
 
 
Coordinate System 
Right-click on a Coordinate System in the Project Tree window to display the following 
menu: 

 

 
 

Modify — Opens the Coordinate System window. (ref. Coordinate System window in 
the Project Menu section of VERICUT Help. 

Cut — Cuts the highlighted coordinate system from the Project Tree and puts it in the 
paste buffer. 

Copy — Copies the highlighted coordinate system from the Project Tree to the paste 
buffer. 

Paste — Adds the contents of the paste buffer after the highlighted coordinate system in 
the Project Tree. 

Delete — Deletes the highlighted model from the Project Tree. 

Active — Use to designate the "active"coordinate system. (ref. Set Active Coordinate 
System, in the Project Menu section of VERICUT Help. 

Visible — Use to make the highlighted coordinate system visible, or not visible in the 
VERICUT graphics area. The Visible icon will indicate the visibility status of the 
coordinate system.  indicates "visible",  indicates "not visible". Click on Visible to 
toggle between the two modes. In the Project Tree, any coordinate system in the "not 
visible" state will be displayed in gray instead if a color. 
 
Shortcut:  Double clicking on a Coordinate System in the Project Tree window will 
open the Coordinate System window. 
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Tooling 
Right-click on Tooling in the Project Tree window to display the following menu: 

  

 
Open — Opens a file selection window enabling you to open a tool library file. 

Tool Manager — Opens the Tool Manager window. (ref. Tool Manager window, in the 
Project Menu section of VERICUT Help) 

Cut — Cuts the highlighted tool library from the Project Tree and puts it in the paste 
buffer. 

Copy — Copies the highlighted tool library from the Project Tree to the paste buffer. 

Paste — Replaces the highlighted tool library, with the tool library contained in the paste 
buffer. 

Delete — Deletes the highlighted tool library from the Project Tree. 
 
Shortcut:  Double clicking on Tooling in the Project Tree window will open the Tool 
Manager window. 
 
 
NC Program Branch 
Right-click on an NC Program branch in the Project Tree window to display the 
following menu: 

  

 
  

Add/Modify NC Programs — Opens the NC Program window. (ref. NC Program 
window, in the Project Menu section of VERICUT Help) 

Paste — Adds the contents of the paste buffer to the highlighted NC Program branch in 
the Project Tree. 
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Delete All — Deletes all NC Programs from the NC Program branch. 

Expand All Children — Expands the NC Program branch so that all of the NC Program 
files are shown. 

 
Shortcut:  Double clicking on an NC Program Branch in the Project Tree window will 
open the NC Program window. 
 
 
NC Program File 
Right-click on an NC Program file in the Project Tree window to display the following 
menu:  

 
  

Active — Use to make the highlighted NC active, or inactive. A check in the menu 
indicates that the current status is "active". When an NC Program is "inactive" it is not 
processed. An "inactive" NC Program is indicated by red text in the Project Tree window. 
The Active feature provides the same functionality as the Use feature in the NC Program 
window. (ref. NC Program window, in the Project Menu section of VERICUT Help)  

Edit — Opens the highlighted NC Program in the NC Program (edit) window. (ref. NC 
Program (edit), in the Edit Menu section of VERICUT Help) 

Add/Modify NC Programs — Opens the NC Program window. (ref. NC Program 
window, in the Project Menu section of VERICUT Help) 

Cut — Cuts the highlighted NC Program file from the Project Tree and puts it in the 
paste buffer. 

Copy — Copies the highlighted NC Program file from the Project Tree to the paste 
buffer. 

Paste — Replaces the highlighted NC Program file, with the NC Program file contained 
in the paste buffer. 

Delete — Deletes the highlighted NC Program file from the Project Tree. 

 

Shortcut:  Double clicking on an NC Program file in the Project Tree window will 
opens the NC program in the NC Program Edit window. 
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NC Subroutine Branch 
Right-click on an NC Subroutines branch in the Project Tree window to display the 
following menu: 

  

 
  

Add/Modify NC Subroutines — Open the G-Code Settings window: Subroutines tab. 
(ref. G-Code Settings window: Subroutines tab, in the Project Menu section of 
VERICUT Help) 

Paste — Adds the contents of the paste buffer to the highlighted NC Subroutines branch 
in the Project Tree. 

Delete All — Deletes all NC Subroutines from the NC Subroutines branch. 

Expand All Children — Expands the NC Subroutines branch so that all of the NC 
Subroutine files are shown. 

 
Shortcut:  Double clicking on an NC Subroutines Branch in the Project Tree window 
will open the G-Code Settings window: Subroutines tab. 
 
 
NC Subroutine File 
Right-click on an NC Subroutine file in the Project Tree window to display the 
following menu: 

  

 
 

Edit — Opens the highlighted NC Subroutine in the NC Program (edit) window. (ref. 
NC Program (edit), in the Edit Menu section of VERICUT Help) 

Cut — Cuts the highlighted NC Subroutine file from the Project Tree and puts it in the 
paste buffer. 
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Copy — Copies the highlighted NC Subroutines file from the Project Tree to the paste 
buffer. 

Paste — Replaces the highlighted NC Subroutines file, with the NC Subroutines file 
contained in the paste buffer. 

Delete — Deletes the highlighted NC Program file from the Project Tree. 

Add/Modify NC Subroutines — Opens the G-Code Settings window: Subroutines tab. 
(ref. G-Code Settings window: Subroutines tab, in the Project Menu section of 
VERICUT Help) 

Shortcut:  Double clicking on an NC Subroutine file in the Project Tree window will 
open the highlighted NC Subroutine in the NC Program (edit) window. 

 
 
Saved IP Files Branch 
Right-click on a Saved IP Files branch in the Project Tree window to display the 
following menu: 

 

 
 

Expand All Children — Expands the Saved IP Files branch so that all of the IP files are 
shown. 

Refresh — Updates the status of  IP files in the list. Enables you to see the status of IP 
files that have been manipulated (deleted, moved, renamed, etc.) outside of VERICUT. 
IP files in the list that cannot be found are displayed with red text. 

Delete All — Deletes all IP files from the Saved IP Files branch. 

Save As — Opens the Save In-Process As window enabling you to save an IP file at the 
"current" state of processing. 

 
Shortcut:  Double clicking on a Saved IP Files branch in the Project Tree window to 
expand the Saved IP Files branch so that all of the IP files are shown. 
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IP File 
Right-click on an IP file in the Project Tree window to display the following menu: 

 

 
 

Open IP File — Opens (loads) the highlighted IP file. 

Merge IP File — Merges the highlighted IP file into the current session. (ref. Merge (In 
Process file), in the File Menu section of VERICUT Help) 

Delete — Deletes the highlighted IP file from the Project Tree. 

Shortcut:  Double clicking on an IP file in the Project Tree window will open 
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Configuration Menu 
 

Machine 
 

Open (Machine file) 
Location:  Configuration menu > Machine > Open 

Toolbar short cut for opening Machine files:    

 

Opens the Open Machine window enabling you to open (load) a Machine file (ref. 
Machine File in the Getting Started with VERICUT section of VERICUT Help). 
Machine files contain data that describes NC machine construction, kinematics, and other 
properties. 

 

 
 

Most features on this window are standard file selection window features that enable you 
to navigate through directories, filter files, and type, or select, /path/filenames. A 
description of features specific to VERICUT can be found in the Introduction to 
VERICUT File Selection Windows in the Getting Started section of VERICUT Help. 

To save space, the features described below are unique to this window. 
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Help on Samples — Opens the VERICUT Help section on "Machine files". Both library 
and sample machines are listed. Find the file you want in the on-line Help, then cut & 
paste the file name into the file selection window. For machines located in the library, set 
Shortcut=CGTECH_LIBRARY and press Open to open the file. For "sample" 
machines, set Shortcut=CGTECH_SAMPLES and press Open. 
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Save (Machine file) 
Location: Configuration menu > Machine > Save 

Toolbar short cut for saving Machine files:   

TIP:  Right-click on the icon to toggle between  (Save Machine) and  (Save 
Machine As) modes. 

 
Saves (updates) an existing Machine file (ref. Machine File in the Getting Started with 
VERICUT section of VERICUT Help) with the current NC machine settings. VERICUT 
will save the machine file if you have sufficient permissions to save the file in its present 
directory. Otherwise, the Save Machine File window will display enabling you to specify 
a location to save where you have write permissions.
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Save As (Machine file) 
Location: Configuration menu > Machine > Save As 

Toolbar short cut for saving Machine files:   

TIP:  Right-click on the icon to toggle between  (Save Machine) and  (Save 
Machine As) modes. 

 

 
 

Opens the Save Machine File window enabling you to save a Machine file (ref. 
Machine File in the Getting Started with VERICUT section of VERICUT Help). 
Machine files contain data that describes NC machine construction, kinematics, and other 
properties. 

Most features on this window are standard file selection window features that enable you 
to navigate through directories, filter files, and type, or select, /path/filenames. A 
description of features specific to VERICUT can be found in the Introduction to 
VERICUT File Selection Windows in the Getting Started section of VERICUT Help. 

To save space, the features described below are unique to this window. 

Units to Save — Controls the units (Inch or Millimeter) in which to store machine 
configuration data. If the session units are different than the units to save, then values are 
converted accordingly when stored in the new file. 

Save Encrypted — Saves the Machine file as a standard encrypted (X-File) with an 
.xmch extension. 
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A "standard" encrypted machine file: 

• works with a standard VERICUT license. 
• is a compressed binary file. 
• contains all files referenced by the Machine file (no external models). 
• simulates exactly the same as a standard machine file (.mch) 
• disables the Configuration menu features when used in a setup. 
• can not be decrypted/expanded except by CGTech so retain your original 

machine (.mch) file 
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Machine Settings (Machine Settings window) 
Location: Configuration menu > Machine Settings 

Toolbar short cut for Machine Settings window:    

 

Opens a window to configure settings for an NC machine, such as: collision checking, 
travel limits, axis priority (for rapid motion), location tables, and when machine motions 
are simulated. 

 

 
 

Machine Simulation On — When toggled "On", simulates machine tool motions when a 
3-D machine is displayed in a machine view.  

 

Shortcut: You can quickly toggle Machine Simulation On, "On" or "Off" by clicking 

on the No Machine Simulation icon  in the toolbar. 

 

Floor/Wall Orient Up — Use to specify which way is "up" (towards the ceiling) for a 
machine when a machine view displays walls in the background. (Ref. View menu > 
Attributes: Background). The up direction is relative to the machine origin. Select the 
appropriate axis direction from the pull-down list. 
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Collision Detect tab — Features on this tab control when collisions between machine 
components are detected, which components are protected, and tolerances used for 
detecting collisions. 

Tables tab — Features on this tab are used to specify important machine locations and 
detail tool change motion. 

Travel Limits tab — Features on this tab define how far each machine axis can go, and 
control when travel limit errors are detected. 

Axis Priority tab — Features on this tab control how machine axes move in rapid 
positioning mode (e.g. G0). 

Machine Notes tab — Features on this tab are used to enter "message notes" and 
"comment notes" in the current machine file. 

 

OK — Applies the changes and closes the Machine Settings window. 

Apply — Applies the changes and leaves the Machine Settings window open. 

Cancel — Closes the Machine Settings window without applying changes. 

 
 
Also see "Building NC Machines", in the Using VERICUT section, in the CGTech Help 
Library.
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Machine Settings window, Collision Detect tab 
Location: Configuration menu > Machine Settings 

Toolbar short cut for Machine Settings window:    

 

Features on this tab control when collisions between machine components are detected, 
which components are protected, and tolerances used for detecting collisions. 

 

 
 

Colliding components are highlighted using the red Error color, and errors are issued to 
the Log file identifying collision causing block(s) and machine components. 
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Collision Detection — When toggled "On", detects collisions between specified 
components. 

Ignore Collision between Cutter and Stock — Controls when collisions between the 
cutter and the Stock component are ignored. This feature is useful when collision 
detection is desired between the stock and shank or holder portions of the tool assembly 
in the machine view, but not with the cutter.  

Options are: 
No — (default) Does not ignore cutter-stock collisions. All collisions are reported. 

All Tools — Ignores cutter-stock collisions for all tools, even inactive tools in multi-
tool machines. 

Active Tool — Ignores cutter-stock collisions for the active tool. However, collisions 
between stock and inactive tools are detected. 

Default Near Miss — Specifies the default collision tolerance applied to all collision 
cases when Set All is pressed (see below). 

Set All — Sets the default collision tolerance for all collision cases to the Default Near 
Miss value. You can edit the supplied tolerance for individual cases. 

 

Component/Component collision list 
Lists the component-to-component collision cases that are checked when collision 
detection is turned on. 

Component1/Component 2 — These features are used to specify the component-to-
component collision cases to check. Clicking on a component field in a record 
displays a pull-down list of component to choose from. 

NOTE:  Do not configure for collision detection between components that move 
(slide or rotate) against each other, such as connected motion axes. In these cases, 
errors may occur each time the components move. 

Sub-Components — Toggle On/Off to include Sub-Components of 
Component1/Component2 during collision checking. 

Near Miss —  Use to specify a value that controls how close the components are 
permitted to be before reporting a collision. Enter a positive value to be alerted if 
components come near each other within the specified clearance, zero to indicate 
components may not touch, or a negative value if components are expected to collide 
by the specified value.  

NOTE:  "Near Miss" tolerances are not supported for collision checking against the 
cut model. The accuracy of collisions with the cut stock is dependent on the "Cutting 
Tolerance". 

 

Add — Adds a new collision case record to the list. 
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Delete — Deletes the selected collision case record from the list. 

 

Shortcut:  You can right-click in the Component/Component collision list to display a 
menu containing Add and Delete. These provide the same functionality described above. 
 
 
 
To Machine Settings window
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Machine Settings window, Tables tab 
Location: Configuration menu > Machine Settings 

Toolbar short cut for Machine Settings window:    

 

Features on the Tables tab are used to specify Machine Tables to store important machine 
locations and detail tool change motion. Machine Tables are used to specify "standard" 
data values specific to a particular machine.  

 

 
 

Tables list — A list of tables that are currently defined. The Machine Settings tables list 
will contain only "machine" tables. The G-Code Settings tables list will contain both 
"job" tables and "tool" tables. 

Add/Modify — Use to access the Add/Modify Tables window enabling you to add 
additional tables or modify existing tables. To add a table, simply click on Add/Modify. 
To modify an existing table, select the table to be modified from the Tables list and click 
on Add/Modify. (You can also "double-click" on the table in the Tables list.) 

Delete — Deletes the selected table entry from the Tables list. If it is the last entry for a 
particular table, then the table is also deleted. 

Use the G-Code Settings window: Tables tab to create Job Tables to specify values to 
override "standard" values set in a Machine Table for particular NC program file(s). 
Machine Tables values are stored in the Machine file. 
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The following Machine tables can be added or modified with the Machine Settings, 
Tables tab: 

Base Work Offset 
Initial Machine Location 
Input Machine Zero (obsolete) 
Machine Reference Location 
Tool Change Location 
Tool Change Retraction 
Work Offsets 
Input Program Zero 

 

See the Tables for Processing G-Codes section, in the CGTech Help Library, for 
additional information on VERICUT tables. 

Also see "Building NC Machines", in the Using VERICUT section, in the CGTech Help 
Library. 
 
 
To Machine Settings window
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Add/Modify Tables window 
  

The following discussion applies to both the Add/Modify Machine Table window, 
accessed from the Machine Settings window: Tables tab and to the Add/Modify G-
Code Table window, accessed from the G-Code Settings window: Tables tab. 

  

 
  

Table Name — Use to identify the table to be added, or modified, if it already exists. 
The Table Name list in the Add/Modify Machine Table window will only contain 
"machine" tables. The Table Name list in the Add/Modify G-Code Table window will 
contain both "job" tables and "tool" tables. 

SubSystem ID — Use to specify ID of the machine subsystem for which the table is 
being defined. 

Register — The Register number that will be used by VERICUT to access corresponding 
table data. For "tool" tables, this number typically corresponds to a tool or offset register 
number. For "job" and "machine" tables, the Register number may correspond to an 
offset register number, or an integer value, as required by a particular table. 
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SubRegister — Use of this feature enables you to access multiple sub-values for the 
same tool from tool related tables. For example, groove tools often have multiple 
"driven" points, which then correspond to multiple gage offsets, and possibly multiple 
Cutter Comp values, Tool Nose Comp values, and Tool Length Comp values. 

This feature can also be used for Work Offset Tables for controls, like Yasnac, that 
support the sub-register feature. 

SubRegister is only active when the selected "Table Name" identifies a "tool" related 
table or for Work Offset tables. 

 
Select From/To and Enter Values: 

These features are only active for the following tables: 

Input Program Zero 
Input Machine Zero 
Base Work Offset 
Work Offsets 
RTCP Pivot Offset 
RPCP Pivot Offset 

For the above tables, VERICUT provides two ways to enter table values.  

 

Select From/To Locations — Enables you to specify table values based on a "relational" 
offset between a "from" point and a "to" point. The "from" and "to" points are designated 
by specifying a particular component or CSYS. VERICUT will use the origin of the 
component/CSYS as the point. You can also specify an offset from the specified 
component/CSYS origin point. Once this relationship has been established, you can 
change the machine configuration or the location of the CSYS origin and the table values 
will updated automatically during the initial Single Step or during Play to End. 

For example:  After Input Program Zero has been defined to be the offset from the Tool 
Component to the "Program Zero" CSYS, you can change the machine configuration, or 
change the location of  "Program Zero" CSYS, and the Input Program Zero offset values 
will be updated automatically during the initial Single Step or during Play to End. 

NOTE:  The offsets are calculated based on where the corresponding origin points are 
located when all linear axes are driven to machine zero (zero with no offsets in place). 

 

When Select From/To Locations is toggled "On", the From/To Feature/Name lists and 
the Offset text fields become activated. Use the From/To Feature lists to specify 
whether the point is associated with a Component or a CSYS (coordinate system). Use 
the From/To Name lists to specify a specific component or coordinate system. 

NOTE:  Only the coordinate systems that have been defined with reference to a machine 
component (i.e., visible in a Machine or Machine/Cut Stock view when Coordinate 
System axis is toggled "on") will appear in the CSYS/Names lists. See the discussion for 
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Project menu > Coordinate Systems for more information on VERICUT Coordinate 
Systems. 

 

Use the Offset text fields to enter 3 values, separated by spaces, representing the X, Y, 
and Z offset from the specified origin point. You can also click on the "select" button 

, then  pick a point in the graphics display area. You can pick the point in either a 
workpiece or machine view. VERICUT will calculate the Offset value between the 
selected point and the designated Feature/Name origin point. Offset is only active when 
Feature is set to Component. 

 

Calculate Relative to Location — This feature enables you to have a relational offset 
recalculated in the machine position where the offset will be used. The new position is 
immediately calculated and stored and therefore is not dependent on the machine position 
when the offset is activated.  

TIP:   See tombstone_work_offsets_single_part.vcproject and 
tombstone_work_offsets_multiple_parts.vcproject in the Sample-Demo Files section, 
in the CGTech Help Library for examples of using this feature. 

 

Additional Offset — Use this text field to specify an additional offset value. 

 

Enter Offset (or select 2 points) — when toggled "On", the Values 
(XYZABCUVWABC) text field is activated enabling you to enter one to twelve numeric 
values as required by the specific table. Multiple value entries require spaces between the 
values.  

You can also click on the "select" button , then  pick two points in the graphics 
display area. You can pick the points in either a workpiece or machine view. VERICUT 
will calculate the Offset value between the selected points. 

For all other tables, Select From/To and Enter Offset (or select 2 points) are both 
inactive. Enter the values in the Values (XYZABCUVWABC) text field as described for 
Enter Offset (or select 2 points) above. 
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In the sample window shown above, the current table is the Work Offsets table. The 
current table entry is register "54", and contains the values "-14.95 -8 -17.25". The table 
is applicable to subsystem "1" of the machine. 

 

The following tables support "axis values" (up to 12 values – XYZABCUVWABC): 

Base Work Offset 
Initial Machine Location 
Machine Zero 
Machine Reference Location 
Tool Change Location 
Tool Change Retraction 
Work Offsets 
Program Zero 
Input Program Zero 

 

VERICUT supports two ways to input values into these tables from the Add/Modify 
Table window.  Both use the Values (XYZABCUVWABC) text field, but use a 
different syntax): 

Traditional format: values are entered in the order specified (XYZABCUVWABC) 
and are separated by spaces.  

WORD/VALUE format (X10 C45) 
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In either case, the resulting display of the axis values will be in the WORD/VALUE 
format.  Only non-zero values will be displayed. In the case of all zero's, X0 Y0 Z0 will 
be displayed. 

The WORD/VALUE format has the following rules: 

1. Valid Words are:  X, Y, Z, A, B, C, U, V, W, AA, BB, CC 
2. Mixed formats are not allowed. You can use either the Traditional format, or the  

WORD/VALUE format. 
3. The Words can be entered in any order. 
4. You only need to specify words with non-zero values.   
5. If a word is specified twice, the last value specified will be used. 
6. If all values are zero, you can leave the field blank.  In this case, the display will 

be X0 Y0 Z0. 
 
 

See the Tables for Processing G-Codes section, in the CGTech Help Library, for 
additional information on VERICUT tables. 

Also see "Building NC Machines", in the Using VERICUT section, in the CGTech Help 
Library. 
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Machine Settings window, Travel Limits tab 
Location: Configuration menu > Machine Settings 

Toolbar short cut for Machine Settings window:    

 

Features on this tab enable you to define travel limits for each machine axis , and control 
when, and under what conditions,  travel limit checking is done and errors reported. 
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Overtravel errors cause the violating machine component to "light up" in the Overtravel 
Color and errors are output to the Log file identifying the problem component. 

 

 
 

Log Error for Over Travel — When active, turns on overtravel detection (travel limit 
checking). Components that move beyond specified limits are highlighted in the 
Overtravel Color and errors are issued to the Log file identifying error causing block(s) 
and machine components. 

Allow Motion Beyond Limit — When toggled "On", axes are allowed to freely travel 
beyond defined limits. When toggled "Off", an axis is never allowed to travel beyond the 
defined limit. 

Overtravel Color — Use to specify the color in which components that move past their 
specified limits are shaded. Available shade colors are defined on the Edit menu > 
Colors: Define tab. 

 

Travel Limit Record Table 
List of travel limit records in which each record consist of a group number, motion 
component (and its axis limits), travel limit condition and an ignore switch. 

 

Group — Enables travel limit records to be grouped together. The default group ID is 0.  
You can change the group ID by clicking on the Group field of the highlighted record to 
put it in edit mode, then enter the desired group number. A specific group of travel limit 
records is activated by using the TravelLimitsGroup macro. For information on the 
TravelLimitsGroup macro, and all VERICUT macros, see VERICUT Macros in the 
CGTech Help Library. 

Component —  Use to specify a motion component for travel limit checking. Click on 
the Component field of the highlighted record to put it in edit mode. Select the desired 
motion component from drop down list. The list contains of all motion components in the 
machine; linear, rotary or turret. 
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Minimum / Maximum — Use to specify the minimum, and maximum, travel limits for 
the motion axis selected in the list. Click on the Minimum/Maximum field of a 
highlighted record to put it in edit mode. Enter the desired axis limit. 

 
The next three columns in the Travel Limit Record Table are used to specify conditions 
when the travel limit record is used. The condition can be set to "OFF" indicating no 
special condition for this record or set to a motion component on the machine.  

When a motion component is specified, then the travel limit record is used if the axis of 
the conditional component is within the conditional minimum and maximum limit values. 

Component (C) —  Use to specify a condition when the travel limit record is used. Set to 
"OFF" indicating no special condition for this record, or specify a conditional motion 
component on the machine. Click on the Component (C) field of the highlighted record to 
put it in edit mode. Select the conditional motion component from drop down list. The 
list contains of all motion components in the machine; linear, rotary or turret. 

Minimum (C) / Maximum (C) — Use to specify the minimum, and maximum, travel 
limits for the conditional motion component (Component (C)). Click on the Minimum 
(C) / Maximum (C) field of a highlighted record to put it in edit mode. Enter the desired 
axis limit. 

Ignore — When toggled "On", over travel checking is ignored for the corresponding 
axis. 

 
 
Add Group — Use this feature to add a group of travel limit records. The number of 
travel limit records added will be equal to the number of motion components in the 
machine. The group number assigned will be the next available ascending group number 
in the list of travel limits.  
 
Insert — Use this feature to add a travel limit record. 
 
Delete — Use this feature to delete the selected travel limit record(s). 
 
 
OK or Apply must be used to apply changes. If you use Cancel and have made changes 
but have not used OK or Apply, you will be queried whether or not you want to apply 
the changes before leaving. 
 
 
To Machine Settings window
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Machine Settings window, Axis Priority tab 
Location: Configuration menu > Machine Settings 

Toolbar short cut for Machine Settings window:    

 

Features on this tab control how machine axes move in rapid positioning mode (e.g. G0). 
By default, machine axes are interpolated with equal priority to arrive at their destinations 
at the same time. You can change the priority to simulate non-interpolated rapid motion 
such as "dog leg" or "squared off" movement. 

 

 
 

Single — This option provides a single set of rapid priorities are used. The rapid 
priorities applied to the tool moving in the negative Z direction are the same as those 
applied to the tool moving in the positive Z direction. 

Pos/Neg — This option provides different rapid priorities depending on whether the tool 
is moving in a positive or negative Z direction. With this option, two rapid priority lists 
are provided. Use the Pos/ Neg options to control which list is seen. 

Positive / Negative options — When Pos/Neg priority is selected, these options control 
which rapid priority list is seen: the list applied when the tool is moving in the Positive Z 
direction, or the list for Negative Z tool motion. 

Axis Priority list — List of all machine motion axes and corresponding priorities. 



VERICUT HELP – Configuration menu 

Priority — Priority for moving motion axes move in rapid. A value of "1" moves that 
axis first. A "2" moves the axis with secondary priority (after those with priority "1"), and 
so on. Axes having the same priority move together. 

Interpolated — When active, interpolates axes that move together such that they arrive 
at their destination at the same time. Clear this checkbox to have axes move based on 
their defined Rapid Rate- ref. Modeling window: Component Attributes tab. 

 
 
To Machine Settings window 
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Machine Settings window, Machine Notes tab 
Location: Configuration menu > Machine Settings 

Toolbar short cut for Machine Settings window:    

 
Features on this tab enable you to add Message Notes and Comment Notes to the 
machine file. 
 
 

 
 
 

Message Notes are saved in the header of the machine file and are displayed in the 
VERICUT message area (Logger) when the machine file is loaded. Comment Notes are 
saved in the header of the machine file but do not display in the VERICUT Logger. 

There is a limit of 255 characters per line, but there is no limit to the number of lines that 
can be added. 

Any Message/Comment Notes that currently exist in the machine file are displayed in the 
appropriate text field as shown below. Any note can be edited and re-saved in the 
machine file. 
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Existing Message/Comment Notes in the machine file: 
 

 
 
 
In the machine file, each line of note is added to the header in quotes, and is preceded by 
either the keyword MESSAGE (for message notes), or COMMENT (for comment notes) 
as shown below. 
 
How the above messages look in the machine file: 
 
CGTech Machine 
Version-6.2 
MESSAGE "This is the 1st message note added to the machine file and 
should appear in the logger." 
MESSAGE "This is the 2nd message note added to the machine file and 
should appear in the logger." 
COMMENT "This is the 1st comment note added to the machine file and 
should not appear in the logger." 
 
UNITS MILLIMETER 
 
MACHINE "" { 
 PRIORITY_TYPE SINGLE 
 
 
Adding /editing notes: 
Add a note by typing the desired text, or edit the text of existing notes in the appropriate 
text field. When finished, press OK, or Apply, depending on whether or not you want to 
leave the Machine Settings window open. Then save the machine file using the 
Configuration menu > Machine > Save (or Save As) feature in the menu bar, or use 

 (Save Machine) in the tool bar. 
 
NOTE:  Machine files containing notes can not be used in pre-V6.2 versions of 
VERICUT. 
 
 
To Machine Settings window
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Component Tree (Component Tree window) 
 

VERICUT Users: 
VERICUT Location: Configuration menu > Component Tree 

VERICUT toolbar short cut:    

 

Mold and Die Users: 
Mold and Die Location:   Advanced Options page > Modeling  

Notebook Feature:      

  

Cutter Grinder Users: 
Cutter Grinder Location:   Advanced Options page > Modeling 

Notebook Feature:      

  

Opens a window that shows the "tree" of components and how they are connected, as 
well as provides a fast and easy way of manipulating components and their models. The 
component tree shows defined components by name and their connect positions. 
Indentation shows how components are connected in the tree. Select a component by 
picking its name in the tree. Actions performed using Components Tree window features 
are performed on the active (selected) component. 

To learn more about modeling and using the component tree, see "About modeling in 
VERICUT" in the Using VERICUT section, in the CGTech Help Library.  

Always press   (Reset Model) after changing components in the component tree. 

Component Tree — Tree of defined components and models. Indentation indicates that 
a component is connected to a parent component. Component names are listed in bold 
text with connect position values. Models added to a component are listed beneath the 
component name. Click the + / - symbols to expand or collapse branches of items in the 
tree. 
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Sample Component Tree window: 

 
 

File menu —  

Open Machine, Save Machine and Save As Machine functions enable you to open 
or save a Machine file containing data that describes NC machine construction, 
kinematics, and other properties. 

Save Cut Stock allows you to save the highlighted "Cut Stock" model as a 
VERICUT Solid file (.vct). This option is only active when the Cut Stock model is 
highlighted in the tree. The default file extension is .vct. 

A cut stock model can be saved as a VERICUT Solid file "with features" or "without 
features". Toggle the Save with Features option, in the Save Cut Stock window, On 
(the default) or Off. 

When the cut stock model is saved "with features", the cut database, the full history 
database, cut and stock colors are stored in the VERICUT Solid file in addition to the 
geometry data. When the cut stock model is saved "without features", only the 
geometry data is saved in the VERICUT Solid file. 
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VERICUT Solid (.vct) files are by default compressed when they are saved. 
VERICUT can read these compressed files directly. 

To disable writing compressed VERICUT Solid files, set the environment variable 
CGTECH_COMPRESS=VCT (ref. Environment Variables in the VERICUT Help 
section, in the CGTech Help Library for additional information). 

See VERICUT Solid File, in the Getting Started with VERICUT section, of 
VERICUT Help for more information. 

This functionality can also be accessed using File menu > Save Cut Stock > stock 
name. 

 

Edit menu — Functions in this menu manipulate components in the tree, as well as 
specify the component name, type, and attributes. 

Cut / Copy / Paste / Delete — Cuts, copies, pastes, or deletes a selected component 
in the component tree. All connected components and models are also affected. 

 

Shortcuts:   
1. Right-click on the component in the component tree, then choose the desired 

option from the menu that appears. See Component Tree Right Mouse Button 
Shortcut Menus below.  

2. You can also move components via dragging them from one parent 
component to another, and copy components via holding down the <Ctrl> 
key and dragging. 

3. Delete components or models by selecting the object in the graphics area, then 
use the <Delete> key on your keyboard. 

 

Rename — Allows you to rename the selected component. Type the new component 
name. 

Component Attributes — Accesses the features on the Modeling window: 
Component Attributes tab-see that section for details. 

Component Type — Enables you to edit the component's "Type" setting which 
determines the component's function in the simulation. Select the desired "Type" 
from the pull-down list. 

Component menu — The features in this menu enable new components to be added 
to the tree.  

Insert — adds the selected component before, and at the same level as the 
highlighted component. 

Append — adds the selected component after, and as a child of  the highlighted 
component. 
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The component type describes the component's function in the simulation. Choose 
the appropriate component type from the option list, based on the component's 
function in the simulation. Use Edit menu > Component Attributes to supply 
any other attributes that are needed. 

Component types: 
X Linear, Y Linear, Z Linear — Linear motion axes on an NC machine. 
Motion axes are parallel to X,Y,Z axes, respectively-but this can be changed 
via the Motion Axis component attribute. 

A Rotary, B Rotary, C Rotary — Rotary motion axes on an NC machine. 
The component origin is the pivot point of rotation. By default, rotation occurs 
about the X, Y, Z axes, respectively-but this can be changed via the Motion 
Axis component attribute. 

U Linear, V Linear, W Linear — Co-linear motion axes on an NC machine. 
Motion axes are parallel to X,Y,Z axes, respectively-but this can be changed 
via the Motion Axis component attribute. 

A2 Rotary, B2 Rotary, C2 Rotary — Secondary rotary motion axes on an 
NC machine. The component origin is the pivot point of rotation. By default, 
rotation occurs about the X, Y, Z axes, respectively-but this can be changed 
via the Motion Axis component attribute. 

A Turret, B Turret, C Turret — Indexing tool turret that rotates about X, Y, 
or Z axes. Like rotary components, the turret component origin is the pivot 
point for rotary indexing. The presence of these components cause all 
connected tools to be displayed making it possible to detect collisions 
resulting from turret indexing. A Turret component is commanded to move 
using a tool change command (e.g. Tn). The turret indexes based upon 
activating a Tool component connected to the turret. Tool component 
orientation determines the tool index position in the turret. Rotary control 
settings determine how turrets rotate, e.g.: rotation direction, etc. 

Base — A non-moving component to which other components are connected. 
Every machine definition begins with this component. 

Fixture — Hardware used to hold the workpiece for machining, such as: base 
plates, clamps, bolts, vises, pallets, etc. VERICUT assumes fixtures are not to 
be machined. Cuts in a fixture are shaded using the red Error color and an 
error is issued to the Log file. 
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Stock — Workpiece to be machined. This component type must be present in all 
simulations. 

Design — Solid or surface representation of the theoretical designed part. 

Design Point — Point representation of the theoretical designed part. 

Deflector — Deflectors used for water jet machining. 

Spindle — Spindle on an NC machine. The function of this component is different, 
depending on the machine type: milling or turning. Milling machine spindle- portion 
of the machine where cutting tools are loaded. Turning machine spindle - rotating 
component that turns the workpiece about the machine Z-axis. 

Tool — The location where cutting tools are loaded in an NC machine. Every NC 
machine definition must include one or more of these components. 

Guide — Wire guides on a wire EDM machine. 

Electrode — Electrodes for Die Sinking Simulation (EDM machining). 

Tool Chain — The Tool Chain component is used to define and model large tool 
handling mechanisms associated with machining centers. See Toolchain Operation 
in the Using VERICUT section, in the CGTech Help Library for more information.  
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NOTE:  The ToolChain component's location, in the component tree, must not 
precede any tool component(s). An error message will be displayed during loading, 
and during resets, if the ToolChain component precedes tool component(s). 

Attach — The Attach component is used to connect "setup" components in the 
project file to the machine. 

• Setup components are saved in the project file, not the machine file. 
• Stock/fixture/design components are "setup" components 
• "Setup" components can be axes and have kinematics relationships 
• Auxiliary devices can be connected to the Attach component 

How does the "Attach" component work? 

• A machine must have at least one Attach component, but multiple Attach 
components are allowed. If none is found, one is automatically created at the 
end of the first non-tool branch of the machine kinematics tree. 

• Components are contained in both in the machine, and in the setup. 
• A parent component in a "setup" references an Attach component in a 

machine. 

Other — Any non-moving component not represented by one of the preceding types. 
This component type is often used to define housings, gear boxes, shields, etc. 

NOTES: 
1. Right-click shortcut menus: Features used to manipulate components are 

displayed in a shortcut menu when you right-click on a component in the 
Component Tree window. Similarly, features used to manipulate models are 
displayed when you right-click on a model in the tree. See Component Tree 
Right Mouse Button Shortcut Menus below for more information. 

2. Double-clicking on a model or component in the Component Tree window 
opens the Model Definition window. 

3. You can move objects in the Component Tree window via dragging them 
from one parent component to another, or copy them via holding down the 
<Ctrl> key and dragging. 

4. Click repeatedly on a model in the graphics area to toggle selection between 
the model and its component. Refer to the Component Tree window to review 
what is selected. 

5. Using the center mouse button of a three button mouse, click repeatedly on a 
model in the graphics area to toggle selection between different models along 
the line of sight from the pick point. Use this technique to select models 
hidden from view by an object in the foreground. 

6. After cutting, a "Cut Stock" model appears as  in the Component 
Tree window. This object can be manipulated using modeling features just 
like any other component or model, allowing you to easily relocate the 
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workpiece for additional machining. You can also save the "Cut Stock" model 
as a VERICUT Solid file (.vct). 
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Component Tree Right Mouse Button Shortcut Menus 
 

Each item in the Component Tree has a right mouse button shortcut menu containing 
features specific to the particular item.  

NOTE:  Any item shown in bold a Component Tree right mouse button shortcut menu 
can also be reached directly by double clicking on the item (component, model) in the 
Component Tree, that you right-clicked on to display the shortcut menu. For example, 
double-clicking on the Component branch in the Component Tree displays the Modeling 
window: Component Attributes tab, just like clicking on Component Attributes in the 
right mouse button shortcut menu shown below. 
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Component 
Right-click on a component in the Component Tree window to display the following 
menu: 
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Component Attributes — Opens the Modeling window: Component Attributes tab. (ref. 
Modeling window: Component Attributes tab in the Project Menu section of 
VERICUT Help) 

Cut — Cuts the highlighted component from the Component Tree and puts it in the paste 
buffer. 

Copy — Copies the highlighted component from the Component Tree to the paste buffer. 

Paste — Uses the contents of the paste buffer to replace the highlighted component in the 
Component Tree. 

Delete — Deletes the highlighted component from the Component Tree. 

Rename — Use to rename the highlighted component. 

Insert — Use to add the selected component above and at the same level as the 
highlighted component. (ref. Component Tree window: Component Menu, in the 
Configuration Menu section of VERICUT Help) 

Append —Use to add the selected component below, and as a child of the highlighted 
component. (ref. Component Tree window: Component Menu, in the Configuration 
Menu section of VERICUT Help) 

Visibility — Use the Visibility features to specify whether or not a component is visible, 
and in what views. The check indicates the "current" visibility status. 

Blank — The highlighted component branch is not visible in any view. When 
Visibility is set to "Blank" for a component, the icon representing the component in 
the Component Tree will be displayed in gray  instead if a color. 

Workpiece View — The highlighted component branch is only visible in a 
Workpiece View. 

Machine View — The highlighted component branch is only visible in a Machine  
View (Machine, or Machine/Cut Stock). 

Both — The highlighted component branch is not visible in any view. 

Shortcut:  Double clicking on a Component will open the Modeling window: 
Component Attributes tab. 
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Model 
Right-click on a model in the Component Tree window to display the following menu: 
  

 
 

Modify — Opens the Modeling window: Model tab. (ref. Modeling window: Model tab 
in the Project Menu section of VERICUT Help) 

Cut — Cuts the highlighted model from the Component Tree and puts it in the paste 
buffer. 

Copy — Copies the highlighted model from the Component Tree to the paste buffer. 

Paste — Uses the contents of the paste buffer to replace the highlighted model in the 
Component Tree. 

Delete — Deletes the highlighted model from the Component Tree. 

Visible — Use to make the highlighted model visible, or not visible in the VERICUT 
graphics area. The Visible icon will indicate the visibility status of the model.  
indicates "visible",  indicates "not visible". Click on Visible to toggle between the two 
modes. In the Component Tree, any model in the "not visible" state will be displayed in 
gray instead if a color. 
 
Shortcut:  Double clicking on a Model in the Component Tree window will open the 
Modeling window: Model tab. 
  
 
Coordinate Systems Branch 
Right-click on a Coordinate Systems branch in the Component Tree window to display 
the following menu: 
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Modify — Opens the Coordinate System window. (ref. Coordinate System window in 
the Project Menu section of VERICUT Help. 
Paste — Use  to paste the contents of the paste buffer to the Coordinate Systems branch. 
Delete All — Deletes all coordinate systems from the Coordinate System branch. 
Expand All Children — Expands the Coordinate System branch showing all coordinate 
systems available in the setup. 
 
Shortcut:  Double clicking on a Coordinate Systems Branch will open the Coordinate 
System window. 
 
 
Coordinate System 
Right-click on a Coordinate System in the Component Tree window to display the 
following menu: 

 
Modify — Opens the Coordinate System window. (ref. Coordinate System window in 
the Project Menu section of VERICUT Help. 

Cut — Cuts the highlighted coordinate system from the Component Tree and puts it in 
the paste buffer. 

Copy — Copies the highlighted coordinate system from the Component Tree to the paste 
buffer. 

Paste — Adds the contents of the paste buffer after the highlighted coordinate system in 
the Component Tree. 

Delete — Deletes the highlighted model from the Component Tree. 

Active — Use to designate the "active"coordinate system. (ref. Set Active Coordinate 
System, in the Project Menu section of VERICUT Help. 

Visible — Use to make the highlighted coordinate system visible, or not visible in the 
VERICUT graphics area. The Visible icon will indicate the visibility status of the 
coordinate system.  indicates "visible",  indicates "not visible". Click on Visible to 
toggle between the two modes. In the Component Tree, any coordinate system in the "not 
visible" state will be displayed in gray instead if a color. 
 
Shortcut:  Double clicking on a Coordinate System in the Component Tree window will 
open the Coordinate System window.
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Control 
 

Open (Control file) 
Location: Configuration menu > Control > Open 

Toolbar short cut for opening Control files:     

 

Opens the Open Control window enabling you to open (load) a Control file (ref. Control 
File in the Getting Started with VERICUT section of VERICUT Help). Control files 
contain data that describes how the NC control processes machine code data. 

 

 
 

Most features on this window are standard file selection window features that enable you 
to navigate through directories, filter files, and type, or select, /path/filenames. A 
description of features specific to VERICUT can be found in the Introduction to 
VERICUT File Selection Windows in the Getting Started section of VERICUT Help. 

To save space, the features described below are unique to this window. 

Help on Samples — Opens the VERICUT Help section on "Library Control Files". 
Assuming Shortcut=CGTECH_LIBRARY, you can find the file you want in the on-line 
Help, then cut & paste the file name into the file selection window and press Open to 
open the file. 
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Save (Control file) 
Location: Configuration menu > Control > Save 

Toolbar short cut for saving Control files:    

TIP:  Right-click on the icon to toggle between  (SaveControl) and  (Save 
Control As) modes. 

 
Saves (updates) an existing Control file with the current NC control settings. VERICUT 
will save the control file if you have sufficient permissions to save the file in its present 
directory. Otherwise, the Save Control File window will display enabling you to specify a 
location to save where you have write permissions.
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Save As (Control file) 
Location: Configuration menu > Control > Save As 

Toolbar short cut for saving Control files:   

TIP:  Right-click on the icon to toggle between  (SaveControl) and  (Save 
Control As) modes. 

 

 
 

Opens the Save Control File window enabling you to save a Control file (ref. Control 
File in the Getting Started with VERICUT section of VERICUT Help). Control files 
contain data that describes how the NC control processes machine code data. 

Most features on this window are standard file selection window features that enable you 
to navigate through directories, filter files, and type, or select, /path/filenames. A 
description of features specific to VERICUT can be found in the Introduction to 
VERICUT File Selection Windows in the Getting Started section of VERICUT Help. 

To save space, the features described below are unique to this window. 

Units to Save — Controls the units (Inch or Millimeter) in which to store control 
configuration data. If the session units are different than the units to save, then values are 
converted accordingly when stored in the new file. 

Save Encrypted — Saves the control file as a standard encrypted (X-File) with an .xctl 
extension. 
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A "standard" encrypted control file: 

• works with a standard VERICUT license. 

• is a compressed binary file. 

• contains all files referenced by the Control file (no external subroutines). 

• simulates exactly the same as a standard control file (.ctl) 

• disables the Configuration menu features when used in a setup. 

• can not be decrypted/expanded except by CGTech so retain your original control 
(.ctl) file. 
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Word Format (Word Format window) 
Location: Configuration menu > Word Format 

VERICUT toolbar short cut:   

 

Opens a window enabling you to specify how the NC control interprets G-Code words 
and special characters, to specify syntax checking rules (error conditions) for checking 
your NC program file for valid syntax. 

 

 
 

 

NOTE:  Always reset VERICUT (press   (Reset Model) on the VERICUT main 
window) after making changes to the control configuration. 

 
Word Format tab — List of machine code, or "G-Code" data words and characters that 
are interpreted by the control, arranged in alphabetical order. The list provides a summary 
of word types, sub-types, inch and metric formats, and multipliers and composite formats. 

 Syntax Check tab — The features on this tab enable you to turn On/Off  VERICUT 
defined syntax checking rules (error conditions) and to define custom syntax checking 
error conditions for checking  the statements in your NC program file for valid syntax. 

 

OK — Saves additions/modifications and dismisses the Word Format window. 

Apply — Saves additions/modifications and leaves the Word Format window open. 

Cancel — Closes the Word Format window without saving any additions/modifications. 
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Word Format window, Word Format tab 
 

Opens a window enabling you to specify how the NC control interprets G-Code words 
and special characters. Once words are defined, they can be "grouped" with address 
values via the Configuration menu > Word/Address function to perform specific 
actions by calling CGTech supplied or custom macros. Undefined words cause errors 
when processed, and are not acted on by VERICUT. 

 

 
 

Each column in the Word Table represents a specific feature that enables you to define 
how the NC control interprets specific G-Code words or special characters. 

 

Name — Identifies the word or special character. Each word name must be unique. 

Type — Specifies the type of control function performed by the word. Options: 

Logical — Evaluates a logical expression. See "Logical Sub-type" below for more 
detailed classifications. 

Special — Accesses special NC control functions. See "Special Sub-type" below for 
more detailed classifications. 

Math — Performs a mathematical operation. See "Math Sub-type" below for more 
detailed classifications. 

Function — Calls the control function specified in the Function Name field. 

Type II — Specifies that the word is a three character mnemonic representing a Type 
II data command, e.g. "AXO", "CLS", etc. 

Macro — Word will be paired with a value, then configured via the Configuration 
menu> Word/Address function to call one or more action macros. 

Conditional — Similar to the Functions word type, except performs multiple 
functions, depending on the condition of word use. Conditional words are typically 
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supported by special routines written by CGTech or other developers to evaluate 
word use. 

Sub Type — Sub-types further differentiate word functions. Available sub-types are 
dependent on the word Type.  

Logical Sub Type — Options for evaluating logical expressions: 

Equal 
Not Equal 
Greater than 
Greater Than or Equal 
Less Than 
Less Than or Equal 
AND 
OR 
 

VERICUT also supports the following bitwise operators: 
 

Bitwise AND:  If both of the corresponding bits are on, then the resulting bit is 
on. 
Bitwise OR:  If either of the corresponding bits are on, then the resulting bit is on. 
Bitwise XOR: If either, but not both, of the corresponding bits are on, then the 
resulting bit is on. 
 
Simple examples: 
 
 9 AND 8 = 8 
 9 OR 8 = 9 
 9 XOR 8 = 1 
 7 AND 8 = 0 
 7 OR 8 = 15 
 7 XOR 8 = 15 

These operators follow the standard rules of precedence. 

NOTE:   For a compound equation, it is always best to use parenthesis, or brackets, 
to insure the order in which the equation will processed. Not all controls follow the 
standard rules of precedence. 

Special Sub Type — Options for performing special control functions. Click on the 
record "Sub Type" field and select from the list of available options in the pull-down 
menu. 

Skip — Skip remaining data in block. 

Begin Data / End Data — Denotes the beginning (or ending) of G-Code data to 
be processed by the control. If a Begin Data special word is defined with out 
specifying an End Data word, the Begin Data word is used for both. 
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Begin Comment / End Comment — Denotes the beginning (or ending) of a 
comment record. 

Begin Type II / End Type II — Denotes the beginning (or ending) of a Type II 
format record. 

Separator — Character used to separate data that is acted on differently by the 
control, for example a list of arguments or values. 

Variable Tag — Character which identifies the number that follows as a variable 
register number, e.g. "#". Example- "#100" indicates variable register number 
"100" is being referenced. 

Variable Name — Alpha-numeric word that identifies a variable which does not 
have an associated variable register number, e.g. "PPX" (type II variable format). 

End of Block — Denotes the end of the G-Code data block. 

Console Message — Identifies the block as a message displayed on the machine 
operator's console. 

Quoted Text — Identifies start/end delimiter for a quoted text string.  The default 
character for delimiting a quoted text string is the double quote (").  If a different 
character(s) is used as a delimiter, it must be defined as a SPECIAL type word 
with a sub-type of Quoted Text. Quoted text is valid in Alpha-Numeric and List-
Alpha-Numeric Word Value types. 

Ignore — Ignores specific words in the tool path file. 

Sin840D CASE — When this word is found, a special 840D parser will be used 
to process the remainder of the block.  

See "Notes about the Siemens 840D CASE and REPEAT commands" in the 
Notes about Special Topics  section, in the CGTech Help Library. 

Sin840D DEF — When this word is found, a special 840D parser will be used to 
process the remainder of the block. 

See "Notes about the Siemens 840D DEF command" in the Notes about Special 
Topics  section, in the CGTech Help Library. 

Sin840D REPEAT — When this word is found, a special 840D parser will be 
used to process the remainder of the block.  

See "Notes about the Siemens 840D CASE and REPEAT commands" in the 
Notes about Special Topics  section, in the CGTech Help Library. 

Sin840D DEFINE —  When this word is found, a special 840D parser will be 
used to process the remainder of the block. It will parse the remainder of the line, 
and establish a temporary substitution entry.  

The format is:  DEFINE str AS …    The "str" will be used as the "Input Text",  
and everything that follows the AS will be used as the "Output Text". 
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This substitution will be removed with the next reset, and will not be saved in the 
control file. Similar to variables, entries which are created in this manner will be 
marked with an "*" in the table on the Substitute tab. 

Sin840D SET — When this word is found, a special 840D parser will be used to 
process the remainder of the block. 

See "Notes about the Siemens 840D DEF command" in the Notes about Special 
Topics  section, in the CGTech Help Library. 

Sin840D REP — When this word is found, a special 840D parser will be used to 
process the remainder of the block. 

See "Notes about the Siemens 840D DEF command" in the Notes about Special 
Topics  section, in the CGTech Help Library. 

Text Argument — Used when defining Siemens 840D Frame access modifiers 
TR (translate value), FI (fine value), RT (rotate value), SC (scale factor) and MI 
(mirror flag). 

See "Notes about the Siemens 840D DEF command" in the Notes about Special 
Topics  section, in the CGTech Help Library. 

NUM VAR Define — When this word is found, a special parser will be used to 
process remainder of the statement up to the closing word ENDV. This includes 
the creation and initialization of the numerical variables, and the creation of the 
corresponding words (of type "Special" and sub-type "Variable Name"). Word 
ENDV is part of the NUM VAR Command but it doesn’t have to be specified in 
Word Format table. The VAR command can contain several blocks but is 
processed as a single block.  

The following defines the basic format of the VAR Command: 

VAR 
  [name] = value [name]…. 
  [name] [name]…. 
  … 
ENDV 

where: 

name – Variable name enclosed in brackets according to NUM syntax. 

value – assigned initial value (or expression) to the variable when present 
after "=" character.  If the initial value is in the form of an expression, it only 
can use previously defined and initialized variables. 

Rules for using: 
1. Brackets are part of the variable name 

2. No spaces or other delimiters are required between name and/or value (if 
used they are ignored).  
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3. Spaces can be used as a part of name (example [NBR AUBE]) inside 
brackets. 

4. Variable can be initialized immediately when defined or later (variable 
[INCR] in example below). 

  

Example: 

 VAR  
 [ORI] 
 [NBR_AUBE]=19 
 [RET_BLOC][NB_AU_US][INCR][POSIT_D][NBR_FOIS] 
 [INCR]=360/[NBR_AUBE] 
 [AUBE_NUM] [TOOL_VIE][NB_AA_US][CHG_1][CHG_2] 
ENDV 

 

NOTE:  Numerical arrays are not supported. 

 

Math Sub Type — Options for performing math operations. Click on the record 
"Sub Type" field and select from the list of available options in the pull-down menu. 

Add 

Subtract 

Multiply 

Divide 

Power 

Left Precedence 

Right Precedence 

Assignment 

Mod   
The Mod math operation is calculated as follows:  

N - D * INT(N/D) ==> -382 - 180 * INT(-2.12222) ==> -382 - 180 * -2 
==> -22 <-- TRUNC Returns Integer part of number) 

The Mod operator will produce the following results: 

382 Mod 180 = 22 

-382 Mod 180 = -22 

10 Mod 3 = 1 

10.1 Mod 3 = 1.1 
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Concatenate String 
This operator is used to concatenate two string variables. 

Example: 
VarA, VarB, and VarC are all defined in the Variables window as "Text" 
variables 

VarA, VarB, and VarC are all defined in the Word Format window as 
Type=Special, Sub Type=Variable Name 

<< is defined in the Word Format window as Type=Math, 
Sub Type=Concatenate String 
 

VarA = "ABC" 
VarB = "DEF" 
VarC = VarA << VarB 
VarC = ABCDEF 

 
Link Frame 

Use to configure the control to use the Siemens Frame link operator ":". The 
Frame link operator is used to combine the settings of 2, or more, functions or 
Frames in one Frame setup. 

See Notes about Siemens 840D DEF Command, in the Notes about Special 
Topics section in the CGTech Help Library for additional information. 

 
Function Sub Type — The control function that is called when the word is 
processed. Click on  in the record "Sub Type" field and select from the list of 
available options in the pull-down menu. See Functions – Listed Alphabetically 
below.  

You can also enter the name of a "custom" mathematical function, created with the 
CGTech Macro Language (CML), in the Sub Type text field as these will not 
appear in the pull-down list. 

NOTE:  The only time a value should ever be typed in is if it is a CMS function. 

Type II Sub Type — Describes syntax expected in a "Type II" command. Enter one 
or more of the descriptors listed below in the "Sub Type" text field to describe the 
expected syntax. Descriptors used in combinations are separated by commas. 

WV — word/value pair, e.g. "X1" 
T — text string 
V — numeric value 
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EXAMPLES: 
1. Configuration for set axis offsets command "(AXO,X1,Y2,Z3)": 

Name=AXO 
Type= Type II 
Sub Type = WV,WV,WV 

2. Configuration for call subroutine command "(CLS,SUB1)": 

Name=CLSType= Type II 

Sub Type= T,V,V,V,V,V 

NOTE:  The "V" descriptors shown in the example above, allow passing 
variables to the subroutine, although none are being passed in the above call 
example. 

Macro Sub Type — Specifies how the control interprets values, or "addresses" that 
follow the word. Click on the record "Sub Type" field and select from the list of 
available options in the pull-down menu. 

Numeric — Interprets word values as numbers. The system reads the numeric 
characters following the macro word until a non-numeric character is found, for 
example: alphabet, symbol, or separator. The non-numeric character indicates the 
beginning of a new word. 

Alphabet — Interprets word values as alphabet characters. The system reads the 
alphabet characters following the macro word until a non-alphabetic character is 
found, for example: number, symbol, or separator. 

Alpha-Numeric — Interprets word values as an alpha-numeric text string. The 
system reads the characters following the macro word until a symbol or separator 
character is found. 

If a "Word" is defined to have an alpha-numeric value, then the text that follows 
is assumed to be the corresponding value. 

1. If the text value corresponds to an existing variable, then the value passed 
will be the contents of the corresponding variable. 

2. If the text value corresponds to a variable tag followed by a numeric value, 
then the value passed will be the contents of the corresponding variable. 

3. Array variables are not supported. 

4. Expressions other then variables are not supported. 

5. Alpha numeric characters include:  A-Z, 0-9, ‘_” and sometimes ‘-“.   

6. The above enhancement does not apply to block like the following, since 
an alpha-numeric string does not follow the word 

a. Word = NAME 

b. Word [NAME] 

See details on what is passed to a macro given various situations. 
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Also see:  Notes about String Capabilities in VERICUT, in the Notes about 
Special Topics section, in the CGTech Help Library. 

 

Composite-Numeric — Separates word values into pieces which can be 
individually acted on. The system uses the Composite Format to "parse" the 
numeric characters following the word until a non-numeric character is found, for 
example: alphabet, symbol, or separator. See Composite Format for examples. 
Each separated piece of a composite-numeric word/value is available for calling 
macros via the Configuration menu > Word/Address function, and can be 
graphically selected from a word pick list. 

List-Numeric — Separates an argument list following the word into pieces which 
can be individually acted on. This option is useful in a situation like acting on "n" 
values differently in the sample codes: TEXT(n,n,n,n,...) or TEXT n,n,n,n,... 
Parens may be present but are not required, and commas separate the arguments. 
Up to 32 arguments can be listed. Each argument must be numeric, or a math 
expression which equates to a numeric value. Similar to Composite-Numeric 
value types, each separated piece of a list-numeric word/value is available for 
calling macros. However, these pieces do not appear in the word pick list. Specify 
the pieces via listing the word followed by a space and the sequential number of 
the argument in the list. Following the above example, you could use the 
Configuration menu > Word/Address function to associate macros with "TEXT 
1" (corresponds to the first "n" parameter value, "TEXT 2" (second "n" 
parameter), and so on. 

List-Alpha-Numeric — Same as above description for List-Numeric with one 
addition. The value may be a quoted-text string. In this case the quoted-text is not 
analyzed, and is just passed as text to an associated  Word/Address macro.  

Alpha-Numeric + Arguments — This subtype is used  to support subroutines 
with arguments for the Siemens 840D PROC command. The text argument 
associated with this subtype value will include an alpha-numeric string, and 
optionally, a string beginning with a "(" and ending with a ")". 

See "Notes about the Siemens 840D PROC command" in the Notes about 
Special Topics  section, in the CGTech Help Library. 

None — The word does not have an associated value. The first character after the 
word indicates the beginning of a new word. 

 

EXAMPLES: 
1. Assume the word "PGM" is defined as a Macro word type. The table below 

shows how Sub Type can affect the interpretation of the values paired with 
"PGM". 
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Sample data 
block 

Sub Type= 

Numeric 

Sub Type= 

Alphabet 

Sub Type= 

Alpha-Numeric 

Sub Type= 

None 

PGM123ABC 123 none 123ABC none 

PGMABC123 none ABC ABC123 none 

 

2. Consider interpreting the following block of data: "TEST(10,20,30)"  

In Word Format, add word "TEST" as follows: 

Name=TEST 
Type=Macro 
Sub Type=List-Numeric 

In Word/Address, add group to act on first argument in TEST list "10": 

Word=TEST 1 
Range=* 
Macroname=<desired macro> (group is passed a value of "10") 
and then add groups to act on second & third arguments in TEST list "20" and 
"30": 
Word=TEST 2 
Range=* 
Macroname=<desired macro> (passed value: "20") 
Word=TEST 3 
Range=* 
Macroname=<desired macro> (passed value: "30") 

  

Conditional Sub Type — The conditional control function that is called when the 
word is processed. Click on  in the record "Sub Type" field and select from the 
list of available options in the pull-down menu. See Conditionals – Listed 
Alphabetically below. You can also enter the name of a "custom" conditional 
function, created with the CGTech Macro Language (CML), in the Sub Type text 
field as these will not appear in the pull-down list. 

NOTE:  The only time a value should ever be typed in is if it is a CMS conditional. 

 

Inch Method — Specifies how to interpret inch address values. This feature is 
significant only for values that do not contain a decimal point. Values with a decimal are 
always interpreted via the "Decimal" method. See NOTE below. 

Options: 
Decimal — Interprets values as floating point decimals. 
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Leading or Decimal — Interprets values without a decimal as having leading zeros. 
Depending on the active unit system (inch or metric), values are interpreted as 
described by the corresponding "Format" (see below). 

Trailing or Decimal — Similar to Leading or Decimal, except interprets values as 
having trailing zeros. 

 

Inch Format — Specifies the number of digits before and after the decimal point when 
interpreting Inch Method, "leading", or "trailing" zero values. Data entry format is: a.b 
where "a" specifies the number of digits before, and "b" specifies the number of digits 
after the decimal point. See NOTE below. 

Metric Method — Specifies how to interpret metric address values. This feature is 
significant only for values that do not contain a decimal point. Values with a decimal are 
always interpreted via the "Decimal" method. See Inch Method, above, for list of 
options. See NOTE below. 

Metric Format — Specifies the number of digits before and after the decimal point 
when interpreting Metric Method, "leading", or "trailing" zero values. Data entry format 
is: a.b where "a" specifies the number of digits before, and "b" specifies the number of 
digits after the decimal point. See NOTE below. 

Multiply / Multiplier — When Multiply is set to "Yes", the word value is multiplied by 
the amount specified in the Multiplier field. (Note that a multiplier of "1" has no affect on 
the word value.) 

NOTE:  Only available when Type = Macro or Type = Conditional) 

 

Composite Format — Specifies how to break up, or "parse" Composite-Numeric value 
types. Enter one or more numbers separated by spaces to specify the quantity of parsed 
number values and the significant places of each. An asterisk "*" can be used as a wild 
card entry. Each parsed value appears in the word pick list of the Configuration menu > 
Word/Address function to perform individual actions. 

 

EXAMPLE: 

Parsing "T" word/values: 

Sample data 
block 

Composite 
Format 

Parsed values 

T0203 2 2 T=203, T1=02, T2=03 

T102 1 2 T=102, T1=1, T2=02 
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T0304 or T304 * 2 T=304, T1=03, T2=04 

T10001 * 2 T=10001, T1=100, T2=01 

T102 1 1 1 T=102, T1=1, T2=0, T3=2 

T12345678 2 * 2 T=12345678, T1=12, 
T2=3456, T3=78 

T102.3 * 2.1 T=102.3, T1=1, T2=02, 
T3=3 

T102.3 2.1 T=102.3, T1=10, T2=3 

T12345678.321 2 2.2 T=12345678.321, T1=12, 
T2=34, T3=32 

 
 

Add — Adds a record to the Word Table enabling you to add words or special characters 
to the control configuration.  

Delete — Deletes the highlighted word record from the control configuration. 

 

NOTE:  Always reset VERICUT (press   (Reset Model) on the VERICUT main 
window) after making changes to the control configuration. 

 

Shortcut:  You can right-click in the Word Table to display a menu containing Add and 
Delete. These provide the same functionality described above. 
 
Also see "Building NC Controls", in the Using VERICUT section, in the CGTech Help 
Library. 
 
 
To Word Format window
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Word Format window, Syntax Check tab 
 

The features on this tab enable you to turn On/Off  VERICUT defined syntax checking 
rules (error conditions), and to define custom syntax checking error conditions for 
checking  the statements in your G-Code NC program file for valid syntax. The syntax 
rules and settings are stored in the control file.  

NOTE:  This feature is not applicable to APT NC programs. 

The actual syntax checking of an NC program file is started in the NC Program window. 
See NC Program (Info), in the Info menu section of VERICUT Help for more 
information. 

 

 
 
 
VERICUT Defined Syntax Errors 
 
The following error conditions are provided with VERICUT. Simply toggle On 
(checkmark displayed) the syntax error conditions that you want checked.  
 

More than one decimal point in an address — Outputs an error when more than one 
decimal point is found in an address. 

Missing word before an address — Outputs an error when a necessary word is missing 
before an address. 
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Unbalanced number of Parentheses or brackets — Outputs an error when the 
statement contains more "opening" characters (i.e. (, or [ ) than "closing" characters (i.e. 
), or ]). 
Invalid comments — Outputs an error when invalid comment statements are found, for 
example, a comment in the middle of a block. 

Missing THEN or GOTO in IF statement — Outputs an error when an IF statement is 
missing a THEN, or GOTO, statement. 

Missing parentheses or brackets in If or While statement — Outputs an error when an 
IF, or While, statement is missing necessary parentheses, or bracket, characters. 

Missing parentheses or brackets in function —  Outputs an error when necessary 
parentheses, or bracket, characters are missing in a Function (or Conditional). 

Missing parentheses or brackets in word address — Outputs an error when necessary 
parentheses, or brackets, characters are missing in a word address. 

Word Format — Outputs an error when the word format is incorrect. 

 
 
User Defined Syntax Errors 
 

User Defined Syntax Error Record Table 

 
 
Each record in the table contains the following features: 
 

Check box — Each record has a checkbox enabling you to toggle the record On/Off. 

 Type — You can define the following two types of User Defined syntax errors 

Condition — Enables you to specific conditions that will be considered an error. 

A, B, C, D, E — Each of these fields represent a word, or group of words, used 
with the Condition fields to define the error condition. Each field is a text field 
that uses a space to separate words. The "space" is interpret as an "OR" condition. 

For example, "G30 G31" is interpret as "G30 or G31" 

The tilda character, "~", is used to define a range of numbers/values. 

For example, "G30~33" is interpret as "G30 or G31 or G32 or G33". 

It can be used to check for mutual exclusive groups. 
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For example: "G30~39" AND "G30~39" means you can only have a G3* 
code in the same line, otherwise it's an error. 

It can also be used to check the limits. 

For example "X-6~5" will find all X values between -6 to 5. 

 

Condition —  Use each of the Condition fields to specify the condition between 
the words, or groups of words, in the adjacent columns (i.e, "A" NOT "B"), that 
together define the error condition. Select the desired condition from the pull-
down list. Choose "blank", (interpret as an "OR" condition), AND, or NOT. 

For example, "G30 G31" AND "G90" means if there is a "G30" or a "G31" 
and there is a "G90" on the same line, it's an error. 

 

Word Format — Enables you to check the numeric format of a word's address. 

A — Use this column to specify the word, or words, used with the Condition 
field to define the error condition. Use a space to separate the words in this field. 

Condition —  Use this field to specify the error condition for the word, or words 
specified in column A that define the error condition. Select the desired condition 
from the pull-down list. Choose Decimal or Integer. 

For example, "M N" Decimal means Word M and Word N must followed by 
an integer, otherwise it's an error. 

 

Add — Adds a User Defined Syntax Error record, after the highlighted record, to the 
table. 

Delete — Deletes the highlighted User Defined Syntax Error record from the table. 

Select All — Toggles On all,  both VERICUT defined and User Defined syntax error 
conditions. 

Clear All — Toggles Off all,  both VERICUT defined and User Defined, syntax error 
conditions. 

 

To Word Format window
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Conditionals - listed alphabetically 
 
The conditionals which can be referenced via Configuration menu > Word Format are 
listed below in alphabetical order. Conditionals are passed the text string of the current 
block, up to and including the current word, and returns a word type specifying how the 
current word is to be interpreted (typically identified by the characters "Cond" in the 
function name) 
 
Conditionals 
 

AbCondEqual 
This function determines if the "=" should be interpreted as an assignment or as a logical 
operator. If the "=" is part of an IF or GTO Type II comand, it will be defined as a logical 
operator. Otherwise, it will be determined as an assignment operator. 
 

AbCondLeftParen 
Conditional function that looks at the next two characters to determine if it is a known 
"TYPE II" command. If the following 2 characters are: AB, AP, AT, CC, CL, CN, CS, 
CY, FA, KB, MD, MI, MT, NS, QU, RN, TA, TB, TC, TS, TT, or ZT, then the left paren 
is interpreted as the beginning of a type II command. Otherwise it is interpreted as a 
comment. 
 

AbCondRightParen 
If a comment is currently being processed, then the right paren is interpreted as an "END 
COMMENT" special control word. Otherwise it is interpreted as an "END TYPEII" 
word. 
 

AtanCondDivide 
AtanCondDivide(block_str) 
If the "/" symbol is part of an ATAN argument and is not imbedded within brackets ([ ]), 
then this function returns the type SEPARATOR. Otherwise this function returns the type 
DIVIDE. 
 

CinciCondEqual 
If G10 exists in the block, ignore the current word. If G11 exists in the block, interpret 
the current word as a logical EQUAL. Otherwise, interpret the current word as an 
assignment.
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CinciCondLeftBracket 
If the previous character was "T", ignore the current word. Otherwise, interpret the 
current word as a LEFT PRECEDENCE. Requires values to be initialized by the 
CinciBlockInit macro. 
 

CinciCondLeftParen 
Returns "Begin Type II" if a Type II command follows. Otherwise returns "Left 
Precedence". Requires values to be initialized by the CinciBlockInit macro. 
 

CinciCondRightBracket 
The current word will be either ignored or interpreted as a RIGHT PRECEDENCE 
depending on how the matching CinciCondLeftBracket was interpreted. Requires 
values to be initialized by the CinciBlockInit macro. 
 

CinciCondRightParen 
Returns "End Type II" if currently processing a Type II command. Otherwise returns 
"Right Precedence". Requires values to be initialized by the CinciBlockInit macro. 
 

CinciCondTWord 
If the current word was preceded by a "[", interpret the current word as a VARIABLE 
TAG. Otherwise, interpret the current word as a MACRO. 
 

CinciCondVWord 
Returns "Assignment" if G10 is in the block. Otherwise returns "Command". 
 

CycleCondPWord 
Sets P_1 (default) or P_2 after checking the context of the block containing the P-word. 
P_2 is set when the block contains a G76 and either X, Y, U or W words. 
 

CycleCondQWord 
Sets Q_1 (default) or Q_2 after checking the context of the block containing the Q-word. 
Q_2 is set when the block contains a G76 and either X, Y, U or W words. 
 

CycleCondRWord 

Sets R_1 (default) or R_2 after checking the context of the block containing the R-word. 
R_2 is set when the block contains a G74, G75, G76 and either X, Y, U or W words. 
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CycleCondUWord 
Sets U_1 (default) or U_2 after checking the context of the block containing the U-word. 
U_2 is set when the block contains a G71, G72, G73 and either P or Q words. 
 

CycleCondWWord 
Sets W_1 (default) or W_2 after checking the context of the block containing the W-
word. W_2 is set when the block contains a G71, G72, G73 and either P or Q words. 
 

FadalCondAsteriskWord 
FadalCondAsteriskWord(block_str) 
If the Asterisk Word comes after a "#" character, then this function returns the type 
MULTIPLY. Otherwise this function returns the type COMMENT. 
 

FadalCondEqualWord 
FadalCondEqualWord(block_str) 
If the Equal Word comes after the string "IF", then this function returns the type EQ . 
Otherwise, this function returns the type ASSIGNMENT. 
 

FadalCondLParenWord 
FadalCondLParenWord(block_str) 

If the Left Parenthesis Word comes after a "#" character, then this function returns the 
type LPAREN. Otherwise this function returns the type COMMENT. 
 

FadalCondNWord 
FadalCondNWord(block_str) 
If the N Word comes after a "#" character, then this function returns the type IGNORE. 
Otherwise this function returns the type COMMAND. 
 

FadalCondRParenWord 
FadalCondRParenWord(block_str) 
If the Right Parenthesis Word comes after a "#" character, then this function returns the 
type RPAREN. Otherwise this function returns the type END_COMMENT. 
 

FadalCondRWord 
FadalCondRWord(block_str) 
If the R Word comes after a “G” character, then this function returns the type 
COMMAND. Otherwise this function returns the type VARIABLE_TAG. 
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GeminiCondEqual 
This conditional determines if the "=" should be interpreted as an assignment or as a 
logical operator. If the "=" is part of an IFT, it will be defined as a logical 
operator. Otherwise, it will be determined as an assignment operator. 

 

GLCondPWord 
GLCondPWord(block_str) 
If the P word is part of a PDO command, in CYCLE mode, or if the next non-space 
character on the block is a "=", then this functions returns the type COMMAND. 
Otherwise this function returns the type VARIABLE_TAG. 
 

GLCondPWord2 
GLCondPWord2(block_str) 
The P word can either be part of a COMMAND, or a VARIABLE_TAG. If P is part of a 
VALUE argument of a TYPE II command, or is preceded by =, +, -, *, /, [, or (, then the 
P will be interpreted as a VARIABLE TAG. If an integer value does not follow the P, 
then the P will be interpreted as a COMMAND. If the integer number is followed by a =, 
+, -, *, /, ], or ), then the P will be interpreted as a VARIABLE TAG. Otherwise the P 
will be interpreted as a COMMAND. This conditional function is an alternative to 
GLCondPWord. You can use which ever function produces the correct results for you. 
 

HeidCondDivide 

• Conditional function which determines how a "/" character is to be interpreted. 
• If a "REP" precedes the "/" on the line, then it will be interpreted BEGIN 

COMMENT.  
• If a "CYCL DEF 14.1" precedes the "/" on the line, it is recognized as a list 

separator used between contour subroutines. See "Notes about simulating 
Heidenhain SL pocket cycles" in the Using VERICUT section for additional 
information. Using VERICUT can be found in the VERICUT Help Library. 

• Otherwise it will be interpreted as DIVIDE. 
 

HeidCondLeftParen 
This conditional is designed for Heidenhain MillPlus controls, where standard comments 
are preceded by a semicolon, but it is also permissible to use (comment) at the end of a 
block. It is used to determine when the "("  word is used as a left precedence for 
mathematical expression, and when it is used as a start of comment character. 
 

HeidCondMultiply 
This conditional is designed for the Heidenhain 530i control where the End Of Block 
(EOB) character is "*".  It is used to determine when the "*" word is used as a 
mathematical multiply operator, and when it is used as an EOB character. If the "*" is 
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only followed by white space characters (blank space, tab, etc.), it is interpret as an EOB 
character. 
 

HeidCondRightParen 
This conditional is designed for Heidenhain MillPlus controls, where standard comments 
are preceded by a semicolon, but it is also permissible to use (comment) at the end of a 
block. It is used to determine when the ")" word is used as a right precedence for 
mathematical expressions, and when it is used as an end of comment character. 
 

HeidCondQWord 
If the Q word comes after a D0 or a D1 string and prior to a P0 string, then this 
conditional function returns the type COMMAND. Otherwise this conditional function 
returns the type VARIABLE TAG 
 

KtCondLeftParen 

KtCondRightParen 
KtCondLeftParen(), KtCondRightParen() 
These functions support the "(" and ")" words when used as mathematical precedence and 
as Begin Type 2 data. 
 

NumCondAWord 
NumCondAWord(block_str) 
If the non-white space character immediately preceding the A Word is a "=", "<" , ">", 
"+", "-", "*", "/", "&", or "!", it is interpret as type FUNCTION, and sets the word to 
mathematical function ATAN. Otherwise the word is interpreted as a COMMAND (or 
MACRO). 
 

NumCondCWord 

NumCondCWord(block_str) 
If the non-white space character immediately preceding the C Word is a "=", "<" , ">", 
"+", "-", "*", "/", "&", or "!", it is interpret as type FUNCTION, and sets the word to 
mathematical function COS. Otherwise the word is interpreted as a COMMAND (or 
MACRO). 
 

NumCondDollarSignWord 
NumCondDollarSignWord(block_str) 
If the Dollar Sign Word comes after an "=", and the previous non-space character is a '+', 
'-', '*', '/', '=', '<', '>, or a '[', then this function returns the type FUNCTION, and sets the 
word to NUM_INPUT. Otherwise this function returns the type CONSOLE_MSG. 
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NumCondEqualWord 
NumCondEqualWord(block_str) 
If the Equal Word comes after the string "G79", or if the Equal Word comes after the 
string "IF" and before the word "THEN", then this function returns the type EQ. 
Otherwise, this function returns the type ASSIGNMENT. 
 

NumCondEWord 
NumCondEWord(block_str) 
If the E Word comes after a number, or if it begins the block , then this function returns 
the type VARIABLE_TAG. Otherwise this function returns the type FUNCTIONS, and 
sets the word to E_FUNC. 
 

NumCondRWord 
NumCondRWord(block_str) 
If the non-white space character immediately preceding the R Word is a "=", "<" , ">", 
"+", "-", "*", "/", "&", or "!", it is interpret as type FUNCTION, and sets the word to 
mathematical function SQRT. Otherwise the word is interpreted as a COMMAND (or 
MACRO). 
 

NumCondSWord 
NumCondSWord(block_str) 
If the non-white space character immediately preceding the S Word is a "=", "<" , ">", 
"+", "-", "*", "/", "&", or "!", it is interpret as type FUNCTION, and sets the word to 
mathematical function SIN. Otherwise the word is interpreted as a COMMAND (or 
MACRO). 
 

NumCondTWord 

NumCondTWord(block_str) 
If the non-white space character immediately preceding the T Word is a "=", "<" , ">", 
"+", "-", "*", "/", "&", or "!", it is interpret as type FUNCTION, and sets the word to FIX. 
Otherwise the word is interpreted as a COMMAND (or MACRO). 
 

OkumaCondNWord 
OkumaCondNWord(block_str) 
This function internally redefines the "N" word during parsing depending upon how it is 
being used: 

• If the next non-space character is numeric and the string "IF" or "GOTO" existed 
previously on the line, then this routine returns the type CONDITIONAL, and sets 
the word to N_GOTO_LABEL. 
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• If the next non-space character is numeric and the string "IF" or "GOTO" does not 
previously exist on the line, then this routine returns the type CONDITIONAL, 
and sets the word to N_LABEL. 

• If the next non-space character is not numeric, and the string "IF" or "GOTO" 
existed previously on the line, then this routine returns the type CONDITIONAL, 
and sets the word to N_GOTO_SEQ. 

 
For this functionality to work, the following words must be defined in the Configuration 
menu > Word Format window: 

• Name=N, Type=Conditional, Function Name=OkumaCondNWord 
• Name=N_GOTO_LABEL, Type=Macro, Value Type=Alpha-Numeric 
• Name=N_GOTO_SEQ, Type=Macro, Value Type=Numeric, Inch Method/Metric 

Method=Decimal 
• Name=N_LABEL, Type=Macro, Value Type=Alpha-Numeric 

 
Then, the Configuration menu > Word/Address function must also be configured to 
process the above-listed words, for example in the "Specials" class: 

• Word=N Range=*, Condition=* *, Macroname=Sequence, Scan=Yes, After=No 
• Word=N_GOTO_LABEL Range=*, Condition=* *, Macroname=LabelName & 

GotoLabel, Scan=No, After=No 
• Word=N_GOTO_SEQ Range=*, Condition=* *, Macroname=GotoJump, 

Scan=No, After=No 
• Word=N_LABEL Range=*, Condition=* *, Macroname=LabelMacro, 

Scan=Yes, After=No 
 

OliCondLeftParent 
OliCondLeftParent(block_str) 
If the Left Parenthesis Word comes after a "=" character, then this function returns the 
type LPAREN. Otherwise this function returns the type BEGIN_TYPEII. 

 

OliCondRightParent 
OliCondRightParent(block_str) 
If the Right Parenthesis Word comes after a BEGIN_TYPEII word, then this function 
returns the type END_TYPEII. Otherwise this function returns the type RPAREN. 
 

Siemens3RCond 
Siemens3RCond(block_str) 
Same as SiemensRCond(block_str), except it also looks to see if the @ command had 
finish prior to this point in the block. It does this by looking backwards from the current 
point, and checking to see if a non-operator, non-R, non-digit character exists between 
the current point and the @ command. When the R word is used as a command, it 
typically calls the VariableArgument macro. This sets up the addition arguments that are 
then processed by the specific Siemens macro. 
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SiemensCondLParenWord  
SiemensCondLParenWord() 
If MCALL is on the line, the word type is set to Left Precedence, otherwise it is set to 
Begin Comment. 
 

SiemensCondRParenWord 
SiemensCondRParenWord() 
If MCALL is on the line, the word type is set to Right Precedence, otherwise it is set to 
End Comment. 
 

SiemensRCond 
SiemensRCond(block_str) 
If the R Word comes after a "@" character, then this function returns the type 
COMMAND. Otherwise this function returns the type VARIABLE_TAG. 
 

TosnucCondVWord 
If the current word is within square brackets ( "[" and "]" ), interpret the current word as a 
VARIABLE TAG. Otherwise, interpret the current word as a MACRO. 
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Functions - listed alphabetically 
 
The functions which can be referenced via Configuration menu > Word Format are 
listed below in alphabetical order. Functions are typically passed a single numerical 
value, and return a numerical value. 
 
Functions 
 

abs 
abs(value) 
Returns the absolute value of the specified value. 
 

AbsCeil  
Rounds the specified value to the next higher absolute integer value. For example: 2.3 
would be rounded to 3, and -2.3 would be rounded to -3. 
 

AbsoluteDimension 
This new functions will handle formats like:  X=AC[2] Y=IC[3] Z=AC[2] I=AC[1] 
J=AC[2] where "[" and "]" are the left and right precedence words.  In the above format, 
AC and IC should be defined as words which then call the function. 
  

If the primary word is X,Y,Z,A,B,C,U,V,or W then:  
AbsoluteDimension will cause the specified value to be interpreted as absolute, 
and if the control is currently in incremental mode, it will convert it.   

If the primary word is I,J, or K then: 
AbsoluteDimension will use the absolute mode, the "Circle Center Mode" 
settings, and the "Incremental Circle Center Method" settings to determine how to 
convert the value.  

If the primary word is anything other then the above, no conversion will be executed, 
and the incoming value will be returned. 
 
Also see: IncrementalDimension 

 

acos_d 
acos_d(value) 
Returns the arc cosine of the specified value. The specified value must be in the range of 
-1.0 to 1.0. The return value is in degrees, and is in the range of 0.0 to 180.0. 
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acos_r 
acos_r(value) 
Returns the arc cosine of the specified value. The specified value must be in the range of 
-1.0 to 1.0. The return value is in radians, and is in the range of 0 to pi. 
 

asin_d 
asin_d(value) 
Returns the arc sine of the specified value. The specified value must be in the range of -
1.0 to 1.0. The return value is in degrees, and is in the range of -90.0 to 90.0. 

asin_r 
asin_r(value) 
Returns the arc sine of the specified value. The specified value must be in the range of -
1.0 to 1.0. The return value is in radians, and is in the range of -pi/2 to pi/2. 
 

atan2_d 
atan2_d(yvalue, xvalue) 
Returns the arc tangent of yvalue/xvalue. The return value is in degrees, and is in the 
range of -180.0 to 180.0. If yvalue and xvalue are both zero, the return value will be zero. 
 

atan2_r 
atan2_r(yvalue, xvalue) 
Returns the arc tangent of yvalue/xvalue. The return value is in radians, and is in the 
range of -pi to pi. If yvalue and xvalue are both zero, the return value will be zero. 
 

atan_d 
atan_d(value) 
Returns the arc tangent of the specified value. The specified value must be in the range of 
-1.0 to 1.0. The return value is in degrees, and is in the range of -90.0 to 90.0. 
 

atan_r 

atan_r(value) 
Returns the arc tangent of the specified value. The specified value must be in the range of 
-1.0 to 1.0. The return value is in radians, and is in the range of -pi/2 to pi/2. 
 

ceil 

ceil(value) 
Returns the least integral value greater than or equal to the specified value. 
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cosh_d 
cosh_d(angle) 
Returns the hyperbolic cosine of the given angle specified in degrees. 
 

cosh_r 
cosh_r(angle) 
Returns the hyperbolic cosine of the given angle specified in radians. 

cos_d 
cos_d(angle) 
Returns the cosine of the given angle specified in degrees. 
 

cos_r 
cos_r(angle) 
Returns the cosine of the given angle specified in radians. 
 

exp 
exp(power) 
Returns the natural logarithm "e" raised to the specified power. 
 

floor 
floor(value) 
Returns the greatest integral value less than or equal to the specified value. 
 

Fractional 
Fractional(value) 
Returns the fractional portion of the specified value. 
 

get_current_N_seqno 
get_current_N_seqno() 
Returns value of the current N word. If the N word was not specified on the current line, 
the value of the last specified N word is returned. 
 

IncrementalDimension 
This new function will handle formats like:  X=AC[2] Y=IC[3] Z=AC[2] I=AC[1] 
J=AC[2] where "[" and "]" are the left and right precedence words.  In the above format, 
AC and IC should be defined as words which then call the function.  
 

If the primary word is X,Y,Z,A,B,C,U,V,or W then:  
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IncrementalDimension will cause the specified value to be interpreted as 
incremental, and if the control is currently in absolute mode, it will convert it.   

If the primary word is I,J, or K then: 
IncrementalDimension will use the incremental mode, the "Circle Center Mode" 
settings, and the "Incremental Circle Center Method" settings to determine how to 
convert the value.  

If the primary word is anything other then the above, no conversion will be executed, 
and the incoming value will be returned. 
 
Also see: AbsoluteDimension 

 

IntTrunc 
IntTrunc(value) 
Returns the integer portion of the specified value. 
 

IntTruncAdj 
This function is identical to IntTrunc, except that it automatically adjusts for computer 
round off errors. The following are the results you can expect: 

 

#1 = TRUNC[4.1]     (ANSWER: 4) 
#2 = TRUNC[-4.1]     (ANSWER: -4) 
#3 = TRUNC[4.1 - 0.1]    (ANSWER: 3) 
#4 = TRUNC[-4.1 + 0.1]   (ANSWER: -3) 
#5 = TRUNC_ADJ[4.1]    (ANSWER: 4) 
#6 = TRUNC_ADJ[-4.1]    (ANSWER: -4) 
#7 = TRUNC_ADJ[4.1 - 0.1]  (ANSWER: 4) 
#8 = TRUNC_ADJ[-4.1 + 0.1]  (ANSWER: -4) 

 

ISNUMBER 
ISNUMBER(string) 

Checks if string parameter is the valid representation of a real number. Returns 1 if the 
string represents a number, or 0 if not. 

See also function NUMBER. 

 

ln 
ln(value) 
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Returns the natural logarithm of the specified value. The specified value must be positive 
otherwise zero is returned. 
 

log 
log(value) 
Returns the base 10 logarithm of the specified value. The specified value must be positive 
otherwise zero is returned. 
 

NumAtan 
NumAtan(value) 
Similar to atan2_d(yvalue, xvalue), except the return value is in thousandths of a degree. 
 

NUMBER 
NUMBER(string) 

Converts the input string into a real number and returns its value. "String" must represent 
a valid real number. Scientific notification with exponent is supported. Returns 0 if 
"string" does not represent a valid real number. 

See also function ISNUMBER. 

 

NumEFunc 
NumEFunc(value) 
If the variable is being assigned to a COMMAND word, a "NUM" specific factor is 
applied to the value of the variable. 
 

NumInput 
NumInput() 
Causes the program to prompt the user for input. If the first character of input is a-z or A-
Z, a value of 1-26 is returned. If the user enters a numeric value, the value entered will be 
returned. 
 

Round 
Round(value) 
Returns the integral value closest to the specified value. 
 

SiemensAxName 
Passed the name of an AXIS, and returns the AXIS (an integer value). 
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SiemensAxString 
Passed an AXIS value, and returns the AXIS name (a string value). 
 

SiemensCFINE 
Use to configure the control to use the Siemens Frame setting function CFINE. Function 
CFINE is used to set fine values of translation for specified axes in Frame. 

See Notes about Siemens 840D DEF Command, in the Notes about Special Topics 
section in the CGTech Help Library for additional information. 

 

SiemensCMIRROR 
Use to configure the control to use the Siemens Frame setting function CMIRROR. 
Function CMIRROR is used to set a mirrored (reverse) orientation for specified axes in 
Frame. 

See Notes about Siemens 840D DEF Command, in the Notes about Special Topics 
section in the CGTech Help Library for additional information. 

 

Siemens CROT 
Use to configure the control to use the Siemens Frame setting function CROT. Function 
CROT is used to set rotation angle values around specified axes in Frame. 

See Notes about Siemens 840D DEF Command, in the Notes about Special Topics 
section in the CGTech Help Library for additional information. 

 

SiemensCSALE 
Use to configure the control to use the Siemens Frame setting function CSALE. Function 
CSCALE is used to set scale values of specified axes in Frame. 

See Notes about Siemens 840D DEF Command, in the Notes about Special Topics 
section in the CGTech Help Library for additional information. 

 

SiemensCTRANS 
Use to configure the control to use the Siemens Frame setting function CTRANS. 
Function CTRANS is used to set translation values for specified axes in Frame. 

See Notes about Siemens 840D DEF Command, in the Notes about Special Topics 
section in the CGTech Help Library for additional information. 
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SiemensMEAFRAME 
Use to configure the control to use the Siemens Frame setting function MEAFRAME. 
Function MEAFRAME is used to create Frame based on difference between the actual 
measured location of 3 points on the machine and the assumed theoretical location of the 
three points. 

See Notes about Siemens 840D DEF Command, in the Notes about Special Topics 
section in the CGTech Help Library for additional information. 

 

sinh_d 
sinh_d(value) 
Returns the hyperbolic cosine of the given angle specified in degrees. 
 

sinh_r 
sinh_r(value) 
Returns the hyperbolic cosine of the given angle specified in radians. 
 

sin_d 
sin_d(value) 
Returns the cosine of the given angle specified in degrees. 
 

sin_r 
sin_r(value) 
Returns the cosine of the given angle specified in radians. 
 

Sqr 
sqr(value) 
Returns the square of the specified value. This function can be used with the word list to 
process statements like:  #1 = SQR(#2 + #3) 
 

sqrt 
sqrt(value) 
Returns the square root of the specified value. 
 

tanh_d 
tanh_d(angle) 
Returns the hyperbolic tangent of the given angle specified in degrees. 
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tanh_r 
tanh_r(angle) 
Returns the hyperbolic tangent of the given angle specified in radians. 
 

tan_d 
tan_d(angle) 
Returns the tangent of the given angle specified in degrees. 
 

tan_r 
tan_r(angle) 
Returns the tangent of the given angle specified in radians.  
 

ToolnumToPocket 
Returns the pocket number given the tool number. Specifically, it searches the tool list for 
the first matching cutter tool id, and returns the corresponding pocket number. If no list 
exist, or if the list is not based on pocket numbers, or if no matching entry can be found, 
the function will return the tool number. 
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Word Address (Word/Address window) 
Location: Configuration menu > Word/Address 

VERICUT toolbar short cut:   

 

Opens a window to "group" G-Code words previously defined via Configuration menu 
> Word Format with a range of address values, and associate them with action macros 
to simulate an action in the control, or on the machine. For simplicity, we'll call each of 
these address/value associations a "group". Each group can be configured to call one or 
more action macros. This functionality allows you to virtually "wire" a custom NC 
control based on machine code information present in the tool path file. Groups with 
similar functions are arranged into a "class". The listed order of classes in the 
Word/Address window helps determine the timing of when corresponding actions occur. 
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The Word/Address window consists of a "menu bar" and a "tree structure" representing 
the configuration of a particular NC control. 

 

The Menu Bar 
 
File 
Open — Opens a window enabling you to open (load) a control file. Provides the same 
function as Configuration menu > Control > Open.  

Save — Saves (updates) an existing Control file with the current NC control settings. 
Provides the same function as Configuration menu > Control > Save. 

Save As — Opens a window enabling you to save the current control file under a 
different name or path. Provides the same function as Configuration menu > Control > 
Save As. 

Close — Closes the Word Address window without saving the control file. 

 

Edit 
Add/Modify — Opens the Add/Modify Word/Address window enabling you to add or 
modify groups within the control configuration. 

Cut — Enables you to "cut" the object highlighted in the control configuration. 

Copy — Enables you to "copy" the object highlighted in the control configuration. 

Paste — Enables you to "paste" a previously "cut" or "copied" object after the object 
highlighted in the control configuration. 

NOTE:  When you "Cut", "Copy", or "Paste" an object in the "tree", all objects below 
it in that particular "branch" (children) are cut, copied, or pasted with it. 

 

Utilities 
Find — Opens the Find Word window enabling you to find the groups in a control 
configuration that are associated with a specific word/address value, or call specific 
macros. 

Validate — Opens the Word/Address Validate window enabling you to validate the 
control configuration.  
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The Control Configuration 
 
Object Hierarchy 

 
  

The illustration above shows an expanded "group" from the configuration "tree". The top 
level object, "Specials", represents a "class". The second level object (or branch), 
"Variable: 3000 *", represents "Word/Variable and Range", in this case Variable and 
Range. The third level object (branch), "**", represents a "conditional 
Word/State/Variable and conditional Range/Value ". The lowest level objects (branches), 
"AlarmSignal" and "EndProgram", represent Macro/Variable Names with associated 
data. Each lower level (or branch) is considered to be "a child or children" of the next 
higher level. 

 

Configuration "tree" 
The control configuration of a particular NC control is displayed as a "tree" structure. 
When you expand a "class" object, the "Word/Range" branch shows the word/address of 
the groups within the class. Expand a "Word/Range" object and the "Condition" branch 
shows conditions defined for the selected group. Finally, expanding a "Condition" object, 
displays the "Macro name" branch which shows the macros associated with the selected 
condition in the group.  

To summarize, expand a "class" to display the "groups" associated with it. Expand a 
"group" to display the different "conditions" associated with it. Similarly, expand a 
"condition" to display the macros/variables associated with the condition. 

Change the order of class, group, condition and macro objects in the control 
configuration by "left clicking" on an object and "dragging" it to the desired position. 
When you reposition an object, all of the objects below it in the branch (children) are also 
repositioned. 

 

Shortcut:  "Right click" in the Control Configuration window to display a shortcut menu 
with the following features: 
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Add/Modify, Cut, Copy, Paste, and Find — These features provide the same 
functionality described above under Edit in the Menu Bar. 

Contract All Children — Use to contract (remove the display) all "children" of the 
highlighted object. 

Expand All Children — Use to expand (display) all "children" of the highlighted object. 

 

NOTES:  

1. Always reset VERICUT (press  (Reset Model) on the VERICUT main window)  
after making changes to the control configuration. 

2. Use the Debug Macro Arguments feature, on the Project menu > Processing 
Options > G-Code > Process Options: Debug tab,  to output the macro name, the 
word, the text string value, and the numeric value for each macro as it is called. 

 
Also see "Building NC Controls", in the Using VERICUT section, in the CGTech Help 
Library.
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Add/Modify Word/Address window 
 

Opened by pressing Add/Modify on the Word/Address window, the features on this 
window enable you to maintain groups/conditions in the control configuration. 
VERICUT will attempt to add a new group after the group selected in the list. A new 
group condition is added after the selected condition, and so on. However, if the word 
and range of an added group matches that of a previously defined group, the new group is 
automatically added as a condition to the previously defined group. This occurs even 
when the previously defined group resides in a different class. 
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Class Name — Enables you to add a new "class" or rename an existing "class".  

Word / Variable — Controls the type of group being defined.  

Word Options: 
Word — These features define a group whose actions are performed when a G-
Code having a corresponding word and address value is processed. Enter the 
group word in the text field. The word must be previously defined via the Word 
Format function. You can type the word character, or click on Pick, and then 
select it from the list of defined words that displays.  

Range — Use the Range text field to specify a value, or range of values, that will 
cause the specified action to be processed. The Range value commonly specifies a 
single address. However, you can also specify multiple range values (separated by 
spaces or commas), inclusive ranges, or use "*" as a wildcard to denote "all 
values". The following shows all valid Range value entries and their meanings: 

 

Range Entry Meaning 

* Any value 

value A specific value like 7, or 9 

7,9 A series of numbers 

5-9 Integer values between 5 and 9 inclusive 

(5, 6, 7, 8, and 9) 

5.0-9.0 All numbers between 5.0 and 9.0 

#2 A variable.  The variable must be prefixed with a # 

$ The current value associated with the word. 

 NOTE:  This really only make sense with a 
"Conditional Value" 

<n Less than n, where n is a value, a variable (designated 
with the #), or a $ 

<=n Less than or equal to n, where n is a value, a variable 
(designated with the #), or a $ 

>n Greater than n, where n is a value, a variable (designated 
with the #), or a $ 
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NOTE:  Typically, Range values are integers. If you need to specify a group of 
NC codes, some of which contain decimal values (for example, G45, G45.1 G46) 
define the group Range as a series (45 45.1 46), rather than as an "inclusive" 
Range (45-46). Inclusive Ranges of real values may be defined by including a 
decimal point with the value. For example, the Range (45.0-46.0) will select all 
values between 45 and 46. 

 

The following are typical examples of how Word and Range can be used to 
specify G-Codes acted on for a specific group "L". 

 

Group Word Range G-Codes acted on by the group 

L 2 L2 

L 1 5 L1, L5 

L 1 5-10 L1, L5, L6, L7, L8, L9, L10 

L NONE L ("L" without a numeric value) 

L * Ln (where "n" is any value) 

 

>=n Greater than or equal to n, where n is a value, a variable 
(designated with the #), or a $ 

=n Equal to n, where n is a value, a variable (designated 
with the #), or a $ 

#3-$ A range of values specified using a variable and a $ 

NONE Supports processing words without values differently 
from the same words with values. For example, you can 
configure N010X to be handled differently from 
N010X0. 
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Variable Options: 
Variable — Use to define a group whose actions are performed when a specified 
variable is set to a corresponding value, or range of values. Enter the group 
variable name in the Variable text field. 

Range — Use the Range text field to specify a value, or range of values, that will 
cause the specified action to be processed. Variable ranges are specified in the 
same manner as described above for Word ranges. 

 
Conditions — Use to specify one or more conditions, which if met, causes the group to 
perform different action(s). 

Operator — Choose and or not from the pull-down list. 

Type — Use to specify the type of condition. 

Word — When Type is set to Word, the Condition is based on another word 
and address value range appearing in the G-Code data block. This is the most 
common condition type. Select the desired Condition from the pull-down list, 
and then enter the Conditional Value(s). Conditional Values are specified in the 
same manner as described above for Word ranges. 

 

For example:      G 81 not (X *) and not (Y *) and not (Z *) calls ErrorMacro 

 
  

 
State — When Type is set to State, the Condition is based on a machine state. 
Choose the desired Condition from the pull-down list, and then choose a value from 
the Conditional Value pull-down list. Notice that only values that are valid for the 
selected Condition appear in the Conditional Value list. 
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Variable — When Type is set to Variable, the Condition is based on when a 
variable is set to a corresponding Conditional Value. In the Condition column enter 
the variable name, and then enter the Conditional Value(s). Conditional Values are 
specified in the same manner as described above for Word ranges. 

 
Add — Use to add a condition to the conditions list. The new condition will be added 
after the highlighted condition in the list. 

NOTE:  It is never necessary to have the list in any specific order since all items in the 
list must be TRUE for the corresponding macro to be executed. As a personal preference, 
you might want to read the list in a specific order. To this end, the new condition is 
always added after the highlighted condition in the list. You can also change the position 
of a condition in the list by clicking on the button, on the left side of each row, and drag 
the condition to the desired position in the list. 

Delete — Use to delete the highlighted condition from the conditions list. 

 
Macroname / Variable — Use to specify whether a group calls a macro, or sets a 
variable.  

Macroname — Specify the macro to be called by selecting from the list or by typing 
the macro name in the text field. Text entered is not case sensitive. Use the automatic 
filtering capability to help you find macros. As you enter text characters in the 
Macroname  text field, the list of macros is automatically filtered to show those that 
match the entered text. 

Process during Scan — When active, calls the macro during a "scan pass" prior 
to NC program processing (ref. "Scan NC Program Files" on the Project menu 
> Processing Options > G-Code > Settings: Settings tab). The default condition 
is to call the macro during NC program processing. 

Variable — Use the Variable Name, and Variable Description text fields to 
specify, and describe, the variable to be set. Use the Override Value text field, 
described below, to specify the variable value. 

 
Process After Motion — When active, performs the group action after motion 
commands in the data block have been processed. The default condition is to perform the 
group action according to the rules of normal G-Code data processing. (Ref. "About 
building NC controls" in the Using VERICUT section. Using VERICUT can be found in 
the VERICUT Help Library.) 

Override Value — This feature acts differently, depending on if Macroname, or 
Variable, is selected: 

With Macroname selected — Used to specify a value to be passed to the specified 
macro. If blank, the address value accompanying the word is passed. 
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With Variable selected — Used to specify a value to be assigned to the specified 
variable.  

Math expressions and variables, understood by the control, are supported. Enter "$" 
to specify using the address value accompanying the word. Enter "#", followed 
immediately by the variable name/number, followed by a space, to specify a variable 
value. Multiple variables can be added, separated by a blank space. If the override 
expression does not contain either of these characters, it is evaluated immediately and 
only the value is retained. If the expression can not be evaluated immediately, the full 
expression is retained in the control configuration and evaluated separately for each 
block that activates the group.  

Also see "Using Equations/Expression In VERICUT" in the Using VERICUT 
section, in the CGTech Help Library, for more information.  

 

Examples of using Override Value: (given that the variable, #2 = 3) 

Text entered in 
Override Value 

field 

What is retained in 
control configuration

Sample G-
Code data 

block 

Resulting value when 
processed 

SIN(30) .5 X5 .5 (constant value- not 
affected by G-Code 
data) 

SIN(30) .5 X10 .5 (see note above) 

$*10 $*10 X5 50 

($+#2)*10 ($+#2)*10 X5 80 

  

Override Text — Similar to Override Value, except that it is used to specify text to be 
passed to the macro. Only certain macros are designed to accept text values. Consult the 
"Macros - listed alphabetically" in the VERICUT Macros section, in the CGTech Help 
Library, for more information. 

Expression(s) can be used in macro override text. If the override text contains the 
sequence "{expression}" , the expression text inside the curly-braces is evaluated, and 
then replaced with the calculated value. 

The syntax for the expression(s) is the same as defined above for Override Values. 
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Examples:  
1. If the MessageMacro is used with the following override text: 

Override Text = "The spindle speed is {#speed} rpm" 

The variable "#speed" is evaluated and if set to 500, the resulting message 
would be: 

"The spindle speed is 500 rpm" 

2. $$ within {} enables you to include the incoming text string. For example: 

Override Text = Operation Name: {$$} 

3. Text variables are also supported. For example: if the variable "NAME" was set 
to the operation name, you could have: 

Override Text = Operation Name: {#NAME} 

If the contents within {} has either a "$$" or a text variable, then the expression will be 
evaluated as a text string. When dealing with text, it is recommended that you have only 
have 1 item within the {}. For example, if the variable "DATE" contained "May 2007", 
you could have:  

Override Text  = Operation Name: {$$}, {#DATE}. This syntax is preferable to:  
Override Text = Operation Name: {$$ : #DATE} 

The output would be: Operation Name: 1-TOP0-FOAM-LICKA, May 2007 

Also see "Using Equations/Expression In VERICUT" in the Using VERICUT section, 
in the CGTech Help Library, for more information.  

 

Override Word Format — When toggled "on", the word format specified with the 
macro will be used rather than the default word format. Use the Set button, described 
below, to display the Override Word Format window, and then use its features to define 
the word format for the specific macro. For example, this feature would enable you to 
define a P with a G71 to be decimal, and a P with a G76 to be Trailing 3.4.  

NOTE:   This feature does not support expressions.  For example, you could not use this 
feature with:  X=54000 + 30000 

Set — Used in conjunction with Override Word Format, described above. Displays the 
Override Word Format window enabling you to specify a word format for a specific 
macro.  

 

Add — Select when adding a new group or condition. 

Modify — Select when modifying an existing group or condition. 

Close — Close the Add/Modify Word/Address window. 
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Override Word Format window 
 

Used in conjunction with the Override Word Format feature, on the Add/Modify 
Word/Address window, to specify a word format to be used with a specific macro rather 
than use the default word format. Use the Set button, on the Add/Modify Word/Address 
window, to display the Override Word Format window. 

 

 
 

Inch Method / Metric Method — Specifies how to interpret inch (or metric) address 
values. This feature is significant only for values that do not contain a decimal point. 
Values with a decimal are always interpreted via the "Decimal" method.  

Options: 
Decimal — Interprets values as floating point decimals. 

Leading or Decimal — Interprets values without a decimal as having leading 
zeros. Depending on the active unit system (inch or metric), values are interpreted 
as described by the corresponding "Format" (see below). 

Trailing or Decimal — Similar to Leading or Decimal, except that values are 
interpreted as having trailing zeros. 

Inch Format / Metric Format — Specifies the number of digits before and after the 
decimal point when interpreting leading or trailing zero values. Data entry format is: 
a.b where "a" specifies the number of digits before, and "b" specifies the number of 
digits after the decimal point. 

OK — Applies the settings and closes the Override Word Format window. 

Cancel — Closes the Override Word Format window without accepting the settings. 
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Find Word window 
 

Opened using Utilities menu >Find on the Word/Address window, the features on this 
window help you find the groups in a control configuration that are associated with a 
specific word/address value, or call specific macros. 

  

 
  

Words/Range tab — Enables you to find groups associated based on a specific 
word/address value. Pick the desired word from the Word list, and then enter the address 
value in the Range field. 

Macroname tab — Enables you to find groups that call a specific macro. Type or pick 
the name of the desired macro from the Macroname list. 

 After configuring the window to find the desired group, use the buttons at the bottom of 
the window to find the First, Next, or Previous occurrence in the control configuration. 
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Word/Address Validate window 
 
Opens the Word/Address Validate window enabling you to validate the control 
configuration.  

 

 
 

Validate — Starts the validation process. VERICUT searches through the control 
checking for errors or conflicts within the Word/Address groups. If an error\conflict 
is detected, the validation process stops and the entity that has the problem is 
highlighted and a message is output to the message log area. If no errors/conflicts are 
found, the validation process continues until the end of the control configuration is 
reached. 

Next — Use to continue the validation process after an error/conflict is identified. 

Previous — Use to go back to the previous error/conflict. 

Close — Stops the validation process and closes the Word/Address Validate window. 
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Control Settings (Control Settings window) 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window enabling you to configure how the machine control will process 
machine code data. 

  

 
  

General tab — Features on this tab are used to configure general guidelines for how the 
control processes machine code data and number equations. 

Motion tab — Features on this tab are used to configure default NC control motion states, 
and the precision used when outputting calculated values. 

Circles tab — Features on this tab are used to configure how the circle center data (e.g. I 
J K) is interpreted.  
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Cycles tab — Features on this tab are used to configure how fixed tool axis, or "canned" 
cycle motion blocks are interpreted, e.g. G8n. 

Tooling tab — The features on this tab are used to configure default tooling conditions 
and tool change activity.  

Rotary tab — Features on this tab are used to configure how rotary motion commands are 
interpreted, e.g. A, B, C.  

Wire EDM tab — Features on this tab are used to configure wire EDM machining 
settings.  

Cutter Compensation tab — Features on this tab are used to configure how the 
programmed tool path is compensated when cutter diameter compensation, or "CDC" is 
used, e.g. G41-42.  

Offsets tab — Features on this tab are used to configure an initial work offset, or “fixture 
offset”, to be in effect at the start of tool path processing.  

Subroutines tab — Features on this tab are used to configure how subroutine names are 
referenced by the NC control. 

OptiPath & Curve Fit tab — Features on this tab are used to configure settings referenced 
when G-Code tool path files are optimized by OptiPath.  

User Defined (CTL) tab — Features on this tab are used to configure user defined control 
settings supplied via a custom CME file. 

Sync tab — Features on this tab configure VERICUT for simulating machining with 
synchronized subsystems. 

Control Notes tab — Features on this tab are used to enter "message notes" and 
"comment notes" in the current control file. 

Turning tab — Features on this tab configure VERICUT for lathe turning simulations. 

 

  

OK — Applies the changes and closes the Control Settings window. 

Apply — Applies the changes and leaves the Control Settings window open. 

Cancel — Closes the Control Settings window without applying changes. 

 
Also see "Building NC Controls", in the Using VERICUT section, in the CGTech Help 
Library.
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Control Settings window, General tab 
Location:   Configuration menu > Control Settings 

OptiPath menu > Control > G-Code Output Options tab 

VERICUT toolbar short cut:   

  

Opens a window to configure general guidelines for how the control processes machine 
code data and number equations. 

  

 
  

Control Type — Sets the type of NC control being used. Choosing the proper option 
establishes a mode of operation consistent with how the control processes NC data. 
Options are: 

Generic — Fanuc and most other controls using standard controller functions. 

NUM — French-made control. This option affects how G-Code data is interpreted, 
for example: how variables are initialized and processed, and how to interpret 
parameters to macros that shift the location of the tool path. 

Heidenhain Conversational — Heidenhain Conversational control. This option 
causes VERICUT to recognize the "L" word as an optimizable word. Also, the "L" 
word is included with any cuts added during optimization. 

Siemens — Siemens 840D control. Special logic is added in the "filter" logic for the 
processing of NURBS. 

Toshiba — Toshiba control. Special logic is added in the "filter" logic for the 
processing of NURBS. 
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Heidenhain ISO — Heidenhain ISO control. If  a block is marked as non-
optimizable, and the block contains a I, J, or K (circle record), then the Feedrate is not 
restored (similar to going into RAPID mode). A series of OptiPath output formatting 
decisions are based on this control type. 

K&T — Kearney & Trecker control. Special handling is added for TYPE II 
processing.  If a TYPE II argument is defined to be a V (Value), but an "=" character 
is found within this argument, then the argument is internally processed as a WV 
argument. 

Calculation Tolerance — Tolerance for rounding mathematical evaluations, such as 
determining if two calculated values are equal to, greater than, or lesser than each other.  

NOTE:  The Calculation Tolerance should be adjusted to eliminate "invalid circle" 
errors caused by circle calculations that produce differences larger than the tolerance 
value when processing G-Code data. 

Order of Math Operations — Order in which math operations are performed. Options 
are: 

Rules of Precedence — Follow the basic rules of math precedence: 

1. Perform exponential (power). 

2. Perform multiplication and division operations. 

3. Perform addition and subtraction operations, example: 5 + 5.3 * 3 * sin(30)= 
12.95 

Enclosing math operations in parenthesis causes them to be performed before 
those not enclosed in parenthesis. The same rules of precedence are applied to 
math operations enclosed in parenthesis. 

Left to Right — Use left to right sequence, example: 5 + 5.3 * 3 * sin(30)= 15.45 

Default Word — Word assumed by VERICUT for NC data blocks beginning with 
numbers, such as NC data for some Heidenhain controls. For example, for VERICUT to 
interpret blocks like "50G01X5", set Default Word to "N". VERICUT then interprets the 
block without error as "N50G01X5". 

 
 
To Control Settings window
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Control Settings window, Motion tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

 

Opens a window enabling you to configure default NC control motion states, and specify 
the precision used when outputting calculated values. These settings are in affect when 
the control and machine are initially powered on. 

 

 
 



VERICUT HELP – Configuration menu 

Default Motion Type — Default motion type for the control.  

Options are: 

Rapid 
Linear 
 

Default Plane Selection — Default motion plane, or "cutting plane" for the control. 
Options are:  

XY 
ZX 
YZ 
 
Default Control Units — Default measurement units for the control. 

Options are: 

Inch 
Metric 
 

Default Command Mode — Default command mode, or "input dimension mode" for 
the control. 

Options are: 

Absolute 
Incremental 
 

Default Feed Mode / Default Feedrate — Default feed rate mode and value for the 
control. 

Feed mode options are: 

Feed per Minute 
Feed per Revolution 
 

Output Initial Spindle Location — When active, causes the machine to move to its 
initial spindle location at the beginning of tool path processing. Enter initial machine 
location values in an Initial Machine Location table. 

Rapid Motion Cancels Cycles — When active, rapid motions (e.g. G0) cancel canned 
cycles (e.g. G81-89). 

Linear Motion Cancels Cycles — When active, linear motions (e.g. G01) cancel canned 
cycles (e.g. G81-89). 

CW Motion Cancels Cycles / CCW Motion Cancels Cycles — When active, clockwise 
(or counterclockwise) circular interpolation motions (e.g. G02) cancel canned cycles (e.g. 
G81-89). 
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Output Rapid Motions as — Controls the format in which rapid motions are written to 
the APT Output file during reverse post-processing. 

Options are: 
Rapid — Output the word "RAPID" followed by a single tool tip location. 

Feedrate — Output "FEDRAT/n" where the feed rate is calculated based on the 
rapid priority of moving axes, and then output the tool tip location(s). When rapid 
priority causes axes to move independently, multiple tool tip positions are output. 

Maximum Inverse Time Output Feedrate — Highest feedrate value which can result 
from interpreting inverse time feed rate values (e.g. G93). The output feed rate is set to 
this rate when in inverse time feed mode and the calculated feed rate is zero or greater 
then the specified maximum. 

Output Precision — Controls the accuracy used to interpret calculated values, such as: 
CDC offset positions, mathematical operations, etc. 

Options are: 
Full Precision — Highest possible accuracy. Note that full precision output values 
can result in higher accuracy than the NC control uses, which may result in 
differences between simulated motion and the actual motion performed by the NC 
control. 

Input Precision — Use the accuracy used in the input tool path file. For example, 
when tool path file data is in 3.4 format, the precision used is also 3.4. 

Specified Precision — Use the accuracy specified via Specified Output Precision 
(see below) 

Specified Output Precision — When Output Precision= Specified Precision, this 
value reflects the accuracy used by the NC control to perform the operations described 
above for Output Precision. 

 
 
To Control Settings window
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Control Settings window, Circles tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure how the circle center data (e.g. IJK) is interpreted. The 
Interpolation Tolerance determines the quantity of machine positions which simulate 
arc and helical motions. 

  

 
  

Circle Center Mode — Mode in which to interpret circle center data. 

Options:  
Absolute — Absolute center coordinates. 

Incremental — Incremental distances. (See "Incremental Circle Center Method" 
below).  

G Code Dependent — As described above, except depends on the active input 
dimension mode: absolute or incremental. 

Incremental Circle Center Method — When interpreting incremental circle center 
values, controls how incremental circle center data is interpreted. 

 

Options:  
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From Start to Center Point — Distance from circle start point to circle center. 

From Center to Start Point — Distance from circle center to circle start point. 

Unsigned — Unsigned, positive incremental distance between circle start point and 
circle center). Unsigned incremental circle motion blocks are always positive in 
value, and do not cut circles greater than 90 degrees. 

Pitch Specified with IJK — This option determines if the CircleCenterX, and 
CircleCenterY, and CircleCenterZ macros can be used to determine the pitch. Only the 
macro which corresponds to the direction perpendicular to the current motion plane will 
be used for the pitch value. The pitch is defined as depth per revolution. The default is 
"No". If set to "Yes", the delta depth distance divided by the pitch will determine the 
number of full loops. If set to "No", the HelicalFullLoops macro should be called, and 
the pitch will be calculated based on the number of full loops, the delta depth distance, 
and the starting and ending angles. 

APT Output for Circular Motion — Controls the format in which circular motions are 
output during conversion to an APT output file. An APT Output file is created when 
Create APT Output File is active. (Ref. Process Options window: G-Code Output 
Files tab). 

 
 
To Control Settings window
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Control Settings window, Cycles tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure how fixed tool axis, or "canned" cycle motion blocks are 
interpreted, e.g. G8n. 

  

 
  

Cycle Return Level — Controls where the tool tip is returned (retracted) after 
processing a cycle command.  

Options: 

R Point — Rapid positioning or "R level". 

Initial Point — Initial level from where the cycle motion began. 

Specified Point — Clearance distance from the workpiece as specified by a 
word/address, such as G71Zn with some Okuma controls, or Clearance + Retraction 
(similar to Specified Point, except a retraction clearance can be specified). 
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Cycle Clearance Distance — Distance from the workpiece to the R level. 
 

 
 

Cycle Rapid method — Controls how rapid positioning is performed between cycle 
executions. 

Options: 
Clearance Plane — FANUC method-R level located at some clearance above the 
workpiece, tool tip placed at the R level). 

Part Surface — Cincinnati Acramatic method-R level located on the workpiece 
surface, tool tip placed .125", or 3 mm above the R level. 

 

 
 

Cycle Depth Value — Controls how the cycle depth values are interpreted. 

Options: 

Absolute — Absolute cycle depth value. 

Incremental — Incremental distance as described by the Cycle Incremental Depth 
Value below). 
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G Code Dependent — As described above, except depends on the active input 
dimension mode: absolute or incremental. 

Cycle Incremental Depth Value — When interpreting incremental cycle depth values, 
controls how incremental distances are interpreted. 

Options: 
Relative to Cycle Rapid Value — Incremental distance from R level. 

Relative to Cycle Initial Level — Incremental distance from initial level. 

Relative to Part Surface — Incremental distance from the part surface. 

Cycle Rapid Value — Controls how cycle rapid values are interpreted to determine the 
R level.  

Options: 
Absolute — Absolute R level position. 

Incremental — Incremental distance to the R level, as specified by the Cycle 
Incremental Rapid Value. 

G Code Dependent — As described above, except depends on the active input 
dimension mode: absolute or incremental. 

Cycle Incremental Rapid Value — When interpreting incremental cycle rapid values, 
controls how incremental distances are interpreted to determine the R level. 

Options: 
Relative to Cycle Initial Level — Incremental distance from the initial level. 

Relative to Part Surface — Incremental distance from the part surface. 

Cycle Causes Rapid Motion — When active, sets the rapid motion mode with a cancel 
cycle command (e.g. G80). 

Ignore Cycles during Rotary Motion — When active, ignores canned cycles during 
rotary motions. Clear this checkbox to allow cycles during rotary motions. The use of this 
modal becomes more important when the Output Intermediate Points control setting is 
in use. 

Cycle Execute — Controls when cycle motions are executed. 

Options: 
On Motion — Execute cycle on cycle block and each following motion until 
cancelled. (Default) 

As Commanded — Cycle definition block is for setup only; execute cycle when 
commanded by a specific word/address, such as G79 with some Phillips NC controls. 
Requires using the CyclesExecute macro in the NC control configuration for the 
codes that command cycles to be executed. 

 

To Control Settings window 



VERICUT HELP – Configuration menu 

 

Control Settings window, Tooling tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window enabling you to configure default tooling conditions, and define tool 
change activity. 

  

 
  

Initial Tool Component ID — Specifies the Tool Index Number of the tool component 
initially active for tool changes. 

Tool Number Method — Controls how to interpret tool number word/addresses (e.g. 
Tn).  

Options are: 
Select Only — Tool number only selects the tool. The tool is changed by a separate 
command, e.g. M6) 

Select & Change — Tool number selects and changes the tool. A separate tool 
change command is not used. 

Tool Change Retract Method — Method of retracting for a tool change. Methods which 
retract machine axes reference location values stored in a Tool Change Location table.  
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Options are: 
No Retract — Change the tool at its current location. 

Retract (Z-Axis only) — Retract the tool only along the Z-axis. 

Retract All Axes — Retract all machine motion axes to their respective tool change 
locations. 

Retract Tool Side Axes — Similar to Retract All Axes, except applies only to 
motion axes connected between the machine Base and Tool components. 

Use Retraction Table — Refer to the Tool Change Retraction table to determine 
which machine axes to retract. 

Tool Change Cancels Cycles — When active, cancels canned cycles with a tool change. 

Tool Change Causes Rapid Motion — When active, sets the rapid motion mode with a 
tool change. 

 
 
To Control Settings window
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Control Settings window, Rotary tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure how rotary motion commands are interpreted, e.g. A, B, C. 
A "moving tool philosophy" is assumed when describing rotations. 

  

 
  

Output Intermediate Points — When active, generates intermediate tool positions 
during rotary motions. If turned off, only the final tool position of a rotary motion is 
shown. Rotary intermediate points help you see the tool-to-workpiece relationship during 
rotary motions, however, the simulation will be slower. The Interpolation Tolerance 
determines the quantity of machine positions which simulate rotary motions. (Ref. File 
menu > Properties: Tolerance tab) 
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OPTIPATH NOTE:  Multi-axis motions are not optimized when Output Intermediate 
Points is active. 

A-axis Rotary Type, B-axis Rotary Type, C-axis Rotary Type — The settings control 
how rotary commands are interpreted (e.g. ABC). Each axis is individually controlled. 
Options: 

EIA (360 Absolute) — Refers to absolute angle positions. Absolute Rotary 
Direction controls how rotation values determine the direction of rotation. 

 

 
 

Linear — Refers to angles on a linear axis "wrapped" around the rotary component. 
In absolute input dimension mode (e.g. G90), rotary values specify absolute locations 
along the linear-rotary axis, while the sign (+ / -) controls which end of the linear axis 
is used. In incremental input dimension mode (e.g. G91), rotary values specify 
degrees to rotate from the current position, and the sign controls the direction of 
rotation: plus = CCW, minus = CW. 
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Example rotations of a B-axis linear-rotary component: 

Current axis 
position 

Command Rotary motion 

(moving tool 
philosophy) 

Rotary destination

B0 G90B75 75 deg CCW B75 

B0 G90B-75 75 deg CW B285 (B-75) 

B35 G90B75 40 deg CCW B75 

B35 G90B-75 110 deg CW B285 (B-75) 

B150 G90B120 30 deg CW B120 

B150 G90B-120 270 deg CW B240 (B-120) 

N/A  G91B75 75 deg CCW Current +75 

N/A G91B-75 75 deg CW Current -75 

 
A2-axis Rotary Type, B2-axis Rotary Type, C2-axis Rotary Type — The settings 
control how rotary commands for secondary rotary axes are interpreted (e.g. A2, B2, C2). 
Each axis is individually controlled. Options are same as described above for ABC rotary 
types. 

Absolute Rotary Direction — Controls how rotation values determine the direction of 
rotation for EIA (360 Absolute) rotary type components. Options and examples follow. 

Positive -> CCW — Sign controls the direction of rotation: plus = CCW, minus = 
CW, and absolute value of the rotation value specifies the rotary destination.  

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirPosCCW macro. 
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Examples of rotary behavior with Absolute Rotary Direction=Positive -> CCW: 

Current axis 
position 

Command Rotary motion 

(moving tool 
philosophy) 

Rotary destination 

NA G90B0 NA B0 

B0 G90B380 20 deg CCW B20 

B20 G90B-90 290 deg CW B90 

B90 G90B60 330 deg CCW B60 

 
Positive -> CW — Similar to Positive -> CCW, except the rotation directions are 
reversed.  

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirPosCW macro. 

  

Examples of rotary behavior with Absolute Rotary Direction=Positive -> CW: 

Current 
axis 

position 

Command Rotary motion

(moving tool 
philosophy) 

Rotary 
destination 

NA G90B0 NA B0 

B0 G90B380 340 deg CW B20 

B20 G90B-90 70 deg CCW B90 

B90 G90B60 30 deg CW B60 

 
Always CCW — Rounds the rotation value to increments of 360, then subtracts 360 
until the subtracted value is between 0-360. The rounded value specifies the rotary 
destination. The tool always rotates in a CCW direction about the rotary center point. 

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirCCW macro. 
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Examples of rotary behavior with Absolute Rotary Direction=Always CCW: 

Current 
axis 

position 

Command Rotary motion

(moving tool 
philosophy) 

Rotary 
destination 

NA G90B0 NA B0 

B0 G90B380 20 deg CCW B20 

B20 G90B-90 250 deg CCW B270 

B270 G90B60 150 deg CCW B60 

 
Always CW — Similar to Always CCW, except the rotation directions are reversed. 

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirCW macro. 

  

Examples of rotary behavior with Absolute Rotary Direction=Always CW: 

Current 
axis 

position 

Command Rotary 
motion 

(moving tool 
philosophy) 

Rotary 
destination 

NA G90B0 NA B0 

B0 G90B380 340 deg CW B20 

B20 G90B-90 110 deg CW B270 

B270 G90B60 210 deg CW B60 

 

Shortest Distance — Uses the rotation value and its sign to specify the absolute 
rotary position. For each rotary motion, the tool rotates the shortest distance about the 
rotary center point to the rotary destination. 
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NOTE:   You can configure the same behavior using Configuration menu  > 
Word/Address and associating the RotaryDirShortestDist macro. 

  

Examples of rotary behavior with Absolute Rotary Direction=Shortest Distance: 

Current 
axis 

position 

Command Rotary motion

(moving tool 
philosophy) 

Rotary 
destination 

NA G90B0 NA B0 

B0 G90B380 20 deg CCW B20 

B20 G90B-90 110 deg CW B270 

B270 G90B60 150 deg CCW B60 

 
Linear — Rounds the rotation value to increments of 360, then subtracts 360 until 
the subtracted value is between 0-360. The difference between the rounded value and 
the current position is the rotary destination while the sign of the difference specifies 
the rotation direction. A positive difference value rotates the tool in a CCW direction 
about the rotary center point, a negative value rotates the tool in a CW direction.  

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirLinear macro. 

  

Examples of rotary behavior with Absolute Rotary Direction=Linear: 

Current 
axis 

position 

Command Rotary motion

(moving tool 
philosophy) 

Rotary 
destination 

NA G90B0 NA B0 

B0 G90B380 20 deg CCW B20 

B20 G90B-90 250 deg CCW B270 

B270 G90B60 210 deg CW B60 
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Shortest Distance – 180 CCW — Uses the rotation value and its sign to specify the 
absolute rotary position. For each rotary motion, the tool rotates the shortest distance 
about the rotary center point to the rotary destination, except when the angle is 
exactly 180 degrees. When the angle is exactly 180 degrees, the direction will always 
be set to counterclockwise. 

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirShortestDist180CCW macro. 

Shortest Distance – 180 CW — Uses the rotation value and its sign to specify the 
absolute rotary position. For each rotary motion, the tool rotates the shortest distance 
about the rotary center point to the rotary destination, except when the angle is 
exactly 180 degrees. When the angle is exactly 180 degrees, the direction will always 
be set to clockwise. 

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirShortestDist180CW macro. 

Positive -> CCW ABSOLUTE — Sets the direction for an EIA (360 Absolute) 
rotary table to be counterclockwise when the angle is positive and clockwise when 
the angle is negative. 

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirPosCCWAbsolute macro. 

Positive -> CW ABSOLUTE — Similar to Positive -> CCW ABSOLUTE, but 
rotary directions are reversed. Sets the direction for an EIA (360 Absolute) rotary 
table to be clockwise when the angle is positive and counterclockwise when the angle 
is negative. 

NOTE:  You can configure the same behavior using Configuration menu > 
Word/Address and associating the RotaryDirPosCWAbsolute macro. 

 
Rotary Tool Control Point — When active, with default settings, Rotary Tool Control 
Point, or "RTCP" causes rotary motion about a specific control point-typically the tool 
tip. When RTCP is not active, rotation occurs about the rotary component origins. This 
feature is intended for use only with tilting head machines. 

RTCP compensates for the gage offset (XYZ distance from tool tip to Tool component) 
and pivot offset (XYZ distance from spindle face/centerline to tool side rotary 
components rotation/pivot point) as tool side rotary components rotate.  
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Affect of using RTCP with an A-axis rotary component: 

 
 

RTCP only applies to rotary components between a Tool component and the Base 
component (tool side). Rotary components between a Stock component and the Base 
component (part side) do not effect the orientation of the tool, and therefore do not affect 
the tool side offsets. 

RPCP, or Rotary Part Control Point, is used with part side rotary components, where the 
part is moved relative to the tool tip. RPCP actually rotates the workpiece coordinate 
system as the part side rotary components rotate.  RPCP should only be used when 
programming in the part coordinate system. See reference information on the "RpcpOn, 
RpcpOff" macros, or the "RPCP Pivot Offset table" in the Tables for Processing G-
Codes section for more information. 

NOTES:    
1. The default state for RTCP is set on the Rotary Settings panel. The RTCP state 

can be modified via the RotaryControlPointOnOff or RtcpOn, RtcpOff 
macros. 

2. See also: "RTCP Pivot Offset table" or "RPCP Pivot Offset table" for possible 
additional configuration for correct RTCP simulation. 

  

RTCP Contour — Use this feature to set the mode for RTCP contouring. "Yes" puts 
RTCP in contouring mode (XYZ offsets are updated and applied continuously during 
rotary motion). "No" puts RTCP in non-contouring mode (XYZ offsets are not updated 
and applied during rotary motion). Use the RtcpContour macro to over-ride this setting. 
RTCP must be active for this setting to have an effect. 

RTCP With Motion — Use this feature to set the mode for RTCP with motion. "Yes" 
causes the RTCP updated XYZ offsets to only take effect when the corresponding X, Y, 
or Z axes are programmed in a rotary motion block. "No" causes the XYZ offsets to take 
effect immediately, meaning X, Y, or Z axes do not have to be programmed in a rotary 
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motion block. Typically, this feature is only applicable when in non-contouring mode 
(RTCP Contour = "No"). Use the RtcpWith Motion macro to over-ride this setting. 
RTCP must be active for this setting to have an effect. 

RTCP Uses — Use this feature to specify which type of pivot offset compensation to 
use. There are two Pivot Offset compensation types: RTCP and Gage. 

RTCP specifies the programmed/driven point is assumed to be the spindle 
face/centerline with no tool loaded. The RTCP Pivot Offset table can be used with 
this type to override the automatic calculation. The centerline of rotation for multiple 
tool side rotary components must intersect. 

Gage specifies the programmed/driven point is assumed to be the rotation/pivot point 
of the tool side rotary component, closest to the Base component. The 
PivotOffsetCompName macro can be used with this type to override where the XYZ 
pivot offset distance will be measured to. The centerline of rotation, for multiple tool 
side rotary components, does not have to intersect. The macros 
TurnOnOffGageOffset and TurnOnOffGagePivotOffset can be used to turn on 
and off the gage offset and the pivot offset, thereby driving either the spindle face or 
the tool tip. If Programming Method is set to Tool Tip, the gage offset is always 
active. RTCP must be active for this setting to have an affect. 

Choose one of the following: 

Default Pivot Offset — Use the RTCP Pivot Offset compensation type. The 
ApplyGagePivotOffset macro can be used to switch to the Gage Pivot Offset 
compensation type. 

Gage Pivot Offset — Use the Gage Pivot Offset compensation type. This option 
should be used for all new jobs. 

NOTE:   The Gage Pivot Offset might currently be turned off, or may be set to 
(0,0,0). 

RTCP Pivot Offset — Use the RTCP Pivot Offset compensation type. 

NOTE:  The RTCP Pivot Offset might currently be turned off, or may be set to 
(0,0,0). 

Only Gage Offset — Do not compensate for XYZ pivot offset. Compensate only for 
the XYZ gage offset. 

 

TECH NOTES:  
Traditionally, Rotary Tool Control Point (RTCP) referred to a state in which the tool 
would rotate about the tool tip when a tool-side rotary was rotated. 

Today this feature has a more generic definition. Rotary Tool Control Point refers to a 
state in which the tool side offsets are automatically updated when a tool-side rotary is 
rotated. This means that even though Rotary Tool Control Point is active, the results 
might not be as described above for the following reasons: 
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1. The traditional definition assumed that the offsets are adjusted continually as the 
rotary axis is rotated. This is not always the case. In the above diagram, an "A90" 
command is being executed. If the offsets are not updated continuously, the tool 
tip position will not stay fixed, but will "wander", and then end up in its original 
position. The RTCP Contour flag allows for configuration of either type. 

2. The traditional definition assumed that the offsets would be applied immediately 
to all axes even though the corresponding linear axes were not specified on the 
block. This is not always the case. If the offsets are only applied when the 
corresponding linear axes are specified, then in the above case (A90), even though 
RTCP was active, the machine would behave as illustrated on the left. Then when 
XYZ is specified (with the original coordinates), then the updated offsets would 
be applied, and the tool tip would return to its original position. The RTCP With 
Motion flag allows for configuration of either type. 

Some controls only adjust some of the 4 tool side offsets. If this is true, then the tool tip 
will not return to the original position. 

 
 
To Control Settings window
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Control Settings window, Wire EDM tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

Opens a window to configure wire EDM machining settings. 
  

 
  
Maximum Wire Angle — Maximum angle the wire can tilt in any direction from 
vertical alignment. If the wire is tilted beyond this angle, an error message is issued. 

Initial Voltage — When active, indicates voltage to the wire is on at the start of tool path 
processing. 

UV Relative to XY — When active, U and V tool path values are relative to the current 
X and Y axis positions. 

XY Also Moves UV — When active, X and Y tool path values also cause the 
corresponding U and V axis to move. In typical wire EDM machine construction, the U 
and V axes are connected such that they are slaved off the X and Y axes. In other words, 
when the X and Y axes move, the corresponding U and V axes also move by default. The 
XY Also Moves UV setting is intended to work with machines built such that the U and 
V axes are separate from the X and Y axes. 

Work Table to XY Output Plane — Distance from the top of the work table (machine 
Z zero) to the XY output plane (output Z values). The XY output plane is the Z-axis level 
at which X and Y values are assumed to be driven. This value is measured along the 
machine Z-axis, and is usually zero. 

 

To Control Settings window
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Control Settings window, Cutter Compensation tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure how the programmed tool path is compensated when cutter 
diameter compensation, or "CDC" is used, e.g. G41-42. Enter CDC offset values into a 
Cutter Compensation table. To apply CDC offsets to the programmed tool path, ensure 
Process Cutter Comp. is active. 

  

 
  

CDC ON/OFF Method — Controls how the offset condition is established when CDC is 
turned on, and how the offset is cancelled when CDC is turned off. Options are: 

Ramp ON/OFF — Establish the offset condition with a "ramp-on" motion after CDC is 
turned on. When CDC is turned off, the offset is cancelled with a "ramp-off" motion on 
the next tool move. 

Immediate — Immediately establishes the offset condition when CDC is turned on, and 
assumes the offset has been established by a prior data block (e.g. G43-44 as interpreted 
by the Phillips CNC controls). When CDC is turned off, the offset is cancelled without a 
tool move. 

CDC Ramp ON/OFF with — Specifies the motion types which establish/cancel the 
CDC offset. Options:  

Active Plane Motion — Turn CDC on with a motion in the active cutting plane. 
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Any Motion — Turn CDC on with any motion, including motion along the tool axis. 

 
 
To Control Settings window



VERICUT HELP – Configuration menu 

 

Control Settings window, Offsets tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure an initial work offset, or "fixture offset", to be in effect at 
the start of tool path processing. 

  

 
  

Initial Work Offset — When active, sets the initial work offset specified by the Initial 
Work Index (see below). 

Initial Work Index — Index, or offset register value, containing the initial work offset. 
The offset remains effective until a different work offset (e.g. G54-59) is processed, or 
until cancelled. Enter the corresponding offset values into a Work Offsets table. 

 
 
To Control Settings window
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Control Settings window, Subroutines tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure how subroutine names are referenced by the NC control. 

  

 
  

Type of Subroutine Names — Controls how names of subroutines are referenced. 
Options are: 

Numeric — Use the numeric value; leading zeros are ignored. For example, "O0010" 
is interpreted the same as "O10". 

Text — Use the text string value. For example, "O0010" is not interpreted the same 
as the name "O10". 

 
 
To Control Settings window
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Control Settings window, OptiPath & Curve Fit tab 
Location:  Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure settings referenced when G-Code tool path files are 
optimized by OptiPath.  

The settings are used to control block sequencing and word/value spacing in the 
optimized output tool path file. Note that by default, optimized blocks receive the same 
sequence number, if any, that appears on the original block processed. This typically 
results in multiple blocks having the same sequence number. 

  

 
  

Auto Sequence Numbering — When active, re-sequences optimized tool path records in 
ascending order. The Sequence Increment Value (see below) is used for the beginning 
sequence number, and as the increment value for subsequent sequence numbers. Both 
optimized and non-optimized blocks with sequence numbers are re-sequenced. Sequence 
numbers are not added to un-optimized blocks without a sequence number. 

NOTE:  If the general control setting Default Word="N", then "N" does not appear in 
the sequence number. The result is a sequence number without a word, for example: 
"50G01X5", such as required by Heidenhain controls. 

Add Sequence Number to Added Blocks — When active, adds sequence numbers to 
blocks added during optimization via the Add More Cuts OptiPath setting. 
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Sequence Increment Value — Initial value and increment value for re-sequencing 
optimized G-Code tool path records. 

 
 

Word Value Spacing — When active, includes a space between word/value pairs in the 
optimized tool path file. Un-optimized records do not receive spacing. When this feature 
is not used, optimized tool path records are not spaced. 

 

 
 
 
To Control Settings window
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Control Settings window, User Defined tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Opens a window to configure user defined control settings supplied via a custom CME 
file. This window will appear differently, depending on the CME file in use. CME files 
are created using the C Macro Extension – Application Programming Interface, or 
CME–API (ref. CME-API in the VERICUT Development Tools section, in the CGTech 
Help Library), and specified for use in VERICUT via Dev Kit CME tab of the 
Advanced Control Options window (ref. Advanced Control Option window: Dev Kit 
CME tab, in the Configuration Menu section of VERICUT Help). 

  

 
  

NOTE:  CME-API defined settings can also appear under Project menu > Processing 
Options > G-Code > Process Options: User Defined tab, as determined by the 
developer. 

 
 
To Control Settings window
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Control Settings window, Sync tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Features on this tab are used to set up VERICUT for simulating machining with 
synchronized subsystems.  

  

 
  

The term "sync" refers to the idea of synchronizing multiple programs (or channels) at 
once. A program could be defined by a separate input file, or by sections of a single input 
file. Each of these programs drives a subsystem. The sync logic will obtain motions for 
all subsystems being synced, and then execute the motion. For example:  If the upper 
system has a motion that will take 3 seconds, and the lower subsystem has a motion that 
will take .5 seconds. The lower subsystem motion and 1/6th of the upper subsystem 
motion will be executed. Then, the next motion will then be retrieved for the lower 
subsystem, and the process continues. The Info menu > NC Program window shows 
which blocks are being processed by the programs. 

 NOTE:  The actual synchronization of the programs based on WAIT or SYNC codes 
are controlled by the Word/Address table. 
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Sync Method — The Sync Method turns on/off the Sync logic, and specifies the method 
that will be used to determine which data applies to which subsystem. 

Options include: 
None — (Default) Turns off Sync logic.  Normal processing occurs. 

G&L - N/O Block — An "N" sequence numbers mark commands for the first 
subsystem, "O" sequence numbers marks commands for the second subsystem,  and 
"B" sequence numbers marks commands for both subsystems.   

Okuma - G13/G14 — The input program is divided into sections. Each section 
begins with either a G13 or a G14. The G13 sections will drive the first subsystem, 
and the G14 sections will drive the second subsystem. 

Fanuc - Multiple NC Programs — Independent tool path files are specified for each 
synced subsystem. The order of the subsystems specified must match the order of the 
NC program files in the NC Program list. 

INDEX - Channel 1/Channel 2 — A single NC program file contains two 
subroutines, one for each head. A word/value, for example "M30", toggles between 
"channels" that control each head. These channels will then drive the corresponding 
subsystems. See the IndexCallMainSub macro in the "Macros - listed 
alphabetically" section for more information. 

Gildemeister - $1/$2 — Blocks starting with $1 will be processed by the first 
subsystem, and blocks starting with $2 will be processed by the second subsystem. 
Blocks not beginning with either a $1 or a $2 will be processed by both subsystems. 

Mazak - G109L1/G109L2 — The input program is divided into sections. Each 
section begins with either a G109L1 or a G109L2. The G109L1 sections will drive 
the first subsystem, and the G109L2 sections will drive the second subsystem. 

Allen-Bradley - Primary/Secondary — This sync type has the following attributes:  

1. A block can contain commands for both subsystems (controls). 

2. Each control is processed independently. 

3. The next block is not processed until both controls are done with the previous 
block. 

4. Although the split up of the Info Toolpath is not necessary (or possibly 
desirable) for this sync type, it is still done for consistency with the way we 
handle sync motion. 

5. When "stepping", both the upper and lower Toolpath windows (controls) will 
process 1 block. 

6. The MDI window will ignore the subsystem specified, and will process the 
line as stated by sending it to both controls. 
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Citizen - $1/$2/$3 — The input program is divided into sections. Each section begins 
with a $1, a $2, or a $3. The $1 sections will drive the first subsystem, the $2 sections 
will drive the second subsystem, and the $3 sections will drive the third subsystem. 

 

Sync Table 
Each record in the Sync Table represent the information related to a particular "sync'd" 
subsystem. 

Input Channel — This field defines what is driving each channel. The information 
displayed here will be different depending on the Sync Method being used. 

Sync SubSystem IDs — This field defines the SubSystem that will be driven by the 
specified Input Channel. Select the subsystem ID from the pull-down list. 

The number of records in the Sync Table must match the Sync Method defined above. 
For example the Citizen must have 3 Sync records, and the Okuma must have 2. The 
Fanuc style could have any number of Sync records. 

NOTE:  A machine might define a separate subsystem for a head changer, a pallet 
changer, …  These are not Sync SubSystems. The Sync SubSystems corresponds to 
the primary SubSystem this is being driven by each of the Sync'd channels. 

 

Add — Use to add a record to the Sync Table after the highlighted SubSystem ID. 

Delete — Use to delete the highlighted record from the Sync Table. 

 

Shortcut:  You can right-click in the Sync Subsystems IDs Table to display a menu 
containing Add and Delete. These provide the same functionality described above. 

 

Tip:  Once you have set up the sync environment using the features in this tab, you can 
use the features on the G-Code Settings window: Sync tab (Project menu > Processing 
Options > G-Code > Settings) to turn off one or more subsystems to assist in debugging 
Sync related problems. 

 
 
To Control Settings window
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Control Settings window, Control Notes tab 
Location: Configuration menu > Control Settings 

Toolbar short cut for Control Settings window:    

 
Features on this tab enable you to add Message Notes and Comment Notes to the 
control file. 
 
 

 
 
 

Message Notes are saved in the header of the control file and are displayed in the 
VERICUT message area (Logger) when the control file is loaded. Comment Notes are 
saved in the header of the control file but do not display in the VERICUT Logger. 

There is a limit of 255 characters per line, but there is no limit to the number of lines that 
can be added. 

Any Message/Comment Notes that currently exist in the control file are displayed in the 
appropriate text field as shown below. Any note can be edited and re-saved in the control 
file. 
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Existing Message/Comment Notes in the control file: 
 

 
 
In the control file, each line of note is added to the header in quotes, and is preceded by 
either the keyword MESSAGE (for message notes), or COMMENT (for comment notes) 
as shown below. 
 
How the above messages look in the control file: 
 
CGTech Control 
Version-6.2 
MESSAGE "This is the 1st message note added to the control file and 
should appear in the logger." 
MESSAGE "This is the 2nd message note added to the control file and 
should appear in the logger." 
COMMENT "This is the 1st comment note added to the control file and 
should not appear in the logger." 
 
UNITS INCH 
 
CSS_MAX_RPM 1000 
 
SYNC_METHOD G13G14 
 
Adding /editing notes: 
Add a note by typing the desired text, or edit the text of existing notes in the appropriate 
text field. When finished, press OK, or Apply, depending on whether or not you want to 
leave the Control Settings window open. Then save the control file using the 
Configuration menu > Control > Save (or Save As) feature in the menu bar, or use 

 (Save Control) in the tool bar. 
 
NOTE:  Control files containing notes can not be used in pre-V6.2 versions of 
VERICUT. 
 
 
To Control Settings window
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Control Settings window, Turning tab 
Location: Configuration menu > Control Settings 

VERICUT toolbar short cut:   

  

Features on this tab configure VERICUT for lathe turning simulations. 

  

 
  

CSS Maximum RPM — When constant surface speed, or "CSS" is controlling spindle 
speed, this value specifies the fastest RPM to turn the workpiece. 

RPM Changes with RAPID and CSS — When selected and CSS is controlling spindle 
speed, rapid motions (e.g. G0) can affect spindle speed, as well as linear and circular 
motions (e.g. G1-3). Clear this checkbox to have only linear and circular motions affect 
RPM. 

 
 
To Control Settings window
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Adv. Options (Advanced Control Options window) 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   

 

Opens a window to configure advanced NC control options, such as: specify subroutines 
available in the NC control, perform actions at key processing events (e.g. start of tool 
path processing, start processing a block, etc.), substitute text strings, and more. 

 

 
 

Subroutines tab — The features on this tab specify names of external files containing 
subroutines accessible by the NC control. 

Events tab — The features on this tab maintain macros called and variables set based on 
key events that occur during tool path file processing. 

Substitute tab — The features on this tab maintain text strings that are substituted when 
specific text in the tool path file is encountered. 

OptiPath Substitute tab — The features on this tab maintain text strings that are 
substituted when tool path files are optimized by OptiPath and written to the Optimized 
file. 

CME/API tab — Features on this tab enable you to specify a custom CME file containing 
custom macros that assist the NC control with processing machine code data. 
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OK — Saves additions/modifications and dismisses the Advanced Control Options 
window. 

Apply — Saves additions/modifications and leaves the Advanced Control Options 
window open. 

Cancel — Closes the Advanced Control Options window without saving any 
additions/modifications. 
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Advanced Control Options, Subroutines tab 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   

 

The features on this tab specify names of external files containing subroutines accessible 
by the NC control. 

 

 
 

File Names list — List of external files containing subs accessible to VERICUT. 

Shortcut:  Right-click in the File Names list area to display a pop-up window with the 
following features: 

 
Add — Opens the Job Subroutine Files selection box enabling you to add external 
subroutine files to the File Names list. 

Replace — Opens the Job Subroutine Files selection box enabling you to replace the 
highlighted subroutine file in the File Names list with another. 

Delete — Deletes the highlighted subroutine file from the File Names list. 

Edit — Displays the of the highlighted subroutine file in a text editing window. 
Standard text editing features are provided, such as: copy/cut, paste, search, etc. For 
more information on using the editing features see Edit menu > Text File. 
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Add — Opens the Job Subroutine Files selection box enabling you to add external 
subroutine files to the File Names list. (Same as Add in the pop-up window described 
above) 

Replace — Opens the Job Subroutine Files selection box enabling you to replace the 
highlighted subroutine file in the File Names list with another. (Same as Replace in the 
pop-up window described above) 

Delete — Deletes the highlighted subroutine file from the File Names list. (same as 
Delete in the pop-up window described above) 

Delete All — Deletes all subroutines files from the File Names list. 

 
 
To Advanced Control Options window
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Advanced Control Options, Events tab 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   

 

The features on this tab enable you to specify the macros called and/or variables set based 
on key events that occur during tool path file processing. The Events tab displays the 
event configurations of a particular NC control as a "tree" structure. When you expand an 
"event" object, the macro calls/variable settings associated with that particular event are 
displayed.  

 

 
 

The following Events are available: 

Reset — Event occurs before the tool path file is scanned. 

Start of Processing — Event occurs after the tool path file has been scanned, but before 
the tool path file is processed.  

NOTE:  The ConversionInit macro must always be the first macro listed for this 
event. 

End of Processing — Event occurs after the tool path file has been processed. 

NOTE:  The ConversionFinish macro must always be the last macro listed for this 
event. 

Start of Block Processing — Event occurs at the start of processing each G-Code data 
block. 

NOTE:  The BlockInit macro must always be the first macro listed for this event. 
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End of Block Processing — Event occurs at the end of processing each G-Code data 
block. 

NOTE:  The BlockFinish macro must always be the last macro listed for this event. 

Start of Type II Command / End of Type II Command — Event occurs at the start (or 
end) of processing a Type II data command. 

 

Add / Modify — Opens the EventsAddMod window enabling you to add (or modify) 
event-based macro calls/variable assignments. 

Delete — Deletes the selected event-based macro call/variable assignment. 

 
 
To Advanced Control Options window
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EventsAddMod window 
Location: Configuration menu > Adv. Options: Events tab 

VERICUT toolbar short cut:   

  

Opened by pressing Add/Modify on the Advanced Control Options window, Events 
tab. The features on this window enable you to add (or modify) event-based macro 
calls/variable assignments. Features in this window behave similar to those described for 
word/address groups on the Add/Modify Word/Address window. 

 

 
  

Event — Enables you to select the event that you want to add to or modify. Select from 
the pull-down list. 
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Macroname/Variable — Controls calls a macro, or sets a variable. Depending on the 
active choice, features are provided for specifying the macro called (select or type in 
field), or the Variable Name and Variable Description of the variable to be set (enter the 
variable value in the Override Value field). You can select macro names, or type them in. 
Text entered is not case sensitive. Use the automatic filtering capability to help you find 
macros. When you enter text characters in the Macroname field, the list of macros is 
automatically filtered to show only those that match the specified text. 

Override Value — This feature acts differently, depending on whether Macroname or 
Variable is selected: 

With Macroname selected — Specifies a value to pass to the specified macro. If 
blank, the address value accompanying the word is passed. 

With Variable selected — Specifies a value to assign to the specified Variable 
Number. Use the Variable Description field to describe what Variable Number 
represents. 

Math expressions and variables understood by the control are supported. Enter "$" to 
specify using the address value accompanying the word. Enter "#", followed 
immediately by the variable name/number, followed by a space, to specify a variable 
value. Multiple variables can be added, separated by a blank space. If the override 
expression does not contain either of these characters, it is evaluated immediately and 
only the value is retained. If the expression can not be evaluated immediately, the full 
expression is retained in the control configuration and evaluated separately for each 
block that activates the group. 

  

Examples of using Override Value: (given that the variable, #2 = 3) 

Text entered in 
Override Value 

field 

What is retained in 
control configuration

Sample G-
Code data 

block 

Resulting value when 
processed 

SIN(30) .5 X5 .5 (constant value- not 
affected by G-Code 
data) 

SIN(30) .5 X10 .5 (see note above) 

$*10 $*10 X5 50 

($+#2)*10 ($+#2)*10 X5 80 
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Also see "Using Equations/Expression in VERICUT" in the Using VERICUT 
section for more information. Using VERICUT can be found in the CGTech Help 
Library. 

  

Override Text — Similar to Override Value, except specifies text to pass to the macro. 
Only certain macros are designed to accept override text values. Consult the "Macros - 
listed alphabetically" section for more information. 

Expression(s) can be used in macro override text. If the override text contains the 
sequence "{expression}" the expression text inside the curly-braces is evaluated and 
replaced with the calculated value.   

For example, if the MessageMacro is used with the following override text: 

"The spindle speed is {#speed} rpm" 

The variable "#speed" is evaluated and if set to 500, the resulting message would be: 

"The spindle speed is 500 rpm" 

The syntax for the expression(s) is the same as defined for override values. 

 
Add — Select when adding a new macro or variable to the event. 

Modify — Select when modifying an existing macro or variable for the event. 

Close — Closes the EventsAddMod window. 
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Advanced Control Options, Substitute tab 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   
 
The features on this tab maintain text strings that are substituted when specific text in the 
tool path file is encountered. Using substitutions lets you to alter how VERICUT "sees" 
data in a block without editing the G-Code tool path file. Substitutions occur at the 
beginning of processing each G-Code data block, prior to parsing block words and values 
into "tokens". Substitutions in the list are applied in listed order.  

 
See "About building NC controls" in the Using VERICUT section for more information 
about how G-Code blocks are processed by VERICUT. Using VERICUT can be found in 
the CGTech Help Library. 

Substitution (Input/Output Text) list — Lists text string substitutions that will occur 
when specified input text is encountered.  

Shortcut:  You can right-click in the Substitution (Input/Output Text) list to display a 
menu containing Add and Delete. These provide the same functionality described below. 

Input Text / Output Text — Specifies an input text string to substitute, and the output 
text that VERICUT will use in its place.  

NOTE:  Substitution input/output text is case sensitive. 

 

Add — Adds a new substitution record, after the highlighted record, to the list. 

Delete — Deletes the selected substitution record from the list. 

 
To Advanced Control Options window
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Advanced Control Options, OptiPath Substitute tab 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   

 

The features on this tab maintain text strings that are substituted when tool path files are 
optimized by OptiPath and written to the Optimized file. Using substitutions lets you to 
alter what VERICUT writes to optimized G-Code tool path file(s). Substitutions occur at 
the end of processing each G-Code data block, prior to outputting to the optimized tool 
path file. 

 

 
 

OptiPath Substitution (Input/Output Text) list — Lists text string substitutions that 
will occur when specified input text is encountered.  

Shortcut:  You can right-click in the OptiPath Substitution (Input/Output Text) list to 
display a menu containing Add and Delete. These provide the same functionality 
described below. 

Input Text / Output Text — Specifies an input text string to substitute, and the output 
text that VERICUT will use in its place.  

NOTE:  Substitution input/output text is case sensitive. 

Add — Adds a new OptiPath substitution record, after the highlighted record, to the list. 

Delete — Deletes the selected OptiPath substitution record from the list. 

 
To Advanced Control Options window
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Advanced Control Options, CME/API tab 
Location: Configuration menu > Adv. Options 

VERICUT toolbar short cut:   

 

Features on this tab enable you to specify a custom CME file, or CGTech Macro 
Executable file containing custom macros that assist the NC control with processing 
machine code data. This file can also supply "control settings" that allow users to further 
customize how machine code data is interpreted, and provide access to custom data tables 
for storing job, tool, and machine related data. A custom CME file is typically created by 
CGTech or other services organization using the C Macro Extension – Application 
Programming Interface, or CME–API (ref. CME-API in the VERICUT Development 
Tools section, in the CGTech Help Library). In this manner, end users can customize 
VERICUT's ability to simulate machine code data according to site-specific needs. 

 

 
 

CME/API File — Opens a window to specify a custom CME file. Features on this 
window are standard file selection window features that enable you to navigate through 
directories, filter files, and type or select file names. 

 

To Advanced Control Options window 
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Analysis Menu 
 

X-Caliper (X-Caliper window) 
 
VERICUT Users: 
VERICUT Location: Analysis menu > X-Caliper 

VERICUT toolbar short cut:      

  

Mold and Die Users: 
Mold and Die Location:   Analyze, View Files, Print page > Measure 

Notebook Feature:    

  

Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print page > Measure 

Notebook Feature:   

  

Opens a window that displays measurements, historical, and mathematical information 
about the VERICUT model. The appearance of the window will vary depending on the 
X-Caliper option being used. X-Caliper shows what is being measured on the model area 
by highlighting the "measure from" point (+) and the "measure to" point (o). Results from 
X-Caliper operations are displayed in the X-Caliper window. Measurements are 
described relative to the active coordinate system. 

The X-Caliper window is also one of the dockable windows enabling you to dock it 
inside the VERICUT main window if you choose. See Dockable Windows in the Getting 
Started with VERICUT section of VERICUT Help for additional information. 

NOTE:  When the X-Caliper window is docked, make sure that you click in the 
window so that it becomes the "active" window before using F1 to get help specific to the 
window. Otherwise F1 will go to the CGTech Help Library. 
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NOTE:  Machined features can only be measured in a workpiece view. 

 

Toolbar — The features in the X-Caliper Toolbar are common to all options except as 
noted below. 

 Enable/Disable Mouse Picks — Toggles to enable/disable the ability pick 
features in a VERICUT workpiece view. Shown here in "enable" mode. 

 or  Set X-Caliper Units — Toggle the icon between inch, and metric, to 
specify the units that you want X-Caliper data displayed in. 

 Measure — Computes measurements based on the current X-Caliper 
window configuration. This feature is useful to have X-Caliper calculate 
measurements based on data keyed in, or edited data. This feature is only active 
for Distance/Angle, Stock Thickness, Air Distance and Closest Point options. 

 Display Tool/Stock Collisions — Use to specifically highlight collisions 
between the tool holder and the stock model in the graphics area. Use the 
Feature/History option to obtain information about the collision (NC Program file, 
Record number, Tool ID, etc.). This feature is only active when holder/stock 
collisions occurred while cutting the part.  
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Disable Holder/Stock Collisions 

toggled "Off" 

Disable Holder/Stock Collisions 

toggled "On" 

  

    

Notice that when toggled "Off", all collisions 
(holder/stock, cutter/fixture, etc.) are 
displayed.  

Notice that when toggled "On", only 
holder/stock collisions are displayed. 
Including the collision areas that were cut 
away by subsequent cuts. 

 

 Clear X-Caliper Report — Clears the results from the X-Caliper window. 

 Print — Displays a Page Setup window enabling you to format the page, 
specify the printer, and print. 

 Save X-Caliper Report — Saves the results from the X-Caliper window to 
a file. Use the file selection window that displays to specify the /path/filename for 
the file to be created. 

 Close Window — Closes the X-Caliper window. 

 

Options — Select the desired X-Caliper option from the pull-down list. The following 
options are available: 

Feature/History — When a cut on the model is selected, this option displays the 
geometric description of the cut feature, and corresponding tool path history. 

Distance Angle — Use to measure the distance and/or angle between any 
combination of two points, planes, conic axes, model or component origins, or 
edges formed by intersecting planes or cylinders. 



VERICUT HELP – Analysis menu 

Stock Thickness — Use to measure solid stock material. 

Air Distance — Use to measure the air gap between two solid surfaces. 

Closest Point — Use to measure the shortest distance from an XYZ point location 
to the closest point on the model surface. 

Scallop — Use to measure the height of a scallop formed by parallel intersecting 
cylinders, typically cut by cutter corner radius. 

Volume — Use to display the following volume values calculated for a selected 
stock workpiece: cut stock volume (cubic units), original stock model volume 
(cubic units), and volume of material removed from the original stock model. 

Stock/Design Distance — Use to measure the distance between the cut stock and 
design models. 

Highlight Same Planes — Use to display all "cut" features that lie in the same 
plane. 

Hole Depth — Use to measure the depth of a hole, or the depth of a chamfer. 

X-Caliper window — This is where the results from X-Caliper operations are displayed. 

Active Coordinate System — Displays the name of the active coordinate system. 

 
 
Also see "X-Caliper", in the Using VERICUT section, in the CGTech Help Library. 
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X-Caliper window, Feature/History 
Location: Analysis menu > X-Caliper: Feature/History option 

Toolbar shortcut:  

 

When a cut on the model is selected, the Feature/History option is used to display related 
cut feature (mathematical description) and tool path history. The historical data includes: 
NC program file name, record number, and tool path record text responsible for the cut.  
This function is useful to spot-check machined features, and determine the source of an 
error cut identified in red by VERICUT. 

 

Sample X-Caliper window, Feature/History option: 

 
 

Following are geometric features identified by VERICUT, listed alphabetically: 

Auto-diff model — (X, Y, Z value and surface normal) an uncut surface on a 
model displayed after an auto-difference Solid method comparison. 

Circle — (X, Y, Z center, axis vector and radius) a surface cut by a circular 
motion. 

Cone — (X, Y, Z center, axis vector and side angle) a hole bottom cut by an 
angle tip drill, corner cut by a tapered endmill, or chamfer cut by a turning 
operation. 
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Cylinder — (X, Y, Z center, axis vector and radius) an inside corner cut by 2 
linear motions having an interior angle less then 180 degree, fillet cut by a bull or 
ball endmill moving perpendicular to the tool axis, or diameter cut by a turning 
operation. 

Ellipse — (X, Y, Z center, axis vector, major and minor focal distances) a 
ramping or plunging surface cut by the bottom of an endmill with a flat, or 
partially flat bottom. 

Fixture model — (X, Y, Z value and surface normal) an uncut surface on a 
fixture model. 

Holder Collision Area — (X, Y, Z value and surface normal) a holder/stock 
collision area cut stock model. Data also includes NC program file, record number 
and tool ID. 

Plane — (X,Y,Z value and surface normal) a flat machined surface. Cylinders or 
circles cut using linear motions can also return this identity. 

Ruled surface — (X,Y,Z value and surface normal) a surface cut by a multi-axis 
motion. 

Sphere — (X, Y, Z center and radius) a surface cut by the end of a ball endmill. 

Stock model — (X, Y, Z value and surface normal) an uncut surface on a stock 
model. 

Torus — (X, Y, Z center, axis vector, major and minor radius) a fillet in a corner 
cut by a bull endmill, or fillet left on a diameter by a radiused cutter during a 
turning operation. 

Torus sweep — (X, Y, Z center, axis vector and major radius) This feature is 
typical of an angled (ramping or plunging) surface cut by a bull endmill. 

 
 
To X-Caliper window
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X-Caliper window, Distance/Angle 
Location: Analysis menu > X-Caliper: Distance/Angle option 

Toolbar shortcut:  

 

The Distance/Angle option is used to measure the distance and/or angle between any 
combination of two points, planes, conic axes, model or component origins, or edges 
formed by intersecting planes or cylinders. In general, select the "From" feature, then 
select the "To" feature. X-Caliper shows what is being measured on the model by 
highlighting the "measure from" point (+) and the "measure to" point (o) as well as a line 
representing the distance (or vectors representing the angle) between them. 

 

Sample X-Caliper window, Distance/Angle option: 

 
 

NOTE:  Machined features can only be measured in a workpiece view. 
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From / To groups — Each group includes the Feature, Location and Direction used to 

specify what to measure from and what to measure to. Use the From / To arrows , to 
control which fields are filled in by screen pick data. You can select features on the 
VERICUT model, or enter number values (separated by blank spaces) directly into the 
fields. After selecting the From feature, VERICUT automatically transfers control to the 
To group. After selecting the To feature the X-Caliper window displays the measurement 
data. 

Feature — Controls the types of features to measure between. Select the Feature 
type from the pull-down list.  

Feature descriptions: 

Point — The X, Y, Z of the pick point or entered point coordinates. 

Plane — A flat, unbounded surface. If a curved surface is selected, data retrieved 
represents a plane tangent to the selected model surface at the pick point. 

Axis — Centerline of a cylinder or conic. 

Edge — Edge formed by two intersecting planes or parallel cylinders. Special 
cases follow. 

Plane/Cylinder edge — Only a cylinder with an axis parallel to the plane can 
produce an edge. Tangent conditions produce 1 edge. Intersecting conditions 
produce 2 possible edges, thus the one closest to the cylinder pick-point is used. 

Cylinder/Cylinder edge — Only cylinders with parallel axes can produce an 
edge. Tangent conditions produce 1 edge. Intersecting conditions produce 2 
edges, thus the one closest to the last cylinder pick-point is used. 

 

 
 

Vertex — Enables you to easily select one of the six key points associated with 
the triangles representing the faces of a model. For each triangle, the points 
consist of the three vertices and the midpoint of each of the triangle's three sides. 
VERICUT selects the point closest to your mouse pick. If the mouse pick is over 
the cut stock, Vertex works in the same way as the Point feature described above. 
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Vertex is a useful tool for measuring the trace of tool/fixture collisions on uncut 
fixtures. 

Model Origin — Origin of a selected model. Use the View menu > View Axes 
function to see model origin axes. 

Component Origin — Origin of a selected component. Use the View menu > 
View Axes function to see component origin axes. 

CSYS Origin — Origin of the selected coordinate system axis. Use the View 
menu > View Axes function to display the coordinate systems that are available. 

CSYS Axis — The X, Y, or Z axis of the selected coordinate system. Use the 
View menu > View Axes function to display the coordinate systems that are 
available. 

Location — Represents the XYZ coordinates of the screen pick. 

Direction — Represents IJK of the normal vector at the location of the screen pick. 

Data from the screen pick fills the Location and Direction data fields in the active From 
or To group. If needed, you can edit data in these fields, and then press Measure to 
obtain a measurement 

Measurement results are displayed in the X-Caliper window. Data output includes the 
From / To values input and the measured distance and/or angle. 

 
 
To X-Caliper window
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X-Caliper window, Stock Thickness 
Location: Analysis menu > X-Caliper: Stock Thickness option 

 Toolbar shortcut:  

  

The Stock Thickness option is used to measure solid stock material. 

  

Sample X-Caliper window, Stock Thickness option: 

 
  

Location — Represents the XYZ coordinates of the point to measure from. 

Direction — Represents IJK of the measurement direction vector into material. 

Data from the screen pick fills the Location and Direction data fields. If needed, you can 
edit data in these fields, and then press Measure to obtain a measurement. 

Measurement results are displayed in the X-Caliper window. Data output includes the 
Location and Direction values input, the XYZ point where the direction vector exits the 
material and the  measured stock thickness between the Location and Exit points. 

 
 
To X-Caliper window
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X-Caliper window, Air Distance 
Location: Analysis menu > X-Caliper: Air Distance option 

 Toolbar shortcut:  

  

The Air Distance option is used to measure air gap between two solid surfaces. 

  

Sample X-Caliper window, Air Distance option: 

 
 Location — Represents the XYZ coordinates of the point to measure from. 

Direction — Represents IJK of the measurement direction vector away from solid 
material.  

Data from the screen pick fills the Location and Direction data fields. If needed, you can 
edit data in these fields, and then press Measure to obtain a measurement. 
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Measurement results are displayed in the X-Caliper window. Data output includes the 
Location and Direction vector values input, the XYZ point where the direction vector re-
enters solid material and the measured air distance between the Location and Entry 
points. 

 
 
To X-Caliper window
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X-Caliper window, Closest Point 
Location: Analysis menu > X-Caliper: Closest Point option 

 Toolbar shortcut:  

  

The Closest Point option is used to measure the shortest distance from an XYZ point 
location to the closest point on the model surface. 

  

Sample X-Caliper window, Closest Point option: 

 
  

Location — Represents the XYZ coordinates of the point to measure from. XYZ values 
must be manually entered. The Closest Point, "From" Location cannot be specified by 
selecting the location graphically. 

Measurement results are displayed in the X-Caliper window. Data output includes the 
From Location, the XYZ coordinates of the closest point on the model, and the 
measured distance between the "from" point and the "closest" point on the model. 

 
 
To X-Caliper window
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X-Caliper window, Scallop 
Location: Analysis menu > X-Caliper: Scallop option 

Toolbar shortcut:  

 

The Scallop option is used to measure the height of a scallop formed by two parallel 
intersecting cylinders. Select the two parallel and intersecting cylinders on the VERICUT 
model that form the scallop. X-Caliper identifies the cylinders being measured by 
displaying intersecting circles on the model. 

 

Sample X-Caliper window, Scallop option: 

 
 

NOTE:  Machined features can only be measured in a workpiece view. 
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Cylinder 1 / Cylinder 2 — Used to define the cylinders to measure from and to. Use the 

choice arrow  to control which cylinder is being picked. Select parallel cylinders on 
the VERICUT model. After selecting Cylinder 1, VERICUT displays a circle 
representing the cylinder in the graphics area and automatically transfers control to 
Cylinder 2. After selecting Cylinder 2, measurement results are displayed in the X-
Caliper window. 

 

 
 

Data output includes Center point, Axis vector and Radius values for each cylinder and 
the Scallop Height measurement. 

 
 
To X-Caliper window
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X-Caliper window, Volume 
Location: Analysis menu > X-Caliper: Volume option 

 Toolbar shortcut:  

  

The Volume option calculates and displays the following volume values for a selected 
stock workpiece: current cut stock volume, original stock model volume, and volume of 
material removed from the original stock model. All volumes are in cubic units. 

 In addition to the total volume of the selected model, if model consists of several disjoint 
pieces, the volume of a selected contiguous piece of material can also be analyzed. In this 
case, a bounding box is drawn around the selected piece to indicate what is being 
calculated. If the model is only one piece, no bounding box is drawn. 

  

Sample X-Caliper window, Volume option: 

 
  

Calculated volumes are displayed in the X-Caliper window. Data output includes the 
Current Stock Volume, Original Volume and Removed Volume. 

 
 
To X-Caliper window
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X-Caliper window, Stock/Design Distance 
Location: Analysis menu > X-Caliper: Stock/Design Distance option 

Toolbar shortcut:   

  

The Stock/Design Distance option enables you to measure the distance between the cut 
stock and the design models. 

  

Sample X-Caliper window, Stock/Design Distance option: 

 
  

Stock — Use to display the stock model in the workpiece view. Options are provided to 
display the models as Solid or Translucent, or turn the display Off. 

Design — Similar to Stock, above, except that it applies to design model(s). 

From Stock to Design / From Design to Stock — Use to specify the "From" and "To" 
components for the measurement.   
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Direction — Use to specify the I, J, and K components, separated by blank spaces, of a 
vector representing the direction of measurement from Location to the "To" component. 

Location — Represents the XYZ coordinates of the point to measure from on the 
"From" component. 

Direction — Represents IJK of the measurement direction vector toward the "To" 
component. 

 

Pick a location on the "From" component in the workpiece view. X-caliper then 
measures the distance, normal to the pick location, to the nearest point on the "To" 
component. You can also enter the X, Y, and Z components, separated by blank spaces, 
of the desired measurement point on the "From" component. 

Data from the screen pick fills the Location and Direction data fields. If needed, you can 
edit data in these fields, and then press Measure to obtain a measurement. 

Measurement results are displayed in the X-Caliper window. Data output includes the 
measurement method, Location and Direction values related to the "From" component, 
the XYZ point of contact on the "To" component, and the measured Distance between 
the Location and the point of contact on the "To" component. 

 
 
To X-Caliper window
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X-Caliper window, Highlight Same Plane 
Location: Analysis menu > X-Caliper: Highlight Same Plane option 

  

Toolbar shortcut:  

  

The Highlight Same Plane option enables you to see all "cut" features that lie in the same 
plane. 

  

Sample X-Caliper window, Highlight Same Plane option: 

 
  

Color — Use to select the color to highlight the planes. Select the desired color from the 
pull-down color list. 

Location — Represents the XYZ coordinates of the screen pick. 

Direction — Represents IJK of the plane's normal vector at the location of the screen 
pick. 

Data from the screen pick fills the Location and Direction data fields. 
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Z Tolerance — Use to specify a tolerance value for determining "same" planes. All 
planes, within +/- the tolerance value, along the normal vector will be highlighted using 
the specified color. 

  

Sample Graphics display after using the X-Caliper window, Highlight Same Plane 
option: 

 
 
 
 
To X-Caliper window
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X-Caliper window, Hole Depth 
Location: Analysis menu > X-Caliper: Hole Depth option 

  

Toolbar shortcut:  

  

The Hole Depth option enables you to measure the depth of a hole, or the depth of a 
chamfer. 

  
Sample X-Caliper window, Hole Depth option: 

 
  

Hole Top — This is the feature that defines the top of the hole (generally a plane).  

Location — Represents the XYZ coordinates of the screen pick. 

VERICUT uses data from the screen pick to fill in the "feature type" and the Location  
data field. 
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Hole Bottom — This is the feature that defines the bottom of the hole. 

Location — Represents the XYZ coordinates of the screen pick. 

VERICUT uses data from the screen pick to fill in the "feature type" and the Location  
data field. 

Feature — Use to specify the feature that you want to measure. 
 
 
Using Hole Depth 

 

 
 
Refer to the picture of the hole cross section above for the following example. 
 
To measure the depth of the hole: 

1. In the X-Caliper window, click on the  next to Hole Top, and then pick the 
feature representing the top of the hole. In this case it is a plane represented by 1 
in the picture. 

2. In the X-Caliper window, click on the  next to Hole Bottom, and then pick 
the feature representing the bottom of the hole. In this case it is a cone represented 
by 2 in the picture. 

3. In the X-Caliper window, click on the  next to Feature, and then pick the 
feature that you want to measure. In this case it is a cylinder represented by 3 in 
the picture. 
X-Caliper will return the information shown in the X-Caliper window shown 
above. X-Caliper will calculate the depth from the intersection of the plane and 
the cylinder to the intersection of the cone and the cylinder. 
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To measure the depth of the top chamfer: 

1. Pick the top plane for the Hole Top. 
2. Pick the cylinder for the Hole Bottom. 
3. Pick the cone representing the chamfer as the Feature. 

 
 
 
To X-Caliper window 
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AUTO-DIFF (AUTO-DIFF window) 
 
VERICUT Users: 
VERICUT Location: Analysis menu > AUTO-DIFF 

VERICUT toolbar short cut:   

 
Mold and Die Users: 
Mold and Die Location:   Analysis and Viewing page > Compare to the Design 

Notebook Feature:     

 

Opens a window that enables you to compare design model data against the VERICUT 
simulated cut model. Using AUTO-DIFF, a licensed option, clearly identifies 
discrepancies between the cut model the intended design model. Errors are identified 
before actual machine time is wasted machining an incorrect part. You can use AUTO-
DIFF interactively, in batch mode, or automatically via "VERICUT-COMMAND" 
records in the tool path file. After using AUTO-DIFF to identify gouges and excess 
material, use other VERICUT functions such as X-Caliper and Zoom (ref. View menu > 
Orient) to measure and help determine the source of the errors. 
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Settings tab — Features on this tab control the AUTO-DIFF comparison, and what you 
see as a result. 

Options tab — Features on this tab are used to set processing and reporting options. 

Compare By Region tab — Features on this tab enable you to select a region to perform 
AUTO-DIFF on. 

Constant Gouge/Excess Check tab — Features on this tab enable you to specify tolerance 
values for gouge and excess checking, and turn Constant Gouge Check On/Off. 

 

Compare Status Light — The compare status light enables you to determine at a glance 
the status of your AUTO-DIFF Compare. The color of the light, and label displayed, will 
change depending on the status as described below. 

   Result Indicator — displays when the AUTO-DIFF "compare" has not finished 
running, or that the "compare" has been "restored". 

  No Differences — displays when the AUTO-DIFF "compare" has finished 
running and no gouges/excesses were detected. 

  Error Detected, Check Report — displays when the AUTO-DIFF "compare" 
has finished running and gouges/excesses were detected. 

 
Apply — Applies the current AUTO-DIFF window settings. 

Compare — Compares the design model(s) specified by the AUTO-DIFF window 
settings. AUTO-DIFF automatically builds the report after the comparison has been done. 
If you are only interested in seeing the graphical results (no report), you can abort report 

building by pressing  (Stop) after you see the message "Creating AUTO-DIFF 
report". 

TIP:  If you are only interested in the graphical AUTO-DIFF results, toggle "on" the 
Disable Report feature, on the Options tab, to prevent AUTO-DIFF from automatically 
building the report.  

Restore — Restores the VERICUT model as it was before performing the AUTO-DIFF 
operation. 

Report — Opens the AUTO-DIFF Report window containing an AUTO-DIFF Report 
file that identifies information related to errors detected by AUTO-DIFF.  

Close — Closes the AUTO-DIFF window without applying window changes. 

 
Also see "Optimizing your NC Program", in the Using VERICUT section, in the 
CGTech Help Library. 
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AUTO-DIFF Report window 
 
Accessed by selecting Report in the AUTO-DIFF window, the AUTO-DIFF Report 
window provides information related to errors detected by AUTO-DIFF. 
 

 
 
 
File menu 
 
Save As —  

Text File — Save the AUTO-DIFF report as a text file. 
CSV File— Save the AUTO-DIFF report in CSV (Comma Separated Value) file 
format that can be opened as a spreadsheet. When saving the report in CSV format, 
only the lower "table" portion of the report is saved. The  information in the top of the 
AUTO-DIFF Report window is not saved. 

 
Print — Opens a window enabling you so print the AUTO-DIFF report. 
Exit —  Closes the AUTO-DIFF report window. 
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 Each record in the AUTO-DIFF Report table provides the following information: 

• The record number in the NC program listing responsible for the error 
• The amount of  the deviation from the design model. 
• The ID of the tool being used at the time of the error. 
• The name if the NC program being used. 
• The NC record that was being processed at the time the error occurred.  

Selecting an error record in the table highlights the location of the error on the model 
displayed in the VERICUT graphics area. Select any column heading in the table to sort 
the report by the entries in that column. 

 
 

To AUTO-DIFF window
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AUTO-DIFF window, Settings tab 
Location: Analysis menu > AUTO-DIFF 

VERICUT toolbar short cut:   

 

Features on this tab control the AUTO-DIFF comparison, and what you see as a result. 
You can compare four types of design data with AUTO-DIFF: solid models, surface data, 
inspection points and profiles. The Comparison Method controls which type of design 
data is compared, while Comparison Type determines the error condition checked for. 
Comparison Tolerance features set the inspection tolerances and the display colors used 
for identified gouge/excess errors. The appearance of the Comparison Tolerance portion 
of the Settings tab will vary depending on the Comparison Method Setting. 

 

 
 

Stock Component — When multiple Stock components are defined, this option controls 
which one is used in the comparison. The Design component used in the comparison is 
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that which is connected to, or connected to the same component as the chosen Stock 
component. 

Stock Display — When selected, displays the stock model in the AUTO-DIFF view. 
Options are provided to display these models as Solid, Translucent, or Lines. The 
available options will vary depending on the Comparison Method that is selected. 

Design Display — Similar to Stock Display above, except applies to design model(s). 

Comparison Method — Controls the method of comparing design model data against 
the VERICUT model. The comparison method also re-configures the Settings tab to 
reflect the tolerances and other data required to compare the data as requested. All 
methods generate an AUTO-DIFF model that can be analyzed or saved as an In Process 
file. Regardless of the method chosen, the design model must first be loaded prior to 
comparison (ref. Modeling window: Model tab). Design models can be loaded at any 
time.  

Options: 
Solid — Compare a solid design model by subtracting solid models from each 
other. Solid models must be "watertight"-in other words, completely enclosed 
surfaces. 

You can check solid design model integrity by loading it as a stock model, then 
select Analysis menu > X-Caliper window: Volume tab to analyze the volume 
of the stock model. After checking the volume, the following problems indicate 
the design model needs repair, or is suitable only for the Surface comparison 
method: 

• small holes or gaps appear in the model 
• model falls apart-is partially displayed 
• model disappears completely 

 

AUTO-DIFF "Solid" method example 
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Surface — Compare a surface, set of surfaces, or skin of a solid design model or 
VERICUT Solid by overlaying the surface on the cut model. VERICUT only 
compares where the design surface and cut model overlap. Surface comparison 
provides multiple colors and tolerances that produce a "rainbow" affect to show 
the extent of errors. 

NOTE:  VERICUT Solids can only be used for Standard (not FastMill) cutting 
mode. 

 

AUTO-DIFF "Surface" method example 

 
 

Point — Compare a set of design inspection points by overlaying the points on 
the cut model. VERICUT searches from each point for an intersection with the 
model surface. Surface normal vectors control the direction in which to search. 
Only points associated with errors are seen in the results. Points associated with 
gouges have the Error color-typically Red, while points associated with excess 
material have the 5th defined color in the Shade Color list (typically Magenta). 

 

AUTO-DIFF "Point" method example 
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Profile— Enables you to compare the turning profile of the cut stock with profile 
of a design model. 

When Comparison Method is set to Profile, up to four profiles (Gouge, Excess, 
Stock, and Design) may be displayed in the "Profile" view. Each can be displayed 
in one of two modes:  Solid or Lines. The display mode for Stock and Design 
profiles is specified using the Design Display / Stock Display features. The 
display mode for Gouge and Excess is specified using the Draw Mode option in 
the View Attributes window for the currently active "Profile" view. 

When display mode is set to "Solid", Stock and Design profiles are displayed the 
"component" color unless the "model" color is different than the "component" 
color. In this case, Stock and Design profiles are displayed the color of the 1st 
model. Gouge and Excess profiles are displayed in the color selected with the 
Comparison Tolerance "color" feature. 

When display mode is set to "Lines", the same color scheme described above is 
used for "uncut" sections of the profile. "Cut" sections of the profile are displayed 
in the "cut" color. 

X-Caliper can be used to analyze any of the profiles (Gouge, Excess, Design, and 
Stock profiles) currently displayed in a "Profile" view.  Saving an In-Process file 
(IP file) stores all four profile types. 

Any valid VERICUT model type can be used as a design model for an AUTO-
DIFF Profile comparison. The design profile which is compared to stock profile is 
a Boolean union of the individual profiles of all Design Component models 
associated with specified Stock. 

If a design model is a Cone, Cylinder, SOR, or IGES Profile, and its Z-axis is 
aligned with the turning axis, its profile is built directly from its definition profile 
and is "exact". In all other cases, the profile is built by spinning the model about 
the turning axis (as is common with other turning applications) and is an 
approximation. The smaller the Cut Tolerance that is used, the better the 
approximation. If the "design component" consists of multiple models, the 
individual model profiles are merged into one design profile. 
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AUTO-DIFF "Profile" method example 

 
 

Comparison Type — Controls the error type(s) checked for by the AUTO-DIFF 
operation.  

Options: 

Gouge 
Excess 
Both 

  

Comparison Tolerance Features 
Comparison Tolerance features are used to specify the tolerances and colors used by 
AUTO-DIFF. The degree to which VERICUT can detect discrepancies is also affected by 
Cutting Tolerance. For best results set cutting tolerance smaller than the smallest 
tolerances used by AUTO-DIFF. 

Comparison Tolerance features displayed will vary depending the on the Comparison 
Method and Comparison Type settings. 



VERICUT HELP – Analysis menu 

Solid comparison tolerances 

 
 

Gouge — Tolerance used when checking for gouges during a Solid comparison. Gouges 
detected by AUTO-DIFF are shaded in the associated gouge color. 

Excess — Similar to Gouge above, except applies when checking for excess material. 

NOTE: "Solid" Gouge/Excess tolerance/color values are independent of "Profile" 
Gouge/Excess tolerance/color values and are stored as separate values in .VcProject file. 

 

Surface comparison tolerances 

 
 

Gouge Range/Color list — Range of tolerances used when checking for gouges during a 
Surface comparison. Multiple tolerance values can be specified, in addition to the 
"Gouge Check Distance" (in this case, 0.75000) used to limit checking,  and the Range 
value of 0.00000 which represents surfaces cut exact with no deviation from the design 
model. If more than six tolerance values are specified, a scroll bar will be added to the 
table. Use the Add and Delete buttons to add/remove tolerance values. The table row 
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containing the Range value of 0.00000 cannot be deleted, and the 0.00000 value cannot 
be modified.   

Gouges detected by AUTO-DIFF are shaded in the gouge color(s) associated with the 
depth of the gouge. Each pair of tolerance values represents a range of gouge depths to 
which a gouge color is associated. The gouge color used for each range is the color 
assigned to the lower tolerance value in the range. For example, in the gouge table shown 
above, all gouges with depths in the range between 0.04500 and 0.06000, will be 
displayed Light Steel Blue. 

The color associated with the "Gouge Check Distance" can be different for the Gouge 
and Excess tables, but the color associated with the Range value of 0.00000 is forced to 
be the same for both tables. 

Excess Range/Color list — Similar to Gouge Range/Color list above, except applies 
when checking for excess material. 
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Minimum Excess — This feature enables you to specify a value and color to be used to 
represent an offset from the design surface. The Minimum Excess value is applied to the 
design surface in all directions. During the compare, any Excess value less than the 
Minimum Excess value is considered to be a gouge and displayed the Minimum Excess 
color. Excess material is measured from the Minimum Excess to the Range value (see 
below) 

  

 
NOTE:  The amount of gouge and excess reported is with respect to the offset design, 
not the original design. In other words, zero deviation is where the cut stock excess with 
respect to the original design exactly equals to the given "Minimum Excess" value. This 
also is where the Excess color table range starts from. 

While in this mode, AUTO_DIFF > Report shows both gouges and excesses with respect 
to the condition described above. If a cut produces both a gouge and an excess, AUTO-
DIFF reports the gouge (no matter what the value of the excess). This is different from 
the Report behavior when "Comparison Type" = "Both" where the biggest deviation 
would be reported. 

 

Point comparison tolerances 
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Gouge Tolerance — Tolerance used when checking for gouges during a Point 
comparison. Gouges detected by AUTO-DIFF are shaded in the gouge color specified for 
a Solid comparison. 

Excess Tolerance — Similar to Gouge above, except applies when checking for excess 
material conditions. 

Gouge Check Distance — Maximum distance to check for the cut model surface in the 
gouge direction. Distance is measured from the inspection point along direction of the 
normal vector used with the inspection point. 

Excess Check Distance — Similar to Gouge Check Distance above, except applies 
when checking for excess material. 

Default Normal (IJK) — Default normal vector in which to check during a Point 
comparison when vector data is not present in the Design Points file. Enter three values 
separated by spaces, for example "0 0 1". 

Normal Direction — Indicates if surface normal vectors associated with design points 
are pointing outward (Out) or inward (In) relative to the design model. 

 

Profile comparison tolerances 

 
The Profile comparison tolerances are applied "exactly", without tessellating the stock 
and/or design profiles.  An arc offset by the tolerance value, will also be an arc and will 
be recognized by X-Caliper as such. The Profile Gouge/Excess tolerance values are 
independent of the Solid Gouge/Excess tolerance values described above, and are stored 
as separate values in .VcProject file. 

Gouge — Tolerance used when checking for gouges during a Profile comparison. 
Gouges detected by AUTO-DIFF are shaded in the associated gouge color.  

Excess — Similar to Gouge above, except applies when checking for excess material. 

NOTE:  "Profile" Gouge/Excess tolerance/color values are independent of "Solid" 
Gouge/Excess tolerance/color values and are stored as separate values in .VcProject file. 

 
To AUTO-DIFF window
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AUTO-DIFF window, Options tab 
Location: Analysis menu > AUTO-DIFF 

VERICUT toolbar short cut:   

  

The features on this tab are used to set processing and reporting options. 

 

 
 

Design Consistency Check—When selected during a "Solid" comparison, checks 
consistency of solid design models, including: check for "watertight" solid- repair 
improperly trimmed surfaces (overlaps and gaps), and reconstruct insignificant missing 
surfaces. This option is highly recommended for design models creating from importing 
IGES data, and other model files which produce unsatisfactory results from the 
comparison. 
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When selected during a "Profile" comparison, Design Consistency Check is applicable 
when building a profile from an STL, VERICUT Polygon, or VERICUT Solid design 
model. 

While checking design model consistency can take a while, it provides the best insurance 
for reliable AUTO-DIFF results. If you've used the model in VERICUT before and know 
the quality is good enough, you can save time by clearing this checkbox. AUTO-DIFF 
will take less time, but results may not be reliable if the solid is not water-tight. 

Keep Design Solid — When selected, keeps the solid design model created by AUTO-
DIFF so it can be used in additional comparisons. This action can reduce AUTO-DIFF 
time if multiple comparisons are made, but will require additional computer resources to 
keep the design solid. The design solid is kept until the VERICUT model is reset, a 
design model is removed or deleted, or the checkbox is cleared and Apply is pressed. 
Saving an IP file also contains the kept design solid. Clear this checkbox to have AUTO-
DIFF create a new design solid for each comparison. 

 Disable Report — Enables you to turn off the AUTO-DIFF Report feature to reduce 
AUTO-DIFF processing time. To generate the report, the processor must search through 
all cut records and lists the maximum error for each bad cut record. This can take a 
significant amount of time for large NC program files. When is toggled "on", you will 
still see the AUTO-DIFF results in the graphic area. Disable Report is only active when 
Comparison Method is set to Solid, Surface or Profile.  

Report Uncut Differences — When selected, differences between the design and uncut 
stock are added to the AUTO-DIFF report. 

Show Point Vectors — Displays the measurement vector associated with each point for 
the "Point" Comparison Method. The Vector is drawn whether AUTO-DIFF compare is 
active or not. 

Save AUTO-DIFF Model — Use to save gouge or excess data as a VERICUT solid 
model file (.vct). Selecting Save AUTO-DIFF Model displays a dialog enabling you to 
specify a directory path and filename for the model file. If both gouge and excess models 
are present, two files will be created ( gouge_filename.vct and excess_filename.vct, 
where filename is the filename you entered in the Save AUTO-DIFF Model dialog. 

This option is only available for use if all of the following are true (otherwise it is grayed 
out):  

1. Standard Cut Mode is active (not FastMill). 

2. Constant Gouge Check is turned off. 

3. AUTO_DIFF Comparison Method is set to Solid or Profile. 

4. AUTO-DIFF Compare has been processed. 

 
 
To AUTO-DIFF window
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AUTO_DIFF window, Compare By Region tab 
Location: Analysis menu > AUTO-DIFF 

VERICUT toolbar short cut:   

  

The features on this tab enable you to select a region to perform AUTO-DIFF on. 
Compare By Region is created for very large parts that would require too much memory 
for AUTO-DIFF to process the entire part.  Optionally, cut stock can be internally re-cut 
within the region with a better Cut Tolerance before doing AUTO-DIFF. The Compare 
By Region tab is not available when Comparison Method is set to "Profile". 

  

 
  

On — When selected, activates the Compare by Region feature. When toggled "on", 
AUTO-DIFF comparison only processes the cut stock and design volumes within the 
specified "region". 
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Apply Regions Over Entire Stock — The check box, Apply Regions Over Entire 
Stock, does the following: 

• Calculates a region that can achieve the specified Comparison Tolerance within 
the computer’s physical memory. 

• Re-processes that region of the cut stock at a tolerance that ensures the 
Comparison Tolerance can be achieved. 

• Does the specified AUTO-DIFF comparison for the region. 
• Repositions the region and does AUTO-DIFF multiple times over the entire cut 

stock. 

During AUTO-DIFF processing, the Region Box is displayed at each position over the 
cut stock. 

When Compare is pressed and this box is checked, a notice dialogue is displayed with the 
text, “Processing may take several minutes depending on tolerance, size of the cut stock, 
memory and processor speed. Press the stop button in the main window to cancel AUTO-
DIFF.”, OK. 

When the Apply Regions Over Entire Stock feature is active, the Region Size features 
are disabled. 

Improve Cut Stock Tolerance — When selected, the Cut Stock is re-evaluated at a new 
tolerance based on the specified minimum AUTO-DIFF tolerance. Having this box 
checked affects the results from both the Fit to Memory and the Apply Regions Over 
Entire Stock features. Typically the Comparison Tolerance is smaller than the Cut 
Tolerance, so processing will take longer when Improve Cut Stock Tolerance is active. 

  

Region Size features 

Show Region Box — Click on the  icon to show / not show the "region box", 
representing the AUTO-DIFF comparison region, in the Workpiece View. 

 Minimum XYZ — Use to enter the minimum X, Y, and Z values (relative to the 
workpiece coordinate system), separated by spaces. These values represent the X, Y, Z 
coordinates of first corner point of the "region box". 

 Maximum XYZ — Use to enter the maximum X, Y, and Z values (relative to the 
workpiece coordinate system), separated by spaces. These values represent the X, Y, Z 
coordinates of the diagonal corner point of the "region box".  

 Maximize to Stock — Use to size the "region box" to the maximum extent of the union 
of the stock and design volumes. 

 Fit to Box — Use to drag a 2 dimensional rectangle (similar to a "zoom" box) over the 
cut stock. The rectangle is projected into 3 dimensional space to define the "region box". 

Drag Region — Enables you grab a corner of the "region box" and drag it to re-size the 
"region box". The new corner location is automatically projected onto the cut stock in 3 
dimensional space. Grab the mid-point of one of the "region box" edges to re-size the 
"region box" by dragging a face. Click with the mouse pointer in the point representing 
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the center of the "region box" and drag around the Cut Stock to reposition the "region 
box" without resizing it. 

Fit to Memory — Use to automatically size the "region box" based on the available 
memory for AUTO-DIFF. A short delay occurs while memory is analyzed. 

 
 
To AUTO-DIFF window
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AUTO-DIFF window, Constant Gouge/Excess Check 
tab 
Location: Analysis menu > AUTO-DIFF 

VERICUT toolbar short cut:   

 

Enables you to specify a maximum gouge value, and a minimum excess value, and turn 
Constant Gouge Check on and off. Gouge areas found by Constant Gouge Check during 
NC Program processing are displayed in the assigned Error color. 

  

 
  

Off — Turns Constant Gouge Check off. 

Maximum Allowable Gouge — Select Maximum Allowable Gouge from the pull-
down list and enter the value in the text field. Then select Apply to turn Constant Gouge 
Check on. 
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Minimum Allowable Excess — Select Minimum Allowable Excess from the pull-down 
list and enter the value in the text field. Then select Apply to turn Constant Gouge Check 
on. 

 

NOTES:  
1. A design model must be present in the component tree for Constant Gouge Check 

to detect potential gouges. 

2. Constant Gouge Check is not compatible with FastMill. When cutting in FastMill 
mode, use one of the AUTO-DIFF comparison methods instead. 

3. AUTO-DIFF and Constant Gouge Check are mutually exclusive. To use the 
AUTO-DIFF features Constant Gouge Check must be turned "off". If you are 
using AUTO-DIFF, you must click the Restore button before you will be able to 
turn Constant Gouge Check "on". 

Tolerance — Specify a tolerance value for Constant Gouge Check. Only gouges, 
greater than the specified tolerance, will be displayed. You can turn Constant Gouge 
Check "off", change the tolerance, and reprocess the NC program at any time. 

NOTE:  A VERICUT Solid (.vct) file can be used for a design model when using 
Constant Gouge Check to find gouges during NC program processing. 

 
 
To AUTO-DIFF window
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Comparator (Comparator window) 
 

VERICUT Users: 
VERICUT Location: Analysis menu > Comparator 

VERICUT toolbar short cut:   

  

Cutter Grinder Users: 
Cutter Grinder Location:   Analyze, View Files, Print page > Comparator Grid 

Notebook Feature:     

  

Opens the Optical Comparator window enabling you to overlay a polar or rectangular 
grid over a workpiece or machine view to emulate an optical comparator chart.  

 

 
 

Use this feature to measure distance and angular relationships of features on your part 
like you would with optical comparator. 
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Comparator Grid Example 

 
 

The grid can be displayed in any view but only in one view at a time. The grid is always 
displayed in the "active" view. The grid is always displayed parallel to the screen and its 
center (0,0) position is related to the origin of either the workpiece coordinate system or 
the machine coordinate system depending on the type of view that is active. 

The grid will be displayed as long as the Optical Comparator window is open. Closing 
the Optical Comparator window removes the grid from the display. 

 Full Polar — Displays a full polar grid . 

 Polar Grid With Linear Quadrant — Displays a polar grid with one linear 
grid quadrant. 

 Half Polar / Half Linear — Displays a grid that is half polar and half linear. 

 Linear Grid With Polar Quadrant — Displays a linear grid with one polar 
quadrant. 

 Full Linear — Displays a full linear grid. 

 Color Pallet — Select a color from the pallet for the optical comparator grid. 
The default color is VERICUT's Foreground color. Click on the "X" in the upper right 
corner of the color pallet to close it. 
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Use the following options to specify the size and position of the grid as well as define the 
spacing between major and minor grid lines. Units are the same as the workpiece or 
machine depending on the type of view that is "active". 

Radius — Specify the radius of the grid that you want to display. 

Center X — Specify the horizontal position of the center of the grid. Enter a value in the 
text field. A negative number moves the center of the grid the specified number of units 
to the left of the coordinate system origin. A positive number moves the grid to the right.  

You can also move the horizontal position of the grid center by selecting one of the arrow 
buttons. Selecting either the < or > button moves the center of the grid to the left or right 
of its current position by the value specified for Minor Linear Spacing. Selecting either 
the < <  or  >>  button moves the center of the grid  to the left, or right, of its current 
position by the value specified for Major Linear Spacing. 

Center Y — Specify the vertical position of the center of the grid.  Enter a value in the 
text field. A negative number moves the center of the grid the specified number of units 
down from the coordinate system origin. A positive number moves the grid up.  

You can also move the vertical position of the grid center by selecting one of the arrow 
buttons. Selecting either the < or > button moves the center of the grid down, or up, from 
its current position by the value specified for Minor Linear Spacing. Selecting either the 
< < or >> button moves the center of the grid down, or up, from its current position by 
the value specified for Major Linear Spacing. 

CCW Rotation — Use to rotate the grid about its center point. Enter an angle value in 
the text field. A positive number rotates the grid the specified number of degrees in a 
counterclockwise direction from its default (zero) position. A negative number rotates the 
grid the specified number of degrees in a clockwise direction from its default (zero) 
position. 

You can also rotate the grid about its center by selecting one of the arrow buttons. 
Selecting either the < or > button rotates the grid clockwise or counterclockwise from its 
current position by the value specified for Minor Angular Spacing. Selecting either 
the << or >> button rotates the grid clockwise, or counterclockwise, from its current 
position by the value specified for Major Angular Spacing.  

Major Angular Spacing — Specify the number of degrees between the "major" grid 
lines of a polar grid. 

Minor Angular Spacing — Specify the number of degrees between the "minor" grid 
lines of a polar grid. 

Major Linear Spacing — Specify the distance between "major" grid lines of a linear 
grid. 

Minor Linear Spacing — Specify the distance between "minor." grid lines of a linear 
grid. 
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Magnification — Use this option to quickly change the size of the grid by either a factor 
of 2, or a factor of 10. Selecting either the < or > button reduces or enlarges the size of 
the grid by a factor of 2. Selecting either the < < or >> button reduces or enlarges the size 
of the grid by a factor of 10. 

Snap to — Use this option to center the grid on a specific feature of the workpiece or 
machine. Click on the text field so that it is highlighted. Select a feature in the graphics 
area and the grid center will move to that location. You can also enter the X, Y, and Z 
coordinates of the workpiece/machine coordinate system in the text field. Selecting the 
Snap to button (or <Enter> on the keyboard) moves the grid to the specified location. 

 

OK — Saves the current settings and dismisses the Optical Comparator window.  

Apply — Applies all of the current settings to the displayed grid without dismissing the 
Optical Comparator window. You can also use the <Enter> key after changing an 
individual setting to immediately apply the change to the current grid display. 

Cancel — Dismisses the Optical Comparator window without saving the settings. 

 
 
Also see "Optical Comparator", in the Using VERICUT section, in the CGTech Help 
Library.
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NC Program Review 
Location:  Analysis > NC Program Review 

VERICUT toolbar short cut:   

 

The NC Program Review feature enables you to quickly and easily view, replay and edit 
a previously processed NC program (toolpath). NC Program Review can be accessed at 
any point in the verification process, however, only information related to the "current" 
setup is available for review. It does not interrupt the current verification status, so reset 
or rewind of the NC program is not necessary. 

NOTE:   The following conditions must be met before a NC program can be viewed 
with NC Program Review. 

1. The NC program must be processed far enough in VERICUT so that a tool has 
been loaded and at least one tool motion has been processed after the tool is 
loaded. 

2. There must be a model attached to the first "Stock" type component in the 
Component Tree. 

3. The first "Stock" type component must be visible in a workpiece view. 
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When you enter NC Program Review mode the VERICUT main window changes in the 
following ways: 

1. Some of the menus in the menu bar become grayed out and are no longer 
available. These include the File, Project, Configuration, and OptiPath menus. 

2. The icons in the Toolbar associated with the features in the menus listed above 
are also not available. If selected the message "Action not allowed in the NC 
Program Review window" will display at the bottom of the Error Listing area. 
These icons include the File Options, Simulation Settings, Project, Configuration, 
and Cut Options groups, AUTO-DIFF and Inspection in the Analysis Group, and 
Clear Log File and Logger in the Info group. For specific information on which 
icons are included in these groups, see the View Toolbar window section of 
VERICUT Help. 

3. The graphics display will change and lines representing the actual tool paths will 
be displayed. 

4. The NC Program Review, Error Listing area, will replace the VERICUT Logger. 

5. Two additional icons,  (Step Back) and  (Play Backward) are added 
to the Simulation (VCR) Controls. 

6. The NC Program Review window will display. If the NC Program window is 
already displayed, it will be replaced by the NC Program Review window. 

Each of these changes is described in detail in the sections that follow. 

 

The NC Program Review main window is composed of three distinct areas, each with 
different user interaction. The window header displays the current NC program file. This 
window can be moved and resized like most other windows, via dragging the window 
header, sides or corners. In addition, the size of the NC Program Listing, Error Listing, 
and Graphics areas can be changed within the main window by dragging the adjoining 
sides of each area.  

NC Program Review enables you to quickly and easily associate the NC program 
record, the motion resulting from it, and any errors that may be associated with it. The 
three areas of the window are linked together so that if you select a NC program record in 
the listing, the tool moves to the corresponding location in the graphics area. If you select 
a location in the graphics area, the corresponding NC program record is highlighted in the 
NC program listing. If you select an error in the error listing, the NC program record that 
caused the error becomes highlighted in the NC program listing and the tool moves to the 
position where the error occurred in the graphics area. 

  

NC Program Listing — This area displays a listing of the NC program records. In this 
area you can manually edit, add, or delete NC program records. Save the modified NC 
program file or open another NC program file associated with the current project file. 
You can also set Start and End markers to define the range of NC program records that 
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you want to review. For more information about this portion of the NC Program Review 
main window, see the NC Program Listing Area section below. 

Error Listing — This area displays a list of the errors that VERICUT found while 
processing the NC program. For more information about this portion of the NC Program 
Review main window, see the Error Listing Area section below. 

Graphics Area — This area displays a visual representation of the motion associated with 
the records in the NC Program Listing. Here you can control how the tool is displayed, 
the method and direction of the replayed NC program as well as the speed of the replay. 
For more information about this portion of the NC Program Review main window, see 
the Graphics Area section below. 

 
Also see "NC Program Review", in the Using VERICUT section, in the CGTech Help 
Library. 
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NC Program Review, NC Program Listing Area 
The NC Program Review window, or NC Program Listing area, contains a listing of 
the NC program records. Features in this window enable you to edit, save, or print the 
NC program, and define display characteristics, and ranges for replay of the NC 
program.. 

The NC Program Review window is one of the dockable windows enabling you to dock 
it inside the VERICUT main window if you choose. See Dockable Windows in the 
Getting Started with VERICUT section of VERICUT Help for additional information. 

NOTE:  When the NC Program Review window is docked, make sure that you click in 
the window so that it becomes the "active" window before using F1 to get help specific to 
the window. Otherwise F1 will go to the CGTech Help Library. 
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Main Menu 
 

 
 

The menu located across the top of the NC Program Review window provides easy 
access to major NC Program Review functions. Each menu contains groups of related 
functions. Left-click on any of the menu names to display the list of functions available in 
that menu. Click on the function in the pull-down menu that you want to use. The name 
of the current NC program file is also displayed in this area. 

 

File 
Save As — Save the current NC program file under a different name. 

Print — Displays a window enabling you to specify print characteristics and print the 
NC program. 

Exit — Closes the NC Program Review window and returns to standard VERICUT 
mode. 

 

Edit 
Cut — Cuts the highlighted text in the NC program listing and puts it in the paste 
buffer.  

Copy — Copies the highlighted text in the NC program listing to the paste buffer. 

Paste — Puts the contents of the paste buffer at the location of the cursor in the NC 
program listing. 

Restore — use to remove all edits from the NC program listing restoring it to its pre-
edited state. 

 

Shortcut: You can also access the Edit menu features by clicking the right mouse button 
in the NC Program listing area. 

 

Utilities 

Calculator — Opens the Calculator window enabling you to do mathematical 
calculations and conversions inside VERICUT. 
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NC Program Statistics — S 

Colors — Opens the NC Program Color window enabling you specify colors for 
specific features (comments, variable, macros, etc.) in the NC Program listing.  

Block Renumber — Opens the Block Renumber window enabling you to renumber 
one, or more blocks, in the NC program and specify format characteristics to be used 
for block numbering. The formats specified must conform to the characteristics 
defined in the current control file.   

Remove Block Numbers — Removes all block numbers from the NC program file. 
Block numbers are identified by the characteristics defined in the current control file. 

Check Syntax — Displays the Check Syntax window enabling you to check the 
displayed NC program for syntax errors. 

 

Settings 

Set Start — Sets the "Start" marker, , to the position specified by the cursor in the 
NC program listing or picking a location in the Graphics Area. 

Set Current — Sets the "Current" marker, , to the position specified either by the 
cursor in the NC program listing or picking a location in the Graphics Area. 

Set End — Sets the "End" marker, , to the position specified by the cursor in the 
NC program listing or picking a location in the Graphics Area. 

Display to Box — Enables you to set "Start", "Current" and "End" markers by 
creating a box around the area of interest in the graphics area. Click on Display to 
Box, then left click in the Graphics Area and drag the cursor to create a box around 
the area of interest. The "Start" marker will be set to the lowest record number 
contained within the boxed area and the "Current" and "End" markers will be set to 
the highest record number contained within the "boxed" area. 

Cut Line — Displays a color pallet enabling you to specify a color for "cutting" 
portions of the toolpath display in the Graphics Area. 

Non-Cut Line — Displays a color pallet enabling you to specify a color for "non-
cutting" portions of the toolpath display in the Graphics Area. 

Current Line — Displays a color pallet enabling you to specify a color for "current" 
motion of the toolpath display in the Graphics Area. 

Goto Start — Moves the cursor in the NC program listing and positions the cutter in 
the Graphics Area to the position indicated by the "Start" marker. 

Goto Current — Moves the cursor in the NC program listing and positions the cutter 
in the Graphics Area to the position indicated by the "Current" marker. 

Goto End — Moves the cursor in the NC program listing and positions the cutter in 
the Graphics Area to the position indicated by the "End" marker. 
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Shortcut: You can also access the Settings menu features by clicking the right mouse 
button in either the NC Program listing area, or in the Graphics Area. 

 
Icon Bar 

 

 
 

The items in the Icon Bar enable you to search for specific items in the NC program 
listing, print the NC program listing, or exit NC Program Review. Moving the cursor 
over the icon will display name of the option. 

 

  NC Program Review — Use this icon to switch between standard VERICUT 
mode and NC Program Review mode (ref .NC Program Review, in the Analysis menu 
section , in VERICUT Help for more information). 

  NC Program Preview — Use this icon to put VERICUT in NC Program Preview 
mode and display a tool trace represented by the NC program and the design model. This 
feature can be used without processing the NC Program first, as required by NC Program 
Review. See NC Program Preview, also in the Analysis menu Section of VERICUT 
Help for more information. 

  NC Program Syntax Check — Displays the Check Syntax window enabling you 
to check the displayed NC program for syntax errors. 

Line Number or Search Text — Use this text field to enter a line number or a string of 
text to search for. 

  Goto Line Number — Moves the cursor in the NC program listing to the line 
number specified in the Line Number or Search Text field. 

  Search Forward — Searches forward in the NC program listing for the text string 
specified in the Line Number or Search Text field. 

  Search Backward — Searches backward in the NC program listing for the text 
string specified in the Line Number or Search Text field. 

Replacement Text — Use this text field to enter a "replacement text" string. 

  Replace One — Replace one occurrence of text string in the Line Number or 
Search Text field (or the highlighted text in the NC program listing) with the text string 
in the Replacement Text field. 
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  Replace All — Replace all occurrences of the text string in the Line Number or 
Search Text field with the text string in the Replacement Text field. 

  Undo Highlighted Changes — Use this feature to undo changes made to the NC 
program listing. Highlight the change and then click on the icon to "undo" the change. 

  Print — Prints the NC program listing. 

  Close Window — Closes the NC Program Review window and returns to 
standard VERICUT mode. 

 
 

NC Program Listing Area 
 

 
 

NC Program Editing 
The NC program listing area allows you to edit the NC program with a full function text 
editor. 

You can use the keyboard to add, change, or delete portions of the NC program listing. 
You can also use the Cut, Copy and Paste functions found under Edit in the main menu. 
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You can easily see the modifications that you have made to the NC program listing. 
Added, changed, and pasted text is displayed in blue and underlined. Cut and deleted text 
is displayed in red with a "strike through" font. Once you save the modified NC program, 
the red and deleted text is removed and the blue added, changed, and pasted text is 
returned to the original font. 

 

Start/Current/End Markers 
The Start/Current/End markers can be found along the left side of the NC Program 
Listing area. The Start marker is represented by the green triangle , the Current 
marker is represented by the aquamarine arrow , and the End marker is represented by 

the red square . You can easily identify each marker by moving the cursor over it. 

The Start and End markers are used to define the range of NC program records that will 
be replayed when using Play to End. The Current marker moves to the NC program 
record that is currently being replayed. Set these markers by either selecting an NC 
program record in the NC program listing or the location in the graphics area where you 
want the marker placed. Then select the appropriate option (Set Start, Set Current, Set 
End) from the menu displayed when using the right mouse button in either the graphics 
area or the NC program listing. The menu can also be found under Settings in the NC 
Program Review window. You can also click on the marker in the NC program listing 
and drag it to the desired NC program record.  

 

Shortcut:  Click the right mouse button in the NC Program Listing Area to display a 
menu with the following features: 
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NOTES: 
1. See the Edit section above for specific information on features Cut through 

Restore. 
2. See the Settings section above for specific information on features Set Start 

through Goto End. 
 
 
Other Features 
 

 
 

The name of the displayed NC program file is displayed near the bottom of the NC 
Program Listing area. If the current setup contains more than one NC program file, 
clicking on the button to the right of the NC program file name displays a list of the NC 
program files contained in the current setup. Click on a file name in the list to change the 
NC program displayed in the NC Program Listing area. 

Tool Display — enables you to specify how the tool is to be displayed in the graphics 
area while in NC Program Review. Choose Off (do not display tool), Solid, or 
Translucent from the pull-down list. 

Line Display — enables you to specify whether or not to display the lines representing 
the tool's path in the graphics area while in NC Program Review. Choose Off (do not 
display), or On (display) from the pull-down list. 

The line number of the "current" record and information related to the current tool (tool 
id or APT description) and the X, Y, Z, I, J, K of the current tool tip position is displayed 
at the bottom of the NC Program Listing area.  

 
 
To NC Program Review 
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NC Program Review, Error Listing Area 
 

The Error Listing area replaces the VERICUT Logger while in NC Program Review. It 
contains a list of the errors that were found while processing the NC program in 
VERICUT. 

 

 
 

Selecting an error in the Error Listing causes the line in the NC Program Listing 
associated with the error to become highlighted. At the same, the tool display in the 
Graphics Area moves to the position where the error occurred. This enables you to 
quickly and easily associate the error with the position in the NC program and in the 
toolpath display. 

 
 
To NC Program Review
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NC Program Review, Graphics Area 
 

 
 

The graphics area displays the active views from the VERICUT main graphics area. 
Also, many of the analysis, display and view manipulation tools in the VERICUT main 
menu are available for use while you are in the NC Program Review graphics area. 

 
Main menu and Toolbar icons 
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The icons shown in the picture above are all available in NC Program Review except  

 (AUTO-DIFF),  (Inspection), and  (Clear Log File and Logger). 

The available Menu bar items and Toolbar icons perform the same function as those 
found in VERICUT. 

Some of the menus in the Menu bar become grayed out and are no longer available while 
in NC Program Review. These include the File, Project, Configuration, and OptiPath 
menus. 

The icons in the Toolbar associated with the features in the menus listed above are also 
not available. If selected the message "Action not allowed in the NC Program Review 
window" will display at the bottom of the Error Listing area. These icons include the 
File Options, Simulation Settings, Project, Configuration, Cut Options groups, AUTO-
DIFF and Inspection in the Analysis Group, and Clear Log File and Logger in the Info 
group. For specific information on which icons are included in these groups, see the View 
Toolbar window section of VERICUT Help. 

The icons shown in the picture above are all available in NC Program Review except 
AUTO-DIFF, Inspection and Clear Log File and Logger. 

 

The Toolpath Display 
As the toolpath is replayed, a line representing the motion of the tool control point is 
displayed in the graphics area. Motions that remove material are displayed as solid lines 
with a default color of the foreground color. Motions that do not remove material are 
displayed as dashed lines with a default color of magenta. The line representing the 
motion of the current NC program record is highlighted with a default color of red. The 
tool image is displayed at the location of the current NC program record. 

The color of the lines can be changed using the Cut Line, Non-Cut Line and Current 
Line options found in the menu that is displayed when using the right mouse button in 
the graphics area or the NC Program listing area, or found under Settings in the NC 
Program Review main window. 

 

Graphics Area Controls 
Animation Speed Slider — Controls the speed of the toolpath replay. Move to the left to 
slow down the replay of the toolpath. Move to the right to speed it up. 

Simulation (VCR) Controls — The simulation controls, also known as VCR buttons, 
located at the bottom-right corner of the graphics area control interactive tool path replay. 
Use these controls to start and stop the replay of the toolpath. To see what action is 
associated with a Simulation control icon, simply position the cursor over the icon and a 
tip appears. 
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Icon Name Function 

 

 
Play to End Replays from the Current position to the End 

position. 

 

 
Step Forward Replays the next NC program record ("single block"). 

 

 
Stop Stop the replay during "Play" (after the current record 

displays) 

 

 
Step Back Replays the previous NC program record ("single 

block"). See notes below. 

 

 
Play Backward Replays from the Current position to the Start 

position. See notes below. 

 

 
Rewind 

Sets the Current marker to the record with the Start 
marker and clears the toolpath display from the 
Graphics area. 

 

 
Reset 

Sets the Start and Current markers to the first motion 
record in the NC program, sets the End marker to the 
last NC program motion record, and clears the toolpath 
display from the Graphics area. 
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NOTES: 
1. You can see removed material replaced as you step back (Step Back or Play 

Backward) through the toolpath by turning on Replace Material When 
Stepping Back on the File menu > Properties window: General tab before 
simulating the toolpath in VERICUT. 

Replace Material When Stepping Back (ref. Replace Material When Stepping 
Back, on the Properties window: General tab, in the File menu section, also in the 
VERICUT Help section) and FastMill mode (ref. FastMill, on the Motion 
window, in the Project menu section, also in the VERICUT Help section) are 
mutually exclusive. 

When Replace Material When Stepping Back is toggled "On", VERICUT will 
turn FastMill "Off" Conversely, if FastMill is toggled "On", VERICUT will turn 
Replace Material When Stepping Back "Off. VERICUT will display a pop-up 
notification when these situations occur. 

2. You can see machine animation as you step back (Step Back or Play Backward) 
through the toolpath by turning on Animate Machine When Stepping Back on 
the File menu > Properties window: General tab before simulating the toolpath 
in VERICUT. 

 
 
To NC Program Review
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Graphics Area Right Mouse Button Shortcut Menus 
 
Workpiece View 
Right-click in the NC Program Review Main Window, Workpiece View to display a 
menu with the following features: 
 

 
NOTES:   

1. See Workpiece View in the Graphics Area Right Mouse Button Shortcut Menus, 
in the Getting Started with VERICUT section of VERICUT Help, for specific 
information on features View Type through Display Axes. 
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See Settings, in the NC Program Review, NC Program Listing area above, for 
specific information on features Set Start through Goto End. 

2. A check next to Accelerated (OpenGL) indicates that the feature is toggled 
"On". 

 
 
Machine View 
Right-click in the NC Program Review Main Window, Machine View to display a 
menu with the following features: 
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NOTES:   
1. See Machine View in the Graphics Area Right Mouse Button Shortcut Menus, in 

the Getting Started with VERICUT section of VERICUT Help, for specific 
information on features View Type through Display Axes. 

See Settings, in the NC Program Review, NC Program Listing area above, for 
specific information on features Set Start through Goto End. 

2. A check next to Accelerated (OpenGL), or any of the Display Axes features,  
indicates that the feature is toggled "On". 

3. A check next to any of the Component Visibility features,  indicates that the 
feature is "visible". 

4. The Component Visibility, and Attach Component, feature lists will contain all 
components in the  current machine. This is especially useful when using an 
encrypted machine as the Component Tree is not available. If the list of 
components gets too long to display on your screen, VERICUT will automatically 
break up Component Visibility, and Attach Component, into multiple menu 
item/feature lists. 

5. The Select View feature list will contain all available standard and custom views. 
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Profile View 
Right-click in the NC Program Review Main Window, Profile View to display a menu 
with the following features: 
 

 
 
 

NOTES:   
1. See Profile View in the Graphics Area Right Mouse Button Shortcut Menus, in 

the Getting Started with VERICUT section of VERICUT Help, for specific 
information on features View Type through Display Axes. 

See Settings, in the NC Program Review, NC Program Listing area above, for 
specific information on features Set Start through Goto End. 

2. A check next to any of the Display Axes features, indicates that the feature is 
toggled "On". 
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NC Program Preview 
 

The NC Program Preview is accessed from the NC Program (Info) window, or from the 

NC Program Review window: NC Program listing area, by using  (NC Program 
Preview) in the icon bar in either of the windows. NC Program Preview puts VERICUT 
in NC Program Review mode except that it displays a tool trace representing the NC 
program and the design model. This feature can be used without processing the NC 
program first, as required by NC Program Review. All of the VERICUT features behave 
in the same way as described above for NC Program Review. 
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NOTES: 
1. The tool trace representing the NC program and design model only display in a 

Workpiece view. 

2. The NC Program Preview feature responds to the "Stop at ..." settings in the 
Motion window. See Motion window, in the Project menu section of VERICUT 
Help, for additional information on these settings. 

 

Shortcut:  NC Program Preview has the same right mouse button shortcut menus in the 
NC Program Listing Area, and in the Graphics Area, that are described above for NC 
Program Review.  
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Inspection 

VERICUT Inspection 
 
The "end product" of VERICUT's Inspection module is a report, or set of reports, which 
define the inspection operations to be performed on a part. Typically these check 
measurements would be made while the part is still on the machine, perhaps after each 
tool's activity, to ensure that the job is proceeding as intended. If a discrepancy is found, 
no additional time will be wasted on subsequent machining. The format of the reports can 
be extensively customized, but there are two essential elements for each inspection 
report; a picture showing the features to be inspected, and a table giving the required 
dimensions and tolerances for each. The following four pairs of pictures and tables 
illustrate the inspection requirements after cutting a simple part with each of four tools.  
After the first tool, we simply check the remaining stock thickness at the "floor" of the 
part.  
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After the second tool, we check the floor thickness at each end of the part, and the "wall" 
thickness of the two webs.  
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After the third tool, we re-check the web thicknesses.  
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And after the fourth and final tool, we specify many more measurements to be made. 
Note the use of datum planes for defining distance and angle dimensions, and how the 
feature identifiers tie the dimensions to the appropriate datum planes.  
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The reports can be generated as HTML files that reference GIF and JPEG images, or as 
PDF files that have all the images embedded. But let's take a look at how you would start 
to use the inspection module. You will find it in VERICUT's menus at "Analysis" > 
"Inspection Sequence ...". When you trigger it from a project file that has not previously 
exercised the module, a dialog similar to the following should appear. 
 

 
 
You can re-size this window if you wish, re-arrange the columns in the table and set their 
widths. Your preferences will be remembered next time you display the dialog. If you let 
the cursor hover over any of the icons in the toolbar, a short tip will be displayed to 
explain its function. While all the functions are also accessible in the dialog's menus, it is 
likely that you will find the toolbar to be more convenient. In addition, each of these 
features is also available by clicking with the right mouse button in the inspection 
window to display the following right mouse button shortcut menu: 
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Following are the icons and a brief description of their intended use.  
 

 Clears the table, ready to start a new inspection sequence. 
 

 Prompts for and opens an existing inspection sequence file. Such files typically 
have the extension ".VcInspect". Note that you can also open the ten most recently 
accessed files more directly from the "File" menu. 
 

 Saves the current inspection sequence to a file. You may be prompted to select a 
file name if the current sequence was not derived from an existing file. There is also 
a "Save As" option in the "File" menu. 
 

 Opens another dialog to assist in identifying the features on the stock that were cut 
by each tool. 
 

 Inserts a row in the table for a wall thickness measurement. You will be prompted 
to pick the wall in a workpiece view. 
 

 Inserts a row in the table for a floor thickness measurement. You will be prompted 
to pick the floor in a workpiece view. 
 

 Inserts a row in the table for a hole diameter measurement. You will be prompted 
to pick the hole in a workpiece view. 
 

 Inserts a row in the table for a datum plane. You will be prompted to pick the 
plane in a workpiece view. 
 

 Inserts a row in the table for a distance from a datum plane. You will be prompted 
to pick the relevant feature in a workpiece view. It does not make sense to use this 
type of measurement without a datum plane. 
 

 Inserts a row in the table for an angle between a selected plane and a datum plane. 
You could use this type of feature without a datum plane if it is obvious which 
angle is to be measured. 
 

 Inserts two or three rows in the table for the coordinates of a position. You could 
use this type of feature to specify the location of the center of a hole, relative to 
the currently active coordinate system. You will be prompted to pick the hole in a 
workpiece view. 
 

 Inserts a row in the table for a hole depth measurement. You will be prompted to 
pick the hole in a workpiece view. 
 

 Inserts a row in the table for a radius measurement. You will be prompted to pick 
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the hole or cylinder in a workpiece view. 
 

 Inserts a row in the table for a surface finish requirement. You will be prompted to 
pick the surface in a workpiece view. 
 

 Inserts a row in the table for a tabulated note. You will be prompted to pick a 
reference location in a workpiece view. 
 

 Changes the measuring instrument in the currently selected row to "Probe". 
 

 Changes the measuring instrument in all rows to "Probe". Typically this would be 
used just before the next icon. 
 

 Causes the Inspection Programming dialog to be displayed, and transfers any 
features that have "Probe" as their measuring instrument, to the extra dialog. 
 

 Allows you to re-position the selected row's symbol in a workpiece view. The 
row's dimension will be recalculated, and if the tolerance value was automatically 
generated, it will also be updated. 
 

 Deletes the selected row from the table. 
 

 Refreshes all the rows. This is equivalent to using the re-positioning icon, , for 
each row and picking all the same screen positions. It causes each dimension and 
non-edited tolerance to be recalculated, and is explained in more detail at the end 
of this document. 
 

 Opens the Save Inspection Sequence window enabling you to specify the 
/path/filename for the inspection report file to be created. Selecting Save generates 
and displays an HTML inspection report. 
 

 Opens the Save Inspection Sequence window enabling you to specify the 
/path/filename for the inspection report file to be created. Selecting Save generates 
and displays a PDF inspection report. 
 

 Exits the dialog. If you have made any changes to the table and not saved the file, 
you will be prompted to do so before the window closes. 

 
File Organization 
 

An inspection sequence file retains all the information needed to reproduce the dialog's 
table and the corresponding symbols on the workpiece for a single report. Thus in the 
example at the start of this document there are four inspection files involved. A file is not 
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the report itself. A report is generated on demand and will typically have the extension 
".htm" or ".pdf". Unless you explicitly specify a file name when you first save an 
inspection sequence, the dialog will offer the project file name, with its extension 
changed to ".VcInspect". If there will be several sequences for a part, it is suggested that 
you adjust the file names to include suffices "1", "2", ... or "A", "B", ... or perhaps tool 
identifiers.  

When you request that a report be generated, the report file name will be the same as the 
inspection sequence file name, with the extension changed to ".htm" or ".pdf". For a PDF 
file, any pictures required in the report will be embedded, which makes it trivial to pass 
the report around electronically. For an HTML file, the pictures are generated as separate 
GIF and JPEG files, making it more difficult to keep all the pieces together, unless you 
place all inspection files and reports for a part in their own folder, perhaps named using 
the part's identifier. 

 

Inserting Rows 
 

For measurements that do not require a datum plane, such as a wall or floor thickness, 
adding the required information to the table is very simple. Pick the relevant icon from 
the toolbar, for example  for a floor thickness, then pick the location where the 
measurement is to be made on a workpiece view. A row will be appended to, or inserted 
in, the table and a feature symbol will be placed on the view. Next to the symbol will be 
an identifier that is repeated in the table. You can adjust the view orientation while it 
contains numerous feature symbols, but the orientation is going to be used for a report's 
picture eventually, so it makes sense to find one, sooner rather than later, that exposes all 
the features to be checked.  

 

 
 

Let's look at each entry in the feature's row. Assuming you haven't already re-arranged 
the columns, the first one on the left contains the name of the workpiece view. An 
inspection report can have a page for each of several views if you need more than one to 
illustrate each required feature. The second column contains the same symbol as appears 
in a view. The third contains a very brief description of the type of feature, "Floor 
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Thickness" in this case. If you click on this entry, you will find that you can adjust the 
feature type, perhaps making it a "Wall Thickness" instead. When you do so, the symbol 
will be updated to reflect the new choice. You can also enter the name of a different 
feature type that we have not thought to offer. If you do so, there will be no 
corresponding symbol in the second column.  

In the fourth column is an automatically generated feature identifier. If the first feature 
inserted in a table does not require a datum plane, its identifier will be "A1". The next 
will be "A2", then "A3", etcetera. If you were to edit the last one in this sequence, making 
it "B1", then subsequently appended rows would continue the new sequence, with "B2", 
"B3", and etcetera. If you then inserted a row after the last "A" feature, its identifier 
would continue the "A" sequence.  

The fifth column indicates the type of instrument to be used to check the dimension. It 
will initially show a suitable instrument type, such as "Ultrasonic" for a floor thickness 
and "Snap Caliper" for a wall thickness. As with the feature types, you can edit the entry 
by picking from the drop-down list of instrument types, or by entering your own 
description. Also you can use the  or  buttons if probe cycles are to be used to 
measure the features on the machine.  

The sixth column is used to specify the expected dimension. For many feature types, but 
not all, this column will be populated by the system. For our floor thickness example, 
behind the scenes we use X-Caliper's abilities to determine the distance through the stock 
from the position you picked to the next "air". The same calculation is performed for wall 
thickness. And if you pick a cylinder when locating a diameter or radius feature, we can 
obviously fill in the column easily. Things are a little more complicated when a datum 
plane is involved, which we will get to soon. Whether the column is populated 
automatically or not, you can always adjust the value.  

If the dimension value is generated by the system when you insert the row, the seventh 
column is filled too. There are hard-coded default tolerances values, or you can supply 
your own. A sample file contains an explanation of the flexibility available and the 
format to be used. If the tolerances generated do not reflect the values you want, at least 
they give you initial entries to edit, with the advantage that you don't need to know how 
to keyboard enter a plus/minus symbol. If you need non-symmetric tolerances you could 
enter "+0.010/-0.008" for example, or you could employ DIN standards by typing an "H" 
number. Incidentally, if you do want to type a plus/minus symbol, on a Windows system 
try holding down the "Alt" key while you hit the numeric pad keys "0", "1", "7" and "7", 
then release the "Alt" key. Cut and paste is easier to remember.  

We'll cover the eighth, geometric tolerance, column towards the end of this document. 
The ninth column is where an inspector will enter the measurements he makes to generate 
a record of the part's compliance. Probably this will occur on paper copies of the reports 
generated by this module. But if your company is on the bleeding edge of digital record 
keeping and you make VERICUT available to your inspectors (which we whole-
heartedly encourage) they could enter the values directly into the table.  

The tenth and last column is filled automatically, if possible, with the identifier of the 
tool that cut the feature. You can edit this entry if you wish. Note that you can re-order 
the columns and your arrangement will be remembered.  
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Datum Planes 
 
For measurements that require a datum plane, such as distances and angles, it makes 
sense to add a row for the plane first, followed by rows for one or more measurements to 
be taken from the plane. Pick the relevant icon, , and a position in a workpiece view. 
Note that in the fourth column, the datum plane's identifier is the next available single 
letter, and that columns 5 through 10 are shaded to show that they are unused. You can 
alter the identifier if you wish, but it is strongly suggested that you stay with the single 
letter convention. You can also edit the third column's entry if you wish to use "Right 
Face" or something more descriptive.  

Now pick the icon for appending a distance row, , and pick another feature in a 
workpiece view. If you pick a plane which is parallel to the datum plane, then there is no 
doubt about the intention and we can automatically populate the sixth, dimension column. 
If you pick some other type of feature, such as the closest edge of a cylindrical boss, then 
the value we insert may not be exactly the one you need, and you would need to edit it. 
Repeat the steps in this paragraph to add other measurements from the datum plane. You 
will see that the identifiers all start with the plane's letter and are numbered 
consecutively.  

 
 

 
For angle dimensions, , the value will be in degrees, is always acute, and is the angle 
between the surface normal at the picked position and the datum plane's normal. If the 
feature selected is not a plane, the angle may well be approximate and will need to be 
edited. To type a degree symbol on a Windows system, hold down the "Alt" key while 
you hit the numeric pad keys "0", "1", "7" and "6", then release the "Alt" key. No default 
tolerances are provided for angle measurements, unless you supply the "rules" in an 
external file.  
 
Coordinate Systems 
 
When you insert position rows, , their dimension values are in the active coordinate 
system. No other type of measurement is dependent on a coordinate system. When the 
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first position is selected with a particular coordinate system active, the 2 or 3 rows for the 
position's coordinates are preceded by a row containing the name of the active coordinate 
system, and an identifying letter.  
 
 

 
 

 

You can use more than one coordinate system, and each will be allocated a unique letter, 
which will be used in the coordinate system's row and all rows with positions to be 
measured in that system. If you adjust the name of a coordinate system elsewhere in 
VERICUT it would make sense to change it in the sequencing table too. If you adjust the 
location or orientation of a coordinate system, you can update the dimensions and 
tolerance on the associated position rows by refreshing, , the table. If you want to 
switch some position measurements from one coordinate system to another, you could 
can edit the system's name in the table and then use the refresh, , capability.  

Coordinate system axes are reproduced in the inspection report pictures, provided they 
are visible in the workpiece views on the screen. The coordinate system rows in the 
report's tables are the only connection between system names and feature identifiers.  

 

Modifying a Symbol Position 

 
When you generate a report for an inspection sequence, with the  or  icon, the 
pictures are based on the workpiece views, but the feature identifiers are moved to the top 
and bottom edges. Primarily this is to reduce the chance of an inspector missing one in a 
cluttered picture. But the algorithm involved is not foolproof when it comes to ensuring 
that the lines from the features to their identifiers do not cross. When you see the pictures 
you may decide to re-orient their views and try again, or to move some of the symbol 
positions.  

To move a row's symbol, select the row then pick the modification icon, . You will be 
prompted to select a new position in a workview. If the system is able to re-calculate the 
dimension at the new position, it will do so and update the value in the sixth column of 
the table. So if, for example, you move a wall thickness symbol from one wall to another, 
or if you move it along a wall of non-uniform thickness, you should expect the value to 
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change. The tolerance value will be altered if it was generated by the system. A tolerance 
value which you entered, either by editing a supplied value or by typing into any empty 
cell, will not be adjusted. Such tolerance values are shown in italics.  

If you move a datum plane's symbol, dimensions that depend on that plane will not be 
updated. However if you move a distance or angle symbol, provided there is a datum 
plane with an identifier which is the first letter of the symbol's identifier, the system will 
try to update the individual dimension value.  

 

Geometric Tolerance 
 
In the eighth column of an inspection sequence table you can place geometric tolerance 
specifications. If you do not use the widely misinterpreted GD&T standard, you can 
shrink this column's width to zero in the table, and omit it completely from your report 
template. But if your company uses geometric tolerancing, select a row that requires it 
and either select "Edit Geometric Tolerance" from the "Edit" menu, or right-click on the 
table and pick the same option from the pop-up menu. The following dialog will be 
presented.  

 
 

 

In the twenty-four white boxes you can assemble the elements of a geometric tolerance 
specification. For a symbol, such as  for "Position", simply click on the required icon 
amongst the characteristics and modifiers. The symbol will be placed in the box that 
currently has the yellow border, which will automatically step to the next box. The same 
is true for a separator, or vertical bar. To enter text in a box, either a tolerance value or a 
datum plane reference, just type into an empty box, then hit the "Tab" or "Enter" key to 
step to the next one. The "Text" button can be used to convert an existing symbol or 
separator box to text. As you define the elements of the geometric tolerance specification, 
a picture is continually updated at the top of the dialog. 
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You can use one of the  icons to shift elements to the right and make space for another 
one. The  icons will delete an element and shift the remaining ones to the left. Once 
you are satisfied with the assembly of elements, click on the "OK" button. The dialog 
will disappear and the picture of the geometric tolerance box will be placed in the 
inspection table.  

 

 
 

If the combination of dimension and geometric tolerance specification in this illustration 
doesn't make sense, we apologize. We prefaced this section by saying that the standard 
was widely misinterpreted, and count ourselves among the confused. The software does 
not attempt to enforce compliance. 

 

Refreshing All Rows 
 
When a design is changed slightly, it is possible that some of the features previously 
selected for inspection will be altered. The  icon is intended to help in this situation by 
identifying which features have changed. It is equivalent to selecting the repositioning 
icon, , for each row of the table, and picking the same screen location for each feature. 
Let's take a wall thickness measurement as an example. The row's icon was on the side of 
the wall in the prior design. When we trigger the refresh capability, the software will 
determine the thickness of the current workpiece directly under the icon's screen position. 
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This thickness will be inserted in the "Dimension" column of the feature's row, and the 
tolerance value will be updated too, provided it was not previously edited by the user.  

To highlight features that have changed significantly, the color of the dimension cells in 
the table may be changed to one of the following shades, . The lightest 
shade indicates a change greater than 10%, the next 20%, 30% and 40%, up to the darkest 
shade, which indicates a change of 50% or more. You can clear a colored cell simply by 
selecting its row. To illustrate the refresh function, we will again use the example at the 
start of this document. After cutting the part with the second tool, we inspected two wall 
and two floor thicknesses.  

 

 
 

 
If we now proceed to cut with the third tool, the sides of the walls are finish machined.  
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We can now trigger the refresh function with the  icon. Because the wall thickness 
icons B1 and B2 are still on the sides of the walls, their dimensions will be adjusted. 

 

 
 

 
Note that the color of the changed dimension cells has been set to the third shade, 
because the values have been reduced by 33%.  
 
Analysis,  Feature Identifier 
 
It is common practice to inspect the first and last feature cut by each tool. Measurement 
of the first feature will confirm that the correct tool is loaded, and measurement of the 
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last will check for excessive tool wear. However, on a complex part it may not be 
obvious where these two features are located. The dialog accessed from this menu item is 
designed to help. It displays a table with a row for each tool that currently has an 
"imprint" on the cut stock.  
 
 

 
 

 
When you select a row, the background of the cell containing the tool's identifier is 
changed to match its "cut color",  
 
 
 
 

 
 

 
and two markers will appear in the workpiece view to indicate the first (1) and last (2) 
features cut by the tool. The colors of these two features will also be adjusted to match 
the color in the dialogs drop-down palette.  

 



VERICUT HELP – Analysis menu 

 
 

 
You can use the  and  buttons to walk through the features cut by the tool until you 
find ones that are suitable for inspection. It is not necessary to close the feature 
identifying dialog while you add rows and features to the inspection sequence table.  
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Colors 
 
By default, feature icons are black, both in the workpiece views and the reports. And the 
icon corresponding to the selected row of the table will be orange in its workpiece view, 
to help you locate it quickly. These on-screen colors can be adjusted, without affecting 
the appearance of the reports. Under the "Colors" menu there are three choices; 

•  In front 
The color you choose here will be used for any feature icon on a face of the cut 
stock whose outward normal points out of the screen.  

•  Behind 
The color you choose here will be used for any feature icon on a face of the cut 
stock whose outward normal points into the screen. Having such icons in the view 
when you generate a report is not good practice, as it may not be clear to the 
reader where the feature's measurement is to be taken. If you do produce a report 
with features on the "back side" of the stock, they are marked with an open circle 
instead of the usual filled circle. The following two pictures illustrate this with a 
workpiece view and report. Icons "in front" are black, those "behind" are pink, 
and the selected one is green.  
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•  Selected 
 

The color you choose here will be used for the single feature icon corresponding 
to the selected row in the sequencing table. 

 
Also see "VERICUT Inspection", in the Using VERICUT section, in the CGTech Help 
Library.
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VERICUT Inspection Programming 
 

The "end product" of VERICUT's Inspection module is a report, or set of reports, which 
define the inspection operations to be performed on a part. Typically these check 
measurements would be made while the part is still on the machine, perhaps after each 
tool's activity, to ensure that the job is proceeding as intended. If a discrepancy is found, 
no additional time will be wasted on subsequent machining. This goal can be reached 
quickly if the inspection is performed on the machine and by the machine, using one or 
more probes.  

To explain the Inspection Programming module we will start with the third set of checks 
from the Inspection Sequencing document. This consisted of two wall thickness 
measurements after the third tool had cut the part. Note that the active coordinate system 
is "Machine Origin". 
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We use the  button to override the measuring instrument for both features, so that they 
will be probed. 

 

 
 

Next we use the  button to request the Inspection Programming dialog. Before we 
see it, we will be prompted to select a post-processor file, which typically has the 
extension ".VcPost". For this explanation we shall use a post-processor developed for 
Renishaw probe cycles on a Fanuc controller. The name of the file is 
"RenishawFanuc.VcPost". 

 

 
 

You can view the post-processor content, and edit it if you wish, by clicking the  
button. Development of a post-processor for probe cycle programming is documented 
elsewhere (refer to CGTech PostProcessor Help, found in postprocessor.pdf, located in 
the hhelp directory of your VERICUT installation). Note that a default name is supplied 
for the G-Code program that will be generated, using the current inspection file name 
with the ".VcInspect" extension replaced by "-Probe.mcd". The two blank pink cells in 
the table, in the "Cycle" column, need to be filled with the name of the cycles we wish to 
use. Because the two webs are in the machine's YZ plane, we can use a "WallX" cycle to 
measure each of them. Double-click on one of the pink cells and select the cycle name 
from the drop-down list. Then repeat for the second feature. The cycle names presented 
in the drop-down lists are defined in the post-processor, and will vary from one target 
machine to another. 
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The numbered columns in the table contain the names of parameters for the cycles. Each 
probe cycle row is preceded by an "Approach" row, and followed by a "Retract" row. The 
table starts with an "Initialization" row and ends with a "Termination" row. All of these 
rows can have associated parameters in the numbered columns. Pink cells represent 
mandatory parameters. Once they are edited to contain numeric values, the color 
disappears. Optional parameters are not colored initially. You can hover over any 
parameter cell to see the parameter name displayed as a tool-tip, even after it contains a 
numeric value. 

 

 
 
You will see that the X and Y parameters in the two "Approach" rows have been filled in 
automatically. These points will be in the center of the selected webs, as required by the 
probe cycle, but the Z parameter, while mandatory, has not been supplied. This is because 
the approach should place the probe near to, but not on, the workpiece. To see the value 
of Z on top of the first web, right-click on the pink Z cell in the first "Approach" row, and 
pick "Z" from the pop-up menu. 
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Then edit the value to increase it by a couple of millimeters. This should leave the probe 
above the web at the end of the approach. Repeat for the second web's approach. 

 

 
 

Before we can run the post-processor to turn the table content into a G-Code program, we 
need to eliminate all the pink by supplying numeric values for the mandatory parameters, 
and perhaps supply some of the optional parameters too. Parameter names and their 
interpretation are a function of the post-processor and the probe cycles available on the 
target machine. So the following is only representative of the process. To fill the 
"WidthX" cells we can right-click on each and select "Nominal Dimension" from the 
drop-down menu. The value is derived from the feature's "Dimension" column in the 
original Inspection Sequencing table. We should fill the "Tolerance" cells for each feature 
in the same way, even though these parameters are optional. Right-click on each such cell 
and pick "Maximum Tolerance" from the drop-down menu. The value comes from the 
"Tolerance" column of the original table. The remaining two pink cells are "Depth", 
which is the distance down the web, from the top, that the probe should move before 
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stepping inward to make the measurement. There is no suitable value available in the 
drop-down menu, so we can just edit these cells to supply one. 

 

 
 

Now that all the pink is gone, what else may we need before generating the probe cycle 
program? The "Initialization" row contains three parameters, "Clearance", "FeedRate" 
and "SlowRate". These parameters appear in "Approach" and "Retract" rows too, so they 
can be adjusted for each feature if necessary. "Clearance" is the height above the 
approach point where the probe should be armed, and is also used after each cycle for the 
retract distance. "FeedRate" is the normal feed rate which will be used for the first part of 
each approach. "SlowRate" is the much slower speed of the probe once it is armed, for 
which the probe cycles supply a default if necessary. So let's provide blanket "Clearance" 
and "FeedRate" values in the "Initialization" row. 

 

 
 
What's missing? It would be faster to use rapid motion before each approach. So right-
click on the first "Approach" cell and pick "Insert Rapid" from the drop-down menu. 
Note that you can also insert moves at the normal feedrate if you wish to avoid obstacles. 
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Replace the pink cell contents with suitable coordinates and repeat for the second web if 
you think a rapid motion over this short distance would make sense. 

 

 
 

There is an alternative more automated way to insert motion between the retract from one 
feature and the approach to the next. If you wish to explore this, right-click on the second 
"Rapid" cell you have just inserted and pick "Delete" from the drop-down menu. When 
you right-click on an "Approach" cell that has a "Retract" cell immediately above, the 
drop-down menu contains three choices.  
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Picking "Insert Transit" will cause insertion of from one to four "Move" and "Rapid" 
rows. The "Transit" parameters along the bottom edge of the dialog are relevant. The 
"Retract Direction" is an IJK vector which determines how the probe is moved away 
from the workpiece, In this sample the probe is moved parallel to the Z axis. The 
"Bottom Clearance" defines how close the tip of the probe can come to any obstacle 
between the features. The workpiece itself, and any fixtures are considered potential 
obstacles. The "Side Clearance" defines how close the side of the probe is allowed to get 
to the obstacles. If you have a long probe and not much variation in workpiece height, 
you could use a side clearance just a little bigger than the probe's radius. With a short 
probe or a workpiece surrounded by large fixtures, it would be wiser to use a value 
generously bigger than the radius of the probe's holder. The first row inserted will be a 
"Move" to raise the probe above the prior feature by at least the bottom clearance. Then a 
"Rapid" row will raise it further to clear any obstacles between the feature, another 
"Rapid" will transit the probe, and a final "Rapid" will drop the probe back to within the 
bottom clearance of the next feature. 
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Some suites of probe cycles have the ability to save the result of one measurement and 
compare it with other measurements in a later cycle. For example, if you wanted to check 
that the Z dimension of one surface matched that of another, you could save the result of 
probing the first surface, then on the second one use a cycle that compared the new 
probed Z with the stored value. While it doesn't make sense for this example, as we won't 
be comparing the webs with each other, if the post-processor is written to handle the 
capability, you could insert a "Save" after any cycle by right-clicking on the 
corresponding "Retract" cell and picking "Insert Save" from the pop-up menu. 

 

 
 

We are ready to click the  button to run the post-processor. Hopefully this will be an 
anti-climax, with no error messages in additional debugging dialogs. To see the resulting 
G-Code program, and perhaps edit it, click o the   button. 
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The comments are derived from the second, third and fourth columns of the table for each 

feature. Note that the first block number in the program comes from the  entry 
box at the top of the Inspection Programming dialog. So you could use a much larger 
value if you intend to cut and paste the program into the one that cuts the part.  

You can simulate the probe cycle program by clicking on the  button. This will trigger 
display of the "NC Program" dialog, append the new program's file name to the end of 
the list, tick the "Use Selected Files" box, untick any other files in the list, and force an 
"Apply". You should then be able to click on VERICUT's  or  button. 

 

 

 
 
Also see "VERICUT Inspection", in the Using VERICUT section, in the CGTech Help 
Library.
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Customizing VERICUT Inspection 
 

The behavior of the Inspection Sequencing dialog can be customized in a number of ways 
by defining one or more text files and having an environment variable, 
CGTECH_INSPECTION_TOLERANCES, which points to one of them. You can define 
the default tolerance values that are placed in the dialog's table for each type of 
measurement. You can define the default instruments to be used for each feature type, 
and specify additional instrument types. And you can supply your own icons for the 
feature types, which will be used in the dialog and the generated reports. 

 

Default Tolerances 
 
There are hard-coded default tolerances values that conform to DAN 11304. When you 
add or modify a row in the sequencing dialog's table, and the nominal dimension is 
supplied by the system, a default tolerance will be generated too. If DAN 11304 isn't 
what you need, you can supply your own set of defaults, with different strategies for each 
feature type if necessary. A sample file contains an explanation of the flexibility available 
and the format to be used.  

If you only need one set of default tolerances for all the workpiece types that you deal 
with, then the environment variable, CGTECH_INSPECTION_TOLERANCES should 
specify the fully qualified path and name of the sole text file. If you need more than one 
set of default tolerances, then the environment variable should reference a file that 
contains a list of the files that each contain a set of default tolerances. For example, if you 
machine parts for two customers, and one of them is still using a mix of units, you may 
have three default tolerance files; 

 

CustomerA-Inch-Tols.txt  
CustomerA-MM-Tols.txt  
CustomerB-MM-Tols.txt  
 

In this case, you would create one more file containing a list of these files. You might call 
it "Inspection-Tols.list" and it would contain something like the following;  

 

C:\CGTech\Inspection\Defaults\CustomerA-Inch-Tols.txt 
C:\CGTech\Inspection\Defaults\CustomerA-MM-Tols.txt 
C:\CGTech\Inspection\Defaults\CustomerB-MM-Tols.txt 
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The environment might be defined in the batch file you use to invoke VERICUT, and 
could be as follows;  
set CGTECH_INSPECTION_TOLERANCES=C:\CGTech\Inspection\Defaults\Inspection-Tols.list 

If you have more than one default tolerance file set up this way, then there will be a drop-
down choice list in the bottom-right corner of the Inspection Sequencing dialog.  

 

 
 

 
If you pick a different file of default tolerances while there are some rows in the table, 

then any tolerance values that have not been edited will be recalculated on the basis of the 
selected file's content.  

Instruments 
Each cell in the Instrument column of the Inspection Sequencing dialog's table contains a 
drop-down list of instrument types.  
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Some of these instruments are the defaults for some of the feature types. Thus each floor 
thickness row will, by default, suggest use of an ultrasonic depth gage, and each wall 
thickness row will mention a snap caliper. You can extend this list of instruments, or 
provide a separate list for each type of feature.  

If you have several default tolerance files for different customers, units or types of parts, 
you can customize the lists of instruments in each of them. If you have no default 
tolerance file and use the hard-coded DAN 11304 values, but need different instruments, 
then you can create a file containing just the customizing text for the instruments. 
Following is a sample of such text;  

 

Instrument Wall  Micrometer 
Instrument Wall  Ultrasound 
Instrument Wall  Caliper 
Instrument Floor Ultrasound 
Instrument Plumb Line 
Instrument Ruler 

 

Each line starts with the keyword "Instrument". If the next word in a line is one of the 
feature types; Wall, Floor, Diameter, Length, Angle, Position, Depth, Radius or Finish, 
then you must provide similar lines for all the instruments that can be used to measure 
that feature type. The instrument name that follows the type in the first such line becomes 
the default for that feature type. The list of instruments for a feature type will replace the 
entire "un-customized" drop-down list. If no customizing lines are provided for any 
feature type, the "standard" list will still be used. If the second word on a line is not one 
of the feature types, then everything after the "Instrument" keyword is just the name of an 
additional instrument type which will be appended to the "standard" list. So with the 
sample customizing text shown above, "Plumb Line" and "Ruler" will be appended to the 
list for all feature types except "Wall" and "Floor". On the other hand, the drop-down list 
for a "Wall" feature will be much shorter.  
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Note that "Probe" is offered as an instrument type regardless of whether the list has been 
customized. This ensures compatibility with the Programming capability.  

 

Icons 
 
By default there are several 24x24 pixel, monochrome icons used in the left-most column 
of the Inspection Sequencing and Inspection Programming dialogs' tables and the 
Inspection Reports, which denote the type of feature to be measured.  

 

Feature Type Icon File Name 

Wall Thickness  InspectW.gif

Floor Thickness  InspectF.gif 

Hole Diameter  InspectD.gif

Datum Plane  InspectS.gif 

Distance  InspectL.gif 

Angle  InspectA.gif

Position  InspectP.gif 

Hole Depth  InspectH.gif

Radius  InspectR.gif 

Surface Finish  InspectT.gif 

Note  InspectN.gif

 

If these icons are not to your taste, you can redesign them, but making them larger is not 
recommended. The icon files are distributed as part of the file, CGTech.jar, which you 
will find in the "classes" folder under your CGTech installation directory. A "jar" file is a 
variation of a "zip" file which commonly available file compression programs can 
manipulate.  

We suggest that you make a copy of CGTech.jar, calling it "CGTech.jar.zip" so that a 
program such as WinZip can recognize it. Then you can use WinZip to extract the icon 
files that you wish to adjust. Note that in each icon file, the white background color is 
actually transparent. You will need to use a paint program that supports GIF Version 89a, 
to handle the transparency. When you have adjusted, or entirely replaced the image, save 
it with the same file name and use WinZip again to update the compressed version in 
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CGTech.jar.zip. When you have changed all icons necessary, delete the original 
CGTech.jar and rename CGTech.jar.zip to take its place. 
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Die Sinking Simulation (Die Sinking Simulation 
window) 
Location:  Analysis menu > Die Sinking Simulation 

  

Opens the Die Sinking Simulation window enabling you to select electrodes and 
simulate the die sinking process. 

  

 
  

Simulation Display Features 

Stock — Enables you to select the Stock component that is to be used for the simulation. 
Select the name of the Stock component from the pull-down list. 

Display Stock — use to specify whether or not to display the Stock model during the 
simulation. The stock model can be displayed as Solid or Translucent. The stock model 
remains displayed during the Burn process unless Display Burned Material is toggled 
on. In this case the Stock model will be turned off when you select Burn and only the 
material removed by the simulated EDM burn will be displayed at the end of the burn 
process. 
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Display Electrodes — use to specify whether or not to display the Electrode model(s). 
Electrode models can be displayed as Solid or Translucent. Electrode models are always 
toggled off after Burn is selected. 

Display Burned Material — use to specify whether or not to display the material that is 
removed by each electrode during the simulation. The "burned material" can be displayed 
as Solid or Translucent. 

Animate — use to specify whether or not to display electrode animation during the 
"burn" process. Use the slider bar to control the speed of the animation. If toggled off, 
displays only the result of the burn process.  

  

Electrode Table 
Table of electrodes selected for use during Die Sinking Simulation.  

On — Toggles on and off to activate/deactivate individual electrodes in the table. Only 
the active electrodes will be used during the "burn" process. 

Electrode — The name of the electrode component.  

Overburn — this column enables you to specify an "overburn" value for each electrode. 
The "overburn" value is applied as an offset to each electrode during "burn" processing. 

Volume Removed — this column displays the volume of material that was removed by 
each active electrode during the burn process. The "volume removed" value is updated in 
the table as each electrode completes the burn process. 

Click and drag the button in the first column of each row to change position of an 
electrode in the table. "Active" electrodes will be processed sequentially starting at the 
top of the table. 

Add — use to add additional electrodes to the table. Select the electrode to be added 
from the pull-down list then select Add. The pull-down list will contain all electrode 
components found in the Component Tree that are not currently in the table. 

Delete — use to remove the highlighted electrode from the table. 

 

Shortcut:  You can right-click in the Electrode table to display a menu containing Add 
and Delete. These provide the same functionality described above. Clicking on Add will 
display the pull-down list of available electrodes that you can choose to add to the table. 

 

Set All — use to activate "all" electrodes in the table.  

Clear All — use to deactivate "all" electrodes in the table. 

  

Die Sinking Simulation features 
Compare With Design — displays the AUTO-DIFF window enabling you to compare 
the stock model at the end of the burn process with the design model. 
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Save Model — enables you to save the stock model that resulted from the burn process 
as a VERICUT solid (.vct) file. 

  

Apply — Use to save the current Die Sinking Simulation settings. 

Burn — Use to start the "burn" process. 

Restore — Restores the stock model to the state it was in prior to the "burn" process. 

Report — Use to create a Die Sinking Simulation Report. 

Close — Closes the Die Sinking Simulation window. 

 
 

Also see "Die Sinking Simulation", in the Using VERICUT section, in the CGTech Help 
Library. 
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OptiPath Menu 
 

Control (OptiPath Control window) 
 

VERICUT Users: 
VERICUT Location:  OptiPath menu > Control 

                                  Project menu > Output: Logs tab, Settings button 

VERICUT toolbar short cut:      

  

Mold and Die Users: 
Mold and Die Location:    Preview and Optimize page > Optimize Tool Path 

Notebook Feature:        

  

Opens a window to control when tool paths are optimized by OptiPath, specify the file to 
receive the optimized data, choose the type of stock material and NC machine involved in 
the cutting the workpiece. Feed rates and spindle speeds can be monitored via the Status 
window. A summary of the cutting conditions encountered during optimization and 
min/max optimized feed rates is written to the Log and available for use when creating a 
report file showing an overview of the results of the current VERICUT session. 

See "Overview of Optimizing NC Programs" in the Using VERICUT section, in the 
CGTech Help Library for information about using OptiPath to optimize your NC 
programs. 
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Settings tab — Features on this tab enable you to control when and how NC programs are 
optimized. 

G-Code Output Options tab — Features on this tab enable you to configure how the 
machine control will process machine code data, and configure settings referenced when 
G-Code NC program files are optimized. 

Learn Mode Options tab — Features on this tab enable you to control how and when 
OptiPath records are written to the Tool Learn Library file during Learn From Toolpath 
processing.  

APT Output Options tab — Features on this tab enable you to configure settings 
referenced when APT NC programs are optimized. 

  

OK — Applies the changes and closes the OptiPath Control window. 

Apply — Applies the changes and leaves the OptiPath Control window open. 

Cancel — Closes the OptiPath Control window without applying changes. 
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OptiPath Control window, Settings tab 
VERICUT Location:  OptiPath menu > Control 

                                  Project menu > Output: Logs tab, Settings button 

 VERICUT toolbar short cut:      

  

Features on this tab enable you to control when and how tool paths are optimized. 

  

 
  

OptiPath Mode — Controls when and how tool paths are optimized. All OptiPath modes 
can be used with both Standard and FastMill cut modes. 

Options: 
Off — Turns optimization off. Optimization is automatically turned off when the end 
of the NC program file has been reached, or when the NC program is reset, or 
rewound. 

On — Turns OptiPath on and writes optimized NC program data to the file specified 
with the Optimized File feature. For optimization to occur, OptiPath records must be 
"associated" with the cutting tools in the NC program file. There are two methods of 
doing this: 

1. Tool Library association method - associate the OptiPath tool Description 
and number of Teeth with a tool in a Tool Library file, then choose the stock 
Material and Machine in the OptiPath Control window. 
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2. Tool List association method - choose the stock Material and Machine in 
the OptiPath Control window, then build a tool list that associates OptiPath 
records with cutting tools to be optimized in the NC program file. 

With either method, tools without "cutting tool-to-OptiPath record" associations are 
not optimized. If both methods are used, associations in the tool list override those 
stored with tools in the Tool Library. 

Prompt While Cutting — Turns OptiPath "On" and interactively prompts for 
optimization data at each tool change by displaying the Optimization Settings 
window. Use the Optimization Settings window features to enter data for optimizing 
the cuts performed by the current tool. When you finish, VERICUT automatically 
stores the information in the Tool Library file, and sets tool properties to point to the 
new OptiPath record. VERICUT restarts the simulation, turns OptiPath on and uses 
this information to write optimized NC program records to the specified Optimized 
File until the next tool change is encountered. 

See "Using OptiPath – Prompt While Cutting" in the Using VERICUT section, in 
the CGTech Help Library for more information. 

Learn From NC Program — Turns OptiPath "On" and automatically creates a new 
Tool Library file for the "current" project file. The new Tool Library file is created in 
the file specified by Tool Learn Library on the Learn Mode Options tab. The 
OptiPath records in the Tool Library file that is created can then be manually fine-
tuned using features in the OptiPath window, and then used to optimize the NC 
program.  

Learn From NC Program can be turned On / Off at any time during cut processing. 
Each time Learn From NC Program is turned on, it creates a Tool Library file. The 
file contains OptiPath settings for every tool loaded since cutting was started with 
Learn From NC Program turned "On", including the tool that was cutting at time 
that Learn From NC Program was turned "Off". These settings are based only on 
cutting conditions that occurred between the time cutting was started with Learn 
From NC Program was turned "On" and the time when cutting stops and Learn 
From NC Program turned "Off". To get complete and accurate information for each 
tool, process the whole job through Learn From NC Program. Turning Learn 
From NC Program On / Off during cutting can be used to analyze cutting 
conditions for a specific group of cuts. 

When Learn From NC Program mode is turned on, any tools with matching OP 
records are skipped, not "learned". Any tools without OP records are "learned" and a 
new OP record is created. The old and new records are combined in a new OP library 
file. 

For each tool, OptiPath finds the maximum volume removal rate and chip thickness 
that occurred during cutting and uses them for corresponding OptiPath settings for the 
tool. The optimization mode is set to a combination of "Chip Thickness" and 
"Volume Removal" for each tool. Axial Depth and Radial Width values are 
determined by the cut that produces the highest volume removal rate. Default values 
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are used for other settings unless they have specifically been changed using Learn 
Mode Options tab. 

Learn From NC Program only automatically creates an updated Tool Library file 
(.tls) containing the "OP Description" and "# Teeth" values associated with the 
newly created OptiPath records. It does not automatically optimize the tool path or 
produce the Optimized File. Once Learn From NC Program creates the updated 
Tool Library file, you are prompted whether or not you want to optimize the NC 
program using the newly created Tool Library file. 

See "Using OptiPath – Learn From NC Program" in the Using VERICUT section, in 
the CGTech Help Library for more information. 

 
Optimized File — Specifies the name of the modified (optimized) tool path file to 
receive optimized NC program data. The format of this file, APT vs. G-Code, is the same 
as the tool path file being optimized. When an APT NC program is optimized the 
programmed "FEDRAT" records are commented out using "$$" and written to the 
modified path for reference. The Optimized File name must be different from that of the 
original NC program file. OptiPath will not permit the original NC program file to be 
overwritten. 

When optimizing multiple NC program files an optimized NC program file is output for 
each NC program file simulated. Each output file has an ascending sequence number 
appended to the end of the base file name. For example: assume Optimized 
File="part.mco" is entered (without the quotes). Optimizing 2 NC programs outputs the 
following files: 

 

part001.mco => optimized NC program file created from NC program 1 

part002.mco => optimized NC program file created from NC program 2 

 

If a dot "." is the last character of the optimized tool path file name, then three digits are 
appended to the file name as the extension. Continuing with the above example: assume 
Optimized File="part." is entered. Optimizing the same 2 NC programs outputs the 
following files: 

 

part.001 => optimized NC program file created from NC program 1 

part.002 => optimized NC program file created from NC program 2 

 

If an asterisk "*" is used in the optimized tool path file name, the original tool path file 
name is used as the output file name in place of the asterisk. If characters follow the 
asterisk, the input tool path file name extension is replaced with the characters following 
the asterisk. Examples follow. 
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Original tool path file Optimized File name Output file name 

dir1/filename.tp dir2/* dir2/filename.tp 

dir1/filename.tp dir2/*.op dir2/filename.op 

dir1/filename.tp dir2/*op dir2/filenameop 

dir1/filename.tp dir2/*op.tp dir2/filenameop.tp 

 filename.tp *.op filename.op 

 

Only a single asterisk is acted on in the optimized NC program file name, with one 
exception: asterisk dot asterisk ("*.*"). This case behaves exactly like the single asterisk 
file name described above. This is NOT a regular expression replacement; therefore any 
characters before the asterisk are ignored and lost. When there is more than one asterisk, 
only the first one is replaced. Examples follow. 

 

Original tool path file Optimized File name Output file name 

dir1/filename.tp dir2/*.* dir2/filename.tp 

dir1/filename.tp dir2/op* dir2/filename.tp 

dir1/filename.tp dir2/op*.ext dir2/filename.ext 

dir1/filename.tp dir2/*op.* dir2/filenameop.* 

 

Material — Identifies the stock material being cut. The material name is changed via 
clicking the arrow and selecting from a list of available materials, or clicking in the data 
field and typing a new material name. 

Machine — Identifies the NC machine being used to cut the workpiece. This feature 
functions similar to Material described above. 

NOTE:  For optimization to occur the Material and Machine names must match those 
of the desired OptiPath records in the Tool Library file. 
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Override All Feedrates — Overrides optimized feed rates calculated for all tools 
optimized. 100% uses optimized feed rates as is, 50% cuts feed rates in half, 200% 
doubles the feed rates, and so on. 

 
 
To OptiPath Control window
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Optimization Settings window 
 

The Optimization Settings window is displayed by VERICUT each time that a tool 
change is encountered during simulation when OptiPath Mode, in the OptiPath Control 
window: Settings tab, is set to Prompt While Cutting. 

 

 
 

The upper part of the Optimization Settings window provides information about the 
current tool, material, and machine  that VERICUT has extracted from Tool Manager, the 
machine file, the OptiPath Control window, etc. 
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The tabs on the lower part of the Optimization Settings window are identical to those 
found on the OptiPath window. See OptiPath window, also in the VERICUT Help 
section for additional information. 

Find Existing — Displays the Search OptiPath Record window enabling you to search 
Tool Library files and Optipath files for existing OptiPath records. See Search OptiPath 
Record window, also in the VERICUT Help section for additional information. 

Do not optimize this tool — Turns optimization off for the current tool. 

 

OK — Accepts the current OptiPath settings. VERICUT automatically stores the 
information in the Tool Library file, sets tool properties to point to the new OptiPath 
record, and restarts the simulation with OptiPath turned on. VERICUT uses this 
information to write optimized NC program records to the specified Optimized File, as 
the simulation continues, until another tool change is encountered. 

Cancel — Causes VERICUT to stop prompting for remaining tools but continues 
optimizing where possible. 

 

 

Also see "Using OptiPath – Prompt While Cutting" in the Using VERICUT section, in 
the CGTech Help Library. 
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OptiPath Control window, G-Code Output Options tab 
VERICUT Location:  OptiPath menu > Control 

                                  Project menu > Output: Logs tab, Settings button 

 VERICUT toolbar short cut:      

  

Enables you to configure how the machine control will process machine code data and 
configure settings referenced when G-Code NC program files are optimized by OptiPath. 
The G-Code Output Options tab is only available when NC Program Type is set to G-
Code Data. 

  

 
  

OptiPath & Curve Fit tab — Features on this tab enable you to configure settings 
referenced when G-Code NC program files are optimized by OptiPath.  

General tab — Features on this tab enable you to configure general guidelines for how 
the control processes machine code data and number equations. 

 
 
 
To OptiPath Control window
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OptiPath Control window, G-Code Output Options tab, 
OptiPath & Curve Fit tab 
VERICUT Location:  OptiPath menu > Control > G-Code Output Options tab 

 

Features on this tab enable you to configure settings referenced when G-Code tool path 
files are optimized by OptiPath.  

  

 
  

The settings are used to control block sequencing and word/value spacing in the 
optimized output tool path file. Note that by default, optimized blocks receive the same 
sequence number, if any, that appears on the original block processed. This typically 
results in multiple blocks having the same sequence number. The features on this tab are 
the same as those found on the Control Settings window: OptiPath & Curve Fit tab. 

Auto Sequence Numbering — When active, OptiPath re-sequences optimized NC 
program records in ascending order. The Sequence Increment Value (see below) is used 
for the beginning sequence number, and as the increment value for subsequent sequence 
numbers. Both optimized and non-optimized blocks with sequence numbers are re-
sequenced. Sequence numbers are not added to un-optimized blocks without a sequence 
number. 

NOTE:  If the general control setting Default Word="N", then "N" does not appear in 
the sequence number. The result is a sequence number without a word, for example: 
"50G01X5", such as required by Heidenhain controls. 
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Add Sequence Number to Added Blocks — When active, adds sequence numbers to 
blocks added during optimization via the Add More Cuts OptiPath setting. 

Sequence Increment Value — Initial value and increment value for re-sequencing 
optimized G-Code NC program records. 

 
 

Word Value Spacing — When active, includes a space between word/value pairs in the 
optimized NC program file. Un-optimized records do not receive spacing. When this 
feature is not used, optimized NC program records are not spaced. 

 
 
To G-Code Output Options tab 
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OptiPath Control window, G-Code Output Options tab, 
General tab 
 
Features on this tab enable you to configure general guidelines for how the control 
processes machine code data and number equations.  
The features on this tab are the same as those found on the Control Settings window: 
General tab. 
 

 
  
 
Control Type — Sets the type of NC control being used. Choosing the proper option 
establishes a mode of operation consistent with how the control processes NC data. 
Options are: 

Generic — Fanuc and most other controls using standard controller functions. 

NUM — French-made control. This option affects how G-Code data is interpreted, 
for example: how variables are initialized and processed, and how to interpret 
parameters to macros that shift the location of the tool path. 

Heidenhain Conversational — Heidenhain Conversational control. This option 
causes VERICUT to recognize the "L" word as an optimizable word. Also, the "L" 
word is included with any cuts added during optimization. 

Calculation Tolerance — Tolerance for rounding mathematical evaluations, such as 
determining if two calculated values are equal to, greater than, or lesser than each other.  

NOTE:  The Calculation Tolerance should be adjusted to eliminate "invalid circle" 
errors caused by circle calculations that produce differences larger than the tolerance 
value when processing G-Code data. 
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Order of Math Operations — Order in which math operations are performed. 

Options are: 
Rules of Precedence — Follow the basic rules of math precedence: 

1. Perform exponential (power). 

2. Perform multiplication and division operations. 

3. Perform addition and subtraction operations, example: 5 + 5.3 * 3 * sin(30)= 
12.95 

Enclosing math operations in parenthesis causes them to be performed before 
those not enclosed in parenthesis. The same rules of precedence are applied to 
math operations enclosed in parenthesis. 

Left to Right — Use left to right sequence, example: 5 + 5.3 * 3 * sin(30)= 15.45 

Default Word — Word assumed by VERICUT for NC data blocks beginning with 
numbers, such as NC data for some Heidenhain controls. For example, for VERICUT to 
interpret blocks like "50G01X5", set Default Word to "N". VERICUT then interprets the 
block without error as "N50G01X5". 

 
 
To G-Code Output Options tab
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OptiPath Control window, Learn Mode Options tab 
VERICUT Location:  OptiPath menu > Control 

                                  Project menu > Output: Logs tab, Settings button 

 VERICUT toolbar short cut:      

  

Features on this tab enable you to control how and when OptiPath records are written to 
the ToolLearn Library file during Learn From Toolpath processing.  

  

 
  

Enables you to override the default values for Minimum Feedrate Change, Clean-up 
Feedrate, Minimum Cut Feedrate and Maximum Cut Feedrate without going to the 
OptiPath Control window: Settings tab. 

The Learn Mode Options tab is only active when OptiPath Mode, on the OptiPath 
Control window: Settings tab, is set to Learn From Toolpath. 

Append to Existing Tool Library — If toggled "On", Learn From NC Program 
appends OptiPath records to the existing Tool Library file for the current project file. 
Otherwise the "Tool Library to be created" window will display enabling you to specify 
the /path/filename for the new Tool Library file to be created. 

Update Optimization Settings for Existing Records — If toggled "On", existing 
OptiPath records are updated with new volume, chip thickness, and spindle speed values. 
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NOTE:  If Update Optimization Settings for Existing Records is toggled "On", and 
the same tool is loaded multiple times in the NC program, the Tool Library file, produced 
by Learn From Toolpath, will have only one record for the tool. The settings for the 
tool are based on the "worst case" cut condition of all cuts made with the tool during the 
current NC program. If toggled "Off", a record will be added to the Tool Library file each 
time the tool is loaded. The settings will be based on the "worst case" cut for the current 
"load tool" cut sequence.  

  

Reset and Optimize after Learning — If toggled "On", VERICUT automatically resets 
and optimizes the NC program after the updated Tool Library file is created. Otherwise, 
you will be prompted whether or not you want to optimize the toolpath using the newly 
created Tool Library file. 

Minimum Feedrate Change — Specifies the minimum change from the current 
optimized feed rate that will cause a new optimized feed rate to be output. This feature 
controls the quantity of feed rates output to the optimized NC program file. A small value 
causes more optimized feed rates to be output than when a larger value is entered. 

Default — When selected, sets the default Minimum Feedrate Change = 1 IPM or 25 
MMPM, whichever applies. 

Clean-up Feedrate — Feed rate used when the tool is adjacent to, but not removing 
material. This condition is commonly referred to as a "spring pass". 

Default — When selected, sets the default clean-up feed rate as follows: 

G-Code NC program = 50% of the Max Feed Velocity of the machine's X-axis. 

APT NC program = 50% of the Fast Feed value. 

 

Tip: Set the Clean-up Feedrate to be less than the Air Cut Feedrate, since actual 
cutting leaves small amounts of material from tool deflection. 

 

Minimum Cut Feedrate — Specifies the minimum optimized feed rates that can be 
output when removing material. 

Default option — When selected, sets the default minimum feed rate = 1 IPM or 25 
MMPM, whichever applies. 

Maximum Cut Feedrate — Specifies the maximum optimized feed rates that can be 
output when removing material. 

Default — When selected, sets the default maximum feed rate as follows: 

G-Code NC program = 45% of the Max Feed Velocity of the machine's X-axis. 

APT NC program = 45% of the Fast Feed value. 
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Air Cut Feed Rate — This option is useful for reducing time of proven NC programs, 
without affecting cutting feed rates and resulting surface finishes. When the checkbox is 
cleared, this feature controls the feed rate used by all other optimization methods to 
optimize air cuts. 

Default — when selected, the air cut feed rate is determined as follows: 

G-Code NC program = Max Feed Velocity of the machine's X-axis. 

APT NC program = Fast Feed value. 

To specify an air cut feed rate value, clear the Default checkbox and enter a value in the 
data field. The feed rate entered should reflect the maximum speed at which machine 
axes can move simultaneously in feed mode (e.g. G01). 

 
 
To OptiPath Control window
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OptiPath Control window, APT Output Options tab 
VERICUT Location:  OptiPath menu > Control 

                                  Project menu > Output: Logs tab, Settings button 

 VERICUT toolbar short cut:      

  

Features on this tab enable you to configure settings referenced when APT NC programs 
are optimized. 

  

 
  

Output Number of Decimal Places — Use the text field to specify the number of 
decimal places that are to be output when OptiPath adds records. The default value is 10. 

 
 
To OptiPath Control window
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Compare Files (Compare NC Program Files window) 
VERICUT Location:  OptiPath menu > Compare Files 

  

Opens a window to enabling you to select and compare the original NC program file and 
the optimized NC program file. 

  

 
  

Toolpath Type — Select APT or G-Code Data. 

Original Toolpath — Enter the \path\file name in the text field of the file to receive 
exported model data or click on Browse and use the Original NC program file selection 
window to specify the file. 

Optimized Toolpath — Enter the \path\file name in the text field of the file to receive 
exported model data or click on Browse and use the Optimized NC program file selection 
window to specify the file. 

Previous Difference — Use the  icon to step back through the file to the previous 
difference. 
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Next Difference — Use the  icon to step forward through the file to the next 
difference. 

Line Number or Search Text — Use to enter a line number or a string of text to search 
for. 

Goto Line Number — Use the  icon to move the cursor in the file listing to the line 
number specified in the Line Number or Search Text field. 

Search Forward — Use the  icon to search forward in the file listing for the text 
string specified in the Line Number or Search Text field. 

Search Backward — Use the    icon to search backward in the file listing for the text 
string specified in the Line Number or Search Text field. 

Compare — Starts the compare of the two specified NC program files. 

Close — Closes the Compare NC Programs window. 

Stop — Use the  icon to stop the compare. 



Help Menu 
 

Help On VERICUT 
VERICUT Location:  Help menu > Help on VERICUT 

  

Opens the CGTech Help Library. 
 
 



 

License 
VERICUT Location:  Help menu > License 

  

Opens a window showing the status of VERICUT licenses on your license server.  
 
 

 
 



 

Feature — This column shows the VERICUT feature licenses that are available on your 
license server. 

Status — This column shows the expiration dated of the VERICUT feature license. 

Total Available — This column shows the total number of VERICUT feature licenses 
that are available on your license server. 

Total in Use — This column shows the total number of VERICUT feature licenses that 
are currently in use. 

Current Session — This column shows the total number of VERICUT feature licenses 
that you are using in your session.



 

Help about VERICUT 
VERICUT Location:  Help menu > Help about VERICUT 

  

Opens a window showing version related information. 
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